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End User License Agreement

1. IMPORTANT NOTICE

This package includes one or more diskette(s), CD-ROM(s), and/or DVD(s) containing copies of APOGEE™ 
software programs and documentation relating thereto, and an associated dongle.

You should carefully read the following terms and conditions before accepting this License Agreement, and 
installing and using this Software (as defined below). This License Agreement (“Agreement”) is a legal agreement 
between You and ECO3 BV, Septestraat 27, B-2640 Mortsel, Belgium (“ECO3”), and describes the terms and 
conditions pursuant to which ECO3 shall license to You this Software, provided however that in the event a hard 
copy license agreement with respect to the Software is signed by or on behalf of both You and ECO3 whose terms 
vary from this Agreement, then such signed hard-copy license agreement shall govern Your Use of the Software. In 
this License Agreement “You” means, and “Your” refers to, the corporation or other entity that obtains the Software 
and enters into this Agreement, including both the reader and any corporate licensee.

BY INSTALLING, COPYING OR OTHERWISE USING THE SOFTWARE, YOU ACCEPT, AND AGREE TO BE BOUND 
BY, THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THESE 
TERMS, DO NOT INSTALL, COPY OR OTHERWISE USE THE SOFTWARE, AND YOU MAY RETURN THE 
SOFTWARE, WITH PROOF OF PAYMENT, FOR A FULL REFUND TO THE PLACE OF PURCHASE WITHIN THIRTY 
(30) DAYS OF THE PURCHASE DATE.

You are licensed to use the Software on the following terms and conditions:

2. DEFINITIONS

2.1 “ECO3 order form” means the electronic or hard copy order form by which You have ordered the Software. 

2.2 “Authorized Users” means the number of users who concurrently may have access to the Software at any 
one time, as specified in the ECO3 order form that is incorporated and made part of this Agreement by 
reference. 

2.3 “Confidential Information” means this Agreement, including all of its terms, and all its amendments and 
addenda, all Software listings, Documentation, information, data, tests, specifications, trade secrets, object 
code and machine-readable copies of the Software, and any other proprietary information supplied to You 
by ECO3, or by You to ECO3 and clearly marked as “confidential information”, including all items defined 
as “confidential information” in any other agreement between You and ECO3 executed prior to the date of 
this Agreement. 

2.4 “Designated Output Device” means an Output Device that has been designated by You to be managed by 
the Software.

2.5 “Documentation” means any instruction manuals, operating instructions, user manuals, “Dongle” help, 
tutorials and specifications provided by ECO3 which describe the use of the Software and which either 
accompany the Software or are provided to You at any time.

2.6 “Dongle” means a small hardware device that connects to a computer and acts as an authentication key for 
the licensed Software. 

2.7 “Effective Date” means the date on which You have accepted to be bound by the terms of this Agreement by 
installing, copying or otherwise using the Software.

2.8 “Font Programs” means the digitally encoded, machine readable outline programs for certain typefaces. 

2.9 “Modules” means the modules elected by You as being part of the Software, as listed in the ECO3 order form 
that is incorporated and made part of this Agreement by reference.

2.10 “Output Device” means a device that is capable of outputting logical pages, such as, without limitation, a 
platesetter or imagesetter.

2.11 “Processor” means one (1) single processor core that forms part of a desktop computer or server, as the case 
may be, on which the Software is installed or executed. For those processors that have multiple execution 
cores, each such core shall be considered a distinct Processor.

2.12 “Software” means APOGEE™ computer software program, all or part of which are owned by ECO3 or other 
parties whereby the license is owned by ECO3 (“Other Owners”), consisting of any of the Modules elected 
by You, provided and licensed to You pursuant to this Agreement.

2.13 “Storage Device” means the diskette(s), CD-ROM(s), DVD(s) and/ or other device on which ECO3 distrib-
utes copies of the Software.
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2.14 “System” means one or more Processors on which the Software is installed or run, and located at the System 
Location. The number of Processors on which You are authorized to install or run the Software is set forth 
in the ECO3 order form that is incorporated and made part of this Agreement by reference.

2.15 “System Location” means, with respect to the System and any part thereof, the address at which the System, 
and any part thereof, is physically located, as identified in the ECO3 order form that is incorporated and 
made part of this Agreement by reference.

2.16 “Updates” shall mean updates, if any, to the Software as commercially released by ECO3 at any given time, 
including, but not limited to, updates, small enhancements, additions, modifications, deletions, incorpora-
tion of patches, and/ or error corrections to any previously delivered version of the Software, as designated 
in ECO3's sole determination.

2.17 “Upgrades” shall mean a new and enhanced release of the Software as commercially released by ECO3 at 
any given time and that, when made or added, materially changes its utility, efficiency, functional 
capability or application, as designated in ECO3's sole determination.

2.18 “Use” means loading, utilization, running, storage or display of the Software by Authorized Users on Your 
System in connection with a Designated Output Device only, and solely for Your own internal business 
operations.

2.19 “Warranty Period” means the period ending ninety (90) days after the Effective Date during which the 
Software is covered by ECO3's warranty as set forth in this Agreement, provided however that in no event 
the Warranty Period shall exceed a period of one hundred and twenty (120) days after the date You have 
purchased the Software.

3. LICENSE AND COPIES

3.1 GRANT OF LICENSE. Subject to the terms and conditions of this Agreement, ECO3 hereby grants to You a 
perpetual, non-exclusive, non-sublicensable and non-transferable limited right and license to (a) Use the 
Software on the System, and (b) use the Documentation in connection with the Use of the Software. You 
acknowledge that the License Fee paid by You for the Use of Software is determined by the Designated 
Output Device. For each Output Device with which You Use the Software different from the Designated 
Output Device You will have to purchase a license upgrade for the Software or, with respect to additional 
Output Devices in connection with which You Use the Software, one or more additional licensed copies of 
the Software. In addition, specific terms and conditions shall apply to the use of Font Programs, as further 
set out in the about-box of the Software. 

3.2 This license transfers to You neither title nor any proprietary or intellectual property rights to the Software, 
Documentation, or any copyrights, patents, or trademarks, embodied or used in connection therewith, 
except for the limited rights expressly granted herein. You acknowledge that the Software and any copies 
thereof are licensed and not sold, and all right, title and interest in and to the Software are and shall remain 
with ECO3 and/ or the Other Owners. 

3.3 COPIES. During the term of this Agreement, You will be entitled to make a reasonable number of machine-
readable copies of the Software for backup or archival purposes only. You may not copy the Software, 
except as permitted by this Agreement. You shall maintain accurate and up-to-date records of the location 
of all copies of the Software and inform ECO3 in writing of such location(s) upon ECO3's request. All copies 
of the Software will be subject to all terms and conditions of this Agreement. Whenever You are permitted 
to copy or reproduce all or any part of the Software, all titles, trademark symbols, copyright symbols and 
legends, and other proprietary markings must be reproduced.

4. LICENSE RESTRICTIONS 

You agree that You are granted a limited right to Use only, and that You will not Yourself, or through any parent, 
subsidiary, affiliate, agent or other third party: 

(a) lease, license or sub-license the Software or the Documentation;

(b) sell or otherwise transfer the Software or Documentation, unless, subject to Article 9.4, You transfer your 
rights under this Agreement to a corporation or other entity and that at the time of transfer You pass the 
Software (and any and all copies in Your control) to such corporation or other entity and such corporation 
or other entity agrees to be bound by the terms and conditions of this Agreement;

(c) decompile, disassemble, or reverse engineer the Software, in whole or in part;

(d) modify the Software or any part thereof, except to the extent that the Software provides for user-modifiable 
components and such modification is necessary to Use the Software; 

(e) write or develop any derivative software or any other software program based upon the Software or any 
part thereof, or any Confidential Information; 
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(f) use the Software to provide software related services; or 

(g) provide, disclose, divulge or make available to, or permit use of the Software by any unauthorized third 
party without ECO3's prior written consent. 

(h) If the Software is used within a country of the European Community, nothing in this Agreement shall be 
construed as restricting or prejudicing any imperative rights available under the European Community 
Software Directive, O.J.Eur.Comm. (No.L.122/42, 1991).

5. LICENSE FEE 

5.1 LICENSE FEE. You shall pay the license fees for the Software applicable at the time of purchase (the 
“License Fee”). All fees hereunder exclude all applicable sales, use, value-added, property and other taxes, 
including duties and similar mandatory payments, and You will be responsible for payment of all such. 

5.2 NO OFFSET. License Fees due from You under this Agreement may not be withheld or offset by You against 
other amounts due to You for any reason. 

6. INSTALLATION - UPDATES - UPGRADES - MAINTENANCE AND SUPPORT 

6.1 You shall be responsible for the installation of the Software on the System, in accordance with the 
Documentation. 

6.2 As from the Effective Date, You may elect to purchase support and maintenance services in connection with 
the Software. In the event such maintenance and support agreement entitles You to Updates and Upgrades 
of the Software, if, and as from the date that, any such Update or Upgrade is installed on the System, it shall 
be an integral part of the Software. An Upgrade is covered by the warranty pursuant to paragraph 6.1 
during a period of ninety (90) days as from the date of installation of the Upgrade, which in no event shall 
exceed a period of 120 days after the Upgrade has been shipped by ECO3.     

6.3 Notwithstanding the foregoing, ECO3 shall have no obligation to offer, or continue to offer, to You the 
opportunity to purchase such support and maintenance services with respect to a given release (Updates or 
Upgrades) of the Software for a period exceeding two (2) years from the date of such release. 

7. LIMITED WARRANTY AND LIMITATION OF LIABILITY 

7.1 LIMITED WARRANTY. ECO3 warrants that during the Warranty Period (a) the Software will perform in 
substantial accordance with the Documentation and (b) the Storage Device on which the Software is 
distributed will be free from defects in materials and workmanship under normal use. If during the 
Warranty Period the Software or the Storage Device on which it is distributed do not perform as warranted, 
ECO3 at its sole and exclusive option shall use commercially reasonable efforts to correct such non-confor-
mance of the Software or to provide a reasonable workaround, or replace the Storage Device free of charge, 
or, if neither of those remedies are commercially practicable, terminate this Agreement and repay to You 
the License Fee. The warranty set forth above is made to and for the benefit of You only. The warranty will 
apply only if: (a) the Software has been properly installed and used at all times and in accordance with the 
Documentation or other instructions for Use, and (b) no modification, alteration or addition has been made 
to the Software by persons other than ECO3 or ECO3's authorized representative, except as authorized in 
writing by ECO3, and (c) the defect, error or problem does not result from any cause within the control of 
You. Any supplements or Updates to the Software, including without limitation, any service packs or hot 
fixes provided to you after the expiration of the Warranty Period are not covered by any warranty or condi-
tion, express, implied or statutory. ECO3 warrants that it possesses all of the right, title, interest and 
authority to enter into this Agreement with You. ECO3 also warrants that no lawsuit or claim concerning 
the Software is currently pending. 

7.2 EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTIES, ECO3 MAKES NO WARRANTIES, WHETHER 
EXPRESS, IMPLIED, OR STATUTORY REGARDING OR RELATING TO THE SOFTWARE OR THE 
DOCUMENTATION, OR ANY MATERIALS OR SERVICES FURNISHED OR PROVIDED TO YOU UNDER 
THIS AGREEMENT. ECO3 SPECIFICALLY DISCLAIMS ALL IMPLIED WARRANTIES OF MERCHANTABI-
LITY AND FITNESS FOR A PARTICULAR PURPOSE WITH RESPECT TO THE SOFTWARE, 
DOCUMENTATION AND SAID OTHER MATERIALS AND SERVICES, AND WITH RESPECT TO THE USE 
OF ANY OF THE FOREGOING. WITHOUT LIMITING THE GENERALITY OF THE FOREGOING, ECO3 DOES 
NOT WARRANT THAT OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, 
OR THAT DATA WILL NOT BE LOST IF FOR ANY REASON OPERATIONS ARE INTERRUPTED.

7.3 LIMITATION OF LIABILITY. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT WILL 
ECO3 BE LIABLE FOR ANY COMMERCIAL LOSS, LOSS OF PROFITS, LOSS OF AN OPPORTUNITY, LOSS 
OF USE, BUSINESS INTERRUPTION, LOSS OF DATA, COST OF COVER OR INDIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES OF ANY KIND IN CONNECTION WITH OR ARISING OUT 
OF THE FURNISHING, PERFORMANCE OR USE OF THE SOFTWARE OR SERVICES PERFORMED 
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HEREUNDER, WHETHER ALLEGED AS A BREACH OF CONTRACT OR TORTIOUS CONDUCT, 
INCLUDING NEGLIGENCE (BUT NOT GROSS NEGLIGENCE OR FRAUD), EVEN IF ECO3 HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ADDITION, ECO3 WILL NOT BE LIABLE FOR ANY 
DAMAGES CAUSED BY DELAY IN DELIVERY OR FURNISHING THE SOFTWARE OR SAID SERVICES. 
ECO3'S LIABILITY UNDER THIS AGREEMENT FOR DIRECT, INDIRECT, SPECIAL, INCIDENTAL AND/OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, INCLUDING, WITHOUT LIMITATION, RESTITUTION, WILL 
NOT, IN ANY EVENT, EXCEED THE LICENSE FEE PAID BY YOU TO ECO3 UNDER THIS AGREEMENT. 

7.4 ALLOCATION OF RISK. The provisions of this Section 6 allocate risks under this Agreement between You 
and ECO3. You acknowledge and recognize that ECO3's pricing reflects this allocation of risks and limita-
tion of liability accordingly. 

8. INDEMNIFICATION 

8.1 INFRINGEMENT INDEMNITY. ECO3 represents it has no reason to believe that the Software infringes upon 
any copyright or any other intellectual property right of any third party. In the event of a claim that the 
Software infringes upon, or violates, a third party's copyright ECO3 will indemnify and hold You harmless 
against any action brought against You based on a claim that the unmodified Software, when used in accor-
dance with this Agreement, infringes a European copyright, patent or other proprietary rights, and ECO3 
shall pay all costs, settlements and damages finally awarded, except for consequential damages. However, 
ECO3 will not be obligated to indemnify or hold You harmless from any such action unless You (i) notify 
ECO3 in writing of any claim within 10 (ten) business days after You learn of such a claim, (ii) give ECO3 
sole control of the defense and settlement thereof, (iii) provide all reasonable assistance in connection with 
the defense and settlement thereof, and (iv) have not yet compromised or settled in any way any such 
losses, claims or damages for which indemnity is sought. If the Software is finally adjudged to so infringe, 
or in ECO3's opinion is likely to become the subject of such a claim, ECO3 shall, at its sole option expense, 
either (1) apply its best efforts to procure for You the right to continue using the Software, or (2) apply its 
best efforts to modify or replace the Software to make it non-infringing, or, if neither (1) or (2) is commer-
cially practicable (3) terminate this Agreement, and repay to You a portion of the License Fee equal to the 
amount paid by You less reasonable depreciation. ECO3 shall have no liability regarding any infringement 
claim arising out of: (i) use of other than a current, unaltered release of the Software; (ii) Use of the 
Software in combination with non-ECO3 software, data or equipment, if the infringement was caused by 
the Use of such combination; (iii) any modification or derivation of the Software not specifically authorized 
in writing by ECO3; or (iv) use of third party software. 

8.2 EXCLUSIVE REMEDY. The foregoing states the entire liability of ECO3 and the exclusive remedy for You 
with respect to infringement of any patent, copyright, trade secret or other proprietary right. 

9. CONFIDENTIALITY 

9.1 CONFIDENTIAL INFORMATION. Each party acknowledges that the Confidential Information constitutes 
valuable trade secrets and each party agrees that it shall use Confidential Information solely in accordance 
with the provisions of this Agreement and will not disclose, or permit to be disclosed, the same, directly or 
indirectly, to any third party without the other party's prior written consent. Each party agrees to exercise 
due care in protecting the Confidential Information from unauthorized use and disclosure. However, 
neither party bears any responsibility for safeguarding information that (i) is publicly available, (ii) already 
in the other party's possession and not subject to a confidentiality obligation, (iii) obtained by the other 
party from third parties without restrictions on disclosure, (iv) independently developed by the other party 
without reference to Confidential Information, or (v) required to be disclosed by order of a court or other 
governmental entity. 

9.2 INJUNCTIVE RELIEF. In the event of actual or threatened breach of the provisions of Section 8.1, the non-
breaching party will have no adequate remedy at law and will be entitled to immediate and injunctive and 
other equitable relief, without bond and without the necessity of showing actual money damages. 

10. TERM AND TERMINATION 

10.1 TERM. This Agreement will take effect on the Effective Date and will remain in force for as long as any 
copyright in the Software exist, subject to termination in accordance with Article 9.2

10.2 TERMINATION. This Agreement may be terminated by ECO3 upon written notice to You if (i) You fail to 
pay any undisputed amount due within thirty (30) days after You have been given written notice of such 
non-payment; (ii) You are in material breach of any non-monetary term, condition or provision of Agree-
ment, which breach, if capable of being cured, is not cured within thirty (30) days after You have been given 
written notice of such breach; or (iii) ECO3 elects to do so in accordance with Article 6.1 or 7.1. Except for 
a termination pursuant to Articles 6.1 or 7.1, no such termination will entitle You to a refund of any portion 
of the License Fee. You may terminate this Agreement at any time for any reason by submitting written 
notice to that effect to ECO3. 
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10.3 EFFECT OF TERMINATION. Upon expiration or termination of this Agreement, You shall promptly 
uninstall and return to ECO3 the Software, any derivative works, all copies thereof, including computer 
memory or storage copies, the associated Dongle, all related Documentation and all copies thereof, and any 
other Confidential Information in Your possession. You shall furnish ECO3 with a certificate signed by an 
executive officer verifying that the same has been done. Termination or Expiration will not affect the provi-
sions regarding the treatment of Confidential Information, provisions relating to the payment of amounts 
due, or provisions limiting or disclaiming ECO3's liability, which provisions will survive termination of this 
Agreement. 

10.4 NON-ASSIGNMENT. Neither this Agreement nor any rights under this Agreement may be assigned or 
otherwise transferred by You, in whole or in part, whether voluntary or by operation of law, including by 
way of sale of assets, merger or consolidation, without the prior written consent of ECO3, which consent 
will not be unreasonably withheld or delayed. Subject to the foregoing, this Agreement will be binding 
upon and will inure to the benefit of the parties and their respective successors and assigns. 

11. MISCELLANEOUS 

11.1 WAIVER. Any waiver of the provisions of this Agreement or of a party's rights or remedies under this Agree-
ment must be in writing to be effective. Failure, neglect, or delay by a party to enforce the provisions of this 
Agreement or its rights or remedies at any time, will not be construed and will not be deemed to be a waiver 
of such party's rights under this Agreement and will not in any way affect the validity of the whole or any 
part of this Agreement or prejudice such party's right to take subsequent action. Except as expressly stated 
in this Agreement, no exercise or enforcement by either party of any right or remedy under this Agreement 
will preclude the enforcement by such party of any other right or remedy under this Agreement or that such 
party is entitled by law to enforce. 

11.2 SEVERABILITY. If any provision, or part of any provision, of this Agreement is invalidated by operation of 
law or otherwise, that provision or part will to that extent be deemed omitted and the remainder of this 
Agreement, or applicable attachment, will remain in full force and effect. In place of any such invalid provi-
sion or part thereof, the parties hereto undertake to agree on a similar but valid provision the effect of which 
is as close as possible to that of the invalid provision or part thereof. If the parties fail to agree on such an 
amendment, such invalid term, condition or provision will be severed from the remaining terms, conditions 
and provisions, which will continue to be valid and enforceable to the fullest extent permitted by law. 

11.3 STANDARD TERMS. No terms, provisions or conditions of any purchase order, acknowledgment or other 
business form that You may use in connection with the licensing of the Software will have any effect on the 
rights, duties or obligations of the parties under, or otherwise modify, this Agreement, regardless of any 
failure of ECO3 to object to such terms, provisions or conditions. 

11.4 RIGHT TO AUDIT. ECO3 shall have the right upon its expense to inspect compliance of You with this Agree-
ment, upon a ten (10) working days prior written notice. Such audit shall not be more frequently than once 
per year, during normal business hours by an accounting firm designated by ECO3. In the event such audit 
should reveal a substantial non-compliance with this Agreement, You shall reimburse ECO3 for the full out-
of-pocket costs in respect of any professional charges incurred for such audit or inspection, in addition to 
any other right or remedy available to ECO3 hereunder.

11.5 REMOTE ACCESS. You agree that ECO3 has the right to access Your network for the sole purpose of, and 
to the extent necessary for, supplying support and monitoring services, including processing and retrieving 
data regarding the Software installed at Your premises. 

11.6 AMENDMENTS TO THIS AGREEMENT. This Agreement may not be amended, except by a writing signed 
by both parties. 

11.7 HEADINGS: Headings to the sections of this Agreement are for convenience only and shall not affect the 
interpretation or construction of this Agreement. Use of the singular includes the plural and vice versa.

11.8 ECO3'S PRIOR CONSENT. Unless expressly provided otherwise in this Agreement, any prior consent of 
ECO3 that is required before You may take an action may be granted or withheld in ECO3's sole and 
absolute discretion.

11.9 THIRD PARTY BENEFICIARY. If and insofar parts of the Software are supplied and licensed to ECO3 by 
Other Owners, such Other Owners are third party beneficiaries of this Agreement and are with respect to 
such parts of the Software entitled to enforce directly against You the terms and conditions of this License 
Agreement. 

11.10 APPLICABLE LAW. This Agreement is made in Belgium and shall be governed by and construed in accor-
dance with the laws of Belgium, excluding its rules for choice of law.

11.11 PUBLIC ANNOUNCEMENTS. You acknowledge that ECO3 may desire to use Your name in press releases, 
product brochures and financial reports indicating that You are a customer of ECO3, and You agree that 
ECO3 may use Your name in such a manner. 
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11.12 ENTIRE AGREEMENT. This Agreement (including any addenda hereto signed by both parties) contains the 
entire agreement of the parties with respect to the subject matter of this Agreement and supersedes all 
previous communications, representations, understandings and agreements, either oral or written, 
between the parties with respect to said subject matter.
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About This Reference Guide
This Reference Guide offers you a complete description of the Apogee Client 
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22 INTENDED AUDIENCE
Intended Audience

This document is designed for operators and administrators who will use one of 
the Apogee Client products to create tickets, manage jobs, and configure and 
monitor the Apogee System.

You should be familiar with your front-end workstations, imagesetter, plate-
setter, and PostScript software applications, as well as prepress processing 
methods, printing procedures, and network traffic. If this is not the case, please 
refer to the relevant user or operator manuals.

The Client software should already been installed, as described in the Apogee 
installation documentation.

Apogee Flavors

Prepress
Prepress is an integrated workflow solution allows you to control every 
phase of the printing production process from a single user interface.

Amfortis
Amfortis is a PDF workflow software for packaging converters and 
printers, covering all prepress production tasks.

Asecuri
Asecuri is a high-security printing software solution to cover all 
processes, file intake, validation, imposition, proofing and rendering.

Asanti
Asanti is a workflow software for streamlining and automating large-
format color management and printing processes.
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What’s New in This Version?

Please visit the ApogeeNetwork website and read the release notes for a complete 
overview of the new features in this version of Apogee.

This document contains new or updated information on the following topics:

doc. version 13.1.1 (latest):

 Hot Ticket support for packaging jobs.

 New features in Layout Editor; Custom Station Numbers, Guidelines, Fix 
Bleed Overlaps slicer, measurements tools 

 Color Bar mark for products and sheets

 APOCSV and APOXML support

 Web Production Schemes improvements

 deltaE calculation for Spot Colors

 Sheet Layout Template improvements

 Auto-Layout, Auto-Fill improvements

 Support to open PDF files with various applications

 Support to automatically export Imposition Reports for packaging jobs.

doc. version 12.2.2:

 New features for wide-format jobs, packaging jobs and security printing

 New features in the “Layout Editor” on page 485

 New design and artwork features in the “Product Editor” on page 605

doc. version 12.0.3:

 “WebGrowth Profiles” on page 1146

 “Automate” on page 750

 “Imposition Reports” on page 455
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 Bottling Rules

 “Number-up Schemes” on page 1098

doc. version 11.0.2:

 Create jobs with several products (multi-product feature): see “What are 
Multi-Part and Multi-Product Jobs?” on page 57.

 New Merge Assistant: see “Merging Jobs” on page 210.

 New product types (cut & stack, booklet, step & repeat) for digital printing: 
see “Imposing Digital Products” on page 464.

 Publish jobs to a web portal: see “Publish to ProductionCenter (WebFlow 
service)” on page 287.

 Fully automated, lights-out imposition with Hot Tickets: see “Viewing the 
Hot Ticket Products Tab” on page 265.

 The Raster Compare feature: see “Comparing Results” on page 130.

 A new mark for press density bars: see “Density Bar Details” on page 1061.

 A new tool for creating and editing finishing paths in the Product Editor: see 
“Paths Inspector” on page 631.

doc. version 10.5.4:

 “Troubleshooting” on page 1177

doc. version 10.5.2:

 Vertical shingling (head/foot) when imposing a product: see “Shingling 
Rules” on page 1136

 Product Editor: “Step & Repeat Patterns” on page 616

doc. version 10.0.3:

 Working with images in the “Product Editor” on page 605

doc. version 10.0.2:

 Versioning:
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 Press sheet versions – the ability to combine different product versions 
(e.g. language versions) on the same press sheet: see “Version Setup 
Dialog Box” on page 836.

 Version-specific content in spot colors: see “Color Policy” on page 789

 In Preview: “Multiple product versions” on page 109

 To collate versions: “Keep versions apart” on page 325

 “Renumber Fold Sheets/Book Signatures” on page 409

 “Renumber and Reorder Press Sheets” on page 411

 “What is a PrintSphere Job?” on page 59
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Related Documentation

The following documents can be referred to for further information:

 Apogee Tutorial: This documentation is available in several languages from 
your local ECO3 organization or via the ApogeeNetwork website.

 Apogee Installation Guide: This documentation is provided with your 
installation.

 Apogee Licensing Guide: This documentation is provided with your 
installation.

 Release Notes

 SphereCenter Help: instructions on buying PrintSphere licenses and creating 
users

 PrintSphere Help: instructions on using the PrintSphere file-sharing service

 StoreCenter Help: instructions on how to create online stores with the Store-
Front application

 ProductionCenter Help: instructions on how to use the ProductionCenter 
module and the WebApproval service

 Please visit the ApogeeNetwork website for additional information.
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Starting and Navigating Help

The online Help is viewed in the standard browser set for your operating system 
and uses a responsive design to accommodate a wide range of screen sizes. This 
means that some navigation features may be displayed or hidden, depending on 
the size of the screen you are viewing this documentation on. For example, the 
table of contents may be hidden if you are viewing the documentation on a small 
screen. Use the buttons in the top navigation bar to browse through the 
documentation.

You can view topics in the online Help by expanding the sections in the Contents 
panel and clicking a heading. You can continue to read in sequence by pressing 
the Next button in the navigation tool bar.

As you progress, the hierarchy of each specific topic is indicated at the top of the 
topic pane in the breadcrumb trail. You can click any one of these levels to go 
back to a higher level in the hierarchy.

You can also jump to Related Topics, to additional information within the 
documentation set and to internet sites. All these links are highlighted in red. In 
these cases, you navigate back and forward by clicking the Back and Forward 
buttons on the browser tool bar.

 Starting the online Help

 In Apogee, press F1

OR

Choose Help > Apogee Help.

The online Help opens on the first page.

OR

Choose Help > Icons, Keyboard Shortcuts or Variables to jump directly to 
one of these sections in the Help.

 To open context-sensitive Help

Context-sensitive Help provides specific information about the window or panel 
you are working in. 
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 In Apogee, context-click in a window or a section of a window, or on an icon, 
and click Help at the bottom of the context menu.

OR

Choose Help > What’s This? and click in the panel that you require help for.

The Help opens on the relevant page.

 To view and print the icon, shortcut and variable overviews

1 Choose Help > Icons.

A new browser window opens, containing an overview of all icons.

2 Click the Print button in the top right corner. 

You can use the printed version of the Icon Overview as a Quick Reference 
Card. It is recommended to print the overview on a color printer. 

You can use this same procedure to view and print the Keyboard Shortcuts 
and Variables overviews.

 Illustrations and Animations

Large images have been reduced in size to display properly in the Help topics.
Apogee Reference Guide
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 Hover over an image and if the cursor changes to a hand you can click the 
image to view it full size. Click the X to close the image and return to the Help 
topic.

 Expanding topics

Headings with a triangle are collapsed to provide a better overview of the 
information.

 Click the heading or the triangle to expand the topic.

Search The Online Help has a search-as-you-type feature for finding information 
quickly in the Help topics. The following queries can be made:

 Simple search with a single word: Enter a single word for a list of all topics 
that contain that word.

 Advanced search for all words: For example, enter disk space for a list of all 
topics that contain disk AND space in the same topic. Try to avoid using 
common words such as “a”, “the”, etc. in your search query.
Apogee Reference Guide
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 Advanced search for an exact phrase: For example, enter “disk space” in 
quotes for a list of topics that only contain this exact phrase.

1 If the search box is not visible, for example if you are working on a small 
screen, click the Search button to go to the Search page.

2 Type a word or phrase in the Search box.

The search results appear as you type and the word or phrase are highlighted 
in yellow – also as you type.

3 Click a search result to jump to the topic.

You will see the search term or phrase highlighted in yellow in the topic. You 
may need to expand sections of the topic to see the word or phrase you 
queried.

Search limitations

 Do not ask questions in the search box, only enter your keywords. Enter “edit 
profile” and not “How can I edit my own profile”.

 Search is case-insensitive.

 Search queries must be at least 3 characters. For example, searching for “QR” 
will not produce any results; you should search for “QR codes”.
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Printing Help If you want to print information from the Online Help, two options are available:

 Print individual topics

 Click the Print button in the navigation bar or choose File > Print from the 
browser menu bar.

 Print the whole document

All the information in the Online Help is also provided in a printer-friendly PDF 
document.

1 Click the PDF button in the navigation bar to open a PDF document.

2 Print the whole document or specific sections as required.

This feature is only available if your browser has the Adobe Acrobat plug-in.

NOTE: You may need to set up browser functionality in Adobe Acrobat.

Navigation 
Overview

Show/hide the table of contents

Switch on Google Translate: translations are generated on the fly but may not be reliable

Show/hide the search panel

Previous topic

Next topic
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Conventions

Keyboard and 
Mouse

All key names are shown in capital letters. For example, the Control key is shown 
as CTRL.

Keys are frequently used in combinations or sequences as shortcut keys. For 
example, SHIFT+F3 means that you have to hold down the SHIFT key while 
pressing F3.

The following mouse conventions are used:

Choosing 
Commands

Many of the Apogee Client commands can be selected in several different ways, 
as described below. You should choose the method(s) which best suit your way 
of working. Throughout this Reference Guide, wherever possible we simply 
indicate which Menu item and/or Tool bar button you require.

 Selecting a Menu item using the mouse

Print a PDF of the whole document

Print current topic

Displays a section

Displays collapsible (expandable) text or images

Takes you to the title topic of the online Help

To... Do this...

Click Point to an item, and then quickly press and release the mouse 
button without moving the mouse.

Double-click Point to an item, and then quickly press and release the mouse 
button twice.

Context-click on Windows Click the right mouse button.

Drag Point to an item. Press and hold down the mouse button as you 
move the mouse to a new location, then release the mouse but-
ton.
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The Apogee Menubar is available in each of the Client windows, and is 
organized according to the commands you will need. In Windows, the menus 
or sub-menus change in accordance with the currently selected Apogee 
window. Menu items are disabled when they are not applicable, and the 
menu item texts reflect the currently selected item.

 Context-clicking an item

A context menu is often a subset of the global Apogee menu items. It contains 
only those items that are applicable to the selection. The way you activate a 
context menu varies according to the platform you are working on (see 
“Conventions” on page 32). For a complete summary of all available context 
menus, refer to “Context Menu Commands” on page 1253.

 Clicking a Tool bar button

The Apogee Tool bar also offers a subset of the Menu bar commands. The 
Tool bar is defined per window to offer the most frequently used commands. 
It may also include disabled tools.

 Entering a Shortcut key combination

Some commands can be selected by entering only a shortcut key 
combination. Where available, these items are displayed next to the 
commands in the menus.
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1 Welcome to Apogee

This section introduces the Apogee System, and highlights its main innovations 
and features. Apogee is the latest generation of ECO3's acclaimed workflow 
system for commercial printing. This system allows you to automate and 
distribute prepress processes using JDF, PDF and Digital Film in an integrated 
all-digital workflow. The system also includes rules-based imposition with the 
Apogee Impose module. 
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36 WHAT IS APOGEE?
What is Apogee?

Apogee is a fully integrated, digital workflow solution that brings together a 
wide range of sophisticated, easy-to-use capabilities in a single application. 
Apogee uses a client/server architecture, and consists of:

 The Apogee Server, which runs on a dedicated 64-bit Windows Server, and 
manages all data and processing functionality.

 An optional Apogee Satellite, which runs on a dedicated 64-bit Windows 
Server, and provides additional processing capacity to increase your total 
production speed.

 The Apogee Client application, which allows you to access and control the 
Apogee Server remotely from any Windows PC or  on the network.

The Apogee System The Apogee System handles all resources, processes, and events, and acts as the 
centralized database of job and system data. The System provides feedback on 
system events and job processes to all Clients that are currently logged in. All 
interaction with the Apogee System is performed via the Client application. 
Refer to the Installation Guide for detailed system requirements.

The Apogee Client The graphically rich and intuitive Client user interface adopts a highly visual 
design approach, using icons to represent elements in the system and in your 
workflow. A set of tools and commands allows you to control and interact with 
all aspects of job production.
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The Apogee Client can be installed on any PC system connected to the network. 
Using the Client, you can configure, monitor and control the system settings, 
and create customized input and processing channels for your jobs. You can also 
use the Client to communicate securely with an Apogee Server over a VPN 
(Virtual Private Network) connection.

Apogee Product 
Flavors

Depending on what you have purchased, your Apogee solution will comprise 
one of the following product flavors, possibly enhanced with one or more of the 
available options:

 Apogee Render

 Apogee Control
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 Apogee Manage

 Apogee Integrate

 Apogee PlateMaker

 Apogee Proof

 Apogee PDF&Proof

 Apogee PlateMaker LE

 Apogee Bridge

 Apogee InkTune
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Ticket Editing

You can choose the type of ticket that best suits your workflow:

 Standard Job Tickets for single jobs.

 Reusable Hot Tickets for repeat jobs.

You can create these tickets yourself, or you can choose from a selection of 
ready-made ticket templates which are directly accessible from the Ticket 
Editor.

You can edit Job Tickets directly from the jobs you see in the Job List.
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Basic Workflow

A typical Apogee workflow is as follows:

1 Create Ticket (including input channel)

You start any workflow by creating or editing a Ticket. The Ticket defines an 
input channel, and describes exactly how all documents received will be 
processed and output by Apogee.

NOTE: You can set up one or more input channels for the same ticket (Hot 
Folders, AppleTalk channels, JDF channels, etc.), and output consistently to 
a wide range of imagesetters, platesetters, and proofers.

2 Input document(s)

You input your documents to the predefined input channel. Typically, these 
documents are PostScript, PDF, EPS, MIME, TIFF or JDF format files. You 
either copy these files to a Hot Folder input channel, or print them to a 
predefined printer queue (AppleTalk, Named Pipe, etc.). If you are working 
in the Layout Editor, you will probably want to input images: PNG, JPG, BMP, 
PSD and AI.
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Apogee automatically processes any input document or images according to 
the parameters specified in the Ticket. The result of this processing is a job.

3 Check job results

You can check your job results either onscreen, or by outputting them to a 
Proofer.

4 Approve job for output

If the job results are satisfactory, you can approve them for output to an 
output device.
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What Are Job Tickets?

A Job Ticket is a file you create using the Job Ticket Editor. A Job Ticket defines 
how the pages of a single job are to be assembled, the processing features to be 
used (imposition, separation, trapping, overprinting, rasterization, etc.), and 
the output device to which the rendered job will be sent. 

A Job Ticket is always associated with one or more unique input channels (Hot 
Folders, AppleTalk Channels, etc.). When a user sends a document to one of 
these input channels, the Apogee System attaches the corresponding Job Ticket 
to it. The input document and the Job Ticket are combined to become a single 
Job.

When should you use Job Tickets?

You should use Job Tickets in workflows that are subject to lots of changes, or 
when you want to process jobs that are made up of several different documents. 
These documents can be combined in a single job by dragging the required pages 
from the Page Store to your Run List. You need to create and manually submit a 
new Job Ticket for every new job. 

If you print a weekly magazine, it is recommended that you use standard Job 
Tickets. This is because you will probably have to create an imposition for 
different document types (advertisements, articles, etc.). The page count and 
content will also probably vary from week to week.
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What Are Hot Tickets?

You create Hot Tickets using the Hot Ticket Editor. A Hot Ticket defines how 
multiple jobs are to be assembled and processed. Unlike a Job Ticket, which can 
create only a single job, a Hot Ticket can create multiple jobs on demand.

When you input a document to a Hot Ticket input channel, the Hot Ticket 
duplicates its ticket, then creates a job by filling in the pages from the input 
document, and automatically submitting it to the Apogee System. A job created 
from a Hot Ticket does not therefore require any manual Run List editing.

A Hot Ticket always remains active, and automatically processes any documents 
that are input via the associated input channel. Each of these documents 
becomes a new job, containing the input document plus a Job Ticket based on 
the Hot Ticket settings. However, the original Hot Ticket itself does not become 
part of the job, and remains unchanged.

When should you use Hot Tickets?

Hot Tickets automate the job creation process, creating multiple jobs on 
demand. If your jobs always have the same parameters, you can use a single Hot 
Ticket to create as many jobs as you need.
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How Are Jobs Created?

To create a job, you must first create a ticket and select or set up one or more 
input channels. 

 With Job Tickets, the job is created as soon as you successfully submit the Job 
Ticket. At this point, the job becomes visible in the Job List. Initially, the job 
only contains the Job Ticket. 

 With Hot Tickets, the job is not created until a document has been input 
through the associated input channel.

Each document you send through one of the jobs' input channels is processed 
and becomes part of the job. The processing results also become part of the job, 
together with logging data which indicates exactly how the job has been 
processed. A job may therefore comprise:

 a Job Ticket (required)

 the document(s) to be printed

 the intermediate and/or final job results (optional)

 log information
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What Is a Production Plan?

You create and modify Production Plans using the Ticket Editor. A Production 
Plan is a series of components (Task Processors and Actions) linked together to 
form one or more processing flows. These components can be configured to 
define exactly how jobs are to be input, processed, and output.

A Production Plan consists of at least one Main processing flow, but you can 
include as many additional flows as you require. Each flow leads to a unique 
output device.

To build your Production Plan, you simply drag the components you require to 
the Production Plan pane, and connect them to other components. The order 
and the types of connections are governed by specific rules. Once all the 
components are in place, you can customize each of them in turn by selecting 
one of a series of predefined settings.

The Production Plan pane provides a graphical overview of your Plan, which can 
be quickly assembled and modified.
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What Are Task Processors?

Task Processors are software components that perform one or more tasks 
(specified by the Ticket), such as input via Hot Folder, Normalization, Preflight, 
Trapping, Rendering, etc.

A sequence of Task Processors can be linked together to form a Production Plan.

Task Processors are divided into four categories:

 Input Task Processors

 Processing Task Processors

 Output Task Processors

 Print Task Processors

What Are Task 
Processor Settings?

Each Task Processor has a default group of settings, which determine how it will 
handle incoming data. When you add a Task Processor to your Production Plan, 
you can modify these settings for this particular ticket.

You can also create and save your own customized versions of these settings 
files, in which you can modify how the Task Processor will operate. These 
customized settings are referred to as Parameter Sets. When you add a Task 
Processor to a Production Plan, you can select any Parameter Sets which may be 
available.

Some Task Processors are multi-functional and require a large number of 
settings. For practical reasons, these settings are grouped according to their 
functionality. For example, The Render Task Processor comprises Trapping, 
Separation, Processing and Screening, each of these functions having their 
respective settings. 

What Are Task 
Processor 
Parameter Sets?

Each Task Processor is installed with initial settings which are automatically 
assigned by Apogee, and cannot be changed or deleted. However, you can define 
additional groups of settings based on the initial settings, and save them under 
different names. These are referred to as Parameter Sets. 
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You can create as many Parameter Sets as you need, and manage them from the 
System Overview window. To do this, you select a Task Processor, and then click 
the Settings icon:

Parameter sets can also be created and managed directly from the Ticket Editor. 
When you first access a Task Processor’s settings, you will see only the factory-
default “initial settings”. You should define additional Parameter Sets based on 
the initial settings, and set one of them as “default”. In future, whenever you add 
this Task Processor to a Production Plan, it will always automatically select the 
default Parameter Set that you specified. However, you can still click on the list, 
and select any other Parameter Set that may be available.

NOTE: The factory-default “initial settings” cannot be deleted.

For detailed information on the settings of a particular Task Processor, open the 
System Overview window and access the Help information. You can do this by 
selecting the Task Processor, context-clicking the Settings icon in the Resources 
pane, and choosing Help from the context menu.

What Is a Task 
Processor 
Configuration?

Each Task Processor has a default configuration that is automatically assigned 
by Apogee. If you have Service access rights, you can view and modify these 
configurations using the Configuration icon in the System Overview window.

The Configuration icon is the first icon displayed in the Resources pane of the 
System Overview window. You can double-click this icon to view or modify the 
configuration of the currently selected Task Processor.

If you have Administrator access rights, you can view and modify the 
configurations of the Generic Devices and Export Task Processor, as well as some 
settings for the Press Task Processor. If you do not have any of the necessary 
access rights, the Configuration icon is hidden from view.
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For detailed information on the configuration of a particular Task Processor, 
open the System Overview window and access the Help information. You can do 
this by selecting the Task Processor, context-clicking the Configuration icon in 
the Resources pane, and choosing Help from the context menu.

What Are Actions?

Actions allow you to precisely control the flow of job data through a Production 
Plan, and keep track of your job results at every point in the processing chain.

Once you have built up a valid Production Plan, you can insert Actions between 
each step in the Plan. When one of these points is reached during job processing, 
an event is triggered. For example, the job results may be archived, or the flow 
may be temporarily halted until specific criteria have been met.
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What Are Resources?

Resources are collections of objects (such as fonts, preflight profiles, or 
calibration curves) that are required by selected devices or Task Processors. By 
default, Apogee provides you with some basic resources for each of the available 
Resource categories. However, you can also add your own resources to those 
supplied. 

You can view the Resource categories by switching to the System Overview 
window. Here, the Resource categories displayed depend on the selected Task 
Processor.

What is a Page Store?

A Page Store is a repository of pages available for a single job. When you input 
documents to Apogee, the document pages are stored in the Page Store 
associated with the job input channel you selected.

A Page Store is automatically generated for each job created. You can view the 
content of a Page Store by selecting a job in the Job List and then selecting the 
Pages tab.

This type of Page Store is sometimes referred to as a “Private” Page Store, to 
differentiate it from a Public Page Store.

1 Page Store

1

Apogee Reference Guide



52 WHAT ARE RESOURCES?
What is a Public Page Store?

A Public Page Store is a repository of pages available for all jobs. To create a 
Public Page Store, you need to create a job based on the Public Page Store job 
template. Any documents or pages that are input via the Public Page Store input 
channel will then appear in the Pages tab, and will be available for all jobs.

A Public Page Store can be viewed and accessed by all users. You can consider it 
as a central repository of documents ready to be processed.

1 Public Page Store

1
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What is a Proof?

A Proof is a set of job results produced before the final results are output to a 
platesetter or imagesetter. This allows you to verify and correct different aspects 
of a job before submitting it to press.

In Apogee, we can distinguish several different types of proofs, each with their 
own purpose:

 Page Proof: A Page Proof allows you to check the content and color 
reproduction of specific pages (color proofs should closely match the 
expected press print output). In many cases, you may not want to proof all 
pages, and you may not need an imposition scheme. Instead, you may simply 
want to pack as many pages onto a flat as possible.

 Imposition Proof: An Imposition Proof allows you to check that the chosen 
imposition scheme correctly produces the required result after folding and 
cutting. This is most commonly used to check a new imposition scheme.

 Production Proof: A Production Proof allows you to check job content and 
page order. This gives you a good idea of how the final result will look, but 
may use a different imposition scheme than the final result.

There are three ways of viewing any type of proof:

 Hard Proof: This method outputs the proof to a physical proofing device, 
such as a Sherpa proofer.

NOTE: Hard Proofs can also be viewed as Soft Proofs.

 Soft Proof: This method does not physically output the proof to a printer. 
Instead, the job data is displayed on-screen. There are two types of Soft 
Proof:

 PDF Proof: A PDF Proof allows you to check PDF job results (flats or 
pages) on-screen, before the job is rendered. No physical output results 
are generated. One or more PDF Proofs can be included in your 
Production Plan. This allows you to view the intermediate job data at 
different points in the flow.

 Digital Film Proof: A Digital Film Proof allows you to check the raster job 
results (flats or pages) on-screen, after the job has been rendered. No 
physical output results are generated. You can view 8-bit contone data, 
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and zoom in to view the more detailed 1-bit high resolution data (each 
raster point is represented by a single display pixel).

 Color-Managed Display Proof: This method displays the job data on-screen in 
Raster Preview. However, in this case you have a preview of the rendered 
result using color management to convert the press color space to the 
monitor color space based on ICC profiles. With a calibrated monitor 
environment and correctly configured monitor profile, contract-proofing 
quality should be achieved. 

You activate the color-managed preview by pressing the color managed 
preview button in the toolbar of the preview pane, or selecting its View-menu 
equivalent. By default the color managed preview mode is idle.

This is a licensed feature.
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What is Versioning?

The Versioning feature allows you to create jobs which contain several different 
versions, typically for some or all of the text (for example, using different 
languages or prices), and to choose the optimal set of plates to be made. If, for 
example, you want to publish a brochure in six different languages, you can 
include the Versioning Task Processor in your Production Plan, and then print 
several different language versions of the brochure using a single job. The basic 
Production Plan is straightforward, using a Versioning Task Processor instead of 
a Run List Task Processor, allowing you to optimize the usage of plates to 
produce the versions.

Versioning can also be used in a Production Plan which contains a Main flow and 
a Digital Film Proof flow. This set-up is meant to generate accurate proofs of the 
different plate versions before assembly and output. This ensures optimal usage 
of resources and media.

NOTE: Versioning is an evolution of the Run List. Most of the features and 
behavior of the Run List are present in Versioning.

A Simple 
Versioning 
Example

Suppose you want to print an 8-page brochure in English, French and Dutch. 
Since only the text is different, the differences between the three versions are in 
the K plate. The English version (V1)is the reference version, from which the 
CMY plates are to be generated (and of course the K plate). From the French 
(V2) and Dutch (V3) versions, only the K plate is imaged and later mounted on 
the press instead of the English K plate. 

Therefore, the printer needs to print the CMY plates only once, and then 
combine them (during printing) with the 3 different K plates: 

 CMY:(common) + K:version1 (English)

 CMY:(common) + K:version2 (French)

 CMY:(common) + K:version3 (Dutch)

So, the run list has two layers:

 The first layer holds pages containing the background graphics. This layer 
provides the common graphics for all three language versions. 

 The second layer contains the three version-specific variations of the “black-
text” (English, French and Dutch). 
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Multiple Versions 
on a Press Sheet

To fill the press sheets of very large presses, you can place multiple instances of 
the same fold sheet or different fold sheets on the same press sheet. For 
versioning jobs, you can use this feature to put different product versions (e.g. V1 
for French and V2 for Dutch) on a single press sheet and reduce the number of 
required plates even further. In this case, the system will generate corresponding 
press sheet versions (SV1, SV2, etc.). You control the sheet versions in the Version 
Setup dialog box which is accessed from the Plates tab of the Versioning task 
processor in the production plan. See “Version Setup Dialog Box” on page 836.
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What are Multi-Part and Multi-Product Jobs?

Each Apogee job has at least one print product. A product may consist of one part 
or multiple parts which are printed as a single job. In these cases we distinguish 
two types of jobs:

 Single-part jobs: A single-part job uses the same settings for the entire job: It 
has a single job name, single order number, single production plan with job-
global parameter values, single unstructured run list, single version per 
sheet, and the same number of pages per version.

 Multi-part jobs: A multi-part job is more complex and typically comprises a 
number of sections (cover, editorial, sports section, etc.) each with different 
properties (paper type, color or B&W, binding style, number of colors, etc.). 
Additionally, different sheets may be printed on different presses, and so on.

A single Apogee job can also combine several print products with the intention 
of optimizing printing operations. For example, you may want to combine the 
covers and body parts of multiple products and print them together on a specific 
press. These jobs are referred to as multi-product jobs. A multi-product job is 
either created from scratch to combine several products in one job or can be the 
result of merging existing jobs into a single multi-product merged job.

NOTE: More than one product is not allowed for WebApproval jobs.

Refer to “Using the Products Tab” on page 295 and “Merging Jobs” on page 210 
for more information.

What is a WebApproval Job?

WebApproval is a web-based proofing service that gives users (your customers’ 
staff or your own staff) remote access to jobs for uploading documents, 
reviewing proofs, and approving pages.

Refer to the ProductionCenter Help for instructions on how to use the 
WebApproval service in the ProductionCenter application.

Related topics: • WebApproval Job Tickets on page 367
Apogee Reference Guide

https://apogee.agfa.net/Resources/Help/WebApproval_13.0_OLH_en/index.html


58 WHAT ARE MULTI-PART AND MULTI-PRODUCT JOBS?
What are Apogee Impose Jobs?

Apogee provides several solutions for imposition jobs. The integrated Apogee 
Impose module is an intelligent, rules-based imposition editor for the imposition 
of bound and unbound products, on sheet-fed as well as web presses. Apogee 
Impose arranges the pages of a job for imposition and places all the required 
marks on the press sheet.

Refer to “Working with Apogee Impose” on page 369 for more information.

What is Document-Based CMS?

Document-based color management uses input and output conversion presets to 
perform color management conversions on incoming documents. The color 
values of the document output intent are converted to values for the actual press 
output. The document output intent may be present in the document or you can 
choose to tag the input colors of the document using an Apogee preflight action 
list.

Refer to the following sections for more information about this feature:

 “Document-Based Color Management settings” on page 796

 “Apogee Preflight Action Lists” on page 943

 “Input Color Conversions” on page 1030

 “Output Color Conversions” on page 1103

 “SISR Profiles” on page 1142

What is the Layout Editor?

The Layout Editor is a workspace which has been specially designed to prepare 
layout jobs and use effective color management for printing on Sign & Display 
devices. It can also be used to create the layout for Unbound Single-Sided 
products in regular jobs.

Refer to “Layout Editor” on page 485 for more information about this feature.
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What is the Product Editor?

The Layout Editor includes the Product Editor, a dedicated workspace for 
editing the images you upload in the Layout Editor.

Refer to “Product Editor” on page 605.

What is a PrintSphere Job?

A PrintSphere job includes a PrintSphere Upload task processor as input in the 
plan. PrintSphere is a cloud service hosted by ECO3 that allows easy file transfer 
between the different collaborators of a job: customers, designers, remote sites, 
etc. For such jobs, you can invite an uploader to upload files for the job at hand, 
or collaborators can be assigned to the job when you select the company.

Refer to “Inputting via PrintSphere” on page 360 for more information about 
this feature.

What is WebFlow?

The WebFlow service lets you publish jobs to the ProductionCenter web portal 
where they can be managed by your internal users.

Refer to “Publish to ProductionCenter (WebFlow service)” on page 287.
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Starting the Client

To start the Client, you need to open a session with the Apogee System. A session 
is a continuous series of user interactions between the Client application and the 
Apogee System. You need to log in to a secured session before running certain 
portions of the application. Each successive interaction in the session is tracked 
and recorded by Apogee. 

 To open a new Apogee session

1 Do one of the following:

 PC users: Choose Start > Programs > Apogee > Apogee Client.

 Double-click the Apogee Client icon on your desktop.

The Apogee Logon dialog box appears.

TIP: PC users can add the 
Client icon to the Windows 
taskbar to start the Apogee 
Client even quicker.

2 Type your user name/password in the appropriate text boxes.

The user name must be a valid Windows account on the Apogee server on 
your network. Add a domain prefix (e.g. domain\username) if the server 
name is different. User names cannot be configured in the Apogee Client.
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3 Select your Apogee System from the list.

If you do not know to which system you should connect, ask your Apogee 
administrator.

4 Select the ‘Connect to selected system at startup’ check box. 

The next time you start the Apogee Client, the Logon dialog box will be 
bypassed. You can reset this option in your Preferences. For more 
information, see “Logging On” on page 93.

NOTE: If you have a DNS server, you can connect using the server host name. 
This is recommended for complex networks such as multiple networks, VPN, 
etc. Click the cogwheel and select the option.

5 Click Log On.

The Apogee Client is started, and a connection is made to the selected Apogee 
System. The Jobs Window is then displayed.

 To view network information

You can view network information to troubleshoot network issues when logging 
on.

1 Start the client and click the cogwheel in the Logon dialog.

2 Choose View Network Information.

The Network Information dialog is displayed.

3 Enter the server credentials and a client-server connection test is performed.

The information for the selected Apogee System is displayed with warnings 
and errors if the connection fails.

4 Click OK to close the Network Information dialog.

Adding/Removing 
Apogee Systems

Additional Apogee Systems may be available on your network but may not be 
visible. This happens when the Apogee Client and Server applications are not 
installed on the same network segment, but are connected via a router. In order 
to access these Apogee Systems, you first need to manually add them to the list 
of systems displayed in the Logon dialog box. To do this, you must know the IP 
address of the Apogee System you want to add.

 To manually add an Apogee System

1 Start the Client.
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NOTE: If the Client is already open, choose File > Log Off to access the Logon 
dialog box. You will have to close your current System connection.

2 From the Apogee Logon dialog box, click the cogwheel button and choose 
Add System.

The Add System dialog box is displayed.

3 Enter the Apogee System IP address or host name, and click Find.

The Client starts to search for the specified system on your network. When it 
is found, the system name is displayed in the dialog box.

4 Click Add to add this system to the list,

 To remove an Apogee System

1 Start the Apogee Client.

NOTE: If the Client is already open, choose File > Log Off... to access the Log 
on dialog box. You will have to close your current System connection.

2 Select the Apogee System you want to delete from the list, click the cogwheel 
button and choose Delete System.

NOTE: You can only remove Systems that were added manually, as described 
above.

3 Click OK to confirm this operation.

The selected system is removed from the list.
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The Management Windows

The Apogee Client includes three management windows:

 The Jobs Window, for viewing and managing jobs.

 The Hot Tickets Window, for viewing and managing Hot Tickets.

 The System Overview Window, for viewing and configuring the system 
components (Task Processors and Resources), managing the Apogee System, 
and managing individual Task Processor activities.

You can switch between these three windows using the Navigation Bar, which is 
located at the bottom of each window.

The Jobs Window The Jobs Window gives you a complete high-level overview of your workflow. In 
a single window, you can see the complete list and status of jobs in the system 
and the output devices that are available. 

You can track the progress and activity of jobs, and view information about 
specific processing parameters. Powerful viewing features let you preview 
rasterized jobs. This allows you to check trapped, imposed, and screened 
bitmaps before imaging a proof, film, or plate. A Message Board keeps all users 
up to date about jobs that require attention.

You can also interact with the displayed information. By context-clicking jobs 
you can set priority handling for rush jobs, hold and resume jobs, approve or 
reject jobs, resubmit jobs, process quick remakes, or open the Ticket Editor.

The Hot Tickets 
Window

This is where you monitor, view, and manage the Hot Tickets that are created by 
the Apogee System. Unlike Job Tickets, which appear in the Jobs Window 
together with the jobs they are used to create, Hot Tickets appear only in the Hot 
Tickets window.

Hot Tickets comprise only 3 tabs: Administration, Options, and Plan. There are 
no Pages or Results tabs.

 There is no Pages tab because Hot Tickets do not require Run Lists to specify 
which pages make up the job: The Run List is generated automatically, based 
on the number of pages in the input document. 

 There is no Results tab because Hot Tickets are never associated with the 
results of a single job: Hot Tickets are used to generate multiple jobs.
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Jobs created by Hot Tickets appear in the Jobs List, together with the jobs 
created by Job Tickets.

The System 
Overview Window

The System Overview provides centralized system management, allowing you 
to monitor key components and tasks. 

Exactly what you will see in the System Overview window depends on your 
Access Level, as specified in your Preferences. However, all users can view and 
configure workflow and process settings, including input channels, normalizing, 
preflighting, screening, trapping, rendering, and output options.

If you have the necessary Access Level, you can also view and configure the 
following system elements for optimal performance:

 Global system settings, such as archiving, logging and administration.

 Any available processing resources, including fonts, screens, calibration 
curves, imposition profiles, ICC profiles, and more. 
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The Ticket Editor

Efficient and complete job ticketing capabilities are at the heart of Apogee. You 
can import job tickets (via JDF), retrieve them from a ticket database (ticket 
templates), or create new ones of your own.

Ticket Editing is an interactive, flexible process that lets you define a complete 
Production Plan - including normalizing, preflighting, PDF trapping, imposition, 
rendering, and integrated proofing. 

Apogee’s Production Plan introduces a multi-flow concept, allowing you to 
define several flows (both input and output) in a single Ticket.

You can access the Ticket Editor from any of the Management windows (see 
“Creating or Editing a Ticket” on page 340). 

There are two types of Tickets: Job Tickets and Hot Tickets. The Ticket Editor 
allows you to create and edit both types. However, when you create or edit a Hot 
Ticket, you do not need to specify page and result options. This is because:

 Hot Tickets do not require Run Lists to specify which pages make up the job: 
The Run List is generated automatically, based on the number of pages in the 
input document. 

 Hot Tickets are never associated with the results of a single job: Hot Tickets 
are used to generate multiple jobs.

The jobs that are created using these Tickets appear in the Jobs List.

Apogee also includes a dedicated module for creating an imposition which is 
called Apogee Impose. This module is accessed from the Products tab of the 
Ticket Editors. Refer to “Working with Apogee Impose” on page 369 for more 
information on the main imposition windows.
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Work Area Commands and Indicators

The Client contains a number of global tools and indicators that are accessible in 
some or all of the main and editing windows.

 Menus

 Toolbar

 Navigation Bar

 Message Indicator

 Tab Area

 Preferences

Related topics: • Working with Apogee Impose on page 369

Menus The Apogee Menubar is available in each of the main Client windows. It includes 
the following menus:

 File Menu

 Edit Menu

 Control Menu (Not available in System Overview)

 Processor Menu (Available in System Overview only)

 View Menu (Not available in System Overview)

 View Menu for Raster Preview

 Window Menu

 Help Menu

NOTE: See “Layout Editor Menus” on page 597 for information on the Layout 
Editor menus.
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Not all items included in these menus are available in every window. The active 
menu or sub-menu items vary according to the window you are working in. This 
is especially the case for the Apogee Impose module; see “Menus” on page 460.

TIP: Some of the menu options can be accessed more quickly by context-clicking 
on jobs in the Job List, and selecting an item from the context menu.
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File Menu

This menu provides commands that apply to sessions (logging in and out), and 
documents (job tickets and archives).

File Menu Item Description

New from Templates Opens the Ticket Template dialog box. When used from the Hot 
Tickets window, the Tickets tab is shown and the default Hot Ticket 
template is selected. Otherwise, the Jobs tab is shown and the 
default Job Ticket Template is selected.

New Default Job/Hot 
Ticket

Opens the Ticket Editor with the default Ticket Template selected.

New From Selected Opens the Job Ticket Editor with an empty Administration tab but 
with the same plan, imposition, etc.

New Wide Format Job/
Hot Ticket

Opens the Layout Editor.

Create StoreFront Hot 
Ticket

To create a hot ticket for integration with the web-to-print 
application.

Open Allows you to select and open a previously saved ticket (*.ajt). 

Save Saves the current ticket (Ticket Editor only).

Save As Allows you to save the ticket with a different name (Ticket Editor 
only).

Save As Template Allows you to save the ticket as a Ticket Template.

Close Closes the current window. 

Upload Document Allows you to add a file or a folder containing files to a job, Hot 
Ticket or Public Page Store. When you upload a folder, Apogee 
uploads all files and folders in that folder recursively. The uploaded 
folder appears as a subfolder in the Page Store.

Submit Job Submits a new Ticket to the Apogee System (Ticket Editor only).

Submit Changes Submits the changes you have made to an existing job (Ticket 
Editor only).

Archive Job Allows you to choose a location and file name in order to archive 
the selected job.

Import Job Archive Allows you to select and restore a previously saved job archive 
(*.arch) or create a new job from a selected archive.
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Export • <selected item> From - Exports the item from a selected point in 
the flow (Latest, Run List, Normalize, etc.).
Document - Saves a PDF document outside Apogee, where the 
document can be edited, and then dragged back into Apogee 
(Page Store PDF files only).

• Export Folder - Exports the selected folder.
• Job Dump - Similar to Archive Job, but only accessible by 

administrators for troubleshooting purposes (only for jobs, not for 
Hot Tickets).

• Export Job Log - Exports the log file for the selected job.
• Export CAD Files: Exports the current original CAD file without any 

changes you may have made.
• Export System Log (System Overview only) - Exports the log file for 

the selected Apogee System.
• InkDrive - Exports the InkDrive files for the selected job (only 

available when the job has InkDrive files).
• Imposition Layout - Exports the Imposition Layout and Marks files 

for the selected job (only available when the job has received 
layout information 'from Input').

• Output Device PPD - Creates a PPD file for the selected output 
device.

• Hot Ticket PPD - Creates a PPD file for the selected Hot Ticket.

Open in 
ProductionCenter

Opens the selected job in the ProductionCenter web application.

Check Consistency • Checks Ticket Templates and/or Hot Tickets for changed 
parameter sets and job resources. Any out-of-date references can 
be updated, and are listed in a Consistency report. This option 
requires Administrator access level.

Open in Production 
Dashboard

Opens the selected job in the Production Dashboard web 
application

Log on / Log off Allows you to log on to an Apogee System, or to log off from one. 
When logging on, the Connect to System dialog box is displayed. If 
you are already logged on to an Apogee System, you are asked to 
confirm before proceeding. Note that Log on always ignores your 
“automatically log on” preference.

Quit / Exit Closes the Apogee Client .

File Menu Item Description
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Edit Menu

This menu allows you to find, select, and edit job items. In Windows, you can 
also access the Preferences from here.

Edit Menu Item Description

Undo / Can’t Undo Undoes the last Cut, Copy, or Paste operation (only enabled when 
editing).

Cut Deletes the selected text, and copies it onto the clipboard.

Copy Copies the selected text onto the clipboard.

Paste Pastes the contents of the clipboard at the selected location.

Delete <selected item> Deletes the current selection.

View Item From Displays the selected item using the default viewer. You cannot edit 
the item.

Edit <selected item> Displays the selected item using the default editor, where you can 
modify the item.

Edit Imposition Opens the selected item in the main Apogee Impose window.

Duplicate Job Duplicates the selected job.

Create Versions Opens the Create Versions assistant. 

Merge Jobs Merges the selected jobs.

Rename Renames the selected item.

Select • All - Selects all items in the current view.
• Even Positions - Selects all even placeholders/pages (Page Store 

Only).
• Odd Positions - Selects all odd placeholders/pages (Page Store 

Only).
• Empty Positions - Selects all empty placeholders (Page Store 

Only).
• Different from Expected - Selects all pages in the Run list which 

have a different size from the expected page size specified in the 
job.

• Fronts - Selects all front sides when the view is set to “Fronts and 
Backs” (Results tab only).

• Backs - Selects all back sides when the view is set to “Fronts and 
Backs” (Results tab only).

• Flat - Selects flat (both front and back sides).
• Signature - Selects all sides in the signature when the view is set 

to “Fronts and Backs” (Results tab only).

Find • <Page> in Page Store - Allows you to select a page in the Run List 
or Page Layout pane, and then find the selected page in the Page 
Store.

Adapt Part’s Page Size • Sets the finished trim size of a Product part to match the pages in 
the Run List. Pages need to be assigned in the Run List.
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Control Menu

This menu allows you to control the processing of jobs, results and Task 
Processors. These items are active only after you have selected a job in the Job 
List. This menu is not available for the System Overview.

Page Adjustments • Offset By... - Allows you to adjust the offset of the selected page(s) 
or placeholder(s).

• Scale By... - Allows you to adjust the scale of the selected page(s) 
or placeholder(s).

• Rotate By... - Allows you to adjust the rotation of the selected 
page(s) or placeholder(s).

• Edit / View - Opens the Adjustments dialog box for the selected 
page(s)/placeholder(s). If you are not editing the job, the 
Adjustments dialog box is read-only.

• Clear - Deletes all page adjustments.

Placeholder • Insert... - Allows you to insert or append placeholders.
• Remove... - Removes the selected placeholders from the Run List 

(disabled when there are no blank pages in the selection).
• Make Blank - Puts a blank page in the selected placeholder(s).

Reverse Page Order Reverses the page order of selected pages placed in the Run List.

Preferences Opens the Preferences .

Control Menu Item Description

Rush Job Upgrades the selected job to a Rush job.

Hold <selected item> Suspends all processing of the selected job(s), result(s) or Task 
Processor(s) after the current activity for the items has been allowed 
to finish. This option is disabled if all items are already on hold.

Resume <selected item> Resumes processing of the selected job(s), result(s) or Task 
Processor(s) This option is disabled if all items are already running.

Continue <selected 
item>

Continues all or part of a job that has stopped. The job may have 
stopped because it has reached a hold Action in its Production Plan, 
or because it has been aborted, rejected, or in error.

Clear and Rebuild Run 
List

Used in Versioning jobs to remove all pages from the Run List, then 
rebuild it using the version names available in the input documents.

Reject <selected item> Rejects the selected item(s). All processing will be stopped for the 
rejected item(s).

Stop Plating Stops the plating process (only available for PrintDrive jobs).

Clear Rejected Status Removes the rejected status from a previously rejected job, and 
restarts processing.

Discard Prevents specific pages, flats or separations from being printed, 
without stopping the rest of the job from being printed. Available 
only when the items are waiting on a Hold action or when finished.

Edit Menu Item Description
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Processor Menu

This menu allows you to control the operation of Task Processors (System 
Overview only).

Include Includes discarded items.

Re-render <selected 
item>

Remakes all the existing job results which follow the selected point 
in the Production Plan. You may want to re-render a job if you have 
changed your resources (new fonts, color books, etc.) or if you want 
to remake aborted results, or remake output when no raster data is 
available.

Re-image <selected 
item>

Remakes previously imaged raster data (Digital Film) on your output 
devices. This feature is available only for flows that have an imaging 
output device and finished raster data.

Re-export <selected 
item>

Re-exports previously exported results (when resources have 
changed or exported files have to be recreated).

Re-print <selected item> Remakes previously imaged raster data (Digital Film) on a digital 
press. This feature is available only for flows that have a digital 
press and finished raster data.

Restart Job Processing At Restarts processing the selected items from a point in the flow. Jobs 
offer the full list of Task Processors from the main flow: Documents 
only offer the Task Processors up to and including the Run List.

Enable Inputs Re-activates all input channels for the selected job(s) or Hot 
Ticket(s). By default, input channels are enabled. This option is 
disabled if all job(s) or Hot Ticket(s) have their inputs enabled.

Disable Inputs De-activates all input channels for the selected job(s) or Hot 
Ticket(s). This option is disabled if all job(s) or Hot Ticket(s) have 
their inputs disabled. A Ticket cannot produce any jobs while 
disabled.

Mark as Finished Marks the selected job as finished, aborting all current processing 
and removing all outstanding tasks.

Processor Menu Item Description

Start Starts the selected Task Processor(s). This option is disabled if all 
Task Processor(s) are active.

Stop Stops the selected Task Processor(s). This option is disabled if all 
Task Processor(s) are stopped.

Restart Restarts the selected Task Processor(s).

Put Offline Disables the scheduling of tasks for the selected Output Task 
Processor. This option is disabled if all Output Task Processors are 
offline.

Control Menu Item Description
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View Menu

This menu allows you to control what information is displayed and how it is 
displayed. This affects the look of the current window, but does not open or close 
windows. View Menu items are only active after you have selected the Results 
tab in the Jobs Window, or in the Ticket Editor.

Put Online Enables the scheduling of tasks for the selected Output Task 
Processor. This option is disabled if all Output Task Processors are 
online.

Exposure Test Submits an Exposure Test job for the selected platesetter.
This command is available only for platesetters (e.g. Galileo, 
Palladio)

Configure Allows you to access the Configuration settings of the selected 
output device. Administrator access level required,

Resources Allows you to quickly access the resources of the selected Task 
Processor.

Flush Starts printing the collected output for ganging (proofer), or flushes 
the drum (imagesetter) and cuts the media.

View Menu Item Description

Flats Only Displays only the flat outlines in the Job Layout Pane. In this mode, 
you cannot select individual pages.

Thumbnails Displays thumbnail images of all pages in the Job Layout pane.

Page Labels Displays/Hides the Page Label column in the Run List.

Run List Indexes Displays/Hides the Run List indexes in the Run List.

Extended Page 
Adjustments

Extends the Adj column in the Run List to display extra icons (up to 
4 icons) which indicate specific page adjustments in the job.

Extras Displays checked items from the Show menu.

Highlight Unplaced 
Pages

Highlights against a green background the pages in the Page Store 
that have not been placed in the Run List.

Show • Page number - Shows the position of the page in the Run List 
(Results tab only).

• Hold States - Shows pages and flats in blue when on hold (Results 
tab only).

Processor Menu Item Description
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View Menu for Raster Preview

The Raster Preview View menu groups all commands that relate to the Preview 
window. Most of these commands are also available as tools and/or keyboard 
shortcuts.

Scale • Small - Displays small thumbnails (Results tab only).
• Normal - Displays normal thumbnails (Results tab only).
• Large - Displays large thumbnails (Results tab only).
• Fit to Window - Scales the results in the Job Layout pane so that 

they fit horizontally within the width of the pane - otherwise a 
fixed scaling is used (Results tab only).

In the Run List on the Pages tab, these commands scale the page 
labels for versioning jobs.

Columns • Front and Back - Displays two columns of pages/flats, and “front”, 
“back” and “signature” labels in the Job Layout pane.

• Fill Width - Displays as many columns of pages/flats as will fit in 
the width of the Job Layout pane.

• 1-10 - Displays the pages/flats over the specified number of 
columns in the Job Layout pane.

Flow • Results tab only. Selects the results from the selected flow for 
viewing.

Panes • Devices: Opens or closes the Device pane (Hot Ticket and Job Lists 
only). 

• Job List: Opens or closes the Job List.
• Flow Activity: Opens or closes the Activity pane (Job list/ Results 

tab only).
• Systems: Shows/hides the Hardware pane (System Overview 

only).
• Production Sets
• Separations
• Resources: Shows/hides the Resources pane (System Overview 

only).

Versions Allows you to view All, Previous or Next versions. 

Preview Menu Item Description

Zoom In Zooms in on the image in the Preview window. Each time you click 
the Zoom In tool, the zoom factor is doubled, until you reach the 
maximum zoom-in level (32:1).

Zoom Out Zooms out on the image in the Preview window. Each time you 
click the Zoom Out tool, the zoom factor is halved, until you reach 
the maximum zoom-out level (1:128).

Size To Fit Selects a zoom level that fits the entire image in the Preview 
window.

View Menu Item Description
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Actual Pixels Sets the zoom level to 1(each raster pixel is represented by a single 
display pixel).

Next Side Displays the next side in the job.

Previous Side Displays the previous side in the job.

First Side Displays the first side in the job.

Last Side Displays the last side in the job.

Turn Sheet Raster Preview always groups results which have 2 sides (front and 
back). When viewing results, use this option to toggle the view 
(front or back). 

Color Managed Displays the raster data using color management to convert the 
press color space to the monitor color space, based on ICC profiles.

Light Table Displays blended front/back viewing, allowing you to check the 
registration of the front and backs, or view whether you have 
problematic ink coverage. 

Rule-Ups Displays the rule-ups you specified in the Rule-Ups floating palette. 
This allows you to display additional layers of information on top of 
the Raster Preview image. These include: Art Box, Trim Box, Crop 
Box, Bleed Box, Media Box.

Boxes Allows you to directly toggle on or off any of the following 
indicators which may be displayed over the raster data:
• Art Box
• Trim Box
• Crop Box
• Bleed Box
• Media Box 
• Expected Page Size
• Press Sheet Size

Press Sheet Displays raster data as if it were a press sheet.

Device Output Displays raster data as it would appear output from an imaging 
device.

Transform • Rotate 90 CW: Rotates the current view 90 degrees clockwise.
• Rotate 90 CCW: Rotates the current view 90 degrees 

counterclockwise.
• Flip Horizontal: Flips the current view horizontally.
• Flip Vertical: Flips the current view vertically.
• Invert: Inverts the current view (negative).

Rulers Toggles on or off the Ruler in the Preview window.

Grid Toggles on or off the Grid in the Preview window.

Preview Menu Item Description
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Control Menu for Raster Preview

Window Menu

This menu allows you to open, rearrange, and switch between the Apogee 
windows. You can also hide or show any subsidiary windows, and bring any 
currently displayed window to the front. This menu also lists the titles of all open 
windows (in order of creation). The currently active window title has a 
checkmark.

Preview Menu Item Description

QuickProof Opens the QuickProof dialog box (only available for 1-bit screened 
data for CTP/CTF devices).

Window Menu Item Description

Zoom Window Opens or switches to the Preview window (OS X Raster Preview 
only).

Minimize Window Minimizes the frontmost window (OS X only).

Bring All to Front Brings all Apogee windows to the front (OS X Raster Preview 
only).

Cycle Through Windows OS X only.

New Window Opens a new Jobs or Raster Preview window.

System Overview Opens or switches to the System Overview window.

Hot Tickets Opens or switches to the Hot Tickets window.

Jobs Opens or switches to the last Jobs window.

Message Board Opens or switches to the Message Board.

Go to ProductionCenter Opens the ProductionCenter application in your default internet 
browser, for example, to manage WebApproval and PrintSphere 
users.

Go to PrintSphere Opens the PrintSphere file-sharing application in your default 
internet browser, for example, to manage PrintSphere users.

Go to SphereCenter Opens the SphereCenter application in your default internet 
browser, for example, to set up a PrintSphere subscription.

Go to StoreFront Opens the StoreCenter application in your default internet 
browser, for example, to create StoreFront online web stores.

Activity for Task Processor Opens an Activity window for the selected Task Processor(s). You 
can open multiple Activity windows.

Info for <selected item> Opens an Info window for the selected item(s). You can open 
multiple Info windows (PDF documents only).

Info From Opens an Info window on the selected item(s) results. You can 
select the latest or any other of the available results.
Apogee Reference Guide



 

3 GETTING STARTED 79
Help Menu

This menu allows you to access the Help system. In Windows, it also includes 
additional application-specific commands.

Remarks Opens the Remarks window, where you can view some or all 
comments that were added to this job, as well as the source of 
the comments (e.g. the Delano System).

Log for <selected item> Opens a Log window for the selected item(s). You can open 
multiple Log windows.

Problem Report for 
<selected item>

Opens a Problem Report window for the selected item(s). You 
can open multiple Problem Report windows (PDF documents 
only).

Preflight Report Opens a Preflight Report window for the selected item(s). You 
can open multiple Preflight Report windows (PDF documents 
only).

Palettes (Raster Preview 
only)

• Show/Hide Navigator: Opens or closes the Navigator palette.
• Show/Hide Inks: Opens or closes the Inks palette.
• Show/Hide Rule-ups: Opens or closes the Rule-ups palette.
• Show/Hide Versions: Opens or closes the Versions palette.
• Show/Hide Tools: Opens or closes the Tools palette.

Help Menu Item Description

About Apogee Displays the splash screen and software version number. Click 
anywhere in the About box to dismiss it).

Check for Client Updates Checks whether you have the latest version of the Apogee client. 
See the Installation Guide for more information on Client Updates.

Apogee Help Opens the first page of the Apogee Reference Guide.

What’s This? Allows you to access context-sensitive help on the selected item.

Icons Displays help information on the Apogee icons.

Keyboard Shortcuts Lists the Apogee keyboard shortcuts.

Variables Lists the Apogee variables.

Apogee Online Launches your web browser to view:
• Apogee Network: the Apogee Network home page
• Apogee Tutorials: practical lessons to help you work with Apogee
• Apogee Forum: an online forum where users of Apogee can post 

questions and answers
• Download: links to download various files to help you work with 

Apogee.

Window Menu Item Description
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Toolbar The Toolbar allows you to quickly apply common commands. The buttons 
displayed vary from window to window, and are available only after you have 
selected a job in the Job List or job results in the Results tab.

Most of these commands can also be accessed from the Control and Edit menus.

Apogee Report • Basic - Uses your browser to display a summarized overview of the 
Apogee System.

• Extended - Uses your browser to display a detailed report of the 
Apogee System.

Licenses • Load License File... - Allows you to select and open an Apogee 
license file. The license file is then sent to the system for 
evaluation.

• Save Fingerprint File... - Allows you to save an Apogee license file 
in a specific location.

Configuration Wizard Launches the configuration wizard.

Help Menu Item Description

Submit job or submit changes to a job.

Delete the selected item.

Edit Ticket.

View <selected item> (Job Ticket Editor only).

Make Blank (page in Run List - Job Ticket Editor only).

Give priority to processing the selected job (Rush job).

Hold job, or put device offline (System Overview).

Resume a job on hold, or put device online (System Overview).

Continue processing <selected item>.

Reject <selected item>.
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Navigation Bar You can switch between the three management windows by clicking in the 
Navigation bar, which is located at the bottom of each window.

On the righthand side of the Navigation bar, you will see the Activity Indicator. 
This indicator is visually active whenever the Client is busy retrieving data from 
the Server.

Message Indicator The Message Indicator flashes when one or more of the jobs or devices needs 
attention. You can click the Message Indicator to open the Message Board and 
find out what has caused the alarm. The Message Indicator will continue to flash 
until you acknowledge the event that caused the alarm.

If all the messages in the Message Board have been acknowledged, the Message 
Indicator stops flashing, but maintains a steady red glow. This is turned off when 
there are no messages to report.

Even when the Message Indicator is not flashing, you can click it to quickly 
access the Message Board.

Reprocess job from first.

Re-image <selected item>.

Enables the selected Hot Ticket (Hot Tickets window only).

Disables the selected Hot Ticket (Hot Tickets window only).

Display information about <selected item>.
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If the Apogee Client is minimized or hidden, your Operating System’s alert 
mechanism will notify you of any messages with a flashing button in the 
Taskbar.

Tab Area The Tab Area appears in the Jobs window, and in the Ticket Editor. In the right 
of the Tab Area are the tabs you can select to view or edit the selected job 
(Administration, Options, Plan, Pages, Results.). These tabs are active only after 
you have selected a job in the Job List. 

In the left of the Tab Area you will see the name of the selected job. 

Job Status Icons in Tab Area (JTE only)

The Tab Area may display additional information when you are working in the 
Job Ticket Editor. In some situations, the job name may be followed by a small 
icon which indicates the current status of the job:

For example:

If there are problems with a job you are creating or editing in the Ticket Editor, 
you will see the following type of message in the Tab Area:

In this case, you can click the red error icon to access a Problem Report.

The job is being viewed by you or by another user (JTE only). 

The job is being edited by another user. 

You are editing the job. 

The selected job was being edited by you or by another user, but the edit session was broken 
(Jobs window only). You can remove this icon by opening the job for editing.
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Viewing Messages

The Message Board is your troubleshooting tool within Apogee. It provides 
information on jobs, devices, or systems which need attention, and gives you a 
number of correction options. You can access the Message Board from anywhere 
in the Apogee Client. You can also filter it based on a number of different criteria, 
and on combinations of criteria.

 To open the Message Board

 Do one of the following:

 Click the Message Indicator in any of the management windows.

 Choose Window > Message Board. 

Message Board

The Message Board consists of a Filter pane, Message List, Acknowledge Pane, 
and Interaction pane. 

 The Filter and Message List work together: The messages displayed are 
determined by the filter (if any) you apply.

 The Acknowledge and Interaction panes work together: They display 
detailed information on the selected message, and let you decide how the 
alert should be handled.

Filter pane

The Filter pane allows you to specify which types of messages are displayed in 
the Message Board. For example, you may only want to see critical warnings, or 
be notified when user intervention is required. You apply a filter by clicking the 
Filter icon, and specifying your filter options.

The Filter pane also indicates how many messages have been generated, and 
how many of these messages have been selected, read, and acknowledged. 

When a filter has been used, you will see the text:
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Notice that the Filter icon is colored green when the filter has been applied. 

By default, all messages are displayed (i.e. no filter is applied). 

For example, if you see the text:

18 new messages, 21 messages displayed

This means there are 21 messages in total, of which 3 have been read and 
acknowledged. In this case, no filter is applied.

Message List

The Message List displays the status, date, location, and description of each 
message.

Message status One of the following status symbols is displayed:

NOTE: These status symbols also appear in the Job List.

Date occurred Displays the time and date at which the message was generated. You can sort the 
messages according to date by clicking the arrow in this column header. Each 
time you click the arrow, the sort is toggled between ascending and descending 
order.

Location Displays the name of the job, device, or system which generated the message. If 
this is a job, then the job order number is also displayed in parentheses. You can 
sort the messages according to location by clicking the arrow in this column 

The Apogee system issued a critical message.

The job has stopped pending user interaction.

The job has generated an error, and has stopped.

The job has generated a warning.

WebApproval message: A message on this job (or results) was received from WebApproval.

The job has generated an information message.
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header. Each time you click the arrow, the sort is toggled alphabetically between 
ascending and descending order.

Description Displays an abbreviated version of the message. You can view the full message 
by selecting it. You can sort the messages according to description by clicking the 
arrow in this column header. Each time you click the arrow, the sort is toggled 
alphabetically between ascending and descending order.

Message background color Each message row has a colored background:

Pink: The message has not yet been Acknowledged.

Yellow: This is the currently selected message.

Gray: The message has been Acknowledged.

Acknowledge pane

The Acknowledge pane displays information and the acknowledgement status 
of the currently selected message in the Message List.

Message summary Displays the summarized message text from the Message List Description 
column.

Reported by Indicates which Task Processor generated the message, and when, in the format 
“Reported by <Task Processor> at <time and date>”.

Acknowledgement status Indicates who (if anybody) first acknowledged the message, and when, in the 
format “acknowledged by <user> at <time and date>”.

Acknowledgement button Click this button once you have read the message. Any Errors or Warnings that 
you acknowledge are removed from the Message List. User Interaction messages 
remain in the list until the required action has been taken.

Notification/Interaction pane

Notification message Displays a more detailed version of the message. Some messages are followed by 
a suggested course of action, such as:

“There is no location for exporting the system log. The default 
C:\Apogee Prepress\SysLog\$DATE.log will be used”

Interactive dialog buttons. Some messages include interactive dialog buttons which allow you to correct the 
cause of the error or warning. For example, Retry, Abort Task, Update, Don’t 
Update, or Yes/No buttons.
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The Edit Job button always appears for job notification messages. You can click 
this button to edit the job directly, and correct the problem. The Edit Job button 
is not available for System messages.

NOTE: If you select more than one message, you will see no specific message 
information, only “x messages selected”.

Filtering Messages You can filter the Message Board based on a number of different criteria, and on 
combinations of criteria.

 To filter messages in the Message Board

 Click the Filter icon.

The Message Board Filter dialog box is displayed.

Any filters you specify are cumulative. Only the messages which match all the 
specified criteria are displayed.
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Message Board Filter

You can apply three types of filters. The options you select in each type are 
combined to produce a highly customizable filtering mechanism:

 From: Shows only messages generated by the selected module(s).

 Level: Shows only messages of a specific level(s) of importance or urgency.

 Date: Shows only messages from a specific time frame.

Filter

On/Off Activate or deactivate the filter by clicking the Filter On or Off radio button.

Unacknowledged
messages only

Select this check box to display only the messages which have not yet been 
acknowledged.

From

Jobs To filter messages based on a particular operator or job name, select the Jobs 
check box, click the associated list box, and choose one of the following:

 Operator Name contains: This is the name of an operator as specified in the 
Administration tab of one or more tickets. Enter the operator’s name here. 
When you apply the filter, all messages which relate to jobs belonging to this 
operator will be displayed.

 Job Name contains: This is the name of a job as specified in the Administra-
tion tab of a ticket. Enter the job name here. When you apply the filter, all 
messages relating to this job will be displayed.

Device Administrator access level only!

To filter messages based on a particular output device, select the Devices check 
box, click the associated list box, and choose one of the available output devices 
(such as printers, imagesetters, proofers, etc.).

When you apply the filter, all messages which relate to the selected device will 
be displayed.

System Administrator access level only!

To filter messages based on those generated by the Apogee System (such as Task 
Processors, Apogee Client, etc.), select the System check box.
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Level

To filter messages by type, select one or more of the Level filtering check boxes.

In Error Filter on jobs which have generated an error.

Warning Filter on jobs which have generated a warning.

User interaction, proofing Filter on jobs which require user intervention or proofing.

Informational Filter on jobs which have generated a message (information only).

Date

To filter messages by date, select the Date filtering check box, and use the three 
associated list boxes to choose a specific date or time window.

Apply and OK

Click Apply to save your settings. Click OK to close the Message Board Filter.

TIP: Simply clicking OK will 
both apply your changes and 
close the Message Board 
Filter.

The filter is applied immediately. This is confirmed by the message “(Filter 
Applied)” in the Filter pane.

Critical Messages If the Apogee system detects a situation that jeopardizes the proper functioning 
of the system (for example, low disk space), it issues a critical message. 

A critical message is a high-priority message that cannot be filtered or acknowl-
edged. Because these messages require immediate action, the client intercepts 
them and displays a special alert window. The client also checks the presence of 
critical messages at startup.

The Critical System Alert window is a floating window that can be moved but 
cannot be closed until the particular problem is resolved. This window does not 
prevent interaction with the client, but normal operation may be affected 
because of the critical condition of the server (slow response, processing on 
hold, etc.). The window lists the critical messages and corresponding 
timestamps. It also includes a ‘Review’ button which you can use to open the 
Message Board to view only the critical messages.
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Viewing Remarks

Apogee jobs are integrated with WebApproval. This means that jobs which 
include a Web Proof Action can be viewed and assessed by interested third-
party’s, such as print buyers. These users can add their comments about the job, 
and can approve or reject it. This feedback can be viewed in Apogee, where you 
can open the Remarks Inspector and view some or all comments that were added 
to this job, as well as the source of the comments (e.g. the WebApproval 
System). 

 To open the Remarks Inspector

1 Select a job with a WebApproval message. 

2 Select Window > Remarks.

The Remarks Inspector is displayed.

3 Click the arrow at the bottom of each remark to view the full text.

NOTE: You can click the “hot spot” of an annotation remark to open the Raster 
Preview Client.

4 Click the Include list to filter the displayed remarks as follows:
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 All

 Today

 Last 2 days

 Last 3 days

 One week

 Most recent

A number of icons are associated with each remark.

Monitor Status

Remark Origin

Remark Type

The monitor status is up to date and the overall display rating is greater than 90% (Excellent). 

The monitor status is up to date and the overall display rating is between 80% and 90% 
(Medium).

The monitor status is up to date and the overall display rating is less than 80% (Bad).

There is no monitor status, or it is out of date (Undefined).

Customer remark (WebApproval jobs only).

Printer remark (WebApproval jobs only).

An annotation remark created in WebApproval. Click the associated (blue -encircled) annota-
tion number to jump directly to the referenced location in Raster Preview. 

The job has been approved by the corresponding reviewer (printer, customer).

The job has been rejected by the corresponding reviewer (printer, customer).

A job remark.

A page remark.

Preflight remark

Preflight remark - warning
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Additionally, you may see blue-circled number next to the remark text. You 
can click this number to jump directly to the referenced location in the job.

Preflight remark - error

Internal remark which cannot be seen by the customer

Remark has attachment (customer remarks only)

View file produced after preflight

View report produced by preflight
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Preferences

Your Preferences are divided into the following categories:

 General

 Logging On

 Viewers

 Imposition Editor

 Validation

 Layout Editor

General

Display units Select the unit of measurement that you want Apogee to display and the 
Precision of the measurements.

 millimeters

 inches

Notifications Select the check box to hear a sound when critical system messages are 
generated.

User Interaction  Enable double-clicking a job to Edit: Select the check box if you want to open 
a job in the Job List by double-clicking it. The job will open in the Job Ticket 
Editor or the Layout Editor, depending on the type of job.

 Open Layout Editor when imposition is Layout: Select if you always want to 
open packaging jobs in the Layout Editor.

 Open Product Editor when double-clicking a product (in stead of Preview): 
Select the check box to open the Product Editor when you double-click a 
product in the Product panel of the Layout Editor (default). Clear the check 
box if you want the product to open in the Raster Preview module and 
automatically create a preview.

 Prompt for details when adding artwork files: Select this option if you want 
to control how products are named when you select artwork to add products 
in the Layout Editor. See “Adding Products from Artwork” on page 492.

Language Lists all the languages in which the user interface is available. The available 
languages were selected when the Apogee System was installed.
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JDF Sheet Names Show MIS press sheet names when present: Select this option to display JDF sheet 
names instead of Apogee names, in the Results tab and main Apogee Impose 
windows.

Job Operator The job operator receives notifications that pertain to his/her jobs. This option 
determines whether the operator field in a job can be edited at anytime, or 
whether it is locked after a job has been submitted. 

Lock operator name after submitting the job: The Operator field is locked and 
cannot be edited after the job has been submitted. This is the default setting.

Always allow changing the operator name: The Operator field remains editable at 
all times. Note that the operator field is always editable if it is empty or when it 
contains a ‘JDF’ string, regardless of the preference.

Create color-managed
Previews

Select the check box to automatically create color-managed previews and 
calculate final output CMYK values when you add new images to a layout job, in 
the Layout Editor. It is recommended to leave this option off unless you always 
need color-managed previews in the Layout Editor.

Logging On

The Logging On tab defines your access rights, and allows you to specify how the 
Client selects and logs on to an Apogee System.

User name Enter the name supplied to you by your Apogee administrator.

Preferred system Enter the name of the system you want to connect to at startup. You can also 
click the Browse button and select a system from the displayed list.

Password Enter the password supplied to you by your Apogee administrator.

Automatically log on at
startup

Select this check box if you want to automatically log on to your preferred 
Apogee System each time the Client is started.

Viewers

There are two viewers: PDF Viewer, for checking PDF job results and Raster 
Preview, for checking raster job results.

PDF Viewer/Editor If you want to be able preview PDF job results in the Pages or Results tabs of the 
Jobs window, you must specify where your viewing application is located. This 
tab defines the applications that can be used for viewing and/or editing PDF 
files.
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You can add applications using Add button (+). This opens a standard File Open 
dialog where you can select an executable file. To remove an application, select 
the application, and click the Delete button (x).

Use as Default Viewer: Select that option, if you want to use an application as the 
Default Viewer. Default Viewer Application is shown in bold text. 

NOTE: Acrobat Reader will always display the first page of the job. To directly 
view a specific page within the job, you need to use Acrobat Professional.

Raster Preview These fields allow you to specify the settings that will be used by Raster Preview. 
You can temporarily override any of these settings while you are previewing 
pages. However, this does not change the default settings.

Gridline every: Sets the default units of measurement of the grid (cms, inches, 
mms, picas, pixels, or points), and the distance between the major gridline 
divisions.

Subdivisions: The grid displays gridlines for every major and minor division of 
the ruler. Major divisions are drawn in solid blue, subdivisions in light blue. This 
parameter sets the distance between the gridline subdivisions. 

Auto-switch zoom factor: Select the switchover point from low resolution 
(contone) viewing to high resolution viewing when previewing a job (4x, 2x, 1, 
1/2, 1/4, 1/8).

Display single separation in color: When you view a single separation (a single 
separation selected in the Raster preview Inks palette), it is by default displayed 
in grayscale. If you select this check box, it is displayed in color. If more than 1 
separation is selected in the Raster Preview, these separations are always 
displayed in color.

When preview is color
managed

You can choose from the following for color-managed previewed results:

Rendering Intent: The following Rendering Intents available, although not all 
profiles contain Look Up tables (LUTs) for each of them. In this case often a 
duplicate of one Look Up table is used for missing Render Intent LUT. The 
Rendering Intent defines the way the source colors are mapped to the destina-
tion space.

 Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from 
source color space is mapped to the white point of destination, this means 
that white stays white. No ink will be placed in white areas.
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 Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the two profiles is preserved. 
White of source color space is simulated with CMYK values from the 
destination color space. The consequence is that every white object/area is 
covered with certain ink amounts.

Accurate Spot Color Mixing: In this enhanced mode, spot color visualization is 
superior to the standard color-managed mode. You can choose from the 
following:

 Off

 Max. 2 colors

 Max. 3 colors

Use Press Paper White: Pantone\spot color inks are transparent and appear 
differently when printed on different substrates. Normally, you should select 
this option when creating a proof which will be used by the printer to print a spot 
color on the Press (when the simulated spot color on proof needs to resemble the 
final printed result). In this case, the paper white from the press profile is used 
in the color calculation.

If this option is not selected, the measured paper white of the color book is used 
in the calculation of the spot colors. The option should therefore be deselected 
when the simulated spot colors on the proof are compared to the color book 
reference prints (with a measurement device, for example).

NOTE: A spectral press profile is required for this option.

Line Appearance Display design lines using: Selects the Line Appearance Set used by the Layout 
Editor and Product Editor to draw the Operations. The following options are 
available from the drop-down list:

 Fixed: Draw the Operations using the fixed colors (default option).

 <list-of-line-appearance-sets>: The list of all available Line Appearance set 
resources, sorted alphabetically in ascending order. 

 Manage Line Appearance Sets: Opens the Line Appearance Set resource 
editor.

Imposition Editor

This tab is used to set your preferences for Apogee Impose.
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When closing the
Imposition Editor

Choose your preferred behavior for when you close the main Apogee Impose 
windows.

Assembly View Choose how you want the Product assembly to be viewed in the Assembly pane.

Apogee Impose Client
License

Select ‘Make this an Apogee Impose editing station’ if you want an Apogee 
Impose license to be assigned to this particular user. 

Auto Fit Enter the time in seconds to allow Apogee Impose to search for an Auto Fit rule 
in automatic imposition mode.

Validation

These validation checks only performed for Apogee Impose jobs.

Product Intent Select the Warn when amount of Kept spot colors doesn’t match the Part’s 
spot colors check box to generate warnings when the number of spot colors in 
the parts is not equal to the kept spot colors in the Separation operation.

Apogee Imposition Select the option to allow the job to be submitted with imposition errors. This 
means that the press sheets must be inspected before further processing.

Layout Editor

These preferences are used by the Layout Editor.

Fitting Options This field allows you to control Fitting Options for any frame that is created in 
the Layout Editor. 

Auto-fit: Select the Enable Auto-fit for new frames check box to enable Auto-fit 
option when a new frame is created. This check box is selected by default.

NOTE: This option is only applicable when you create a new frame in the Layout 
Editor. Frames which are present in the existing Jobs, Ticket Templates and 
Sheet Layout are not affected.

You can select the Show Auto-fit option in Position bar check box when you 
want to show the Auto-fit option in the Position bar. You can use that option to 
prevent the change of the Auto-fit option accidentally. 

Snapping and Guides This field groups the preferences for snapping and the guides in the Layout 
Editor.

Snap distance: The threshold distance (in pixels) at which the items will be 
snapped to the nearest item. The default value is 10 pixels.
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Check alignment distance: The threshold distance on a sheet at which the frames 
will be checked for alignment to the guide(s). The default value is 3 mm.

 To open your Preferences

 Choose Edit > Preferences.

Customizing Your Work Area

When you start the Apogee Client, the Jobs window is automatically opened. 
From here, you can open the other Main windows (Hot Tickets and System 
Overview), and arrange all three windows on your desktop.

You can reposition and resize each window, and adjust the panes inside the 
windows. Most of these panes can be resized by dragging the pane borders. 
Some panes also have an expansion triangle. This is a small triangular icon in the 
centre edge of the pane pointing either to the right or left. For example, the Job 
List pane in the Jobs window has an expansion triangle on the right edge. You 
can close the pane, and open it again by clicking on this expansion triangle.

When you quit the Client, any adjustments you have made to the positions and 
sizes of the windows and panes are saved. The next time you start the Client, The 
Jobs window will open with these new settings. When you open the other Main 
window, these too are restored with the last settings used (position and size).

 To adjust the width of a pane

1 Select a pane, and position the mouse pointer over the one of the borders.

If the pointer changes to a two-headed arrow, you can adjust it.

2 Click and drag the pointer to the left or right, and release the mouse button.
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4 Previewing Job Results

This section describes how you can view and analyze job results. On the basis of 
this detailed preview, you can then approve and send the job results directly to 
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Apogee Soft Previews

You can preview your job data at any point in the Production Plan. This “soft 
preview” data is not physically output to a printer. Instead, the job data is 
displayed on-screen. 

There are two types of Preview:

 PDF Preview: The purpose of a PDF Preview is to allow you to check PDF job 
results (flats or pages) on-screen, before the job is rendered. No physical 
output results are generated. For more information on PDF Preview, see “To 
view job results in the Page Store or Run List” on page 215.

 Raster Preview: The purpose of a Raster Preview is to allow you to check 
raster job results (flats or pages) on-screen, after the job has been rendered. 
No physical output results are generated. Raster Preview is an integrated part 
of Apogee, and is described in detail in this section.

Raster Preview

Raster Preview allows you to examine rasterized job data. Once Apogee has 
rendered one or more jobs, you can select and view the individual job pages by 
double-clicking the job results in the Job Layout pane. Apogee creates an exact, 
viewable image of the data on your front-end workstation. The requested raster 
data is displayed as a series of overlapping separations. You can open and view 
pages at different magnifications, and check individual color separations, ink 
coverage, and screen angles.

On the basis of this detailed job preview, you can approve and send the job 
directly to your output device (platesetter, imagesetter, etc.) or abort the job 
before submitting it to output. You can also save the rendered job data to disk.

Preview supports all resolutions, screening modes, and page sizes. You can 
simultaneously preview several pages from the same job, and multiple previews 
of a single page. Images can be displayed at any zoom factor from 1:128 to 32:1.

You can preview one page of a job which has been rendered, while the following 
page is being rendered. Overlap between “rendering/previewing” and 
“imaging” is also supported on a page-by-page or flat-by-flat basis.
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NOTE: Preview is a “read-only” application: Tools are provided for zooming and 
panning the image, and for displaying various types of image information. 
However, no changes can be made to the raster data. If errors are found in the 
previewed data, the job content must be corrected in the original application, 
and then re-submitted.

Post-Preview 
Options

When you have finished previewing the pages of a job, you can:

 Approve the results: You can approve the previewed page, or the entire job, 
and send it directly to your output device. Once it has been output, the raster 
data is automatically deleted, and will no longer be available for previewing 
or imaging.

 Reject the results: You can reject the previewed page, or the entire job. 
Rejected items are marked with a red stripe.

 Approve rejected results: You can approve a job or item which is currently 
marked as rejected. This item is then treated the same as an approved item.

Preview Window and Tools

When you select and open a page or flat for previewing, the Preview window is 
opened on your desktop. This window displays the selected raster data, and 
provides a set of tools and options for viewing and measuring the data.

At the bottom of the Preview window is the status bar.

The Preview status bar contains the following tools:

 Zoom slider: You can drag the zoom slider left or right to change the zoom 
level. This zooms the image around the center of the Preview window. 

 Screen angle measurement results: Displays the results of any screen angle 
measurements you perform.

 Width and height measurement results: Displays the width and height of the 
box defined by the diagonal you draw with the Measurements tool.
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 Screen frequency results: Displays the results of any screen frequency 
measurements you perform (only displayed when you zoom in to view the 
raster data).

 Light table tool: Displays blended front and back views of your raster data. 
This allows you to check the registration of the front and backs, or check if 
there are problems with the ink coverage.

 Full screen display button: On the right is a button which switches the 
Preview window to full screen (the shortcut key is ‘f”). You can return to 
normal view by pressing the Esc key.

You can also display a series of small palettes for the currently active Preview 
window:

NOTE: These palettes are 
hidden when the active 
window is not a raster 
Preview window.

 Navigator Palette: Provides a snapshot of the entire page or flat, as a low 
resolution continuous tone image. Using this palette, you can focus on the 
detail of one area of the selected page or flat. This view can be panned and 
zoomed over the entire area of the page.

 Inks Palette: Allows you to view the different separations, and measures the 
ink coverage within the selected area of the Preview window. 

 Rule-ups Palette: Rule-ups are additional layers of information which are 
displayed on top of the Raster Preview image. The Rule/ups palette contains 
a table which lists the layers you can display.

 Versions Palette: Allows you to display version-specific plates. For more 
information, see “What is Versioning?” on page 55.

 The Tools Palette: Provides quick access to common tasks and procedures.

The Preview window and the Navigator and Inks palettes can be resized using 
the resize handle in the lower right corner. The location and size of all windows 
is remembered between sessions.

You can open several Preview windows, but only one Inks palette. These display 
information about the active Preview window. You can close or minimize each 
of the smaller palettes individually, or you can hide them all at once.

Preview Window The Preview window displays in detail the area of the image that is currently 
selected by the Navigator palette locator. The Preview window displays:

 A Title bar: Shows the name of the job, followed by the page or signature 
number and Task Processor name.
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 The selected raster data: When you open an item to preview, the selected 
raster data (page or flat) is initially shown as a low resolution continuous 
tone image. When you zoom in to approximately an 8x zoom factor, the 
continuous tone image is replaced with the high resolution raster data. This 
allows you to preview traps, halftone dots, etc. The way in which raster data 
is by default displayed can be customized, as described in “Preferences” on 
page 92. 

 Ruler and Grid (optional): Preview windows can display rulers in user-select-
able units of measurement (millimeters, centimeters, inches, pixels, or 
picas).

You can open as many Preview windows as your system resources allow. You can 
have several Preview windows showing the same raster data at different 
magnifications, or windows showing different raster data.

Navigator Palette The Navigator palette displays a snapshot of the entire page or flats as a low 
resolution continuous tone image. This palette can be switched on or off by 
selecting Window > Palettes > Show/Hide Navigator.

You can open a Navigator palette for every page that you preview. 

The Navigator provides a view of the entire page or flat, at a low magnification: 
A red “locator” rectangle in the Navigator palette indicates which part of the 
page is enlarged in the Preview window. You can quickly preview different areas 
of the page by clicking the mouse pointer inside the locator and dragging it to 
another position. You can click outside the locator to center the view area on the 
clicked point.

Inks Palette The Inks palette automatically measures the ink coverage within the selected 
area of the Preview window. This palette can be switched on or off by selecting 
Window > Palettes > Show/Hide Inks.
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The Inks palette contains a table which lists the separations in the selected page 
or flat. 

The table has three columns:

 Visibility control (eye icon): You can click the eye icon to hide the associated 
separation. The eye icon then disappears. You can click the same icon to 
display the separation again. 

 Color well: Click here to open the system color picker, and select the color of 
the associated box. For White, Primer or Varnish, you can also set the 
transparency.

 Ink: The name of the separation. This may be a CMYK separation, or a spot 
color. This can also be White, Primer or Varnish if these are included in the 
document.

 Covers %: The ink coverage is expressed as a percentage, and is represented 
both numerically and as a color bar. The bar shows the color of the separa-
tion. The ink coverage calculation is accurate to within 3 percent of the actual 
ink coverage.

Under the table there is a ‘Show ink coverage’ check box. By default, this option 
is unchecked, and Preview does not perform any ink coverage calculations. This 
avoids unwanted (and possibly lengthy) calculations each time you preview 
raster results. Click the Cursor/Selection or Entire image button to measure the 
ink coverage at the cursor point, for a selected area or the entire image.

NOTE: You can press the Alt key  and click on a hidden separation to show that 
separation, hiding all others.
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The Inks palette can be resized using the resize handle in the lower right corner, 
and can be switched on or off by selecting Window > Palettes > Show/Hide 
Inks.

Rule-ups Palette Rule-ups are additional layers of information which are displayed on top of the 
Raster Preview image. The Rule/ups palette contains a table which lists the 
layers you can display.

The table has five columns:

 Visibility control (eye icon): You can click the eye icon to hide the associated 
layer. The eye icon then disappears. You can click the same icon to display the 
layer again. 

 Color well: Click here to open the system color picker, and select the color of 
the associated box.

 Layer: The name of the layer. This may include any of the following:

 Trim box

 Crop box

 Art box

 Media box

 Bleed box

 Press Sheet
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 Expected Page Size

 Design 

 Line Style: Click the associated dropdown list and select a line style:

 Solid

 Dashed (8-pixel / 6-pixel gap)

 Dotted (1-pixel / 2-pixel gap)

Initially all line styles are Solid.

 Design: This entry shows all paths that are associated with an Operation 
using the selected Line Appearance Set, regardless of their origin, i.e., from a 
CAD or a content file, automatically mapped or assigned manually. The last 
option in the drop-down menu Manage Line Appearance Sets opens Line 
Appearance Set resource editor where you can adjust or create new sets.

NOTE: The Design is only shown for Layout Editor-based jobs, i.e., Wide 
Format jobs, Packaging jobs, Plate Assembler jobs. It is hidden for any other 
job types.

Under the table there is a ‘Show/Hide Rule-ups’ check box. By default, this 
option is unchecked, and Preview does not display any boxes. 

NOTE: You can press the Alt key  and click on a hidden box to show that box, 
hiding all others.

Your last used Rule-ups palette configuration is saved locally (colors, line styles, 
rule-ups selection shown). It does not change when you browse through your 
results. 

Light Table Slider The Light Table slider allows you to display blended front and back views of your 
raster data. This allows you to check the registration of the front and backs, or 
check if there are problems with the ink coverage.

NOTE: This feature only works on the front and backs of the same signature/
page. You cannot combine sides that belong to different signatures/flats.
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You control this feature using the Light Table slider. This slider allows you to 
shift the opacity of the results from the front view to the back view. When you 
move the slider, a percentage of both sides (front and back) is blended in the 
results you are viewing. 

NOTE: In Press sheet mode, the side that is in front (front or back) will always be 
right reading. Typically, the other side of the Light Table view that shines 
through will be wrong reading. 

The preview takes longer to build when the Light Table option enabled in the 
View menu. The buildup of the preview will progressively show all separation 
colors from the front and backside. In most cases this means the load time will 
double when Light Table is active. Each time you slide the opacity slider the 
preview will rebuild.

The Light Table options are disabled if you are viewing one-sided results (pages 
with no imposition) or if this feature in not licensed.

Versions Palette The Versions Palette allows you to display version-specific plates in versioning 
jobs. The palette lists the available versions in the job, together with their 
associated plate sets.

 Show version specific plates only: Select this check box to display only the 
plates belonging to the selected version.

 Show version specific plates as: Select this check box to identify version-
specific content using the associated color.

Comparing Versions

Raster Preview provides you with a Compare functionality which allows you to 
inspect misalignment issues in versioning jobs by comparing version-specific 
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plates against each other. The goal is to spot objects that became shifted across 
versions, especially when those versions share a set of common plates.

For example, suppose you have a job with three versions, containing a 
photograph that prints in CMYK. The three versions share the CMY plates, and 
each have their own K plate. For the photograph to print correctly in all versions, 
the photograph image on the K plate of each version must be aligned precisely 
with the common CMY plates. In some cases the shift is small, and is hard to 
notice when previewing the version on screen. However, it is very obvious in 
print. 

To spot such shifts quickly and easily, you can keep one version - the master 
version - on a light table, and lay the next version on top of it. When looking at 
the layered composite, unwanted shifts become immediately obvious. A quick 
way to check whether there might be a problem, before comparing the 
individual versions, is to layer all versions on top of each other: Common images 
should still look OK. If you notice a shift, you can use the comparison technique 
to identify the problem version (or versions).

You control the viewing mode by clicking the viewing mode selector in the 
Versions palette or by selecting the corresponding menu item 
(View > Versions). You can also switch modes by using shortcuts (‘N’ for Normal 
mode, ‘A’ for All and ‘C’ for compare).

 Normal: Views each version as printed, one by one. The previous and next 
version shortcuts simply switch the version being viewed. By default, you see 
all plates that make up the version, but you can view the version-specific 
plates only. 

 All: Shows all version-specific plates on top of each other. This is done using 
the View >  All Versions command or the ‘A’ shortcut. If you double-click a 
flat from within the Results tab in ‘View All’ mode, Raster Preview also starts 
in ‘All’ mode. The plate of the first version is shown is cyan, the other plates 
are all shown in magenta. As such, shifted pixels stand out very clearly. 

NOTE: This mode only shows the version-specific plates: You cannot switch 
this off.

 Compare: Shows the version-specific plates of the master version and a 
version, layered on top of each other. The master and version plates appear 
in different colors to highlight possible shifts. The previous and next version 
shortcut keys switch the top-layered version, keeping the master plate under-
neath. You can also click a version in the palette to make an immediate 
selection. When Raster Preview detects a change of master, it switches the 
master plate as well.
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Multiple product versions

If a press sheet contains more than one product version (a so-called multiple-
versions press sheet), the Versions palette lists the plates for each press sheet 
version. The sheet version number (SV1, SV2, etc.) is displayed instead of the 
version name.

Tools Palette The Tools palette provides quick access to common tasks and procedures.

Each of these tools is described below.

Icon to indicate the master version.

Marquee tool. Allows you to draw a rectangle in the Preview window by clicking and 
dragging. The ink values for the selected region are measured and displayed in the Inks 
palette. For more information, see “To measure the ink coverage of a selected area” on 
page 120.

Hand tool. Pans the image, allowing you to view a page that exceeds the size of the Preview 
window. With this tool selected, click inside the Preview window and drag the image around.
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Zoom tool. Zooms in to the next zoom level in the Preview window. You can zoom out by 
holding down the Alt key. Alternatively, you can click and drag to zoom into a specified area. 

Measure tool. Measures raster angles, and distances between the raster points. You can also 
use it to calculate the line ruling of a separation. 

Next tool: Displays the next side result (e.g. Cover Sig 1 Front > Cover Sig 1 Back > Cover Sig 
2 Front > Cover Sig 2 Back etc.). If you hold down the ‘C’ key while clicking the tool, Apogee 
displays the next sheet result (e.g. Cover Sig 1 Back > Cover Sig 2 Back > Cover Sig 3 Back).

Previous tool: Displays the previous side result. If you hold down the ‘C’ key while clicking 
the tool, Apogee displays the previous sheet result.

Turn Sheet tool. If your results have 2 sides (front and back), Raster Preview can switch 
between the two sides. Click this tool (CTRL+T) to toggle the view (front or back). This tool is 
disabled if the result only contains one side.

Info tool. Display information about the selected item.

Light Table tool. Displays or hides blended front and back views of your raster data. This 
feature only works on the front and backs of the same signature/page.

Rule-Ups tool. Displays or hides additional layers of information on top of the Raster Preview 
image. The Rule/ups palette contains a table which lists the layers you can display.

Rotate clockwise tool. Rotates the current view 90 degrees clockwise. 

Rotate counterclockwise tool. Rotates the current view 90 degrees counterclockwise. 

Flip vertical tool. Flips the current view vertically. 

Flip horizontal tool. Flips the current view horizontally. 

Invert tool. Inverts the current view (negative). For more information, see “To invert an image 
(negative)” on page 117.

Color Managed tool. Activates color-managed raster preview. This allows you to preview the 
rendered result using color management to convert the press color space to the monitor color 
space (based on ICC profiles). 

Show/hide a Depth map. See “Depth Tool” on page 125. 

Show/hide the Distortion. See “Distortion” on page 127. 

Show/Hide rulers tool. Shows/Hides ruler coordinates in the units set in your Preferences. 

Show/Hide gridlines tool. Shows/Hides gridlines for every major and minor division of the 
ruler. The default setting is specified in your Preferences.
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Preview Menus All the Preview settings and commands are grouped in the View, Control and 
Window menus.

Opening/Closing Pages or Flats for Preview

This section describes the different ways that you can open and close pages or 
flats in Preview mode.

 To open pages or flats for preview

1 Select the Jobs Window.

2 Look in the Job List, and select a job that has a Soft Proof status icon.

NOTE: Do not select a folder: You need to expand folders in order to select 
jobs.

After a few seconds, the job data is retrieved.

3 Select the Results tab.

4 Look in the Job Layout pane.

You will see a graphical thumbnail representation of the selected job pages or 
flats.

A successfully rendered page or flat will have solid separation indicators.

5 Double-click one or more page or flat thumbnails that have been successfully 
rendered.

Approve tool. Approves a previewed result. This tool is disabled if no soft preview has been 
requested. 

Reject tool. Rejects a previewed result. This tool is disabled if no soft preview has been 
requested. .
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The first of the selected items is displayed in Preview mode. The default view 
is set to “Fit to window”, and the view settings display a positive, upright, 
right-reading image.

When opening pages for preview, the page is initially shown as a low resolution 
continuous tone image. When zooming in, if you have the Raster Preview 
option, the continuous tone image is replaced with the high resolution raster 
data (from approximately 1:8 zoom factor). This allows you to preview traps, 
halftone dots, etc. Only the full version of Apogee allows you to preview high 
resolution raster data. The Apogee Light version can be upgraded to include the 
Raster Preview option.

NOTE: More than one Preview Window can be opened for a particular page, each 
with its own zoom factor. You can also open multiple different pages within a 
job, but you cannot simultaneously open and view pages from different jobs.

 To open multiple views on a page

In addition to opening multiple pages, you can also open up multiple windows 
on the currently selected page to display detailed views on different areas of the 
image.

1 Open a page or flat, as described in “To open pages or flats for preview” on 
page 111.

2 While your selected page is active, select Window > New Window.

Preview opens a new Preview window for the current page. Each of the 
windows you open can display a different part of the page with a different 
zoom factor.

NOTE: The maximum number of windows that you can have open at any 
given time depends largely on your system’s memory configuration. 
However, you can preview only one job at a time.

 To close a preview window

1 Click the mouse inside the Preview window that you want to close.

This makes the window the active window.

2 Select File > Close, or directly click the close button in the Title bar.

3 The selected Preview window is closed. 
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If this is the only Preview window open, then the Navigator and any other 
associated Preview windows that may be open are also closed.

Browsing your Results

To view your results you can select multiple results in the Results tab, and 
multiple raster preview windows will open. However, once Raster Preview is 
launched, it offers an alternative way to browse through your results within a 
single raster preview window. This way you can avoid switching back and forth 
between the Results tab and Raster Preview. 

 To view next and previous results

1 Double-click on a page in the middle of a set of results to launch Raster 
Preview.

2 Click the Next and Previous buttons to browse forwards and backwards 
through the results from front to back.

Raster Preview displays the next and previous side results (e.g. Cover Sig 1 
Front < > Cover Sig 1 Back < > Cover Sig 2 Front < > Cover Sig 2 Back < 
> etc.). 

3 Hold down the C key while clicking the Next and Previous buttons to browse 
forwards and backwards through the results from sheet to sheet.

Raster Preview displays the next and previous sheet results (e.g. Cover Sig 1 
Back < > Cover Sig 2 Back < > Cover Sig 3 Back, etc.). 

 To view the first and last results

1 To display the first result, press the Home button.

2 To display the last result, press the End button.

NOTE: If a job consists of 10 signatures: Sig 1 Front is the first result and Sig 10 
Back is the last result.

 To turn a sheet

If your results have 2 sides (front and back), Raster Preview will always group 
these results. 

1 Select both the front and back of one and the same sheet and double-click.

A single raster preview window will open. 
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2 Click the Turn Sheet tool (CTRL+T) to toggle the view (front or back). 

Alternatively, you can click the Side Switcher in the Light Table palette.

The Turn Sheet tool is disabled if the result only contains one side.

NOTE: The zoom factor, Navigator view and position and Inks separation 
selection remain the same when you turn a sheet.

Zooming Images

There are a number of different ways to zoom in and out, as described below.

The zoom level is always expressed in powers of 2. The available zoom factors 
are: 1:512 (1 screen pixel corresponds to 512 raster data pixels), 1:256, 1:128, 
1:64, 1:32, 1:16, 1:8, 1:4, 1:2, 1:1, 2:1, and so on up to 32:1. 

NOTE: When opening pages to preview, the page is initially shown as a low 
resolution continuous tone image. When zooming in, if you have the Raster 
Preview option, the continuous tone image is replaced with the high resolution 
raster data allowing for previewing traps, halftone dots, etc. Only the full version 
of Apogee will allow for high resolution raster data previewing. Other versions 
of Apogee can be upgraded to include the Raster Preview option.

 To zoom the Preview window using the slider or menu option

1 In the Preview status bar, drag the zoom slider to the left to zoom out (up to 
1/512), or to the right to zoom in (up to 32X).

To the left of the zoom slider, Raster Preview displays the current zoom 
factor. When zooming out, “1/” is displayed, followed by the zoom factor (1/
2, 1/8, 1/128). When zooming in, the zoom factor is displayed, followed by 
a “X” (32X, 4X, 1X).

2 You can also select a zoom level from the View menu (View > Zoom In/Out). 
This zooms the image around the center of the preview pane. The View menu 
also includes the following options:

 Size to Fit. This selects a zoom level that fits the entire image in the 
Preview window. 

 Actual Pixels. This sets the zoom level to 1(i.e. each raster pixel is repre-
sented by a single display pixel).
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 To zoom in on a point using the Zoom tool

1 Click the Zoom tool.

2 Click a point in the Preview window to zoom in on that point in the image.

Preview calculates an appropriate zoom factor to fit the active Preview 
window on your screen. Each time you click the Zoom tool, the zoom factor 
is doubled, until you reach the maximum zoom-in level (32:1).

 To zoom out on a point using the Zoom tool

1 Click the Zoom tool.

2 Click a point in the Preview window while holding down the Alt key.

3 Preview zooms out on that point in the Preview window.

 To zoom in on an area using the Zoom tool

1 Click the Zoom tool.

2 Click-and-drag in the Preview window to select a rectangular area of your 
choice. 

The selected area is re-scaled to fill the current window size. The re-scaling is 
performed to the nearest zoom factor to the power of 2.

 To zoom out on an area using the Zoom tool

1 Click the Zoom tool.

2 Click-and-drag in the Preview window to select a rectangular area of your 
choice while holding down the Alt key. 

The selected area is re-scaled to fill the current window size. The re-scaling is 
performed to the nearest zoom factor to the power of 2.
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NOTE: Each successive zoom operation that you start will interrupt any ongoing 
operation. This means that if you start a new operation, such as a zoom in, before 
an ongoing operation is completed, then the ongoing operation will be aborted.

Changing the Default View

This section explains how to manipulate the images you preview, and how to 
customize your viewing options. In addition to panning, rotating, flipping, and 
inverting images, you can also display raster data as if it were a press sheet 
(positive and gripper edge down), or as if it were output from an imaging device 
(with polarity, orientation, and reading set accordingly). 

 To pan an image

1 Select the Pan tool.

TIP: You can also pan an 
image by dragging the 
rectangular locator in the 
Navigator palette.

2 Click and hold down the mouse button on a point in the Preview window.

3 While still holding down the mouse button, pan the image by moving the 
mouse around the Preview window. 

The image is updated when you release the mouse button.

 To fit the image size to the screen size

1 Select View > Size To Fit.

This calculates an appropriate zoom factor to make the active Preview 
window fit on your screen. Image re-scaling is performed to the nearest zoom 
factor to the power of 2.

In this mode, any area that is not covered by the image is shown with a gray 
and white checkerboard pattern.

 To rotate an image

1 Select the Preview window which contains the image you want to rotate.

2 Select View > Transform > Rotate 90 CW to rotate the image 90° clockwise, 
or View > Transform > Rotate 90 CCW to rotate the image 90° 
counterclockwise. You can also use the Rotate tools:
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3 Repeat the procedure to rotate an image through 180°, or 270°.

The thumbnail in the Navigator palette reflects the new orientation. The 
Navigator palette does not resize; the thumbnail does. The feed direction and 
punch indicators are also rotated.

In “Size to Fit” mode the window size may need to grow to accommodate the 
new orientation and to keep the same zoom level. If this is not possible, the zoom 
level is adjusted to the “Size to Fit” mode. The window only grows if necessary; 
it never shrinks.

NOTE: Rotating an image does not change the raster data, or affect other views.

 To flip an image

1 Select the Preview window which contains the image you want to flip.

2 Select View > Transform > Flip Horizontal to flip the image on the 
horizontal axis (left-to-right).

3 Select View > Transform > Flip Vertical to flip the image on the vertical axis 
(upside-down). You can also use the Flip tools:

The thumbnail in the Navigator palette reflects the new orientation. The feed 
direction and punch indicators are also flipped.

NOTE: Flipping an image does not change the raster data, or affect other views.

 To invert an image (negative)

1 Select the Preview window which contains the image you want to invert.

2 Select View > Transform > Invert, or click the Invert tool.

The image is inverted. The thumbnail in the Navigator palette also reflects 
the new state.

Inverting an image is useful for previewing negative separations. It trans-
poses the solid areas of an image to transparent, and transparent areas to 
solid, and is applied to each of the image separations.

For example, suppose an image is made up of 4 separations; cyan, magenta, 
yellow, and black. Each separation is actually made up of only 2 types of 
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areas - solid areas (black) and transparent areas. When you select Invert, 
Preview reverses the display of these areas individually on each separation. 
This means that, on the cyan plate, all cyan areas are displayed as trans-
parent, and all transparent areas are displayed as cyan. The same reversal is 
applied to the magenta, yellow, and black plates.

NOTE: Inverting an image does not change the raster data, or affect other 
views.

 To display a full-size image

1 Select the Preview window which contains the image you want to display.

2 Select View > Actual Pixels.

The image in the currently active Preview window is displayed full size, at the 
zoom factor of 1:1 (i.e. one raster data pixel is displayed using 1 screen 
pixel).

NOTE: Only the full version of Apogee allows you to preview high resolution 
raster data (in order to check traps, halftone dots, etc.). Certain Apogee 
versions can be upgraded to include the high resolution Raster Preview 
option.

 To display/hide separations

1 Select the Preview window which contains the image you want to view.

2 Select the Inks palette.

This window allows you to toggle individual separations on or off.

3 Click the eye icon next to one or more of the ink names to toggle the 
separations on or off.

You can hold down the Alt key when you click on the eye icon. This hides all 
other separations, showing only the one you clicked on. Repeat this action to 
bring back all hidden separations. Alt-clicking on a hidden separation shows 
that separation, hiding all others.

All combinations of process and spot color separations can be selected.

 To view raster data as a press sheet

1 Select the Preview window which contains the image you want to view.

2 Select View > Press Sheet.
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The raster data is displayed as a press sheet (positive and gripper edge 
down). 

NOTE: This does not change the raster data or your Client Preference settings, 
and does not affect any other views.

 To view raster data as output from an imaging device

1 Select the Preview window which contains the image you want to view.

2 Select View > Device Output.

The raster data is displayed as if it were the output of the imaging device 
(polarity, orientation, reading, and punch marks are set accordingly). In this 
view, the feed direction indicator in the Navigator palette always points up.

NOTE: This does not change the raster data or your Client Preference settings, 
and does not affect any other views.

 To show / hide the Ruler

1 Select the Preview window.

2 Select View > Rulers, or click the Rulers tool to toggle on or off the Ruler in 
the Preview window.

The Ruler is displayed along the edges of the Preview window, starting from 
the top left corner. The default unit of measurement is taken from your 
Preferences.

When the zoom level is sufficiently high, the ruler has the following marks:

You can display rulers for each of the Preview Windows. 

 To show / hide the Grid

1 Select the Preview window.

2 Select View > Grid, or click the Grid tool to toggle on or off the Grid in the 
Preview window.

Units Numbered marks Major marks Minor marks

cms Every cm Every 1/2 cm Every mm

inches Every inch Every 1/2 inch Every 1/8 inch
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Gridlines are displayed for every major and minor division of the Ruler. 
Major divisions are drawn in dark blue, subdivisions in light blue.

NOTE: The gridlines do not necessarily match with the ruler divisions.

Measuring Ink Coverage

The Inks palette indicates the percentage of ink that is used in any given area of 
the currently active Preview window. This feature is used in conjunction with 
the Marquee tool.

 To measure the ink coverage of a selected area

1 Select the Preview window which contains the image you want to measure.

2 Make sure the Inks palette is displayed and the Cursor/Selection button is 
selected.

3 Select the Marquee tool.

4 Click and drag the mouse to define a rectangular area in the Preview window.

The selected area is displayed with a dotted outline.

The Inks palette displays the ink coverage within the selected area. To 
indicate that it is not the global coverage, the total percentage is displayed in 
italics. If no area was selected, the ink coverage for the entire active Preview 
Window would be displayed, and the total percentage would be displayed in 
normal characters.
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The ink coverage percentage is displayed for each process color, and any spot 
colors. This information is calculated on the basis of the real pixel data, and 
is accurate to within around 3%. When zoomed in at 1:1, the information is 
accurate to 1%.

NOTE: Calculating ink coverage might take a while. A dash is displayed until 
the result has been calculated. When you change the selection, Preview 
restarts the calculation; you do not have to wait for the calculation to finish.

5 If you wish, you can select the rectangular area you defined in the Preview 
window, and drag it around to measure different areas of the image.

6 Click outside the rectangular area to cancel this selection.

When calculation is off, or in progress, the Covers % displays dashes (-).

NOTE: When the Inks palette is displayed, it is updated every time a new area 
is selected in the Preview Window. If an ink is deselected in the Inks palette, 
no Cover % for that ink will appear.

 To measure the ink coverage at cursor point

1 Select the Preview window which contains the image you want to measure.

2 Make sure the Inks palette is displayed and the Cursor/Selection button is 
selected.

3 Click where you want to measure the ink coverage.

The Inks palette displays the ink coverage within the selected area. To 
indicate that it is not the global coverage, the total percentage is displayed in 
italics.

 To measure the ink coverage of the whole page/image

1 Select the Preview window which contains the page or image you want to 
measure.

2 Make sure the Inks palette is displayed and the Image button is selected.

The Inks palette displays the ink coverage for the entire active Preview 
Window. To indicate that it is the global coverage, the percentages are 
displayed in normal characters (not in italics).
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The ink coverage percentage is displayed for each process color, and any spot 
colors. This information is calculated on the basis of the real pixel data, and 
is accurate to within around 3%. When zoomed in at 1:1, the information is 
accurate to 1%.

NOTE: Calculating ink coverage might take a while. A dash is displayed until 
the result has been calculated. When you change the selection, Preview 
restarts the calculation; you do not have to wait for the calculation to finish.

When calculation is off, or in progress, the Covers % displays dashes (-). If an 
ink is deselected in the Inks palette, no Cover % for that ink will appear.

Measuring Screen Angles

This section describes how to measure screen angles. This helps you to avoid 
unwanted moiré effects in your final output.

 To measure screen angles

1 Select the Preview window which contains the image you want to measure.

2 Select the Measurement tool.

TIP: You need to select a 
good pattern to achieve 
useful results.

3 Click a reference point inside the Preview window and drag the mouse 
pointer to another position in the window.

As you move the mouse, Preview automatically calculates the distance and 
angle between the point where the mouse button was pressed and the 
current mouse position. Distances are measured in the units you have 
specified.
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NOTE: If you press the Shift key  while dragging the mouse, the direction of 
the line you draw will be restricted to a horizontal, vertical, or diagonal 
direction.

A line connects the start and end reference points. The distance between the 
reference points and the angle of the line are displayed in the status bar.

 The first of these two values indicates the actual distance between the two 
points, in the user-specified units.

 The second value indicates the screen angle between the two points, 
expressed in degrees.

The angle is measured counterclockwise from the zero angle reference axis 
through to the starting point (i.e. the point you started dragging the mouse). 
If the value is greater than or equal to 180, the read-out will be decremented 
by 180.

To the right of the displayed values in the status bar, you will see some 
additional measurements.

 The first of these two values indicates the horizontal distance between the 
two points, in the user-specified units.

 The second value indicates the vertical distance between the two points, 
in the user-specified units.

NOTE: By default the unit of measurement for the above fields is taken from 
your Preferences.

Measuring Line Frequency

This section describes how to measure the line frequency of a separation.

 To measure the line frequency of a separation

1 Select the Preview window which contains the separation you want to 
measure.

2 Select the Measurement tool.
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3 Zoom the image so that you can see the raster dots.

When you do this, you will see that 

4 Select a dot, and drag the mouse pointer along the line of the raster to 
another dot.

As you move the mouse, Preview counts the number of dots along the line 
and automatically calculates the line frequency. The readout in the Status 
bar shows the number of dots found and the resulting frequency. The 
frequency is displayed in line per inch (lpi) or lines per cm (lpc), depending 
on the units you specified in your Preferences.

Color-Managed Raster Preview

Color-managed raster preview is a preview of the rendered result using color 
management to convert the press color space to the monitor color space, based 
on ICC profiles. Contract proofing quality can be achieved, provided you have a 
calibrated monitor and correctly configured monitor profile. 

NOTE: Color-managed raster preview is a licensed feature.

 Activate color-managed raster preview 

1 Select the Preview window which contains the image you want to preview.

2 Click the Color-managed Preview tool to activate the color-managed 
preview.

Selecting Color-managed mode will disable the ink display in the Inks 
palette.

To activate the enhanced visualization of overlapping spot colors, the 
following additional preview license is required:

 accurate spot color mix preview

In this enhanced mode, spot color visualization is superior to the standard 
color-managed mode.
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You may also see one of the following icons, which indicates the status of the 
monitor (see “Viewing Remarks” on page 89).

Monitor Display Rating

Depth Tool

With the Depth tool you can display a depth map of a monochrome, 8-bit file 
using indexed colors. Each pixel value (1–254) is mapped to a different color in 
a one-to-one relation between pixel value and color depth. The color palette uses 
the colors of a rainbow with color value 0 shown as black.

 Activate and show the Depth palette

The tool is only available when the required license is present and the file type 
being viewed allows for the tool to be used.

 Choose Window > Palettes > Show Depth to open the Depth palette or 
press CTRL+ALT+H. The option is only enabled if a required file type is 
being viewed.

OR

 Click the Depth tool in the Tools palette.

The monitor status is up to date and the overall display rating is greater than 90% (Excellent). 

The monitor status is up to date and the overall display rating is between 80% and 90% 
(Medium).

The monitor status is up to date and the overall display rating is less than 80% (Bad).

There is no monitor status, or it is out of date (Undefined).
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 Enabling Depth view

 In the Depth palette, select the View Depth check box or press ALT+H.

The depth map is applied to the image and the state of the Depth tool icon 
changes to enabled. Now you can move the cursor over the image and read 
the depth on the rainbow bar in the Depth palette.

Depth Palette

View Depth check box Select the check box to show/hide the image using mapped indexed colors.

Rainbow bar The vertical, colored bar represents the full range (1-254) of pixel values. The 
top of the bar has the lowest values, with black representing zero. The maximum 
pixel value is 254 at the bottom of the bar.

Range sliders The two sliders define the depth range from 1 to 254. Drag the sliders to adjust 
the range or click in a slider to type an integer value between 1 and 254.
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Pointer value As you move the mouse cursor over the image you can see the depth value on the 
rainbow bar for the pointer position in question, with the actual values shown 
next to the sliding marker.

Pointer position The horizontal and vertical distance between the pointer and the selected refer-
ence point, with arrows depending on the selected reference point.

Reference point The point on the sheet that serves as the reference point for the pointer position. 
Click one of the nine reference points to set the reference point.

Related topics: • Mark Pens on page 1081

Distortion

The Distortion Raster Preview shows the distortion caused by the web growth. 
When Distortion is selected, Raster Preview applies the web-growth compensa-
tion, otherwise Raster Preview shows the uncompensated raster. 

NOTE: This option requires a special license.

 To view the Distortion

Select the Preview window which contains the image you want to view the 
distortion.

 Choose Window > Palettes > Show Tools to open the Tools palette and click 
Distortion (Web Growth) tool button. 

OR

 Choose View > Distortion (Web Growth), or press ALT+G.

You can toggle between the distorted and not-distorted views. To view the 
distortion better, it is recommended to zoom in higher resolutions.
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Related topics: • Edit Distortion Values on page 555
• WebGrowth Profiles on page 1146

Saturation, Contrast and Channel Adjustments

NOTE: This feature only applies for jobs using the M-Press Task Processor and 
only on clients with Windows.

The Adjustments palette has three panels with the following tools to adjust 
rendered results:

 Saturation slider: The slider has a range from -100 to +100 with a default 
value of 0 as the neutral setting. You can apply an adjustment by selecting the 
check box and dragging the slider, clicking in the slider path or entering a 
value. The Protect skin tones option lets you disable the saturation adjustment 
for skin tones.

 Contrast adjustment curve: This adjustment controls the luminance of the 
rendered result which can range from 0% (black) to 100% (white). The plot 
area consists of a horizontal In axis and a vertical Out axis, and a diagonal 
baseline where the In and Out values are the same. The baseline is black if no 
adjustments have been applied and changes to gray once you begin to make 
adjustments. Drag any point on the black baseline or curve to make adjust-
ments. You can also choose an adjustment preset by clicking the cogwheel 
and selecting a preset you defined in the Contrast Adjustment resource for 
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this particular device. Make sure the Contrast check box is displayed to see 
the effect on the sheet.

 Channel adjustment curves: These curves control the CMYK ink coverage of 
the device within a range of 0% (no ink) to 100% (full coverage). The plot 
area consists of a horizontal In axis and a vertical Out axis, and a diagonal 
baseline where the In and Out values are the same. Choose the channel that 
you want to adjust from the drop-down list (Cyan, Magenta, Yellow, Black) 
to activate one of the four channel curves. Drag any point on the curve to 
make adjustments. You can also choose an adjustment preset by clicking the 
cogwheel and selecting a preset you defined in the Curve Adjustment 
resource for this particular device. Make sure the Curves check box is 
displayed to see the effect on the sheet.

You can revert to the initial values by clicking the revert button.

Figure 4.1: Saturation slider, Contrast and Channel Adjustment curves in Raster Preview
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A warning icon is displayed when you make adjustments and these adjustments 
cannot be shown in the current preview mode.

Switch to Contone Preview using the zoom level menu to see the effect of the 
adjustments on the sheet.

Comparing Results

The Raster Compare feature lets you compare the results of two jobs with each 
other. This is particularly useful for security printing applications where you 
may need to check extremely small differences in the raster data. The feature can 
also be used in regular commercial printing environments to compare the 
difference between previously rendered data and the latest result.

You start the Raster Compare using the Compare palette, and you can also use 
the Inks palette to compare ink coverage in the two images.

NOTE: You cannot compare with a job archive result.
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 Compare the results of two jobs

1 Open the first page or flat you want to use for the comparison.

2 Choose Window > Palettes > Show Compare to open the Compare 
palette.

The current image you are viewing is image A of the comparison and the job 
name and signature are specified at the top of the palette.

3 Click the browse button on the second line to choose the preview data you 
want to compare the current image with (image B or reference image).

4 Select the reference job (image B) in the list on the left; if the list is long, use 
the filter.

The available Results for the selected job are listed on the right.

5 Choose the Results you want to compare with and click Open.

A blue progress bar is displayed as the system compares the two images, and 
the reference image is now specified on the second line in the palette.

6 A mask for each image shows the pixels which are only in the respective 
image. In the Display panel, moving the slider to the right increases the 
intensity of these masks and hides the actual image. You can alternate 
between both images by clicking A or B. You can change the color of the two 
masks by clicking the patch and selecting another color in the picker.

7 In the Inks palette, you can check whether the ink coverage for the two 
images is the same (indicated with a green check mark) or not the same 
(indicated with a red cross).
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8 In the Alignment panel you can enter positive or negatives values (Offset) to 
move the reference image (image B) horizontally and/or vertically and align 
the images. You can choose a reference point (Origin) to apply the offset.

NOTE: When you’ve finished comparing and close the Preview window, none 
of your alignment changes are saved.

Approving/Rejecting Jobs

You can approve or reject any job item which has a Waiting for Soft Approval 
status (icon on the left) in the Job List or the Job Layout panes. You can also 
approve any soft proof which was previously rejected (icon on the right).

 To approve or reject one or more job items

1 Select the Preview window which contains the image you want to assess.

2 Select and analyze the raster data.

This may be a single page/flat, several pages/flats, or the entire job.

3 If the results are satisfactory, click the Approve tool (left icon): Otherwise, 
click the Reject tool (right icon).

NOTE: These icons are disabled if no soft proof has been requested.
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4 If you select Approve, the selected results are continued. 

If you return to the Jobs window, you will see that these results are no longer 
on hold, and the separation indicators have check marks, indicating that they 
have been output.

5 If you select Reject, a Reject confirmation dialog box is displayed. Here, if you 
wish you can enter some comments about the rejected item, and click Reject 
to proceed. 

If you return to the Jobs window, you will see that these results are no longer 
on hold, and are marked with a red stripe, indicating that they have been 
rejected.

6 Click OK.

The selected items are now either approved for output to a physical output 
device, or rejected. Any associated Waiting for Approval icons are removed 
in both the Job List and Job Layout panes.

When you reject job results, the results are marked as “rejected” in both the 
Job List and Job Layout panes. However, the results remain in the system, 
and are not deleted until the date/time specified in your Logging options (see 
“Logging” on page 679). This gives you a time window during which you can 
still approve the rejected results before they are automatically deleted from 
the system.

NOTE: You do not have to approve or reject an item before quitting Preview. You 
can always approve or reject it later.
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 To approve a rejected item (override)

1 Select an item marked as rejected in the Job Layout pane.

2 Click the Approve tool.

A Continue confirmation dialog box is displayed.

3 Click Continue.

This overrides the rejected status. The job item is again put on hold (blue 
background), and is now approved for output.

NOTE: Although the rejected item has now been approved, it still retains the 
red stripe, indicating that it was once rejected.

4 To output the results, select the job item and click the Approve tool again.

You will see that these results are no longer on hold, and the separation 
indicators have check marks, indicating that they have been output.
APOGEE Reference Guide



 

4 PREVIEWING JOB RESULTS 135
Comparing Version-Specific Plates

Suppose you have a job with three versions, containing a photograph that prints 
in CMYK. The three versions share the CMY plates, and have each their own K 
plate. For the photograph to print correctly in all versions, the image on the K 
plate of each version must be aligned precisely with the common CMY plates. 
The shift may be small and hard to notice when previewing the version on 
screen. However, it will become very obvious in print. 

To quickly and easily spot such shifts, Raster Preview allows you to inspect 
misalignment issues in multi-version jobs by comparing version-specific plates 
against each other. The goal is to spot objects that were shifted across versions, 
especially when those versions share a set of common plates.

The idea is to keep one version - the master version - on a light table, and to lay 
the next version on top of it. When looking at the layered composite, unwanted 
shifts become immediately obvious. By switching the top layer, and comparing 
it against the same master, you can quickly verify the registration of the different 
versions. A quick way to check whether there might be a problem, before 
comparing individual versions, is to layer all versions on top of each other; 
common images should still look OK. If you notice a shift, you can then use the 
comparison technique to identify the problem version (or versions).

For example, suppose you want to compare the K-plate of a Dutch version with 
an English one. The misalignment in the text is normal, since the texts are 
different. However, any images on the page will be shifted to make room for the 
longer Dutch text.

View modes You can control the viewing mode by clicking the viewing mode selector in the 
Versions palette, or by selecting View > Versions. You can also switch modes 
using the shortcuts: ‘N’ for Normal mode, ‘A’ for All and ‘C’ for compare.

 Normal Mode: Views each version as printed, one by one. The previous and 
next version shortcuts simply switch the version being viewed. By default, 
you see all plates that make up the version, but you can view the version-
specific plates only. 

 All Versions Mode: Shows all version specific plates on top of each other. 
View > All Versions or ‘A’ shortcut. If you double click a flat from within the 
Results tab in ‘View All’ mode, Raster Preview starts in ‘All’ mode. 
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The plate of the first version shown is magenta: This is the reference version. 
The other plates are all shown in cyan. Shifted pixels therefore stand out very 
clearly. 

NOTE: This mode only shows version-specific plates: You cannot switch this 
off. 

 Compare Mode: Shows the version specific plates of the master version and 
a version, layered on top of each other. The master and version plates appear 
in different colors to highlight possible shifts. 

The previous and next version shortcuts keys switch the top-layered version, 
keeping the master plate underneath. You can also click a version in the 
palette to select it immediately.
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Viewing/Editing Raster Preview Preferences

A set of Raster Preview Preferences allow you to specify default viewing settings 
(units of measurement, etc.) that will be used each time you launch Raster 
Preview.

 To open and edit your Raster Preview Preferences

1 From the Jobs window, choose Edit > Preferences...

2 Select the Viewers tab.

3 Edit the Raster Preview fields, as described in “Preferences” on page 92.

QuickProof

The QuickProof feature is only available for 1-bit screened data for CTP/CTF 
devices.

QuickProof allows you to send a full preview or a selected area to a proofing 
device.

 QuickProof a preview

1 Open the preview and select the area that you want to proof.

2 Choose Control > QuickProof.

The QuickProof dialog box is displayed where you can select a proofing 
device.

3 If you want to proof only the selected area, select the Proof selected area 
check box. Otherwise, clear this check box.

4 Click QuickProof.
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The Jobs Window

The main purpose of the Jobs window is to allow you to monitor, view, and 
manage the jobs that are created by the Apogee System. Much of the information 
you need is displayed as icons in the Job List. This information, together with the 
six tabs of selected job details, gives you a full and detailed snapshot of the jobs 
in hand.

The main window is divided into 4 panes:

 The Output Device List: On the left side of the window, you see a list of 
currently configured output devices, e.g. Export, TIFF Imagesetter, etc.

 The Job List: Next to the Output Device list, you see the Job List. This list 
displays the jobs that have been submitted to the Apogee System. 

NOTE: Only jobs associated with the device selected in the Output Device List 
are displayed.

 Filters: Above the Job List, you can enter filter criteria directly into the Quick 
Filter box. Below the Output Device List, you have custom job filters for 
filtering the Job List based on a variety of criteria.

 Selected Job details: The pane on the right side of the window displays infor-
mation on the selected job:

 The Administration tab: Contains customer-specific information that can 
be used to associate specific processing workflows with particular 
customers or job types. See “Viewing the Administration Tab” on 
page 170.

 The Options tab: Displays information on how the job is to be handled, 
including archiving and notification settings, post-processing channel 
settings, etc. See “Viewing the Options Tab” on page 171.

 The Products tab: For multi-part and multi-product jobs, this tab displays 
information on how the job is structured, and how each individual section 
of the job will be processed. See “Viewing the Products Tab” on page 172.

 The Plan tab: The Plan tab displays the selected job’s Production Plan, and 
allows you to view the individual settings of each of the items in the Plan. 
See “Viewing the Plan Tab” on page 174.
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 The Pages tab: Lists the documents that have been input to the Page Store, 
and the pages that have been copied from the Page Store and included in 
the job’s Run List. See “Viewing the Pages Tab” on page 176. 

 The Results tab: Allows you to view the results of the selected job. This tab 
displays thumbnails of the Run List pages, and job separations (if any). 
See “Viewing the Results Tab” on page 183.

NOTE: The Job Manager provides a read-only view on jobs. For details on 
creating or editing jobs, see “Creating and Editing Tickets” on page 281.
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The Output Device List

The Output Device List displays all available Output and Print Task Processors. 
This pane is identical in both the Jobs Window and the Hot Tickets Window.

When you select an Output or Print Task Processor in the Jobs Window, the Job 
List is filtered to display only the jobs that include the selected Task Processor in 
their Production Plan. 

NOTE: Depending on their software or hardware status, Task Processor icons 
may be displayed with different colors or with small icon overlays. For more 
information, see “Task Processor Component (Software) Status” on page 665 
and “Output Task Processor Hardware Status” on page 664.
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The Job List

The Job List displays the status of jobs that have been submitted to the Apogee 
System. This includes jobs created using Job Tickets, as well as jobs created 
dynamically using Hot Tickets.

Job List Layout When you create and submit a job, it appears immediately in the Job List with its 
details displayed in columns. You may see a flat list of jobs or groups of jobs in 
expandable folders if you choose to group your jobs. 

For each job, the Job List displays one or more icons which indicate its current 
status, and the type of processing that has been applied in this job. A job 
produced by a Hot Ticket is indistinguishable from any other manually 
submitted job.

The Job List is divided vertically into the following columns:

 Notification: May display an icon which indicates an error, warning, or 
remark.

 Status: May display one or more icons (up to 4) which indicate the current or 
recent job states. These icons are sorted from the left according to priority. 
You can expand the width of this column to view the lower priority icons.

 Job: Either the name of the job, or an expandable group folder which 
contains all the jobs that are grouped by the selected property.

 Order Number: The order number of a job.

 Job Number: A unique ascending number assigned chronologically to each 
job.

 Media: The media selected to print the job.

 Flows: Displays one or more icons which correspond to the number and types 
of flows specified in the Ticket.

 Create Date: The dates and times when jobs were submitted. The date and 
time format adapts automatically to the width of the column.

 Modified Date: The dates and times when jobs were modified. The date and 
time format adapts automatically to the width of the column.

 Company: The company name of the customer.
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 Device: The device selected to print the job.

 Milestone: The due date you entered for the planning of the job.

These job details are displayed for each job in their respective column.

The Job List is also divided horizontally into two lists. The upper list displays all 
the Private Page Store jobs which have been created: The lower list displays all 
the Public Page Store jobs which have been created.

For more information, see “Private and Public Page Stores” on page 177.

Organizing the Job 
List

By default, the Job List displays jobs in alphabetical (ascending) order with all 
the columns displayed. You can organize how the Job List is displayed as follows. 

 Sort Job List columns

Job List columns can be sorted according to any of the column headers by 
clicking the relevant column header: Click once to sort alphabetically 
(ascending); click again (or Shift-click) to sort in reverse alphabetical order 
(descending).

The sort column is indicated with a darker header and an arrow indicates the 
ascending or descending sort order. You cannot sort on the Flows column.

 Rearrange Job List columns

You can rearrange the columns by dragging the column headers horizontally, 
and adjust the width of the columns by dragging the left or right edges of the 
column headers.
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 Show/hide Job List columns

Context-click in any of the column headers to display a menu where you can 
show/hide the columns by selecting/clearing the appropriate check box.

 Group jobs in the Job List

You can group jobs by clicking in the column header context-menu and selecting 
the Group by option. You can group by:

 Order Number

 Create Date

 Modified Date

 Device

 Media

 Company

For example, selecting Group by Order Number, groups the jobs with the same 
order number in an expandable folder. These expandable order number folders 
are shown in the Job column and the Order Number column is hidden.

TIP: You can also click the 
expand/collapse buttons to 
open and close job folders.

If you double-click a job group in the Job List, the folder is expanded to reveal 
the individual jobs. The job will have no content until you or other users start 
inputting documents via the associated input channel.
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The # symbol you see on the folders indicates that the jobs in the Job List are 
grouped into folders.

Filtering the Job 
List

You can customize the layout and content of the Job List to suit your particular 
requirements, and to keep track of your jobs more easily. This becomes more 
important as the size of the Job List increases, while you want to keep track of 
specific orders and/or jobs.

Apogee filters the Job List based on a combination of all the selected filters. 
When you apply the filter, only the jobs which match ALL the selected criteria 
will be displayed. 

The following three filter types are available above and below the Output Device 
list on the left of the Job List:

 Quick filter: a text entry box

 Output Device filters to filter jobs by device (number of matching jobs to the 
right of the device name)

 Custom Job filters that allow users to specify custom sets of filter criteria 
(number of matching jobs to the right of the filter name)

You can apply the filters individually or combine them. Combining filters of the 
same type, e.g. two Output Device filters, displays the sum of the two filters. 
Combining filters of different types, e.g. Quick filter + Output Device + Custom 
Job filter, only displays the jobs that match all the criteria of the filters.

These filtering features also apply for Hot Tickets in the Hot Ticket List.

NOTE: An Administrator can also filter the Job List by user role to allow specified 
users to see only certain jobs. This filtering is not indicated in the Job List. See 
“Users” on page 695.
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NOTE: The Output Devices pane must be set to show to see the Show All button 
and the Custom job filters panel. Choose View > Panes > Devices to show/hide 
the Output Devices pane.

 Filter the Job or Hot Ticket List using Quick Filter

The Quick Filter can be used to search for text contained anywhere in the order 
number, job name or number, media name of jobs or Hot Tickets. The Quick 
Filter is always applied in addition to other selected filters.

1 Select the Jobs or Hot Tickets Window.

2 Click inside the Quick Filter text field.

3 Start to enter the text you want to search for.

As you type, the list is dynamically filtered. 

For example, if you type the letter ‘j’, the Job List will start filtering for all jobs 
with fields that contain the letter ‘j’. If you extend the search text to ‘je’, the 
number of matches are further narrowed down accordingly.

4 Click the Clear button on the right of the Quick Filter text field to remove the 
Quick filter.

Figure 5.2: Job List filters
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 Filter the Job List with one or more custom job filters

1 Select the Jobs Window.

2 Click one of the custom job filters under the output device pane.

The Job List now displays only the jobs which correspond to the selected filter 
criteria.

The selected Job List Filter icon is colored green to indicate that this partic-
ular filter is active, with an arrow pointing to the number of jobs displayed for 
this filter.

In the filter panel in the top right corner of the Job List, you can also see the 
total number of jobs displayed in the Job List, with an indication that a filter 
is applied.

3 To switch off a job filter, click the filter once.

The Show All indicator is highlighted and all the jobs are displayed if no other 
filters are selected.

4 To apply multiple filters, hold the CTRL button and click the filters you want 
to combine. Click a selected filter again with the CTRL button pressed to 
deselect it. You can combine Custom Job filters with Output Device filters 
and Quick filter.
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Combining filters of the same type, e.g. two Output Device filters, displays 
the sum of the two filters. Combining filters of different types, e.g. Quick 
filter + Output Device + Custom Job filter, only displays the jobs that match 
all the criteria of the filters.

 Create a new custom job filter

The first new custom filter is created as a duplicate of the initial Custom Filter. 
Subsequently, you can also duplicate your newly created filters.

1 Hover over the initial Custom Filter and choose Save As in the cogwheel 
drop-down list.

2 Enter the new name in the Save As box and click Save.

The new filter is added to the bottom of the list. This is a duplicate of the 
initial Custom Filter which always remains at the top of the list.

You may need to scroll through the list with the Up and Down arrows.

3 To move the filter in the list, hover over the filter and choose Move Up/Move 
Down in the cogwheel drop-down list. You can also insert a dividing line 
under a filter by choosing Insert Divider in the same drop-down list.

You can now edit this newly created filter.
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 Edit a custom job filter

1 Hover over the filter you want to edit and choose Edit in the cogwheel drop-
down list.

2 Specify your filter options, as described in “Job Filter Settings” on page 157.

3 Click Apply to see the effects of the filter on the number of jobs displayed in 
the Job List.

4 Click Save to confirm your changes and close the Job Filter dialog.

 Rename/duplicate/delete a custom job filter

 Hover over the filter name you want to rename/duplicate/delete and choose 
the action in the cogwheel drop-down list.

NOTE: You cannot rename/duplicate/delete/move the initial Custom Filter.

 Filter the Job or Hot Ticket List on the selected output device

1 Select the Jobs or Hot Tickets Window.

The number of jobs using a particular output device is shown on the right of 
each device name in the Output Device list.

2 Select one of the devices in the Output Device list.

The Jobs/Hot Tickets List now displays only the jobs or tickets which use the 
selected output device.

In the filter pane in the top right corner of the Job List, you can see the total 
number of jobs or Hot Tickets that use the selected output device.

3 Click another output device or the Show All filter to remove the filter. Hold 
the CTRL button and click multiple output devices to display the jobs of all 
the selected devices.

Job Notification 
Icons

Apogee displays Job Notification icons in the 1st column of the Job and Hot 
Ticket Lists. These icons indicate errors, warnings and remarks, and are sorted 
by priority; i.e. when a job has several notifications at the same time, Apogee 
displays the highest priority icon.
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A group of jobs (order number folder in the job list) shows the icon of the job 
with the highest priority notification within the group.

NOTE: The Hot Ticket list can only display a limited subset of these Notification 
icons.

The icons you may see are as follows (listed in order of priority):

You can click any of these icons to display a detailed Problem Report.

Job Status Icons Apogee displays Job Status icons in the 2nd column of the Job and Hot Ticket 
Lists. These icons indicate the current or last activity associated with the corre-
sponding job.

The Status icons are sorted by priority; i.e. when a job has several states at the 
same time, Apogee displays the highest priority icon first.

A group of jobs (order number folder in the job list) shows the status icon of the 
job with the highest priority status within the group. The exceptions are the 
archiving, deleting and finished status icons. The first two are never shown, and 
the last is only shown when all jobs in the group are finished.

The Apogee system issued a critical message.

The job has stopped pending user interaction.

The job has generated an error, and has stopped.

The job has generated a warning.

WebApproval message: A message on this job (or results) was received from WebApproval.

The job has generated an information message.
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NOTE: The Hot Ticket list can only display a limited subset of these Status icons.

The icons you may see are as follows (listed in order of priority):

The job is being archived or dumped.

The job is being imported from archive.

The job is being deleted.

Apogee is queuing all commands for this job.

The document is being edited (it is ‘checked out’).

The job is being edited by another user.

The Run List is being edited by another user.

You are editing the job. 

You are editing the Run List.

The job is finished.

The job was broken during editing. You can remove this icon by opening the job for editing.

The job has been manually put on hold.

The job output is waiting for the correct media to be loaded on the output device.

The job is waiting for a Task Processor (none currently available).

A group of results is complete, and is waiting to be printed (blue icon).

The result is waiting for a hard proof.

The result is waiting for a web proof.
Apogee Reference Guide



 

5 MANAGING JOBS 153
Job Icons Apogee displays Job icons in the Job or Order No columns of the Job List. These 
icons indicate the type of job, as well as whether or not the Run List is complete.

With the exception of the Job folder icon, all the basic Job icons may be super-
imposed with one or more additional icon indicators. These provide supplemen-
tary status information, and allow you to make a highly detailed visual 
assessment of your jobs by simply looking at the Job List.

The job is waiting for a soft proof.

A task has been aborted.

The task has been manually put on hold.

New (unplaced) documents are available in the (Private) Page Store.

The job is waiting for results.

Not all the results of a group are yet available (green icon).

The job is waiting for After Hours processing.

Some results have been rejected by the user.

The layout/imposition is not yet defined.

The job has reached a Milestone: The Run List is not complete. This Milestone was set up in 
the Options tab.

The job has reached a Milestone: The job deadline has been reached. This Milestone was set 
up in the Options tab.

The job has reached a Milestone: The result is not available in time. This Milestone was set up 
using a Milestone Action in the Production Plan.

The job is managed by PlateMaker (ready to plate). The PlateMaker client will take care of fur-
ther plate production.

A job that has been merged

A merged job: The job resulting from the merging of two or more other jobs.

A StoreFront job: The job was generated by StoreFront.
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These icon indicators may be combined, so that up to 4 additional items of infor-
mation may be displayed for any of the Job icons (see “Job Icon Combinations 
(Commercial Jobs)” below).

NOTE: Only the Complete Run List icon is displayed in the Hot Tickets List.

Job Icon Combinations (Commercial Jobs)

The following table lists all the possible icon combinations you may see for 
Commercial jobs.

Job group.

Commercial job with incomplete Run List.

Commercial job with complete Run List.

Rush job (Commercial jobs only).

Commercial job with disabled input channel.

Commercial job is scheduled to be archived when it is finished (Options tab).

Commercial job has been archived.

Commercial job is scheduled to be deleted when it is finished (Options tab).

Commercial job has been deleted.

Commercial job is scheduled to be archived and deleted when it is finished (Options tab).

Commercial job has been archived and deleted.

Job group (based on Order Number).

Commercial job with incomplete Run List.
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Flow Icons Apogee displays Flow icons in the Job and Hot Ticket Lists. These icons corre-
spond to the number and types of flows specified in the job or ticket:

When you create a Ticket, it appears in the Job/Hot Ticket List, together with 
one or more Flow icons in the Flows column. 

The Flow icons display:

 the type of flow, indicated by the icon image.

 the status of the flow, indicated by the icon color. 

The following icon types are available:

Job status normal deleting deleted
archiving/
dumping

archived/
dumped

archiving
& deleting

archived
& deleting

archived
& deleted

Incomplete Run List

Incomplete Run List
disabled input

Incomplete Run List
rushed job

Incomplete Run List
disabled input+rushed job

Complete Run List

Complete Run List
disabled input

Complete Run List
rushed job

Complete Run List
disabled input+rushed job
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The different flows associated with a job can also be monitored in The Activity 
Pane.

Up to three flow icons may be displayed for each job or ticket.

Flow Icon Color Coding

As a general rule throughout the Apogee user interface, you will find that 
specific icon background colors are associated with specific conditions. 

In the Job List, the background color of each flow icon indicates one of several 
states, as follows:

Main Output to a high resolution output device.

Main Output to a Sign and Display output device.

Imposition Proof: An optional flow which may be added to the Main Output flow, and is used 
for output to an imposition proofing device.

Page Proof: An optional flow which may be added to the Main Output flow, and is used for 
output to a page proofing device.

Export: An optional or alternate flow to the Main Output flow, used for exporting job results to 
file in PDF or PostScript format.

Public Page Store: An optional or alternate flow to the Main Output flow, used for storing job 
results in a Public Page Store.

Display: An optional or alternate flow to the Main Output flow, used to create job results for 
high-resolution soft proofing.

Digital Quick Strip (DQS): An alternate mode of operation which supports the PrintDrive DQS 
mode of Apogee Series3. In this mode, Apogee creates and renders the flat backgrounds and 
pages separately. These are then sent as separate items to PrintDrive. PrintDrive assembles 
the pages onto the backgrounds, and then outputs the results as an integral job.

Collecting Hot Ticket: Uses the Collect TP to collect images and create special Hot Tickets.
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Job Filter Settings

The Job Filter allows you to filter the jobs displayed in the Job List according to 
job status, administration fields, media, or date.

 Display the job filter settings by hovering over the filter name and clicking 
Edit in the cogwheel drop-down list.

A white background color indicates that this flow is idle. 

A green background color indicates that this flow is currently active. 

A blue background color indicates that this flow is on hold.

A yellow background color indicates that this flow contains tasks which are queued and wait-
ing to be processed.

A white background color with a green checkmark indicates that this flow has finished. 

A red background color indicates that this flow has generated an error.

A purple background color indicates that further handling of this flow has been taken over by 
the PlateMaker Client (Main flow only). For more details, refer to the PlateMaker Client docu-
mentation.
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Status

In Page Store To filter on Page Store criteria, select the In Page Store check box, click the 
associated list, and choose one of the following options:

 New documents: Displays only jobs that contain new documents that have 
not yet been added to the Run List.

 No new documents: Displays only jobs that have no new documents.

Pages To filter on Run List criteria, select the Pages check box, click the associated list, 
and choose one of the following options:

 Has All: Display jobs that have a complete Run List. 

 Misses Some: Display jobs that have incomplete Run Lists.

For more information, see “The Run List (Ticket Editor)” on page 335.

On Hold To filter on jobs on hold, select the On Hold check box, click the associated list, 
and choose one of the following options:

 Is: Display jobs that are on hold.

 Is Not: Display the jobs that are not on hold.

In Error To filter on error criteria, select the In Error check box, click the associated list, 
and choose one of the following options:

 Is: Display jobs that are in error.

 Is Not: Display the jobs that are not in error.

Finished To filter on complete or incomplete jobs, select the Finished check box, click the 
associated list, and choose one of the following options:

 Is: Display jobs that are finished.

 Is Not: Display the jobs that are not finished.

Archived To filter on archived job criteria, select the Archived check box, click the associ-
ated list, and choose one of the following options:

 Is: Display jobs that have been archived.

 Is Not: Display the jobs that have not been archived.

Deleted To filter on deleted job criteria, select the Deleted check box, click the associated 
list, and choose one of the following options:
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 Is: Display jobs that are deleted

 Is Not: Display the jobs that are not deleted

Merged To display jobs that have been merged into a merged job, select the check box, 
click the associated list, and choose one of the following options:

 Has: Displays jobs that have already been merged

 Has Not: Displays the jobs that have not yet been merged

Merged job To show only merged jobs (i.e. jobs that merge other jobs into a single job), 
select the check box, click the associated list, and choose one of the following 
options:

 Is: Displays jobs that are merged jobs

 Is Not: Displays the jobs that are not merged jobs

Layout job To filter by jobs set up in the Layout Editor.

Set up by printer/customer Allows you to filter on the status of WebApproval jobs: the job setup is Pending 
or Completed by the printer or customer.

Submitted by

Select these check boxes to filter the jobs which have been:

 submitted or not submitted by StoreFront

 enabled or not enabled for WebApproval.

Administration

Use the Administration filter to view jobs based on the criteria specified in the 
job’s Administration tab. You can filter on any combination of these fields, 
however the Job List will display only the jobs which pass through all of the 
filters. The following fields can be used to filter:

 Job Name

 Order Number

 Operator Name

 Company Name

 Operator
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The following filter parameters can be chosen in the drop-down list:

 Contains/Does not contain

 Starts with/Does not start with

 Ends with/Does not end with

 Equals/Does not equal

 Any/Current User (for Operator Name only)

Media

Allows you to filter on the media used for the job, with the same filter parameters 
as for Administration.

Date

Use the Date filter to view jobs that were submitted, modified, finished or due, 
before or after a specific date or within a specific time period. If you use the 
between argument, the first date to enter is the most recent date.
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Job and System Logging

Two types of logs are available in Apogee:

 The Job Log: For logging events related to jobs.

 The System Log: For logging events related to the Apogee System.

The Job Log

The Job Log is opened when you context-click on a job in the Jobs window, and 
select Log for Job from the context menu. The Job Log is used to keep track of 
completed jobs. It is also useful for accounting and troubleshooting. You can 
specify which job events are logged in the System Overview (see “Logging 
Settings” on page 679).

NOTE: The Job Log does not list System events. These are recorded in the System 
Log (see “The System Log” on page 164).

The Job Log is automatically exported when the job completes. This allows an 
external MIS to pick up the log file and perform any required accounting. One or 
more logged items can also be copied as text using the Copy/Paste commands. 
However, the Job Log cannot be manually exported.

The Job Log lists all job events which take place within Apogee. This is a plain, 
non-interactive event log.
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The Job Log consists of a Filter pane, a chronological list of logged events, and 
an additional information pane. 

 The Job Log Filter and list of events work together: The events displayed are 
determined by the filter (if any) you apply.

 The lower pane displays more detailed information on the selected event.

List of Events

The list of events displays a date, source, event type and description for each 
event.

When Displays the time and date at which the event was logged.

From Displays the name of the job which generated the logged message. 

Event Displays the type of the event that was logged.

Description Displays an abbreviated version of the generated event. You can view the full 
message (in the lower pane) by selecting it. 

You can sort the events on any of these Message fields by clicking the arrow in 
the column headers. Each time you click the arrow, the sort is toggled between 
ascending and descending order.

The Job Log Filter

You access the Job Log filter by clicking on the Filter icon in the Job Log:

Filter

Toggle filtering on or off.

Event Type

Choose one or more event groups for which the filter will be applied. 

Life cycle events (created, started, finished): When a job is created, has started or 
is finished.
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Error warning notifications: This includes the error status of Task Processors, 
device statuses such as error, online and offline and non-informative notifica-
tions with their reply.

Informative notifications: Important job-related actions such as job editing.

Proofing actions: Events related to the proofing result such as waiting, continue, 
approve, reject, resume.

User interactions: Job related events such as resume, rush, edit. Task Processor 
related events such as hold, resume, rush. Result related events such as remake.

Media usage: Events related to the use of resources such as film and plate or 
proofing media.

Used resources: Events related to Resource selection such as screen types, 
profiles, calibration and linearization curves. Events related to Task Processor 
parameter sets.

Color Management: Events related to input document color management, press 
and proofing output color management and spot colors.

Event Details

Contains: Find a match on a specified text string (in any of the event’s fields). If you type 
several words, all words must occur. For example, “preflight red” only shows 
events that contain both the words “preflight” and “red”. Leave the field empty 
if you do not wish to filter on content. This filter is case insensitive.

Occurred Display only the events that were generated during a specific time period.

You apply the filter by toggling the Filter On, choosing or specifying your 
filtering options, and clicking Apply.

When the filter is in use, you will see the following type of message with an 
indication of the number of logged events:

NOTE: By default, all events are displayed (i.e. no filter is applied). 
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The System Log

The System log displays logging information on the selected item in the System 
Overview (the Apogee System or a specific Task Processor). The main purpose 
of the System log is for troubleshooting. The log can be inspected interactively, 
or can be exported. The Apogee System keeps logged events for a specified time 
period, after which they are removed. You can also manually clean up the 
System log.

System events are events that are not directly related to the processing of jobs 
(although they may affect job processing).

The System Log consists of a Filter pane, a chronological list of logged events, 
and an additional information pane. 

 The Job Log Filter and list of events work together: The events displayed are 
determined by the filter (if any) you apply.

 The lower pane displays more detailed information on the selected event.

List of Events

The list of events displays a date, source, event type and description for each 
event.

When Displays the time and date at which the event was logged.

From Displays the name of the device or system which generated the logged message.

Event Displays the name of the type of event that was logged.
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Description Displays an abbreviated version of the generated event. You can view the full 
message (in the lower pane) by selecting it. 

You can sort the events on any of these Message fields by clicking the arrow in 
the column headers. Each time you click the arrow, the sort is toggled between 
ascending and descending order.

The System Log Filter

You access the System Log filter by clicking on the Filter icon in the System Log:

Filter

Toggle filtering on or off.

Event Type

Choose one or more event groups for which the filter will be applied.

Major Task Processor events (start, stop): This includes the status such as boot or 
shutdown of Task Processors.

Error and warning notifications: This includes the error status of Task Processors, 
device statuses such as error, online and offline and non-informative notifica-
tions with their reply.

Informative notifications: Important job-related actions such as job editing.

Proofing actions: Events related to the proofing result such as waiting, continue, 
approve, reject, resume.

User interactions (start, stop, restart): This includes Task Processor statuses such 
as start, shutdown, hold or resume.

Used resources: Events related to Resource selection such as screen types, 
profiles, calibration and linearization curves. Events related to Task Processor 
parameter sets.

Event Details

Contains: Find a match on a specified text string (in any of the event’s fields). If you type 
several words, all words must occur. For example, “preflight red” only shows 
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events that contain both the words “preflight” and “red”. Leave the field empty 
if you do not wish to filter on content. This filter is case insensitive.

Occurred Display only the events that were generated during a specific time period.

You apply the filter by toggling the Filter On, choosing or specifying your 
filtering options, and clicking Apply.

When the filter is in use, you will see the following type of message with an 
indication of the number of logged events:

NOTE: By default, all events are displayed (i.e. no filter is applied). 

Problem Report

The Problem Report displays all messages generated by the associated job. It is 
similar to the Message Board. The main difference is that the Problem Report 
gives an overview of all problems found during ticket editing in the Ticket 
Editor, or Run List editing in the Jobs window. The Problem Report is generated 
on the local Client, not on the Apogee System.

A Problem Report is opened if you click one of the following status icons which 
may appear next to a job in the Job List:

The Apogee system issued a critical message.

The job has stopped pending user interaction.

The job has generated an error, and has stopped.

The job has generated a warning.

WebApproval message: A message on this job (or results) was received from WebApproval.

The job has generated an information message.
Apogee Reference Guide



 

5 MANAGING JOBS 167
NOTE: In the Job List, do not click on the status icon of a collapsed group. You 
must first expand the group to reveal the job in error.

It is also opened if you click any of the same status icons which may appear in the 
Tab Area of the Ticket Editor:

The Problem Report consists of a Message List, Acknowledge Pane, and Interac-
tion pane. 

Message List

The Message List displays the status, date, type, and description of each 
message.

Status One of the four job status icons is displayed (see above).

Date occurred Displays the date and time that the problem occurred.

Location Displays the name of the job, device, or system where the message was gener-
ated. If this is a job, then the job order number is also displayed in parentheses. 
You can sort the messages according to location by clicking the arrow in this 
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column header. Each time you click the arrow, the sort is toggled alphabetically 
between ascending and descending order.

Description Displays an abbreviated version of the message. You can view the full message 
by selecting it. You can sort the messages according to description by clicking the 
arrow in this column header. Each time you click the arrow, the sort is toggled 
alphabetically between ascending and descending order.

Each message row has a colored background:

Pink: The message has not yet been Acknowledged.

Blue: This is the currently selected message.

Gray: The message has been Acknowledged.

Acknowledge pane

The Acknowledge pane displays information and the acknowledgement status 
of the currently selected message in the Message List.

Message summary Displays the summarized message text from the Message List Description 
column.

Reported by Indicates which Task Processor generated the message, and when, in the format 
“Reported by <Task Processor> on <time and date>”.

Acknowledgement status Indicates who (if anybody) first acknowledged the message, and when, in the 
format “acknowledged by <user> at <time and date>”.

Acknowledgement button This button appears if the selected message has not yet been acknowledged. 
Click this button once you have read the message. Any Errors or Warnings that 
you acknowledge are removed from the Message List. User Interaction messages 
remain in the list until the required action has been taken.

Notification/Interaction pane

Notification message Displays a more detailed version of the message. Some messages are followed by 
a suggested course of action, such as:

“There is no location for exporting the system log. The default 
C:\Apogee Prepress\SysLog\$DATE.log will be used”

Interactive dialog buttons. Some messages include interactive dialog buttons which allow you to correct the 
cause of the error or warning. For example, Edit Job or Resume Job.
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NOTE: If you select more than one message, you will see no specific message 
information, only “x messages selected”.
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Viewing the Administration Tab

The Administration tab contains customer-specific information that can be used 
to associate specific Production Plans with particular customers or job types.

You can use the order number to group jobs in the Job List.

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.

For full details on each of the fields, see “Administration Tab Information” on 
page 284.
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Viewing the Options Tab

The Options tab displays information on how the jobs which use this ticket are 
to be handled (archiving, notifications, etc.). 

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.

For full details on each of the fields, see “Using the Options Tab” on page 288.
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Viewing the Products Tab

The Products tab displays information on multi-part jobs and multi-product 
jobs. It indicates how the job is structured, and how each individual part of the 
job will be processed (colors used, output devices, etc.).

The Products tab is disabled if the selected job is not a multi-part job or a multi-
product job.

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.

What are Parts? A book may consist of a jacket, a cover and a text block. Often, these different 
parts are made of different materials and have to be processed and printed 
differently. Parts could also be used to structure a product into content- oriented 
sections. In this case, parts do not necessarily require different materials or 
processing, but they help structure the job for content delivery and proofing.

Every job contains at least one default product part. This is the only part in a 
single-part job. It is a plain part with the name ‘body’, and has continuous page 
numbering. The number of pages and page ranges is calculated automatically, 
and the part receives extra pages when you increase the total number of pages. 
It also receives the pages that you remove from other parts.

What are 
Production Sets?

A production set is a group of plates that are all processed in the same way. For 
example, a simple publication may comprise a production set for the cover 
printed in color, and another for the body printed in black. Each production set 
can have its own individual settings, and can be sent to a different press. This is 
done by separating the output plates into sections, and processing each section 
differently. However, production sets do not always correspond with the parts of 
a product. If a part requires specific processing (color/gray, different paper 
type), a corresponding production set will be created. If a part does not require 
specific processing, the default production set is used.

Every job contains at least one production set: the default production set, called 
Body plates. It is very similar in concept to the default part: in single-part jobs, it 
acts as the only production set; in multi-production set jobs, it receives extra 
sheets or those that are removed from another set.
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Production sets describe the results that make up the final product, i.e., the 
results of the main flow. As such, they are the direct result of the main imposition 
scheme of the job. Auxiliary flows (page or imposition proofs) usually produce 
results that are different in layout - their sheets contain a different number of 
pages and/or different pages. Therefore, auxiliary flows cannot use production 
sets unless their results are derived directly from the main flow, and remain 
unchanged.

Production sets provide a different way of partitioning a publication by looking 
at how the different publication parts need to be produced, and creating Produc-
tion sets that will process specific parts (e.g. sheets) differently from others. 

For simple publications, you can create a production set for every part. For 
example, a softcover book with a cover in color and a black&white text block can 
be produced with two sets of settings (two production sets); one set for the cover 
and one for the text.

However, this simple approach will not work if the text block has a couple of 
pages in color (that need different processing). To solve this, you can either 
create an extra product part, or you can create an extra production set.

Production sets give the printer the freedom to solve the issue in any way he likes 
without impacting the product parts. The printer can put the color pages on a 
separate sheet, combine them with black-only pages on a larger sheet, or choose 
whatever production method is appropriate. The printer could also combine 
signatures of different product parts on the same sheet (provided the different 
parts are compatible). In a multi-part job, there is no simple one-to-one relation 
between parts and production sets.

The smallest result a production set can produce is a single side of a press sheet 
(all color separations for the side). Thus, all sides that are produced by a single 
production set have the same production settings. 

If auxiliary flows use a different imposition task processor (e.g., to make a 2- up 
page proof), the results of this imposition are not part of the production sets.

Apogee Impose brings together sheets with the same press, paper and color 
spaces (CMYK, gray) in Production Sets.

For full details on each of the fields, see “Using the Products Tab” on page 295.
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Viewing the Plan Tab

The Plan tab displays the selected job’s Production Plan, and allows you to view 
the individual settings of each of the items in the Plan. 

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.

The Plan tab has two panes:

 Production Plan Pane (Jobs Window)

 Settings Pane (Jobs Window)

Production Plan 
Pane (Jobs 
Window)

The Production Plan is a series of components (Task Processors and Actions) 
linked together to form one or more processing flows. These components are 
configured to define exactly how jobs are to be input, processed, and output.

When you select one of these components, you will see the associated settings 
displayed in the lower Settings Pane (Jobs Window).

Below each Task Processor icon, there is a drop-down list from in which you can 
view the selected Parameter Set. If no Parameter Set is selected, the Task 
Processor uses its initial settings. 

Some Task Processors may display a thick blue underscore beneath their Param-
eter Sets drop-down list. This indicates that you are viewing a multi-part job, and 
that the associated Task Processor has multiple settings (known as Production 
Sets).

The last Task Processor in a flow always displays the Flow Identifier at the end 
of the flow. In a single-flow plan, this always indicates a Main Output flow.

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.
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Settings Pane (Jobs 
Window)

The Settings pane displays the name of the component (Task Processor or 
Action) selected in the Production Plan pane, and its current settings.

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.
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Viewing the Pages Tab

The Pages tab lists the documents that have been input to the selected Page Store 
(Private or Public Page Stores), and the pages that have been copied from the 
Page Store and included in the job’s Run Lists.

The Pages tab has two panes:

 Page Store (Jobs Window)

 Run List (Jobs Window)

The Pages tab displays any errors encountered with the input documents, but 
does not show any processing or hold states. These are displayed in the Results 
tab. 

The Pages tab is disabled if there is no Run List in the selected job.

NOTE: The information displayed is read-only. If you want to change the 
information in any of the fields, you first need to context-click the job in the Job 
List, and select Edit from the context menu. You can also select the job and click 
the Edit button.

Page Store (Jobs 
Window)

The Page Store lists the documents that have been input to Apogee, and that may 
be added to your Run List.

By default, documents are arranged as folders alphabetically in the Page Store. 
The number of pages is shown in parentheses after the document name. If more 
than one version of the document has been input, you will see the document 
revision number in a separate column.

NOTE: When a document is first input to the Page Store, there is no revision 
number. If subsequent revisions of the same document are input, they are 
numbered in the ‘Rev’ column in order of arrival (or creation), starting with 1.

Apogee automatically names each document with the name of the input file. If 
no name is available, Apogee uses the generic name “Document”, immediately 
followed by a sequence number. If you add a document that is already known by 
Apogee (e.g. from another job), then the same document name is used.
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When you expand a document folder, Apogee lists the individual pages in the 
selected document. It is from this view that you can select the pages that you 
want to include in your Run List.

To organize your files more efficiently, for each input channel you define, you 
can create one or more subfolders. For example:

\\$SYSTEMCOMPUTER\HotFolderRoot\$ORDER\Folder1

These will then appear under the main job folder in the Page Store.

Private and Public Page Stores

By default, each job created has its own “private” Page Store, which contains the 
input documents that are available for this job alone. However, if an Apogee user 
creates a Public Page Store, this will be visible in every user’s Page Store, in 
addition to their own private input documents.

If there are no Public Page Stores, the Page Store will display only the documents 
for the selected job in the Job List.

NOTE: The Page Store always displays the Private Page Store for the selected job, 
which contains only the documents for this single job. However, the Page Store 
may also display one or more Public Page Stores, which contain the documents 
created by any Page Store Task Processors.

Run List (Jobs 
Window)

The Run List displays the pages that have been selected from the Page Store, and 
that will be included in your job.

A page in the Run List shows similar information to the same page in the Page 
Store. The page name is the document name as displayed in the Page Store, 
followed by the page number. Placeholders and blank pages do not have a name.

The Run List provides the following information about the listed pages:

Adjustments
May display up to four columns of page adjustment icons, indicating that 
the positioning of this individual page has been modified (offset).
The size of the placeholder (as specified in the Production Plan) is different 
from the size of the page that is placed on it (imposition jobs only).

Lbl
The page label (selected using View > Page Labels). Page labels are dis-
played when the Run List is (automatically) updated with new revisions.

# The page number in the Run List.

Page The name of the page (the same as in the Page Store).
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A variety of information may also be displayed in the placard area above the Run 
List.

NOTE: If you are viewing a versioning or a multi-part job, the layout of the Run 
List is considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Run List” on 
page 228 and “Multi-part Jobs in the Run List” on page 232.

If you edit the job, you can add pages or documents to the Run List, move and 
delete pages from it, and add blank pages. You can also change the number of 
pages in the Run List, although this might invalidate any imposition scheme you 
may have selected.

There is only one Run List per job.

Page Store / Run 
List Icons

Document/Page Type Icons

Both the Page Store and the Run List display a variety of icons for different 
document/page formats. Each item you see may be any combination of the 
following:

 PDF/PostScript data unknown file type

When you input PDF or PostScript files, Apogee recognizes these file formats, 
converts them to PDF, and places the PDF results in the Page Store. 

If you input a document with a different file format, the file is not converted 
and is not placed in the Page Store. Instead, a notification is sent to the 
Message Board.

If you select a job which has already been processed by a renderer, you will 
see raster data in the Run List.

 a document or a page

Rev The revision number of this page (if any).

Sig
The Signature to which the page belongs (when imposition is included in 
the Plan).

The total number of empty placeholders in the Run List. If you position your cur-
sor over this icon, Apogee displays a Tooltip indicating how many placeholders 
are empty, placed and blank.
The number of spot colors used in the job. If you position your cursor over this 
icon, Apogee displays a Tooltip indicating the spot color names. If you click this 
icon, Apogee displays the separation settings in the Plan tab.

Indicates that the Run List contains pages with different sizes.
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A page icon looks like a single page: a document icon looks like a stack of 
pages. There are 2 types of document icons: 

 Documents containing pages (the pages in the icon have a light gray 
outline).

 Documents containing page files (the pages in the icon have a solid black 
outline).

 a composite or a pre-separated file

 Composite documents or pages are represented by simple page or 
document icons.

 Pre-separated document or page icons include a small 4-color bar on the 
right.

In addition, each item is in one of the following states:

 OK (colored green)

 In error (colored red)

 In error, and rejected (colored red, with a red stripe)

 On hold (colored blue)

 On hold and rejected (colored blue with a red stripe)

These combinations are summarized in the following table:

Document / Page Type OK Error Error rej Hold Hold rej

PDF / PostScript com-
posite document

PDF / PostScript com-
posite page

PDF / PostScript pre-
separated document

PDF / PostScript pre-
separated page

Raster composite docu-
ment

Raster composite page
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NOTE: The names of placed pages/documents are displayed in gray.

NOTE: Raster data includes TIFF, Copy Dot, or other supported raster data.

PDF Layer Icons

In Versioning jobs, PDF layer icons appear as overlays when you select pages that 
have layers in the Page Store. They may also appear in the Run List of a 
Versioning job, where they display the same states as their parent pages.

Run List Page Adjustment Icons

The Run List has a dedicated Adjustments column, showing the application of 
page adjustments. Apogee offers two ways of showing the page adjustments:

 Simple view: A single icon indicates that page adjustments have been made.

 Extended view: Dedicated icons are displayed for the different adjustments. 

Note that you can position your mouse cursor over the Simple view page adjust-
ments icon to display a Tooltip which indicates exactly which page adjustments 
have been made.

Raster pre-separated 
document

Raster pre-separated 
page

PDF layers

Document / Page Type OK Error Error rej Hold Hold rej
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By default, Apogee shows the simple view. However, you can select 
View > Extended Page Adjustments to switch to extended view.

When Auto Center is in effect, the simple view shows the Center page adjust-
ment icon; when you manually apply extra adjustments, the icons show the 
generic page adjustment icon.

The extended adjustment column has a row of 4 icons, indicating the presence 
of center, offset, scale and rotation adjustments, respectively. These icons have 
a fixed position in the column, making it easier to scan the run list for specific 
types of adjustments.

Other Icons

The other icons you will see in the Pages tab include:

Center Offset Scale Rotate

Horizontal

Vertical

Both

Auto-center Auto-center only in simple view

90

180

270
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a Public Page Store (Page Store only).

an empty placeholder (Run List only).

a blank page (Run List only).

job processing is not yet complete in the Production Plan before the Run List.

unknown document.

the job has generated a warning.

the job has generated an error, and has stopped.

Page imposition has been adjusted (Run List only).

(in Run List status column of normal job). The page has a preflight report. Clicking on the icon 
will open the report in your PDF viewer.

(in Run List status column of versioning job). One or more pages in this row have a preflight 
report. Clicking on the icon will bring up a menu which contains the titles of the objects to 
which the preflight reports are attached. Selecting one of the menu items opens the report in 
your PDF viewer.

(in Run List status column of job). The page has generated a preflight error. Clicking on the 
icon will open the Problem Report.

(in Run List status column of job). The page has generated a preflight warning. Clicking on the 
icon will open the Problem Report.

PDF is certified.

PDF is not certified.

The document is being edited interactively within Apogee using the Check-Out plug-in for 
Acrobat or any other PDF Viewer/Editor application such as the Amfortis Editor.

The document has been edited interactively within Apogee using the Check-Out plug-in for 
Acrobat or any other PDF Viewer/Editor application such as the Amfortis Editor.
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Viewing the Results Tab

The Results tab allows you to view the results of the selected job. This tab 
displays thumbnails of the Run List pages, and job separations (if any).

NOTE: Double-clicking a result opens it in preview mode (see “Previewing Job 
Results” on page 99).

This tab is divided into the following panes:

 The Activity Pane

 The Job Layout Pane (Jobs Window)

 The Separations Pane (Jobs Window)

NOTE: If you are viewing a versioning or multi-part job, the layout of the Results 
tab is considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Results Tab” 
on page 249 and “Multi-part Jobs in the Results Tab” on page 253.

The Activity Pane This pane allows you to monitor the current processing status of any of the 
selected job’s Processing and Output Task Processors.

The Activity pane includes the following:

 Flow selection icons

You will see one or more Flow Identifier icons, corresponding to each flow in 
the selected job. When you click on any of these icons, the selected flow is 
displayed, and you will see the Task Processors and Actions that are active in 
this particular flow. This is the same as clicking the Flow Status icons in the 
Job List.
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 Selected flow components (active Task Processors and Actions).

You will see the Task Processors and Actions that are active in the selected 
flow. If you double-click on any of the Task Processors, you will see the 
Activity Window for that particular component. 

 Results tab display icons.

 Click the first of these icons to show/hide the Activity pane. 

 Click the second of these icons to show/hide the Production Sets table 
(Multi-part jobs only). 

 Click the third icon to show/hide the Separations pane.

NOTE: Input channel activity is not displayed in the Activity pane. If you want to 
check this, switch to the System Overview and double-click the Task Processor 
that you want to monitor. Any processing is then displayed in the Activity 
window. For more information, see “Monitoring your Task Processors” on 
page 664.

The Job Layout 
Pane (Jobs 
Window)

This pane displays thumbnails of the Run List pages of the selected job. Status 
icons, corner folds, and colored backgrounds provide additional information 
about the current status and orientation of each of the displayed thumbnails.

TIP: To improve the speed 
with which job results are 
displayed, you can disable 
thumbnail viewing from the 
View menu.

You can double-click any of the thumbnails to launch the appropriate viewer for 
this specific page (Acrobat for PDF documents or Raster Preview for TIFF files). 
If the job has not yet received all required pages, you will see only empty 
placeholders.

NOTE: If you are viewing a versioning job, the layout is considerably different 
(depending on the specific parameters of the input documents). For more 
information, refer to “Versioning Jobs in the Results Tab” on page 249.
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Page and Flat Thumbnails

You need to enable thumbnails (View > Thumbnails) in order to view a minia-
ture representation of your job pages in the Job Layout pane.

If no imposition has been specified for the selected job, you will see a series of 
pages. The current status of each page is indicated by its background color.

A thumbnail view of this page is either not available, or is currently being 
retrieved from the Apogee System (green background color).

Page has been processed successfully (no background color).

Page has been processed successfully, and is on hold pending approval 
(blue background color).

Page has been processed with errors (red background color).

Page is managed by the PlateMaker Client, and is ready to plate (purple 
background color).
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If an imposition scheme has been specified, you will see a series of flats. As with 
pages, the status of each flat is indicated by its background color.

Page has been processed successfully, but has been rejected.

Page has been discarded.

An empty page in the Run List (white background with a cross).

A blank page in the Run List (white background).
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Extra Thumbnail Information

The following additional information is available for both pages and flats:

 Action indicator

 Separation indicator

 Proofing data indicator

 Raster data indicator

 Corner fold indicator

 Page number

 Flat label

 Signature

Action Indicator

Each individual page or flat may have one or more Action indicators above it 
(corresponding to hold points in the Production Plan). These may be any of the 
following:

The job’s Production Plan contains an After Hours Action. When this point is reached, the job 
results are held (written to disk) pending the specified time.

The job’s Production Plan contains a Soft Proof Action. When this point is reached, the job 
results are held (written to disk) pending approval/rejection of a Digital Film preview by the 
user.

The job’s Production Plan contains a Hard Copy Proof Action. When this point is reached, the 
job results are held (written to disk) pending approval/ rejection of a hard copy proof by the 
user.

The job’s Production Plan contains a Ready for Plating Action. When this point is reached, the 
job results are taken over and managed by PlateRunner (ready to plate).

The job’s Production Plan contains a Collect for Output Action. When this point is reached, 
the job results are held (written to disk) pending user intervention.

The job’s Production Plan contains a Waiting for Results Action. When this point is reached, 
the job results are held until the target flow or required pages are finished. 

The job’s Production Plan contains a Discard Action. When this point is reached, the job 
results are held until the specified pages have been automatically discarded.
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These Action indicators can be in one of three states (as indicated below for the 
Soft Proof Action):

When a flat is on hold, the entire flat is colored with a blue background in the 
Results tab, as illustrated below:

When a page is on hold, only the page is colored with a blue background:

Any actions that have already been passed in the flow are grayed-out (dimmed), 
as follows:

The job’s Production Plan contains a Web Proof Action. When this point is reached, the job 
results are held (written to disk) pending approval/rejection of a Digital Film preview by the 
remote user.

Result will be frozen once it has been approved by the remote user.

Result has been frozen because it has been approved by the remote user.

Action icon Status

The page or flat has not yet reached this Action.

The page or flat has reached this Action (blue background).

The page or flat has passed this Action (dimmed icon).
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Separation Indicator

If a page or flat is made up of a series of separations, this is indicated by four (or 
more) small colored icons to the right. If you select the page or flat, the 
individual separations are displayed in the Separations pane (see “The Separa-
tions Pane (Jobs Window)” on page 193).

A square icon indicates that the separation is a process color; a round icon 
indicates that the separation is a spot color.

The separation indicators provide the following information for each of the 
colors.
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Apogee Reference Guide

For example, the page below contains 8 separations: the four CMYK process 
colors plus four spot colors. All these separations have been rendered (as 
indicated by the solid separation indicators) and have been successfully output 
(as indicated by the associated checkmarks):

Proofing Data Indicator

Results may display a small, square multi-colored icon to their right. This is the 
Proofing Data indicator. It indicates that the page/flat belongs to a proofing 
workflow, and is a composite TIFF file (i.e., no separations). 

A checkmark indicates that the page/flat has been successfully output.

Square outlined separation indicator: 
• A process color separation is expected (it has not yet been rendered). In this example, it is 

the magenta separation.
• The background is available for an Apogee DQS job.

Square solid separation indicator: A process color separation has been rendered, and is ready 
for output. In this example, it is the magenta separation.

Checked separation indicator: The separation has been rendered, and has been successfully 
output. In this example, it is the magenta separation.

Dimmed separation indicator: The separation has been discarded, and will not be output.

Round outlined separation indicator: A spot color separation is expected (it has not yet been 
rendered). The outline color is the color of the expected spot color.

Round solid separation indicator: A spot color separation has been rendered, and is ready for 
output. The solid color is the spot color.

Checked separation indicator: The spot color separation has been rendered, and has been suc-
cessfully output.
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Raster Data Indicator

For DQS and native Apogee DQS (Raster Impose) results, you can choose 
View > Show > Page Rendered. Results will then display a square gray-colored 
indicator in the lower right corner. This is the Raster Data indicator. It means 
that all separations in the page(s) have been fully rendered and are ready for 
previewing or output.

Corner Fold Indicator

Small corner folds in a corner of each page indicate a page’s orientation.

The orientation of a page may vary in an imposition layout. The position of the 
corner fold tells you where the top of the page is:

The page/flat belongs to a proofing workflow or a layout job, and is a composite file (i.e., not 
a separation). The page/flat has been rendered, and is ready for output.

The page/flat belongs to a proofing workflow or a layout job, and is a composite file (i.e., not 
a separation). The checkmark indicates that it has been successfully printed.

The orientation of a page may vary in an imposition layout. The position of the corner fold 
tells you where the top of the page is.
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Page Number

Page numbers indicate the position of pages in the Run List. If you are viewing a 
flat, you will see the position of the pages on the flat.

Flat Label

Below each flat you will see a label, which indicates which side of the signature 
you are looking at. You can click this label to quickly select the entire flat. This is 
useful if pages cover the entire surface of the flat, making it difficult to select the 
flat (and not a page) by clicking directly on it.

Signature

If Front and Back viewing has been enabled, you will see the complete signature 
for each page or flat in the job.

NOTE: In this example, the small checkmarks you can see indicates that all 
separations have been output.
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The Separations 
Pane (Jobs 
Window)

This pane displays thumbnails of each of the separations for the page or signa-
ture you select in the Job Layout pane. Double-clicking a thumbnail launches the 
appropriate viewer. For PDF data, this is your PDF Reader; for raster data, this is 
Raster Preview.
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Working with Jobs in the Job List

The Job List displays information on all jobs that have been submitted to the 
Apogee System. From here you can monitor these jobs, and make a variety of 
changes to their current status:

 “Selecting Jobs” on page 194

 “Monitoring Jobs” on page 195

 “Holding/Resuming Jobs” on page 196

 “Continuing Jobs” on page 197

 “Making Rush Jobs” on page 201

 “Restarting Job Processing” on page 201

 “Duplicating Jobs” on page 201

 “Creating a New Job from an Existing Job” on page 202

 “Deleting Jobs” on page 202

 “Deleting a Public Page Store” on page 205

 “Enabling/Disabling Input Channels” on page 205

 “Opening the Job and System Logs” on page 206

 “Archiving Jobs” on page 207

 “Dumping Jobs” on page 209

 “Merging Jobs” on page 210

Selecting Jobs In the Job List and the Results tab, as in other areas of the Apogee Client, you can 
use the following procedures to select and de-select multiple items (jobs, Hot 
Tickets, pages, flats, etc.).

NOTE: Jobs may be grouped in job folders as explained in “Organizing the Job 
List” on page 144.
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 To select a job

1 Select the Jobs Window.

2 Double-click a job folder in the Job List.

The job folder is expanded to reveal the job contents. These are the 
documents that have been input via the input channel(s) associated with this 
particular ticket.

3 Select one of the jobs.

The job details are retrieved from the Apogee System and displayed in the 
pane on the right. This information is arranged into 5 tabs - Administration, 
Options, Products, Plan, Pages, and Results.

TIP: You can also click the expand/collapse buttons to open and close job folders.

 To select or de-select multiple jobs or items

1 Select the Jobs Window.

2 Click the first item you want to select in the Job List.

3 While holding down the CTRL key (Windows) or COMMAND key, click each 
additional item you want to select.

4 To de-select an item, hold down the CTRL key  and then click the item.

5 To extend the selection over a block of contiguous items, click the first item 
and then hold down the SHIFT key while clicking the last item you want to 
select.

Monitoring Jobs You can quickly check the status of your jobs as follows:

 To monitor a job

1 Select the Jobs Window.

2 Expand the folders in the Job List to view your jobs.

A series of icons indicate the current status of each job in the Job List. These 
include Job Notification Icons, Job Status Icons, Job Icons, and Flow Icons.

3 To view information on a job’s Run List, select the job and click the Pages tab.

The Run List is displayed in the pane on the right.

4 To view intermediate job results, select the job and click the Results tab.
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If any page results are available, they are displayed in the pane on the right. 
Otherwise, you will see only empty page holders.

5 To monitor any ongoing processing, expand the Activity pane in the Results 
tab.

For more information, see “The Activity Pane” on page 183.

Holding/Resuming 
Jobs

When you manually put a job on hold in the Jobs List, you suspend all processing 
tasks for the entire job (after the current activity has been allowed to finish). The 
job remains on hold until you resume it.

NOTE: You cannot “continue” a job that is on hold: The Continue command will 
be disabled. In this case, you must use the “Resume” command.

 To manually hold a job

1 Select the Jobs Window.

2 Context-click a job which has not yet finished processing in the Job List (or 
job results in the Job Layout pane), and choose Hold Job from the context 
menu.

3 You can also click the Hold button:

The Hold Job dialog box appears. Here you can choose to stop any ongoing 
processing, or allow it to finish before the job is put on hold.

4 If you want to stop processing, choose Stop and Hold.

This means that active tasks are stopped and rescheduled. The rescheduled 
tasks are then put on hold.

5 If you want to allow any ongoing processing to finish, choose Hold.

This means that all active tasks will be allowed to finish and all queued tasks 
will be put on hold.

The Hold icon appears in the Status column to the left of the job. Notice also 
that the background color of the associated Job Flow icon changes to blue.

All flats and pages that still need to be processed in the Pages and Results tabs 
will also be colored blue. Only results that were finished are not colored blue.
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The job’s input channels will continue to receive and deliver documents to 
the Page Store, but no further processing will be done on them. This means 
that although you may see new documents arrive in the Page Store, you 
cannot add these document pages to your Run List since they have not yet 
been processed by the Normalizer.

NOTE: Manually holding a job from the Jobs Window stops all processing tasks 
for the entire job. This is different from including an Action in the job’s 
Production Plan, where you can put any individual job item on hold at any time, 
whether it is a page, a flat or a separation.

 To resume a job on hold

1 Select the Jobs Window.

2 In the Job List, select a job which has been manually put on hold.

The following Status icon is attached to jobs which are on hold:

Additionally, the background color of the associated Job Flow icon will be 
blue.

3 Choose Control > Resume Job, or click the Resume button in the Toolbar.

The Hold icon disappears, and the background color of the associated Job 
Flow icon changes to green.

Resuming a job does not resume results and/or tasks that are waiting on an 
Action, or that are rejected or in error.

NOTE: Resuming a job resumes processing of the entire job which was 
manually put on hold. This is different from Continuing an individual job 
item (page, flat or separation) which was automatically put on hold by an 
Action in the job’s Production Plan.

Continuing Jobs A job may be stopped because it has reached a hold Action in its Production Plan, 
or because it has been aborted, rejected, or in error. In all cases, you can continue 
all or part of the job manually.
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NOTE: You cannot manually continue jobs that are waiting for a Task Processor: 
They will be continued automatically when a Task Processor becomes available.

 To continue results which are waiting on an Action

1 Select the Jobs Window.

2 In the Job List, select a job which has been stopped by Apogee, and is waiting 
for user interaction.

Jobs which have been stopped due to a hold Action will be flagged with one 
of the following Status icons:

3 Select the Results tab.

In the Job Layout pane, you will see thumbnails of all the pages or flats in the 
selected job. Above each job item, you will see one or more Action icons. 
These correspond to the Actions included in the job’s Production Plan. The 
color of each icon indicates the current processing status of the selected page 
or flat within the job:

 If the icon is displayed normally, the page/flat has not yet reached this 
checkpoint in the Production Plan.

 If the icon has a blue background, the page/flat has reached this check-
point in the Production Plan, and is on hold. In this case, the page/flat 
itself is also colored blue. The exception to this is the pages with the 

The job’s Production Plan contains an After Hours Action.

The job’s Production Plan contains a Soft Proof Action.

The job’s Production Plan contains a Hard Copy Proof Action.

The job’s output device is controlled by the PlateMaker Client.

The job’s Production Plan contains a Collect for Output Action. 

The job’s Production Plan contains a Waiting for Results Action.

The job’s Production Plan contains a Discard Action.

The job’s Production Plan contains a Web Proof Action.
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Collect for Output Action, these only turn blue when ALL the specified 
pages are available.

 If the icon is dimmed (grayed out), the page/flat has already passed this 
checkpoint in the Production Plan.

4 Select one or more pages or flats which are on hold (blue background).

5 Click Continue.

The selected pages or flats resume processing, the blue color is removed, and 
the associated Action icon is dimmed.

NOTE: If you continue a job that is being collected (Collect for Output) but is 
not yet complete, only the currently available results will be output: Apogee 
will automatically continue to collect the remaining results, but you will need 
to select them and again click Continue to output them.

 To continue results which were aborted, rejected, or in error

1 Select the Jobs Window.

2 In the Job List, select a job which is flagged with one of the following Notifi-
cation or Status icons:

 aborted

 rejected

 warning

 error

3 Select the Results tab.

In the Job Layout pane, you will see thumbnails of all the pages or flats in the 
selected job.

4 Select one or more pages or flats (with the aborted, rejected, warning or error 
status).

5 Click Continue.

A Continue confirmation dialog box is displayed.
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6 If you wish, enter a comment explaining why you are continuing to process 
this result.

TIP: You can view this comment later by checking the Job Log (Log for Job).

7 Click Continue.

The selected pages or flats resume processing. However:

 In the Job List, the status of jobs with the rejected or warning condition 
does not change. Only aborted and error conditions are cleared.

 In the Results tab, the status of results with the rejected, warning or error 
condition does not change. Only the aborted condition is cleared.

 To continue multiple results

1 Select a job in the Jobs window which is waiting on an Action, or is rejected, 
aborted or in error.

2 Select the Results tab, and choose the first item you want to continue.

3 Extend your selection, as described in “To select or de-select multiple jobs or 
items” on page 195. If the items are part of a flat, select the entire flat.

4 Click Continue.

NOTE: You can only continue multiple results provided they are all in the 
same waiting state. This button is disabled if one or more items have a 
different state, or are not waiting on an Action.

If one or more of the selected items contains rejected, aborted, or error 
results, a Continue confirmation dialog box is displayed.

5 If you wish, enter a comment explaining why you are continuing to process 
this result.

TIP: To view this comment later, click the Status icon next to the page in the Page 
Store or Run List.

6 Click Continue.
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Making Rush Jobs You can upgrade any job in the Job List to a “rush” job. This puts the job to the 
top of the queue of jobs waiting to be processed by Apogee. A rush job will be 
processed as soon as Apogee has finished processing the current job.

 To make a rush job

1 Select the Jobs Window.

2 In the Job List, select a job.

3 Choose Control > Rush Job, or click the Rush Job button in the Toolbar.

The Job icon changes to a chequered background, indicating that this job will 
be given priority over the other jobs in the Job List.

Restarting Job 
Processing

You can remake all the existing job results which follow a selected point in the 
Production Plan. You may want to do this if you have changed your resources 
(new fonts, color books, etc.), or if you want to remake aborted results or remake 
output when no raster data is available.

 To restart job processing

1 Select the Jobs window.

2 In the Job List, select a job and choose Control > Restart Job Processing At.

3 Select the Task Processor from which you want to restart processing.

Apogee starts to re-render the job from the selected point in the Production 
Plan.

Duplicating Jobs Apogee allows you to duplicate jobs. This is useful for applications which require 
nearly identical jobs (e.g. where only a single separation - usually black - needs 
to be changed across different jobs)

When you duplicate a job, Apogee makes an exact copy of the job, ready for 
editing. The ‘source’ job is not affected.

 To duplicate a job

1 Select the Jobs window.

2 In the Job List, select a job and choose Edit > Duplicate Job.
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Apogee duplicates the job, and opens the duplicate version in the Ticket 
Editor. Here, you can make any changes you require (e.g. change the job 
name).

Close the Ticket Editor.

The duplicate job is automatically submitted, and appears in the Job List.

Creating a New Job 
from an Existing 
Job

You can create a new empty job by using the job ticket of an existing job. The new 
job re-uses certain settings from the existing job while others are reset:

 Job Name and Order Number are blank

 Operator Name is taken from the existing job

 Print Center, Company and Collaborators are taken from the existing job

 Guest collaborators are removed

 Hot Folder is reset to the settings stored in the selected parameter set

 Content files are removed

 The job has a new job-ID

 The new job has no history

 All other settings are re-used: plan, products, imposition, production sets, 
etc.

 To create a new job from an existing job

1 Context-click a job or highlight a job and choose File > New From Selected.

2 The Job Ticket Editor opens with an empty Administration tab and you can 
complete the job ticket set up and upload new content files.

Deleting Jobs By default, jobs are not automatically deleted from the system. You must delete 
them manually. When you delete a job, all the job’s resources and results are 
erased, but the job still remains logged in the system and can still be seen in the 
Job List by the Administrator (these jobs have a strike-through). To permanently 
remove all traces of a deleted job, the Administrator needs to delete it a second 
time from the Job List. Alternatively, he can set up a schedule for automatically 
removing deleted jobs from the system.
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NOTE: You can also delete a job together with all its logging information in a 
single step by purging it, as described below.

 To delete a job from the Job List

1 Select the Jobs Window.

2 Select the job that you want to delete in the Job List.

3 Choose Edit > Delete Job, or press the Delete key.

You will see the message “The job <jobname> will be deleted. You cannot 
undo this”.

4 Click Delete.

NOTE: If you delete a Job 
created from a Hot Ticket, 
the Hot Ticket itself is not 
deleted.

The Job is deleted, together with the Job Ticket, and any intermediate job 
results. Only the job log remains. If you are logged in as an Operator, the job 
immediately disappears from the Job List. However, if you are logged in as an 
Administrator, you will still see the job in the Job List: The job has a strike-
through and is grayed out:

To remove a job with a strike-through from the Job List (Administrators 
only), you need to select it and delete it a second time.

NOTE: If you delete a Job created from a Hot Ticket, the Hot Ticket itself is not 
deleted.

 To view/remove all ‘deleted’ jobs from the Job List

Administrator access level only!

Deleted jobs can still be seen in the Job List by Administrators: They have a 
strike-through and are grayed out.

1 Select the Jobs Window.

To quickly located all deleted jobs, you can use the Custom Job Filter.
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2 Edit the Custom Job Filter by hovering over the Custom Filter button and 
clicking Edit in the cogwheel menu to open the filter settings.

3 In the filter settings, select the ‘deleted’ Status check box, and choose ‘Is’ from 
the associated list options.

4 Click Apply to activate the filter, then click OK.

5 Select the deleted job(s) that you want to permanently remove in the Job 
List.

6 Choose Edit > Delete Job, or press the Delete key.

The selected job(s) are permanently deleted. No trace of them remains on the 
system, in the Job List, or in the Job Log.

 To purge a job from the Job List

1 Select the Jobs Window.

2 Select the job that you want to purge in the Job List.

3 Hold down the Shift key while pressing the Delete key.

You will see the message “The job <jobname> will be deleted immediately. 
You cannot undo this”.

4 Click Delete.

The job is permanently deleted. No trace of the job remains on the system, the 
Job List, or the Job Log.

 To automatically clean up deleted jobs

Administrator access level only!

1 Select the System Overview window.

2 Click the Apogee System icon.

A set of icons is displayed in the Resources pane.

3 Double-click the Job Housekeeping icon.
Apogee Reference Guide



 

5 MANAGING JOBS 205
The Job Housekeeping Settings dialog box is displayed.

4 Select a schedule for cleaning up deleted jobs, as described in “Job House-
keeping Settings” on page 677.

5 Click OK.

Deleting a Public 
Page Store

You can delete a Public Page Store, and all the documents it contains, as 
described below.

Administrator access level only!

 To delete a public page store

1 Select the Jobs Window.

2 In the Job List, select the Public Page Store that you want to delete.

3 Choose Edit > Delete Page Store Job.

4 Click Delete to confirm that you want to delete the selected Public Page 
Store.

The Public Page Store, and all the documents it contains, is deleted. 

NOTE: This will not affect jobs which are still using documents from this 
Public Page Store.

Enabling/Disabling 
Input Channels

By default, all input channels are enabled when they are first created. However, 
you may want to disable them from time to time - to prevent other users input-
ting documents, or to improve system performance.

You can enable or disable input channels from the Hot Tickets List (for Hot 
Tickets which will be used to create jobs) or from the Jobs List (for jobs which 
have already been created).

 To disable an input channel

1 Select a Hot Ticket in the Hot Ticket List, or select a job in the Job List.

2 Choose Control > Disable Inputs.
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The inputs for this job are closed. Apogee will no longer accept document 
input on this channel. Any documents which are input will be queued up, 
pending reactivation of the channel.

You will see that the disabled job or Hot Ticket now has a “disabled input” job 
icon:

 To enable an input channel

1 Select a disabled Hot Ticket in the Hot Ticket List, or a disabled job in the Job 
List.

Disabled jobs and Hot Tickets Have a “disabled input” job icon:

2 Choose Control > Enable Inputs.

The job icon changes to indicate that the inputs have been successfully 
opened.

 To automatically enable or disable an input channel

1 Create a new Job Ticket/Hot Ticket, or context-click a job in the Job List and 
select Edit Job from the context menu.

2 Select the Options tab.

3 To disable an input channel, select the ‘Deactivate input when’ check box, 
then click open the associated list box and select one of the available options, 
as described in “Input Channels” on page 292.

4 To enable an input channel, clear the ‘Deactivate input when’ check box.

Opening the Job 
and System Logs

The Job and System Logs list all job and system events which take place within 
Apogee. They provide information on jobs, devices, or systems which need 
attention.

 To open the Job Log

1 Select the Jobs Window.

2 Context-click on a job in the Job List, and select Log for Job from the context 
menu.

Make sure you context-click a job, and not the job folder.
Apogee Reference Guide



 

5 MANAGING JOBS 207
The Job Log is displayed.

NOTE: The largest item you can select is a job. You cannot view the log for several 
jobs at once. If you select a flat, the log includes all separations of that flat, but 
not the pages that make it up.

 To open the System Log

1 Select the System Overview Window.

2 Choose Window > Log for Apogee System.

The System Log is displayed.

Archiving Jobs When a job is processed by Apogee, all the input files, intermediate processing 
results, resources, profiles, etc. are by default automatically discarded. If you 
want to keep them (or part of them), you must archive them. There are three 
different ways of doing this. You can:

 archive jobs manually in the Job List

 include archiving “Actions” in the Jobs Production Plan

 set up an automated job archiving schedule

Apogee Archive Icons in Windows Explorer

When you archive a job, the job is exported from the Apogee environment, and 
is stored as a file in the specified archive location (this location is defined in your 
Job Housekeeping Settings). You can see these archive files using Windows 
Explorer. The icons vary according to the type of job:

What gets Archived?

You can specify your job archiving preferences in the Job Ticket Options. This 
allows you to define exactly which parts of the job are archived (marked results, 
all available results).

Archived Commercial job (.arch)

Archived Public Page Store job (.arch)
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 To archive a job manually from the Job List

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Choose File > Archive Job.

The following status icon appears next to the job name while the job is being 
archived: 

As soon as the job has been successfully archived, the Archiving status icon 
disappears (any previous status icon reappears), and the job icon displays a 
small “archived” indicator:

The default archive name and location are defined in your Job Housekeeping 
Settings. The location must be a shared disk accessible by both Apogee Client 
and System (for example: D:\ArchiveRoot\$ORDER\$JOB).

Job archive files are saved with the .arch file extension.

 To import an archived job, create new job from archive

1 Select the Jobs Window.

2 Choose File > Import Job Archive.

The Open dialog box appears.

3 Browse to the location where you save your archives.

The default archive name and location are defined in your Job Housekeeping 
Settings. The location must be a shared disk accessible by both Apogee Client 
and System (for example: D:\ArchiveRoot\$ORDER\$JOB). Job archive 
files are saved with the .arch file extension.

4 Select an archive, and click Open.

Now you can choose how you want to import the archive:

 Restore the original job: puts back the original job as it was

 Create a new job : if you select this option, you can enter a new Job Name 
and Order Number for the new job. All the other information and content 
files in the private page store and Run List are the same as the original 
archive. Can be used for reprints.
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5 Choose of the above options and click OK.

The Importing Archive status icon appears briefly next to the job name while 
the archive is being imported: 

As soon as the archive has been successfully imported, the Importing Archive 
status icon disappears (any previous status icon reappears), and the 
imported job appears in the Job List.

Apogee validates the imported ticket against the current configuration of the 
system. Any ticket errors are reported via the Message Board, and can be 
corrected using the Ticket Editor.

 To set up an automated job archiving schedule

1 Select the System Overview window.

2 Click the Apogee System icon.

A set of icons is displayed in the Resources pane.

Administrator access level only!

3 Double-click the Job Housekeeping icon.

The Job Housekeeping dialog box is displayed.

4 Select a schedule for archiving jobs, as described in “Job Housekeeping 
Settings” on page 677.

5 Click OK.

Dumping Jobs Dumping a job is similar to archiving a job. However, this function is only avail-
able to administrators, and is used for troubleshooting purposes. Dumping a job 
saves the job, together with all its system resources. This information can then 
be delivered to your Service Technician who can use it to reproduce the problem. 
You can also make a dump of several jobs.
Apogee Reference Guide



210 WORKING WITH JOBS IN THE JOB LIST
Administrator access level only!

 To dump a job

1 Select the Jobs Window.

2 Select one or more jobs in the Job List.

3 Choose File > Export > Job Dump.

4 In the Save As dialog, choose the location where you want to save the job 
dump. The file name is the job number with the .zip extension. You can 
change the name of the ZIP file if you want. If you selected more than one job, 
each job dump is saved in a separate ZIP file.

The following status icon appears next to the job name while the job is being 
dumped: 

Make sure the location you chose has sufficient disk space to save the job and 
perform the compression.

As soon as the job has been successfully dumped, the dumping status icon 
disappears (any previous status icon reappears), and the job icon displays a 
small “dumped” indicator:

Merging Jobs Apogee allows you to merge any number of jobs in the Job List into a single 
merged job. This is particularly useful for ganging the products of several smaller 
jobs into a larger job. You can combine multiple jobs with bound and/or 
unbound products into a merged job. Merged jobs are by definition multi-
product jobs. The Apogee Impose module can be used to place the parts of the 
different jobs on the press sheets of the merged job.

The Origins of Merged Jobs

The relationship between a merged job and the originating jobs and products is 
displayed in the top right corner of the Products tab as a property of the selected 
product. For merged jobs, the link indicates the order number and job name of 
the original job (originator). For jobs that have been merged, the link indicates 
the order number and job name of the merged job. Clicking these links highlights 
the job in the Job List.
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Unsupported Jobs

The following conditions must be met in order to merge jobs:

 A job to be merged must not be a multi-product job, in other words it should 
only have one product.

 A job to be merged must not have versions (versioning job).

 A job which has already been merged and a merged job cannot be used as one 
of the jobs to be merged.

 It is not possible to merge regular, non-layout jobs with layout jobs.

Otherwise you are free to combine bound and unbound jobs with different 
properties (presses, colors, media) and the Merge Assistant helps you collect and 
merge suitable jobs.

NOTE: The imposition settings for the individual products are maintained in the 
new merged job.

 To merge existing jobs

1 In the Job List, select the jobs you want to merge into a single merged job by 
pressing CTRL and clicking the jobs.

You can select job folders or individual jobs within a folder. If you select 
folders, all the jobs in the folder are included in your selection for merging.

2 Context-click in the blue, highlighted area and choose Merge Jobs.

The Merge Assistant is displayed.
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The selected jobs are listed with their details. Jobs which cannot be merged 
(unsupported) are grayed out and the product type is displayed in red in the 
Product column.

Unsupported jobs (e.g. multi-product and versioning jobs) can be hidden in 
the list by selecting the Hide unsupported jobs check box.

3 If necessary, fine-tune the list of jobs you want include in the merged job. You 
can sort the jobs by column and choose the most appropriate jobs to be 
merged by Press, Stock, Media, etc. 

You can select multiple jobs in the list and click one of the check boxes to clear 
them from the list, or to include them in the merging.

The properties in the columns are also available in the Filter panel on the left. 
Either type in the Quick Filter to filter on the Order Name and Job Name, or 
choose/combine with any of the other filters. You can save your filter by 
choosing Set As Default in the cogwheel menu (top right corner of the Filter 
panel). You can revert to this filter at any time by choosing Revert in the 
same menu.

A summary of the jobs you are going to merge appears at the end of the table. 
If you want the system to delete the jobs to be merged, select the Mark for 
deletion after check box and enter the number of days/months before the 
jobs are deleted. You also have a Disable inputs check box that allows you to 
queue documents that are input for jobs to be merged.

NOTE: If you selected a mix of regular jobs and layout jobs, you will see two 
radio buttons (non-layout jobs and layout jobs) forcing you to select either 
one of these job types. It is not possible to merge regular, non-layout jobs 
with layout jobs.
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4 In the Resulting merged job panel, you specify the details for the new 
merged job:

By default, the first supported job ticket in the Candidate Jobs list is used to 
create the new job. If you want to use a different job ticket, click the cogwheel 
button and choose another job from the drop-down list.

OR

Click the cogwheel button and select a Ticket Template. The Templates 
dialog is displayed and you can choose a job ticket template. Click Select to 
return to the Merge Assistant.

5 Enter the Order Number and Job Name for the new, merged job to activate 
the Merge Jobs button.

6 Select the Preserve imposition of original jobs check box if you do not want 
the Merge Assistant to change the existing impositions.

7 Click Merge Jobs.

If you didn’t clear the Edit merged job with Job Ticket Editor check box, the 
Job Ticket Editor opens and you can complete the job set-up, including 
imposition with Apogee Impose. If the merged jobs had documents, these 
documents are added to the merged job. The Comments box in the Adminis-
tration tab lists the jobs merged to create the merged job.

The Merge Assistant window remains open but the merged jobs are removed 
from the list. If you want to close the Merge Assistant after merging, select the 
Close Merge Assistant check box before clicking the Merge Jobs button.

8 Submit the new merged job.

The merged job is added to the Job List. The original jobs and the merged job 
are indicated with a special status icon:

9 In the Merge Assistant, click Close to finish merging or repeat the merging 
procedure to merge another batch of jobs in a second merged job.

A job that has been merged

A merged job: The job resulting from the merging of two or more other jobs.
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Working with Jobs in the Pages Tab

The Pages tab lists the documents that have been input to the selected Page Store 
(Private or Public Page Stores), and the pages that have been copied from the 
Page Store and included in the job’s Run List. You can add pages from the Page 
Store to the Run List, but you cannot change or remove previously placed pages 
since this would require a remake of the job. To change or remove previously 
placed pages, you must edit the job in the JTE.

 “Working with the Page Store” on page 215

 “Working with the Run List” on page 218

 “Imposition Adjustment” on page 224

 “Create Versions Assistant in the Page Store” on page 226

 “Versioning Jobs in the Run List” on page 228

 “Multi-part Jobs in the Run List” on page 232

NOTE: If you are viewing a versioning job, the layout of the Run List is 
considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Run List” on 
page 228.

 To display pages in the Pages tab

1 Select the Jobs Window.

2 In the Job List, select a job to which pages or documents have been input.

3 Click the Pages tab.

NOTE: The Pages tab is only available for jobs based on Job Tickets: It is not 
available for jobs based on Hot Tickets.

You will see the Page Store on the left and the Run List on the right. Any 
documents that have been successfully input are listed in the Page Store. By 
default, this list is collapsed. 

The Run List displays the number of placeholders in this job. This number is 
specified in the Run List Task Processor Settings.
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4 To view individual pages in the Page Store, click the expand buttons associ-
ated with the input documents.

 To view job results in the Page Store or Run List

NOTE: To open PDF documents, you must have already specified where your PDF 
Reader application is located (see “Preferences” on page 92).

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Pages tab.

4 Context-click a page or document in either the Page Store or the Run List, and 
select View Page From.

A sub-menu is displayed, listing the results which are still available at various 
stages in your Production plan. For example:

By default, whenever you include a Run List in your Production Plan, a Keep 
Results Action is always attached to the preceding Task Processor in the flow. 
You will therefore have at least one set of results (the Latest) to choose from. 
If any of the earlier Task Processors in the flow have Keep Results Actions 
attached to them, you can choose to view these instead.

TIP: This feature is useful if 
you want to diagnose errors, 
by comparing results from 
different points in your 
Production Plan.

5 Select the results you want to view.

Apogee automatically starts the PDF Reader.

If you select a document, the viewing application displays the first page of the 
selected document. The page or document is opened in read-only mode.

NOTE: You can also simply double-click a page or document to display the last 
available result before the Run List Task Processor in your Production Plan.

You can also view results in the Results tab view. The distinction here is that 
the Pages tab provides a view on job input results, while the Results tab 
provides a view on the output results.

Working with the 
Page Store

The Page Store may be either a Private Page Store, which displays only the 
documents for a single job, or may include one or more Public Page Stores which 
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display the documents created by all Page Store Out Task Processors. The Page 
Store lists the documents that have been input, and that may be added to your 
Run List. 

By default, documents are arranged as folders alphabetically in the Page Store. 
The number of pages is shown in parentheses after the document name. If more 
than one version of the document has been input, you will see the document 
revision number in a separate column.

 To delete documents from a Page Store

1 Open a job for editing, as described in “To select and edit a Ticket” on 
page 342.

2 Click the Pages tab.

3 Select the documents you want to delete from the Page Store.

NOTE: You can only delete documents: You cannot delete individual pages.

4 Choose Edit > Delete Document, or press the Delete key.

Apogee requests your confirmation.

5 Click Delete to delete the document.

6 Submit your changes.

 To delete documents from a Public Page Store

1 Select a Public Page Store from the Jobs List.

2 Select one of the Public Page Store documents in the Pages tab.

3 Choose Edit > Delete Document, or press the Delete key.

Apogee requests your confirmation.

4 Click Delete to remove the document and all its pages.

Any documents that are still being used will be kept until they are no longer 
required.

 To export documents from a Page Store

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Pages tab.
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4 Select a document in the Page Store (or in a Public Page Store ).

5 Choose File > Export > Export Document From, and select the Task 
Processor from which you want to export the document results (e.g, Latest, 
Preflight, etc.).

NOTE: You can choose to export from any of the available results at any point 
in the flow.

The Export Document dialog box is displayed.

6 Choose a name, location, and file type (pdf), and click Save.

Apogee suspends all processing on the selected item and its results, and saves 
the document in the specified Export location. You can now edit the exported 
file outside the Apogee Client, using the associated PDF editing application.

 To check out pages or documents in a Page Store

You may want to edit a PDF document which is already in the Page Store.

1 Go to the Page Store and select one or more pages, or one or more documents 
(but not a combination of pages and documents).

2 Choose Edit > Check Out and Edit Document, or context-click and choose 
this command.

3 After editing, check in the documents or pages using the Apogee plug-in in 
Acrobat or any other PDF Viewer/Editor application such as the Amfortis 
Editor.

 To copy documents to another job

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Pages tab.

4 Select one or more documents in the Page Store.

5 Drag the document(s) to another job in the Job List.

You can copy a document, or a folder of documents from one job to another 
job, to a Hot Ticket, or to the file system (Finder or Explorer). You can also 
copy documents from and to a Public Page Store.

NOTE: You can only copy a complete document.
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Working with the 
Run List

The Run List displays the pages that have been selected from the Page Store, and 
that will be included in your job. A page in the Run List shows similar informa-
tion to the same page in the Page Store. The page name is the document name 
as displayed in the Page Store, followed by the page number. Placeholders and 
blank pages do not have a name.

NOTE: If you are working with a versioning job, the layout of the Run List is 
considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Run List” on 
page 228.

 To add pages to a Run List

1 Locate the pages in the Page Store, as described in “To display pages in the 
Pages tab” on page 214.

2 Select the document and/or pages you want to add.

Pages that are not placed in the Run List have a green background.

For information on selecting several contiguous or non-contiguous pages, 
see “To select or de-select multiple jobs or items” on page 195.

3 Drag the documents and/or pages from the Page Store to the desired position 
in the Run List.

TIP: Press E to select even 
placeholders and press O to 
select odd placeholders 
while dragging pages to the 
Run List.

The status icon in the Job List indicates that the Run List is being edited:

While you are editing the Run List, Apogee locks it to prevent other users 
from trying to edit it at the same time.

Pages that are placed in the Run List now have a gray background.

After adding pages to the Run List, you need to submit your changes (see “To 
submit a ticket” on page 354). Other Clients will not see the newly added pages 
until they have been submitted.

NOTE: If a page is to be added to the Run List, but fails before it reaches the Run 
List Task Processor (e.g. in the Normalizer), then it will not appear in the Run 
List. Instead, it will be marked as being in error in the Page Store. You will be 
alerted of this by a notification.
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 To select all, even, odd, or empty placeholders

1 Open the Run List, as described in “To display pages in the Pages tab” on 
page 214.

2 Context-click on a page in the Run List.

3 From the context menu, choose:

 Select > All: to select all pages in the Run List.

 Select > Even Positions: to select all even numbered pages in the Run 
List.

 Select > Odd Positions: to select all odd numbered pages in the Run List.

 Select > Empty Positions: to select all empty placeholders in the Run List.

These options are useful for quickly setting up different page imposition 
settings for odd and even pages in a job.

 To move pages around within the Run List

1 Edit a job, and select the Pages tab.

2 Select the page you would like to move in the Run List, drag it to an empty 
placeholder, and release the mouse button.

The page is moved to the new position.

You cannot simply drop the page on top of another page, or on a blank page. 
If you want to do this, see “To move-replace pages within the Run List” on 
page 220.

3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 To move-insert pages within the Run List

1 Edit a job, and select the Pages tab.

2 Select the page you would like to move-insert and, while holding down the 
ALT key, drag it to another position in the Run List, and release the mouse 
button.

The page is removed from its original location and inserted at the selected 
position in the Run List.
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3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 To move-replace pages within the Run List

1 Edit a job, and select the Pages tab.

2 Select the page you would like to move and, while holding down the Shift key 
, drag it to another position in the Run List, and release the mouse button.

If you drop the page on an empty placeholder, the placeholder is filled. If you 
drop the page on top of another page or a blank page, the page is replaced. 
The original page position becomes an empty placeholder.

3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 To duplicate pages within the Run List

1 Edit a job, and select the Pages tab.

2 Select the page you would like to copy and, while holding down the CTRL 
key, drag it to an empty placeholder in the Run List, and release the mouse 
button.

The page is duplicated in the new position.

You cannot simply duplicate the page on top of another page, or on a blank 
page. If you want to do this, see “To duplicate-replace pages within the Run 
List” on page 221.

3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 To duplicate-insert pages within the Run List

1 Edit a job, and select the Pages tab.
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2 Select the page you would like to duplicate-insert and, while holding down 
the ALT-CRTL keys, drag it to another position in the Run List, and release the 
mouse button.

A copy of the page is inserted at the selected position in the Run List. The Run 
List is automatically extended by the inserted number of pages.

3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 To duplicate-replace pages within the Run List

1 Edit a job, and select the Pages tab.

2 Select the page you would like to copy and, while holding down the Shift and 
CTRL keys, drag it to another position in the Run List, and release the mouse 
button.

If you drop the page on an empty placeholder, the placeholder is filled. If you 
drop the page on top of another page or a blank page, the page is replaced.

3 Submit your changes.

NOTE: Take care to ensure that any changes you make do not conflict with your 
imposition layout.

 Reverse the order of pages in the Run List

The page order in the Run List can be reversed while dragging them from the 
Page Store or by selecting placed pages.

1 Open the Run List, as described in “To display pages in the Pages tab” on 
page 214.

2 Select the placed pages that you want to reverse and choose Edit > Reverse 
Page Order, or briefly press ‘R’.

OR

3 While dragging the pages on to the Run List, briefly press ‘R’.

The order of the pages is now reversed.
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 To insert blank pages in the Run List

1 Open the Run List, as described in “To display pages in the Pages tab” on 
page 214.

2 Select the placeholder(s) in the Run List that you want to fill with blank 
pages.

3 Context-click on the selection, and choose Placeholder > Make Blank from 
the context menu (or click the Make Blank button in the Toolbar).

The empty placeholders are replaced with blank pages.

 To fill all empty placeholders with blank pages

1 Open the Run List, as described in “To display pages in the Pages tab” on 
page 214.

If your job contains a series of empty placeholders that are spread out 
throughout the Run List, you can fill them all with blank pages in one step.

2 Select all pages in the Run List.

3 Context-click on one of the highlighted pages, and choose 
Placeholder > Make Blank from the context menu (or click the Make Blank 
button in the Toolbar).

All the empty placeholders are replaced with blank pages.

 To jump to a position in the Run List

1 Open the Run List, as described in “To display pages in the Pages tab” on 
page 214.

2 Select the Run List pane.

3 Type the # character, followed by the placeholder position you want to jump 
to. 

For example, type #33.

4 The selected Run List placeholder position is displayed.

 Add a page comment in the Run List

 Click in the Comments column on the row of a page or placeholder in the Run 
List, and type your comment.

The comment is displayed as text in the column or as a balloon icon if the 
column width is minimized; hover over the balloon icon to see the comment.
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After submitting the job, comments are visible for all users who can see the 
job in the Job List.

 To adjust page imposition in the Run List

1 Select a job which uses imposition in the Production Plan, and edit it.

2 Open the Run List.

3 To change the layout of a page, do one of the following:

 Context-click the page in the Run List, and choose Page 
Adjustment > Offset By...

 Context-click the page in the Run List, and choose Page 
Adjustment > Scale By...

 Context-click the page in the Run List, and choose Page 
Adjustment > Rotate By...

4 Make your changes as described in “Imposition Adjustment” on page 224.

Any pages that you modify in this way are flagged in the Run List with the 
following icon:

By default, Apogee shows the simple page adjustment view. However, you 
can select View > Extended Page Adjustments to switch the view. For more 
information, refer to “Run List Page Adjustment Icons” on page 180.

5 Submit the job to save your page adjustments.

You can also access all imposition options in a single dialog box. To do this, you 
must first edit the page, and then context-click it and choose Page 
Adjustments > Edit from the context menu. 
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NOTE: The Page Adjustments dialog box displays the cumulative page 
adjustments you have made, unlike the individual offset, scaling, and rotating 
dialog boxes, which do not indicate any previously applied adjustments.

For example: if you set a 4 mm offset on a certain page and then select Page 
Adjustments > Edit, you will see that there is an offset of 4 mm for that page. If 
you add a second 4 mm offset for this page and again select Page 
Adjustments > Edit, you will see that there is a cumulative offset of 8 mm.

Imposition Adjustment

You can change the imposition of any page in the Run List by context-clicking the 
page and choosing Page Adjustments > Edit from the context menu.

NOTE: The adjustments displayed in this dialog box are the cumulative results of 
all adjustments you have done on the selected page. 

Offset

You can center a page, offset a page from the origin (lower left), or offset a page 
from the center.

Center Centers the page in the placeholder along the chosen axis (horizontal or 
vertical). The Center check box reflects the current center state; it is selected if 
the page was previously centered (regardless of the offset), and deselected if 
not.
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When you change the state of the Center option, the offset command sets the 
absolute position instead of adding to the previous one. In other words, the 
existing offset is reset, and the values of Center and Offset by are applied instead. 
In this case, the dialog box may display a warning: Changing the centering will 
reset the previously applied positioning.

NOTE: Changing the Center option on multiple pages, with a mixed Center state, 
becomes more complicated: Pages whose Center option will be changed are 
given an absolute offset; pages whose Center option will not be changed are 
given a relative offset.

Offset by Moves the page along the chosen axis (horizontal or vertical). Positive values 
move the page to the right, negative values move the page to the left. The default 
value is 0, meaning that no extra offset will take place.

Scale

You can reduce or enlarge the scale of a page within the imposition layout.

Horizontal To scale the page on the horizontal axis, select the Horizontal radio button and 
enter a value in the box.

 Positive values scale the image area up by the specified percentage towards 
the right of the page.

 Negative values scale the image area down by the specified percentage 
towards the left of the page.

 Click the Scaled to fit radio button to scale the horizontal page size up to the 
template page size.

Vertical To scale the page on the vertical axis, select the Vertical radio button and enter 
a value in the box.

 Positive values scale the image area up by the specified percentage towards 
the top of the page.

 Negative values scale the image area down by the specified percentage 
towards the bottom of the page.

 Click the Scaled to fit radio button to scale the vertical page size up to the 
template page size.

Retain original aspect ratio Select this check box if despite all changes you want the image to keep its 
original aspect ratio.
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Rotation

To rotate the page, click the Rotation list, and select one of the page rotation 
options:

 None

 90°

 180°

 270° 

NOTE: If you make any changes, you need to submit the job to save them (see 
“Submitting Tickets” on page 354).

Create Versions 
Assistant in the 
Page Store

If you are working with a versioning job, you can start the Create Versions assis-
tant in the Page Store. This assistant helps you set up your versioning job based 
on the documents available in the Page Store.

NOTE: The Create Versions assistant can also be opened in the Versions tab of the 
Versioning Task Processor in the production plan.

 Context-click a file, page, PDF layer or folder in the Page Store and choose 
Create Versions to open the Create Versions assistant.

Create versions

In this drop-down list you can choose how you want to create your versions.

 From files (n files): a version is created for each file in the Page Store.

 From pages (n pages): a version is created for each page in the Page Store; 
each version is named Version 1, Version 2, to Version n.

 From PDF layers (n layers): a version is created for each layer in the 
document

 From sub-folders (n folders): a version is created for each folder in the 
Page Store
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 Manually: choose this option if you want to set up your versions from 
scratch; enter the number of versions you want in the ‘Number of 
versions’ box.

NOTE: Depending on what you selected in the Job Store (a file, page, PDF layer 
or folder) one of the first four options is selected automatically. The options 
displayed in the drop-down list depend on the structure of the Page Store.

Name convention

In this field you can control the creation of the versions in two ways (all modes 
except manual):

 select items that match the name convention and move those that don’t 
match from the Versions column to the Ignored Items column

 extract part of the item name for use as the version name

This matching system uses file name templates with wildcard characters and the 
following 2 variables:

 <VERSION>: extracts the version base name from the item name
e.g. a name convention Brochure_<VERSION> will create a Version Name 
French from a file name Brochure_French

 <VERSIONINDEX>: extracts the version number from the item name

If these variables are not used, the version name is the item name (or part of it) 
with an assigned version number.

Versions and Ignored Items

The Versions pane lists all the versions created by the assistant in accordance 
with the option chosen in the ‘Create versions’ drop-down list and the filtering 
applied with the name convention. If no filtering is applied, a version is made for 
every file, page, PDF layer or sub-folder, and the versions will be organized in the 
Run List according to this list.

You can rearrange the versions in the list using the buttons on the left and you 
can choose to ignore versions in the list by moving them to the Ignore items list 
on the right. Items can be moved back to the versions list and the versions are re-
numbered. You can use the Reset button to re-apply the naming convention.

Set up Run List Layers These are some extra options for correctly setting up run list layers. Select this 
option to create a run list layer based only on the version.
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 Include a column for common content: a run list layer called Common for the 
full page range is created 

 Limit version-specific content to a range of pages: select this check box if you 
want to specify a run list range for the version-specific run list layer. You can 
select default page ranges from the drop-down list.

Jump to versioning task
processor when done

Select this check box if you want to continue setting up the Versioning task 
processor when you have finished using the assistant.

Versioning Jobs in 
the Run List

If you are working with a versioning job, the layout of the Run List is consider-
ably different. 

The Run List has one group of columns for each layer added in the Page 
Assembly setup (Versioning Task Processor settings). Each column group has 
one column for each possible variation of the layer. To make a page for a version, 
Apogee combines the contents of one layer variation from each column group. 
Each different version combines the content from different layer variations. By 
default, you will see all the columns that contribute to all versions.

Overview - All Versions

The example below has two layers: one for background graphics and one for 
text. The layer for text has four variations - Default, English, French and 
German.

The columns - referred to as Run List Layers (RLLs) - contain all possible varia-
tions which can be used to produce the different page versions. For each page, 
you will see an associated page number and signature.
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Versions

The versions are defined in the job’s Production Plan, allowing you to create jobs 
which contain several different versions for some or all of the text (for example, 
using different languages as illustrated above).

Run List Layers (RLLs)

The RLLs are defined in the job’s Production Plan, and are used to add extra 
dimensions to the specified versions. For example, you can use RLLs to break 
down each language version into two parts: The CMY ‘background’ color separa-
tions which are common to all versions, and the black ‘text’ separation which is 
different for each version.

In the example above, there are two RLL columns: The first RLL is labeled 
‘Background’; the second RLL is labeled ‘Text’.

Version selection list

By clicking the All list at the top right of the Run List, you can display the Version 
selection list.

Each version is automatically assigned a specific version number (V1, V2, etc.) 
and color code for easy identification. Here, you can select a specific version, in 
order to display only the pages that contribute to this version. 

These shortcuts are available in the plate set-up tab of the Versioning task 
processor in the Plan tab.

To... Press (Windows)

Switch to a next version, or the first one if 
on `all versions'. Does not
wrap around, and does not select `all ver-
sions' if on the last version.

CTRL + ]

Switch to a previous version, or the last 
one if on `all versions'. Does not
wrap around, and does not select `all ver-
sions' if on the first version.

CTRL + [

Show all versions. CTRL + \
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Apogee makes a version page by combining the contributing pages you see in 
one row.

Page and Version Indicators

Each page may contribute to a side in one or more versions. To the left of the 
page icon, you will see a small vertical bar called the plate set indicator. This 
indicates if the page is contributing to sides for which plates will be made.

To select/clear identical plates of all 
selected version rows.

Alt + click a plate

To set every version in the selected rows 
to a specific version.

Alt + select a specific 
version in the Version 
list

To set every version in the selected rows 
to its own version.

Alt + select Own Version 
at the top of the Version 
list

Expand a selection. Shift

Exclude from a selection. CTRL

Clear a selection. CTRL + Shift + A

To... Press (Windows)
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In the Page Store, the names and page numbers of placed pages are displayed in 
gray: Unplaced page names and numbers are displayed in black. As soon as one 
page or even one PDF layer from a document is placed, the document name is 
also displayed in gray. A document name displayed in black indicates that none 
of its pages are placed.

NOTE: Folders names never indicate placed/unplaced status. They always 
appear in black.

Flowing Pages in Versioning jobs

Placing pages for versioning jobs is facilitated by the ability to flow version pages 
horizontally in the run list. For example, 20 versioning pages can be dragged 
onto a single page in the run list to fill it with different versioning content.

Zooming into the Run List

For versioning jobs you can zoom into the Run List pane and make the labels 
wider or narrower.

A full bar indicates that one or more of the side versions to which this page contributes will 
have a full set of plates made.

A half full bar indicates that one or more of the side versions to which this page contributes 
will have a partial set of plates made.

An empty bar indicates that none of the side versions to which this page contributes will have 
any plates made.
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 Press the CTRL key and use the scroll wheel, or the plus and minus keys to 
zoom in and out

OR

Choose View > Scale and select one of the scaling commands.

Multi-part Jobs in 
the Run List

If you are working with a multi-part job, the layout of the Run List is considerably 
different. In the Run List header you will see the parts filter. This allows you to 
refine the view to the pages of a single part only, and each part is color-coded.

NOTE: You cannot select multiple parts for viewing: Your choice is either all or 
one.

NOTE: If there are a lot of 
parts, the part names are 
abbreviated, or the buttons 
may be replaced by a drop-
down list.

If there is only one part (the default part), the parts filter is hidden and there is 
no color-coding: The job therefore looks like a simple job.

Any inserts that need to be produced by the job do not interrupt the page 
numbering of the main content. Inserts have their own page numbering, which 
is clearly distinguishable from the main content.
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Placing Pages in Multi-part jobs

The filtering or sorting of the Run List does not affect the way you place pages in 
it. The rule is the same in all cases: pages are placed consecutively, and there 
must be sufficient placeholders:

 If the Run List is in normal view mode, you add pages as usual. Multiple pages 
are placed on consecutive placeholders, regardless of parts, except those that 
have independent numbering.

 If the Run list is filtered on a single part. The positions of the part are treated 
as being consecutive. The boundaries of the Run List are set by the number of 
pages in the part - you cannot add more pages than there are positions in the 
part.
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Working with Jobs in the Results Tab

The Results tab allows you to preview the results of the selected job, and monitor 
any ongoing activity in the job’s Production Plan:

 “Changing Viewing Options” on page 234

 “Re-rendering Results” on page 236

 “Re-imaging Results” on page 237

 “Re-exporting Results” on page 238

 “Remaking InkDrive Files” on page 239

 “Re-printing Results” on page 239

 “Viewing Job Results in the Results Tab” on page 240

 “Rejecting Results” on page 241

 “Discarding Results” on page 242

 “Including Results” on page 243

 “Getting Information on PDF Data” on page 243

 “Info Window (for PDF Files)” on page 246

 “Info Window (for RGB/TIFF or Raster Files)” on page 248

 “Versioning Jobs in the Results Tab” on page 249

 “Multi-part Jobs in the Results Tab” on page 253

Changing Viewing 
Options

By default, all the available viewing options are selected. However, you can 
always disable or re-enable specific viewing options from the Jobs window.

 To show/hide thumbnails

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Results tab.
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4 Choose View > Thumbnails to toggle thumbnails on or off for the results 
displayed in the Job Layout pane.

TIP: Results are displayed 
faster when thumbnails are 
turned off.

When thumbnails are turned on, you will see a miniature image of how the 
selected results will look when printed. When thumbnails are turned off, you 
will see only a colored background instead of the image.

 To show/hide extra information

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Results tab.

4 Choose View > Show, and set your Extra display options by toggling on or off 
any of the following:

 Page Number: Shows the position of the page in the Run List.

 Hold States: Shows pages or flats in blue when on hold.

5 Choose View > Extras.

This acts as a “master switch”, to toggle all your selected Extra display 
options on or off.

 To select front and back sides

1 Select the Jobs Window.

2 In the Job List, select a job which uses imposition in the Production Plan.

3 Select the Results tab.

4 Choose View > Columns > Front and Back.

All the page signatures are displayed (the front and back of each page or flat).
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 To scale the Results view

1 Select the Jobs Window.

2 Select a job in the Job List.

3 Select the Results tab.

4 Choose View > Scale, and select one of the following:

 Small: Provides the smallest thumbnail visualization of the selected 
results.

 Normal: Provides the standard thumbnail visualization of the selected 
results.

 Large: Provides the most detailed thumbnail visualization of the selected 
results.

 Fit to Window: All selected thumbnail viewing options are displayed, 
scaled within the limits of the Job Layout pane. The results may be small, 
but you will not need to scroll to view them all.

 To show/hide separations

1 Select the Jobs Window.

2 Select a separated job in the Job List.

3 Select the Results tab.

4 Select a page or flat in the Job Layout pane.

The individual separations which combine to make up this item are displayed 
in the Separations pane. Each separation represents a different color.

NOTE: Separations are not available for composite jobs.

Re-rendering 
Results

You can re-render individually selected results (non-imposed flats, pages, or 
separations). When you do so, only the results of the selected pages or flats are 
remade - not the entire job.

You may want to re-render results if you have changed your resources (new 
fonts, color books, etc.). This is also useful if you want to remake aborted results, 
or remake output when the raster data (Digital Film) is no longer available. 
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NOTE: You can also re-render the output when the raster data is still available.

To re-render job results, the job must still have the original input documents (i.e. 
Keep Results Action on the input channel). 

What is the difference between Re-rendering and Re-imaging results?

When you select Re-render, Apogee will re-render and output the selected job 
results. When you select Re-image, Apogee will not render the results again: It 
will simply output the existing raster data to the selected output device. Re-
rendering therefore completely regenerates the selected job results, but takes 
more time and uses more resources.

 To re-render results

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, select a flat, page, or separation that 
has already been successfully processed.

4 Choose Control > Re-render <item>.

TIP: This is different from 
editing a job, where existing 
results are not affected by 
any changes you make.

All scheduled and active tasks after the selected point in the flow are aborted, 
and re-rendering is started. Any archives that were made on the first pass will 
be remade, and the old archives deleted.

 To re-render backgrounds (Apogee DQS)

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, select a flat that has already been 
successfully processed using Apogee DQS.

4 Choose Control > Re-render backgrounds.

Re-imaging Results Re-imaging is used to remake previously imaged raster data (Digital Film). This 
feature is available only for flows that have an imaging output device, and that 
have kept the finished raster data using the Keep Results Action.
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What is the difference between Re-rendering and Re-imaging results?

When you select Re-render, Apogee will re-render and output the selected job 
results. When you select Re-image, Apogee will not render the results again: It 
will simply output the existing raster data to the selected output device. Re-
imaging is therefore quicker and uses fewer resources.

 To re-image results

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, select a flat, page, or separation that 
has already been successfully processed, and which has kept the finished 
raster data.

4 Choose Control > Re-image, or click the Re-image button in the Toolbar.

The selected items are automatically re-imaged, ignoring any proofing or 
After Hours actions. In fact, no manual intervention is required since in most 
cases you want to re-image a plate as soon as possible.

If you re-image a job, Apogee re-images only the results of the main flow. If you 
want to re-image the results of another flow, you must select those results before 
re-imaging.

Re-exporting 
Results

You may want to re-export previously exported results if resources have 
changed, or when exported files have to be recreated.

 To re-export results

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, select a flat, page, or separation that 
has already been successfully exported, and which has kept the finished 
raster data.

4 Choose Control > Re-export.

The selected items are re-exported.
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Remaking InkDrive 
Files

Apogee allows you to remake InkDrive files for selected flats, pages, or separa-
tions. This may be necessary if the files are accidentally deleted or lost on the 
press side.

NOTE: The InkDrive license must be available, otherwise this option is disabled. 
Also, you can only remake InkDrive files when all selected results have the 
InkDrive data available.

 To remake InkDrive files

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, context-click a flat, page, or separa-
tion that has already been successfully processed, and which has kept the 
finished raster data.

4 Choose Remake InkDrive for <item> from the context menu.

Apogee sends the InkDrive file(s) for the selected results to the assigned 
location.

If you selected flats, Apogee creates an InkDrive file per flat; If you selected 
separations, an InkDrive file is created per separation. The names of the 
created InkDrive files are based on the default file name template that 
matches your selection: flats or separations.

NOTE: If you select separations in a multi-version job, Apogee creates 
InkDrive files for all selected separations.

Re-printing Results Re-printing is similar to Re-imaging, but is used specifically to print previously 
imaged raster data (Digital Film) on a digital press. This feature is available only 
for flows that have a digital press, and that have kept the finished raster data 
(using the Keep Results Action on the last processing Task Processor).

 To re-print results

1 Select the Jobs window.

2 Select the Results tab.

3 In the Job Layout or Separations pane, select a flat, page, or separation that 
has already been successfully processed, and which has kept the finished 
raster data.
Apogee Reference Guide



240 WORKING WITH JOBS IN THE RESULTS TAB
4 Choose Control > Re-print.

The selected items are re-printed on your digital press.

Viewing Job 
Results in the 
Results Tab

When you view results in the Results tab view, Apogee provides a view on the 
rendered output results. This is different from viewing results in the Pages tab, 
where Apogee provides a view on the job’s input results.

 To view job results in the Results tab

NOTE: To open PDF documents, you must have already specified where your PDF 
Reader application is located (see “Preferences” on page 92).

TIP: This feature is useful if 
you want to diagnose errors, 
by comparing results from 
different points in your 
Production Plan.

1 Select the Jobs Window.

2 Select a job in the Job List which has some rendered results.

3 Select the Results tab.

4 You can do either of the following:

 Context-click a page or flat in the Job Layout pane, and select View Page/
Flat From.

 Context-click a separation in the Separations pane, and select View 
Separation From.

A submenu is displayed, listing the results which are still available at various 
stages in your Production plan. Provided you attached a Keep Results Action 
to your output device, you can view the latest rendered results. If any of the 
earlier Task Processors in the flow have Keep Results Actions attached to 
them, you can also choose to view these instead.

5 Select the results you want to view.

Apogee automatically starts the viewing application that supports the 
selected document type. This is either:

 A PDF Reader for PDF documents.

 Raster Preview for documents which have already been rendered (Digital 
Film).

If you select a document, the viewing application displays the first page of the 
selected document. The page or document is opened in read-only mode.
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NOTE: You can also simply double-click a page or document to display the last 
available result in your Production Plan.

Rejecting Results There are two reasons why you would want to reject results:

 The content of the page/flat is wrong (incorrect information or typograph-
ical mistakes).

 The processing is wrong (incorrect screening, traps are too small, etc.). In 
this case, you can only reject results that are waiting on an Action that 
requires manual intervention (such as proofing or “collect for output”).

In both cases, in order to correct the problem you must re-submit the original 
document to the Apogee System.

If you wish, you can later accept rejected results and continue processing using 
the Continue command (see “Continuing Jobs” on page 197).

NOTE: Rejected pages are not re-rendered if you later re-render the job.

 To reject results

1 Select the Jobs window.

2 Select either the Pages or the Results tab.

3 Select a document, page, flat or separation.

4 Choose Control > Reject <item>, or click the Reject button in the Toolbar.

The Reject dialog box is displayed. 

5 If you wish, add a comment explaining why you are rejecting the results. 
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This information can later be viewed in the Job Log.

6 Click Reject.

All processing for the selected item is aborted, and the job is marked with a 
rejected status icon.

All flats that use the rejected page will be marked as rejected.

NOTE: In a multi-flow Production Plan, you can only reject the processing of a 
Main or Export flow, not of a Proofer flow.

 To clear rejected results

1 Select the Jobs window.

2 Select either the Pages or the Results tab.

3 Select the rejected result(s).

4 Choose Control > Clear Rejected Status.

The rejected status is removed, and processing restarts.

Discarding Results You discard results in order to prevent specific documents, pages, flats or separa-
tions from being printed, without stopping the rest of the job from being printed. 
You can discard results interactively in the Results tab, or you can add a Discard 
Action to your Production Plan.

 To discard results interactively

1 Select the Jobs window.

2 Select the Results tab.

3 Select a document, page, flat or separation.

4 Choose Control > Discard <item>.
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NOTE: You can only discard results that are already output or that are waiting 
to be output. You cannot discard input files, or pages in an imposition 
workflow.

The thumbnail of the selected item is dimmed with diagonal stripes across it 
and the separation icons are dimmed and barred (see below left). If you are 
discarding a specific separation, only the separation icon is dimmed and 
barred in the Job Layout pane (see below right). However, the individual 
separation is barred in the Separations pane.

You can perform no further action on discarded results (delete, reject, etc.) 
until they are ‘included’ once more in the job.

Including Results You can ‘include’ discarded results in order to remove their discarded status, and 
to make the selected results part of the job again. Any status that the results had 
before they were discarded is once again taken into account (e.g., on hold, in 
error, etc.).

 To include results

1 Select the Jobs window.

2 Select the Results tab.

3 Select a document, page, flat or separation that has been discarded.

The thumbnail of the selected item is dimmed with diagonal stripes across it. 

4 Choose Control > Include <item>.

The thumbnail returns to normal, and the selected item is once more part of 
the job.

Getting Information 
on PDF Data

Get Info is a command that displays extensive information about a selected item 
(a page, a flat, or a job). The Info window uses an extensible mechanism to 
organize and display the attributes of the selected item(s).
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 If you select one or more documents in the Page Store (Pages tab), one Info 
window is displayed per selected document. Each window describes a single 
document and it’s page details.

 If you select one or more pages from a document, a single Info window is 
displayed, describing the document and the selected page details.

 If you select one or more pages from the Run List, a single Info window is 
displayed, describing the origins of the selected pages and the page details.

 If you select a single flat in the Results tab, a single Info window is displayed, 
describing the flat and the details of its pages.

 If you select multiple flats, one Info window is displayed per flat.

 To get info on an item

1 Select one or more items in the Pages tab or the Results tab.

These may be documents, pages, flats, or jobs.

2 Context-click a page or flat in the Job Layout pane, and select Info for 
<item> From.

A submenu is displayed, listing the results which are available at various 
stages in your Production plan. 

TIP: This feature is useful if 
you want to view info on 
results from different points 
in your Production Plan.

For example:

3 Select the results you want to view information on.

4 You can also click the Info tool for information on the Latest results.

The Info dialog box is displayed. The content of the dialog box depends on 
the selected item(s): 

 If you choose to view result information from the Hot Folder or Normalize 
Task Processors, you will see information on the PDF results (see “Info 
Window (for PDF Files)” on page 246).
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 If you choose to view result information from the Render Task Processor, 
you will see information on the TIFF results (see “Info Window (for RGB/
TIFF or Raster Files)” on page 248).

NOTE: You can get information on a selection containing multiple items, if the 
items are of the same type. You cannot select multiple items of different types. 
For example, you can get information on several files in the Page Store, but not 
on a file and a page.
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Info Window (for PDF Files)

The Info window has a number of tabs which provide information on any PDF 
item you select.

General

The first section displays the name, title and author of the selected item, as well 
as the date it was created and the name of the person who created it.

The second section indicates how the document was received and converted into 
an acceptable working format (PDF or TIFF).

Producer The name and version of the Task Processor that converted the document into 
an acceptable format (e.g. the Normalizer).

Page Store The path name of the document in the Page Store. You can context-click the field 
label or path name to reveal the physical location of the file. The label then 
changes to “Location”. If the document is stored as multiple files (e.g. split PDF, 
DCS, etc.), only the common part of the file name is shown. context-click again 
to display the Page Store location.

Size The physical size of the document on disk.

Nr of Pages The number of independent pages in the document. The word “Split” appears 
when the document is stored as a single, independent file per page (this is one of 
the Normalize Settings).

NOTE: Apogee displays a status icon if the document has any outstanding 
warnings or errors. Clicking the icon opens the job's problem report, filtered to 
show the current document's notifications. 

The third section details modifications (if any) which may have been made to 
the document:

Format The name and version of the document’s format (e.g. Composite, PDF 1.5). This 
can either be the format it was converted to, or the original format of the 
document if this was already acceptable. Some format details may also be listed 
here.

Dimensions

This tab provides detailed information on the width and height of the selected 
pages.
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The first section lists all pages in the document, and a summary of the most 
important box dimensions:

Page Indicates the standard page size.

Trim Box Indicates the trimmed page size (the size of the paper in the desktop printer; the 
size of the pages after folding/binding and cutting in a production house).

Bleed Box Indicates the bleed area specified in the layout application, or in the PostScript 
to PDF converter.

Crop Box Indicates the page size in Acrobat, and is also the default view (when this PDF 
file is opened).

The second section displays additional box size information on the page selected 
in the first section.

Art Box Used to select an area of the page, such as clipping path, which you can import 
into another application.

Media Box Contains all the other boxes, and is always the largest box.

Resources

The resource tab features a page list, resource category list, and a resource list in 
the top section, and a Resource Details pane in the lower section.

Page Lists the page(s) selected.

Category Lists all resource categories available for the selected page(s). A number after 
the category name shows how many resources of that category exist for the 
item(s) selected. If there are no resources for a given category, no number is 
shown.

Resource Lists all resources available for the selected page(s) and category, sorted by 
category name and resource name or occurrence.

Resource: Displays the name of the resource. Unnamed resources are given a 
name by concatenating the resource category and an occurrence number.

Position: Shows the positions in the Run List where each resource appears. It is 
empty if the resource is not used in the job.

Attributes: Displays a textual summary of the most important attributes of the 
resource.
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Selected Resource details The attributes of the selected resource are displayed in the lower section of the 
Resources tab.

Refer to “Task Processor Resources” on page 939 for details on the different 
resources and their attributes.

Info Window (for RGB/TIFF or Raster Files)

The Info window provides the following information on your RGB/TIFF or raster 
results.

Kind Provides the following information about the selected image type:

 Monochrome

 Grey

 RGB

Channels May indicate which color channels are available in the selected image:

 R, G, B

 C, M, Y, K

Physical Dimensions Width and height of the selected item, in the selected display units specified in 
your Preferences (mms or inches).

Dimensions Width and height of the selected item, in pixels.

Resolution Width and height of the selected item, in pixels-per-inch.

Rows/Strip Number of rows per strip.

Compression The type of image compression used, if any:

 ASWC

 CCIT

 PackBits

 Group 3 Fax

 Group 3 Fax
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 JPEG

 LZW

 None

Orientation The orientation of the selected file:

 Up

 Down

 Right

 Left

# Separation number.

Separation Separation name.

Versioning Jobs in 
the Results Tab

If you are working with a versioning job, the layout of the Results tab is consid-
erably different. There are far more signatures (one set per version) than in a 
conventional job, so viewing them together is impractical. Apogee therefore 
presents an overview of all signatures, from which you can switch to a view of 
the signatures of any single version.

The versions are defined in the job’s Production Plan, allowing you to create jobs 
which contain several different versions for some or all of the text (for example, 
using different languages). Each version is automatically assigned a specific 
version number (V1, V2, etc.) and color code for easy identification. 
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Overview - All Versions

In the Results overview, Apogee displays all signatures together in a matrix, 
organized by signature number across and by version down. Version titles are 
displayed on the left, signature numbers above and plate counts for each version 
on the right. If there are too many signatures and/or versions to fit in the display 
area, the signatures, titles and plate counts scroll in the manner of a spreadsheet, 
while the appropriate titles and plate counts remain visible.

Signature status icons

In each signature area in the matrix, Apogee displays a rectangle for each side of 
the signature for which one or more plates will be made according to the plate 
setup. Apogee omits sides for which where no plates will be made. The sides are 
arranged in front and back pairs where appropriate and with one pair per web 
when necessary.

The following version states may be displayed:

Figure 5.3: Version matrix (single-version press sheets)
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If you double-click on a side, the selected results are displayed in Raster Preview 
(if the raster data is available).

Version titles

To the left of each row of signatures, Apogee displays a version title next to the 
version number. For single-version sheets (i.e. each version is assigned to its 
own press sheet), the original product version title is used. If the versioning job 
has multiple product versions on a press sheet, the sheet version title is 
displayed, for example, PS 1-SV2, and not the product version title. See “Version 
Setup Dialog Box” on page 836 for more information on multiple product 
versions on a press sheet.

Full bar at the side of the box: A full set of plates will be made for this side.

Half bar at the side of the box: A partial set of plates will be made for this version.

One or more version pages used by the side is not yet available (empty placeholder).

The background and all version pages used by the side are available, but the render 
data for the whole side is not yet complete.

All render data for the side is available, but not all plates have yet been produced.

Finished state: All plates for the side have been produced.

Error state: Processing of this side has been stopped by an error.

On Hold state: Processing of this side is waiting at a hold point.

This side or one of its separations or pages has been rejected.

This side has been discarded and will not be processed further.
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The version title indicates the signature status:

 If any side is in error, the version title background is displayed in red.

 If any side is on hold (and none are in error), the version title background is 
displayed in blue.

 If all the sides are either ready to be printed, or have already been printed, 
then the version name is displayed in bold.

If you double-click a version title, Apogee displays the signatures of the selected 
product version or press sheet version.

Signature titles

Above each column of signatures, Apogee displays a signature title (the number 
of the signature). The signature title indicates any error or hold states among the 
sides in its column in the same way as a version title.

If you double-click on a signature title, Apogee displays the sides in that signa-
ture in Raster Preview.

Plate count summaries

To the right of each row of signatures, Apogee displays a plate count summary. 
This indicates the number of plates made so far, and the total to be made. 
Clicking on the plate count summary has the same effect as clicking on a version 
title.

Figure 5.4: Version indication for multiple product versions on a single press sheet (multiple-
version sheets)
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Apogee estimates the number of plates to be made for a version from the infor-
mation you enter in the plate setup. 

Version selection list

Open the version selection list to display the results for a particular product 
version. The process color plates for the selected version are specified along the 
top right edge of the thumbnail using the same color code for the version 
indicator.

For press sheets containing multiple product versions (multiple-version sheets), 
you will see a sheet version indicator on a gray background.

Multi-part Jobs in 
the Results Tab

If you are working with a multi-part job, the layout of the Results tab is consid-
erably different. 
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The Job-Context Selector

Multi-part jobs include a job-context selector in the Activity pane. This allows 
you to select the different contexts in the results tab - flows, versions and produc-
tion sets. This also includes a production set selector.

The version and production set controls in the job-context selector have a drop-
down menu that allows you to display a list of versions and production sets. 
These lists have an additional All item which shows all results in that level.

The flow control has no list. Instead, it shows the different flows as icons (plus 
the name of the flow). Click on an icon to select the flow results you want to 
view. You cannot select multiple flows.

To the right of the job-context selector, you will see a textual description of the 
number of results (usually plates) in the selected job context and how many of 
those are finished. If you select a signature, you will also see the selected item 
name and the number of plates that are included.

Production Sets Table

The Results tab also includes a Production Sets table, similar to the one in the 
Plan tab. This table lists the names of the production sets, the engines and 
presses that are being used, the sheet ranges and plate counts and the part(s) 
contained in each. The table also indicates the status per production set (idle, 
waiting, error, finished, etc.).

The Production Sets table allows you to filter the results view to the sheets of one 
or more production sets, regardless of the number of devices and/or presses that 
are used to make it. You can CTRL-click to select multiple items.
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NOTE: If you continue any of the results, Apogee will continue only what you 
have selected, regardless of the grouping of the Collect for Output action.

Display Icons

You can hide the Production Sets table independently from the Activity Pane, 
using the buttons in the top right corner of the Results tab. 

 Click the first of these icons to show/hide the Activity pane. 

 Click the second of these icons to show/hide the Production Sets table. 

 Click the third icon to show/hide the Separations pane.

Single-part and Existing Jobs

When you create a single-part job, Apogee creates one part and one production 
set (the default part and production set). You can simply ignore the Products 
tab, and set up your job as usual. If you upgrade from previous versions of 
Apogee, all jobs, Hot Tickets and Ticket Templates have a single part and 
production set added. If you wish, you can hide complexity in single-part jobs by 
collapsing the views.
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QuickProofing Pages

QuickProofing is a method of proofing one or more documents or pages from a 
job without having to edit the Production Plan of the job. You can do this by 
selecting the items you want to proof (a document, page, or multiple documents 
or pages) and dragging them to a proofer icon in the Output Device panel. You 
can use all proofing devices (real and file-based) for QuickProofing, and you can 
drag pages/documents from the Page Store, Run List, or Results tab.

You can QuickProof: 

 PDF documents and pages.

 Raster documents (representing pages or flats) that are compatible with the 
Digital Film Proofer Task Processor (1-bit and 8-bit, composite or pre-
separated).

The resulting QuickProof job is no different from any other, user-created job. 
However, the job is automatically deleted after the proof has been generated.

 To QuickProof one or more pages/documents

1 Select the Jobs window.

2 Select a job, and then select the Pages or Results tab.

3 Select the pages or documents you want to QuickProof.

This may be in the Page Store, Run List or Results tab.

4 Drag the selected item(s) to the Output Device pane, and drop them on a 
proofing device.

The proofer icon is highlighted if it accepts the page, and the QuickProof 
dialog box is displayed.

5 Select the Image and Output parameter sets you want to use, and click the 
QuickProof button.
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The selected items are sent to the proofer. Apogee creates a new QuickProof 
job with the same order number as the source job and with normal priority. 
You will see the new job appear briefly in the Job List with a green activity 
icon. The selected proofer will also turn green, indicating that it is busy 
processing the job. 

When the proof has been completed, the job is automatically removed from 
the Job List. You can then collect your proof from the selected proofing 
device.

NOTE: You can only QuickProof PDF and raster documents. You cannot 
QuickProof PostScript documents, PDF layers (versioning), separations, or a 
mixture of different formats.
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The Hot Ticket Manager

The Hot Ticket Manager can be opened from any of the main windows in the 
Apogee Client by clicking Hot Tickets in the Apogee Taskbar. This is where you 
will monitor, view, and manage the Hot Tickets that you create.

The main window is divided into 3 panes:

 The Output Device List: On the left side of the window, you will see a list of 
currently configured output devices (e.g., Avantra25, Export, etc.).

 The Hot Ticket List: Next to the Output Device List, you will see the Hot 
Ticket List. This List displays the status of all Hot Tickets that have been 
submitted to the Apogee System. For more information, see “What Are Hot 
Tickets?” on page 45.

 Collecting Tickets List: See “Collecting Hot Tickets” on page 279.

Filters: Above the Hot Ticket List, you can enter filter criteria directly into the 
Quick Filter box. Below the Output Device List, you have custom job filters for 
filtering the Hot Ticket List based on a variety of criteria.

Selected Hot Ticket details: The large pane on the right side of the window 
displays information on the selected Hot Ticket. This information is arranged 
into three tabs:

 The Administration tab (see “Viewing the Hot Ticket Administration Tab” 
on page 263)

 The Options tab (see “Viewing the Hot Ticket Options Tab” on page 264)

 The Products tab (see “Viewing the Hot Ticket Products Tab” on 
page 265)

 The Plan tab (see “Viewing the Hot Ticket Plan Tab” on page 266).
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The Hot Ticket List

The Hot Ticket List displays all the Hot Tickets that have been submitted to the 
Apogee System. When you first create and submit a Hot Ticket, it will be 
displayed immediately in the Hot Ticket List.

A series of icons indicate the current status of each Hot Ticket in the list. These 
include Job Notification Icons, Job Status Icons, Hot Ticket Icons, and Flow 
Icons. Note, however, that a Hot Ticket cannot be finished, cannot be put on 
hold, and cannot be made into a rush ticket.

Hot Ticket List 
Layout

The Hot Ticket List is divided vertically into the following columns:

 Notification: May display an icon which indicates an error, warning, or 
remark.

 Status: May display one or more icons (up to 4) which indicate the current or 
recent job states. These icons are sorted from the left according to priority. 
You can expand the width of this column to view the lower priority icons.

 Hot Ticket column - Hot Ticket Icons: Displays an icon which indicates the 
type of Hot Ticket, as well as the Hot Ticket name.

 Flows: Displays one or more icons which correspond to the number and types 
of flows specified in the Ticket.

 Create Date: The dates and times when tickets were submitted. The date and 
time format adapts automatically to the width of the column.

 Modified Date: The dates and times when tickets were modified. The date 
and time format adapts automatically to the width of the column.

 Media: The media selected to print the job.

 Device: The device selected to print the job.

 Milestone: The due date you entered for the planning of the job.

 Company: The company name of the customer.
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These details are displayed for each Hot Ticket in their respective column. These 
columns can be sorted, rearranged, hidden or grouped just like the Job List. You 
can also filter hot tickets. Refer to the following sections: 

 “Organizing the Job List” on page 144

 “Filtering the Job List” on page 146.

If you want to see the jobs that have been created using these Hot Tickets, click 
Jobs in the Apogee Taskbar to switch to the Job Manager window.

Hot Ticket Icons Apogee displays the following icons in the Hot Ticket column.

Commercial Hot Ticket

Commercial Hot Ticket with a disabled input channel

Job that requires set-up by Printer (WebApproval jobs only)

Collecting Hot Tickets (tickets grouped in separate panel)
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Viewing the Hot Ticket Administration Tab

The Administration tab contains customer-specific information that can be used 
to associate specific Production Plans with particular customers or job types. 

The Hot Ticket name is displayed in the Hot Ticket List after the Ticket has been 
submitted.

The information displayed is read-only. If you want to change the information in 
any of the fields, you first need to context-click the Hot Ticket in the Hot Ticket 
List, and select Edit from the context menu. You can also select the Hot Ticket 
and click the Edit button.

For full details on each of the fields, see “Using the Administration Tab” on 
page 284.
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Viewing the Hot Ticket Options Tab

The Options tab displays information on how jobs are to be handled, including 
archiving and notification settings, post-processing channel settings, etc.

The information displayed is read-only. If you want to change the information in 
any of the fields, you first need to context-click the Hot Ticket in the Hot Ticket 
List, and select Edit from the context menu. You can also select the Hot Ticket 
and click the Edit button.

For full details on each of the fields, see “Using the Options Tab” on page 288.
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Viewing the Hot Ticket Products Tab

The Products tab for Hot Tickets allows you to set up fully automated imposition. 
Drop a document onto a Hot Ticket and create a job whose pages are imposed, 
while the product name, number of pages and page size can all be taken from the 
uploaded document. This is an interesting feature that enables ‘lights-out’ 
printing of digital products, but fully automated imposition can also be used for 
basic commercial offset jobs.

NOTE: A Hot Ticket can only have one product and the command to add products 
is disabled.

For more information on the Products tab, see “Using the Products Tab” on 
page 295.
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Viewing the Hot Ticket Plan Tab

The Plan tab displays the selected Hot Ticket’s Production Plan, and allows you 
to view the individual settings of each of the items in the Plan. 

The information displayed is read-only. If you want to change the information in 
any of the fields, you first need to context-click the ticket in the Hot Ticket List, 
and select Edit from the context menu. You can also select the ticket and click the 
Edit button.

The Plan tab has two panes:

 Production Plan Pane (Hot Tickets)

 Settings Pane (Hot Tickets)

Production Plan 
Pane (Hot Tickets)

The Production Plan is a series of components (Task Processors and Actions) 
linked together to form one or more processing flows. These components are 
configured to define exactly how jobs are to be input, processed, and output.

When you select one of these components, you will see the associated settings 
displayed in the lower Settings Pane (Hot Tickets).

Below the Task Processor icon, there is a drop-down list from in which you can 
view the selected Parameter Set. If no Parameter Set is selected, the Task 
Processor uses its factory settings.

The last Task Processor in a flow always displays the Flow ID icon at the end of 
the flow. By default, this always indicates a Main Output flow.

The information displayed is read-only. If you want to change the information in 
any of the fields, you first need to context-click the Hot Ticket in the Hot Ticket 
List, and select Edit from the context menu. You can also select the Hot Ticket 
and click the Edit button.

Settings Pane (Hot 
Tickets)

The Settings pane displays the settings that were configured for the component 
(Task Processor or Action) selected in the Production Plan pane.

The information displayed is read-only. If you want to change the information in 
any of the fields, you first need to context-click the Hot Ticket in the Hot Ticket 
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List, and select Edit from the context menu. You can also select the Hot Ticket 
and click the Edit button.
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Working with Hot Tickets

The main purpose of the Hot Ticket window is to allow you to view, and manage 
the Hot Tickets that are created by the Apogee System. Much of the information 
you need is displayed as icons in the Hot Tickets List. This information, together 
with the four tabs of selected Hot Ticket details, gives you a full and detailed 
snapshot of all existing Hot Tickets.

 “Selecting Hot Tickets” on page 268

 “Duplicating a Hot Ticket” on page 268

 “Deleting a Hot Ticket” on page 269

 “Creating a PPD for a Hot Ticket” on page 269

 “Checking Hot Ticket and Ticket Template Consistency” on page 270

Selecting Hot 
Tickets

Hot Tickets are listed in the Hot Ticket List in alphabetical order. 

 To select a Hot Ticket

1 Select the Hot Tickets Window.

2 Click a Hot Ticket in the Hot Ticket List.

The Hot Ticket details are retrieved from the Apogee System and displayed 
in the pane on the right. This information is arranged into 3 tabs - Adminis-
tration, Options, and Plan.

You can now edit the ticket as described in “Creating or Editing a Ticket” on 
page 340.

 To select multiple Hot Tickets

1 Select the Hot Tickets Window.

2 Select the Hot Tickets as described in “To select or de-select multiple jobs or 
items” on page 195.

Duplicating a Hot 
Ticket

You can create a copy of a Hot Ticket as follows. This command is also available 
on the Edit menu or by pressing CTRL+D.
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 To duplicate a Hot Ticket

1 Select the Hot Tickets Window.

2 Context-click the Hot Ticket that you want to duplicate in the Hot Ticket List.

3 Choose Duplicate Ticket.

A new Hot Ticket is created and the Administration tab is displayed.

4 Enter a new name and submit the Hot Ticket.

The duplicate Hot Ticket appears in the Hot Ticket List with the new name.

NOTE: If you do not change the name of the Hot Ticket, it appears greyed-out 
in the list for editing at a later stage.

Deleting a Hot 
Ticket

You can delete a Hot Ticket as follows.

 To delete a Hot Ticket

1 Select the Hot Tickets Window.

2 Select the Hot Ticket that you want to delete in the Hot Ticket List.

3 Choose Edit > Delete Hot Ticket, or press the Delete key.

You will see the message “The hot ticket <name> will be deleted. You 
cannot undo this”.

4 Click Delete.

The Hot Ticket is deleted from the Hot Ticket List.

NOTE: Only the Hot Ticket is deleted: Any jobs which have been created using 
this Hot Ticket remain on the system, and can still be viewed in the Job List when 
you switch to the Jobs window.

Creating a PPD for 
a Hot Ticket

You can create a PostScript Printer Description (PPD) file for a Hot Ticket, 
containing all job-related information specific for your output environment. A 
PPD created from a Hot Ticket allows you to select the parameter sets in the PPD.
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 To create a PPD for a Hot Ticket

1 Select the Hot Tickets Window.

2 Select the Hot Ticket for which you want to create a PPD file.

3 Choose File > Export Hot Ticket PPD. 

You can also directly context-click on the Hot Ticket and select Export Hot 
Ticket PPD.

The PPD User Options dialog box appears.

4 Specify the necessary Format and Content options as specified in “PPD User 
Options” on page 670.

5 Click OK to create the PPD file.

Checking Hot 
Ticket and Ticket 
Template 
Consistency

Hot Tickets and Ticket Templates store the names of the parameter sets they use, 
and the values in these sets. However, if you later modify the parameter set, the 
Hot Ticket/Ticket Template is not automatically updated: It still uses the 
original parameter set names and values. 

In many cases, you will need any such changes to be reflected in the Hot Ticket/
Ticket Template. To do this, you need to run a ‘Consistency Check’. This checks 
every Ticket Template (both Jobs and Hot Tickets templates) and Hot Tickets - 
in that order - for changed job resources. Any out-of-date references are listed in 
a Consistency report. 

You have the option to simply check if there are any discrepancies (without 
making any changes), or to both check and update your Hot Tickets/Ticket 
Templates.

NOTE: Consistency checking is only available to users with Administrator or 
higher access level, and does not affect existing jobs.

 To check the consistency of a Hot Ticket or Ticket Template

1 From any of the Apogee main menus, choose File > Check Consistency.

The Consistency Check dialog box is displayed. By default, both the Hot 
Tickets and Ticket Templates options are selected.

2 Select one or both check boxes, and then click either of the following buttons:
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 Verify Only: The selected items are checked and a consistency report is 
displayed in a browser window. The report lists any consistencies found 
in the selected items.

 Verify and Update: The selected items are checked and a consistency 
report is displayed in a browser window. The report lists any consistencies 
found in the selected items, and indicates that these items have been 
updated.

Fully Automated 
Imposition

A Hot Ticket can be set up so that the newly created job takes a number of 
product settings from the uploaded document and is imposed based on 
predefined imposition settings. Such a ticket uses the From Input options in the 
Products tab.

NOTE: This fully automated imposition can only be used for jobs consisting of one 
product. Only one document can be uploaded to the Hot Ticket.

 Create a From Input Hot Ticket

1 Create your Hot Ticket as explained in Creating and Editing Tickets on 
page 281.

2 In the Products tab, make sure the following are enabled:

 Product Type > Number of Pages: select the From Input check box.

 Default Part > Page Size: choose <From Input> in the top of the drop-
down list.

The Auto Impose button changes to Set Up Auto Impose.

3 Click the Set Up Auto Impose button and specify the settings in the Auto 
Impose window.

4 Click OK.

NOTE: You cannot prepare the actual imposition in this scenario. The 
imposition will be created on the fly when you create your job from the Hot 
Ticket.

5 The Auto Impose window closes and details of the imposition are displayed 
next to the Run Auto Impose check box.

These Auto Impose settings are saved to the Impose resource.
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6 Select the Run Auto Impose check box.

7 Save the Hot Ticket.

Jobs created with the Hot Ticket will take the number of pages and the page 
size of the uploaded document and use the saved Auto Impose settings for the 
imposition. The document file name (without extension) is used as the name 
of the product.
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Wide Format Hot Tickets

Wide Format Hot Tickets allow you to automate the creation of wide-format 
jobs. Files can be dropped in a hot folder or uploaded, and new wide-format jobs 
are created and submitted automatically.

For each product or document, the system creates an individual job that takes 
the file name as job name and the job name of the hot ticket as order number. 
Depending on whether the input is an image file or document, the processing is 
as follows:

 Input file is an image: a wide-format job is created for each image and this job 
consists of one sheet and one Print Layout.

 Input file is a document: each page is assigned to a sheet in the same wide-
format job; a layout hot ticket can only have one sheet, so additional sheets 
are replicated from this one sheet.

There are two options for the placement of the images on the sheet:

 Sheet without frames: the image is placed in the default image placement 
position, i.e. in one of the corners of the sheet, aligned with the lay of the 
printer.

 Sheet with frames: the image is used to fill all the frames on the sheet; each 
frame on this sheet can have a different size, fitting options, etc.

Wide Format Hot Tickets are managed in the Hot Tickets window.

 Create a Wide Format Hot Ticket

NOTE: This option requires a special license.

1 Go to the Hot Tickets window.

2 Choose File > New from Templates and then the Wide Format Hot Tickets 
tab.

3 Choose the template you want to use in the list, enter a name for the hot 
ticket and choose a Printer.

4 Click Open.

The Layout Editor opens and you can set up the sheet just like you would do 
for a regular wide-format job. Leave the sheet empty if you want images to be 
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placed in the default image placement position. Draw frames on the sheet if 
you want multiple instances of the same image on the sheet.

NOTE: Only create 1 sheet. Additional sheets will be discarded when you save 
the hot ticket.

5 Go to the Media Layout inspector, which is slightly different for hot tickets 
than for regular wide-format jobs. In the Layout Products panel, select the 
options as required:

 Automatically place images on sheets: select this option if you want your 
images to be placed automatically on sheets

 When no frames, place: Single image per sheet or Multiple images per 
sheet

 Optimize orientation: If you selected the first option to place images, you 
can choose to automatically rotate images so they fit in the frames.

6 Click the Submit Job button to save your hot ticket and choose the Print Files 
and Cut Files option you want to use for all the jobs created from the hot 
ticket.

7 Click Submit to save your changes.

 Create jobs from a Wide Format Hot Ticket

1 Go to the Hot Tickets window.

2 Context-click the hot ticket you want to use in the Hot Ticket list and choose 
Upload Document.

3 Browse to the images or documents you want to upload. Multiple images and 
documents can be uploaded.

4 Click Open.

The system creates one or more wide-format jobs in the background. Go to 
the Jobs window and you will see the new jobs appearing in the Job list. An 
individual job is created for each image and/or page in a document. For 
example, if you uploaded 20 images, the system creates 20 jobs.

5 Double-click a job to edit and fine-tune in the Layout Editor.

 Make a Wide Format Hot Ticket template

A Wide Format Hot Ticket is always created from a template. You can create 
your own templates from an existing Wide Format Hot Ticket.
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1 Go to the Hot Tickets window.

2 Select the hot ticket you want to save as a template in the Hot Ticket list.

3 Choose File > Save as Template.

4 Choose a template Category and click Save.

The template is added to the list of templates.

NOTE: To delete a template, go to the Templates resource. Read the section 
“Monitoring and Configuring Your System” on page 657.
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Hot Tickets for Packaging Jobs

Hot Tickets Manager allows you also to automate the creation of packaging jobs. 
Files can be dropped in a hot folder or uploaded, and packaging jobs are created 
and submitted automatically.

For each product, the system creates an individual job that takes the file name as 
job name and the job name of the hot ticket as order number.

Packaging jobs Hot Tickets are managed in the Hot Tickets window. To create 
the Layout, you need the Layout Editor, and use Auto-Layout, Sheet Layout 
Templates, possibly in combination with Auto-Fill.

Packaging jobs and their Hot Tickets also support editing their Production Plan, 
using the commands Edit Production Plan, or Edit Hot Ticket and then select 
the Plan tab. This opens the job or the Hot Ticket.

 Create a Hot Ticket for Packaging Jobs

NOTE: This option requires a special license.

1 Go to the Hot Tickets window.

2 Choose File > New from Templates and then the Hot Tickets tab.

3 Choose the packaging template you want to use in the list.

4 Enter the Hot Ticket name, and the values you require; Copies, Product Type, 
Parts Body page size and orientation, Paper Stock type, number of parts to 
create (per product), and click Open.

NOTE: Product Type should be Unbound (Packaging single-sided).
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5 In the Products tab opened, ensure that Imposition mode Edit Imposition 
with Layout Editor is selected. Click this button to open the Layout Editor.

6 In the Layout Editor, you can set up the layout just like you would do for a 
regular packaging job. Refer to “Layout Editor” on page 485 for detailed 
information. 

7 Click the Submit Job button to save your hot ticket.
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 Create jobs from a Hot Ticket for Packaging Jobs

1 Go to the Hot Tickets window.

2 Context-click the hot ticket you want to use in the Hot Ticket list and choose 
Upload Document.

3 Browse to the products you want to upload. Multiple products can be 
uploaded.

4 Click Open.

The system creates one or more packaging jobs in the background. Go to the 
Jobs window and you will see the new jobs appearing in the Job list. An 
individual job is created for each product. For example, if you uploaded 20 
products, the system creates 20 jobs.

5 Double-click a job to edit and fine-tune in the Layout Editor.

 Make a Hot Ticket template for Packaging Jobs

A Hot Ticket for packaging jobs is always created from a template. You can 
create your own templates from an existing Packaging Hot Ticket.

1 Go to the Hot Tickets window.

2 Select the hot ticket you want to save as a template in the Hot Ticket list.

3 Choose File > Save as Template.

4 Choose a template Category, enter the name, and click Save.

The template is added to the list of templates.

NOTE: To delete a template, go to the Templates resource. Read the section 
“Monitoring and Configuring Your System” on page 657.
Apogee Reference Guide



 

6 MANAGING HOT TICKETS 279
Collecting Hot Tickets

A Collecting Hot Ticket is a special kind of Hot Ticket which is used to collect and 
arrange images and create wide-format jobs. These Hot Tickets use the Collect 
task processor to organize multiple images and multiple pages in a multi-page 
file and output imposed sheets. Collecting Hot Tickets typically have a Hot 
Folder, Normalize and Collect task processors but may also include the 
Automate task processor for even more automation.

Collecting Hot Tickets are displayed in a separate panel in the Hot Tickets List.
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The Ticket Editor

The Ticket Editor is where you create and edit your Tickets. You can create four 
types of Tickets:

 Job Tickets: the definition of a job

 Hot Tickets: automatically creates and submits jobs

 Layout Tickets: job tickets for Sign & Display work

 Layout Hot Tickets: hot tickets for Sign & Display work

NOTE: The Layout Editor and not the Ticket Editor is opened when you 
choose to create Layout Tickets or Layout Hot Tickets. See “Layout Editor” on 
page 485.

The features of the Ticket Editor are organized in the following tabs. When you 
create a Job Ticket, you will see two extra tabs which allow you to specify a Run 
List and view intermediate processing results.

 The Administration tab: Uniquely identifies the job, and associates a specific 
Production Plan with a particular customer. See “Using the Administration 
Tab” on page 284.

 The Options tab: Defines how the jobs which use this ticket are to be handled 
(archiving, notifications, deletion options, etc.). See “Using the Options Tab” 
on page 288.

 The Products tab: For multi-part jobs and multi-product jobs, this tab allows 
you to specify how the job is structured, and how each individual section of 
the job will be processed. See “Using the Products Tab” on page 295.

 The Plan tab: Allows you to create, view, or modify a Production Plan. See 
“Using the Products Tab” on page 295.

 The Pages tab (Job Tickets only): Displays both the list of pages contained in 
the Page Store, and the pages that have been included in the Run List. See 
“Using the Pages Tab” on page 334.

 The Results tab (Job Tickets only): Allows you to monitor the current 
processing status of the selected job, displays thumbnails of the Run List 
pages, and separation information. See “Using the Results Tab” on page 337.
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Related topics: • Working with Job Tickets and Hot Tickets on page 339
• Shortcuts: Job Ticket Editor on page 1206
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Using the Administration Tab

The Administration tab contains customer-specific information that can be used 
to associate specific Production Plans with particular customers or job types. You 
can use job names or order numbers to group jobs in the Job List. 

For Hot Tickets, you use the Hot Ticket name to group the resulting jobs. For 
example, if you enter “poster6” as the Hot Ticket name, all jobs that are created 
using this Hot Ticket will be grouped in the Job List under the name “poster6”. 

Administration Tab 
Information

The Administration tab includes the following fields:

Order number

You must enter an order number to identify the job that will be generated by a 
Job Ticket. You can enter a number or a name as your Order Number. As soon as 
you submit the ticket, the job will appear in the Job List. Initially, the job consists 
of only the job parameters, and is represented as a folder. The Order Number is 
displayed next to the job folder icon. 

The text you enter in the Order Number field may later be used to automatically 
sort archived jobs into subfolders. For more information see “When Job is 
Finished” on page 291.

NOTE: An Order number is not required for Hot Tickets or Public Page Store jobs.

Job name, Hot Ticket name, or Public Page Store name

You must enter a name to identify the Job, Hot Ticket, or Public Page Store. 

 If you are creating a Hot Ticket, the Hot Ticket can be seen only in the Hot 
Ticket window. 

 If you are creating a Job (based on a Job Ticket), the Job name can be seen in 
the Job List after a document has been input. You can see this name when you 
expand the associated job folder (which is named according to the job Order 
number).

 If you are creating a Public Page Store Job, the Public Page Store will appear, 
together with any other Public Page Stores, below the Job List.

The text you enter in this field may later be used to automatically sort archived 
jobs into subfolders. For more information see “When Job is Finished” on 
page 291.
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Operator

The operator is the person responsible for processing the documents associated 
with this job. An operator name is automatically entered when you create a job 
or when jobs are automatically submitted by Hot Tickets. This name is the same 
as your NT logon user name. 

If you wish you can manually edit the operator name.

In the Message Board filter, you can filter on operator name in order to see all 
the messages for a specific operator (see “Message Board Filter” on page 87).

Description

Any information you may see displayed here is automatically extracted from an 
incoming JDF file.

Comments

Enter any special comments that apply to this job. This is a free text entry field 
that is not used by Apogee.

Print Center

This option is only visible if you have the relevant license to work with multiple 
Print Centers. These are printing companies or other service providers belonging 
to the same organization and that can use Apogee independently from each 
other. Choose a Print Center from the drop-down list to manage the Customers, 
Customer’s staff and Printer’s staff for that particular Print Center.

Customer

In this panel you can provide information about the customer and the collabora-
tors who will work on the job at hand (optional). You can select a known 
company from the Company drop-down list. A known company is a customer 
which has been defined with all its users and their contact details in the WebAp-
proval (ProductionCenter) or PrintSphere applications. Your own company and 
staff are also set up in these applications. See the online help of these applica-
tions for more information. If you do not select a known company and the 
Company field is blank, you can fill in the contact details (name, email and 
phone no.) of the customer for this job. 

Printer’s Staff and Customer’s Staff

After selecting a known company, you are presented a list of Customer’s Staff 
and Printer’s Staff that you can designate to collaborate on this job. If you did not 
select a company, you only see your own staff. Each collaborator in the 
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Customer’s Staff and Printer’s Staff lists can have one or more roles which are 
activated by clicking the icons in the Roles column. The roles are Approver, 
Uploader, and Viewer. Select the Uploader can place files check box if you want 
to allow Uploaders to place files in the run list of a WebApproval job. You can 
change the role of the default collaborators by clicking these icons.

In addition, collaborators in the Printer’s Staff list can be a candidate Customer 
Service Representative (CSR) or a preferred CSR. Clicking the candidate CSR icon 
changes the role of the collaborator to preferred CSR and vice versa. More than 
one preferred CSR can be assigned to a job.

Add Guest

Use this button to add guests to collaborate on this job. Enter the person’s e-mail 
and select the User Roles: Uploader check-box if you want this person to upload 
files for the job. Click the Add Guest button to create the guest who is subse-
quently added to the list of Customer’s Staff.

NOTE: Once the job is submitted you can no longer edit the Customer’s Staff and 
Printer’s Staff lists.

When you select a company from the Company drop-down list, Apogee looks up 
the name in the Accounts resource and the PrintSphere application to see if the 
account is active or inactive. This status is indicated at the bottom of the 
Customer Contact dialog box.

Approver: This user can approve jobs in the WebApproval application.

Uploader: This user can upload files for this job in the WebApproval application.

Viewer

Candidate CSR (Customer Service Representative)

Preferred CSR (Customer Service Representative)

WebApproval account is inactive: the account exists but is not enabled.

WebApproval account is active: the account exists and is enabled.

PrintSphere account is inactive: the account exists but is not enabled.

PrintSphere account is active: the account exists and is enabled.
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Publish to ProductionCenter (WebFlow service)

A drop-down list next to the Company list lets you control whether a job is 
published to the ProductionCenter web portal or not. You have one or more of 
the following options, depending on whether you have licenses for the WebFlow 
service and/or the WebApproval service:

 Publish: (default) The job will also appear in the list of jobs in Production-
Center, and Printer Company as well as Print Buyer users are able to 
upload files and approve pages depending on their role.

 Publish Internally: The job will appear in the list of jobs in Production-
Center but only for Printer Company users.

 Don’t Publish: The job is not published to ProductionCenter (e.g. confi-
dential jobs) even if you have the required license to do so.

 Publish for Upload: The job will appear in the list of jobs in Production-
Center but only for uploading purposes.

 Publish for Approval: The job will appear in the list of jobs in Production-
Center but only for approval purposes.

The text in the Customer Contact fields may later be used to automatically sort 
archived jobs into subfolders. For more information see “When Job is Finished” 
on page 291.

You can print some or all of the Administration tab information on film or plate. 
This process is handled using marks and variables when setting up the imposi-
tion. The variables are prepended with $ characters. These variables correspond 
to the various fields in the Administration tab and are used to print the job infor-
mation on your film or plate. For information on the Apogee variables, refer to 
System Variables. For more information on imposition, see “Working with 
Apogee Impose” on page 369 or refer to the user guide supplied with your third-
party imposition software.

Related topics: • Accounts on page 699
• What is a WebApproval Job? on page 57
• What is WebFlow? on page 59
• What is a PrintSphere Job? on page 59
• System Variables on page 1183
• Working with Apogee Impose on page 369
Apogee Reference Guide



288 USING THE OPTIONS TAB
Using the Options Tab

The Options tab displays information on how the jobs which use this ticket are 
to be handled (archiving, notifications, etc.). This tab offers options that affect 
the job as a whole, and which are not related to a specific Task Processor. You 
need to set Job Options for Job Tickets, Hot Tickets, and Public Page Store jobs, 
although not all options are used in Hot Tickets and Public Page Store jobs.

The Options tab includes the following sections:

 Job Priority

 Job Update Policy

 Milestones (Jobs only)

 Job States

 When Job is Finished (Jobs and Hot Tickets only)

 Input Channels (Jobs only)

 Notifications

 Validation

Job Priority

 High

 Normal

 Low

NOTE: Job priority can also be changed for one or multiple jobs in the Job List.

Job Update Policy

This section provides a method to control the application of job updates that are 
sent from an MIS system (when the MIS resubmits a JDF job).
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You can overrule the system-wide job update policy on a per-job basis at job 
level: There is no different policy per part, production set or operation.

For more information on JDF job updating, refer to “JDF Updating” on page 707.

Follow System Policy

Uses the update policy specified at the MIS site. This allows the MIS to apply JDF 
job updates without asking, and without informing the operator that there was 
an update.

Apply and Inform

Applies all JDF job updates without asking, but posts a notification after 
applying the updates.

Notify 

Posts a notification when a JDF job update needs to be applied. The operator can 
decide whether to accept or deny the update.

This policy should only be used when the MIS supports asynchronous JMF 
commands. Otherwise, the MIS will fail the update when the operator does not 
immediately answer the notification. 

Apogee returns an error to the MIS upon receiving a synchronous command, and 
posts a notification. The notification states that the update was rejected because 
of a misconfiguration, and suggests you either change the MIS protocol settings 
or use a different update policy. The same message is included in the error reply 
sent to the MIS.

Deny and Inform

Denies the JDF job update without asking, and without informing the operator 
that the update was denied.

Milestones

You can configure the system to distribute messages to the Message Board (and 
optionally to a defined e-mail address) when specific milestones have been 
reached in the job assembly and generation process. 
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NOTE: The Milestones section is not available in Hot Tickets and Public Page 
Store jobs.

You can set two such generic milestones for all jobs that are created using this 
ticket:

 Run list complete by

 Job finished by

Run list complete by

NOTE: Windows users can 
click the associated Browse 
button to display the Choose 
Date/Time dialog box, and 
select month, day and time. 

Select this check box if you want to set a date and time by which time all the 
documents required for the job have been successfully delivered to the Apogee 
System. 

If you choose this milestone, the associated Notify check box is enabled. You 
should select this check box if you want a reminder to be generated, indicating 
that the final date for document input is approaching. You then need to specify 
the notification period. This can be set to any period of days or hours before the 
final input date. When the notification date is reached, a notification is automat-
ically sent to the Message Board (and optionally to a defined e-mail address).

Job finished by

NOTE: Windows users can 
click the associated Browse 
button to display the Choose 
Date/Time dialog box, and 
select month, day and time. 

Select this check box if you want to set a date and time by which time the job 
must be successfully completed.

When the current date exceeds the due date minus the notification period, 
Apogee flags the job with an appropriate job status icon in the Job List (see “Job 
Status Icons” on page 151).

NOTE: You can also configure the system to send around an e-mail notification 
when a job has been successfully finished, as described in When Job is Finished, 
below.

If you choose this milestone, the associated Notify check box is enabled. You 
should select this check box if you want a reminder to be generated, indicating 
that the job completion date is approaching. You then need to specify the notifi-
cation period. This can be set to any period of days or hours before the job 
completion date. When the notification date is reached, a notification is 
automatically sent to the Message Board (and optionally to a defined e-mail 
address).
Apogee Reference Guide



 

7 CREATING AND EDITING TICKETS 291
Job States

Disable input channels
when

Choose when you want to disable the input channels:

 when Run List is complete

 when Job is finished

Mark job as finished Choose when you want to mark the job as finished:

 when All flows finish (e.g. main and proofing flows)

 when Main Output flow finish (e.g. job is marked finished while the 
proofing flow has not yet finished)

When Job is Finished

To optimize disk space and to keep the Job List easily manageable, it is a good 
idea to archive and delete jobs that have been successfully created. You can set 
the following generic post-completion options for all jobs that are created using 
this ticket:

 Notify

 Mark for archive

 Delete

NOTE: The When Job is Finished section is not available in Public Page Store jobs.

Notify

Select this check box if you want a notification to be sent to the Message Board 
as soon as the job has been finished. Optionally, an e-mail message can also be 
generated, and sent to the operator responsible, or to the address you specify in 
the Notifications section, below.

Mark for archive

Archiving exports the specified intermediate job results from Apogee to the 
specified output destination (to tape or other archiving media).
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Select this check box if you want to automatically archive all jobs that have been 
successfully completed when the archiving process runs. Archive makes an 
external copy of the job. 

For information on specifying an archive location, see “Job Housekeeping 
Settings” on page 677. This location must be a shared disk accessible by both 
Apogee Client and Server.

Archive Location Displays the location (path name) where the archive has been saved. You can 
click the small button at the end of the path name to open the archive location in 
Explorer.

Delete

Select this check box if you want to delete all jobs that have been successfully 
completed. 

Mark for deletion after Select this option if you want to automatically mark for deletion all jobs that 
have been successfully completed. You need to specify how long the job should 
be kept before it is marked for deletion. This can be set at anything up to 99 days 
or hours after the job completion date. 

Immediately Select this option to immediately delete all successfully completed jobs.

For information on how jobs are deleted, see “Job Housekeeping Settings” on 
page 677. 

Input Channels

You can configure a ticket with one or more input channels, such as Hot Folders 
or AppleTalk channels. These channels normally remain active all the time. 
However, you may want to deactivate an input channel to prevent further 
additions to a completed Run List, or to a finished job.

If you want to do this, select the ‘Deactivate input when:’ check box, then click 
open the associated list box and select one of the available options:

Deactivate input when Job is finished

All the ticket’s input channels are disabled as soon as the job has been success-
fully completed.
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Deactivate input when Run list is complete

All the Job Ticket’s input channels are disabled as soon as the Run List is 
complete. This option is not available for Hot Tickets. For more information on 
Run Lists, see “Working with Jobs in the Pages Tab” on page 214.

Once the input channel has been deactivated, you can reactivate it by selecting 
the job in the Job List pane, and clicking the Enable/Disable tool.

NOTE: The Input Channels section is not available in Hot Tickets and Public Page 
Store jobs.

Notifications

This section allows you to send all notifications as e-mails to a specified e-mail 
address (this is in addition to the normal use of messages in the Message Board 
- see “Message Board” on page 83). The text of the e-mail is a text-only version 
of the message. You can enter an e-mail address. No validation is performed.

Validation

Click the Edit Job Validation Rules button to open a dialog where you can set 
the severity level of a selected number of validation rules that do not have a fixed 
severity level. Most of these validation rules use variables and an explanation of 
each rule is given under the list of rules. Validation rules generate messages in 
the Problem Report.

 Select the rule in the list and then click the Severity drop-down list to choose 
one of the severity levels: 

 Ignore: The rule will be ignored.

 Inform: An information message will be generated.

 Warn: A warning message will be generated.

 Fail: An error message will be generated.

 Default: Sets the default severity.
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NOTE: When you change the severity level, the system re-runs the validation.

Related topics: • Problem Report on page 166
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Using the Products Tab

In the Products tab you will edit the Products, Parts and Production Sets of a job 
and impose your jobs using the Imposition Editor or the Layout Editor. 

The Products tab is visible but disabled if the job does not include an Impose 
Task Processor. It comprises the following sections:

 Products and Parts List

 Product Inspector

 Part Inspector

 Imposition

 Production Sets

Products and Parts List

This panel lists the products and parts of the job with the most important attri-
butes of each product and part in a table. Context-click the table header to select 
more or fewer attributes. The products are listed in the order they are created. 
The table shows the parts sorted by their first page (first page on top). You can 
click a product or part to view and edit all attributes in the inspector on the right.

With a product or part highlighted in the list, you can navigate to a product or 
part in the list using the up and down arrows or by typing the first letter of the 
name. For example, press “B” to select the next Body part in the list and view its 
settings in the inspector.

While working in the product or part inspector, you can jump to the next/
previous product or part in the list by pressing CTRL+ arrow up/down.

The Parts section header displays a warning if there is a mismatch between the 
Run List and the page ranges in the parts (in addition to the usual problem report 
messages).

Product/Part type icon The following color-coded icons are used in the product and parts list:
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Product/Part name: The name of the product or part. For multi-product jobs, the name of the first 
product is by default the same as the Job name. You can change the name here 
and this is reflected immediately in the Pages tab. If you created multiple 
products using the Quick Fill dialog, the product names are the same as the Job 
name with incrementing suffixes.

Run List Indexes The Run List positions and the total page count per part.

Run List Pages Same as Run List Indexes if ‘Number pages independently’ is not selected for the 
Part; if the product has a cover, one or more of the following 9 panel designators 
are used:

 OFC: outside front cover

 OFF: outside front flap

 IFF: inside front flap

 IFC: inside front cover

 IBC: inside back cover

Bound product

Cover part

Plain part

Insert part

Unbound, flat, single-sided product

Unbound, flat, double-sided product

Unbound, folded, single-sided product

Unbound, folded, double-sided product

Unbound product with different part types

Calendar product

Sign and Display product
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 IBF: inside back flap

 OBF: outside back flap

 OBC: outside back cover

 SPN: outside spine

Page Size The expected page size (width and height). An icon indicates the orientation.

Copy Count (Unbound) The required number of copies for each element placed on a sheet.

Colors The expected process and/or spot colors.

Stock The stock used for the part.

Binding options The name of the selected resource for binding.

Comments Icons representing the presence of comments and a comment URL. Tool-tips on 
these icons show the comments and the URL, respectively. Click the URL icon to 
open a browser window on the referenced page.

 Add products to a job

1 Click the Add button (+) in the top right corner of the products and parts list, 
and choose Add Product.

The Add Product dialog is displayed which displays the same information as 
the QuickFill dialog.

2 Enter the details for your new product as described in the Product Inspector.

3 Click Add.

Adding a new product to a job will create an imposition error, and you must 
edit the imposition.
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 Add parts to a product

1 Highlight the product you want to add a part to in the products and parts list 
and click the Add button (+) in the top right corner of the products and parts 
list, and choose Add Part.

A new part is added under the product in the list.

2 Edit the settings for the new part in the Part Inspector.

 Duplicate a product

1 Highlight one or more products that you want to copy in the products and 
parts list and click the Duplicate button (++) in the top right corner of the 
products and parts list.

2 Enter the number of copies you want to make of your selection and click OK.

The products with their respective parts are added to the list.

 Delete a product or part

1 Highlight one or more products or parts that you want to delete in the 
products and parts list and click the Delete button (x) in the top right corner 
of the products and parts list.

2 Click Yes in the confirmation dialog.

 Navigating Multiple Products in the Products Tab

The following shortcuts apply if you have more than one product in the products 
list (multi-product jobs).

Related topics: • Working with Apogee Impose on page 369

To... Press (Windows)

Go to the next item in the list CTRL + Down arrow

Go to the previous item in the list CTRL + Up arrow

Go to the next item of the same level in the list CTRL + SHIFT + Down 
arrow

Go to the previous item of the same level in the list CTRL + SHIFT + Up 
arrow

Go to the next cover part c or C

Go to the next plain or insert part b or B
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Product Inspector

Select a product in the product and parts list on the left to display its properties 
in this inspector. The Product inspector displays the same settings found in the 
Products system resource.

The settings you choose for the Product are inherited by the various Parts of the 
Product.

Product

Product Order The order number of the job is used as the default order number for the product. 
Here you can enter a dedicated order number for the product. If you leave this 
field empty, it automatically reverts to the job order number.

Product Name The name of the selected Product is the same as the job name if the job only 
consists of one product. If you created multiple products when completing the 
Quick Fill dialog, each product is indicated with the job name and a sequential 
suffix. You can change the product name to a value of your choice.

Copy Count The number of copies for each product.

Product Type

Product Type List: Lists all the product presets available in the Products resource for you to choose 
from. Click Manage Products at the end of the list to open the Products resource.

No. of Pages The number of pages determines the page range that you can use in the defini-
tion of the parts. This is the same as in the Run List: You can change this value in 
both places. Click the Edit button to change the starting position in the Run List. 
For Hot Tickets, you can select the From Input check box to set the number of 
pages equal to that of the document. Choosing From Input changes the Auto 
Impose button to Set Up Auto Impose, and you can only specify the basic 
settings but not the actual imposition.

Product Type The type on which the selected Product preset is based. The settings you see in 
the inspector depend on the different types:

Bound:  for products that require assembly and binding; have one or more Parts

Unbound: for products which are a mixture of flat, folded or step and repeat work

Calendar: for flip and spread products

Sign and Display: for Sign and Display products.
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Bound Products

Binding Options Choose one of the binding options from the drop-down list. The gray arrow 
button is a short-cut to the Binding Options resource where you can modify the 
binding options specifically for the current job.

Edge The edge for binding: Left, Right, Top or Bottom

Glue Zones Choose one of the Glue Zones resources for creating ink-free zones where glue 
can be applied.

Advanced book signature
numbering

Select this option to use the advanced numbering feature that allows you to 
control the numbering of book signatures in the Fold Sheet inspector. See “To 
inspect the Fold Sheet” on page 441.

Default Part

Stock and weight Choose a paper stock from the drop-down list. These options are created in the 
Paper Stock resource of the Press.

Page Size The page size of the finished product. For Hot Tickets, you can choose <From 
Input> at the top of the list. This allows you to set up fully automated imposition 
for jobs created from a Hot Ticket. Choosing <From Input> changes the Auto 
Impose button to Set Up Auto Impose, and you can only specify the basic 
settings but not the actual imposition.

Default Production

Bleed Sets the bleed on all sides to the same value. This can be changed later for 
individual Parts, pages and press sheet sides.

Shingling Choose whether you want to apply shingling or not.

None:  No shingling is applied

Manual: Set the values for shifting or scaling manually

From a resource: Choose one of the Shingling Rules which has been set up in the 
resources

Manage Shingling Rules: A short-cut to the Shingling Rules resource where you 
can edit a rule or create new ones

Bottling Choose how you want to apply compensation for page skew by selecting one of 
the Bottling Rules. Three modes are possible broadly speaking:

Automatic: page skew compensation is based on page creep
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Manual: uses pre-established values in a Bottling Table to compensate page skew 
and only when a table is provided in the Web Production Scheme

Semi-automatic: uses a Bottling Table and also takes stock thickness and page 
size into account

Mulltiplier: enter a value greater than the default (1) to apply a multiplier to pre-
established bottling values (e.g. for a newer version of a product)

Unbound Products

Selecting Unbound as Product Type switches off the binding options. The parts 
become elements which can be placed on the same sheet.

NOTE: The Part Type and Pagination are not inherited by existing parts, only by 
new parts you add to the product.

Default Part List of compatible parts. Choose a part type to set as default when adding parts 
(elements) to the product.

Edit Imposition in Layout
Editor

This option is only enabled for Unbound Flat - Singled-Sided. Selecting this 
check box allows you to impose elements in the Layout Editor workspace. 

Copy Count The number of copies for each element.

Margins Adds extra space around each element, similar to the trim margins in the binding 
style of bound products. The extra space may be required for post-press activi-
ties. Select a Margin resource from the drop-down or click the gray arrow icon to 
set a custom margin. If you selected the Edit Imposition in Layout Editor check 
box, the list contains Finishing Margins.

Calendar Products

Selecting Calendar as Product Type displays special Calendar Style options.

Calendar Style Flip-over:  The leaves are flipped over, usually with the spine on top and the back 
left blank

Spread: The leaves are not flipped over but turned upward so the bottom leaf is 
an extension of the back of the top leaf.

NOTE: When working with multiple products, you can select similar products 
and change the settings for all these products simultaneously.
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Part Inspector

You can edit the settings of a Part, which are inherited from the Product, by 
selecting the part in the list so its settings are displayed in the inspector on the 
right. You can revert to some settings of the Product by clicking the gray revert 
button on the right.

Part Type

Part Type The type of a part sets the number of pages, the page range and the independent 
page numbering attributes. There are three standard types for bound products:

Cover: A cover part contains the first two pages and the last two pages of a publi-
cation, regardless of how many pages the publication contains. There can only 
be one cover part in a job: you cannot select this type if another one exists. When 
this option is selected, the Number of pages and Run List Positions options are 
read-only.

Insert: An insert part has its pages numbered independently from the main 
content. The Number pages independently option is automatically selected and 
read-only. An insert is part of the product, but has no direct relation with its 
content. Inserts can be externally produced, in which case you only need to 
know about them if they affect the imposition (e.g., shingling). Otherwise, the 
insert needs to be produced by the job, and needs to be an integral part of the job.

Plain: A plain part is freely editable; there are no consequences when selecting a 
plain part.

Part Type (for Unbound) An unbound product can have the following part types:

Flat - single-sided:  An unfolded leaf printed on one side; sets the page range to a 
single page

Flat - double-sided: An unfolded leaf printed on both sides; sets the page range to 
two consecutive pages

Folded - single-sided:  A leaf consisting of several panels printed on one side; the 
number of panels is set by the pagination scheme and the page range corre-
sponds with the number panels

Folded - double-sided: A leaf consisting of several panels printed on both sides; 
the number of panels is set by the pagination scheme and the page range is twice 
the number of panels
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Pagination (for Unbound
Folded)

This drop-down list with pagination schemes is only available for unbound 
folded part types. Choose an existing scheme from the drop-down list. The list is 
filtered and only displays the relevant schemes for single or double-sided parts.

The pagination scheme provides a grid for arranging the pages of the part as 
panels and may also apply values to modify their size. For example, a panel may 
need to be reduced in size for folding as a leaflet. You can go to the pagination 
editor by clicking the gray arrow icon and set the precise dimensions for each 
panel and customize the grid. See “Pagination Schemes Overview” on 
page 1112 for more information.

Part Name A short name that identifies the part.

Part Color This is a visual identifier of the part in the Products tab and main imposition 
windows. The initial color depends on the type of part. You will see a number of 
alternative colors when you create multiple parts of the same type. You can click 
on the initial color to select a different color. 

Cover Type You can set the following options for the Cover part type:

Double sided: select the check box for a double-sided cover.

Page Spreads: When you choose this option, the entire outside cover has run list 
index 1 and the inner cover has run list index 2.

Panels as separate pages: When you select this option, you can control how the 
cover is organized and divided into maximum 9 panels to accommodate a spine 
and flaps. You can set the following options:

 Spine: Select this option to activate the drop-down list and choose the 
content for the outside spine of the cover:

 PDF Page: a separate PDF must be provided for the spine and a place-
holder is added at the last position of the run list

 Blank: the spine is blank and no placeholder is provided

 Bleed from adjacent Pages: the right and left half of the spine are filled 
with bleed from the adjacent pages and no placeholder is added to the run 
list

 Bleed from Front page: The spine is filled with the bleed from the front 
page

You can specify the width of the spine or select the Automatic check box so 
Apogee Impose can calculate the width based on the thickness of the paper.
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 Front and Back flaps: Select the check box and specify the width, including 
extra width for folds

Copy Count (Unbound) The number of copies of the part.

Run List Indexes This field specifies where the pages of the part should be placed. You can specify 
single pages, a set of contiguous pages or a mix. For example, 1-3, 5 is pages 1,2, 
3 and 5. This field is read-only for the default Parts, i.e. the first Cover, Body 
parts created.

The maximum number of pages for a Cover is 9: the first four pages for the front 
cover panels; the last 5 pages for the back cover panels and spine (very last page 
in the run list).

NOTE: Apogee ignores spaces in the range specification.

Keep pages on separate
signatures

By default, pages of different parts can be combined on the same signature; this 
option allows you to switch this behavior off.

Keep book signatures on
separate press sheets

By default, the book signatures of different parts can be combined on the same 
press sheet; this option allows you to switch this behavior off.

Number pages
independently

Select this check box to number the Run List positions independently of the 
remainder of the Run List. The first Run List slot for the part is assigned number 
1, and so on. The remainder of the Run List is numbered as if the part did not 
exist.

The following rules apply for independent parts:

 The page numbering of an independent part starts at 1, regardless of the 
position of that part in the Run List. 
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 The page numbering of an independent part is contiguous.

 Independent part numbering does not affect the numbering of other parts 
(independent or otherwise).

 Independent part numbering affects the $RLPAGE variable and is taken into 
account when using automatic file placement. 

The Parts table displays the page range of an independent part in brackets (e.g., 
[3, 4, 7, 8]). The Run List tab indents pages from independent parts, so they are 
easier to identify.

Stock and Size

Page Size The expected trim size of all pages in the part. You can choose from a list of 
standard sizes. The size you select sets the Width and Height values. The Page 
Size automatically switches to Custom when you edit the Width or Height.

Width, Height The page dimensions in your selected units. The dimensions are set by the 
selected Page Size, but can be edited.

Orientation Reflects the orientation of the page dimensions.

Production

Binding options Choose one of the binding options from the drop-down list. The grey arrow 
button is a short-cut to the Binding Options resource where you can modify the 
binding options specifically for the current job.

Margins (Unbound) Adds extra space around each element, similar to the trim margins in the binding 
style of bound products. The extra space may be required for post-press activi-
ties. Select a Margin resource from the drop-down or click the grey arrow button 
to set a custom margin.

Bleed Sets the bleed on all sides to the same value. This can be changed later for 
individual Parts, pages and sides.

Shingling/Bottling Choose whether you want to apply the shingling/bottling set for the product to 
this part, or not; not available for Unbound products.

Colors

Colors The selected color space resource (process colors).

Spot Colors You can specify one or more spot color placeholders or actual spot color names 
that you want to include in the selected part. The list displays all colors from all 
parts. You should select only the colors required for the part, and leave the 
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others unchecked. You can add a spot color when needed, remove one when no 
longer needed, or change its name.

The specified colors are added as “manually added colors” to the Keep colors in 
the separation settings. Placeholder spot color names are later mapped to the 
actual document colors. 

The check box in the Match column specifies whether the color is an actual color 
name (i.e., whether the document's color must match the given one) or a generic 
placeholder. 

Comments This is a free form text box for comments. If set by JDF, the field is read-only.

For more information on using these options, refer to “About Parts and Page 
Ranges” on page 309.

Adapting a Part’s 
Page Size

If you have uploaded and assigned a document to a Part which has a different 
page trim size, an icon is displayed in the Run List and Products tab to indicate 
that a different size was expected.

You can choose to adapt the page size of the Part to match the document size.

 To adapt a Part’s page size to match a document

1 Upload a document and assign at least one page to the Part.

If the size does not match, the following icon is displayed in the Run List:

At this stage you can still delete the assigned page.

2 In the Products tab, select the Part you want to adapt. It’s indicated by the 
same icon.

3 Choose Edit > Adapt Part’s Page Size and the Page Size of the Part is 
modified.
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WARNING: This command cannot be undone.

Changing the Part’s Page Size may generate an imposition warning, for 
example if the Part no longer fits on the Press Sheet.

Imposition

The Imposition pane provides access to the main Apogee Impose windows and 
settings.

Imposition Mode Selector

This drop-down list is only enabled for unbound, flat, single-sided jobs in which 
case you can choose either the Imposition Editor or the Layout Editor to prepare 
the press sheet.

 Mode selector enabled with Imposition Editor selected:

 Mode selector enabled with Layout Editor selected:

 Mode selector disabled:

Auto Impose button

Opens the Auto Impose window where you define the settings for automatic 
imposition.

Set Up Auto Impose (Hot Tickets)

For Hot Tickets, the Set Up Auto Impose button is enabled if the number of 
pages or the page size of the product are to be taken from the input. Click this 
button to select the Auto Impose settings for the from input ticket. Then click OK 
to store the Auto Impose settings and close Auto Impose without actually 
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creating the imposition. Once the Auto Impose settings have been defined for a 
from input ticket, and the imposition prepared in the case of a fixed imposition 
ticket, the Run Auto Impose check box is enabled and displays a summary of the 
Auto Impose settings. Select this check box to ensure that the jobs created from 
the Hot Ticket are imposed. At this stage you can still go back to the settings by 
clicking the Set Up Auto Impose button.

Edit Imposition button

Opens the Product View where you can create the imposition interactively – also 
referred to as manual imposition. You will create the Assembly, choose the 
Folding Schemes, etc.

Edit Imposition with Layout Editor button

Only for Unbound Flat Single-Sided jobs for which this option has been selected 
in the Product Editor. Opens the Layout Editor where elements can be arranged. 
The button is only enabled if the imposition is set to Undefined.

Press Sheet Layout

A drop-down list with all the available press sheet layouts. Initially, the default 
sheet layout as specified for the chosen press is selected (from press). You can 
choose a different layout and revert to the default by clicking the revert icon. 
Clicking the arrow icon takes you to the Press Sheet Layout editor where you can 
modify the binding options specifically for the current job. 

Impose TP

Clicking the arrow icon takes you to the Impose parameter set view in the Plan 
tab, if it is present in the plan. Otherwise, it only takes you as far as the Plan tab. 

Production Sets

The Production Sets table in the Products tab shows the most important attri-
butes of each production set. The parts are sorted by their first sheet (first sheet 
on top). You can double-click a production set to see and edit all attributes.

Production Sets Table

Production Set The name of the production set, sheet or side, based on the name of the associ-
ated parts. In a multi-product job, the various part names per set are juxtaposed 
with a plus sign to create the name. Apogee uses the same sheet and side names 
as in the Results tab. The name is preceded by an icon representing the produc-
tion set, a sheet or a side. Production sets and sheets can be expanded and 
collapsed.
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Sheet Indexes The sheet indexes of the production set (read only).

Sheets/Sides The sheet sides of the production set (read only).

Parts The name(s) of the originating part(s) that are represented by the sides in the set 
(read only).

Press The name of the press that is selected in the Production Plan (read only).

Output Device The name of the output device that is selected in the Production Plan (read 
only).

Update Imposition

This button is active if you made changes in the Production Plan. You can subse-
quently update the imposition to reflect these changes.

Update Production Sets

You can use this button to restore the production sets in accordance with new or 
deleted parts and the imposition.

About Parts and 
Page Ranges

When you create your Product, or when you modify a JDF job, you can manually 
edit and create/merge parts. A number of scenarios are possible whereby the 
default Body part plays a special role:

 create a new part: add the pages to the page range and Apogee removes the 
added pages from the default part.

 assign pages to a different part: edit the part you want the pages to be part of, 
and add those pages to the page range. Apogee removes the added pages 
from the default part.

 remove a part: select the part and click the Delete button. The pages of the 
part return to the default part.

Keeping count of pages

While defining parts and Run List positions, you may find that the number of 
pages does not match the sum of the parts (if the parts overlap). In this case, 
Apogee displays a warning, and you cannot submit the job; you must first fix the 
ranges.

In a simple job, the default part hides the complexity of parts: Changing the 
number of Run List pages simply adds or removes pages at the end of the default 
part. In a multi-part job, the default part acts as the body part.
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In a `simple' multi-part job, you can have one cover part and the default body 
part. Such a setup makes it easy to change the total number of pages without 
having to edit the parts: when you increase the number of pages, the default 
parts grows and the cover widens; when you decrease the number of pages, the 
default part shrinks and the cover narrows.

When you have a product with additional parts, other than a cover, the default 
part contains the `left-overs' from the other parts: you specify the pages in the 
other parts, and the default parts contains the remaining pages. It is valid to have 
zero pages in a part, whether it is the default part or any other.

Keeping track of page ranges 

Apogee does not attempt to keep the page ranges valid across the different parts 
while you are busy editing the Run List, parts and page ranges. Instead, it relies 
on a few basic rules, and checks the ranges when you change them.

 Apogee never adjusts the ranges of custom parts automatically, except those 
of the Cover part (if present).

 The Cover part is automatically adjusted to the Run List: Its first two pages 
are set to the numbers of the first two Run List positions, and its last two 
pages are set to the numbers of the last two Run List positions.

 When you enlarge the Run List, the added pages go in the default part.

 When you shrink the Run List, the `removed' pages are removed from the 
default part, insofar they are present. They are never taken from custom 
parts.

 When you create a new part, the default range is set to the range of the 
default part.

 When you make a part range smaller, the `removed pages' move back to the 
default part.

 When you make a part range larger, the `added pages' are taken from the 
default part insofar they are present.

Range Validation

Apogee does not attempt to maintain the ranges across different parts; instead, 
it checks whether the entire range, covered by all parts, matches the entire Run 
List, with no overlaps. If not, it posts a warning message in the Problem Report 
and displays it in the placard above the parts table. Parts with conflicting page 
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ranges display the range in red text. You must fix page range conflicts manually 
before you can submit the job.

Managing 
Production Sets

 To manually create a new production set

1 In the Production Sets pane, click the New button.

2 Enter a name for the production set.

3 Enter the range of sheets and sides that this production range covers. 

You can specify ranges in the same way as you do for the Discard Action (see 
“Discard Settings” on page 315).

4 Click OK.

Apogee creates a new production set, containing the selected sheets (or 
sides). 

Creating a new production set affects those operations in the production plan 
that have different processing per production set. The following rules are 
used to assign a parameter set to the new production set:

 If all items in the new production set originate from a single production 
set:

The operational parameters for the newly created production set are a 
copy of the originating one. As a result, when nothing else is changed, the 
job will generate exactly the same output as before.

 If the items in the new production set originate from different production 
sets: 

The newly created production set takes the parameter set that is associ-
ated with single processing. As a result, when nothing else is changed, the 
job might generate different output than before. 

 To delete production sets

Apogee does not delete empty production sets automatically. You have to 
delete them manually.
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Using the Plan Tab

The Plan tab allows you to create, view, or modify a Production Plan. This tab 
has three panes:

 Production Plan Components Pane

 Production Plan Pane (Ticket Editor)

 Settings Pane (Ticket Editor)

Production Plan 
Components Pane

This pane gives you access to all the available Task Processors and Actions that 
you can include in your Production Plan. This pane is divided into four tabs:

 Input Tab

 Process Tab

 Output Tab

 Actions Tab

Input Tab

Displays all the available Input Task Processors for your plan in the Production 
Plan pane. Input Task Processors accept documents or resources from the 
“outside world”. They function as input channels for Apogee.

When creating a ticket, you need to include one or more Input Task Processors 
in a Production Plan to accept the documents that will be input using the associ-
ated Ticket.

Process Tab

Displays all the available Processing Task Processors for your plan in the Produc-
tion Plan pane. Processing Task Processors execute tasks such as imposition, 
preflight, normalization, rendering, separation and trapping on the incoming 
documents.

When creating a ticket, you normally need to include several Processing Task 
Processors in a Production Plan. Each of these accepts job data from the 
preceding Task Processor, processes the data in accordance with a pre-config-
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ured setup, and passes the intermediate results on to the next Task Processor in 
the flow.

Output Tab

Displays all the available Output and Press Task Processors for your plan in the 
Production Plan pane. These Task Processors represent your output devices: 
imagesetters, platesetters and proofers. Apart from the physical devices, Apogee 
provides additional Task Processors such as Export and Page Store Out.

When creating a ticket, you need to include an Output Task Processor for each 
flow in the Production Plan. These accept the final job data from the preceding 
Processing Task Processor, and output the job to the specified printer or press.

Actions Tab

Displays all the available Actions for your plan in the Production Plan pane. 
Actions allow you to precisely control the flow of job data through the Produc-
tion Plan, and for keeping track of your job results at every point in the 
processing chain.

Once you have built up a valid Production Plan, you can insert Actions between 
each step in the Plan. When one of these points is reached during job processing, 
an event is triggered. For example, the job results may be archived, or the flow 
may be temporarily halted until specific criteria have been met.

Two Types of Actions

The available Actions are divided into two categories: Result Actions and Flow 
Control Actions.

Result Actions 

One or more of these actions can be placed directly above a Task Processor in the 
Production Plan pane. Unlike Flow Control Actions, these actions do not inter-
rupt the flow of job data from one Task Processor to the next. They pass the job 
data on as normal, but they perform some extra processing, such as archiving the 
data or sending out a notification. 

The following Result actions are available.
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Flow Control Actions 

One or more of these actions can be inserted between any two adjacent Task 
Processors in the Production Plan pane. These actions interrupt the passing of 
job data from one Task Processor to the next. Once the action criteria have been 
met, the flow is resumed, and the job data is passed on to the next Task 
Processor. A typical Flow Control Action is ‘After Hours’, which interrupts and 
holds the processing flow until a specific time has been reached. 

The following Flow Control actions are available.

NOTE: To emphasize the fact that Flow Control actions suspend the Production 
flow, you will see a break in the connector leading to the following component 
in the Plan.

Discard

Keep Result

Archive Result

Notify

Milestone

Discard

Web Proof

Soft Proof

Hard Copy Proof

Wait for Results

Collect for Output

After Hours
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This Action may be inserted between two Task Processors in your Production 
Plan. Discard is used to prevent specific result from being output, without 
stopping the rest of the job from being printed. You can use this Action to proof 
only a few pages or flats, instead of having to proof them all in order to finish the 
job.

Apogee displays discarded flats, pages or separations by dimming the thumbnail 
and name and ‘striping’ the thumbnail.

You can discard one or more results interactively in the Results tab, or by adding 
a Discard Action to your Production Plan.

Interactive Discard

The goal is to prevent a result from being output. To do so, select that result in 
the Results tab, and select the Discard item menu command. When you discard 
a result interactively, the result is immediately marked as `discarded'. All 
processing for that result is halted. 

NOTE: You cannot discard results when editing a job.

Planned Discard

You can plan to discard results based on their location in the job (Run List 
position, at number, part or production set). You might want to do this to 
prevent all pages or flats from being proofed: You can then interactively include 
the pages or flats you want to have a proof of. 

Discard Settings

When you add or select the Discard Settings Action in the Production Plan, you 
will see the default Action parameters displayed in the Settings pane. Discard 
includes two main switches; one to discard reprocessing, and one to discard or 
include a range of results, optionally coupled with a condition on original 
version or revision. These switches work independently; however, the repro-
cessing switch always affects all results, regardless of the range or condition 
selected in the other switch.

Discard check box

Enables discarding based on ranges and originals/revisions. When enabled, 
Apogee looks at the selection in the Discard/Include list box to determine 
whether to discard a result or not. When disabled, the Discard/Include list box 
is disabled and Apogee does not discard results based on such a condition (i.e., 
it normally includes all results, except when discarded by the reprocessing 
condition). By default, this check box is disabled.
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Discard/Include list box

Select whether results that match the condition will be discarded or included.

Discard Discards results that match the condition, and includes those that do not.

Include Includes results that match the condition, and discards those that do not.

Results list box

Select this check box to specify a specific set of results that must be discarded or 
included. See “Specifying Ranges” on page 317.

All Results Select this option to specify all results, regardless of range. Use this option if you 
want to hand-pick results for inclusion.

NOTE: The QuickProof feature might make this option less useful.

Results in range Select this option to specify all results that fall within the specified range.

Results outside of range Select this option to specify results that do not fall within the specified range. 
This is the opposite of the previous option. It is convenient if you want to set up 
a pair of discard actions: one discarding a specific range and the other one 
discarding the others. Both actions can use the same range, but one uses ‘When 
in range’ and the other one uses ‘When outside of range’. See “Specifying 
Ranges” on page 317.

Parts/Production Sets This option is available only in multi-part jobs. You can select which results to 
discard, using the parts or production sets of the job. This is a much more conve-
nient way of specifying ranges: Because the ranges are already specified and 
named (in the Parts tab), you can simply select the ones you want to discard.

Condition list box

Select whether to discard or include initial content or changed content.

Always Select this option if you want to always discard (or include) results, regardless 
of reprocessing, initial or changed content.

If you select Always when the action is set to Discard, the ‘Always discard results 
when reprocessing’ option is selected as well, and the option is disabled. Note 
that this leaves you with no set up in which you can discard everything, except 
reprocessing. In all other cases, the ‘Always discard results when processing’ 
option remains enabled. 

With initial content Select this option if you want to operate on results that are being created, i.e., 
results which did not already exist.
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With changed content Select this option if you want to operate on results that have changed, i.e., the 
content of the result to be made has changed. Changed content includes using a 
new page revision, moving pages in the Run List and changing the imposition 
scheme.

Always discard results when reprocessing check box

When selected, Apogee discards unchanged results that are being reprocessed. 
In other words, when reprocessing occurs because of a parameter change or an 
explicit Reprocess (menu) command, but where the content of the result itself 
has not changed. By default, this check box is selected.

Specifying Ranges

The range field takes allows you to enter a comma-delimited list of sub-ranges. 
An empty range field is identical to None. The range field is not case sensitive, 
and you can use spaces anywhere to make the range more readable. Apogee 
removes all spaces when processing the range data.

Specify a page range: Examples

Ranges for a page proofer flow for a 20-page job

Ranges for imposition proofer flow (4 signatures, each with front/backside)

Range Pages that are in range

1-$ All

1,$ 1 and 20

1,2 1 and 2

1-5 1, 2, 3, 4 and 5

1$ 19

3$ 17

15-3$ 15, 16, 17

1-3, 3$-$ 1, 2, 3, 17, 18, 19, 20

1, 2-5, 8, 4$-$ 1, 2, 3, 4, 5, 8, 16, 17, 18, 19, 20

(empty) None

Range Flats that are in range

1-$ All

1, $ 1F, 1B, 4F and 4B

1 1F and 1B

1F 1F

1 F Same as 1F
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Ranges for imposition proof with 2 webs, 2 signatures with a front/backside

Web Proof

In order to remotely proof a result, you must place a Web Proof action in the 
Production Plan. This Action may be inserted between two Task Processors in 
your Production Plan. Web Proof pauses the processing flow as soon as the 
preceding Task Processor has finished its task. 

The Web Proof icon is displayed in Job List when one or more results of a job are 
on hold pending a Web proof. In this case, the associated Flow Status icon is 
colored blue.

NOTE: You cannot put a Web Proof Action on a 'PDF flat' path; i.e., between the 
PDF Impose and Render Task Processors.

1F-3F 1F, 1B, 2F, 2B and 3F

F All fronts

$F 4F

Range Flats that are in range

1 1W1F, 1W1B, 1W2F and 1W2B

1,2 1W1F, 1W1B, 1W2F, 1W2B, 2W1F, 2W1B, 2W2F and 2W2B

1W1 1W1F and 1W1B

1W1F 1W1F

1F 1W1F and 1W2F

F All fronts

1-$ All

1W2-2W2F 1W2F, 1W2B, 2W1F, 2W1B and 2W2F

$ 2W1F, 2W1B, 2W2F and 2W2B

1$ 1W1F, 1W1B, 1W2F and 1W2B (referring to the signature 
before the last one)

$W1F 2W1F

1$W1F 1W1F (referring to the flat before the specified flat of the 
last signature)

$W1 2W1F and 2W1B

Range Flats that are in range
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In the Results tab, the Job Layout pane indicates graphically which results 
(pages or flats) are waiting for a Web proof, together with their current status. 

The Activity pane indicates where in the Plan the Action was inserted, and which 
Task Processors (if any) are currently active.

The local operator can continue a result waiting for approval (e.g. at the request 
of the customer when the internet connection is down). This requires a 
confirmation.

Web Proof Settings

Results must be continued by local operator as well

When selected, results approved by the remote user must also be approved by 
the operator before processing is resumed.

Freeze results when approved/continued

Select this check box to prevent results being reprocessed once the pages have 
been approved by the remote user.
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Approval ready by

Here you can set a deadline for approving the web proof. All approvers receive a 
notification if all the pages have not been approved by the entered date. 

Soft Proof

This Action may be inserted between two Task Processors in your Production 
Plan. Soft Proof pauses the processing flow as soon as the preceding Task 
Processor has finished its task. This allows you to view the intermediate job 
results produced by the preceding Task Processor (also referred to as a “soft 
proof”). 

The Soft Proof icon is displayed in Job List when one or more results of a job are 
on hold pending a soft proof. In this case, the associated Flow Status icon is 
colored blue.

In the Results tab, the Job Layout pane indicates graphically which results 
(pages or flats) are waiting for a soft proof, together with their current status. 
The Activity pane indicates where in the Plan the Action was inserted, and which 
Task Processors (if any) are currently active.
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You can manually continue processing the job. You do this by context-clicking 
the job in the Job List, and selecting Resume from the context menu.

Soft Proof Settings

When you add or select the Soft Proof Action in the Production Plan, you will see 
the default Action parameters displayed in the Settings pane. You can modify 
these parameters as follows.

Send Notification

Select this check box if you want to distribute notifications when some or all of 
the job results are ready. You can then choose one of two options:

Each time a result is ready A notification is delivered each time the Task Processor receives and processes 
part of the job. 

Only when all results are
ready

A single notification is delivered when the Task Processor has received and 
processed all of the job. 

For information on specifying notification recipients, see “Notify” on page 327.

Hard Copy Proof
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This Action may be inserted between two Task Processors in your Production 
Plan. Hard Copy Proof pauses the processing unconditionally as soon as the 
preceding Task Processor has finished its task. The intermediate job results are 
put on hold, pending Approval. 

The Hard Copy Proof icon is displayed in the Job List when one or more results 
of a job are held for Approval. In this case, the associated Flow Status icon is 
colored blue.

The job’s Results tab indicates more precisely which results are waiting for 
Approval.

To continue the job, you have to select the job and/or one or more results in the 
Jobs Window, and select Approve from the Jobs menu.

Hard Copy Proof Settings

When you add or select the Hard Copy Proof Action in the Production Plan, you 
will see the default Action parameters displayed in the Settings pane. You can 
modify these parameters as follows:

Send Notification

Select this check box if you want to distribute notifications when some or all of 
the job results are ready. You can then choose one of two options:

Each time a result is ready. A notification is delivered each time the Task Processor receives and processes 
part of the job. 

Only when all results are
ready.

A single notification is delivered when the Task Processor has received and 
processed all of the job. 

For information on specifying notification recipients, see “Notify” on page 327.

Wait for Results

The Wait for Results Action tells Apogee to hold the results at the action point 
until results from another flow are made (i.e. finished). This action provides the 
automated continuation of results in the main flow(s), when results in a 
proofing flow have been finished.

The typical use of the Wait for Result Action is to connect proofing flows and 
main flows.
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Wait for Results Settings

When you add or select the Wait for Results Action in the Production Plan, you 
will see the default Action parameters displayed in the Settings pane. You can 
modify these parameters as follows.

Flow to watch

Select the flow that will be watched by the Wait for Results action. The available 
options display the names of all flows that can be watched.

Continue results in this flow

Only when the watched
flow is completely finished

Select this option if you want to wait for all results in the watched flow to be 
finished before releasing the results.

When the required pages
finish in the watched flow

Select this option if you want to release a waiting result as soon as the corre-
sponding results in the watched flow are finished. Apogee will decide which 
pages are needed for each watching result, and wait for those pages to finish in 
the flow being watched.

Collect for Output

Whenever you add an Output Task Processor to your Production Plan, the 
Collect for Output Action is automatically attached to it. This Action holds the 
intermediate job results pending receipt of specific groups of job data, as speci-
fied in the Action’s output settings.

In the Results tab, the Job Layout pane indicates graphically which results are 
being grouped for output. The Activity pane indicates where in the Plan the 
Action was inserted, and which Task Processors (if any) are currently active.

The Collect for Output icon is displayed in the Job List when one or more results 
of a job are waiting to be output. In this case, the associated Flow Status icon is 
colored blue. 

If the job results are only partially complete (i.e., they are still being collected), 
the pages/flats in the Results tab turn blue, but the Collect for Output Action 
icon does not. This icon turns blue only when all the results have been collected.

To output these results, see “Continuing Jobs” on page 197.
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NOTE: You can place a Collect for Output Action at any point in your Production 
Plan.

Collect for Output Settings

When you add or select the Collect for Output Action in the Production Plan, you 
will see the default Action parameters displayed in the Settings pane. You can 
modify these parameters as follows:

Group and print by

Allows you to specify how the various sections of your job will be arranged and 
grouped for printing. 

 For a job with imposition, this may be:

 Job: All separations of the job are first grouped together, and then 
printed. In a Split for Proof flow of a packaging job, collects all results for 
all placed products of the entire job.

 Sheet: In a Split for Proof flow of a packaging job, collects the result(s) per 
product.

 Version: All the versions of the job are grouped and then printed in 
sequence.

 Signature: The job will be grouped together as a series of signatures (a 
series of press sheets with both front and back print data), and these 
signatures will be printed in sequence.

 Web: For newspaper printing (you can have multiple webs, each of which 
provides one or more inserts for the completed paper).

 Side: The job will be grouped together into 2 sets - front and back, and the 
two sets will be printed in sequence.

 Separation: The job will be grouped together into sets of separations 
(CMYK and any spot colors), and each set will be printed in sequence.

 For a job without imposition, this may be:

 Job: All separations of the job are first grouped together, and then 
printed.

 Page: The job will be grouped together as a series of pages, and these will 
be printed in sequence.
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 Separation: The job will be grouped together as 4 sets of process separa-
tions (CMYK), and each set will be printed in sequence.

For example, if you select Separation, Apogee will group together all the Cyan 
separations, and will print these first, followed by the Magenta, Yellow, Black, 
and spot color separations (i.e., sheet 1 cyan, sheet 2 cyan, sheet 1 magenta, 
sheet 2 magenta, etc.). If you select Signature, Apogee will gather the job 
together as a sequential series of signatures (i.e., sheet 1 front, sheet 1back, 
sheet 2 front, sheet 2 back, etc.)

NOTE: Since most users adopt a specific method of job output for their specific 
workflow requirements, it is not likely that you would want to change this 
setting very often.

Keep versions apart Select this option to collect the press sheets by product version (e.g. English, 
French, German).

Print when

Automatically as soon as a
group is complete

Select this check box if you want Apogee to automatically start printing the 
selected job results when a group is available.

Automatically when all
groups are complete

Select this check box if you want Apogee to automatically start printing the 
selected job results when all groups are available.

Options

Notify when group is ready
for printing

Select this check box if you want Apogee to send a message as soon as the 
selected job results are available.

After Hours

This Action may be inserted between two Task Processors in your Production 
Plan. The After Hours settings suspend the transfer of results from the preceding 
Task Processor to the next one in the flow until a predefined date and/or time is 
reached. 

The After Hours icon is displayed in Job List when one or more results of a job 
are on hold pending the specified date/time. In this case, the associated Flow 
Status icon is colored blue.

In the Results tab, the Job Layout pane indicates graphically which results 
(pages or flats) are waiting for After Hours processing, together with their 
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current status. The Activity pane indicates where in the Plan the Action was 
inserted, and which Task Processors (if any) are currently active.

You can manually continue processing the job. You do this by context-clicking 
the job in the Job List, and selecting Resume from the context menu.

After Hours Settings

When you add or select the After Hours Action in the Production Plan, you will 
see the default Action parameters displayed in the Settings pane. You can modify 
these parameters as follows.

Daily

Select this option if you want to specify a daily time period (e.g. 18.00 until 
23:00) during which job results are allowed to pass through to the next Task 
Processor.

Daily, between Select the time to start passing results to the next Task Processor.

and Select the time to stop passing results to the next Task Processor.

Keep Result

This Action may be placed above a Task Processor in your Production Plan. Keep 
Results passes on the intermediate job results to the next Task Processor in the 
flow without interruption. By default, when a Task Processor passes on its 
results, it does not retain a copy of them. However, the Keep Result Action 
instructs Apogee to keep this Task Processor’s results.

The Keep Result Action is automatically added whenever you add an Input Task 
Processor to your Production Plan. This ensures that the intermediate results 
(the input documents) are saved and kept on the system. This allows you to run 
fast job remakes, without having to find and input the same source documents.

Keep Result is always applied by default to any Task Processor which immedi-
ately precedes a Run List in a Production Plan.

NOTE: The Keep Result Action has no options or settings.
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Archive Result

This Action may be placed above a Task Processor in your Production Plan. 
Archive Result passes on the job results to the next Task Processor in the flow 
without interruption. However, it also marks these intermediate results for 
archiving on the Apogee System.

The Archive icon is displayed in the Job List when one or more results of a job are 
being archived.

In the Results tab, the Job Layout pane indicates graphically which results 
(pages or flats) are archived. The Activity pane indicates where in the Plan the 
Action was inserted, and which Task Processor’s (if any) are currently active.

NOTE: The Archive Result Action has no options or settings.

When and where are the Results Archived?

You can specify when and where these results are archived by switching to the 
System Overview window, and double-clicking the Apogee System icon in the 
Hardware pane, and then double-clicking the Job Housekeeping icon. For more 
information, see “Job Housekeeping Settings” on page 677.

Notify

This Action can be placed above a Task Processor in your Production Plan. Notify 
passes on the intermediate job results from the associated Task Processor to the 
next Task Processor in the flow without interruption. However, one of three 
predefined notifications is also generated, indicating how much of the interme-
diate job results are available.

Notify Settings

When you add or select the Notify Action in the Production Plan, you will see the 
default Action parameters displayed in the Settings pane. You can modify these 
parameters as follows:
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When

You can then choose one of three options:

When first result is ready A notification is delivered when the Task Processor produces the first interme-
diate job results. 

Each time a result is ready A notification is delivered each time the Task Processor produces intermediate 
job results. 

Only when all results are
ready

A single notification is delivered when the Task Processor produces the final job 
results.

Send

Select either or both of the following check boxes:

As notification To distribute notifications when some or all of the job results are ready.

As e-mail To distribute e-mails when some or all of the job results are ready. In this case, 
you must enter an e-mail address in the adjacent box.

Additional Text

The text that you enter here will appear in the notification that is generated.

Milestone

This Action can be placed above a Task Processor in your Production Plan. 
Milestone passes on the intermediate job results from the associated Task 
Processor to the next Task Processor in the flow without interruption. However, 
a notification is generated if the associated Task Processor does not deliver all 
intermediate job results by a predefined date and time.

The Milestone icon is displayed in Job List when a job has generated a Milestone 
notification. The job’s Results tab indicates more precisely which results (pages 
or flats) are not yet available.

Milestone Settings

When you add or select the Milestone Action in the Production Plan, you will see 
the default Action parameters displayed in the Settings pane. You can modify 
these parameters as follows:
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Notify if all results not ready by:

Date Select the date by which all intermediate job results are required.

Time Select the time of day by which all intermediate job results are required.

Production Plan 
Pane (Ticket Editor)

The Production Plan is a series of components (Task Processors and Actions) 
linked together to form one or more processing flows. These components are 
configured to define exactly how the job is to be input, processed, and output.

When you select one of the components, you will see the associated settings 
displayed below in the Settings Pane (Ticket Editor).

Below each Task Processor icon, there is a drop-down list from which you can 
select a group of predefined settings (a Parameter Set). If none is selected, the 
Task Processor uses its initial settings. 

The last Task Processor in a flow is followed by a Flow Identifier. By default, this 
always indicates a Main Output flow. However, you can redefine it as described 
in “Creating a Production Plan with Multiple Proofing Flows” on page 349.

Flow Identifier

For each Ticket you create, you define one or more output paths in the Produc-
tion Plan. For example, you may want your jobs to be output both to a proofing 
device and to a platesetter. When you set this up in the Plan tab, you can select a 
specific flow identifier at the end of each flow in your Production Plan.

The following flow options are available:
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Settings Pane 
(Ticket Editor)

The Settings pane displays the settings for the component (Task Processor or 
Action) that is currently selected in the Production Plan pane.

The settings may be locked, as indicated by the Lock icon which is located in the 
top right of the Settings pane.

If you want to edit individual settings, click the Lock icon to toggle off the lock, 
and then edit the settings according to your job requirements. 

The name of the selected parameter set is displayed in a box at the top of the 
Settings pane (“initial” by default). If you make any changes to an “initial” 
parameter set, these changes are indicated by an asterisk in front of the “initial” 
parameter set name.

You will also see a “Different Processing” check box in the top right of the 
Settings pane.

Main Output: The default flow for all jobs, used for output to a high resolution output device.

Imposition Proof: An optional flow which may be added to the Main Output flow, and is used 
for output to an imposition proofing device.

Page Proof: An optional flow which may be added to the Main Output flow, and is used for 
output to a page proofing device.

Export: An optional or alternate flow to the Main Output flow, used for exporting job results to 
file in PDF or PostScript format.

Public Page Store: An optional or alternate flow to the Main Output flow, used for storing job 
results in a Public Page Store.

Image Collector: An optional or alternate flow to the Main Output flow, which supports image 
collector Task Processors.

Display: A flow which is used to output the job results to a monitor for high-resolution soft 
proofing.

Automatic: If this option is selected, Apogee will automatically select the most appropriate 
icon, based on the content of the flow.
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This is used specifically in multi-part jobs to select alternate processing settings 
for one or more parts of the job (for example, different color settings for the 
cover). If you select this option in a normal job, you will see that the job contains 
a single part (a Production Set), called “Body plates”. For more information on 
multi-part jobs, refer to “Multi-part Jobs in the Plan Tab” on page 331.

For more information, see “What Are Task Processor Settings?” on page 48. For 
details on editing Task Processor Parameter Sets, see “To create, duplicate, edit, 
delete, import or export Parameter Sets” on page 715.

For information on individual Task Processor settings, refer to the relevant Task 
Processor section. For information on individual Action settings, refer to “Two 
Types of Actions” on page 313.

Multi-part Jobs in 
the Plan Tab

The Production Plan visually highlights with a thick blue underscore those 
operations that have different processing settings defined. 

TIP: You can only specify 
different settings for specific 
Task Processors.

When you add a Task Processor to a plan, it has by default the same settings for 
the whole job (i.e, it is set to single processing). To specify different settings, 
select the Different Processing option in the header of the Settings pane. A 
production sets table is then displayed, listing the different production sets, 
including ranges and parts, as defined in the Products tab. 

NOTE: You cannot manage productions sets from here. 

The single processing set is used as the default set for when you create new 
production sets. Apogee copies the parameter values used for the single 
processing mode to each production set. You can switch back and forth between 
the two modes without loosing any edits.
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When you create a new production set (in the Products tab), it becomes visible 
to all operations that support it (and that have Different Processing selected). 
See “Managing Production Sets” on page 311.

The Parameter Set column displays the selected parameter set(s). You can select 
a different parameter set from the drop-down list, or change the name (by 
double clicking it). 

Press and Output Task Processors feature an extra Device column from which 
you can select the device you want to use. By default, the device and parameter 
selection are identical for all production sets, and matches the device and 
parameter set that was selected in single processing mode. 

NOTE: Since JDF has no names for a set of parameters, Apogee uses generic 
names for displaying the parameter set name. This generic name is of the form 
JDF Set, optionally followed by space and a number to differentiate different 
parameter values for different production sets.

The Parameter Set Drop-down menu

You can change the parameter set in the flow by selecting another from the 
Parameter Set drop down list. This assigns the selected parameter set to all 
production sets. 
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Save As

To save the parameter set, select Save As. Apogee prompts for a name, after 
which it saves the current values as a parameter set with the given name. Doing 
so also sets the current selection to the newly created parameter set.

Manage Parameter Sets

Select this item to open the Parameter Sets Resource overview, with the current 
operation selected (Administrator only).

Output

 CtP, CtF and Proofers: If you select Different Settings in the Output opera-
tion, you automatically select them for the Image parameters as well. This is 
because the image parameters of a production set must always correspond to 
the selected output device. However, you can only switch between devices of 
the same class (CtP, CtF or Proofer).

 Press: The parameter view of the Press task processor presents the different 
press task processors in the production set table, allowing you to select a 
particular one. The Generic Press task processor only offers parameter sets.

The Run List Task Processor

 General settings: The Number of Pages option is shared with the corre-
sponding item in the Products tab: You can change its value in either place. 
The effects of changing it is the same as with previous versions of Apogee.

The First page starts at option is not available in multi-part jobs with multiple 
parts. Instead, it is set to `1'. It is enabled if the job has a single part. 

 Hard copy proofing: Introducing production sets removes the need to have 
multiple proofing flows, one for every press flow. When you set the param-
eter set of the press in the proofing flow to (from main), the proofer press 
follows the settings from the main press, including the set up for different 
processing. If you do not use (from main), you will have to manually specify 
the parameters for the different processing.
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Using the Pages Tab

For each job you select, the Pages tab displays both the list of pages contained in 
the Page Store, and the pages that have been included in the Run List. 

This tab is subdivided into three panes:

 Products

 The Page Store (Ticket Editor)

 The Run List (Ticket Editor)

The Pages tab is disabled if there is no Run List in the selected job:

If you are creating a new job ticket, the Pages tab remains disabled until you add 
a Run List to the Production Plan.

The Pages tab is not available in the Hot Ticket Editor.

Products In this pane you see the same list of products and parts that you see in the 
Products tab (see “Products and Parts List” on page 295). Select a product or part 
in this list to display the corresponding Run List. Products and parts can also be 
selected by clicking the selectors at the top of the Pages tab (Products: on the 
left; Parts: on the right). You can show/hide the Products pane by clicking the 
show/hide button in the top left corner of the tab.

For versioning jobs, which can only consist of one product, this panel lists the 
versions.
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1 Show/hide the Products pane
2 Product selectors
3 Part selectors

The Page Store 
(Ticket Editor)

The Page Store may be either a Private Page Store, which displays only the 
documents for a single job, or may include one or more Public Page Stores which 
display the documents created by all Page Store Out Task Processors.

The Page Store lists the documents that have been input and that may be added 
to your Run List. 

By default, documents are arranged as folders alphabetically in the Page Store. 
The number of pages is shown in parentheses after the document name. If more 
than one version of the document has been input, you will see the document 
revision number in a separate column.

Apogee automatically names each document with the name of the input file. If 
no name is available, Apogee uses the generic name “Document”, immediately 
followed by a sequence number. If you add a document that is already known by 
Apogee (e.g. from another job), then the same document name is used.

When you expand a document folder, Apogee lists the individual pages in the 
selected document. It is from this view that you can select the pages that you 
want to include in your job’s Run List.

The Run List (Ticket 
Editor)

The Run List displays the pages that have been selected from the Page Store, and 
that will be included in your job.

1 2 3
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A page in the Run List shows similar information to the same page in the Page 
Store. The page name is the document name as displayed in the Page Store, 
followed by the page number. Placeholders and blank pages do not have a name.

The Run List provides the following information about the listed pages:

A variety of information may also be displayed in the placard area above the Run 
List.

NOTE: For a versioning or a multi-part job, the layout of the Run List is 
considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Run List” on 
page 228 and “Multi-part Jobs in the Run List” on page 232.

You can add pages or documents to the Run List, move and delete pages from it, 
and add blank pages. You can also change the number of pages in the Run List, 
although this might invalidate any imposition scheme you may have selected.

Job Tickets require a Run List: They will not work correctly without one. Hot 
Tickets can also use Run Lists, but do not require one if no imposition is specified 
in the Production Plan.

Adjustments
May display up to four columns of page adjustment icons, indicating that 
the positioning of this individual page has been modified (offset).

The size of the placeholder (as specified in the Production Plan) is different 
from the size of the page that is placed on it (imposition jobs only).

Lbl
The page label (selected using View > Page Labels). Page labels are dis-
played when the Run List is (automatically) updated with new revisions.

# The page number in the Run List.

Page The name of the page (the same as in the Page Store).

Rev The revision number of this page (if any).

Sig
The Signature to which the page belongs (when imposition is included in 
the Plan).

The total number of empty placeholders in the Run List. If you position your cursor 
over this icon, Apogee displays a Tooltip indicating how many placeholders are 
empty, placed and blank.
The number of spot colors used in the job. If you position your cursor over this icon, 
Apogee displays a Tooltip indicating the spot color names. If you click this icon, Apo-
gee displays the separation settings in the Plan tab.

Indicates that the Run List contains pages with different sizes.
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Using the Results Tab

The Results tab allows you to view the results of the selected job. This tab 
displays thumbnails of the Run List pages, and job separations (if any).

NOTE: The Results tab is not available in the Hot Ticket Editor.

This tab is divided into two panes:

 The Job Layout Pane (Ticket Editor)

 The Separations Pane (Ticket Editor)

Above these two panes, you will see a row with the Production Sets selector and 
one or more Flow Identifier icons, corresponding to each flow in the selected job. 
When you click on any of these icons, you will see the results for this particular 
flow.

NOTE: If you are viewing a versioning or multi-part job, the layout of the Results 
tab is considerably different (depending on the specific parameters of the input 
documents). For more information, refer to “Versioning Jobs in the Results Tab” 
on page 249 and “Multi-part Jobs in the Results Tab” on page 253.

The Job Layout 
Pane (Ticket Editor)

Displays thumbnails of the Run List pages of the selected job. Status icons, 
corner folds, and colored backgrounds provide additional information about the 
current status and orientation of each of the displayed thumbnails.

You can then double-click any of the thumbnails to launch the appropriate 
viewer for this specific page. If the job has not yet been successfully processed, 
you will see only empty placeholders. Double-clicking a thumbnail launches the 
appropriate viewer (Acrobat for PDF documents or Raster Preview for Digital 
Film).

You must correctly configure the location of Adobe Acrobat to enable raster 
previews. For more information, refer to the Apogee Installation Guide.

NOTE: For a versioning job, the layout is considerably different (depending on 
the specific parameters of the input documents). For more information, refer to 
“Versioning Jobs in the Results Tab” on page 249.
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The Separations 
Pane (Ticket Editor)

Displays thumbnails of each of the separations for the page you select in the Job 
Layout pane. Double-clicking a thumbnail launches the Raster Preview viewer.
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Working with Job Tickets and Hot Tickets

The procedures for creating and editing Job and Hot Tickets are similar. For 
both, you specify your options in the Administration, Options, and Plan tabs. The 
difference is that Job Tickets also include Pages and Results tabs, where you can 
define a Run List and imposition layout.

Preparing Your 
Plan

Before starting, it is a good idea to first define the type of Production Plan you 
require. This will determine the number and types of input channels and output 
devices you will need to configure, the number of flows required, and the 
resources and Parameter Sets you will need.

Job or Hot Ticket?

If you are creating a new ticket, the type of ticket you should choose depends on 
the number and formats of the documents that you want to process.

Layout Ticket?

Choose a Layout Ticket or Layout Hot Ticket for Sign & Display jobs which are 
prepared in the Layout editor.

New Ticket or Template?

Apogee provides you with a series of ready-made ticket templates which can be 
used as a starting point for most types of workflow. Wherever possible, you are 
advised to start from one of these templates, and adapt it according to your 
requirements. When you are more familiar with the Apogee System, you can of 
course create new tickets from scratch.

Do You Want one or More Proofing Flows?

If you want to include proofing in your Plan, you will need to add one or more 
flows to your main flow. To avoid time-consuming editing later, it is better to 
sketch out your proposed Production Plan in advance. Remember that Imposi-
tion and Page Proof flows must be connected to the main flow at specific points, 
and must each be configured with their own unique output devices.

Which Components Do You Need in your Plan?

The components you need in your Production Plan depend on the ticket type, 
and your prepress requirements. There are some rules, however:

 You always need at least one input component, one processing component, 
and one output component.

 A Job Ticket must have a Run List.
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 A Run List is not required for a Hot Ticket. Documents are delivered to an 
input channel, and the input channel creates one job per document.

 If you include the Impose component, you will also need to add a Run List 
component. You can input multiple documents per job for jobs which require 
imposition, since not all the documents of the job have to be delivered at the 
same time.

 When you create a flow using either an imagesetter or platesetter output 
device, you always need to add a Press Task Processor to the end of the flow. 
This is not required when you use Export with Trapping, or proofer output 
devices.

Are All Necessary Resources Available?

By default, Apogee associates some standard Resources (fonts, halftones, etc.) 
with the available Task Processors. However, you may need to supplement these 
with additional resources of your own.

What happens in a 
Processing Flow

The following sequence of events takes place in a typical Production Plan:

 A document is input via an input channel (e.g. Hot Folder).

 The document is processed by the first Task Processor, and the intermediate 
job results are passed to the next Task Processor in the flow.

 Intermediate job Results are passed successively from Task Processor to Task 
Processor in the Production Plan flow.

 By default, once a Task Processor passes on its results, it does not keep a copy 
of them.

 Inserting Actions allows you to control the flow, and to save and view inter-
mediate results.

 The last Task Processor in the flow is a Print, Press, or Export Task Processor 
to which the final results are delivered.

Creating or Editing 
a Ticket

You create a new ticket using the Ticket Editor. The Ticket Editor can be opened 
from any of the main windows in the Apogee Client.

To edit an existing Job Ticket, you must first select the associated job in the Job 
List. The jobs displayed in the Job List comprise both the job data and the job 
ticket (see “What Are Job Tickets?” on page 44). 
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To edit an existing Hot Ticket (from which several jobs may already have been 
created), you must select the ticket from the Hot Tickets list (see “What Are Hot 
Tickets?” on page 45).

NOTE: The Layout Editor and not the Ticket Editor is opened when you choose to 
create Layout Tickets or Layout Hot Tickets. See “Layout Editor” on page 485.

 To create a new ticket based on a template

1 Choose File > New from Templates. (CTRL-N).

The Templates dialog box is displayed with the Quick Fill panel.

2 Select either the Jobs Tickets or the Layout Tickets tab to create a Job Ticket 
or a Layout Ticket. You will also see these tabs if you are creating Hot Tickets.

3 Select a Ticket Category.

The Ticket Templates that are available in this category are displayed in the 
Template panel.

4 Select one of the Ticket Templates.

If the creator of this template entered a template description, then this is 
displayed in the panel on the right.

If the creator of this template included an Impose Task Processor in the Plan, 
the Product and Parts panes are also active.
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5 Enter the Administration, Product and Parts details in the Quick Fill panel 
and click Open, or click Open directly and enter the details on the tabs as 
described below.

The Ticket Editor appears. If you defined a Product and its Parts, the Ticket 
opens with the Products tab selected. The Ticket uses the Administration, 
Product and Parts details that you entered. Otherwise, the Administration 
tab is selected. 

6 Complete the Administration tab. For details on each of the fields, see “Using 
the Administration Tab” on page 284.

7 Select the Options tab, and define how the jobs which use this ticket are to be 
handled (archiving, notifications, etc.). For details on each of the fields, see 
“Using the Options Tab” on page 288.

8 Select the Plan tab and create a Production Plan in the Production Plan pane. 
See “Creating or Editing a Production Plan” on page 343.

9 Choose File >Submit to submit the Ticket. 

For more information, see “Submitting Tickets” on page 354.

 To quickly create a blank ticket

1 From any of the main windows, click CTRL+ALT+N.

A new blank ticket is opened in the Ticket Editor.

2 Edit the ticket, then choose File >Submit to submit it. 

 To select and edit a Ticket

1 Select the Jobs Window.

2 In the Job List, select the job you want to edit., and click the Edit Ticket 
button in the Toolbar.

The job is put on hold and the associated ticket is opened in the Ticket Editor.

3 Edit the ticket using the procedures described in the rest of this chapter (see 
“Creating or Editing a Production Plan” on page 343).

Any errors you introduce will generate the following type of message in the 
Tab Area:
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You can then click the error status icon to access the Problem Report (see 
“Problem Report” on page 166).

TIP: Any existing results 
which are not affected by the 
changes are kept - unlike the 
Re-render command, which 
forces the re-rendering of 
results, whether or not they 
are required.

4 When you have finished editing the ticket, submit your changes (see 
“Submitting Tickets” on page 354).

Apogee checks the changes, determines what needs to be reprocessed, and 
automatically starts reprocessing those results. 

Creating or Editing 
a Production Plan

You need to create a Production Plan for both Job and Hot Tickets. You do this 
in 5 steps:

 Adding the First Input Task Processor to Your Production Plan

 Dragging Additional Task Processors to Your Production Plan

 Connecting Task Processors in your Production Plan

 Setting or Changing Task Processor Settings

 Adding Actions to Your Production Plan

Once you have created a basic single-flow Production Plan, you can expand it by 
adding extra proofing flows. The following sections explain how to do this, as 
well as how to edit and rearrange your Plan:

 Creating a Production Plan with Multiple Proofing Flows

 Deleting a Component from Your Production Plan

Adding the First Input Task Processor to Your Production Plan

When you create a new ticket, there is no Production Plan. You can start building 
one by adding the first Task Processor to the Production Plan pane.
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 To add the first Task Processor to your Production Plan

1 In the Ticket Editor window, select the Plan tab.

You will see the Production Plan Components pane on the left. This gives you 
access to all the available Task Processors and Actions that you can include in 
your Production Plan. 

2 Select the Input tab in the Production Plan Components pane.

3 Select an Input Task Processor, drag it onto the Production Plan pane, and 
drop it anywhere in the left of the pane.

Since this is the first Task Processor in your Plan, you will see that it has a 
square gray connector on the right. This is the point at which you can connect 
the next Task Processor that you add to this flow. Task Processors use a 
number of different types of connectors, as described in “Connecting Task 
Processors in your Production Plan” on page 345.

NOTE: A Keep Results action is always added to input Task Processors.

Below the Task Processor, you will see the name of the initial settings file that 
the Task Processor will use. If you click this name, you will see a list of all the 
available Parameter Sets for this Task Processor. For more information, see 
“Setting or Changing Task Processor Settings” on page 346.

Currently, this is the first and only Task Processor in your flow.

NOTE: When you add any component to the Production Plan, the default 
component settings are displayed in the Settings pane.

Dragging Additional Task Processors to Your Production Plan

You create a Main prepress flow by linking together a series of Task Processors 
in the Production Plan pane.

 To add more Task Processor to your Production Plan

1 Select the Input, Processing, or Output tab in the Production Plan Compo-
nents pane.
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The type of Task Processor you can add depends on which Task Processor you 
want to connect it to. 

2 Click on a Task Processor, and drag it to the right edge of the last Task 
Processor in the Production Plan pane.

 If you see a green connection, it means that this is a valid addition to your 
Production Plan.

 If you see a red connection, then this combination of Task Processors is 
invalid. For more information, see “Connecting Task Processors in your 
Production Plan” on page 345.

3 When you have a valid connection, release the mouse button to place the 
Task Processor.

4 Continue adding Task Processors to the flow.

Connecting Task Processors in your Production Plan

To build a flow in the Production Plan pane, you need to link together a series of 
Task Processors. However, you can only make links between “compatible” Task 
Processors. 

Each Task Processor has a data-in connector and a data-out connector (Input 
Task Processors only have a data-out connector). These connectors indicate the 
type of data that can be input to, or output from the Task Processor, and are 
displayed graphically as follows:

 Round connectors: These represent PDF or PostScript data. 

 A Task Processor with round data-in/data-out connectors (e.g. Impose or 
Preflight) can only receive or deliver PDF or PostScript data.

A round connector can only be connected to a square connector, or to 
another round connector.

 Arrow connectors: These represent raster data.
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 A Task Processor with an arrow data-out connector (e.g. Digital Film 
Proof) can only deliver raster data. 

An arrow connector can only be connected to a square connector.

 Square connectors: These represent multiple data types (PDF, PostScript, 
Raster, other).

 A Task Processor with square data-in/data-out connectors (e.g. PDF 
Render, shown above) can receive or deliver any type of data.

A square connector can be connected to any other type of connector.

NOTE: The Run List Task Processor cannot receive PostScript data.

Setting or Changing Task Processor Settings

You customize each Task Processor in the Plan by opening the Task Processor’s 
list box and selecting one of the available predefined Parameter Sets. 

When you select a Parameter Set, the corresponding settings are displayed in the 
Settings pane (below the Production Plan pane). If you wish you can directly 
modify any of the displayed settings.

The Task Processor list box also has two other options: 

 Save As: Displays a dialog box which allows you to enter a name and save the 
current settings as a new parameter set.
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 Manage Parameter Sets: Opens the Parameter Sets dialog box, where you 
can create, duplicate, edit, delete, import or export parameter sets.

Creating a Production Plan with a Single Main Output Flow

To create a simple Production Plan, you need to build a single Main Output flow 
containing an Input, Processing, and Output Task Processor.

 To create a single main output flow

1 Start a new ticket, click the Plan tab, and add an Input Task Processor to the 
Production Plan as described in “Adding the First Input Task Processor to 
Your Production Plan” on page 343. For example, add a Hot Folder.

2 Add a Processing Task Processor to the Production Plan as described in 
“Dragging Additional Task Processors to Your Production Plan” on page 344. 
For example, add Render.

3 Add an Output Task Processor to the Production Plan. For example, add TIFF 
Imagesetter.

4 In the Production Plan pane, click the Input Hot Folder Task Processor.

5 The default Hot Folder settings are displayed in the Settings pane. By default, 
the location of the Hot Folder is specified as:

\\$SYSTEMCOMPUTER\HotFolderRoot\$ORDER\

The default location uses the $ORDER variable. This means a Hot Folder will 
be automatically created as a subfolder under the HotFolderRoot, using the 
job’s order number as the Hot Folder name.

6 Click the Settings list of each of the remaining Task Processor Operations and 
select one of the available Parameter Sets as described in “Setting or 
Changing Task Processor Settings” on page 346.

Adding Actions to Your Production Plan

You control the flow of job data through the Production Plan by inserting Actions 
at specific points in the flow. Actions can also be used to keep track of your job 
results at any point in the flow.

 To add a flow control action

1 In the Ticket Editor window, select the Plan tab.
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You will see the Production Plan Components pane on the left. This gives you 
access to all the available Task Processors and Actions that you can include in 
your Production Plan. 

2 Select the Actions tab in the Production Plan Components pane.

To add a Flow Control Action, such as After Hours, you will need to drag and 
drop the Action onto the right edge of the Task Processor whose results will 
be held, pending the specified time.

3 Click on one of the Flow Control Actions and, holding down the mouse 
button, drag it onto the Production Plan pane to the right edge of the selected 
Task Processor.

The right edge of the Task Processor is highlighted with a blue bar when the 
Action is in the correct position.

4 Release the mouse button to drop the Action into place.

NOTE: You can add up to 4 
Flow Control Actions, and 4 
Result Actions to any Task 
Processor.

Flow Control Actions, such as After Hours, interrupt the flow (indicated by 
the break in the flowline). The Action icon is positioned above and to the 
right of the selected Task Processor, after the break. 

5 If you select the Action, you will see the default Action parameters displayed 
below in the Settings pane. You can modify these parameters as described in 
the topics listed below.

6 If you click the Results tab, you will also see any Flow Control Actions you 
have added. Here, the Action icons have a background color to indicate their 
current status. For more information, see “Working with Jobs in the Results 
Tab” on page 234.

 To add a result action

1 In the Ticket Editor window, select the Plan tab.

You will see the Production Plan Components pane on the left. This gives you 
access to all the available Task Processors and Actions that you can include in 
your Production Plan. 

2 Select the Actions tab in the Production Plan Components pane.

To add a Result Action, such as Archive Result, you will need to drag and 
drop the Action directly on top of the Task Processor whose results you want 
to archive.
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3 Click on one of the four Result Actions and, holding down the mouse button, 
drag it onto the selected Task Processor in the Production Plan pane.

The background color of the Task Processor changes to light grey when the 
Action is in the correct position.

4 Release the mouse button to drop the Action into place.

NOTE: You can add up to 4 
Flow Control Actions, and 4 
Result Actions to any Task 
Processor.

Result Actions, such as Archive Result, do not interrupt the flow. The Action 
icon is positioned above and to the right of the selected Task Processor. 

If you select the Action, you will see the default Action parameters displayed in 
the Settings pane. You can modify these parameters as described in the topics 
listed below.

Deleting a Component from Your Production Plan

Proceed as follows to delete a component (Task Processor or Action) from your 
Production Plan:

1 Open the Ticket for editing, and select the Plan tab.

2 Select an Action or Task Processor, and do one of the following:

 Press Delete.

 Click the Delete button.

If you delete a Task Processor, a gap appears in the Production Plan. You can 
close the gap by dragging one of the broken connectors to the other. You 
could also insert and reconnect another Task Processor in the gap.

Creating a Production Plan with Multiple Proofing Flows

When you build a Production Plan, you must always create a Main flow. 
However, if you want to include proofing and/or output to additional devices, 
you will need to create one or more parallel flows, and link them to your Main 
flow. 
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The following procedures describe, step-by-step, how to create a Production 
Plan comprising three flows:

 Main flow

 Imposition Proof flow

 Page Proof flow

NOTE: In each of these procedures, you will need to specify settings for each 
component. You will also need to submit the ticket when you have finished.

 To create a main output flow

1 Create a new Ticket, and select the Plan tab.

2 Create a single Main Output flow, adding components in the following 
sequence:

Hot Folder - Normalize - Run List - Impose - PDF Render - TIFF Platesetter - 
Press

Your flow should look like this:

Notice that a “Collect for Output” Action is automatically inserted between 
the PDF Render and TIFF Platesetter Task Processors.

NOTE: When you create a main flow using either an imagesetter or platesetter 
output device, you always need to add a Press Task Processor to the end of the 
flow. This is not required when you use export or proofer output devices.

A flow always displays a Flow Identifier after the last Task Processor the flow. 
By default, this always indicates a Main Output flow. However, you can 
redefine this as described in “Creating a Production Plan with Multiple 
Proofing Flows” on page 349.

 To add an Imposition Proof flow to your Main flow

When included in a Production Plan, an Imposition Proof flow should branch 
from the Main flow after the Impose component. This ensures that the results 
from the Main flow and the Imposition flow are identical in layout.

1 Start with the main flow you created in the preceding procedure.
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2 Select another PDF Render component from the list of available Processing 
components in the Production Plan Components pane and drag-and-drop it 
exactly below the first PDF Renderer in your main flow.

3 Click the square connector on the left edge of this second PDF Renderer.

4 Hold down the mouse button, and drag it up to the round connector on the 
right side of the Impose component in the Main Output flow.

A connecting line extends between the two components, and is colored 
green, indicating that this is a valid connection.

5 Release the mouse button.

You now have the start of a second flow, extending from the first.

6 Add a Proofer output component to the second flow.

7 Add a Press to the end of the second flow.

Notice the Flow Identifier at the end of the second flow: It automatically 
indicates that this is an Imposition Proof flow.

8 Click the Flow Identifier to display the name of the flow.

 To add a Page Proof flow

When included in a Production Plan, a Page Proof flow should branch from the 
Main flow after the Run List and before the Impose component. 
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NOTE: You always need a Run List if you want to select individual pages for 
proofing.

1 Select a third PDF Render component, drag it the Production Plan Compo-
nents pane, and drop it exactly below the PDF Renderer in your Imposition 
Proof flow.

2 Click the square connector on the left edge of this third PDF Renderer.

3 Hold down the mouse button, and drag it up to the round connector on the 
right side of the Run List in the Main Output flow.

A connecting line extends between the two components, and is colored 
green, indicating that this is a valid connection.

4 Release the mouse button.

5 Add a Proofer output component to the third flow.

6 Add a Press to the end of the third flow.

Notice the Flow Identifier at the end of the third flow: It automatically 
indicates that this is a Page Proof flow.

7 Click the Flow Identifier to display the name of the flow:

NOTE: When Page Proofs are printed on a large format proofer, a simple 
media saving page layout should be used. To get as many pages on a sheet as 
possible, you must switch on the media optimization feature in the output 
device.

 To control your Production Plan using Actions

Finally, you need to insert some Actions in your Plan to control the sequence of 
events when a document is processed.
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 Insert two Hard Copy Proof Actions in the Main flow, one immediately before 
the Impose component and one immediately after it.

Your Production Plan should look like this:

You now have a multiple flow Production Plan, which allows you to first 
check and approve a page proof, then an imposition proof, and finally to 
output your job to an imagesetter. 

This works as follows:

 Page Proof: A document is input and the job results are held in the main 
flow just before being imposed. However, the results are also passed on to 
the Page Proofing flow, where they are rendered and output to a Page 
Proofer. The Page Proof allows you to check colors and content.

 Imposition Proof: If you approve the Page Proof, the results which are on 
hold at the first point in the main flow are resumed, and the job is 
imposed. After this, the job results are again held in the main flow. 
However, they are also passed on to the Imposition Proofing flow, where 
they are output to an Imposition Proofer. The Imposition Proof allows you 
to check the layout of the job.

 Print to Imagesetter: If you approve the Imposition Proof, the results 
which are on hold in the main flow are resumed again, and the job is 
finally output to an imagesetter.

Exporting Job Results

When you build a Production Plan, you may simply want to export your job 
results to file, instead of sending them to an output device. In this case, you need 
to add the Export component to the end of your Production Plan flow.

Export allows you to export processed job results to a specific directory in PDF or 
PostScript file format. These files can then be used outside the Apogee environ-
ment. For more information, refer to “Export Settings” on page 886.
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 To export job results

1 Create a new Ticket, and select the Plan tab.

2 Create a single Main Output flow, adding some basic input and processing 
components. For example, you could add the following:

Hot Folder - Normalize - Run List - Impose

3 Select the Output tab in the Production Plan Components pane, and select 
the Export component.

4 Drag the component to the Production Plan pane, and add it to the end of 
your flow.

Your flow should look like this:

5 Select Export and enter the export settings you require, as described in 
“Export Settings” on page 886.

Submitting Tickets When you have completed the information in Using the Administration Tab, 
Using the Options Tab, and Using the Plan Tab, you are ready to send your Ticket 
to the Apogee System. This process is referred to as submitting a ticket. You may 
do this when you create a new Ticket and send it to the Apogee System for the 
first time, or when you open an existing Ticket for editing, and send the updated 
Ticket to the Apogee System. 

NOTE: When you submit a ticket, Apogee automatically reprocesses only the 
required results. This is different from using the Re-render command, which re-
renders only the results that follow the selected editing point in the Production 
Plan.

 To submit a ticket

 From the Ticket Editor window, choose File > Submit Job.

This process takes a few moments.

If your Production Plan is valid, you will be able to see your ticket either in 
the Hot Tickets window (Hot Tickets), or in the Jobs window (Job Tickets). 
The name of the ticket will be the same as the Order Number you specified in 
the Administration tab.
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If your Production Plan is not valid, the Problem Report is displayed, 
indicating where the problem is. For more information, see “Problem Report” 
on page 166.

Opening a Ticket You can open an existing ticket as follows.

 To open a ticket

1 Choose File > Open. (CTRL+O).

2 Locate the folder where your tickets are stored, select a ticket, and click OK.

Ticket files can be recognized by their .ajt filename extension.

Saving a Ticket You can save a Ticket to file for future use. When you save a Ticket, the Ticket is 
exported from the Apogee environment, and is stored as a file in the specified 
save location. 

Apogee Ticket Icons in Windows Explorer

You can see the saved Ticket files using your local file system. The icons and file 
extensions vary according to the type of Ticket:

 To save a ticket

1 Create or modify your ticket as described in “Creating or Editing a Ticket” on 
page 340.

2 Choose File > Save (CTRL+S) or File > Save As...

3 Browse to your Tickets folder, enter a filename, and click Save.

4 If you have customized the default location of the Tickets folder, open your 
Preferences (choose Edit > Preferences...) to check the folder location.

Creating a Public 
Page Store

To create a Public Page Store, you must start from a blank Public Page Store 
template.

Saved Commercial Job Ticket(.ajt)

Saved Commercial Hot Ticket(.aht)
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 To create a Public Page Store

1 Create a new Job Ticket from a Blank Page Store Job template.

2 In the Administration tab, enter a Public Page Store name.

3 Select the Plan tab, and build your Production Plan, ending with the Page 
Store component.

In a Page Store ticket, only the following Task Processors are valid:

 All Input Task Processors

 Normalize

 Preflight

 Page Store

NOTE: The Page Store component can be found in the Output tab, and is only 
available when you are creating a job based on a Blank Page Store Job 
template.
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For example, you can add the following components to your Production 
Plan:

Hot Folder - Normalize - Page Store

4 Select Normalize.

5 In the Settings pane, you may need to click the Unlock button so that you can 
edit the Normalize settings.

6 Select the PDF Processing tab.

7 Deselect the ‘Convert all Pantone color names to’ check box.

You cannot select the ‘Follow Press’ option, since a Press Task Processor 
cannot be used.

8 Submit the job.

The new Page Store will appear in the Public Page Store section of the Jobs 
List. You can input documents to it in the same way you input documents to 
a standard Job Ticket Hot Folder. These documents will be available to all 
users.
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Inputting Documents

The final step in job creation is inputting the documents that will become your 
job data. There are several different ways of doing this, using a variety of input 
channel types. These input channels specify the locations or methods which you 
will use to print or drag the documents that you want to input to the Apogee 
System. 

There are two basic types of input channel. You should choose the method(s) 
which best suit your hardware platform and working environment:

 File-based input: This type of input is based on dragging files directly to jobs 
in the Job List or Hot folders in the Hot Folders list. You can also copy files to 
the specific folders associated with the following types of input channels:

 Hot Folder and Open Connect input channels make the input documents 
available only to a single job (this is referred to as a Private Page Store ).

 PrintSphere Upload is similar to a Hot Folder input channel but files are 
uploaded to a cloud service by the collaborators of a job who are invited 
by e-mail.

 Public Page Store channels make all input documents available to all jobs.

 JDF Import channels allow you to input JDF files generated by 3rd-party 
applications (such as MIS systems), and convert them to Apogee Job 
Tickets.

These types of input channels can be assigned specific polling times.

 Stream-based input: This type of input is based on printing jobs directly from 
your front-end applications. For this, you need to define printers associated 
with the following types of input channels:

 Named Pipe channels allow you to print jobs to the Apogee System 
directly from your Windows front-end applications. 

 TCP/IP input channels allow you to send jobs to the Apogee System via 
the Internet.

NOTE: By default, any stream-based input channel is spooled (written to 
disk). To enable spooling, the Keep Results Action is automatically added to 
all Input components.
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Inputting via Hot 
Folder / JDF Import 
/ Public Page Store

After you have successfully created a ticket and built a Production Plan as 
described in “Working with Job Tickets and Hot Tickets” on page 339, you are 
ready to start inputting documents.

 To drag a file directly to a Job or Hot Ticket

1 Locate the document(s) that you want to input.

These may be PostScript, EPS, or PDF files. If they are PDF files, then they 
must be “high-end” PDF files.

2 Drag your input documents directly to a job in the Job List or to a Hot folder 
in the Hot Folders list.

3 If you want to monitor the process, open the Activity window.

For more information, see “Monitoring Jobs” on page 195.

When your documents have been processed, either open or switch to the Jobs 
window to view them. For further information, see “The Job List” on page 143.

 To drag a file to an input folder

1 Locate the document(s) that you want to input.

These may be PostScript, EPS, PDF, or JDF files. If they are PDF files, then 
they must be “high-end” PDF files.

2 Locate the folder you associated with this input channel.

The input channel may be a Hot Folder, a JDF Import channel, or a Public 
Page Store folder.

TIP: You may want to create 
a shortcut to your Hot Folder 
on your desktop.

3 Drag your input documents to the folder.

Apogee polls all configured input folders, and automatically picks up all 
documents that are dropped in any of them. 

4 If you want to monitor the process, open the Activity window.

For more information, see “Monitoring Jobs” on page 195.

When your documents have been processed, either open or switch to the Jobs 
window to view them. For further information, see “The Job List” on page 143.
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Inputting via 
PrintSphere

A PrintSphere job includes the PrintSphere Upload task processor in the Produc-
tion Plan, on its own or with another input task processor. For such jobs, you can 
invite an uploader to upload files for the job at hand, or collaborators can be 
assigned to the job when you select the company. PrintSphere is a cloud service, 
hosted by ECO3 Graphics, which allows easy file transfer between the different 
collaborators of a job: customers, designers, remote sites, etc. See the 
PrintSphere online help and technical documentation for more information.

 Invite uploaders to input files via PrintSphere

This procedure explains how to invite one or more persons to upload files for the 
job at hand (i.e. guest mode). These uploaders do not have to be known collab-
orators of a company. The job must have a PrintSphere Upload task processor in 
the Production Plan.

1 Context-click the PrintSphere job in the Job List and choose Invite 
PrintSphere Uploader.

2 Enter the E-mail address of the person you want to invite. You can enter 
multiple e-mail addresses by separating them with a comma. You can also 
select a Language for the e-mail. The Subject field is filled in automatically 
with the name of the job. The URL is a link to the location where the files can 
be uploaded which is generated automatically by the PrintSphere service.

3 Click Send to send the message to the uploader.

The uploader receives an e-mail with the URL where he can upload files for 
the current job. Uploaded files appear in the Page Store of this job.

Inputting via 
Named Pipe

To print a job directly from a Windows front-end application, you should use a 
Named Pipe input channel. Before you can do this, you must first create a print 
queue to the Named Pipe input channel on your Windows Server. You will also 
need to share this queue on your network.

NOTE: The Named Pipe print queue is not automatically created when you install 
Apogee.

To complete this procedure, you need your printer's PPD and oemsetup.inf files.

 To create a print queue to the Named Pipe input channel

1 Make sure that the Apogee System is running.

2 Open the Control Panel on the machine on which the Apogee System is 
running.
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3 Select Printers.

4 Double-click Add Printer.

The Add Printer Wizard is started.

5 Click Next.

6 Choose Local Printer, deselect Auto Detect, and click Next.

7 Click Create a New Port.

8 Select Local Port from the Type list, and click Next.

The Port Name dialog box is displayed.

9 Enter the Named Pipe name, preceded by \\.\pipe.

For example: \\.\pipe\Apogee

10 Click the OK button.

The Named Pipe name is defined in the settings of the Named Pipe compo-
nent. The default name is “Apogee“. You should type this string exactly as 
shown above, since the text is case-sensitive.

NOTE: The Apogee System must be running before you can create this port. 
Otherwise, you will get an “invalid port name” error message.

The Printer Ports dialog is displayed again.

11 Click Close.

The Apogee Named Pipe channel should now appear in the list of ports.

12 Select the Named Pipe channel, and click Next.

A list of printer manufacturers and models is displayed.

13 Click Have Disk.

NOTE: To select your printer manufacturer and model, you need both your 
printer's oemsetup.inf file and the printer's PPD file. These files should both 
be located in the same folder.

14 Browse to the folder which contains your printer's oemsetup.inf and PPD 
files.

15 Select the Oemprint.inf file, and click Open.

16 Click OK.
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The following dialog indicates the name of the printer associated with the 
selected PPD file.

17 Select the printer, and click Next.

18 Enter a name for your printer.

19 If you want this to be the default printer for your Apogee System, click 'Yes', 
and then click Next.

To allow users working on other network workstations to access the printer, 
it must be shared on the network.

20 Click 'Shared', enter a Share Name, and click Next.

The Share Name can be the same as the printer name.

21 If you want to print a test page, click 'Yes', and then click Finish.

The Wizard starts to install the necessary printer files.

To create the printer, Windows needs the PSCRIPT.DLL file.

22 Insert your Windows 2003 CD, and browse to the I386 folder.

23 Select the Pscript.dll_ file, and click Open.

24 Click OK.

The Installer finishes, and the new printer appears in the Printer window.

 To input a document using a Named Pipe or TCP/IP channel

1 Start from your front-end application.

2 Select the Named Pipe or TCP/IP printer you created earlier.

3 For a spooled queue, set up the printer with the Apogee.PPD.

NOTE: The Apogee.PPD is copied to the shared Apogee SupportFiles folder 
during installation of the Apogee System.

4 In your page layout program, select the Apogee.PPD.

5 Turn Background Spooling on or off (depending on whether or not you set 
up spooling for this channel).

6 Ensure that separations and registration are turned off.

7 Locate the document(s) that you want to input.

8 Print the document(s).
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9 If you want to monitor the process, open the Activity window.

For more information, see “Monitoring Jobs” on page 195.

10 When your documents have been processed, either open or switch to the Jobs 
window to view them. For further information, see “The Job List” on 
page 143.

Inputting via TCP/
IP

To send jobs to the Apogee System via the Internet, you should use a TCP/IP 
input channel. Before you can do this, you must first create a print queue to the 
TCP/IP input channel on your Windows Server. You will need to set up a name 
and port number. You will also need to share this queue on your network.

The TCP/IP print queue is not automatically created when you install Apogee. 
You need to create it yourself using the Adobe PostScript driver, as described 
below.

 To create a print queue to the TCP/IP input channel

You first need to create a TCP/IP port:

1 Choose Start > Settings > Printers.

2 Choose File > Server Properties.

3 Choose the Ports tab, and click Add Port.

4 Double click Standard TCP/IP Port.

5 Click Next.

6 Enter the IP address of your server in the Printer Name or IP Address field.

TIP: If you do not know the IP address of your Apogee Server, choose 
Start > Run on the Apogee System, type cmd in the Open field, and click OK. 
Then type ipconfig and press Enter.

7 Click Next.

This process may take a while.

8 Choose Custom, and click Settings.

9 Leave the protocol on Raw, enter the port number you specified for Apogee, 
and click OK.

10 Click Next.
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11 Click Finish.

12 Click Close twice.
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Interactive Document Content Editing

There are two ways that you can edit documents which belong to Apogee jobs:

 External Editing: External or Non-Interactive document editing is performed 
outside Apogee, typically for major content changes in applications such as 
QuarkXpress or InDesign. The document is then re-submitted to the Apogee 
system, where a new revision of that document is created. In combination 
with Apogee revision handling, this is the safest way of editing documents.

 Interactive Document Content Editing: This type of editing is performed 
directly on the document from within Apogee. This is done by double- or 
context-clicking an Apogee result to open the document in Acrobat. Using the 
Apogee Check-Out/In plug-in for Acrobat or any other PDF Viewer/Editor 
application such as the Amfortis Editor, documents can be edited directly 
within the Apogee job. This saves time since the document does not have to 
be re-submitted. Note that Interactive Document Editing requires full user 
attention! Misuse may lead to unexpected results.

Interactive Document Content Editing is used to edit documents before they 
reach the Run List in the Production Plan. In this case, a new revision of the 
document is created in the Run List. This is typically designed for minor changes 
such as small text edits or typos. Since the Page Store is related to the Run List, 
you can also edit results that are ‘Run List ready’ (no page processing activity). 

NOTE: The Check Out/Check In plug-in must be installed in order to perform 
interactive document editing. This is included in the Apogee Trap Spotter plug-
in.

Checking Out 
Documents

When you view a result in Apogee it is opened in your PDF viewer. If you want 
to edit the result you need to first ‘check it out’. This is done by selecting the 
Apogee Check-Out option in Acrobat.

When you Check Out a document:

 Apogee locks the job. The job will go on hold and all new job processing will 
be suspended.

 The job has a status icon which indicates that it is being edited.

 In the Run List / Page Store, you will see the ‘document is being edited’ status 
icon next to the job.
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 The Edit Job tool in the Apogee toolbar is disabled. 

NOTE: Even if you only edit one page of a document, all pages of that document 
will receive the ‘document is being edited’ status in the Run List and Page Store.

Checking In 
Documents

After editing, you need to select the Apogee Check-In option to save your 
changes in Apogee. This is done by selecting the Apogee Check-In option in 
Acrobat.

When you Check In a document:

 Apogee unlocks the job, and the job will resume processing.

 The ‘Edit Job’ status icon is removed.

 A new revision of the document is saved in the Run List / Page Store, and you 
will see the ‘document has been edited’ status icon next to the job

 The Edit Job tool in the Apogee toolbar is enabled again. 
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WebApproval Job Tickets

WebApproval is a web-based proofing service that gives users (your customers’ 
staff or your own staff) remote access to jobs for uploading documents, 
reviewing soft-proofs, and approving pages. A WebApproval job ticket has two 
flows: the production flow for printing the job and a display flow to create the 
remote soft-proof for the ProductionCenter web portal.

 Create a WebApproval job ticket

1 Create a ticket with a main flow and a flow with the Display task processor. 
The Hot Folder in the main flow must have the Web-enabled check box 
selected. The main flow typically has a Wait for Results action that holds the 
results until the required pages have been approved in ProductionCenter.

2 In the display flow, place a Web Proof action before the Display task 
processor.

3 In the Administration tab, select a Company and the staff you want to assign 
to the jobs. Also choose one of the Publish options in the drop-down list.

NOTE: Refer to the tutorials for more details on creating basic to complex 
WebApproval job tickets.

Related topics: • Using the Administration Tab on page 284
• Hot Folder on page 724
• Web Proof on page 318
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Impose

This section introduces Apogee Impose, an integrated imposition editor that 
enables you to create the imposition for a job within Apogee.

 About Apogee Impose ....................................................................................... 370
 Auto Impose Window ........................................................................................ 377
 Product View ......................................................................................................... 386
 Press Sheet View ................................................................................................. 415
 Inspector ................................................................................................................ 432
 Mark Sets Inspector ........................................................................................... 450
 Snag List ................................................................................................................. 452
 Page Previews ...................................................................................................... 454
 Imposition Reports ............................................................................................. 455
 Menus ...................................................................................................................... 460
 Imposing Multi-Product Jobs ......................................................................... 462
 Imposing Digital Products ............................................................................... 464
 Imposing Multi-Up Products ........................................................................... 466
 Imposing Web Production Jobs ..................................................................... 469
 Imposing Unbound Products .......................................................................... 476
369



370 ABOUT APOGEE IMPOSE
About Apogee Impose

Apogee Impose is a rules-based system for creating imposition jobs quickly and 
efficiently with Apogee. Apogee Impose arranges the pages of a job for imposi-
tion and places all the required marks on the press sheet. A job may consist of a 
single Product or multiple Products (i.e. a multi-product job).

The Parts and Pages of a Product are assembled automatically, based on a 
number of rules which are specific to your production environment. Alterna-
tively, you can create or edit the imposition manually. When the imposition is 
ready, Apogee Impose creates the Production Sets required for printing the job.

Marks can be placed manually or automatically based on rules and conditions.

An intuitive graphical interface, also referred to as the Imposition Editor, lets 
you inspect and edit the imposition and printing marks of your Product 
interactively.

NOTE: Apogee Impose is activated if you choose this option in the Impose 
parameter set of your Plan and if you have the required license.

Related topics: • Using the Products Tab on page 295
• Creating or Editing a Ticket on page 340

A Product and its 
Parts

To work with Apogee Impose you must first define a Product and its Parts in the 
Products tab. The Products tab is available if you included an Impose Task 
Processor in your production plan.

You first need to choose from one of the top level Product types:

 Bound Product: consists of book signatures that need to bound; can be a 
single Part or several Parts, e.g. a cover and the body pages; typical examples 
are brochures, magazines, catalogs, etc.

 Unbound Product: flats containing unrelated content elements (e.g. 
different business cards) or a Product that only needs to be folded (e.g. a 
leaflet, gatefolds and other complex folded jobs)

 Calendar: for pages that need calendar-style options such as flipping over 
leaves or spreads from top to bottom pages
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 Sign and Display: for Sign and Display products.

NOTE: Do not select this type manually. These type of products are created 
and used by the Layout Editor.

Within these categories you can choose a Product preset from the Product drop-
down list (e.g. a standard publication type) or you can create a Product from 
scratch.

A Product defines a number of settings that are inherited by its Parts, such as the 
binding style and paper stock, but these settings can be modified for each Part 
individually as you add the Parts to your Product.

Figure 8.5: The Product Inspector
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A Product and its Parts can also be defined in the Templates dialog box if you 
create your job from a template. You can also choose to create multiple Products 
for a job by entering a number in the Quantities panel.

Figure 8.6: The Part Inspector
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Related topics: • Product Inspector on page 299
• Part Inspector on page 302

Automatic and 
Interactive 
Imposition

Apogee Impose provides a choice of automatic mode (Auto Impose) or interac-
tive or manual mode for creating your imposition. You choose Auto Impose if 
your imposition rules have been set in advance for a typical job, and interactive 
if you want to create the imposition manually from scratch. 

If your job has been set up correctly with an Impose Task Processor, you will see 
the following two buttons in the Imposition pane of the Products tab: 

 Auto Impose

 Edit Imposition

Clicking the Auto Impose button for automatic imposition, opens the Auto 
Impose editor in the Print & Fold tab, where you can select the Press, Press Sheet 
size, and Workstyle for each part type (Cover, Plain, Insert, etc.). By default, all 
part types are selected, so you specify the same settings for all parts. You select 
the Auto Impose Rule that defines the arrangement of the imposition in the 
Rules tab.

Figure 8.7:  Product and Parts in the Templates dialog box
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You then review the imposition in the Product View.

Figure 8.8: The Auto Impose Editor (job with multiple Products)

Figure 8.9: The Product View after clicking Impose in the Auto Impose editor (job with a 
single Product)
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Clicking Edit Imposition in the Auto Impose editor takes you directly to the 
Product View where you can create your imposition interactively or still choose 
to open the Auto Impose editor.

The following sections give an overview of the Auto Impose windows, the two 
main views, and the palettes you see once you have defined your Product and 
choose to view or edit the imposition:

 “Auto Impose Window” on page 377

 Views:

 “Product View” on page 386

 “Press Sheet View” on page 415

 Palettes:

 “View Options” on page 416

 “Marks Palette” on page 427

 “Inspector” on page 432

 “Mark Sets Inspector” on page 450

Figure 8.10: The Product View after clicking Edit Imposition to create the imposition 
interactively (job with a single Product)
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 “Snag List” on page 452

 “Positioning Palette” on page 480

 Quick Access to the Product and Press Sheet Views

The following shortcuts provide quick access to the Product View or Press Sheet 
View.

 Re-use an imposition

You can create a new job with the same imposition you created interactively or 
automatically for an existing job.

 Select a job whose imposition you want to re-use in the Job List and choose 
File > New From Selected.

The Job Ticket Editor opens with an empty Administration tab for you to fill 
in for the new job ticket. The imposition and plan are the same as the selected 
job. See “Creating a New Job from an Existing Job” on page 202.

To... Press (Windows)

Select a job in the Jobs List and jump to the Product View CTRL + SHIFT + Enter

Jump to the Product View while in the Job Ticket Editor CTRL + SHIFT + Enter

View a flat you selected in the Results tab in the Product View CTRL + SHIFT + Enter

View a flat you selected in the Results Preview in the Product View CTRL + SHIFT + Enter

Return to the Job Ticket Editor from the Product View ALT + F4

Close the Product View and submit the Job Ticket CTRL + SHIFT + G

Jump to the Press Sheet View from the Product View, with a Press 
Sheet selected in the Press Sheet or Press nodes 

CTRL + Enter
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Auto Impose Window

Clicking the Auto Impose button in the Products tab opens the Auto Impose 
window where you define the settings for automatic imposition.

This window has the following tabs:

 Print & Fold Tab: In this tab you select a Press and related settings, and the 
Folding Scheme set for each part.

 Number-Up tab: In this tab you can select a Number-Up scheme to combine 
parts or products on the same Fold Sheet (see “Number-up Schemes” on 
page 1098). This tab is disabled and not displayed if a number-up binding 
style has been selected for the product in the Binding Options.

 Rules Tab: In this tab you select the Auto Impose Depending on the imposi-
tion type, this tab either refers to the Auto Impose Rules resource (for 
Standard Offset), or you specify the settings directly in the tab (for digital 
printing modes: Cut & Stack, Booklet, Step & Repeat). The rule applies for all 
parts.
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This window can also be opened from the Product View to edit your Auto Impose 
settings or to switch from manual imposition to Auto Impose.

NOTE: The Auto Impose window has fewer settings for web printing.

Imposition Type Here you can choose the basic mode of the imposition for Bound jobs:

 Standard Offset: The regular imposition mode which is generally used for 
offset printing and displays the Folding Scheme Selection panel in the Print 
& Fold tab.

 Cut & Stack: The pages on a press sheets of a Cut & Stack imposition are cut 
and then put on top of each other to obtain the correct page sequence.

 Booklet: The press sheets form stacks of two-by-two page spreads that can be 
folded in the middle and then collected to create a booklet. Book signatures 
can be created to allow for the maximum folding thickness.

 Step & Repeat: Pages are duplicated on the press sheet which is cut to create 
2 or more products.

The latter three modes are specifically for digital printing but may also be used 
for offset printing. For multi-product jobs, the digital printing modes always 
keep products apart so you cannot combine parts from multiple digital products 
on the same press sheet.

NOTE: Some of these options may be licensed features for Bound jobs. Unbound 
jobs are set to Standard Offset as the other options are not applicable.

Related topics: • Imposing Digital Products on page 464

Preserve (Only enabled for Standard Offset) The Preserve options allow you to keep 
certain parts of the imposition as is when using Auto Impose:

 Fold Sheets: Preserves the existing fold sheets and the corresponding book 
signatures. Folding schemes are selected for the unassigned parts of the 
assembly and the rest of the imposition is created. This method can be used 
to preserve parts of the assembly and let Apogee Impose split the rest: assign 
a fold sheet to only those parts of the assembly you want to preserve, and 
then run Auto Impose with this check box selected.
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 Assembly: Preserves the current assembly, i.e. the current arrangement and 
size of the book signatures. Folding schemes are selected to complete the 
imposition. You may have to adjust the assembly if it is too large.

 Already imposed items: Preserves the imposition of parts that have already 
been assigned to press sheets. Apogee Impose determines the book signa-
tures, fold sheets and press sheets for unassigned parts.

Print & Fold Tab The table lists all the parts in your product with a summary of the settings. 
Clicking a part allows you to edit the settings in the panes below. The list is 
updated as you define the settings. Parts with the same settings that can be 
printed on the same Press Sheet are grouped and appear together on the same 
line. This is also the case for multi-product jobs where parts from different 
products can be grouped together if their printing settings are compatible.

Keep single and double-
sided printing parts apart

Select the check box if you do not want to group single-sided and double-sided 
elements for printing on the same Press Sheets.

The panel on the left shows the details of the selected part or the individual parts 
of a parts group as defined in the Product and/or Part inspectors. On the right 
you have more settings that need to be completed before you can create the 
imposition:

Print on Press A drop-down list with the names of your Presses. If you have not chosen a Press 
in the Production Plan, this field is blank and you must choose a Press here.

Sheet Size A drop-down list with all available Press Sheet sizes. The last item in the list, 
Manage Sheet Sizes, is a shortcut to the Sheet Sizes resource.

The width and height (W x H) of the Press Sheet are displayed under the drop-
down list. You can also edit these fields to create a custom Sheet Size and save 
this custom size by choosing Save As in the drop-down list.

NOTE: If you choose a web press, you can only define the width.

Press sheet layout A drop-down list with all the available press sheet layouts. Initially, the default 
sheet layout as specified for the chosen press is selected (from press). You can 
choose a different layout and revert to the default by clicking the revert icon. 
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Main workstyle Initially, the default main workstyle as specified for the chosen press is selected 
(from press). A drop-down list with workstyles:

 Sheetwise: A sheet has different content on front and back sides. The sheets 
are turned, keeping the gripper edge at the same side.

 Work And Turn: Both sides have the same content. The sheets are turned, 
keeping the gripper edge at the same side.

 Work And Tumble: Both sides have the same content. Sheets are turned in 
such a way that the gripper edge is on the opposite side.

 Perfecting: A sheet has different content on front and back sides. Sheets are 
turned in such a way that the gripper edge is on the opposite side.

 Single Sided: There is only one side per sheet.

Initially, the default workstyle as specified for the chosen press is selected 
(from press). You can specify another workstyle for the job. This chosen 
workstyle is used for all Press Sheets of the part, unless an alternative 
workstyle is applied by the Auto Impose Rule (see “Auto Impose Rules” on 
page 953).

Side lay Initially, the default side lay as specified for the chosen press is selected (from 
press). You can specify the Operator or Drive side for the job.

Folding scheme selection (For Standard Offset only) A drop-down list with Folding Scheme sets and 
individual Folding Schemes. You can choose a set from which Apogee Impose 
will select the most appropriate schemes while taking the selected Auto Impose 
Rule into account. Alternatively, you can choose a specific Folding Scheme that 
you may prefer for a particular job. Choosing a set displays the available sizes 
under the drop-down list.

The default is the set at the top of the list. The last item in the list, Manage 
Folding Schemes, is a shortcut to the Folding Schemes resource.

NOTE: There is no option to choose a Folding Scheme as this is not applicable for 
Unbound products.

NOTE: For web printing, you need to choose a Web Production Scheme.
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Number-Up tab This tab is only displayed if you have not selected a number-up binding style for 
the product in the Binding Options. It allows you to create slots on the Fold 
Sheets where you can place different book signatures from the same or multiple 
products. See “Number-up Schemes” on page 1098 for more information.

Main Number-Up Scheme Select one of the schemes from the list. 1-up (default) means that no special set-
up applies and you cannot combine parts of the same or multiple products. 

Combine products Select/clear this check-box if you want/don’t want Auto Impose to combine the 
parts of multiple products on the same Fold Sheet. Auto Impose will always try 
to combine the parts of multiple products in the same job.

Product/Part - Delivery Selecting a scheme in the Main Number-Up Scheme box lets you inspect how the 
products and parts are assigned to the deliveries (A, B, C, etc. and color-coded). 
You also see the actual and the requested copy counts separated with a slash and 
in blue if these two counts do not correspond. Deliveries are parts that are not 
necessarily combined to create the same product. 

Scheme Assignment The panel on the right shows the product assembly blocks (#1, #2, #3, etc.), the 
actual copy count per delivery and the number of deliveries (A, B, C, etc. and 
color-coded) for each assembly block. The assigned scheme is taken from the 
Main Number-Up Scheme selected above but you can override it here.
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Rules Tab 
(Standard Offset)

In this tab you choose a predefined resource to impose all the parts of the job. 
Different rules can be chosen for Bound and Unbound products.

Bound Products

Auto Impose Rule A drop-down list of rules (see “Auto Impose Rules” on page 953) that control 
which Fold Sheets can be used for the job, whether an alternative workstyle is 
required and how book signatures are sorted in the assembly. The name is 
usually shorthand for the main characteristics of the rule. The specified Auto 
Impose rule is for all the parts of the product.

Unbound Products

Imposition Mode Choose how to fill sheets

 Produce requested number of wanted copies: the imposition uses the 
copy counts as absolute values and the run length is calculated for each 
press sheet in order to obtain the copy count.

 Fill sheet, using copy count as ratio: the sheets are filled with as many 
elements as possible using the copy counts of the parts as ratio; the 
created press sheets have a run length equal to 1.

NOTE: If you choose the latter imposition mode, it is recommended to 
select an auto-fit rule that uses the Fewer sheet layouts strategy, and set the 
Allow extra printed material to Whatever it takes.

Auto Fit Rule A drop-down list of rules (see “Auto Fit Rules” on page 949) that control the 
arrangement of elements on the Press Sheet and when and how the elements are 
rotated. The name of the rule is usually shorthand for the main characteristics of 
the rule. Under the rule name you see the auto fit strategy and, depending on the 
selected rule, a slider to indicate the number of extra printed copies that you 
want to allow in order to reduce the number of Press Sheets (Allow extra printed 
material), or a field to enter a percentage of the allowed waste (Keep waste 
below).
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Rules Tab (Cut & 
Stack)

In this tab you specify the rules for imposing the pages on the press sheet so they 
can be cut and then stacked in the correct sequence.

Sequence

Lowest Folio Select one of the four corners to set the starting point for the pages in the page 
arrangement grid. If the grid has more columns or rows, the stacking order 
continues in the same direction.

Stacking Order You can choose from two stacking orders for each Lowest Folio position:

 Horizontally: To cut all columns apart and stack them on top of each other. 
Then repeat in the other direction.

 Vertically: To cut all rows apart and stack them on top of each other. Then 
repeat in the other direction.

Rotate Pages

You can let Apogee Impose rotate pages automatically to make them fit on the press 
sheet, or you can force pages to not rotate, or to rotate 90° clockwise, 90° counter-
clockwise, or 180°.

Split into Book Signatures

Select the Limit number of press sheets to check box to split large jobs into 
smaller signatures so the stacks of sheets can be cut. Enter the maximum number 
of sheets to stack.

Figure 8.11:  Horizontal stacking order selected for Lowest Folio in top-left corner
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Gutter for Cutting

 Apply page trim margins at cut: By default, Apogee Impose positions the 
trim pages using the trim margins. You can disable the Apply page trim 
margins at cut, if the middle cut is good enough as a trim cut. 

 Extra gutter: Specify an extra amount of space to provide for cutting. 

Rules Tab (Booklet) In this tab you specify the rules for a page arrangement using two-by-two page 
spreads. 

Split into Book Signatures

Select the Limit number of press sheets to check box to split large jobs into 
smaller signatures so the stack of sheets can still be folded. Enter the maximum 
number of sheets to stack.

Multiple Page-Spreads

If more than one two-by-two page spreads can be placed on the press sheet, you 
have two options for filling the press sheet:

 Cut and Stack: Page spreads are arranged on the press sheet so they can be 
cut and stacked ready for finishing.

 Step and Repeat: Each page spread is duplicated and repeated to fill one 
press sheet; may result in more press sheets

Sequence (multiple spreads)

This setting is enabled if you choose the Cut and Stack arrangement for multiple 
page spreads: See “Rules Tab (Cut & Stack)” on page 383.

Gutter for Cutting

 Apply page trim margins at cut: By default, Apogee Impose positions the 
trim pages using the trim margins. You can disable the Apply page trim 
margins at cut, if the middle cut is good enough as a trim cut. 

 Extra gutter: Specify an extra amount of space to provide for cutting. 
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Rules Tab (Step & 
Repeat)

In this tab you specify the rules for duplicating and repeating pages to fill the 
press sheet. 

Rotate Pages

You can let Apogee Impose rotate pages automatically to make them fit on the press 
sheet, or you can force pages to not rotate, or to rotate 90° clockwise, 90° counter-
clockwise, or 180°.

Split into Book Signatures

Select the Limit number of press sheets to check box to split large jobs into 
smaller signatures so the stack of sheets can still be folded. Enter the maximum 
number of sheets to stack.

Gutter for Cutting

 Apply page trim margins at cut: By default, Apogee Impose positions the 
trim pages using the trim margins. You can disable the Apply page trim 
margins at cut, if the middle cut is good enough as a trim cut. 

 Extra gutter: Specify an extra amount of space to provide for cutting. 

Related topics: • Shingling Rules on page 1136
• Auto Impose Rules on page 953
• Sheet Layout Templates on page 1134
• Auto Fit Rules on page 19
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Product View

The Product View is the first window to be displayed when you create or edit an 
imposition. This view is the same for both interactive and Auto Impose modes.

This view visualizes the Product in a structure consisting of so-called nodes. At 
the top in the Assembly pane, you see the book signatures of the Product. In the 
Product pane below, you can see how the Product is broken down into Parts and 
how the Pages are assigned to Fold Sheets, Press Sheets and Presses. 

The Product View is a powerful interface where you can arrange the book signa-
tures in the Assembly, change the settings in each of the nodes, and assign 
Folding Schemes and Presses as required.

All changes made in this window are applied immediately and you are not 
requested to confirm editing actions.

NOTE: You define the basic structure of the Product, i.e. number of Pages and 
Parts, in the Job Ticket Editor and this cannot be modified here.

 The Product View can be opened in the Job Ticket Editor, by clicking the Edit 
Imposition or Auto Impose buttons in the Products tab, or from the Impose 
settings in the Plan tab.

 The Product View can also be opened directly from the Jobs window by 
selecting the job and pressing CTRL+Shift+Enter. This shortcut can also be 
used from various locations in the Job Ticket Editor: the Pages and Results 
tabs, and in Raster Preview.
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 Highlighting Nodes in the Product Structure

 Click a node or component in the structure to highlight the relationship of 
that particular component with other nodes in the structure.

For example, click a Page in the Product node to see where the page is 
located, from Part to Printing Plate.

Figure 8.12: Product View window

1 Assembly pane
2 Product pane
3 Toolbar 1

2

3
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 Inspecting Nodes using the Inspector

 With the Inspector open (CTRL+I), click a node to select it and view the 
settings in the Inspector.

You can change settings in the Inspector or by choosing a value in the drop-
down lists in the nodes.

Assembly Pane The Assembly pane shows how the different book signatures (BS), i.e. folded 
Fold Sheets, of the product are put together. In this pane you can define and 
arrange book signatures to suit production needs.

The Assembly displays the book signatures of a Product (BS1, BS2, etc.)with a 
name that corresponds with the respective Fold Sheet (FS1, FS2, etc.). These 
names are generated automatically together with the number of pages, and the 
start and end page of the book signature. A color code is used to indicate book 
signatures of the same Part, e.g. orange for Cover and light yellow for Body 
parts. Special color codes are used for certain kinds of jobs, e.g. JDF jobs.

Apogee Impose automatically creates separate book signatures for the different 
Parts of a Product.
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Assembly Types

There are two main assembly types and a mixed type:

 Nested for saddle-stitched products

 Stacked for perfect-bound products

 Mixed: a combination of nested and stacked products

1 Cover book signature (BS1)
2 Body book signatures (BS1 and BS2
3 Number of pages per book signature
4 Start and end page numbers of the book signature

4

3

2

1
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 Selecting Book Signatures

 Clicking in one or more of the book signatures highlights the pages of the 
book signature or book signatures and where these pages are located in the 
other parts of the Imposition window.

NOTE: Click in between two adjacent book signatures to select both book 
signatures or hold down the CTRL key to select multiple book signatures.

 Hover over two adjacent book signatures to see the number of pages of the 
two book signatures.

 Combining Book Signatures

 Click a book signature and drag it onto another book signature of the same 
part to combine them.

NOTE: A Folding Scheme needs to be applied to the newly created book 
signature.

 Click a book signature and drag it onto a book signature of a different part to 
combine them.
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 Splitting Book Signatures

1 Click the Split Assembly button in the Toolbar 

OR

press Alt with the cursor in the Assembly pane.

2 Click in the book signature to split as required.

NOTE: A Folding Scheme needs to be applied to the newly created book 
signatures.

Product Pane The middle section of the Product View displays the nodes of the Product where 
you can see how the Pages are assigned to Fold Sheets, Press Sheets and Presses.

 “Product and Pages” on page 392

 “Parts” on page 394

 “Book Signatures (hidden by default)” on page 395

 “Fold Sheets” on page 395

 “Press Sheet” on page 397

 “Press” on page 402

TIP: If you have many parts 
or products, choose 
View > Compact View for a 
better overview.

For multi-product jobs, all the Products are displayed under each other in the 
order they were created. 
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In each node you can see the settings for that particular node and you can also 
change these settings if necessary. When using Auto Impose, you may want to 
change the settings to fine-tune the imposition created automatically by Apogee. 
In manual mode, you will use the nodes more extensively to choose the appro-
priate settings. The same settings can also be inspected and changed using the 
Inspector.

Product and Pages

The Product node provides a summary of the Product definition: the name of the 
Product, Number of Pages, Type (e.g. bound), Binding (e.g. Nested), and Page 
Size (e.g. 210 x 297 mm).

Clicking the grey arrow on the right reveals the spine view of the Pages in their 
consecutive order with page numbers. The Parts are indicated in their respective 
colors.

1 Product with Pages
2 Parts
3 Book Signatures
4 Fold Sheets
5 Press Sheets
6 Presses with Printing Plates per 

Production Set

1

2

3
4

5

6
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Page Icons

Pages not assigned to signature (grey outline)

Pages assigned to signature (black outline)

Shingling applied (black arrows)

No shingling applied

Bleed (thick grey border on bleed side)

Glue zones (blue strips indicate non-image areas)

No spine (unbound product)

Double-sided part (unbound product - Fold Sheet node)
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Node Icons

 Modifying Shingling

If shingling was applied for the Product, you can change this behavior in this 
node.

 Select one or several Pages and drag one side towards the spine to disable 
shingling and away from the spine to re-apply shingling.

Parts

A product consists of one or more Parts, e.g. a Cover and a Body part. Each Part 
is identified with a name and color, and they are sorted in ascending order of 
their lowest page number. The default colors are orange for Cover and yellow for 
Body but other colors can be chosen when defining the product.

A Part may consist of several book signatures.

The following information is displayed but cannot be edited:

 Paper stock and weight

 Colors

 Page size

The initial node definition has been overruled (yellow background if only gutters and/or mar-
gins have changed).

The node contains an error that needs to be resolved.
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Book Signatures (hidden by default)

The book signatures in your assembly can also be shown as a column of nodes 
between the Parts and the Fold Sheet nodes. This is useful f or jobs using 
complex number-up schemes. You can show/hide this column by choosing 
View > Show/Hide Book Signatures.

Fold Sheets

This node shows the flat fold sheet and the folding scheme used to fold it. In 
general, different Fold Sheets are selected for different Parts.

The Fold Sheet node contains the following information:

 Fold Sheet Name: same numbering sequence as the Press Sheets so FS1 
corresponds with PS 1, FS2 with PS 2, etc.

 Folding Scheme (drop-down): the selected Folding Scheme is indicated in 
the top right corner.

 Fold Sheet with lowest page number (mirrored if this page is on the back)

The Fold Sheets are sorted by the lowest page number you see here.

 Book Signature icon with number of pages in Book Signature

1 Fold Sheet name
2 Folding Scheme
3 Blue triangle: top page
4 Fold Sheet
5 Book Signature and number of 

pages
6 Spine
7 Fold lines
8 Fold Sheet lay
9 Folding sequence

1

2

3
4

5

6

8

7

9

Apogee Reference Guide



396 PRODUCT VIEW
 Spine 

 Fold lines

 Top page after folding (blue triangle)

 Fold Sheet Lay (red corner icon)

 Folding Sequence: uses a special notation to indicate how many times and in 
which directions the sheet is folded

 Selecting a Folding Scheme

1 Hover over the Folding Scheme name in the top right corner and click in the 
black field to reveal a list of folding schemes.

The list shows all compatible folding schemes, i.e. those that match the 
number of pages in the book signature. 

2 Choose one of the Folding Schemes.

OR

Choose No Scheme to remove the current scheme.
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NOTE: Choosing No Scheme displays an error in the Assembly.

OR

Choose Auto Select to find the best matching scheme.

Changing a Folding Scheme automatically changes the arrangement of the 
pages on the Press Sheet.

 Assigning a Fold Sheet to a Press Sheet

 If a Press Sheet is empty, you can drag a Fold Sheet onto the Press Sheet to 
assign it to that Press Sheet.

Press Sheet

The Press Sheet nodes represent all the Press Sheets for the product. Each Press 
Sheet node displays the front and the back of the Press Sheet that contains one 
or more Fold Sheets. In this view you can see how all the pages of the product are 
arranged for printing.

Clicking a component within the node highlights the component throughout the 
product structure.
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The Press Sheet node contains the following information:

 Workstyle (drop-down):

 Sheetwise: A sheet has different content on front and back sides. The 
sheets are turned, keeping the gripper edge at the same side.

 Work And Turn: Both sides have the same content. The sheets are turned, 
keeping the gripper edge at the same side.

 Work And Tumble: Both sides have the same content. Sheets are turned 
in such a way that the gripper edge is on the opposite side.

 Perfecting: A sheet has different content on front and back sides. Sheets 
are turned in such a way that the gripper edge is on the opposite side.

 Single Sided: There is only one side per sheet.

 Web production schemes for web presses

 Press Sheet Lay: green icon which is lighter for the Back

 Press Sheet Sides: the Front and Back of the Book Signature; only one side for 
Work & Turn and Work & Tumble, or single-sided.

1 Press Sheet name
2 Workstyle
3 Paper stock, weight and size
4 Press Sheet
5 Fold Sheet
6 Lowest page no. (bright yellow)
7 Fold Sheet Lay
8 Press Sheet Lay

6

7

1

2

3

4

5

8
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 Fold Sheet Front and Back with page numbers

 Fold Sheet Lay: red icon which is lighter for the Back

 Paper Stock (drop-down): as set for the Product or Part

 Paper Weight (drop-down): as set for the Product or Part

 Press Sheet Size (drop-down): as chosen in the Auto Impose window

NOTE: When performing interactive imposition (Edit Imposition), none of the 
above settings are specified. The missing settings are indicated in red and need 
to be chosen interactively.

 Selecting a Workstyle

1 Hover over the Workstyle name in the top right corner and click in the black 
field to reveal a list of workstyles.

Work & Turn Press Sheet
Front = Back

Sheetwise Press Sheet
with Front and Back

1 Front
2 Back 

2

1
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NOTE: The default workstyle is Sheetwise.

 Selecting Stock Type

 Hover over the Stock Type name in the bottom left corner and click in the 
black field to reveal a list of compatible stocks.
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 Selecting Stock Weight

 Hover over the Stock Weight name in the bottom left corner and click in the 
black field to reveal a list of available weights for the selected stock.

 Selecting the Press Sheet Size

1 Hover over the Sheet Size in the bottom right corner and click in the black 
field to reveal a list of available weights for the selected stock.

2 Choose a preset Sheet Size from the list.

OR

Choose Auto Select to select the smallest available sheet size for the fold 
sheets.

OR
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Choose New to enter a new Sheet Size.

 Opening the Press Sheet View

 Double-click in the Press Sheet node to open the Press Sheet View and 
examine the sheet in more detail.

Press

The Press nodes on the right in the Product View represent the available presses. 
Each Press node displays the Press Sheets assigned to a particular press and the 
plates necessary to print the Front and the Back in the required process or spot 
colors. All of these book signatures belong to the same Production Set.

Clicking a component within the node highlights the component throughout the 
product structure.

The Press node contains the following information:

 Press name

 Press Parameter Set

 Press Sheet information: stock, weight, size, workstyle

 Press Sheet name (PS1, PS2, etc.) with an indication of the plates for Front 
and Back (if applicable), process colors and spot colors

1 Press name
2 Production Set
3 Paper stock, weight and size
4 Work & Turn Press Sheet
5 Sheetwise Press Sheet (Front)
6 Sheetwise Press Sheet (Back)
7 Plates
8 Press Sheet name

1

3

2

4

6

5

8

7
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Arranging Press Sheets on a Press

 Assigning a Press Sheet to a Press

 In the Press Sheet node, drag a Press Sheet side or the entire node onto a 
Press.

 Deleting a Press Sheet from a Press

 Click the Press Sheet (e.g. PS 1) and drag it out of the Press node.

OR

 Click the Press Sheet and press the Delete key.

Editing Press Settings

 Selecting a Press Parameter Set

1 Hover over the Press Parameter Set in the top right corner and click in the 
black field to reveal a list of Parameter Sets.

Parameter Sets for the selected Press are displayed.

2 Choose a Parameter Set or click Manage Parameter Sets to create a new set.

NOTE: Only compatible Parameter Sets are shown in the list.
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 Opening the Press Sheet View

 Select a Sheet in the Press node and click the Press Sheet View button in the 
toolbar at the bottom, to open the Press Sheet View and examine the sheet in 
more detail.

Example: Cover with Work 
& Turn workstyle and 
Body parts with Sheetwise 
workstyle assigned to the 
same press.

Example: Cover and Body 
parts assigned to different 
presses.

Example: A page selected 
in the Product node 
highlights the separations 
for that particular page.
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Toolbar The Toolbar at the bottom of the Product View provides quick access to common 
tasks and commands. These commands are also available on the main menu or 
by using shortcuts.

NOTE: The availability of the tools and buttons on the Toolbar depends on the 
node you select.

Each of these tools is described below.

Press Sheet View button. Select a Press Sheet or Press Sheet side in the Press Sheet or Press 
nodes and click this button to open the Press Sheet View and view the selected Press Sheet 
side.

Selection tool. Use this tool to select a component or area and display its properties. This is 
the default tool.

Split Assembly tool. Use this tool to split blocks in the Assembly.

Repeat tool. Use this tool to repeat selected components.

Auto Impose button. Click this button to perform the Auto Impose task, for example after rear-
ranging nodes or changing the properties of a Fold Sheet, Press Sheet or Press.

Rotate counterclockwise tool (only if Fold Sheet is selected). Rotates selected Fold Sheets 90 
degrees counterclockwise on the Press Sheet. 

Rotate clockwise tool (only if Fold Sheet is selected). Rotates selected Fold Sheets 90 degrees 
clockwise on the Press Sheet. 

Flip Over tool (only if Fold Sheet is selected). Flips the front and back of the selected Fold 
Sheet on the Press Sheet.

Shows/Hides the Inspector window

Shows/Hides the Mark Sets Inspector window.

Shows/Hide the Positioning palette

Submit button. Submits the job with the edited imposition.

Close button. In the imposition windows, saves your changes and closes the imposition win-
dow. Behavior is set in the Preferences.
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Arranging Fold 
Sheets on a Press 
Sheet

Apogee Impose enables you to drag and drop Fold Sheets onto a Press Sheet so 
you can rearrange the imposition interactively.

 Assigning a Fold Sheet to a Press Sheet

1 If a Press Sheet is empty, drag the Fold Sheet onto the front of a Press Sheet 
and the front of the Fold Sheet will be assigned to the front of the Press Sheet 
and the back of the Fold Sheet to the back of the Press Sheet.

Dragging the Fold Sheet to the back of a Press Sheet flips the front of the Fold 
Sheet to the back of the Press Sheet.

2 While dragging, press the spacebar to rotate the Fold Sheet counterclockwise 
in increments of 90 degrees.

 Rotating a Fold Sheet on a Press Sheet

1 Select the Fold Sheet you want to rotate by clicking it on the Press Sheet.

2 Drag the Fold Sheet until you see a dark blue insertion line.

3 With the Fold Sheet still selected, press the spacebar to rotate the Fold Sheet 
counterclockwise in increments of 90 degrees.

NOTE: The blue plus sign must be visible in order to rotate.

 Deleting a Fold Sheet from a Press Sheet

 Click the front or back of a Fold Sheet and drag it out of the Press Sheet node 
or press Delete.

 Adding multiple Fold Sheets to a Press Sheet

1 Drag your first Fold Sheet onto the Press Sheet.

The Press Sheet Layout Rule determines the position of the first Fold Sheet, 
e.g. Bottom Center.
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2 Drag your second Fold Sheet onto the Press Sheet.

The blue insertion bar is displayed to indicate the proposed position and 
orientation of the Fold Sheet. The bar is grey to indicate the position on the 
Back.

3 Drop the Fold Sheet where you want it on the Press Sheet, or with the Fold 
Sheet still selected, press the spacebar to rotate the Fold Sheet counterclock-
wise in increments of 90 degrees.

Repeating an 
Imposition across 
Press Sheets

If you have prepared the imposition and assigned a press for one Press Sheet, 
you can re-use the same arrangement for other Press Sheets. This is referred to 
as repeating an imposed Press Sheet and it can be useful when performing a 
manual imposition. Apogee Impose copies the following settings from the refer-
ence Press Sheet to the target Press Sheet:

 Press Sheet size

 Workstyle

 Press Sheet layout and manual edits
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 Press assignment

 Manual edits to Fold Sheet placements, gutters and margins

 Manually placed marks

 To repeat an imposition

1 Prepare your first Press Sheet; in manual mode this may involve the placing 
of several Fold Sheets on a single Press Sheet.

2 Click the Press Sheet to select it and choose Edit > Repeat Imposition.

The Repeat Imposed Press Sheet dialog is displayed with the selected Press 
Sheet in the top drop-down list as reference imposition.

3 In the second drop-down list, choose the Press Sheet you want to copy the 
imposition to.

If you selected a reference Press Sheet to start the procedure, you have three 
options:

 Selected item: the selected imposition will be used to copy the imposition 
to; if you choose this option, choose a different Press Sheet from the first 
list to copy from

 Part name: the imposition is re-used for all book signatures of that part

 Compatible parts: the imposition is re-used for all book signatures that 
are compatible with the reference Press Sheet

NOTE: If you didn’t select a reference imposition, you can only choose from 
the last two options.

4 Click Repeat.

All the settings of the reference imposition are copied to the other Press 
Sheets.
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Renumber Fold 
Sheets/Book 
Signatures

By default, fold sheets follow the same consecutive numbering as their respec-
tive book signatures, and BS 1, BS 2, BS 3, etc. corresponds with FS 1, FS 2, FS 3, 
etc. In certain production cases, e.g. the book signatures of a bound job at hand 
need to be combined with signatures from another job, you may want to take 
control of signature numbering to avoid confusion when finishing or to make 
sure the collation marks are correct. The Advanced book signature numbering 
option lets you renumber fold sheets.

 Renumber fold sheet/book signatures

1 Go to the product editor and select the Advanced book signature 
numbering option.

Selecting this option enables the numbering feature in the Fold Sheet 
inspector.

2 Click OK and edit the imposition.

3 Open the Inspector and select the fold sheet from which you want to change 
the numbering.

In the Signature numbering panel, you see that the numbering is set to 
Automatic as default.

4 Clear the Automatic check box to enable the following settings:

 Nesting level: Choose a nesting level from (Outer) 1 to 10 as required for 
the numbering. This generates a numbering notation with dot-separated 
levels. The digit after the last dot increments. This is only possible for a 
mixed assembly and not for a nested assembly, which only has one level. 
If the fold sheet is a cover, the nesting level is set to 0 (Cover) and the list 
is disabled.
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 Start numbering at: Enter a number that you want to start the numbering 
with. For level 1, this start number increments. For level 2 to 10, the 
number after the last dot increments. This option is disabled if the fold 
sheet is a cover.

The selected fold sheet is renumbered and all the subsequent fold sheets are 
renumbered automatically. You can see the new numbers in the header of the 
book signature and fold sheet nodes, and in the middle of the fold sheet. For 
example, if your job has four book signatures and you set the second signa-
ture to FS 10, the third and fourth signatures will be renumbered as FS 11 
and FS 12. These subsequent fold sheets have their numbering set to 
Automatic. 

The blue arrow icon (overrule) on the node where the renumbering starts, 
indicates that the numbering has been changed manually. You can interrupt 
the renumbering by clearing the Automatic check box and setting a new start 
number. 
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Effect on Collation Marks and Variables

The new fold sheet numbers are also the signature index numbers, and these are 
used for the collation marks. This means you can control collation mark 
numbering and avoid confusion. Collation marks are only generated for fold 
sheets of Level 1, and not for covers or nested fold sheets in a mixed assembly.

The $fold_sheet.number variable uses the new fold sheet numbers.

Renumber and 
Reorder Press 
Sheets

By default, the numbering of press sheets follows the numbering of book signa-
tures and fold sheets, and FS 1, FS 2, FS 3, etc. correspond with PS 1, PS 2, PS 3, 
etc. In certain production conditions, e.g. when arranging fold sheets on large 
press sheets and for partial jobs, you may want to change the numbering and/or 
order of press sheets.

 Renumber press sheets

You can renumber press sheets without changing their order.

Figure 8.13: Fold sheets renumbered, starting from FS 2 which is renumbered to FS 10
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1 In Product View, open the Inspector and select the press sheet from which 
you want to change the numbering.

In the Numbering panel, you see that the numbering is set to Automatic as 
default. Clear the Automatic check box.

2 In the Start numbering at box, enter a number that you want to start the 
numbering with. 

The selected press sheet is renumbered and all the subsequent sheets are 
renumbered automatically. You can see the new numbers in the header of the 
press sheet nodes and in the press node. For example, if your job has six press 
sheets and you set the first sheet to PS 20, the subsequent sheets are renum-
bered PS 21, PS 22, PS 23, PS 24 and PS 25. An asterisk (*) on the first sheet 
indicates that the numbering has been changed manually. The subsequent 
sheets have their numbering set to Automatic. You can interrupt the renum-
bering by clearing the Automatic check box and setting a new start number. 

 Reorder press sheets

You can reorder press sheets by changing the order of the nodes in the product 
and this automatically adjusts the numbering. You can move several nodes 
simultaneously.

 In Product View, select the node of the press sheet you want to move and drag 
it up or down to the desired location. A blue line indicates where you can 
drop the node in its new position. You can also select multiple press sheets 
nodes (press CTRL) and move them together. 

The press sheet is renumbered to respect the new order of the sheets, and the 
subsequent press sheets are renumbered accordingly. An asterisk (*) in all 
the node headers indicates that the order of the press sheets has been 
changed manually.
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Effect on Variables

The $sheet.name and $sheet.number variables use the new press sheet 
numbers. The $sheet.index variable follows the order as shown in the product 
view.

 Tools in Product View

Figure 8.14: Press sheets renumbered, starting from PS 20, and then reordered.

To... Press (Windows)

Switch to the Select Tool ALT + A

Switch to Split Assembly Tool ALT + S

Temporarily switch to the Split Assembly Tool Hold ALT

Split into multiple blocks (with Split Assembly Tool selected) Hold CTRL

Switch to the Split Assembly Tool and split an assembly in multiple 
blocks

Hold ALT + CTRL

Split a stacked signature horizontally, splitting off inserted child nodes. Hold + SHIFT

Repeat Step and repeat a placed fold sheet or element interactively ALT + R

Repeat the selected Fold Sheet (Repeat tool) CTRL + ALT + S
Apogee Reference Guide



414 PRODUCT VIEW
Open the Auto Impose window in the Product View CTRL + N

Rotate a Fold Sheet 90 degrees counterclockwise (must be selected on 
a Press Sheet)

CTRL + ALT + SHIFT + 
T

Rotate a Fold Sheet 90 degrees clockwise (must be selected on a Press 
Sheet)

CTRL + ALT + T

Flip a Fold Sheet (must be selected on a Press Sheet) CTRL + ALT + F

Rotate a Fold Sheet 180 degrees (must be selected on a Press Sheet) CTRL + ALT + Y

Show/Hide Inspector CTRL + I

Show/Hide Mark Set Inspector CTRL + SHIFT + I

Show/Hide Positioning Palette CTRL + |

Repeat the layout of an imposed Press Sheet to other Sheets CTRL + ALT + R

Show/Hide Assembly pane CTRL + ALT + 1

Show/Hide Fold Sheets CTRL + ALT + 2

Show/Hide Part/Fold Sheet details CTRL + ALT + 3

To... Press (Windows)
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Press Sheet View

In the Product View you can choose to view a Press Sheet in more detail. A 
number of tools and palettes allow you to inspect the Press Sheet and Pages and 
add or edit marks.

If a job already has content assigned to some or all of the Pages, this content can 
be displayed in the Press Sheet View by choosing View > Show Page Preview.

 Double-click a Press Sheet in the Press Sheet node, or select a Press Sheet in 
the Press Sheet node and click the Press Sheet View in the bottom left corner, 
or choose View > Show Sheet View.

Besides the detailed arrangement and marks of the Press Sheet, this view has 
three dedicated palettes and a toolbar:

 View Options Palette

 Marks Palette

 Positioning Palette (mainly used for unbound jobs)

Figure 8.15: Press Sheet View

1 Press Sheet
2 View Options
3 Toolbar
4 Marks Palette

1

4

2

3
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 Press Sheet Toolbar

NOTE: The Inspector and Mark Sets Inspector can also be used in the Product 
View.

View Options The Press Sheet view opens with a single Press Sheet displayed. By default, you 
will see the Front or Back of the Press Sheet depending on which side you 
selected. You can also view the reverse side of the Press Sheet with the Light 
Table tool.

The View Options palette in the Press Sheet View is used to show and hide the 
various rule-ups. For example, this allows you to inspect overlapping rule-ups.

1 Text Mark
2 File Mark
3 Press Sheet Box
4 Press Sheet Margin
5 Fold Sheet Box
6 Page Box
7 Page Bleed
8 Fold Sheet Gutter
9 Gripper
10 Fold Sheet Lay
11 Press Sheet Lay
12 Overfold

1

11

2

3

6

5

7

4

910 8

12
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The rule-ups are divided into the following categories:

 Press Sheet Rule-Ups

 Box: the bounding box around the Press Sheet

 Name: the Press Sheet name

 Lay: triangle icon indicating lay of the Press Sheet

 Fold Sheet Block: the area enclosing all Fold Sheets

 Gaps: the space between Fold Sheets/elements

 Margins: the margins, except the gripper

 Gripper: the Gripper area of the Press Sheet as set for the Press

 W&T: the mirrored part of a Work and Turn or Work and Tumble sheet
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 Slow Down Wheel Lanes: the positions of Slow Down Wheel lanes

 Fold Sheet Rule-Ups

 Box: the bounding box around the Fold Sheet

 Name: FS1, FS2, etc. in the middle of the Fold Sheet

 Lay: triangle icon indicating lay of the Fold Sheet

 Overfold: extra area for finishing machines

 Gutters: the no-content area

 Page

 Box: the bounding box around the Page; Name: the Page numbers

 Name: the page numbers

 Bleed: shows the bleed area on the Page

 Mark Box: the bounding box around the Text Mark and File Mark

 Previews: shows the content of marks (e.g. colorbars) and high resolution 
page thumbnails

 Measurements: shows fixed measurements of the Press Sheet and its 
components, the margins and the gutter; does not affect custom 
measurements

 Hidden Marks: marks that will not be printed due to conflicts; displayed in a 
red, hatched box

 View Options Sets drop-down list: choose, create, rename or delete 
preference sets for the View Options

 To show/hide rule-ups and hidden marks

1 Click the Show/hide View Options button in the Toolbar or choose 
Window >  View Options to show the View palette.

2 Click the individual or group eye icons to show or hide the various rule-ups 
and marks.
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3 Click the colored boxes to open a color editor where you can change the color 
of the rule-ups and measurements.

4 Click in the drop-down list at the bottom of the View Options palette to 
choose, create, rename or delete preference sets for the View Options.

Hovering, 
Selecting, 
Navigating

To inspect the different components (Pages, Fold Sheets, Marks, etc.) on the 
Press Sheet, you can hover over these components to highlight the area and 
tooltips with settings. Most components can be selected by clicking and then 
inspected with the Inspector.

NOTE: The Selection tool must be selected for this mode.

 Inspecting by hovering

 With the Selection tool selected, hover over a component to highlight the 
area of the component.

The component or area is highlighted with a thick line.

 Inspecting with tooltips

 With the Selection tool selected, click a component and hold the mouse 
button until its settings are displayed.

The component or area is highlighted and details are displayed in a tooltip.

 example: face trim
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 example: text mark

 Selecting a Page

 With the Selection tool selected, click in a Page.

The Page is indicated in blue.
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 Selecting a Fold Sheet

 With the Selection tool selected, click along the edge of the Fold Sheet area 
and click the Fold Sheet name (e.g. FS1 on PS1) in the tooltip list.

The Fold Sheet is indicated in blue.

 Selecting a Press Sheet

 With the Selection tool selected, click in the Press Sheet area outside the Fold 
Sheet.

The Press Sheet is indicated in blue.
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 Inspecting and editing with the Inspector

With the Inspector open you can select a component or area and change its 
settings.

1 Open the Inspector and click in a component, for example a mark.

The settings for the mark are displayed.

2 Change the settings as required.

These settings are applied immediately to the Press Sheet you are modifying.

 Zooming and Navigating in Press Sheet View

Additional tools in the toolbar at the bottom of the Press Sheet View are used to 
navigate the Press Sheet and inspect the content more closely. These tools are 
similar to the tools used in Raster Preview. Refer to the Icons Overview for more 
information about these tools.
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 Selecting layers in Press Sheet View

The Press Sheet View consists of layers to enable the selection of obscured or 
overlapping items. 

1 Click in a component and hold the mouse button until a tooltip appears.

The tooltip shows a list of the layers and the components on these layers, with 
the topmost layer at the top of the list and the bottommost layer at the 
bottom.

2 Click the component in this list to select it.

Related topics: • Mark Pens on page 1081
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Measuring the 
Press Sheet 
Components

Apogee Impose can display a large number of fixed measurements on the Press 
Sheet, or you can choose to define your own measurements with the Measure-
ment tool.

Fixed Measurements

Fixed measurements of the Press Sheet and its components, the margins, gutters 
and the gripper are available at all times for all Press Sheets.

 Choose View > Show Measurements to display all the fixed measurements.

OR

Open the View Options palette, expand the Measurements item and choose 
the measurements you want to see:

 Dimensions: Page, Fold Sheet and Press Sheet sizes

 Shingling: the amount and direction of shingling effects

 Fold Sheet Block: distance to the edge of the Press Sheet

 Fold Sheets: distance to the edge of the Press Sheet

 Gutters: distance between trim edges of Pages within the same Fold Sheet

 Outside Margins: distance from outside trim edges of the Page to the edge 
of the Press Sheet

 Gripper

NOTE: Use the shortcut CTRL+SHIFT+R to switch measurements on and off.
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Custom Measurements

The Measurements tool lets you make detailed measurements on the Press Sheet 
and determine the distance between components on the sheet. Several measure-
ments can be made and remain visible simultaneously, even when you switch 
back to another tool. These measurements are updated according to any 
changes made to the components.

When you have finished measuring, you can clear all the measurements from the 
Press Sheet View. Measurements are also removed if you close the Press Sheet 
View.

NOTE: Show/Hide Measurements in the View Options palette or when chosen 
from the View menu does not affect custom measurements.

Each component has 9 reference hot spots: 8 around the edges and 1 in the 
middle. These are indicated with a blue dot. Measuring between hot spots 
provides two-dimensional measurements where applicable.

Two methods exist for measuring:

 Single-clicking 2 reference points

 Double-clicking a component

 To measure the distance between reference points

1 Click the Measurement button in the Toolbar.

The cursor displays a number 1. 
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2 Hover over the component you want to start your measurement from, for 
example a Page, Mark or Rule-up, and click to fix the first reference point.

NOTE: Press Esc to cancel a reference point.

3 Click a second time to fix the second reference point.

 To display the measurements of a component

1 Click the Measurement button in the Toolbar.

The cursor displays a number 1. 

2 Double-click a component, for example a color bar.

If applicable, the width and height of the component are displayed 
automatically.

 To measure between two hot spots (two-dimensional)

1 Click the Measurement button in the Toolbar.

The cursor displays a number 1. 
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2 Hover over the component you want to start your measurement from, for 
example a Page, Mark or Rule-up, but locate a hot spot (blue dot) before 
clicking to fix the first reference point.

3 Click another hot spot to define the second reference point.

You now have two measurements between your reference points.

Marks Palette The Marks palette in the Press Sheet View is used to place marks manually on the 
Page, Fold Sheet or Press Sheet. In other words these marks do not depend on 
conditions and they can be placed relative to any possible object on the page or 
sheet.

The palette contains the following marks categories:

 Page Marks: e.g., Page Crop

 Fold Sheet Marks (bound jobs)/Element Marks (unbound jobs): e.g., Fold 
Line, Cut, Collation

 Press Sheet Marks: e.g., Registration marks

The various mark types in these categories are managed in the Mark Engraver 
Resource of the Impose Task Processor. Refer to “Mark Engraver” on page 1038 
and “Mark Types” on page 1045 for more information about the different types 
of marks and their settings.

CAUTION: Marks placed manually may be positioned at unexpected locations 
and on other sheets than the sheet you are working on. 

Related topics: • Mark Engraver on page 1038
• Mark Types on page 1045
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 To place a mark manually

1 Click the Marks button in the Toolbar or choose Window >  Marks Palette to 
show the Marks palette.

The Marks palette is displayed.

2 Hover over the icons to see what kind of marks are available.

3 Drag the required mark onto the Press Sheet.

The Marks Inspector appears with default settings for the selected mark.

4 Change the settings as required.

 To add a mark to a Mark Set

Once a mark has been added to a page or sheet, it can be included in a Mark Set.

1 In the Marks Inspector, click the cogwheel in the bottom left corner.
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2 Choose an existing Mark Set or choose New to create a new Mark Set for your 
manually placed marks.

 To move/copy a mark

The following marks can be moved and/or copied:

 File

 Rectangle

 Circle

 Line

 Text

1 Select the mark you want to move, drag it to the desired location and release 
the mouse button.

2 To duplicate the mark, press CTRL.

A + sign is displayed.
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The original mark reappears at the original location and a copy is created 
when you release the mouse button.

NOTE: Marks can only be moved and copied one by one.

Press Sheet Toolbar The tools in the Press Sheet View are similar to those of the main Imposition 
window and the Raster Preview window. The following tools are dedicated to 
the Press Sheet View only:

Product View button. Return to Product View from Press Sheet View.

Selection tool. Use this tool to select a component or area and display its properties. This is 
the default tool.

Single Instance Selection tool. Use this pointer tool to select a single instance of marks 
which are placed at various locations on the Press Sheet, or part of a compound mark.

Pan tool: To pan layouts in the Layout Editor.

Zoom tool: To zoom into a specific area of a layout.

Measurements. Use this tool to make measurements on the Press Sheet.

Clear Measurements (only activated if the sheet has measurements). Click to remove all mea-
surements displayed on the Press Sheet.

Shows/Hides the Inspector window

Shows/Hides the Mark Sets Inspector window.

Shows/Hide the Positioning palette

Marks Palette button: shows/hides the Marks Palette

View Options Palette button: shows/hides the View Options Palette

Go to previous Press Sheet or web

Go to next Press Sheet or web

Turn Sheet button. In the Press Sheet View, click to view the other side of a Press Sheet.

Light Table.
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 Tools in Press Sheet View

Zoom slider with Zoom to fit and Zoom to maximum buttons, and drop-down list with zoom 
presets

Submit button. In the Press Sheet View, closes the window and submits the job without 
returning to the Product View.

To... Press (Windows)

Switch to the Select Tool ALT + A

Select segments or individual instances of an item. ALT + D

Switch to the Pan Tool ALT + H

Switch to the Zoom Tool ALT + Z

Switch to Measurement Tool ALT + M

Clear any measurements from a Press Sheet CTRL + ALT + M

Show/Hide Inspector CTRL + I

Show/Hide Mark Set Inspector CTRL + SHIFT + I

Show/Hide Marks Palette CTRL + M

Show/Hide View Options CTRL + E

Go to previous sheet (Sheet View) CTRL + left arrow

Go to next sheet (Sheet View) CTRL + right arrow

To turn the Press Sheet: flip front to back (Turn Press Sheet tool) CTRL + T

Switch Light Table mode on and off CTRL + L

Temporarily switch to the Measurement Tool Hold ALT

Temporarily switch to the Pan Tool Hold space bar

Zoom into Press Sheet CTRL +
OR
CTRL + mouse wheel

Zoom out of Press Sheet CTRL -
OR
CTRL + mouse wheel

Zoom to fit Press Sheet in window CTRL + 0 (zero)

Close the selected gaps (Sheet View) CTRL+.

Copy a mark CTRL+ drag
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Inspector

In the Product View and Press Sheet View, you can use the Inspector to check 
and edit the settings of the various imposition components (Pages, Fold Sheets, 
Press Sheets, Marks, etc.).

You can also use the Inspector to verify in which nodes a particular component 
can be found or to make selections by component.

In the Press Sheet View you can use the Inspector to locate marks on a Press 
Sheet.

Figure 8.16:  Displaying settings and highlighting components in Product View

Figure 8.17: Highlighting the location of a mark in Press Sheet View
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 To view the Inspector, click in a node or a component (Page, Fold Sheet, 
Press Sheet, Mark, etc.), and then click the Inspector button in the toolbar 

OR

Press CTRL+I.

The Inspector consists of the following panels:

 Selection panel with selection button: identifies the current selection (on 
the left) and provides a way to expand the selection by choosing a crite-
rion from the drop-down list (on the right).

 Settings: lists all the settings of the selected component in a single panel 
or on several tabs if many settings exist, e.g. for marks. You can edit these 
settings. Some settings have an extra button to open the resource settings 
in a separate window.

 cogwheel: displays a list of relevant commands.

1 Selection panel
2 Selection button
3 Settings
4 Resource settings button
5 Reset (revert) button
6 Cogwheel menu

1

3

6

2

4

5
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Editing/Resetting 
with the Inspector

The Inspector displays two kinds of settings for nodes and their imposition 
components:

 Settings inherited from a parent component: for example Page Stock is inher-
ited from Product by Part, Pages, Fold Sheet and Press Sheet. These can be 
reset with the Reset button.

 Component-specific settings: for example Folding Scheme of a Fold Sheet. If 
you change one of these, you can revert by choosing Undo (CTRL+Z).

Choosing an option from a drop-down list (e.g. a Folding Scheme) will apply this 
option immediately to the selected component.

Entering values in edit boxes are confirmed when you click outside the box or 
press Enter.

When you change the settings in the Inspector they are applied immediately in 
the Imposition windows but they are only updated in the Job Ticket Editor when 
you close the Imposition windows. This means the settings in the Inspector may 
differ from those in the Job Ticket Editor if you switch between these windows 
while editing.

With the Resource Settings button you can jump to specific resources, e.g. 
Binding Options and Press Sheet Layout rules. These changes apply only to the 
Product you are working on and do not affect the configuration.

Editing the settings may create a conflict. This is indicated with a red outline 
around the node and an error icon.

Clicking the red error icon displays the Snag List that lists the errors.

For the marks in the Press Sheet View, the Inspector displays settings which are 
specific for the selected mark (usually on several tabs). These settings are not 
inherited from the Product.
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Inspecting 
Imposition Settings 
in Product View

In Product View you can inspect and edit the settings of the imposition nodes 
and the components in the nodes.

For the Product, Part and Page, the Inspector shows the settings defined in the 
Products tab of the Job Ticket Editor. The Product and Part editors are used to 
define these settings in the Products tab. In the Inspector you can choose to 
change these generic settings for individual components.

For the other nodes, the Inspector shows the setting defined in the Auto Impose 
editor (automatic imposition mode) or the settings you chose for the imposition 
in manual imposition mode.

Some components are displayed in more than one node, e.g. the Fold Sheet in 
the Fold Sheet node and the Assembly node. In this case the Inspector shows the 
same information in each of these nodes.

Related topics: • Product Inspector on page 299
• Part Inspector on page 302
• Press Sheet Layout Rules Overview on page 1124
• Binding Options Overview on page 958

 To inspect the Product

 Click the Product node to display the settings for the Product.

The settings for the Product are displayed.
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You can modify the following resources or settings for the product:

 Stock

 Page Size

 Bleed

 Binding Options Overview

 Glue Zones Overview

 Press Sheet Layout Rules Overview

 Shingling Rules

 Bottling Rules

 Multiplier
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 To inspect the Page

You can inspect a page and change the page size so it has a different size than the 
other pages in the part.

 Click a Page in the Product node to display the settings for the Page.

The settings for the Page are displayed.

You can override the following settings for the selected page:

 Page Size

 Bleed
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 Glue Zones Overview (Knock out, shift, scale)

 Shingling Rules

 Bottling Rules

 Spine edge of the page

 To inspect the Part

 Click a Part node to display the settings for the Part.

The settings for the Part are displayed.
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 To inspect the Book Signature

TIP: You can show/hide the 
Book Signatures column by 
choosing View > Show/Hide 
Book Signatures.

 Click a Book Signature node to display the settings for the Book Signature.

The settings for the Book Signature are displayed.

Click the arrow in the Pages section to see which Part the signature belongs 
to and click the Placed On arrow to see on which Folding Sheet the signature 
has been placed.
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 To inspect the Fold Sheet

 Click the Fold Sheet, or the Fold Sheet node or the Assembly node to 
display the settings for the Fold Sheet.

The settings for the Fold Sheet are displayed.

NOTE: The Signature numbering panel is displayed in the inspector if you 
enabled the Advanced book signature numbering option in the Product 
editor. See “Renumber Fold Sheets/Book Signatures” on page 409.
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 To inspect the Fold Sheet Side

 Click the Fold SheetSide in the Press Sheet node to display the settings for 
the Fold Sheet Side.

The settings for the Fold Sheet Side are displayed.

 To inspect the Press Sheet

 Click a Press Sheet node or a PS in the Press node to display the settings for 
the Press Sheet.

The settings for the Press Sheet are displayed.
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NOTE: In the Numbering panel you can control how press sheets are numbered. 
See “Renumber and Reorder Press Sheets” on page 411.

 To inspect the Press Sheet Side

 Click a Press Sheet Front or Back in the Press node to display the settings 
for the Press Sheet Side.

The settings for the Press Sheet Side are displayed.
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 To inspect similar components (Expand Selection)

An arrow in the selection panel of the Inspector indicates that a drop-down list 
is available for expanding the selection based on the settings of the selected 
component.

1 Click in a node, or a component (Pages, Fold Sheets, Press Sheets, Marks, 
etc.) with the Inspector open.

The settings window appears (e.g. for a Fold Sheet).

2 Click in the drop-down list in the top right corner
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3 Choose an option, e.g., Same folding scheme.

All components with the same folding scheme are indicated with a blue 
outline.

4 Click the grey arrow in the top left corner to highlight these components.

 Opening Binding Options from the Inspector

A grey selection button in the Inspector of certain nodes (for example: Product) 
provides a shortcut to additional setting.

1 Click the Product node with the Inspector open.

2 Click the resource settings button next to Binding Options to open the 
Binding Options.
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 Opening Press Sheet Layout Rules from the Inspector

A grey selection arrow in the Inspector of certain nodes (for example: Product) 
provides a shortcut to additional setting.

1 Click the Product node with the Inspector open.

2 Click the grey arrow next to Sheet Layout Rules to edit these rules.
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Inspecting Marks in 
Sheet View

Most of the imposition components (Pages, Fold Sheet and Press Sheets) can be 
inspected and edited in the Sheet View, however, you will generally use the 
Sheet View to inspect marks.

The settings displayed in the Inspector are similar to those you find in the Mark 
Engraver resource.

 Selecting Marks with the Inspector (Expand Selection)

1 In the Press Sheet View, click in a Mark with the Inspector open.

The settings window appears (e.g. for a File Mark).

2 Click in the drop-down list in the top right corner

3 Choose an option, e.g. Same appearance.

The selected marks are indicated with a blue outline.

4 Click the grey arrow in the top left corner to highlight these components.

This can be done for all mark types.
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 Finding how a mark was placed

1 In the Press Sheet View, click in a Mark with the Inspector open.

The settings window appears (e.g. for a Page Crop mark) and in the bottom 
right corner you can see how the mark was placed.

2 Click the grey button.

The Mark Engraver opens and the Mark Set that placed the mark is 
highlighted.

Related topics: • Mark Engraver on page 1038

Cogwheel 
Commands in the 
Inspector

The cogwheel in the bottom left corner of the Inspector lists a number of 
commands that are relevant for the selected imposition node or component.
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The following commands are displayed depending on the selected node or 
components:

 Imposition components in Product and Sheet View

 Marks in Sheet View

Command Action

Reset Resets selection

Reset All Resets all production settings

Auto Impose Opens the Auto Impose dialog box

View Opens the Press Sheet View

Reset (Fold Sheets) Resets the layout of the Fold Sheets according to the Press Sheet 
Layout Rules

Reset Position Resets the orientation and flip state to 0° and not flipped

Command Action

Reset Resets selection

Reset All Resets all production settings

Add to Mark Sets Adds the selection to a Mark Set

Open in Mark Engraver Opens the selected Mark in the Mark Engraver

Manage Mark Sets Opens the Mark Engraver (from Mark Sets Inspector)
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Mark Sets Inspector

The Mark Sets Inspector is available in the Product View and the Press Sheet 
View. This inspector lists all the Mark Sets by category and in the same order as 
they appear in the Mark Engraver. Only information relevant for the current 
selection is shown.

 The Mark Set Inspector is opened by clicking the Mark Sets Inspector button 
in the toolbar.

The Mark Sets Inspector is displayed.

NOTE: A Mark Set in red means the Mark Set is not available.

Depending on the current selection, the Mark Sets Inspector may contain 
information on some or all of the following Mark Set categories:

 Page Mark Sets

 Fold Sheet Mark Sets

 Press Sheet Mark Sets

The Remove Manual Marks button can be used to delete any marks that you 
placed manually.

The cogwheel provides a shortcut to the Mark Engraver.
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Related topics: • Mark Engraver on page 1038
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Snag List

The Snag List is available in the Product View and the Press Sheet View and lists 
conflicts and problems to be checked.

 The Snag List is opened by clicking a problem in a node, by clicking the error 
icon in the bottom right corner of the Product View or Press Sheet View, or by 
clicking CTRL+R.

The Snag List contains the following information:

 Left column - top pane: summary of all validation items with 2 entries: one 
for All and a second for the selected node or component.

 Left column - bottom pane: items to be checked, sorted by severity with 
errors at the top and OK at the bottom.

 Right column: the list of issues per category with button to jump to the 
problem in the Product View of the Sheet View.

 To locate an imposition conflict

1 Click an error icon in a node in the Product View or Press Sheet View.

The Snag List opens and the total number of issues for the selected node are 
indicated.

2 In the bottom pane of the left column, select a category.
Apogee Reference Guide



 

8 WORKING WITH APOGEE IMPOSE 453
3 In the right column, click the grey arrow to highlight the issue in the Product 
View of the Press Sheet View.

Marks are highlighted in the Press Sheet View.

Problems related to a node are highlighted in the Product View.

NOTE: The view you are in may switch, depending on the type of issue you 
jump to.

4 Resolve the error by changing the settings for the mark or the node.
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Page Previews

If pages have been assigned to the Run List, you can view thumbnail previews in 
Product View as well as Press Sheet View. The job with placed pages does not 
have to be submitted for you to see the thumbnails.

NOTE: In the Normalizer, select the Create Low Resolution Previews option to 
obtain page previews with a higher resolution in the Press Sheet View.

 To see page previews in Product View

 Choose View > Show Page Preview to preview thumbnails of the pages 
already placed in the Run List.

 To see page previews in Press Sheet View

 Choose View > Show Page Preview to preview thumbnails of the pages 
already placed in the Run List

OR

Select Page Previews in the View Options palette.

NOTE: Use the shortcut CTRL+SHIFT+T to switch thumbnails on and off while 
working in Product or Press Sheet View.

Related topics: • Low Resolution Previews on page 775
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Imposition Reports

Imposition Reports can be created from the Job List or from any of the Apogee 
Impose windows. An Imposition Report includes a mock-up of a Press Sheet 
imposition and the details of the job. This information is exported as a PDF file 
and saved to a specified location. The report can be created interactively if 
needed for the job at hand or you can set it up to be generated automatically each 
time a job is processed. The mock-up includes the main rule-ups, fixed measure-
ments (not custom measurements), lays, colorbars and gripper. The job details 
may include a variety of the parameters you can find in Product inspector such 
as paper stock, press sheet size, folding scheme, etc. A report is created for each 
flow in the plan. The presets for these reports are created in the Imposition 
Reports editor.

 Generate an Imposition Report interactively

This procedure is for generating an Imposition Report interactively for a selected 
job which has been imposed.

1 In Product View or Press Sheet View, choose Imposition > Export Imposition 
Report.

OR

In the Job List, context-click the job and choose Export Imposition Report.

2 In the dialog box, choose an Imposition Report preset from the drop-down 
list. Two presets are provided by default: one for a mock-up and one for a 
mock-up and job details.

3 Click the Export and Open button.

A report is created for all the press sheets and according to the Imposition 
Report preset you chose, for example with or without page previews. The 
PDF opens in your PDF reader application. The PDF is saved in the location 
specified in your preset.

You can create a bespoke Imposition Report for your job by clicking Manage 
Imposition Reports at the bottom of the drop-down list.

 Generate Imposition Reports automatically

You can set up your Job Ticket or Hot Ticket so that an Imposition Report is 
created automatically each time the job is processed. This is done in the Impose 
component of the Production Plan where Apogee Impose must be selected for 
the imposition.

1 Go to the Impose component in the Production Plan of your Job Ticket or Hot 
Ticket. If you have multiple flows, repeat this procedure for each flow.
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2 Unlock the settings and choose an Imposition Report preset from the drop-
down list. 

3 Select the Export automatically check-box and lock the settings.

4 Make sure your imposition is ready and set the View options in Press Sheet 
view. If necessary, create a View options preset that can be referenced in the 
Imposition Report preset. Any changes you make to the View options are not 
shown in the mock-up if they are not saved as a View options preset.

5 Submit the Job Ticket.

An Imposition Report will be generated and saved in the location specified in 
the preset when you process the job. The PDF does not open automatically 
and you need to browse to the output location to open it.

 Create an Imposition Report preset

Imposition Report presets are created in the Imposition Report editor.

1 In Product View or Press Sheet View, choose Imposition > Export Imposition 
Report.

OR

In the Job List, context-click the job and choose Export Imposition Report.

OR

Go to the settings panel of the Impose component in the Production Plan of 
your Job Ticket or Hot Ticket. 

2 From the Imposition Reports drop-down list, choose Manage Imposition 
Reports to open the Imposition Reports editor.

3 Create a preset like you would for other resources.

Related topics:

 Imposition Reports Editor

This dialog box is for creating presets that need to be selected if you want to 
generate an Imposition Report. You can specify if you want a section with the 
details of the job, a section with a mock-up, or both sections.
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Contents

Include Job Details Select to include information about the job:

 General information: Order no., Job name, Customer name and contact, 
comments

 Products and Parts: A table lists the product (or multiple products) and its 
parts with the settings as used for the job (Fold Sheet, Pages, Scheme, 
Size, Stock, Press), product thumbnail

 Press Sheets: A table lists the press sheets of the job with their settings 
(workstyle, colors, size, stock, press, run length)
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Include Press Sheet Mock-
up

Select to include previews of the Press Sheets which by default will be full-size 
and use the Standard View Options; you can control this with the following 
options:

Type Full-size press sheets: the Front and Back sides of all the Press Sheets are 
produced at full-size and per page of the PDF

Scaled press sheets: The Front and Back sides of each Press Sheet are scaled so 
they can be shown on a single page of the PDF

View Options Select one of the presets for the View Options from the drop-down list; this 
determines which components will be shown in the mock-up; for example the 
page previews (page content), rule-ups, measurements, etc. Note that any 
incidental changes to View Options that you may have made in Press Sheet view 
will not be shown in the mock-up. It is recommended to set up the View Options 
you want for your report in Press Sheet view and then save these View Options 
as a preset that can be picked up here.

Line Appearance Set When the Imposition type is Layout Editor, you can select a line appearance set 
to be used to draw the Operations. If there are no line appearance sets, the pop-
up is blank and the report will not have any Operations drawn. The last drop-
down menu option opens the Line Appearance Sets - Impose dialog box to 
manage the Imposition Report Resources.
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Line Appearance Set option is hidden when the Imposition type is not Layout 
Editor.

Page number Select to use the Run List indexes instead of the page labels.

JDF sheet names Select to use the JDF names for the Press Sheets, if applicable.

Page size Select the page size of the Imposition Report PDF for the job details section and 
the mock-up if the scaled press sheets option is chosen.

Units Choose mm or inches for the units used in the report.

Decimal separator Choose decimal point or comma for the units used in the report.

Precision in Mockup Choose the number of decimals to be used for printing dimensions and distances 
in the mock-up.

Hide trailing zero’s Choose this check box to hide trailing zero’s in the decimal part when printing 
dimensions and distances in the mock-up.

Result Delivery

On this tab you can specify the Export Directory and the File Name for the report 
using the usual variables or by browsing to a location. In the Conflict Handling 
section you can choose to replace existing files (reports) or keep existing files 
and add a sequence number (_1, _2, etc.) to the file name each time a report is 
generated.

Related topics: • Generic Variables on page 1184
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Menus

The following menus are available in the main imposition window. Some 
commands are only active in the specified view (Product View or Press Sheet 
View), while others only for certain Product types (bound, unbound, calendar).

Imposition Menu

Edit Menu

Commands on the Edit menu affect the imposition.

View Menu

Commands on the View menu can be used to show and hide components but do 
not affect the imposition.

Menu Item To...

Auto Impose Open the Auto Impose window (Product View)

Close Save your imposition changes and close the Imposition window

Submit Changes Close the Product View and submit the Job Ticket

Export Imposition Report Open the Imposition Report dialog to create a PDF of the imposition

Menu Item To...

Select All (Product View) Select all components of the same category: Select all Parts, Fold 
Sheets, Press Sheets

Select All Marks (Press 
Sheet View)

Select all marks on the Press Sheet

Expand Selection Expand your selection based on a setting of the selected 
component; the relevant settings appear in a drop-down list

Repeat Imposition 
(Product View)

Display a dialog box where you can choose to copy the imposition 
of a Press Sheet to other Press Sheets

Reapply All Mark Sets Re-apply marks to their automatic settings, removing manual edits

Flip Front/Back (Fold 
Sheet in Product View)

Flip the selected Fold Sheet on the Press Sheet

Rotate (Fold Sheet in 
Product View)

Rotate the selected Fold Sheet on the Press Sheet 90° clockwise, 
90° counterclockwise or 180° clockwise

Close Gap Close the selected gap (Sheet View)

Calculate Zones for Slow-
Down Wheels

Forces the system to search for a suitable layout with slow-down 
wheels, without time-out.
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Window Menu

Commands on the Window menu can be used to activate or switch off palettes 
and inspector windows.

Menu Item To...

Show/Hide Run List 
Indexes

switch between absolute run list index and page numbering per part

Show Selection show the selection when it is not visible on the screen

Show/Hide Assembly 
Pane

show/hide the assembly at the top of the Product View

Show/Hide Book 
Signatures

show/hide the Book Signature nodes in a column next to the Fold 
Sheet nodes

Show/Hide Fold Sheets show/hide the Fold Sheet nodes in the Product View

Show/Hide Part/Fold 
Sheet Details

expand/collapse the Part and Fold Sheet nodes in the Product View

Show Press Sheet open the Press Sheet View of a selected Press Sheet

Show Product View return to the Product View of the open Press Sheet

Show/Hide Page 
Previews

display page thumbnails if pages have been assigned in the Run List

Show/Hide Page 
Measurements

display all standard measurements for components on the Press 
Sheet

Compact View only show the labels of the nodes and make the view more compact

Show/Hide Sheet View open a selected Press Sheet in Press Sheet view
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Imposing Multi-Product Jobs

A single Apogee job can combine several print products with the intention of 
optimizing printing operations, and these jobs are referred to as multi-product 
jobs. A multi-product job is either created from scratch to combine several 
products in one job (i.e. a planned multi-product job) or can be the result of 
merging existing jobs (i.e. a merged job). You can combine bound with unbound 
products, and products with different attributes. You can preserve existing 
impositions and combine them with new impositions using the interactive and/
or automatic modes of Apogee Impose.

NOTE: More than one product is not allowed for WebApproval jobs.

Planned Multi-
Product Jobs

The basic structure of a planned multi-product job has to be created by the 
operator in Apogee or submitted to the system using JDF. Use the Add Product 
command in the Products tab of the Job Ticket Editor to add multiple products 
to a job you are creating. You can also use the Add Product command to create 
and add new products to an existing job. Apogee Impose can subsequently be 
used to deal with the imposition details – just like single-product jobs.

Figure 8.18: Multi-products in Product View (Compact View)
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Related topics: • Using the Products Tab on page 295

Merged Jobs You may want to bring together smaller jobs that already exist and combine the 
individual products of these jobs into a multi-product job. All merged jobs are 
multi-product jobs. You cannot merge jobs that have versions or already have 
more than one product, but you can merge jobs whose products have several 
parts.

NOTE: Merging Layout jobs produces a merged job with a single product, and 
consequently you cannot preserve the imposition of the original jobs.

Related topics: • Merging Jobs on page 210
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Imposing Digital Products

In this documentation, a digital product refers to a product printed on a digital 
printer or press, except Sign and Display products. Apogee Impose provides the 
following imposition types that can be selected when using the Auto Impose 
feature for digital products:

Cut & Stack The pages on a press sheets of a Cut & Stack imposition are cut and then put on 
top of each other to obtain the correct page sequence.

Booklet The press sheets form stacks of two-by-two page spreads that can be folded in 
the middle and then collected to create a booklet. Book signatures can be created 
to allow for the maximum folding thickness.

Step & Repeat Pages are duplicated on the press sheet which is cut to create 2 or more products.

Figure 8.19: 16-page double-sided product with Cut & Stack imposition (right) compared with 
a nested imposition (left)

Figure 8.20: 16-page double-sided product with Booklet imposition and 2 book signatures 
(right) compared with a nested imposition for 1 book signature (left)
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The imposition type is also indicated in the Fold Sheet node in the Product View.

Related topics: • Imposition Type on page 378

Figure 8.21: 8-page double-sided product with Step & Repeat imposition to create 2 identical 
products (right) compared with a Cut & Stack imposition (left)
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Imposing Multi-Up Products

With a Multi-Up product you can combine two or more book signatures on a 
single Fold Sheet. After printing, folding and binding, the bound block is cut in 
two or more products. Apogee Impose automates the n-up arrangement and 
optimizes the filling of the Press Sheet. The different types of marks and mark 
variables are placed logically according to the number of products.

A Multi-Up product is set up in the Product editor when defining the product by 
choosing a Binding Options resource that has a Number-up binding selected, 
typically 2-Up or 3-Up. Fitting the Fold Sheet horizontally and vertically to the 
Press Sheet is set in the Press Sheet Layout Rules.

Multi-Up is ideal for small products that will be printed on large printing presses 
to reduce press run lengths. Multi-Up is also used for the Come and Go binding 
style that puts different book signatures on the same Fold and Press Sheets to 
reduce the number of plates required to print a job. Alternatively, Number-up 
Come and Go (reversed) binding style can be used to reverse the page order and 
orientation of the book signatures.

Following icons show the possible Number-up binding arrangements. The color 
of the front and back sides indicate the page order and orientation of the book 
signature.
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Viewing a Multi-Up 
Product

The Fold Sheet and Press Sheet nodes in regular Multi-Up jobs have 2 or 3 
identical book signatures which are displayed in different shades in the main 
imposition windows.

In the Fold Sheet node you can see the actual number of pages in the book signa-
ture. For example 2 x 8 means the book signature has 8 pages which will be 
printed twice on the same sheet. Apogee Impose selects a Folding Scheme for 8 
pages and not for 16 pages even though the Fold Sheet has 16 pages to be placed.

NOTE: If you decide to choose a Folding Scheme in the Auto Impose window, 
remember that it must match the number of pages in the book signature and not 
the number of cells on the Fold Sheet.

A Come and Go job puts 2 different book signatures on the same Fold Sheet and 
Press Sheet. In other words, there is no one-to-one relationship between the 
book signatures and the Fold and Press Sheets. The redundant Fold and Press 
Sheets are greyed out. Selecting a book signature node in the assembly 
highlights corresponding pages on the Fold Sheet and Press Sheet.

1 Pages of book signatures 
highlighted in different shades

2 Number of pages per book 
signature

2

1

Figure 8.22: A regular 2-up job
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Related topics: • Binding Options Overview on page 958
• Press Sheet Layout Rules Overview on page 1124

Figure 8.23: A Come and Go 2-up job with redundant sheets greyed out
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Imposing Web Production Jobs

Web production jobs are jobs which have a web press in the production plan and 
are printed on a roll of paper instead of sheets. A web press uses a web produc-
tion scheme, similar to a folding scheme for sheet-fed presses, to arrange the 
pages of the job on the web. A web production scheme can be set up to produce 
several deliveries and accommodate ribbons if required. A web press can have 
multiple webs and a job on such a press is referred to as a multi-web job.

The following are prerequisites for creating a web production job:

 Set up a web press in the Press resource: See “Generic Press” on page 910 for 
more information.

 Create a Web Production Scheme resource for the web press: See “Web 
Production Schemes” on page 1150 for more information.

 Define press sheet sizes for the web press: See “Sheet Sizes” on page 690 for 
more information.

Web production introduces a series of specific naming conventions for webs, 
deliveries, etc. and these naming conventions that you see in the Apogee Impose 
module also trickle through to the other tabs of the Job Ticket Editor.

Product View (Web 
Printing)

The Product View for a web production job is similar to the view of a sheet-fed 
bound product. The main difference with a sheet-fed job is that the press and its 
web production schemes define the page arrangement and not the folding 
scheme.
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The Workstyle list in the Press Sheet node includes the web production schemes. 
If the Press Sheet is already assigned to a press, the Workstyle list only shows the 
web production schemes for that particular press. These schemes are organized 
by categories if applicable.

Selecting a Web Production Scheme displays the slots on the bottom and top of 
the sheet, and for the different color-coded deliveries with the number of pages 
for each deliverable.

The Fold Sheet nodes can be dragged onto the slots if the numbers of pages 
match. 

Figure 8.24: 32 pages on a single web, with filled slots for 2 deliveries (A and B)

Figure 8.25: Press Sheet node with empty slots for 2 deliveries
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Selecting a scheme also sets the sheet size. Apogee Impose takes the best avail-
able Sheet Size width and retrieves the height for that specific press. A web press 
prints on a roll of paper and the height of the press sheet depends on the press 
cut-off.

If a scheme has more than one web, the press sheet for each web is displayed in 
a single press sheet node and each web is indicated with W1, W2, W3, etc. 
Multiple webs are displayed as one virtual press sheet in the Press node.

Note that the Fold Sheet node does not have a folding scheme. It only provides a 
color-coded indication of the deliveries (A, B, C, etc.). Deliveries are also 
indicated in the Assembly node when you select them in the Press Sheet node.

Figure 8.26: Multi-web Press node with the sheets of 2 webs on the same Press Sheet

Figure 8.27: 32 pages as 1 delivery on 2 webs (W1 and W2), on 1 virtual press sheet
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 To create a web production job with Auto Impose

1 Create a job for a bound product like you would for a sheet-fed job.

2 Enter the number of pages and define the parts.

3 In the Products tab, choose a Press Sheet Layout and click the Auto Impose 
button to open the Auto Impose window.

4 Choose a web press from the drop-down list.

When a web press is selected, some of the panels change and you can only 
select a Sheet Size and a Web Production Scheme. The Workstyle and 
Folding Scheme fields are no longer available.

5 Select a Sheet Size from the drop-down list. The list is filtered and only sizes 
for the web press are shown.

Only the width is defined as the height depends on the cut-off length of the 
web press

6 Select a web production scheme from the drop-down list. Schemes may be 
organized in categories.

The description of the scheme is displayed under the scheme name. Check 
that the scheme is suitable for the job: number of pages, number of deliveries, 
etc.

7 Repeat for each part.

8 Click Impose.

The Product View is displayed with press sheets assigned to the web press 
and the fold sheets assigned to a deliverable on the press sheet.

Figure 8.28: Multi-web Press Sheet node with 1 of 2 deliveries selected (blue outline)
Apogee Reference Guide



 

8 WORKING WITH APOGEE IMPOSE 473
 To create a web production job in manual mode

1 Create a job for a bound product like you would for a sheet-fed job.

2 Enter the number of pages and define the parts.

3 In the Products tab, choose a Press Sheet Layout and click the Edit Imposition 
button to open the Product View.

4 Drag the Press Sheet node onto a web press.

NOTE: To change the press once it has been assigned, drag the Press Sheet off 
the node of the assigned press and then drag the Press Sheet node onto the 
new press.

5 In the Press Sheet node, select a Web Production Scheme from the Workstyle 
drop-down list.

The list is filtered and only displays web production schemes for the selected 
press. Schemes may be organized in categories.

NOTE: If you click in the Workstyle list before assigning the press sheet to a 
web press, you will also see the workstyles for sheet-fed presses. These sheet-
fed workstyles cannot be applied for web production.

6 Select a Sheet Size from the drop-down list.

The list is filtered and only sizes for the web press are shown. Only the width 
is defined as the height depends on the cut-off length of the web press

7 Drag the Fold Sheet nodes onto the color-coded deliveries on the Press Sheet 
node. The number of pages of the Fold Sheet node must correspond with the 
pages for the deliveries.

8 Repeat for each Fold Sheet node.

9 Click Submit to save the imposition.
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Press Sheet View 
(Web Printing)

The Press Sheet view of a web production job displays the web production 
scheme which contains the deliveries. The press sheets for multiple webs are 
displayed separately and you can navigate to the different multi-web press 
sheets using the Next/Previous buttons.

View Options The View Options palette in the Press Sheet View is used to show and hide the 
various rule-ups. For example, this allows you to inspect overlapping rule-ups.

The following rule-ups are specifically for web press sheets and only visible for 
web production jobs. See “View Options” on page 416 for more information on 
the generic rule-ups.

 Press Sheet Rule-Ups

 Box: the bounding box around the Press Sheet

 Name: the Press Sheet name

 Web Production Scheme: the area enclosing all deliveries

 Margins: the margins, except the gripper

1 Web number (W1, W2, etc.)
2 Delivery rule-up
3 Web production scheme rule-up
4 Next/Previous buttons to other 

webs
5 Delivery name (A, B, C, etc.)

1

2

3

5

5

4
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 Slow Down Wheel Lanes: the positions of Slow Down Wheel lanes

NOTE: Web press sheets do not have a lay, gaps or a gripper.

 Delivery Rule-Ups

 Box: the bounding box around the Delivery

 Name: A, B, C, etc. in the middle of the Delivery

 Overfold: extra area for finishing machines

 Gutters: the no-content area

NOTE: Web press deliveries do not have a lay.
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Imposing Unbound Products

The Unbound product type is chosen for work that does not require binding and 
assembly. This product type is generally for independent pages that are printed 
on their own or together with independent pages from other projects, commonly 
referred to as ganging jobs. 

The independent pages or elements of an Unbound product can be defined 
similar to the Parts of a Bound product. For example, elements can have 
different sizes and you can create as many elements as you need for a job. 

In automatic mode, Apogee Impose maximizes the use of the available Press 
Sheet size by grouping as many elements as possible on a single Press Sheet and 
repeating elements. The Auto Fit rules provide the settings for this. Apogee 
Impose also calculates the number of pages required in the Run List by making 
the sum of all the elements in the Product.

Apogee Impose also has powerful tools and features for editing the imposition 
and placing elements on the Press Sheet in interactive mode. For example, the 
Step & Repeat tool can be used to repeat one or more elements on a Press Sheet.

The Unbound Folded product type uses pagination schemes to arrange pages 
arbitrarily on panels of varying dimensions. This product type is ideal for z-folds, 
gatefolds and other complex folded jobs.

Figure 8.29: Apogee Impose places 5 different-sized elements on a single Press Sheet
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For complex positioning of elements you can switch to manual positioning mode 
and override the Press Sheet Layout and Auto Fit rules for a selected Press Sheet.

Product View of 
Unbound Products

The structure of an Unbound Product as shown in the Product View is similar to 
that of a Bound Product, with the following differences:

 no spine view: the Product consists of a number of loose Parts; double-sided 
Parts have their front and back pages next to each other

 each Part has its own color so it can be identified easily on the Press Sheet

 the Part node shows the Part type, name and copy count

 the Fold Sheet node indicates the size of the page and the page icon is scaled 
to compare with other pages

Figure 8.30: Elements (Parts) are repeated on a Press Sheet to maximize sheet usage
Apogee Reference Guide



478 IMPOSING UNBOUND PRODUCTS
Copy Count When ganging different elements on a single press sheet, Apogee Impose calcu-
lates and displays the copy count for each element in the Part node. Each 
element can have a different requested copy count and this is taken into account 
to calculate the press run length.

The calculated press run length is displayed in the Press Sheet node.

1 Product with Elements
2 Elements (Part node) indicating 

actual and requested copy count
3 Elements (Fold Sheet node) with 

size indication
4 Press Sheet with ganged elements
5 Presses with Printing Plates per 

Production Set

1

2 3

4
5

1 Actual copy count in blue (over-run)
2 Requested copy count
3 Actual copy count in red (under-run)

1

2

2

3
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Understanding 
Ganging in Apogee 
Impose

Unbound products can be used to combine elements from different projects to 
maximize the available space on a Press Sheet. Each element can be set up using 
the Part editor.

The elements are combined by Apogee Impose based on the following selection 
criteria:

 printing colors

 paper stock and weight

 keep on separate Press Sheet option per Part

 single or double-sided

In the Auto Impose window you see the elements combined in Parts and you can 
fine-tune the settings before letting Apogee Impose create the imposition.

Step and Repeat 
(Manual 
Imposition)

With at least one element placed on a Press Sheet, you can use the Step & Repeat 
tool to fill part or all of the Press Sheet with the element.

 To use the Step & Repeat tool

1 Drag the element, e.g. a business card, that you want to repeat onto the Press 
Sheet.

1 Calculated press run length

1
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2 Click the Step & Repeat button in the toolbar.

3 Click the element and hover over the element until blue arrows appear along 
the sides of the element.

4 Choose a side and drag to repeat the element in the direction that you want. 
The number of duplicates is displayed.

To expand diagonally, hover over a corner until you see two arrows and drag.

NOTE: Press the ALT key while dragging to suppress specified margins and 
bleed between elements.

Positioning Palette For the complex positioning of elements in mainly unbound products, you can 
switch to manual positioning in the Product View and use the Positioning 
palette.

In this mode, Apogee Impose snaps dragged elements to align with other 
elements when they are close to these other elements and you can suppress 
margins and bleed if you want.

NOTE: If you do not switch to manual positioning mode, Apogee Impose 
continues to apply its rules as you reposition the elements on the Press Sheet.

 To switch to manual positioning mode

1 Click the Press Sheet node you want to apply manual positioning to.
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2 In the Inspector, select the arrange elements manually check box in the 
Press Sheet Layout pane.

OR

Click the Positioning button in the toolbar to open the Positioning palette 
and select the arrange elements manually check box at the top of the 
palette.

The manual positioning icon is displayed in the title bar of Press Sheet node.

You can now override the selected Press Sheet Layout rule and position the 
elements individually or in groups on the Press Sheet.

 Positioning elements with the Positioning palette

The Positioning palette is used to arrange elements on the Press Sheet. 
Depending on whether you have one or more elements selected, the Positioning 
palette activates relevant tools.

1 Click the Positioning Palette button in the toolbar...

... to open the Positioning palette and select the arrange elements 
manually check box at the top of the palette.

2 Select one element.

You can now either position the element by filling in a Horizontal and 
Vertical position (1)or you can choose one of the Align in Sheet options (2) 
to align along the top, left, right, bottom, center of the Press Sheet. If you 
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select the Align to margins check box, the reference edges are the sheet 
margins as set in the Press Sheet Layout rule.

3 While positioning and aligning the elements you can click the Margin or 
Trim buttons (3) to choose a reference: either the page trim box or the box 
extended with the page trim margins. You can toggle between these two 
references by holding down the ALT key.

4 Select two or more elements.

You can now Group the elements (4) and align the group in the sheet (top, 
left, right, bottom, center) (2), or align the selected elements with each other 
(5).

You can also change the reference here for aligning by holding down the ALT 
key (3).

You can also use the Set Gaps tools (6) to distribute selected elements verti-
cally, horizontally, or both, so that the gaps between the elements are the 
same. If the gap size is not specified (Distribute), the outermost elements 
keep their positions and the elements in between move; if a gap size is speci-
fied (fixed), the left most or bottommost elements remain in position and the 
others move.

 Manual positioning by dragging elements

1 Drag elements from the Flat nodes to the Press Sheet or use the Step & Repeat 
tool to copy elements already on the sheet. 

2 Select one or more elements using conventional Windows key combinations.

3 Drag the element or group to the desired position.
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Apogee Impose snaps the element or group to align with the Press Sheet 
margins, edge or gripper or with the edge of other elements, highlighting the 
edges as you drag. You can also snap to the trim box by holding down the ALT 
key.

The following color code is used for this highlighting:

NOTE: An error icon appears if the positioning has created a conflict. Open the 
Snag List for details.

 Reverting to the Press Sheet Layout rule from manual positioning

You can always revert to automatic positioning by the Press Sheet layout rule. If 
the manual arrangement contains overlapping elements, these elements are 
rearranged so there is no overlapping and they can be cut.

 Clear the arrange elements manually check box in the Inspector or 
Positioning palette. 

Apogee Impose applies the Press Sheet Layout rule set for the product.

Snap element to... highlight

Edge of other element solid cyan

Gripper solid magenta

Press Sheet Margin dashed magenta

Press Sheet Edge dashed cyan
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NOTE: The layout may be different than the initial layout after reverting.

Elements positioned manually Reverted to Center Center rule
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9 Layout Editor

The Layout Editor is a dedicated workspace for setting up wide-format jobs, 
which are printed on Sign & Display printing devices, packaging jobs and any flat 
jobs that require an intricate layout.
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486 OVERVIEW
Overview

The Layout Editor is used to create wide-format jobs for printing on Sign & 
Display devices. These jobs open immediately in the Layout Editor from where 
they are set up and submitted. In addition, the Layout Editor can also be used to 
prepare the imposition of other unbound flat jobs that require an intricate 
arrangement of products on the sheet, such as packaging jobs. The latter jobs can 
be opened in the Layout Editor using the Imposition Mode selector in the 
Products tab.

NOTE: The Layout Editor workspace does not display all the tabs and inspectors 
as described in the following sections when it is used for packaging jobs or 
regular prepress jobs.

Related topics: • Imposition Mode Selector on page 307

Layout Editor 
Modes

The Layout Editor has two modes when working with wide-format jobs:

 Sheet Layout mode: for uploading, placing and arranging products on sheets

 Print Layout mode: for organizing sheets on the print layout, i.e. the printer 
bed or belt of wide-format printers

The products you want to print are first placed on one or more sheets in Sheet 
Layout mode, and these sheets are placed on print layouts that you can see if you 
switch to Print Layout mode. The print layout represents the printer bed (flat-
bed devices) or the printer belt (roll-fed devices), which can accommodate 
multiple sheets and has the dimensions of the chosen device. A print layout is 
created automatically for each sheet that you prepare in Sheet Layout mode, 
with the sheet positioned by default in the printer’s home position. You only 
need to switch to Print Layout mode if you want to inspect how the sheet is 
arranged on the print layout, or if you need to combine multiple sheets on one 
or more print layouts.

The workspace is similar in both modes, except for a few tools and inspectors 
that are only relevant in the respective modes. To switch between Sheet Layout 
mode and Print Layout mode, click the Sheets or Print Layouts tabs respectively 
above the Products panel. You can also edit a placed sheet by double-clicking it 
on the print layout.

NOTE: Print Layout mode is only available for jobs using wide-format printers, 
i.e. wide format jobs.
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9 LAYOUT EDITOR 487
Open and Close the 
Layout Editor

The Layout Editor is opened when you create or edit a wide-format job or a 
packaging job. Alternatively, you can open the Layout Editor from the Jobs 
window:

 Choose File > New Wide Format Job.

The Layout Editor opens and a new wide-format job is created using the 
default template.

OR

 Drop an image or document on a supported output device, or context-click a 
device and choose New Wide Format Job.

The Layout Editor opens and a new wide-format job is created using the 
default template for the device.

OR

 Select a job in the Job List and click the Edit Job icon in the Jobs window 
toolbar or choose Edit Job in the context menu.

The Layout Editor opens and a new wide-format job is created using the 
default template.

To exit the Layout Editor, submit the job and choose Delete Job (new job), or 
Discard (existing job). See “Applying Changes and Submitting a Job” on 
page 580 for more information.

Related topics: • Creating Templates for Wide Format Jobs on page 688
• Templates on page 682
• The Jobs Window on page 140.
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488 OVERVIEW
Figure 9.31: Sheet Layout mode with different products placed on a sheet

1 Product panel
2 Mode buttons and Sheet tabs
3 Sheet panel
4 Inspectors
5 Edit in Job Editor, Submit and Apply Changes buttons
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NOTE: The Print Layout Editor is only available for Wide Format jobs.

Figure 9.32: Print Layout mode with different sheets placed on a print layout

1 Sheet panel
2 Mode buttons and Layout tabs
3 Print Layout panel
4 Inspectors
5 Submit and Apply Changes buttons
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490 OVERVIEW
Figure 9.33: Layout Editor with different products placed in an offset job

1 Products list
2 Mode buttons and Layout tabs
3 Products panel
4 Inspectors
5 Submit and Apply Changes buttons
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Product Panel

The Product panel displays thumbnails of the products that you upload and want 
to place on the sheet for printing.

You can upload artwork files (images and documents) and CAD files to create 
products.

NOTE: Many of the features in the Product panel only apply for the Sheet Layout 
mode. Remember that you have a Sheet Panel that contains all your sheets when 
working in Print Layout mode.

Adding Products Use the following methods to add products to the Product panel:

 Drag and drop one or more products onto the Product panel.

 Drag and drop one or more products onto a sheet.

 Drag and drop one or more products onto a printing device in the Jobs list.

 Click the + button in the top right corner of the Product panel and select one 
or more files from the location of your choice.

 Choose File > Add Products and select one or more products from the 
location of your choice.

If you add a product with the same file name, you are prompted to cancel, 
update or just add the new product:

 Update: Adds the file as a revision of the previous one. This replaces all 
placed products of the existing file with the new one.

 Just Add: Adds the file to the job as a new file with the same file name but 
with a copy suffix.

 Cancel: Cancels the action.

Thumbnails of the uploaded products are displayed in the Product panel.

Product Processing Status

While an uploaded product is being processed, you will see a product icon with 
a green background. When the processing is finished, you see a thumbnail with 
the file name and physical dimensions of the product.
Apogee Reference Guide



492 PRODUCT PANEL
Adding Products from Artwork

When choosing artwork files to add products to the Product panel, you can 
change the default information and provide additional information.

NOTE: This needs to be selected in your Preferences. See “General” on page 92.

Organizing 
Products

Click the cogwheel to display a menu for organizing and filtering the products 
you see in this panel.
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9 LAYOUT EDITOR 493
1 Cogwheel menu
2 Add Products button
3 Number of products displayed according to the chosen filter
4 Product status icons, errors and warnings
5 Instances of a product on all the sheets of a job
6 Product details: file name and physical dimensions
7 Product preview status
8 Product color

Tool Tip

A tool tip appears when hovering over the entire area of the product’s cell.

1

2

3

5

6

8

7

4
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494 PRODUCT PANEL
The tool tip shows the following information:

 Product name

 Artwork and design sources names with alignment values (snap-values)

 Requested and actual copy counts

 Content IDs, when the product is assigned to frames with content ID.

Add Products

The following commands are available on the Add Products button: 

 Add Products: Creates products from a content file (e.g., PDF).

 Add Products From CAD: Creates products from a CAD file.

 Add Product(s) From Frame(s): Create product(s) from the selected 
frame(s).

 Duplicate Product(s): Duplicates the selected product(s).

 Place CAD layout: Creates a sheet from a CAD layout file or place a CAD 
layout on a sheet. 

Cogwheel Menu

The following commands are available on the cogwheel menu:

 Show all: Shows all products in the job.

 Show placed: Shows only the products that are placed.

 Show placed on current sheet: Shows only the products that are placed on 
the current Sheet Layout. 

 Show not placed: Shows only the products that are not yet placed.

 Has artwork: Shows products that have artwork assigned.

 Has no artwork: Shows products that do not have any artwork assigned.

 Single-sided: Shows products that are single-sided.

 Double-sided: Shows products that are double-sided.
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9 LAYOUT EDITOR 495
 Sort by file name: Sorts the products alphabetically by their names, in 
ascending order.

 Sort by type: Sorts the products alphabetically by the file type of its artwork, 
in ascending order.

 Sort by Width: Sorts the products by their widths, in descending order.

 Sort by Height: Sorts the products by their heights, in descending order.

 Sort by Largest Dimension: Sorts the products by their largest size (i.e., the 
maximum of the width and height), in descending order.

 Show small thumbnails: Shows smaller thumbnails.

 Show large thumbnails: Shows larger thumbnails.

 Fit to largest: Shows thumbnails with a dynamic scale, where the widest 
thumbnail determines the scale.

 Fit each: Shows thumbnails with a dynamic scale per image, where each 
image is fit individually to the width of the panel.

 Show Product Colors: Colorizes the backgrounds of the cells using the 
product’s colors and draws a color picker to select the color.

 Show Both Sides: Shows a thumbnail that combines the front and back sides 
of the product side by side.

Managing/Editing 
Products

In the Product panel, context-click a product to display the following commands 
for this product:

 Get Info: displays the Info dialog box with information about the original 
product file organized in the General, Dimensions and Resources tabs; the 
Resources tab lists the fonts, products and spot colors used in the original 
product.

 Show Preflight Report: opens a PDF with a preflight report for the selected 
product, if available.

 Export Original File/Normalized PDF: exports the original file or normalized 
PDF to a location of your choice.

 Proof Product: opens the QuickProof dialog to proof the selected products. 
See “QuickProof Products and Sheets” on page 594.
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 Delete Product: deletes the selected products from the Product panel, not 
from your disk.

 Duplicate Product(s): creates an exact copy of the products. See “Duplicating 
Products” on page 527.

 Assign Artwork: opens the file explorer to select artwork to add to an empty 
product.

 Front/Back: changes the front/back artwork of a product:

 From Available: selects a previously uploaded page from the sub-menu; 
list of all artwork that is available in the Page Store.

 Open: browses the file system and loads the artwork from a file.

 Blank: selects to have a blank side.

 Mirror: mirrors the current artwork, disabled when there is no current 
artwork.

 Swap with back: swaps the assignment with that of the other side (front/
back).

 None: selects to have no artwork on that side.

 Get Info: shows the Get Info window for the assigned artwork. 

 Show Preflight Report: creates and opens the Preflight Report for the 
document that is assigned to the current side.

 Check Out and Edit Document: edits the document in the selected editor.

 Design: changes the design of a product:

 From Product: lists the sub-menu with the other products.

 Open: browses the file system and loads a design from a CAD file.

 From Front: the artwork assigned to the front, disabled when the front 
has no artwork.

 From Back: the artwork assigned to the back, disabled when the back has 
no artwork.

 Mirror: mirrors the current design.
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 None: sets the design to a rectangle with the size specified by the Product 
size, disabled when the Product size is From design.

 Turn Over: turns over the product(s) contained in one or multiple frames.

 Mirror Product: mirrors the front and back artwork and mirrors the design.

 Convert to Single-sided Product(s): creates two single-sided products from a 
double-sided product (front/back) with the artwork assigned to the 
respective sides.

 Convert to Double-sided Product(s): combines two products (or multiple 
pairs of products selected in the Product panel) into double-sided products.

 Open in Product Editor: opens the selected product in the Product Editor.

 Edit with Preview: opens the product in Preview; this feature is useful for 
soft-proofing images which are color managed; you can perform color 
adjustments and contrast curve adjustment; see “Previewing Job Results” on 
page 99 for more information on working with Preview.

 Check Out and Edit Document: opens images and documents in Acrobat or 
any other PDF Viewer/Editor application such as the Amfortis Editor, from 
where they can be checked in after editing.

 Auto-Layout Product: opens the Auto Layout dialog box, see “Placing 
Products with Auto-Layout” on page 533.

 Auto Fill Products: opens the Auto-Fill dialog box, see “Placing Products with 
Auto-Fill” on page 537.

 Create Grid: opens the Create Grid dialog box, see “Create Grid” on page 530.

 Collapse Tiles: collapses the tiles of a tiled image, see “Expand or collapse a 
tiled image” on page 654.

 Expand Tiles: expands a tiled images to see the individual tiles, see “Expand 
or collapse a tiled image” on page 654.

 Fitting: opens the Fitting Options dialog box where you can set the cropping, 
see “Fitting Options Dialog Box” on page 517.

 Revert Product Size: reverts the size of the original product back to the size it 
initially had when you added it to the Product panel.
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 Locate Product on Sheet: highlights all the instances of a product/sheet on 
the current or first available sheet/print layout.

In the Print Layouts panel, context-click a product to display the following 
commands for this sheet:

 Delete Sheet: deletes the selected sheets from the Print Layout. panel. 
Deleting a Print Layout does not delete the Sheet Layouts that it contains.

 Duplicate Sheet: duplicates a Print Layout. This creates an exact copy of the 
current Print Layout, including all Sheet Layouts. See “Duplicating Products” 
on page 527.

 Edit Sheet: switches to Sheet Layout panel to allow editing the sheet. 

 Locate Sheet: locates the placed instance of a sheet on the Print Layout.

 Proof Sheets: opens the QuickProof dialog to proof the selected sheets. See 
“QuickProof Products and Sheets” on page 594.

NOTE: The Print Layout Editor is only available for Wide Format jobs.

Product Status Icons

The design of the product has a contour-defining operation (other than the frame or trim-box).

The product is double-sided.

At least one of the product’s artworks was rejected. In addition, the thumbnail of the rejected 
artwork is shown with a red diagonal line.

At least one of the product’s artworks has remarks other than rejected.

At least one of the product’s artworks could not be aligned to the design.

At least one of the product’s artworks could not be aligned to the design with great 
confidence.

The product is Locked or Uniform.

The product requires vertical or horizontal Grain/Flute and there are no placed instances that 
violate that requirement.

The product requires vertical or horizontal Grain/Flute, but at least one placed instance 
violates that requirement.

The product has white content, either from the artwork or generated.
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Sheet Status Icons

The product has varnish content, either from the artwork or generated.

The product has primer content, either from the artwork or generated.

The image is being edited via an external editor.

Indicates that full-gamut color management is applied.

‘F’ shows the effects of the rotation and mirror attributes (here shown with 90 degrees 
rotation and no mirroring.

Indicates a preflight report has been generated for the image.

Image preview has been generated (gray) or is being processed (green).

Color adjustments (saturation, contrast, curves) have been made in Preview.

The product has Image Operations that prevent changing the product’s size (tiling, canvas 
extensions, etc.).

There is a notification or snag message present on the product. The icon depicts the severity 
of the status: error, warning or intervention required.

The design of the sheet has a contour-defining operation.

The sheet is Locked.

The sheet’s workstyle and sidelay.

The sheet has Grain/Flute running in the specified direction (either can be long or short).

The sheet has a custom bleed mask. The mask is up-to-date (white) or needs reviewing 
(yellow). 

The sheet has white content, either from the artwork or generated.

The sheet has varnish content, either from the artwork or generated.

The sheet has primer content, either from the artwork or generated.

There is a notification or snag message present on the sheet. The icon depicts the severity of 
the status: error, warning or intervention required.
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Clicking the status icon opens the message(s) for that sheet/product in the Snag 
List.

Inspecting 
Products

You can use the Product inspector to inspect one or more products in the Product 
panel before placing them on a layout. See “Frame/Product Inspector” on 
page 569 for more information.

You can also use some of the tools in the positioning toolbar for a product 
selected in the Product panel: size, scale, mirror and rotate the product. See 
“Positioning and resizing products with the positioning toolbar” on page 511.

Changes you make to the original in the Product panel do not affect products 
that are already placed on the sheet and vice versa.

Product Previews When you upload products to the Product panel, Apogee does not process 
product previews automatically by default.

NOTE: You can change the default behavior and let the system create previews 
automatically when you add products to the Product panel. See “Preferences” on 
page 92.

When products are added to the Product panel, the Create Previews button 
appears in the bottom right corner of the Layout Editor. Click this button when 
you are ready to create the previews.

Products with a preview are indicated in the Product panel with a magnifying 
glass icon. This icon is grey if the preview has been generated and green while 
the preview is being processed.
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 Create product previews

If automatic product previews are not selected in your Apogee client 
Preferences, you can create previews as required as you work in the Layout 
Editor.

 Context-click one or more products in the Product panel and choose Edit with 
Preview.

This creates a color-managed preview of the selected products and opens the 
preview immediately in the Raster Preview module when the processing is 
finished. The magnifier status icon in the Product panel changes from green 
to gray to indicate the previews are ready.

OR

 Click the Create Previews button in the bottom right corner to create product 
previews of all the products in the Product panel.

Previews of all the products in the Product panel are generated in the 
background. The magnifier status icon is gray when the previews are ready. 
The previews can be opened immediately in the Raster Preview module.

OR

 Double-click a product in the Product panel.

You can change the default behavior so the Raster Preview module is opened 
and previews are created instead of opening the Product Editor. See “Prefer-
ences” on page 92.

If you change settings that modify the preview (for example, choose a 
different printer), the Create Preview button re-appears and you can choose 
whether you want to update the previews or not. See also “Applying Changes 
and Submitting a Job” on page 580.
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 Previewing white and special colors

The Raster Preview module has special features for previewing white ink and 
other special colors such as varnish and primer.

1 In the Raster Preview module, make sure the Inks palette is shown.

2 In the Ink table, ALT-click the eye icon next to the white ink.

The white ink is drawn in grayscale with 100% white drawn as 100% black. 
The other inks are hidden.

3 ALT-click the eye icon again to show all the colors.

Alternatively, you can choose to show white in a different color, as a mask.

1 Click the color patch for the white ink and in the Viewing Options dialog box, 
choose As Mask.

2 Choose a color and an opacity with the slider.

3 Click OK.

The white layer is drawn in the selected color and opacity on top of the other 
layers.

Related topics: • Previewing Job Results on page 99

File Types The following file types can be processed:

 Content files: Files that contain the content to be printed. In some cases, such 
files may also contain structural (non-printing) information that can be used 
by Apogee.

 Image file types: TIFF, JPG, PNG, BMP

 Adobe PhotoShop (PSD) and Illustrator (AI)

 PDF, PS, PSB, EPS

 CAD files: Files that contain structural information but no content.

 CFF2, DXF

All file types are converted to an internal PDF file format in the background, but 
they keep their original name and file extension.
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NOTE: If you upload a PDF document that consists of several pages, each page is 
displayed in the Product panel as an individual product. The page no. is suffixed 
to the file name.

 Placing and arranging products on a sheet

NOTE: Some of these shortcuts can also be used for placing sheets on printer 
layouts.

To Drag the product and

Place one or more products at the cursor position without ganging 
them.

Hold SHIFT and 
release

Switch between snapping to margins (magenta snap guides) and 
snapping to edges (blue snap guides).

Press ALT

Restrain movement horizontally and vertically. Hold SHIFT

Cancel the product placement. Press ESC

Rotate one or more products 90° counterclockwise, while moving 
them

Press space bar once

Copy a selected product. Press CTRL + C

Paste a copied product. Press CTRL + V

Center a product on the current sheet or on a new sheet if the current 
one is not empty. Multiple selected products are centered on individual 
sheets.

Press C

Center a product on the current sheet even if it is not empty. Multiple 
selected products are centered on individual sheets.

Press SHIFT + C

Duplicate one or more selected products according to the copy count 
and gang the products on the current and new sheets.

Press N

Duplicate one or more selected products according to the copy count 
and gang the products on the current and new sheets but starting at 
the cursor position.

Press SHIFT + N

Duplicate one or more selected products according to the copy count 
and center the products on the current sheet if empty and on new 
sheets.

Press N + C

Duplicate the selected product and fill the current sheet if empty. Fill 
one sheet for each product if multiple products are selected.

Press F

Duplicate a selected product and gang the products with existing 
products on the current sheet to fill the sheet. Selecting multiple 
products fills multiple sheets.

Press SHIFT + F

Duplicate the selected product and fill and center on the current sheet 
if empty. Fill one sheet for each product if multiple products are 
selected.

Press F + C

Rotate the selected product or products clockwise. Press R
Apogee Reference Guide
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Rotate the selected product or products counterclockwise. Press SHIFT + R

Mirror the selected product or products clockwise. Press M

Mirror the selected product or products counterclockwise. Press SHIFT + M

To Drag the product and
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Layout Panel

NOTE: Most of the features in the Layout Panel apply for both the Sheet Layout 
mode as well as the Print Layout mode. Remember that you work with sheets on 
a print layout when in Print Layout mode.

The sheet layout panel consists of one or more sheet tabs where products are 
placed, positioning tools to position the products on the sheet, and palettes for 
inspecting the sheet in more detail.

1 Positioning toolbar
2 Sheet with placed products
3 View Options palette
4 Marks palette
5 Layout toolbar

Figure 9.34: The layout panel (Sheet Layout mode)
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506 LAYOUT PANEL
1 Positioning toolbar
2 Products panel
3 View Options palette
4 Marks palette
5 Layout toolbar

 Add a Sheet

 Click the + button next to the Sheet 1 tab.

OR

Drag a product onto the + button

OR

Choose Sheet > New Empty Sheet.

NOTE: If sheet media is used, layouts are added automatically to 
accommodate products that you add to an existing layout that does not have 
sufficient space for the product.

Figure 9.35: The layout panel with different products placed in an offset job
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 Delete a Sheet

 Context-click the Sheet tab you want to delete and choose Delete Current 
Sheet.

OR

Select the Sheet Layout and choose Sheet > Delete Current Sheet.

Default Product 
Placement

Products are placed on the sheet by dragging and dropping. They are arranged 
automatically in a logical sequence. This initial placement of products is referred 
to as the default product placement or ganging.

 Select one or more products in the Product panel and drag them onto the 
sheet.

The first product is placed against the sheet lay, which is an indication of the 
leading edge of the printer. For Anapurna printing devices, this is the bottom 
right corner of the sheet; for Jeti printing devices, this is the bottom left 
corner of the sheet.

Subsequent products are ganged adjacent to the placed products, row by 
row. When the sheet is filled, a new sheet is added automatically. 

Products are placed on the sheet at their native size and they are enclosed in 
a blue frame.

The resolution of a product is checked when you place it on a sheet. If the resolu-
tion is too low, a warning icon appears in the Product panel. Click this warning 
icon to open the Snag List. See “Snag List” on page 551.

If you want to print several instances of the same product and you have set the 
copy count, you can fill the sheets while dragging the products onto the sheet.

 Select one or more products in the Product panel and press “n” or “N” while 
dragging them onto the sheet to duplicate the products in accordance with 
the copy count.

The sheet is filled with the products in accordance with the copy count. 
Additional sheets are created if necessary to accommodate the copy count. If 
multiple products were selected, the sheets are first filled with the first 
product in the Product panel and then with the second product, and so on, 
until the copy count for all the products is obtained.
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NOTE: The default placement of sheets on the print layout can be specified in the 
Media Layout tab. 

Placing Products 
Interactively

The default product placement can be modified extensively.

 Moving Products

 To move one or more products on the sheet, select them with the selection 
tool and drag them randomly on the sheet.

You can also restrain the dragging to a horizontal and vertical movement by 
pressing SHIFT as you drag. Snap guides can be activated to help you align 
products or bounding boxes with each other and with the edge of the sheet. 

 Centering Products

 Press “c” or “C” to move one or more selected products to the centre of the 
sheet.

If you select multiple products, the group of products is centred. Selecting 
multiple products consecutively will superimpose the products on top of each 
other.

Figure 9.36: Snap guides to align products on a sheet
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 Snapping to Margins or Edges

 Choose View > Guides > Snap to Margins or Snap to Edges to display 
magenta or cyan snap guides as you move products on the layout.

With either of these options selected, you can switch between snapping to the 
finishing margins of a product or snapping to its edges by holding down the ALT 
key. See “Frame/Product Inspector” on page 569 for information on setting 
finishing margins for products.

The following color codes are used for the snap guides:

 Grouping products

 You can select multiple products using conventional Windows key combina-
tions. Multiple, selected products are enclosed in a blue bounding box. To 
keep these products together, choose Arrange > Group.

The bounding box changes to black. The group of products can be moved on 
the layout interactively by dragging or with the positioning tools.

Snapping snap guide color

Finishing margin of the product to the margin of another 
product or to the edge of the sheet

solid magenta

Finishing margin of the product to the margin of the sheet dashed magenta

Edge of the product to the edge of another product or to 
the edge of the sheet

solid cyan

Edge of the product to the margin of the sheet dashed cyan

Figure 9.37: Snapping to product finishing margins (magenta snap guides)
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 Rotating products

 While placing or moving one or more products on the sheet, press the SPACE 
bar once to rotate the product 90° counterclockwise, twice for 180° counter-
clockwise, etc.

OR

Select a placed product and press the SPACE bar or use the rotation tool in 
the positioning toolbar.

 Restoring the default placement

 After moving products interactively, you may want to restore the default 
placement of one or more products. Select the product you want to reset and 
choose Layout > Rearrange Frames.

The selected products are ganged according to the default placement.

 Copy products to another sheet

1 Select one or more products on the active sheet and press CTRL+C to copy 
them

2 Go to another sheet and press CTRL+V to paste the copied products on this 
sheet.

 Removing Products

 To remove one or more products from the sheet, select them with the selec-
tion tool and press the Delete button, or press CTRL+X.

The product or products are removed from the active sheet.

Removed products are not deleted from the Product panel and can be placed 
again on the same or a different sheet.

 Shortcuts for overriding the default product placement

 Use the following keyboard shortcuts to override the default placement of 
the products when dragging them onto the sheet or moving them once they 
are placed on the sheet:

NOTE: Some of these shortcuts can also be used for placing sheets on printer 
layouts.
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 Positioning and resizing products with the positioning toolbar

The positioning toolbar provides tools for arranging and resizing products on 
the sheet interactively.

Select one or more products on the sheet to activate the tools.

1 Horizontal and vertical coordinates relative to the chosen reference point
2 Set size with aspect ratio lock; set Auto-fit option
3 Rotate/mirror one or more products on the sheet
4 Align in sheet
5 Align multiple products with each other
6 Set the gaps horizontally or vertically
7 Group/ungroup multiple products

Depending on whether you have one or more products selected, the positioning 
toolbar activates the relevant tools.

1 Select one product.

You can now either position the product by filling in a Horizontal and 
Vertical position (1)or you can choose one of the Align in Sheet options (4) 
to align along the top, left, right, bottom, center of the layout. If you select the 

To Drag the product and

Place one or more products without ganging them Hold SHIFT and 
release

Switch between snapping to margins (magenta snap guides) and 
snapping to edges (blue snap guides)

Press ALT

Restrain movement horizontally and vertically Hold SHIFT

Cancel the product placement Press ESC

Rotate one or more products 90° counterclockwise, while moving 
them

Press space bar once

Copy a selected product. Press CTRL + C

Paste a copied product. Press CTRL + V

Move a selected product to the center of the sheet. Press C or c

Duplicate a selected product to accommodate the copy count. Press N or n

Rotate the selected product or products clockwise Press R

Rotate the selected product or products counterclockwise Press SHIFT + R

Mirror the selected product or products clockwise Press M

Mirror the selected product or products counterclockwise Press SHIFT + M
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Align to margins check box, the reference edges are the layout margins as set 
in the finishing inspector.

Select a rotation angle in the Rotation drop-down box (3) to rotate the 
selected product, or click the horizontal or vertical Mirror buttons (3) to 
mirror the product along its horizontal or vertical axis.

2 Select two or more products.

You can now Group the products (7) and align the group in the sheet (top, 
left, right, bottom, center) (4), or align the selected products with each other 
(5).

You can also use the Set Gaps tools (6) to distribute selected products verti-
cally, horizontally, or both, so that the gaps between the elements are the 
same. If the gap size is not specified (Distribute), the outermost elements 
keep their positions and the elements in between move; if a gap size is speci-
fied (fixed), the left most or bottommost elements remain in position and the 
others move.

3 Select one or more products.

With the Size tool (2) you can set the size of the product frame. See 
“Inspecting Frames” on page 515 to read how you can fill a resized frame 
with the product. If you selected multiple products (i.e. product frames), all 
the products in the bounding box are modified accordingly.

 Using alignment pins

When placing sheets on a print layout, you can use alignment pins for certain 
printing devices to ensure the sheet aligns with the media.

1 In Print Layout mode, go to the Media Layout inspector.

2 In the Horizontally drop-down list, select the Alignment Pin Set that you 
want to use, at the bottom of the list.

Figure 9.38: A product which is copied, mirrored and snapped to product edges (cyan snap 
guides)
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3 In the second drop-down list, select the pin configuration you want to use. 
See “Alignment Pin Sets” on page 942 for creating alignment pin sets.

The alignment pins are shown on the print layout and you can now position 
your sheets against these pins with the snap feature.

Working with 
Frames

A product placed on a sheet is always enclosed in a frame and most actions you 
perform in the Layout Editor actually affect the frame, not the product. For 
placed products, the Auto-fit check box is selected by default in the Positioning 
toolbar to ensure that the product fits the frame. You can clear the Auto-fit check 
box if you want to manipulate the frame independently from the product, for 
example to crop the product disproportionately. The parts of the product that 
are outside the frame are not printed, except for the bleed.

1 Product resize handle
2 Frame
3 Product icon
4 Product origin (indicates rotation/mirroring)

The frame and the product can be resized independently of each other, for 
example to crop a product.

Figure 9.39: A placed product with its frame highlighted for resizing

1

3

4

1

2
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A product is selected within its frame by clicking the product icon. The cursor 
state changes when you do this, as follows:

NOTE: Context-clicking a product within a frame provides access to the product-
specific commands. See “Managing/Editing Products” on page 495.

Empty frames are frames without a product, which are the result of either 
deleting the product from the frame of a placed product or drawing a new frame 
on the sheet.

Figure 9.40: A placed product, selected and enlarged beyond its own frame

Product frame is selected.

Product is selected.

Figure 9.41: An empty frame
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Empty frames can be arranged on a sheet interactively just like placed products, 
using the Positioning toolbar and commands such as Step and Repeat, Dupli-
cate, etc., and snap guides for aligning. You can also set fitting options to control 
how products must fit in empty frames. Frames also give you more flexibility 
when creating sheet templates. There is no Auto-Layout feature for empty 
frames.

NOTE: Empty frames are saved with a job but they are not processed as content 
when you submit the job. So you will not see frame boxes, etc. in the output.

Related topics: • Sheet Layout Templates on page 583
• Fitting Options Dialog Box on page 517

 Inspecting Frames

The following commands can be performed by context-clicking a frame:

 Add Products From Frame: When one or more frames are selected on the 
sheet, creates products with the dimensions of the selected frames and adds 
them to the Products list.

 Cut: Removes the frames from the sheet.

 Copy: Places a copy of the selected frames on the clipboard.

 Delete Frame: Removes the frame and its product from the sheet.

 Remove Frame: Deletes the product from the frame.

 Duplicate Frame on Sheet: See “Duplicating Products” on page 527.

 Step and Repeat: See “Step & Repeat” on page 528.

 Add Product From Artwork: Creates product by assigning artwork to a frame.

 Assign Artwork: Opens the file explorer to select artwork to add to a frame. 
See “Managing/Editing Products” on page 495.

 Front/Back: Changes the front/back artwork of a product in a frame. See 
“Managing/Editing Products” on page 495.

 Design: Changes the design of a product in a frame. See “Managing/Editing 
Products” on page 495.

 Open in Product Editor: Opens the selected product in the Product Editor.
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 Edit with Preview: Opens the product in Preview. See “Previewing Job 
Results” on page 99 for more information on working with Preview.

 Check Out and Edit Document: Opens images and documents in the selected 
Acrobat or any other PDF Viewer/Editor application.

 Group/Ungroup: Groups or ungroups the selected frames.

 Fitting: This sub-menu provides the following options:

 Fit Product in Frame Proportionally: Resizes the product proportionally 
to fit within the frame.

 Fill Frame With Product Proportionally: Scales the product proportion-
ally to fill the entire frame. 

 Fit Frame to Product: Resizes the frame to fit the product.

 Fill Frame With Product: Scales the product to fill the entire frame, but 
not proportionally.

 Center Product: Centers the product, in its current size, in the frame.

 Reset Fitting: Sets the fitting options of the frame to those of the original 
product in the Product panel.

 Fitting Options: see “Fitting Options Dialog Box” on page 517.

 Size Frame to Sheet: Fills the sheet with the product; this may change the 
proportions.

 Size Sheet to Frame: Sizes the sheet to the selected product frame which can 
be empty or filled.

 Revert Frame: Reverts the frame and product to the size of the original 
product.

 Scale for Bleed: Extends the product beyond the frame to accommodate the 
specified bleed.

 Rearrange Frame: Re-positions the frame to the default placement on the 
sheet and applies modified inspector settings.

 Assign Content ID: Assigns a content ID to the selected frame or all frames if 
none is selected. The frames must be filled.
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 Clear Content ID: Clears the content IDs of the selected frames or all frames 
if none are selected.

 Locate Product in Product List: Highlights all the instances of a product on 
the current or first available print layout.

Fitting Options Dialog Box

The Fitting Options dialog box gives you more detailed control for fitting a 
product within the frame.

 With one or more product frames selected on the sheet, choose 
Arrange > Fitting > Fitting Options to open the Fitting Options dialog box.

OR

 Right-click a frame and choose Fitting > Fitting Options.

OR

 Context-click a product in the Product panel and choose Fitting > Fitting 
Options.

NOTE: You can only set the crop values for products in the Product panel.
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Cropping

The values that you want to apply to products in the frame. If the product fits in 
the frame exactly, the four values are zero, for example when you drag a product 
onto a sheet. Positive values crop the product by shifting the product outside the 
frame. Negative values create more space, a border, between the product and 
the frame. Values in blue mean the Auto-fit settings have introduced extra 
cropping.

Fitting

Here you specify the Auto-fit settings for fitting the product inside the frame.

Auto-fit Product to Frame Select this check box to choose a Scale and Orientation for fitting the product 
automatically in the frame. The check box is selected by default for placed 
products (i.e. products that you dragged on the sheet).

Scale The following options are available to scale the product when Auto-fit is 
selected:

 Fit Product to Frame: scales the product so it fits completely in the frame 
which is not necessarily filled.

 Fill Frame with Product: scales the product so it fills the frame and crops 
the product if necessary.

 Fill Product to Frame Width: scales the product so its width fits that of the 
frame.

 Fill Product to Frame Height: scales the product so its height fits that of 
the frame.

Maintain proportions Keeps the width and height scale factors the same when scaling.

Orientation/Rotate for
better fit

Rotates the product to match the aspect ratio of the frame when Auto-fit is 
selected.

Align Sets the alignment of the product in the frame.

Reset Button Resets the product to fill the frame.

Related topics: • Sheet Layout Templates on page 583
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 Adding frames to a Sheet

1 On the sheet where you want to draw a new frame, select the Frame tool on 
the toolbar at the bottom of the Layout Editor.

2 On the sheet, click, drag and release the mouse to draw the frame.

A frame has an outline and two diagonals from corner to corner. The color 
depends on your View Options settings.

3 With the Frame tool still selected, you can draw additional frames on the 
sheet.

The product block expands accordingly as you add more frames.

Figure 9.42: Unnamed frames inside the product block, on a sheet
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4 To position your frames, click the Selection tool in the toolbar and now you 
can select the frames.

The outline is thicker and has resizing handles.

5 Use the Positioning toolbar to arrange the frames just like you would do with 
products.
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The same snap guides are available to help you align frames with edges and 
margins.

Related topics: • Placing Products Interactively on page 508

 Rearrange frames

The Rearrange command reverts the placed products on a sheet to the default 
placement. Depending on the printing device, the products are ganged from left 
to right or right to left on the sheet. You cannot rearrange locked sheets.

1 Select the products or frames that you want to rearrange on the sheet.

2 Choose Layout > Rearrange Frames.

The selected products or frames revert to the default placement. Some 
products may be placed on a new sheet if the current sheet cannot accommo-
date the rearranged products.

If no products or frames are selected, then everything on the sheet is 
rearranged.

Naming frames (content IDs)

Frames that you draw on a sheet are initially so-called unnamed frames. Frames 
created by dragging products on the sheet are also unnamed. It is possible to 
assign content IDs ([A[, [B], [C], etc.) to frames for automation purposes, and 
these frames are called named frames.

Named frames allow you to use the same product in multiple frames by simply 
dragging the product once onto the sheet. Each product is placed in the position 
and with the size, frame rotation, and fitting options specified for the different 
frames. 

NOTE: Content IDs do not work across multiple sheets. For example, placing a 
product in a frame with Content ID [A] on Sheet 1 does not fill frames with the 
same ID on Sheet 2.

Named frames are extremely useful when creating sheet layout templates.

Related topics: • “Sheet Layout Templates” on page 583

 Naming empty frames (interactively)

Empty frames on a sheet can only be named manually because they have no 
content.
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1 Draw the frame on the sheet with the Frame tool.

2 Switch to the Selection tool and select one or more frames.

3 In the Product Inspector, enter an ID in the Content ID box.

4 Click outside the ID box, and the ID is displayed in the center of the frame.

If you selected multiple frames, the same ID is assigned to each frame.

You can edit the content ID as long as no products are placed on the sheet.

 Naming filled frames

If a sheet contains at least one product, you cannot use the Product Inspector to 
assign content IDs interactively. You would have to clear all the frames first. 

However, there are two methods for naming filled frames automatically: by 
saving the sheet layout as a template (see “Sheet Layout Templates” on 
page 583), or by using the Assign Content IDs command. This command lets you 
assign IDs to filled frames without clearing all the products from the sheet.

1 Select the products you want to name on the sheet.

2 Choose Layout > Assign Content IDs.

The selected products are assigned unique IDs and instances of the same 
product have the same unique ID. If you didn’t select any products, then all 
the frames with products on the sheet are assigned IDs, and empty frames are 
not assigned IDs.
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The content ID is displayed under the product name if this is set to show in the 
View Options.

The content IDs are also displayed under the thumbnail of the original 
product in the Product panel.

In this example you can see that the product has been assigned to 4 frames 
with content ID [A].

NOTE: The same product can also be assigned to frames with different IDs, for 
example, [A,A,B,C,D,D].

3 You can repeat the Assign Content IDs command if you drag more products 
on the sheet. New, unique IDs will be assigned and this is also the case if you 
add the same original product.

4 You can clear the IDs of selected products or all the IDs by choosing 
Layout > Clear Content IDs.

NOTE: If all of your frames have IDs, it’s not possible to re-assign IDs, for example 
when you have deleted a product from the sheet.
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Create Guides The Crate Guides allows you to create multiple guides (guidelines) at specified 
locations.

You can create guides as follows: 

 Drag from the ruler

 Choose View > Guides > Create Guides command to open the Create Guide 
dialog box.

 Choose View > Guides > Create Guides From Frame(s).

NOTE: You cannot add guides to a locked sheet.

 To create guides dragging from the ruler

1 Make that the ruler is displayed.

2 Click and hold the mouse inside the top or left ruler. Drag the cursor into the 
layout pane while holding down the mouse.

3 Release the mouse where you want the guide to be placed. The guide(s) are 
displayed.
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 To create guides from the dialog box

1 Choose View > Guides > Create Guides.

2 The Layout Editor opens the Create Guides dialog box. Specify the guides in 
horizontal/vertical direction(s).

3 The Layout Editor previews the guides in the layout pane. Click the Apply 
button to save the changes, or the OK button to apply the changes and close 
the dialog box.

Create Guides Dialog Box

Position (Horizontal/
Vertical)

Enter the position of the guide you want to create. You can leave this field empty, 
if you do not want to create a guide in that particular orientation.

Step (Horizontal/Vertical) Enter the step distance between each guide to create multiple guides across the 
entire sheet.

Amount (Horizontal/
Vertical)

Specify the total amount of guides when you want to create multiple guides.

 To create guides from frame(s)

1 Select a frame or more frames to use as reference guide(s).

2 Choose View > Guides > Create Guides From Frame(s). 

The Layout Editor creates guide(s) along every edge in the selection, using 
the default guide color.
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 To remove guides

 To remove a guide from the sheet, select the guide and choose View > Guides 
> Remove Guide(s), or context-click the guide and choose Remove Guide.

OR

Select the guide and press the Delete button. 

 To remove all guide from the sheet, choose View > Guides > Remove All 
Guide(s).

NOTE: You can set the colors for the Guides and the Guide Alignment through 
their respective entries in the View Options palette. See “Place Station Numbers” 
on page 542.
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Copy Count, 
Cropping, Scaling

You can use the Product inspector to prepare products before placing them on 
the sheet. See “Frame/Product Inspector” on page 569 for more information.

 With one or more products selected in the Product panel, select the Product 
inspector and set the Copies, Size, Bleed and Finishing operations as desired. 
Drag the products onto the sheet.

The selected products are placed on the sheet and modified accordingly.

Duplicating 
Products

The Duplicate feature allows you to either create a copy of one or more products 
that you select in the Product panel, or duplicate and/or fill a sheet with one or 
more products that you have selected on the sheet.

 Select one product in the Product panel and choose Edit > Duplicate 
Product.

OR

Context-click a product and choose Duplicate.

A copy of the selected product is added to the Product panel and the Copy 
suffix is appended to the file name of the duplicated product.

 Select one or more products or empty frames that have been placed on a 
sheet and choose Edit > Duplicate Frames on Sheet.

OR

Context-click a product and choose Duplicate Frames on Sheet.

You can enter the number of copies you want to make on the sheet, or let 
Apogee fill the sheet.
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Step & Repeat

 Select a product which has been placed on the layout and choose Edit > Step 
and Repeat to display the Step and Repeat dialog box.

OR

Context-click a placed product and choose Step & Repeat.

Step and Repeat Dialog Box

Grid

The maximum number of horizontal rows and vertical columns for placing 
copies are indicated in gray but you can also set the number of rows and 
columns. A message is displayed if these maximum values are exceeded.

Figure 9.43: A product which is stepped and repeated to fill the entire grid of a sheet
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Horizontal Enter the number of copies you want to repeat horizontally. Click the revert 
button to reset the value to the maximum.

Vertical Enter the number of copies you want to repeat vertically. Click the revert button 
to reset the value to the maximum.

Copies Enter the number of copies to fill the layout as required; the number of copies 
should not exceed the number of horizontal rows multiplied by the number of 
vertical columns; a message is displayed if you exceed this maximum.

Fill entire grid Choose this option to fill the grid you defined. The number of copies is entered 
automatically (horizontal rows x vertical columns).

Fill Direction If you choose the option to enter the number of copies yourself, you can also 
choose how the grid is filled: horizontal rows first or vertical columns first.

The total number of copies is indicated in gray in the bottom right corner of the 
dialog box.

Gaps

Horizontal Enter a value for the horizontal gaps between repeated products.

Vertical Enter a value for the vertical gaps between repeated products.
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Create Grid Create/Edit Grid feature allows you to create a grid or modify the existing one 
using the Create/Edit Grid commands. The Layout Editor numbers the frames in 
the grid according to the row/column based order and the last used numbering 
scheme.

Select a product in the Product panel and open the Create Grid dialog box as 
follows:

 Choose Arrange > Create Grid

OR

Context-click the selected products and choose Arrange > Create Grid.

Create Grid Dialog Box

Crate/Modify Grid dialog box consists of the Row/Column layout, Orientation, 
Staggering and Sheet Margins options.
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Row/Column Layout

Horizontally/Across
Vertically/Around

Select the arrangement of the frames: Manual, Center, Distribute, or Repeat:

 Manual: Place the specified amount of frames with the specified gap/step

 Center: Place as many frames as possible and center

 Distribute: Place as many frames as possible and spread out

 Repeat: Place as many frames as possible for continuous printing

Amount The number of frames in the first row or column.

Step/Gap Select how to specify the distances between two adjacent frames: Gap between 
bounding boxes, Gap between contours or a Step size. When you change the 
mode, the Layout Editor displays the corresponding gap value(s).

 Gap between bounding boxes: Specify the minimum distance between the 
frames

 Gap between contours: Specify the minimum distance between the contours

 Step size: Specify the minimum step size

(Minimal) Step/Gap The sizes of the odd and even gaps or steps. 

NOTE: The caption changes depending on the selected fill mode and step/gap 
mode.

Link icon The link icon keeps the odd/even values in synchronization. Click the link icon 
and re-enter values if you want to specify different values for the odd/even 
values. 

Orientation

Orientation Select the orientation of the first frame. The Up orientation is the current 
orientation of the selected frame, regardless of its actual rotation (or mirroring).

Alternate Select whether to alternate the orientation for rows and/or columns:

 All the same: Keep the orientation the same in all rows and columns.

 Alternate rows: Rotate the even rows by 180 degrees.

 Alternate columns: Rotate the even columns by 180 degrees.
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 Alternate both: Rotate all even rows and columns by 180 degrees. Stations 
that are in an even row and even column have the same orientation as the 
first.

Staggering

Stagger Select whether to stagger and in which direction: No Stagger, Stagger 
Vertically/Around, or Stagger Horizontally/Across.

Shift Specify the how far to shift the next row or column. You can use an absolute 
value or a value that is relative to the frame’s size, either as a ratio (e.g., 1/3 ) or 
as a percentage (e.g., 25%). Shift is disabled, when staggering is off.

Restart after Select the check box to restart the staggering after a specified number of 
columns or row. It is disabled when staggering is off.

Restart value and unit Select the value to restart shifting the column/row. If you specify a value which 
is larger than the current number of frames, there will be no restart. The unit is 
displayed either in columns or rows, depending on the stagger direction.

In/Out Select whether to reset the shift and then start shifting again, or to shift back 
until the original position is reached.

Sheet Margins

This section displays the top, bottom, left and right sheet margins. The link icon 
keeps all the sheet margins in synchronization. Click the link icon and re-enter 
values if you want to specify different margins. When you close the link icon, the 
left margin value is copied into the other margins.
Apogee Reference Guide



 

9 LAYOUT EDITOR 533
Placing Products 
with Auto-Layout

The Auto-Layout feature places and arranges all the selected products 
automatically on the sheet according to the chosen layout strategy. The products 
are placed on all the sheets of the job, including locked sheets.

CAUTION: Products already placed on sheets are cleared, even if the sheet is 
locked.

Select one or more products in the Product panel and open the Auto-Layout 
dialog box as follows:

 Choose Arrange > Auto Layout Products

OR

Context-click the selected products and choose Auto-Layout Products.

NOTE: If no products are selected, Apogee auto-layouts all the products in the 
Product panel.

Auto-Layout Dialog Box

Size

Media size By default, the size of the media as defined in the job set-up. Choose a size from 
the drop-down list or enter a custom size. You cannot change this if you have 
already placed products on a sheet.

Products

Copy Count Here you can set the number of copies you want to print of each placed product. 
Apogee calculates the number of sheets that need to be printed to obtain the 
entered copy count. See “Sheet Inspector” on page 576.

Layout

Here you specify the layout strategy.

Type Selecting a layout type shows options which are specific to each type.

True-Shape Nesting: to nest products more intricately based on the cutting path 
of each product.

Rectangular Nesting: to nest products in an intricate layout that may not be 
suitable for guillotine cutting.
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Guillotine Cuts: to nest products in a sheet that is suitable for guillotine cutting.

Rotation It’s possible that more products can be arranged on the sheet by allowing Apogee 
to rotate them. Choose one of the following:

None: No rotation is allowed. Places the products in their original orientation. 

90 degrees: Rotates the products sideways to the left (90 degrees).

180 degrees: Turns the products upside down.

270 degrees: Rotates the products sideways to the right (270 degrees).

90 or 270 degrees: Rotates the products sideways to the left (90 degrees) or to 
the right (270 degrees).

0 or 180 degrees: Keeps the products at their original orientation or turn them 
upside down.

Any angle: Allows to rotate the products when that yield a better fit. You cannot 
control in which direction they are rotated. This option rotates products to meet 
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the grain/flute requirements. If rotation is needed, it rotates the product by 90 
degrees counter-clockwise.

Optimize for Choose whether you want the fitting strategy to reduce waste or reduce the 
number of sheets:

Minimal waste: Reduces the waste (including the overrun, treating off-cut as 
non-waste). 

Minimal sheets: Reduces the number of different sheets, at the expense of 
producing a little overrun.

Single sheet: Places all products on a single sheet, using the copy counts of the 
products as a ratio. This method may produce more waste or overrun.

Single sheet per layout: Places as many copies of a single product on a single 
sheet. As such, there will be as many sheets as there are products. This method 
may produce more waste or overrun.

Allow Overrun % Allows you to set a percentage for the number of extra copy counts to achieve the 
chosen fitting strategy.

Auto-stop Apogee stops searching for the best arrangement once the specified waste level 
is obtained (default is 50%).

Centering Select to center the resulting product block on the media.

Finishing Margins

In this panel you can change the default finishing margins, i.e. the spacing 
between products and the edges of the sheet, as defined in the job set-up. See 
“Finishing” on page 562.

Auto-Layout Progress

This dialog box is displayed when you click the Auto-Layout button and it shows 
the progress of the auto-layout process. If the layout is complex and the system 
requires a lot of time to arrange the products, you can click the Use button to 
accept the Best solution so far. Otherwise, wait until the process is complete 
and the Auto-Layout Progress dialog box closes. The longer you wait, the better 
the proposed sheet.
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Progress The diagram shows the total number of layouts found so far.

Best solution so far The proposed number of sheets and the total run length to accommodate the 
fitting strategy and your copy count as best as possible.

Elapsed time The elapsed processing time to search for possible layouts. 

Auto-Layout Progress Steps

The complete Auto-Layout process can be represented in three different steps. 
Each step clearly marks if something is available that can be ‘used’ for the next 
step.

 Step 1 - Searching for Layouts: This step generates different combinations 
of products and examine whether that combination can be fitted onto a 
sheet, by taking into account the requested copy counts, adjusting some copy 
counts to allow more and better combinations. Every combination is 
examined. When a combination is successful, Auto-Layout shows it as a 
possible candidate, and continues searching for a better one. As soon as a 
candidate layout is found, Auto-Layout shows some information and enables 
the Use button. When you click it, or press the Enter key, process stops 
searching for alternative layouts and moves to the next step. If the candidate 
layout matches the criteria, Auto-Layout process immediately proceeds to 
the next step with that layout.

 Step 2 - Optimizing Layouts: Once a layout has been found and accepted, 
Auto-Layout process tries to compact the layout to provide more off-cut. If 
the current solution is acceptable, Auto-Layout automatically proceeds to the 
next step. If you consider the gain to be good enough, you can then click the 
Stop Optimizing button, or press the Enter key.

 Step 3 - Finalizing: This last step checks and adjusts the clipping paths 
between the products that have overlapping bleed.
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Placing Products 
with Auto-Fill

The Auto-Fill feature places the selected products (or all products if there is no 
selection) in the layout that is on the current sheet.

CAUTION: Products already placed on sheets are cleared, even if the sheet is 
locked.

Select one or more products in the Product panel and open the Auto-Fill dialog 
box as follows:

 Choose Arrange > Auto Fill Products

OR

Context-click the selected products and choose Auto Fill Products.

NOTE: Auto-fill can only be used on a rectangular grid layout with unnamed, 
identical frames.

When the sheet has one or more placed products that are part of the selection, 
they will be removed from the sheet when you apply the Auto-Fill. The sheet will 
not be changed when you cancel the Auto-Fill.

Products that are part of the selection and that are already placed on other sheets 
will be removed from those sheets in the same way Auto-Layout removes them. 
Those sheets will not be changed when you cancel the Auto-Fill.

When the sheet has one or more placed products that are not part of the 
selection, you have to remove them, or to keep the current sheet and make new 
sheets before you apply the Auto-Fill.

Auto-Fill Dialog Box

Auto-fill starts searching for solutions as soon as the dialog opens, using the 
options as they were set during the previous session.

The Solutions table shows the solutions that are found. It updates dynamically 
while the search continues. The search stops when there are no more 
combinations to try or when you apply a solution. The search restarts when you 
change the options. This clears the found solutions.

You can sort the solutions by clicking the columns and select a solution to show 
the product break-down in the Products table. The selected solution remains 
selected, even when the table gets updated.
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Click the OK button to apply the selected solution. Apogee applies the selected 
solution using the current sheet and as many duplicates of it as needed. This 
includes the station numbers and marks that are on the sheet. In a Wide Format 
job, the extra sheets are placed on a Print Layout as instructed by the Layout 
Defaults inspector.

Max overrun The allowed overrun, both per product and for the overall count, expressed in %. 
Default value is from the last session, 10% on the run.

Allow multiple products
per lane

Defines whether each lane can have different products or not. Basically, this is 
the switch between sheet-printing and label-printing. This option is only 
enabled when Allow multiple products per sheet is on.

Allow multiple products
per sheet

Defines whether a single sheet can have multiple products or not. Default value 
is from the last session, allow on first run.

Allow products to appear
on different sheets

Defines whether a product may be placed on different sheets. This option is only 
enabled, when Allow multiple products per sheet is on. Default value is from 
the last session, allow on first run.
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Fix Bleed Overlaps The Layout Editor by default splits the bleed area between products in the 
middle if the products are located too close to each other. In some cases you may 
want to override this behavior, e.g. the bleed of product A needs to be printed 
inside the flap of product B. This is done with the Fix Overlaps feature.

 Choose Sheet > Fix Bleed Overlaps to open the Fix Overlaps dialog

OR

Context-click the selected sheet and choose Fix Bleed Overlaps.

Fix Overlaps Dialog Box

The dialog shows the total number of times products overlap and the number of 
occurrences for each product overlap. You can cycle through the overlaps and 
choose whether A must overlap B, split A and B (no overlap), or B overlaps A. 
Choosing one of these options will fix all the occurrences of the overlap, and the 
wizard takes you to the next overlap. You can cut up a too large bleed zone into 
smaller ones by using the Slice tool. Click the Split Unhandled button, if you 
want to apply the second option (no overlap) to all the overlaps. Click the Reset 
button to start all over again. Open the cogwheel menu to continue fixing 
overlaps on other sheets (other side, next sheet, previous sheet).

Auto-fix

Auto-fix options specify how to split the overlaps, when the remaining bleed 
after fixing is at least the specified size. This allows the Layout Editor to handle 
most of the overlaps automatically.
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Split overlap if remaining
bleed is at least

Select to split the overlap in two equal parts, if the remaining amount of bleed is 
at least equal to the specified minimum bleed.

Minimum bleed The minimum amount of bleed that is acceptable. The value must be smaller 
than or equal zero. This value does not affect manual splits. The minimum bleed 
is used to eliminate a number of overlaps to be reviewed.

Fixing the Current Overlap

This section allows you to handle the current overlap. The header shows the 
number of unhandled, total, and auto-fixed overlaps.

Navigation buttons Navigate between the overlaps. Using navigation buttons, you can select the 
first, previous, next or the last overlap.

Current overlap The sequence number of the current overlap and the number of identical 
overlaps on the sheet. 

NOTE: The sequence numbering ignores the fixes that are made by auto-fix, if the 
Hide auto-fixes is set.

Method Define how to fix the current overlap. When you are on an overlap that is already 
handled, the button that corresponds with the selected action is selected. If the 
fix was made automatically, the label appears below the split-button.

 A over B: Adjust the bleed mask of frame B.

 Split: Adjust both masks.

 B over A: Adjust the bleed mask of frame A.

 Slice tool: Activate the Slice tool.

Slice tool You can slice an overlap that is too large to be handled with a single fix into two 
or more smaller ones. To slice a bleed overlap zone, navigate to the zone that 
needs cutting, activate the Slice tool, move to the location where you want the 
zone to be split and click at the location you want to slice the overlap zone. You 
can revert a sliced overlap by using the Revert icon.

Maximum intrusion When set, allow the overlapping station to bleed into the station that is being 
overlapped, but not more than the specified value.

Split Unhandled Splits all unhandled overlaps. It is disabled, if all overlaps are handled.

Reset All Restores the working bleed mask to the raw bleed mask, e.g., it brings back all 
possible overlaps.
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Cogwheel menu

You can open the cogwheel menu to continue fixing overlaps. 

Fix other side The Layout Editor applies the selected fixes on the current side and moves to the 
other side of the sheet, option is disabled for a single-sided sheet.

Fix next sheet The Layout Editor applies the selected fixes on the current size and moves to the 
front of the next sheet, option is disabled when you are at the last sheet.

Fix previous sheet The Layout Editor applies the selected fixes on the current size and moves to the 
front of the previous sheet, option is disabled when you are at the first sheet.

Preferences  Advance to next when selecting fix: When set, advance to the next overlap 
when you fix the current one. Otherwise, stay at the current fix.

 Hide Auto-fixes: When set, the overlaps that where fixed automatically are 
not included in the navigation. You can uncheck this option, if you want to 
review them.
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Place Station 
Numbers

Station numbers are sequence numbers that identify the stations (frames) on a 
sheet. They can be used to identify, after cutting, where a product was originally 
positioned on a sheet. The numbers appear in station number marks on the 
content (see “Station Number Mark Details” on page 1074). Station numbers 
can be imported with a CAD file, defined in a template or set manually in the 
Product Editor (see “Mark Sets Inspector and Mark Inspector” on page 634).

Station Numbers Dialog Box

This dialog allows you to specify a sequence for numbering stations and what the 
number consists of.

 Go to the sheet you want to number and choose Sheet > Station Numbers to 
open the Station Numbers dialog.

Sequence Click in the first icon to specify in which corner of the sheet the sequence will 
start. The other four icons will change accordingly. Click one of these four icons 
to specify the sequence horizontally and vertically and whether the numbering 
starts at the beginning of a row or column.

Start at Set the sequence number to be used for the first station and for the first station 
of each group, when you select to restart the numbering per row/column or 
product.
Apogee Reference Guide



 

9 LAYOUT EDITOR 543
Restart Select one of the options to restart the sequence numbering:

 Don’t restart: Do not restart the numbering. All stations will have continuous 
sequence numbers.

 Every (main direction): Restart the numbering per row or column, 
depending on the main direction (row/column) of the traversal sequence.

 Every product: Restart the numbering per product.

Format Select whether to print the sequence numbers as numbers or as letters (lower or 
uppercase).

Row/Column/Product
number

Select one of the following options to form the station number by combining the 
sequence number and the group number (row/column/product):

 Don’t include: Do not include the row/column/product number.

(prefix) (sequence-nr) (suffix)

 Before sequence: Print the row/column/product number before the 
sequence number.

(prefix) (group-nr) (betweenix) (sequence-nr) (suffix)

 After sequence: Print the row/column/product number after the sequence 
number.

(prefix) (sequence-nr) (betweenix) (group-nr) (suffix)

Format Select whether to print the group (row/column/product) numbers as numbers 
or as letters (lower or uppercase).

Template Enter the Prefix and Suffix text. Default value is both prefix and suffix fields are 
empty. The #S and #R/#C/#P show the position of the sequence and group 
numbers.

An example of the station number of the first station in the sequence appears 
below the template field, using the specified formatting and template. Click the 
Apply button, to see how the rest of the frames will be numbered and apply the 
changes to the sheet.
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Apply to all sheets Select this check box to apply the same station numbering to all sheets in the job.

View Options 
Palette

The View Options palette is used to show and hide the various components on 
the layout. The list of available options you see in the palette depends on the 
layout mode you are working in – Sheet Layout or Print Layout.

NOTE: Hiding content or marks with the View Options palette does not mean 
they will not be printed.

The following elements can be shown/hidden:

 Preview

 Images: the content of the products placed on the sheet

 Marks: the cutting marks selected for finishing, or other marks
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 White: the white layer of an image (or generated white)

 Varnish: the varnish layer of an image (or generated primer)

 Sheet

 Lay: triangle icon indicating the lay of the sheet

 Image block: the bounding box enclosing all the products

 Margins: the margin around the sheet as set in the Finishing inspector

 CAD Layout name: the name of the CAD layout file or of the Sheet layout 
template

 Background: the area of the sheet where no products are placed

 Ink zone: the area on the print layout where printing will effectively 
occur, similar to the product bleed zone (only for Print Layout mode)

 Gripper: the gripper zone of the selected Generic Press (hidden for Wide 
Format jobs)

 Image

 Product name: the name of the product

 Artwork name: the base name of the artwork on the currently viewed 
side, as shown in the Source list of the Product Editor.

 Station number: the Station number of the frame

 Design name: the name of the design as shown in the Source list of the 
Product Editor.

 Tile number: on a tile, the tile number, row and column numbers

 Content-ID: the content-ID of the frame, if set.

 Size: the size of the frame on the sheet as (w) x (h) (units), with units 
being the same units as those in the Position bar.

 Scale: the scale of the placed product, relative to its original size, as 
(hscale) x (vscale) %.
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 Bleed zone: the bleed path the Layout Editor always draws the actual 
bleed content)

 Bleed overlap: the overlaps of the working bleed path

 Frame Box: the bounding box of the frame (the frame box is always 
shown when the frame is empty, regardless of the state of this option).

 Origin: the lower-left corner of the frame

 Contours: the contour that is used for clipping. When an image has no 
contour-defining Operations assigned or when its Clip to contour option 
is off, the contour follows the frame.

 Design: the paths and texts that associated with Operations that are 
present on the sheet and its products, using the appearance as defined in 
the Line Appearances set that is selected in the Client preferences.

 Printer (only for Print Layout mode)

 Lay: the lay of the print layout that indicates the leading edge of the layout 
and the home position of the printer shuttle. 

 Background: representation of the surface of the printer bed or belt and 
more specifically the area where no printer sheets are placed

 Measurements

 Dimensions: the dimensions of the printer’s sheet or frames

 Product block: the dimensions of the product block and the distances to 
the sheet edges

 Steps/Gaps: the distance between the frames of two neighboring 
products, per pair of elements. 

 Gripper: the size of the gripper (only for Offset jobs)
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 Guides

 Guides: the guides on the sheet.

 Guide Alignment: how closely the frames align to the guides

 Marks

 Marks: the bounding box of the marks

 Hidden Marks: marks that will not be printed due to conflicts; displayed 
in a red, hatched box

In the View Options drop-down list you can select, create, rename or delete 
preference sets for the View Options.
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 To show/hide content, rule-ups and marks

1 Click the Show/hide View Options button in the toolbar or choose 
Window >  View Options to show the View Options palette.

2 Click the individual or group eye icons to show or hide the various rule-ups 
and marks.

3 Click the colored boxes to open a color editor where you can change the color 
of the rule-ups and measurements.

4 Click in the drop-down list at the bottom of the View Options palette to 
choose, create, rename or delete preference sets for the View Options.

Marks Palette The Marks palette is used to place marks on a product or sheet interactively. In 
other words, these marks do not depend on the conditions of a Mark Set and they 
can be placed relative to any possible object on the product or sheet.

The palette contains the following marks categories:

 Image: e.g. Text, Line, Grommet, Crop

 Sheet: e.g. Text, Line, File, Cut, Registration, File

 Press Sheet Marks: e.g. Cut-off, File, Density, Color Bar, Ink-Eater

The various mark types in these categories are managed in the Mark Engraver 
Resource of the Impose Task Processor. Refer to “Mark Engraver” on page 1038 
and “Mark Types” on page 1045 for more information about the different types 
of marks and their settings.

CAUTION: Marks placed interactively may be positioned at unexpected locations 
and on other sheets than the sheet you are working on. 

 To place a mark interactively

1 Click the Marks button in the Toolbar or choose Window >  Show Marks 
Palette to show the Marks palette.

The Marks palette is displayed.
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2 Hover over the icons to see what kind of marks are available.

3 Drag the required mark onto the Press Sheet and release the mouse button at 
the location where you want to place the mark.

NOTE: It is not possible to move the mark once you have dragged it to a certain 
position.

If you select the Mark Inspector, you can see the default settings for the 
selected mark. See “Mark Inspector” on page 576.

4 Change the settings as required.

NOTE: Double-clicking a mark in the Marks palette also places the mark on 
the Press Sheet.

Layout Toolbar Some of the tools described here may only be available in the Product Editor. 
You can also use shortcuts to activate the tools and these shortcuts are case-
insensitive and some only require a single key. For example, type Z or z to 
activate the Zoom tool and then type A or a to return to the Selection tool.
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Selection tool: To select a component or area and display its properties. This is 
the default tool.

Single Instance Selection tool: To select a single instance of marks which are 
placed at various locations, or part of a compound mark. In the Paths inspector: 
selects a path and its anchor points.

Pan tool: To pan layouts in the Layout Editor.

Zoom tool: To zoom into a specific area of a layout.

Frame tool: To draw empty frames on a sheet.

Measurements tool. Use this tool to make measurements on the Press Sheet.

Clear Measurements tool (only activated if the sheet has measurements). Click 
to remove all measurements displayed on the Press Sheet.

View Options palette button: Shows/hides the View Options palette.

Marks palette button: Shows/hides the Marks palette.

(Licensed feature) Presets: To open the Presets dialog box.

Crop image: Activates the crop mode to crop an image (Image inspector in the 
Product Editor).

Split tool: Activates the Split tool to split an image into tiles (Tiling inspector in 
the Product Editor).

Pen tool: Activates the Pen for drawing free-form paths on an image and add-
ing/deleting points of existing paths (Paths inspector in the Product Editor).

Ellipse Path tool: Activates the Ellipse Path tool to draw ellipse and circle paths 
on an image (Paths inspector in the Product Editor).

Rectangle Path tool: Activates the Rectangle Path tool to draw rectangle paths 
on an image (Paths inspector in the Product Editor).

Zoom slider with Zoom to fit and Zoom to maximum buttons, and drop-down 
list with zoom presets
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Snag List The Snag List shows conflicts (errors and warnings) relating to the products in 
the Product panel or the placement of products on the sheet. These conflicts 
should be checked before submitting a job.

 The Snag List is opened by clicking a yellow warning icon or a red error icon

The Snag List contains the following information:

 Left column - top pane: summary of all conflicts.

 Left column - bottom pane: conflict categories sorted by severity with 
errors at the top and OK at the bottom.

 Right column: conflicts of the selected category; some conflicts can be 
clicked to open a detailed report.
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Inspectors

NOTE: Some of the inspectors may not be visible with your license.

NOTE: Most of the inspectors are available for both the Sheet Layout mode as 
well as the Print Layout mode, except where indicated otherwise.

The panel on the right of the Layout Editor consists of a number of tabs and sub-
tabs which are referred to as inspectors.

1 Job Set-Up Inspector
2 Frame/Product Inspector
3 Colors Inspector
4 Mark Sets Inspector (Sheet Layout mode only)
5 Sheet Inspector/Print Layout Inspector

Job Set-Up 
Inspector

In the Job Set-Up tab, you define the job settings for all the sheets of a job.

 Click the open book icon to display the Job Set-Up.

This tab consists of the following inspector panels:

 Printing Set-Up

 Layout Sheets

 Finishing

 Color Management
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 Preflight

 Job Identification

1 Printing Set-Up
2 Layout Sheets
3 Finishing
4 Color Management
5 Preflight
6 Job Identification

Printing Set-Up

In the Job Set-Up inspector, you choose the media, printing quality and printing 
device for your job.

Printer

In this panel you select the printing device.

Device A list of the printing devices which are available in your printing environment. 
The device you used for the last submitted job is displayed when you create a 
new job.

Media

In the Media panel you choose the media you want to print the job on and set its 
size. 

Media This drop-down list displays all the available media, i.e. media for which 
Calibrated Printing Modes exist. See “Media Hub” on page 1088. The media you 
used for the last submitted job is displayed when you create a new job.

Print on roll Select this check box if you want to use roll media. This disables the Height 
setting for the Size of the media as this is defined by the printing device, and 
filters the sizes you see in the Size drop-down list. When you add products to a 
layout, the height increases accordingly.
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Size A drop-down list with all available sheet sizes. The last item in the list, Manage 
Sheet Sizes, is a shortcut to the Sheet Sizes resource. The width and height (W x 
H) of the sheet, and page orientation (portrait or landscape) are displayed under 
the drop-down list. You can also edit these fields to create a custom sheet size 
and save this custom size by choosing Save As in the drop-down list. When you 
change the size, the preview in the Layout Editor zooms the new size to fit the 
available preview area. See “Sheet Sizes” on page 690.

NOTE: Only one size can be set for the different sheets of a job.

NOTE: Choose a size which is smaller than the maximum size for the printing 
device to combine multiple sheets on a single print layout.

Thickness The thickness of the media. The default unit is micron; context-click in the box 
to change the unit: micron, mil, mm, inch.

Grain/Flute Choose the grain/flute direction of the current sheet; Short, Long, From size, or 
None.

Quality Select a quality level to suit the visual quality you expect from the printed result, 
depending on the selected printer (e.g. Standard or High Quality). Quality levels 
have corresponding Calibrated Printing Modes. See “Media Hub” on page 1088.

Workstyle Select a workstyle for the selected printer:

 Sheetwise: Sets the default double-sided workstyle to Sheetwise.

 Perfecting: Sets the default double-sided workstyle to Perfecting.

 Turn: Sets the default double-sided workstyle to Turn.

 Tumble: Sets the default double-sided workstyle to Tumble.

Side lay Select the side-lay that is used to align the sheet to the printer’s side-lay:

 Left (Drive side): Printer lay is on the left.

 Right (Operator side): Printer lay is on the right.

Press Parameters

The Press Parameters section is specially used for Security type of Offset jobs. 
Select a press parameter set the drop down box. The gray arrow button is a short-
cut to the Press parameters resource where you can modify the options 
specifically for the current job.
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Distortion Select one of the following options:

 None: Do not compensate for web growth.

 Calculated: Compensate using the distortion values as specified in the 
Distortion Values editor.

NOTE: This option requires a special license.

Edit Distortion Values This button gives access to the Distortion Values editor. It is only displayed, 
when the Distortion is set to Calculated.

The distortion parameters specify the relative change of the sheet’s width near 
the bottom and near the top of the sheet, and the relative change of the sheet’s 
height. The relative change is expressed as a factor, i.e., 1 is no change. Enter the 
distortion values (up to 6 significant decimals) you require and click OK.
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To view the distortion, you can toggle between the distorted and not-distorted 
views by clicking the Distortion (Web Growth) tool in the Tools Palette (Raster 
Preview). It is recommended to zoom in higher resolutions.

Related topics: • Distortion on page 127

Application

In the Application panel you choose how you want to handle printing with 
special colors: white ink, varnish and primer. The data for printing the special 
color can be generated by the printing device (on Printer) or by the system 
(Apogee). If you let Apogee do this, you can also set the opacity or have the ink 
choked or spread.

White Click the triangle to expand the panel. Select the check box if you are printing 
with white and choose the method:

 Fill (on Printer): The printing device fills the area of the product block (with 
bleed) with a solid layer of the special color.

 Mask (on Printer): The printing device prints dots under the color dots; non-
ink zones in the product receive no ink. The density of the ink depends on the 
density of the color dots.

 Fill Entire Image (Apogee): Apogee fills the area of the product with the 
special color at a constant opacity. You can select the opacity.
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 Solid Pixel Mask (Apogee): Apogee prints with a constant opacity under the 
dots inside the bleed path (or cut path/frame) of the product. Only areas with 
data are printed.

 Solid Image Mask (Apogee): Apogee prints with a constant opacity under the 
product which is defined by scanning for color dots at the edges of the bleed 
path (or cut path/frame). 

 Variable Pixel Mask (Apogee): Apogee prints within the bleed path (or cut 
path/frame). The density of the mask depends on the lightness of the product 
and the given opacity. This option disables the Choke/Spread and Opacity 
options.

 From Image (Apogee): The content of the product (usually a spot color) 
determines where to print and the density. The Opacity value scales the 
opacity values in the content file.

Opacity The opacity of the special color. An opacity of 100% corresponds with the White 
density set in the CPM.

Apply Choke/Spread Choke and spread are deactivated by default.

Choke/Spread/Amount To change the direction and amount of choke or spread.

If one of the white printing modes is selected, you can also set how the white ink 
is applied:

 Pre-white: White is to be printed underneath the product. You first print 
the white on the media, then the product on top of the white. The most 
common application is to flood a non-white medium so the product can 
be printed on a white background.

 Post-white: White is to be printed on top of the product. You first print the 
product on the media, then print the white on top of the product. The 
most common application is to print a product on clear (transparent) 
material, where the white serves as the white background.

 Sandwich white: White is to be printed between a first and second print 
of the same product.

Spot color names can be mapped to white ink in the Colors inspector. See 
“Colors Inspector” on page 573.

Print primer Click the triangle to expand the panel. This panel is only visible if the printing 
device has a primer ink in its inkset. The settings are similar to the settings for 
white ink. Primer is printed before other layers.
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Print varnish Click the triangle to expand the panel. This panel is only visible if the printing 
device has a varnish ink in its inkset. The settings are similar to the settings for 
white ink. Varnish is printed after other layers.

Calibrated Printing Mode

A list of calibrated printing modes (CPM) filtered by printing device, so you only 
see the modes which can be used with the specified device. Selecting a mode that 
has a different quality setting than what you specified in the Quality list, changes 
the Quality setting accordingly. See “Media Hub” on page 1088 for more 
information about calibrated printing modes.

The following warnings in red are possible for this option:

 [Multiple]: multiple modes are suitable for the selected combination of 
printing device and quality, and the most suitable modes are displayed at the 
top of the list. Choose a mode.

 [No suitable CPMs]: no suitable modes exist for the selected combination of 
printing device and quality. Choose a mode and the quality and media will 
change accordingly.

Printer Parameters button This button is displayed when a printer and CPM are selected. Click the button 
to open the Printer Parameters for the selected printer:

 Print Mode Parameters

 Media Parameters

You can set and change the parameters specifically for the current job.

The gray asterisk icon next to the button turns red if the printer operator 
changed the printer settings on the machine. You can clear these changes made 
by the operator by clicking Clear All On-Printer Changed Values.

NOTE: Only for printers that support Apogee printer parameters.

Media Deformation

Click the triangle to expand the panel. Select this check box to compensate for 
the stretching or shrinking of the media during printing and finishing. You must 
enter the percentage of stretching or shrinking and the system scales the product 
to compensate.

X (Shuttle) Enter the percentage that the media stretches/shrinks in the shuttle direction.
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Y (Feed) Enter the percentage that the media stretches/shrinks in the feed direction.

Layout Sheets

In this inspector you can modify the default placement of sheets (also referred to 
as ganging) on the print layout.

Any changes you make in this inspector do not affect the arrangement of sheets 
that are already ganged on the print layout. However, you can apply new 
settings to placed sheets with the rearrange or remake commands.

It is possible to specify different setting while working on the same print layout, 
and these new settings apply for subsequent sheets you place on the print layout.

NOTE: The Layout sheets section is only available for wide-format jobs and wide-
format hot tickets.
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Combinations

Combinations controls how the ganging algorithm combines sheets on a Print 
Layout.

Sheets This option defines whether different Sheet Layout can be placed on the same 
Print Layout (pair) or not.

 Place sheets on separate layouts: Place different Sheet Layouts on separate 
Print Layout (pairs).

 Combine sheets if possible: Allow to place different Sheet Layouts on the 
same Print Layout (pair).

NOTE: Single- and double-sided Sheet Layouts are never combined.

Sides This option defines whether flats of the same side (front or back) can be placed 
on the same Print Layout or not.

 Place sides on separate layouts: Place the front and back sides on the front- 
and back Print Layouts of a Print Layout-pair. The front sides are placed on 
the front Print Layout and the back sides are placed on the back Print Layout.

 Combine sides if possible: Combine front and back flats on the front Print 
Layout.

NOTE: This option is hidden, when double-sided printing is not allowed.

The default value is to place sheets and sides on separate Print Layouts. This 
corresponds with the Single sheet per layout in previous versions.
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Positions

The Positioning selects the method that is used to define the stops, i.e., the points 
that can be used to align the sheets with.

Align the nearest stop Position the sheets against a repeating set of stops, keeping a minimum distance 
between them, starting at the home position.

 Stops every: The distance between every stop. A stop can be a registration pin 
or an easy to set/measure marker on the printer’s ruler. The first stop is the 
printer’s lay itself.

 Minimum gap width: The distance to keep between adjacent sheets.

Gap between sheets Position each sheet at a fixed distance from the previous one, starting at the 
home position. This is the default positioning method when combining items.

 Gap between sheets: The distance to keep between adjacent sheets.

 Rearrange and remake the print layout

The following commands are available on the cogwheel menu and Print Layout 
file menu:

 Rearrange Sheets: Applies the current settings in the inspector to the 
current layout.
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 Rearrange All Sheets in Job: Applies the current settings in the inspector 
to all layouts.

 Remake All Print Layouts: Deletes all layouts and remakes the layouts 
according to the inspector settings.

Finishing

In this inspector you can choose your cutting device, set margins and generate a 
cutting file for a digital cutting/routing device if required. See also “Finishing 
Hub” on page 993 for more information about finishing.

Cutter

The drop-down list includes the cutting device brands (Fotoba, Zünd, etc.) 
installed with your resources. Depending on the type of cutter, Apogee either 
draws the necessary cutting marks on the sheet, creates a cutting file with the 
cutting path, or both.

Finishing Margins

Margins are indicated with magenta snap guides when you drag a product next 
to other products.

 Click the gray arrow button to open the Finishing Margins dialog box and set 
a custom value for margins on all sides or selected sides of all the products, 
or choose a preset from the drop-down list. The presets are created in the 
Finishing Hub. See “Finishing Hub” on page 993 for more information.

NOTE: Changing the margins value does not reposition products already 
placed on the sheet.

Cutting Files

Mirror cutting files Select to mirror the entire layout in the cutting file, for example if the media will 
be cut on the back side of the sheet.

Generate Cutting File
(button)

Click this button to generate a cutting file which is used to route certain cutting 
devices. A 1-page PDF document is created for each sheet and contains 
registration marks and cutting lines or a cutting path, but not the actual content.

The cutting files are saved immediately in the FinishingRoot folder in your 
system directory – before you actually submit the job. When you submit the job, 
you can choose to send the cutting file to the cutter.
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Subsequent cutting files that you may create for a job are saved with an incre-
mental suffix. 

This button also allows you to generate and export a CAD file for a Packaging job 
which was not created with a CF2/DXF file, by selecting the Generic CAD Die 
Maker option as a cutter type.

NOTE: A cutting file is only generated for devices that require a separate file for 
registration and routing. For example, the Fotoba cutting lines are printed on the 
sheet so a cutting file with extra cutting marks is not necessary.

Reveal Cutting File
Location (button)

Click this button to display the directory in which the cutting file is created.

The buttons are disabled if no cutting device is selected.

Bleed/Mask

Amount The bleed, i.e. content that goes beyond the trim size, is the same for all products 
as inherited from the job ticket. You can set a different bleed that you want to 
render for the selected product here. Leave the link icon closed to set the same 
bleed on all sides or open the link icon if you want to enter specific values for 
Left, Right, Top or Bottom.

Content From the drop-list you can specify when bleed is created by the system or taken 
from the bleed area available in the image file. These options are mainly relevant 
for images which have a bleed area present in the image file. Only the first and 
the last options are relevant if the image has no bleed area.

 None: Sets the maximum bleed to 0 even if bleed is provided in the image file. 
The bleed box coincides with the canvas extension box or the product size.
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 From image, fixed size: The system uses the bleed in the image file for the 
maximum bleed you specified or only what is available if the bleed in the 
image is less than the specified bleed.

 From image, create if needed: The system uses the bleed in the image file if it 
is equal or greater than the specified maximum bleed; if the image bleed is 
less than the specified bleed, the system creates the bleed and does not use 
the image bleed.

 Always create bleed: The system creates the maximum bleed, effectively 
replacing any bleed in the image file.

Default Bleed Overlap
Handling

If products are placed too close to each other on the sheet, the available area for 
bleed is distributed (split) evenly between the products. This is the default 
behavior with the Automatically split bleed overlaps check-box enabled.

NOTE: This default bleed overlap handling can be overridden whereby you 
choose which product will have its bleed run over the other product. See “Fix 
Bleed Overlaps” on page 539.

Color Management

Select one of the color management options to control how your products are 
rendered. This option is especially important for controlling the output of 
different kinds of products.

Full gamut Converts all input color values directly to the color space of the printing device, 
skipping the output intent of the product.

Simulate Allows you to choose a standard output intent or use the output intent of the 
product. The Simulation drop-down list displays the available output intents.

Decide per document This mode uses Full gamut when it’s safe to do so, and switches to Simulate when 
it’s not safe.

No CMS No color management is applied.

 Click the pencil icon to open the Input Tagging dialog box and edit the action 
list.

In this dialog box you can control how input color values are converted to 
produce the actual output with the default action list. If you change any of the 
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settings, the action list is indicated with an asterisk in the inspector. Click the 
Revert arrow icon if you want to restore the values to those of the action list.

Preflight

Check product resolution Select this check box to check the resolution of placed products, taking into 
account the scaling and the expected quality. Warnings will be displayed when 
necessary.

Preflight Choose a Preflight parameter set from the drop-down list to display Action lists 
and select/clear the action check boxes as required. Type in the search box to 
filter the Action List. Choose Manage Preflight Parameter Sets to edit or create 
parameter sets. See “Apogee Preflight Action Lists” on page 943. Click the arrow 
icon next to an action list to edit the action list for the current job. An asterisk 
indicates that the action list has been modified.

Job Identification

Name The order name identifies your job in the Job List. If you do not enter a name 
here, the job appears in the Job List as Untitled if no products have been 
uploaded for the job, or the name of the first file in your products list is re-used 
for the job name.

Order number An order number is optional but can be useful to group jobs that are assigned the 
same number in the Job List.

Remarks Enter any special comments that apply to this job.

Recurring job Select this check box to set the job is a recurring job to prevent deleting 
automatically. 

PrintSphere

Select the Allow uploading via PrintSphere check box to enable remote users to 
upload files for a job via the PrintSphere service. If you choose a known company 
in the Customer panel, the Assign button is enabled so you can designate 
collaborators. Alternatively, you can specify occasional guest users in the Job List 
by context-clicking a job and choosing Invite PrintSphere Uploader.
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Print Center

This option is only visible if you have the relevant license to work with multiple 
Print Centers. These are printing companies or other service providers belonging 
to the same organization and that can use Apogee independently from each 
other. Choose a Print Center from the drop-down list to manage the Customers, 
Customer’s staff and Printer’s staff for that particular Print Center.

Customer

In this panel you can provide information about the customer and the 
collaborators who will work on the job at hand (optional). You can select a 
known company from the Company drop-down list. A known company is a 
customer which has been defined with all its users and their contact details in the 
WebApproval (ProductionCenter) or PrintSphere applications. Your own 
company and staff are also set up in these applications. See the online help of 
these applications for more information. If you do not select a known company 
and the Company field is blank, you can fill in the contact details (name, email 
and phone no.) of the customer for this job. 

Printer’s Staff and Customer’s Staff

After selecting a known company, you are presented a list of Customer’s Staff 
and Printer’s Staff that you can designate to collaborate on this job. If you did not 
select a company, you only see your own staff. Each collaborator in the 
Customer’s Staff and Printer’s Staff lists can have one or more roles which are 
activated by clicking the icons in the Roles column. The roles are Approver, 
Uploader, and Viewer. Select the Uploader can place files check box if you want 
to allow Uploaders to place files in the run list of a WebApproval job. You can 
change the role of the default collaborators by clicking these icons.

In addition, collaborators in the Printer’s Staff list can be a candidate Customer 
Service Representative (CSR) or a preferred CSR. Clicking the candidate CSR icon 
changes the role of the collaborator to preferred CSR and vice versa. More than 
one preferred CSR can be assigned to a job.

Add Guest

Use this button to add guests to collaborate on this job. Enter the person’s e-mail 
and select the User Roles: Uploader check-box if you want this person to upload 
files for the job. Click the Add Guest button to create the guest who is 
subsequently added to the list of Customer’s Staff.

NOTE: Once the job is submitted you can no longer edit the Customer’s Staff and 
Printer’s Staff lists.
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When you select a company from the Company drop-down list, Apogee looks up 
the name in the Accounts resource and the PrintSphere application to see if the 
account is active or inactive. This status is indicated at the bottom of the 
Customer Contact dialog box.

Job Priority

This option allows you to select the job priority. The following options are 
available from the drop-down list:

 Low

 Normal (the default priority)

 High

You can change the priority afterwards if needed.

Milestone

This optional information can help you keep track of jobs. Selecting the check 
box activates the Due Date drop-down list with the following options:

 Today

 Tomorrow

 End of week

Approver: This user can approve jobs in the WebApproval application.

Uploader: This user can upload files for this job in the WebApproval application.

Viewer

Candidate CSR (Customer Service Representative)

Preferred CSR (Customer Service Representative)

WebApproval account is inactive: the account exists but is not enabled.

WebApproval account is active: the account exists and is enabled.

PrintSphere account is inactive: the account exists but is not enabled.

PrintSphere account is active: the account exists and is enabled.
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 Beginning of next week

You can fine-tune the date by clicking the calendar icon, and also change the 
default time.

NOTE: Setting a due date does not affect the actual processing of a job by the 
Apogee system.

When Job Finishes

Notify Select this check box to send an informational notification, when the job is 
finished.

Archive Select this check box to automatically archive this job when it has been success-
fully completed. The archive location is set during installation.

Delete Select this check box to automatically delete this job when it has been 
successfully completed. You have the following options:

 After 1 day (default value)

 Immediately 

Notifications

E-mail notification to Select this check box to send an informational notification, when the job is 
finished. You can enter the e-mail addresses in the field that appears below, 
separating them with commas.

Job Report

Select one of the Imposition Report Resources from the drop-down menu to use. 
The last option opens the Line Appearance Sets - Impose dialog box to manage 
the Imposition Report Resources.

Export automatically Select this check box to let the Apogee system create the Imposition Report 
automatically, when the job is submitted with an imposition.

NOTE: This option requires a special license.

Export and Open Click this button to create the Imposition Report interactively. The Layout Editor 
generates the report and opens it. 
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 Save, Save As and Delete Job Set-Up

 Click the black triangle to open a menu where you can save and delete a job 
set-up.

Job set-ups that you already saved appear at the top of the menu and can be 
applied to the current job.

Frame/Product 
Inspector

The Frame/Product inspector displays the specifications of products selected in 
the Product panel or on a layout, and allows you to modify them.

 Click the product icon to display the product inspector.

NOTE: Modifications made in the inspector do not affect products already 
placed on a layout.

Selection

Title The title shows the type of the selected item(s); Product, Frame, Group, Grid, 
CAD group, Mixed selection, Embedded product, or No selection.

Size The size of the selected item(s). The size of a placed product can be different 
from that of the original product or that of other places copies, unless the 
product is uniform.

Design The Design shows the name of the design and its origin.

Station The station number of the frame displays the current station number. You can 
change the station number.

Content ID The frame content ID which is only active when a product or frame is selected on 
a sheet. If the frame contains a product, you cannot edit this box because the 
sheet is locked. In this case you will see the locked frame icon next to the box.
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Original

This section shows the name, copy count, the size-breakdown and the lowest 
printed resolution of the product when the selected item(s) refer to a single 
product.

Product name The name of the product.

Fitting options Click the gray arrow next to the file name to open the Fitting Options where you 
can modify the cropping and fitting settings for a product selected on the sheet. 
See “Fitting Options Dialog Box” on page 517.

Copies Enter the total number of copies of the selected product that you want to print, 
i.e. the number of copies on all the layouts multiplied by the run length.

NOTE: This is not the number of products on the current sheet.

Size The dimensions of the original product. If the product has been edited in the 
Product Editor, the most recent product size (with crop and scale) is specified 
instead of the original product size.

Lowest printed resolution The Lowest printed resolution and the corresponding scaling factor. This is the 
lowest resolution found in all placed copies.

Edit product button Opens a product selected in the list of products in the Product Editor.

Bleed/Mask

Amount The bleed, i.e. content that goes beyond the trim size, is the same for all products 
as inherited from the job ticket. You can set a different bleed that you want to 
render for the selected product here. Leave the link icon closed to set the same 
bleed on all sides or open the link icon if you want to enter specific values for 
Left, Right, Top or Bottom.
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Content From the drop-list you can specify when bleed is created by the system or taken 
from the bleed area available in the image file. These options are mainly relevant 
for images which have a bleed area present in the image file. Only the first and 
the last options are relevant if the image has no bleed area.

 None: Sets the maximum bleed to 0 even if bleed is provided in the image file. 
The bleed box coincides with the canvas extension box or the product size.

 From image, fixed size: The system uses the bleed in the image file for the 
maximum bleed you specified or only what is available if the bleed in the 
image is less than the specified bleed.

 From image, create if needed: The system uses the bleed in the image file if it 
is equal or greater than the specified maximum bleed; if the image bleed is 
less than the specified bleed, the system creates the bleed and does not use 
the image bleed.

 Always create bleed: The system creates the maximum bleed, effectively 
replacing any bleed in the image file.

You can fine-tune or change the behavior by clicking the pencil icon next to the 
bleed types to open the Bleed Generator dialog box. See “Bleed Generator” on 
page 615.

Finishing

Clip to contour Select this check box in the Finishing panel to crop and clip the product to the 
contour instead of to the frame. Leave unchecked, if you do not want to clip to 
contours. The default behavior can be changed in the Contour Preferences in the 
cogwheel menu (Set ‘Clip to Contour’ on new products). If the product has a 
finishing operation path and this option is selected, the cut path icon is displayed 
next to the product in the Product panel.

Finishing A list of finishing operations that apply for the product. The table shows how 
Content Elements of the product (spot colors) are mapped to operations. Click 
the Add button to add operations, or click the cogwheel to open a menu where 
you can add, edit, delete, reapply finishing operations and open the Finishing 
Hub. See “Finishing Hub” on page 993 for more information.
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Product operations A summary of the product edits made in the Product Editor: canvas extensions, 
grommets and tiling.
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Colors Inspector The Colors inspector displays the color settings for all the colors used in the job.

 Click the color book icon to display the colors inspector.

Colors

The colors in the Colors list are initially, i.e. before products are uploaded, the 
colors defined for the printing device – generally CMYK and White, Primer and 
Varnish for certain devices. Additional colors (e.g. spot colors) appear in the list 
as you upload products.

Additional colors can be mapped to output colors by choosing the color in the 
list, clicking the Print as check box and choosing a color from the drop-down list, 
or a new Color from Color Books.

The list may also contain one or more finishing colors which means that a spot 
color in the product has been identified for use as a finishing operation. See 
“Finishing Hub” on page 993 for more information about finishing operations, 
and the “Frame/Product Inspector” on page 569 to see how spot colors are 
mapped to finishing operations.

Colors inspector icons

The color will be printed/output (‘Print as’ check box selected).

The color will not be printed/output (‘Print as’ check box not selected).

The color is a process color or will be printed as a process color.

The color is a spot color, varnish or white.

The color is mapped to a color from a color book.

The color is taken from the application.

The color is mapped to a finishing operation.

The color is mapped to a custom color.
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Default Color Policies

The Keep/Convert option determines whether to print colors that are not yet 
listed as spot colors or as process colors:

Keep as spot: Prints the color as a spot color.

Convert to CMYK: Prints the color with process colors.

Notify: Sends a ‘User interaction’ message. You must manually select how to 
print the color.

NOTE: This option is only available for offset printing. In a wide-format job all 
new colors are printed as process colors, unless they are recognized as a special 
color (White, Varnish, etc.) or as a finishing operation.

Emulate Overprint emulates the overprint behavior of colors whose color policy 
has been changed, for example when spot colors are printed with process colors. 
Changing the policy may require reprocessing.

 Never emulate overprint: Don’t emulate overprint.

 Always emulate overprint: Emulate overprint 

 Automatically emulate overprint: Apogee decides whether to emulate 
overprint or not.

Color Definitions

This section specifies how and from where Apogee will retrieve its color 
definitions. You have three search options:

Color Books only Apogee searches the specified books. The job will fail if the color is not found in 
the any of the selected books.

Color Books, then
Application CMYK

Same as above, but now Apogee will also use the application values if the color 
is not found in the books.

The color is mapped automatically as defined for the colors of the device.

The color is mapped to and depends on another color in the list.
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Application CMYK, then
Color Books

Apogee uses the application values, unless the application does not supply the 
values. Apogee will then search the books.

NOTE: When this option is selected, the application might find a color in a 
different color space. In this case, there is a color space conflict.

Books Clicking the Books button displays the book selection window. The table shows 
all the available books that can be searched. 

You can select or clear the check box next to the book’s name to either include 
the book in or exclude it from the search. You can also change the search order 
by using the up and down arrows or by dragging and dropping.

Trapping

Choose a trapping parameter set from the drop-down list or click the arrow to 
specify custom settings. See “PDF Render - Trap Settings” on page 778.

Mark Sets 
Inspector (Sheet 
Layout mode only)

NOTE: The Mark Sets tab controls marks for the selected sheet and/or selected 
products, not for the entire job.

 Click the marks icon to display the marks sets inspector.

This tab consists of the following inspector panels:

 Mark Sets

 Mark Inspector

Mark Sets

In the Mark Sets tab you can choose to place Image marks or Sheet marks on the 
selected products or current sheet.

Image Marks for selected products

Select the check boxes to place sets of marks on the selected product, e.g.:

 apply Grommet marks along the sides of all the products on a sheet

 place text marks on all the products on a sheet
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Sheet Marks for all layouts in job

Select the check boxes to place sets of marks on the selected sheet, e.g.:

 apply Grommet marks along the sides of a sheet

 apply cutting marks for different cutting devices and override the Finishing 
inspector

Press Sheet Marks for press sheets in job

Select the check boxes to place sets of marks on the selected sheet, e.g.:

 apply Color Bars along the press sheet

 place text marks on the press sheet.

Select the Apply changes to all products/layouts in job if you want the 
selected marks to appear throughout the job.

Mark Inspector

This tab shows the details of the selected mark. You can edit the settings for the 
selected mark. See “Mark Engraver” on page 1038 for more information about 
the different types of marks and their settings.

Click the cogwheel and select Manage Mark Sets to open the Mark Engraver. See 
“Mark Engraver” on page 1038 for more information. The cogwheel also has a 
command to switch off all the mark sets.

Sheet Inspector  Click the layout icon to display the layout inspector.

Sheet

Sheet number and lock
status

A sheet can be locked or unlocked as indicated by the black lock icon. Click the 
lock to change its status.

Copy Count The total number of sheets to be printed to accommodate the requested copy 
count of products.

Media, Thickness, Size As chosen in the job set-up. The height is not shown for roll media.
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Grain/Flute Choose the grain/flute direction of the current sheet; Short, Long, From size, or 
None.

Workstyle Shows the actual workstyle for the selected printer:

 Single-sided: The workstyle of a single-sided sheet is set to Single-sided and 
you cannot change it.

 Sheetwise: Sets the default double-sided workstyle to Sheetwise.

 Perfecting: Sets the default double-sided workstyle to Perfecting.

 Turn: Sets the default double-sided workstyle to Turn.

 Tumble: Sets the default double-sided workstyle to Tumble.

Side lay Shows the side-lay that is used to align the sheet to the printer’s side-lay:

 Left (Drive side): Printer lay is on the left.

 Right (Operator side): Printer lay is on the right.

Image Area The width and height of the product box, i.e. the area to effectively be printed. 
This area on the sheet is shown in a small diagram with the distance to the edges 
of the sheet. This is meant to give you an idea of the position of the print area on 
the sheet:

 positive distance: the print area is inside the sheet

 0: the area is exactly on the edge of the sheet

 negative distance: the area is outside the sheet

If all the values are positive, the print area is yellow; if one of the values is 
negative, the area is magenta.
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Cut File Operations

Operation Shows the collected Operations from the products that are on the sheet, e.g. 
Crease, Through Cut, Print Registration.

Print Layout 
Inspector

Print Layout

Run Length The number of times the print layout needs to be printed to obtain the copy 
count of products:

 By default: equal to the sheet copy count because a single print layout is 
initially created for every sheet

 multiple identical sheets on a print layout: the copy count divided by the 
number of sheets on the print layout

 different sheets on a print layout: the sum of the run length for each 
individual sheet

Media, Thickness, Size As chosen in the job set-up. The height is not shown for roll media.

Print Area The area to effectively be printed. This area is shown in a small diagram with the 
distance to the edges of the print layout. This is meant to give you an idea of the 
position of the print area on the printer bed:

 yellow: the print area is inside the printer bed

 magenta: the print area is on the edge or outside the printer bed and at 
least one sheet will be printer borderless

Start Printing The coordinates of the corner of the printing area that is closest to the home 
position.

End Printing The coordinates of the corner containing the last pixel to be printed diagonally 
opposite to the starting point
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Media

Sheet list A table which lists all the sheets on the print layout, with their position along the 
horizontal and vertical axes of the print layout (relative to the printer, and their 
size. The same color code is used for the position. The green border indicates the 
lay.
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Applying Changes and Submitting a Job

Applying Changes If you change settings that modify the color rendering of the products (e.g. 
preflight, calibrated printing mode), the Apply Changes button appears in the 
amber status box in the bottom right corner. You can choose whether you want 
to apply your changes or not because this may take considerable time and inter-
fere with your work.

NOTE: Applying changes does not create new previews of products already 
added. See “Product Previews” on page 500.

Submitting a Job After placing your products on the sheet, reviewing the print layout, and 
completing the job set-up, you can submit the job by clicking the Submit Job 
button in the bottom right corner. Submitting a job also creates previews if you 
chose not to generate previews while preparing the job.

The Submit Job dialog box displays the Job name, Order number and the 
following options that you can choose:

Print Files

Hold The job appears in the Jobs list but no files are processed.

Make and hold The files for the printing device are processed but not sent to the printing device.

Make and send to printer The files for the printing device are processed and sent to the printing device.
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Cutter Files

Hold The cutting files are not sent to the cutting device.

Make and send to printer The cutting files are processed and sent to the cutting device.

Show Snag List

When you want to submit a job that has warnings, Layout Editor asks you to 
confirm the submission. Clicking the Show Snag List button closes the 
submission dialog and opens the Snag List. The Snag List shows conflicts (errors 
and warnings) relating to the products in the Product panel or the placement of 
products on the sheet. See “Snag List” on page 551 for more information.

Submit button

Click the Submit button to confirm your changes to the job. The Layout Editor 
closes and the actions you selected for the print files and cutter files are 
executed. The job is updated in the Jobs list.

Discard/Delete Job button

If the job has not yet been submitted you will see the Delete Job button. Clicking 
this button will delete the job. If the job has already been submitted and you 
were making additional changes to the job, you will see the Discard button. 
Clicking this button closes the Layout Editor without saving your changes to the 
job.

Cancel button

Click the Cancel button to return to the Layout Editor without confirming your 
changes.

DQS Indicator The DQS indicator is visible in the bottom right corner if DQS, or Digital Quick 
Strip, is enabled. The indicator informs whether DQS is active and at what level 
(product or sheet). Hover over the indicator to see the status tooltip.

The DQS feature is enabled automatically if duplicate content is found in the job. 
If the same product is placed multiple times, it is quicker to render it once and 
then compose the raster data.

 Click the DQS indicator to open the DQS menu and select a level to override 
the automatic application of DQS:

Image DQS (green) This level of DQS renders the product once.

Sheet DQS (yellow) This level creates and renders a Print Layout as a collection of Sheet Layouts.
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DQS not possible (white) DQS is enabled but not beneficial.

No DQS (red bar) DQS is switched off although it is available.

Automatic The system has determined that DQS should be enabled.

NOTE: The printer may also have a DQS option.
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Sheet Layout Templates

Sheet layout templates help you apply a standard sheet layout to several sheets 
in the same job or to the sheets of different jobs. A template consists of empty 
frames that are used as placeholders for arranging products on the sheet. 

A template applies the following settings to the current sheet:

 The width and height of the Sheet

 The frames on the sheet and their properties; embedded designs, associated 
products, Fitting Options, orientation and mirroring, location and size, 
Content ID and Station number

 Frame groups and their properties; Grids. CAD layout groups. regular frame 
groups

 The special mark(s) that holds the non-product CAD-lines

 Manually added Image and Sheet marks

 Altered Sheet and Image-mark sets. These are mark sets that have any of the 
following alterations; forced activation state, removed marks, modified 
marks

 The bleed mask of front and back, if present

 Products that are associated with the frames on that sheet, and their 
associations; the design, if present, manually drawn paths and their 
operation assignments, such as  ink-free zones, manually placed Product 
marks, all image operations, all Guidelines.

Related topics: • Working with Frames on page 513
• Naming frames (content IDs) on page 521
• Layout Panel on page 505
• Placing Products Interactively on page 508

 Create a template from an existing sheet with placed products

You can create a sheet layout template by saving a sheet that you prepared for a 
particular job. This will probably be a layout with placed products. Saving as a 
template removes the products and creates a layout with just the frames.

1 Go to the sheet that you want to save as a template and select the Sheet Size.

Make sure all the settings for the individual frames are fine-tuned.
Apogee Reference Guide



584 SHEET LAYOUT TEMPLATES
2 Choose Sheet > Save Sheet Layout Template.

3 In the dialog box, enter the following information:

 Name: type a descriptive name for the template

 Categories: assign a category or enter a new category

 Assign Content IDs: Select this check box to name the frames on your 
template. If the frames of your layout contain products, each frame is 
assigned a unique content ID but frames that contain the same product 
are assigned the same ID.

NOTE: If the layout contains a combination of named and unnamed 
frames, the IDs of the named frames are used for the named frames and 
the unnamed frames are not assigned an ID.

4 Click Save.

The dialog box closes and you can continue working in the Layout Editor. If 
you want to check that your template has been saved, follow the procedure 
to apply a template and you will see your new template in the list of 
templates. If you want to check that your template has the desired frames and 
content IDs, apply the template to a new layout sheet.

NOTE: Your sheet must have at least one product or frame, otherwise the 
template is not saved and will not appear in the list of templates.
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Figure 9.44: A sheet with placed products saved as a template with content IDs

 Apply a Sheet Layout Template

CAUTION: Applying a sheet layout template erases all the placed products and 
frames from the current sheet. In other words, the template is applied to the 
sheet, not to its content.

1 On the current sheet or a new sheet, choose Sheet >  Apply Sheet Layout 
Template.
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The Filter Panel shows the attributes that you can use to filter the list of 
templates. You can search for the Name, Sheet size, Product size, Number of 
Frames, and Design name.

The Category Filter is a list that shows all categories from the templates that 
match the filter, sorted by ascending alphabetical order.

The Template list shows the templates that match all filters.

The Attribute panel shows the attributes of the selected template:

 When you’re saving a sheet, the Attribute panel shows the attributes of 
the sheet being saved, as it will be saved as a Sheet Layout Template.

 When you’re managing Sheet Layout Templates or applying a Sheet 
Layout Template, the Attribute panel shows the attributes of the template 
that is selected in the Template list.

The Design list of shows a list of combinations of designs and content IDs, 
together with the size and count of each combination.

Create empty product(s) check box allows to place products immediately 
on the Sheet Layout, when you import new products via the Add Artwork 
context menu option (for the Empty products). 

Figure 9.45: Sheet Layout Template

1 Filter Panel
2 Category Filter
3 Template List
4 Attribute Panel
5 Design List
Apogee Reference Guide



 

9 LAYOUT EDITOR 587
NOTE: As the Product Marks and Ink-Free zones (User paths) are defined on 
the Products, you need to enable the Create empty product(s) in order to 
have the marks and zones applied.

2 Select the template you want to use and click Apply or double-click it.

3 The sheet now has the size as specified in the template and all the frames are 
empty, except for product marks that you may have added.

4 The lock icon next to the Sheet tab label indicates that the sheet is locked 
which means that you cannot change the layout without unlocking it. 

5 Now you can start placing products on the layout and submit your job.

Figure 9.46: Applied Sheet Layout Template

1 Empty frames with Content IDs
2 Lock icon in sheet tab
3 Button to unlock/lock a sheet in the Product Inspector
4 Image marks
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6 If you want the same layout for another sheet in the same job or another job, 
you can apply the template again.

 Create a sheet layout template from scratch

You can create a sheet layout template from a sheet with empty frames. This 
involves drawing and naming frames, and setting their Fitting Options.

1 Go the sheet that you want to save or add a new sheet and select the Sheet 
Size.

2 Draw your frames on the sheet with the Frame tool.

3 Depending on the automation effects that you want to achieve with the 
template, you can fine-tune the individual frames on the layout, for example:

 Name the frames, assign the content IDs of your choice to the frames. You 
do this interactively by entering IDs for each frame in the Product 
Inspector. If you want the same product to be used in different frames, 
enter the same ID for these frames.

 Fitting options: Activate the Auto-fit option and set the fitting settings to 
control how products will fit in the frame. For example, if you want to 
place a single product in frames with different sizes and orientation, 
choose the settings to fit the product in the frames.

4 When you have finished your layout, choose Sheet > Save Sheet Layout 
Template.

5 In the dialog box, enter the following information:

 Save as: type a descriptive name for the template

 Assign Content IDs: This option is grayed out because there are no filled 
frames on the sheet.

6 Click Save.

The dialog box closes and you can continue working in the Layout Editor. If 
you want to check that your template has been saved, follow the procedure 
to apply a template and you will see your new template in the list of 
templates. If you want to check that your template has the desired frames and 
content IDs, apply the template to a new layout sheet.

NOTE: If the layout contains a combination of named and unnamed frames, 
the IDs of the named frames are used for the named frames and the unnamed 
frames are not assigned an ID.
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 Edit/Rename a sheet layout template

1 Apply the template to a sheet.

2 Edit the sheet and save it with a different name or the same name.

Saving with the same name overwrites the existing template.

 Delete a sheet layout template

1 In the Layout Editor, choose Sheet > Apply Sheet Layout Template.

2 Select the template you want to delete in the list of templates, and press the 
Delete key.

 Locking/Unlocking a Sheet

When a sheet is locked, you cannot modify the number of frames on the sheet, 
the position of frames, or the size of the frames. It is possible to change the 
Fitting Options and the Content IDs.

Sheets created from a template are locked by default as indicated by the lock 
icon in the Sheet tab label.

1 On the sheet that you want to lock/unlock, go to the Sheet Inspector.

2 Click the lock icon the lock/unlock the sheet.
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 Importing/exporting templates

Templates can be imported and exported through the resources in the System 
Overview.

Related topics: • Resources on page 596
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Working with CAD Layouts

Import CAD Files 
Wizard

 The Import CAD dialog is opened when you choose File > Place CAD Layout 
in the Layout Editor.

This dialog consists of 3 panels:

Preview Panel

The Preview panel on the left shows a preview of how the Layout Editor 
interprets the CAD file, with the lines and empty products shown or hidden as 
specified in the controls on the right.

Lines and Elements Controls

Flip CAD Layout Select to mirror the layout horizontally or vertically.

CAD Units Shows the measurement units as defined in the CAD file: drop-down list is 
disabled; if the file does not specify units, the list is enabled and you can choose 
a different unit than the default defined in the Apogee Preferences.

Line Mapping A drop-down list with the CAD Line Input Maps resources available for the type 
of CAD file and appearing in the order as they are listed in this resource. Click the 
pencil icon if you want to open this resource. See “CAD Line Input Maps” on 
page 999 for more information.

Line Mapping Table The table lists the line types which were detected in the CAD file. They are 
mapped to operations according to the selected Line Input Maps resource and 
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numbered according to their order in the resource. If a line cannot be mapped it 
is grayed out. All mapped lines are imported by default. Select/deselect a line in 
the Type (Layer) column, if you want it to include or exclude it. In the 
Operation column you can change the operation specified by the resource to 
any of the operations in the drop-down list. Remapping the operation sets the 
Line Mapping drop-down list to <Custom>. Lines that were not mapped 
automatically by the resource are set to <Unknown>.

Elements Tables This table lists all the elements found in the CAD file, typically one or more 
products which are repeated in the layout and other non-repeating elements. 
The CAD file is analyzed during the import to recognize contour-defining lines 
that are mapped to stations, i.e. placeholder instances of one or more products, 
or background lines that may be needed for the proofing layer (indicated as 
*MAIN*). In the Element column, you can choose to show/hide a product or 
other element. The number of instances of the product or element on the sheet 
is also indicated. The Target column specifies how the elements will be 
imported:

 Stations: placeholders for empty products to which artwork can be added 
later; see “Mark Engraver” on page 1038 and “Place Station Numbers” on 
page 542 for information on station marks.

 Proofing only: elements useful for proofing the sheet that do not repre-
sent empty products.

You can change the Target by selecting a different target in the drop-down list.

Fix Select one of the options in the list and the CAD file will be analyzed to solve 
common issues in designs:

 None: Imports the CAD file as it is.

 Combined designs: Attempts to recognize individual designs.

 Nested cut lines: Attempts to reconstruct the common lines in the designs.

 Common knife lines: Attempts to recognize when the contour-defining 
lines are nested. The outermost lines are assumed to be the design.

For the second and third options, you can override the default maximum 
distance for recognizing nearby endpoints by selecting the Connect 
endpoints when closer than check box and entering a value higher than 
the default 0.8 Points.
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Action and Products

Create sheet from CAD A new sheet will be created with the sheet dimensions and arrangement of 
elements as specified in the CAD file.

Place Product Block on
sheet

Select this option to choose your own sheet size and change the element 
positions. A new sheet is created. Select the sheet size from the drop-down list: 
current sheet size or a standard size in the list; here you can also select the size 
defined in the CAD file. If you want the CAD to be added to the current sheet, 
deselect the New Sheet check-box.

Create empty products Select this option to create an empty product for every element that is imported 
as a station and to link those products to the station on the sheet.

Place Layout Button

Clicking this button will import the CAD file and place the layout on the current 
sheet or create a new sheet with the placed layout.
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QuickProof Products and Sheets

NOTE: This option requires a special license.

With the QuickProof feature you can send a product or a sheet immediately to a 
proofer from within the Layout Editor. The system creates a job in the 
background to print to the proofer and this job is deleted automatically after the 
job has been printed successfully. 

A product proof includes all the product settings as set in the Layout Editor and 
Product Editor: bleed, scaling, mirroring, canvas extensions, etc. However, if a 
product has been tiled, you can only proof the master product, not the individual 
tiles. If you want to proof tiles, place them on a layout sheet first.

A layout sheet proof takes into account how the product is placed on the sheet 
and as such, the proof of a placed product can be different than the proof of the 
original product as a result of fitting and resizing for example.

 Proof a product

 In the Product panel (list of products) of the Layout Editor, context-click the 
product you want to proof, and choose Proof Product.

OR

Choose File > Proof Product.

The QuickProof dialog box is displayed. Select the appropriate check boxes, 
Proofer, Image and Output and click the Proof button.

 Proof a layout sheet

 In the Sheets panel (list of layout sheets) of the Layout Editor, context-click 
the sheet you want to proof, and choose Proof Sheet.

OR

Choose File > Proof Sheet.

The QuickProof dialog box is displayed. Select the appropriate check boxes, 
Proofer, Image and Output and click the Proof button.
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QuickProof Dialog Box

These setting are remembered for the job.

Products Select the product/sheet or all items to be proofed.

Include  Spot Colors for Finishing: Select the check box to print each finishing opera-
tion with a 1-point solid line in the color that is associated with the color of 
the finishing operation in the selected cutter. When no cutter is selected, or 
when the finishing operation is not available in that cutter, the finishing 
operation is not printed. The finishing operations are printed on top of every-
thing else, in the order as defined by the finishing operations.

 White/Varnish: Select the check box to print these special inks using the 
specified color and opacity. These special colors are always printed on top of 
the other content.

Proofer Choose a proofer from the drop-down list. You can only print the proof on a 
proofer.

Image Select the parameter set to be used. Use a line appearance set to output the CAD 
operations.

Output Select the parameter set to be used.
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Resources

Resources are the settings used in the background to process jobs.

In the Layout Editor, you can open some of the Apogee resources by choosing 
Window > Resources and selecting a resource, or via the inspectors.

See the following sections:

 for task processor resources:

 “Media Hub” on page 1088

 “Paper Stock” on page 1114

 “Finishing Hub” on page 993

 “Mark Engraver” on page 1038

 “Color Books” on page 977

 “Alignment Pin Sets” on page 942

 for system resources:

 “Sheet Sizes” on page 690

 “Sheet Layout Templates” on page 583

Administrator access level only! All Apogee resources can be opened in System 
Overview, either as system resources or task processor resources. 
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Layout Editor Menus

Main Menus The following menus are available on the top menu bar in the Layout Editor 
window.

File Menu

Edit Menu

Menu Item Description

Add Products Opens a file browser to select and upload content files.

Add Products from CAD Opens a file browser to select a CAD file; the products in the CAD 
file are added to the Products list.

Add Products from 
Frames

When one or more frames are selected on the sheet, creates 
products with the dimensions of the selected frames and adds them 
to the Products list.

Place CAD Layout Opens a file browser to select a CAD file that you can place with its 
empty products on the sheet.

Restore Deleted Products Restores deleted products.

Get Info Displays the Info dialog box with information about the original 
product file organized in the General, Dimensions and Resources 
tabs.

Show Preflight Report Opens a PDF with a preflight report for the selected product, if 
available.

Export Original File/
Normalized PDF

Exports the original file or a normalized PDF to a location of your 
choice.

Proof Products Sends selected products to a proofer. See “QuickProof Products and 
Sheets” on page 594.

Proof Sheet Sends the selected sheet to a proofer. See “QuickProof Products and 
Sheets” on page 594.

Save as Template Saves the current job as a Wide Format Ticket template.

Open in Production 
Dashboard/
ProductionCenter

Opens your standard browser with the job in Production Dashboard/ 
Production Center.

Submit Opens the Submit Job dialog box. See “Applying Changes and 
Submitting a Job” on page 580.

Menu Item Description

Undo/Redo Undoes/Redoes the last operation.

Cut, Copy, Paste Cuts, Copies, Pastes the current selection.

Delete Product Deletes the selected product from the Products list.

Delete Frame Deletes the current frame.

Remove Product(s) Deletes the product(s).
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Product Menu

Duplicate Product Makes a copy of the product in the Product panel.

Duplicate Frame on 
Sheet

Opens the Duplicate dialog box for duplicating the selected frame 
or frames on the sheet. See “Duplicating Products” on page 527.

Select All Selects all products in the Product panel, or all products on a 
selected layout.

Select None Deselects all products in the Product panel, or all products on a 
selected layout.

Select All Odd-
Numbered/Even-
Numbered Products

Selects all products in the Product panel, or all products on a 
selected layout.

Edit Sheet With a sheet selected on a print layout in Print Layout mode, 
switches to the selected sheet in Sheet Layout mode.

Menu Item Description

Add Product from 
Artwork

Creates product by assigning artwork to a frame.

Assign Artwork Assigns an artwork file to one or more existing products.

Front • From Available: Selects a previously uploaded page from the sub-
menu; list of all artwork that is available in the Page Store.

• Open: Browses the file system and loads the artwork from a file.
• Blank: Selects to have a blank side.
• Mirror: Mirrors the current artwork. Disabled when there is no 

current artwork.
• Swap with back: Swaps the assignment with that of the back, 

whatever the assignments are.
• None: Selects to have no artwork on that side.
• Get Info: Shows the Get Info window for the assigned artwork. 
• Show Preflight Report: Creates and opens the Preflight Report for 

the document that is assigned to the current side.
• Check Out and Edit Document: Edits the document in the selected 

editor.

Menu Item Description
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Back • From Available: Selects a previously uploaded page from the sub-
menu; list of all artwork that is available in the Page Store.

• Open: Browses the file system and loads the artwork from a file.
• Same as front: Uses the artwork assigned to the front. Disabled 

when the front has no artwork.
• Mirror of front: Uses the artwork assigned to the front. Disabled 

when the front has no artwork.
• Blank: Selects to have a blank side.
• Mirror: Mirrors the current artwork. Disabled when there is no 

current artwork.
• Swap with front: Swaps the assignment with that of the front, 

whatever the assignments are.
• None: Selects to have no artwork on that side.
• Get Info: Shows the Get Info window for the assigned artwork. 
• Show Preflight Report: Creates and opens the Preflight Report for 

the document that is assigned to the current side.
• Check Out and Edit Document: Edits the document in the selected 

editor.

Design • From Product: Lists the sub-menu with the other products.
• Open: Browses the file system and loads a design from a CAD file.
• From Front: The artwork assigned to the front, disabled when the 

front has no artwork.
• From Back: The artwork assigned to the back, disabled when the 

back has no artwork.
• Mirror: Mirrors the current design.
• None: Sets the design to a rectangle with the size specified by the 

Product size, disabled when the Product size is From design.

Turn Over Swaps the front and back artwork and mirror the design.

Mirror Product Mirrors the front and back artwork and mirrors the design. This is 
useful for printing single-sided work on the back-side of transparent 
media.

Convert to Double-sided 
Product(s)

Combines two single-sided products into one double-sided 
products. (Double-sided printing is only available for offset-printing 
or for wide format printing when the license is available.)

Convert to Single-sided 
Product(s)

Splits a double-sided product in two single-sided products.
(Double-sided printing is only available for offset-printing or for 
wide format printing when the license is available.)

Open in Product Editor Opens the selected product in the Product Editor. See “Product 
Editor” on page 605.

Edit with Preview Opens the selected product in Preview. See “Previewing Job 
Results” on page 99.

Check Out and Edit 
Document With

Opens products and documents in Acrobat or any other PDF 
Viewer/Editor application such as the Amfortis Editor, from where 
they can be checked in after editing.

Menu Item Description
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Arrange Menu

Sheet Menu

Menu Item Description

Auto-Layout Product Opens the Auto-Layout dialog box. See “Placing Products with Auto-
Layout” on page 533.

Auto Fill Products Opens the Auto-Fill dialog box. See “Placing Products with Auto-
Fill” on page 537.

Create Grid Opens the Create Grid dialog box. See “Create Grid” on page 530.

Step and Repeat Opens the Step and Repeat dialog box, if one or more placed 
products are selected. See “Step & Repeat” on page 528.

Group/Ungroup Groups/ungroups the products selected on a layout.

Fitting Options for fitting the product and frame, and to open the Fitting 
Options dialog box. See “Inspecting Frames” on page 515.

Size Frame to Sheet Fills the sheet with the selected product frame which can be empty 
or filled.

Size Sheet to Frame Sizes the sheet to the selected product frame which can be empty 
or filled.

Revert Frame Reverts a filled frame to the size of the original product.

Scale for Bleed Scales the product outside the frame to allow for the specified 
bleed content.

Revert Product Size Reverts the size of the original product back to the size it initially 
had when you added it to the Product panel.

Menu Item Description

New Empty Sheet Creates a new, empty sheet for the job.

Duplicate Sheet Creates a new sheet and duplicates the content.

Delete Current Sheet Deletes the current sheet.

Delete Sheets Opens a dialog box where you can choose to delete empty sheets or 
all sheets.

Delete Empty Sheets Deletes the empty sheets.

Rearrange Frames Rearranges the selected frames to their automatic placement.

Rearrange All Frames in 
Job

Rearranges all the frames to their automatic placement on all the 
sheets.

Reapply All Mark Sets in 
Job

Removes all marks and reapplies the marks set rules.

Apply Sheet Layout 
Template

Opens a dialog box with the saved sheet layout templates which 
can be applied to the current sheet.

Save Sheet Layout 
Template

Opens a dialog box to save the current sheet as a sheet layout 
template.

Assign Content IDs Assigns content IDs to the selected frames or all frames if none are 
selected. The frame must contain a product.
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Print Layout Menu

View Menu

Clear Content IDs Clears the content IDs of the selected frames or all frames if none 
are selected.

Station Numbers Opens the Station Numbers dialog with settings for the numbering 
sequence. See “Place Station Numbers” on page 542.

Fix Bleed Overlaps Opens the Fix Bleed Overlaps dialog. See “Fix Bleed Overlaps” on 
page 539.

Revert to Default Bleed 
Overlap Handling

Removes a side’s custom bleed mask, i.e., the bleed mask that was 
created by fixing the overlaps manually and reverts to the default 
bleed overlap handling. This option is disabled, if the side has no 
custom bleed mask.

Lock/Unlock Sheet Locks/unlocks the sheet to disable/enable editing.

Menu Item Description

New Empty Print Layout Creates a new, empty print layout for the job.

Duplicate Print Layout Creates a new Print Layout and duplicates the content.

Delete Current Print 
Layout

Deletes the current Print Layout.

Delete Print Layouts Opens a dialog box where you can choose to delete empty Print 
Layouts or all layouts.

Rearrange Sheets Rearranges the selected sheets to their automatic placement.

Rearrange All Sheets in 
Job

Rearranges all the sheets to their automatic placement on all the 
Print Layouts.

Remake All Print Layouts Repositions all sheets in accordance with modified sheet layout 
settings.

Menu Item Description

Sheets / Print Layouts Switches to Sheets or Print Layouts view.

Zoom In/Out Increases/decreases the zoom factor for viewing the layout.

Zoom to Fit Fits the layout to the area between the Product panel and the 
inspectors.

Zoom to Width Sets the zoom level so that the entire width is visible in the current 
view.

Zoom to Height Sets the zoom level so that the entire height is visible in the current 
view.

Zoom to Max Selects the maximum zoom level.

Expand/Collapse Tiles Reveals/hides the tiles of a selected tiled product.

Menu Item Description
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Snap Toggles the Snap menu item:
• When Snap is off, the Layout Editor disables snapping in all 

operations.
• When Snap is on, the Layout Editor snaps to the items selected in 

the Snap To sub-menu.

Snap To • Frames: When moving a frame towards another frame, snaps 
when the edges of the two frames touch or align, or when they are 
separated by the distance specified in Finishing Margins > 
Minimum distance between frames.

• Guides: Snaps to guides.
• Gripper: Enabled only for offset presses.
• Sheet Margin: i.e., the distance set in Finishing Margins > 

Minimum distance between products and sheet edges.
• Sheet Edge: 
• All: Enables all targets.
• None: Disables all targets.
• Honor 'Minimum Distance Between Frames': The frame snaps 

when two opposing edges are at the distance that is specified as 
Finishing Margins > Minimum distance between frames.

Guides • Lock Guides: Locks the guides.
• Remove Guide(s): Removes selected guides.
• Remove All Guides: Removes all guides.
• Create Guides: Opens Create Guides dialog to create multiple 

guides at specified locations.
• Create Guides From Frames: Creates guides that run along the 

edges of one or more selected frames or from the frames in a 
frame group.

Show / Hide Rulers Shows or hides rulers.

Print Layout Editor 
Orientation

• Leading edge as on printer: Shows the Print Layout with the 
leading edge at the top or bottom, depending on the orientation 
of the printer.

• Leading edge always on bottom of window: Shows the Print 
Layout with the leading edge at the bottom, regardless of the 
orientation of the printer.

• Leading edge always on top of window: Shows the Print Layout 
with the leading edge at the top, regardless of the orientation of 
the printer.

Sheet Layout Editor 
Orientation

• Follow Print Layout Editor orientation: Shows the Sheet Layout in 
the same orientation as the Print Layout Editor.

• Leading edge always on bottom/top of window: Shows the Sheet 
Layout with the leading edge at the bottom, regardless of the 
orientation of the printer or that of the Print Layout Editor.

Menu Item Description
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Window Menu

Context Menus The following menus are available by context-clicking in the various panels or 
objects in the Layout Editor.

Sheet Layout Mode - Product in the Product Panel

See “Managing/Editing Products” on page 495.

Sheet Layout Mode - Product on a Sheet

See “Inspecting Frames” on page 515.

Menu Item Description

System Overview Opens or switches to the System Overview window.

Jobs Opens or switches to the last Jobs window.

Hot Tickets Opens or switches to the Hot Tickets window.

Resources • “Media Hub” on page 1088
• “Paper Stock” on page 1114
• “Finishing Hub” on page 993
• “Mark Engraver” on page 1038
• “Sheet Sizes” on page 690
• “Color Books” on page 977
• “Sheet Layout Templates” on page 583
• “Alignment Pin Sets” on page 942

Go to ProductionCenter Opens the ProductionCenter application in your internet browser.

Go to PrintSphere Opens the PrintSphere file-sharing application in your default 
internet browser, for example, to manage PrintSphere users.

Go to SphereCenter Opens the SphereCenter application in your default internet 
browser, for example, to set up a PrintSphere subscription.

Show Snag List Shows/hides the Snag List.

Show View Options Shows/hides the View Options palette.

Show Presets Shows/hides the Presets.

Panels • Show/Hide Inspector: shows/hides the panel on the right with 
inspectors.

• Show/Hide Sheet Panel/ Product List: shows/hides the panel on 
the left with products.

Inspector • “Job Set-Up Inspector” on page 552
• “Frame/Product Inspector” on page 569 (Frame/Product Inspec-

tor)
• “Colors Inspector” on page 573
• “Mark Sets Inspector (Sheet Layout mode only)” on page 575
• “Sheet Inspector” on page 576 (Layout Inspector)
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Print Layout Mode - Sheet in the Sheets Panel

Print Layout Mode - Sheet on a Print Layout

Context Menu Item Description

Delete Sheet Deletes the selected sheet from the Sheets panel and removes it 
from the Print Layout.

Duplicate Sheet Creates a copy of the sheet in the Sheets panel and creates a new 
Print Layout that contains the new sheet.

Edit Sheet Opens the selected sheet in Sheet Layout mode.

Locate Sheet on Print 
Layout

Highlights the sheet on the current Print Layout.

Proof Sheet Sends the selected sheet(s) to a proofer. See “QuickProof Products 
and Sheets” on page 594.

Context Menu Item Description

Delete Sheet Deletes the selected sheet from the Print Layout.

Duplicate Sheet on Print 
Layout

Creates one or more copies of the sheet and places them on the 
current Print Layout or creates new Print Layouts if sufficient space 
is not available.

Edit Sheet Opens the selected sheet in Sheet Layout mode.

Rearrange Sheet Rearranges the selected sheets to their automatic placement.

Locate Sheet in Sheet 
List

Locates the selected sheet on the Print Layout.
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10 Product Editor

This section describes the Product Editor, a dedicated workspace for editing the 
products you upload in the Layout Editor. The Product Editor includes compre-
hensive features for tiling and contour paths.
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Overview

The Product Editor is a module of the Layout Editor that opens when you open a 
product that has been added to the list of products in the Product panel. 

 To open the Product Editor from the Layout Editor window:

Double-click a product or one of the tiles of a tiled image in the Product panel

OR

Context-click a product in the Product panel and choose Open in Product 
Editor

OR

When a product is selected in the Product panel, click the Edit product 
button in the Frame/Product inspector.

Figure 10.47: A product open in the Product Editor

1 Positioning tools and snapping drop-down
2 Product pane
3 Inspectors
4 Editing toolbar
5 View Options palette
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Inspectors The panel on the right consists of a number of tabs, which are referred to as 
inspectors, where the actual editing is performed.

1 Product Inspector for basic edits to the product (size, bleed, etc.)
2 Canvas Extensions and Grommets Inspector
3 Tiling Inspector to tile a large image into smaller tiles
4 Paths Inspector where you can edit existing contour paths or create new ones
5 Mark Sets Inspector and Mark Inspector

The following sections discuss each inspector separately and how the various 
settings affect the image being edited. Note, however, that changes you make in 
one inspector may also affect what you specified in another inspector and vice 
versa. For example, you can specify bleed in the Image inspector, create canvas 
extensions and grommets in the second inspector, and then tile the resulting 
product into smaller tiles in the Tiling inspector. The tiling is applied to the 
entire product including the extensions, while the bleed you specified in the 
Image inspector is applied to the individual tiles created in the Tiling inspector.

View Options 
Palette

Open the View Options palette to choose the various boxes and non-printed 
information that you want to see while working in the Product Editor.

NOTE: Hiding content or marks with the View Options palette does not mean 
they will not be printed.
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 Click the View Options button in the toolbar to Show/Hide the View Options 
palette.

The following components can be shown/hidden:

 Preview

 Image: the actual content of the image you are editing

 Mark: the cutting marks selected for finishing, or other marks

 Product

 Trim box: the original trim box of the image

 Product Size: the box indicating the size of the product to be printed

 Frame: the box around the image that includes canvas extensions but not 
the bleed
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 Bleed box: the box around the image that includes the bleed area, and the 
canvas extensions if applicable

 Contours: the path around an image for finishing operations, for example 
for cutting

 Design: an outline based on a CAD file for example.

 Extra

 Canvas Extensions: the box around the canvas extensions

 Grommets: the marks representing the grommets to be printed as content 
with the image

 Motif: the cells that contain the motif of a step & repeat pattern

 Tiles

 Number: the sequence number of the tiles

 Visible size: the box indicating the visible size of the tiles

 Total size: the box indicating the visible size plus overlapping edges and 
bleed

 Overlap: the overlapping edges of tiles as required for the tiling 
arrangement 

 No-ink: the no-ink zone on the tile overlap

 Anchor: the black arrow icon indicating the anchor corner that depends 
on the montage sequence

 Extra

 Canvas Extensions: the outlines of flaps in case of canvas extensions

 Grommets: the grommets when applied

 Motif: the border of the motif (non-clipped) in a Step and Repeat pattern

 Marks

 Box: the bounding box of the marks
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 Hidden marks: marks that will not be printed due to conflicts; displayed 
in a red, hatched box.

In the View Options drop-down list you can select, create, rename or delete 
preference sets for the View Options.

Related topics: • Place Station Numbers on page 542

Toolbars The toolbar in the bottom left corner basically has the same tools as in the Layout 
Editor, except for specific tools (Crop, Split, Paths) which are available in the 
Product Editor when the various inspectors are selected.

Related topics: • Layout Toolbar on page 549

When using the Tiling inspector you will also see a positioning toolbar at the top 
of the product editing panel which is activated when you select a tile. See 
“Positioning Toolbar” on page 641.

Applying Changes When you’ve finished editing a product you must click the Apply button in the 
bottom right corner to save your edits. So although you can see the changes you 
make as you work on the product, they are only final when you save them with 
the Apply button. You can click the Cancel button if you do not want to save your 
edits and keep the product as it was. Click the Apply to all button if you want to 
apply the edits to all the products in the job and overrule any previous edits 
made to these products.

NOTE: Saved edits are also applied to products already placed on sheets.
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Product Inspector

The product is initially the same size as the original image. The product 
inspector is where you can crop the original image, change the product size and 
specify how the image fits in the product, and specify the bleed.

 Click the tab to display the Product inspector where you can expand and 
collapse the various panels.

Product

Name The name set by the Layout Editor when you create a product from a file or dupli-
cate a product. You can also set a different color to represent the product in 
various views by clicking the color patch.

Order Number Field to specify an order number of your choice.

Product Code Field to specify a product code of your choice.

Copies Enter the total number of copies of the selected image that you want to print, i.e. 
the number of copies on all the layouts multiplied by the run length.

NOTE: This is not the number of images on the current sheet.

Grain/Flute Select grain/flute direction from the drop-down list for the media you will be 
printing on:

 None: No specific requirements regarding the substrate grain/flute

 Horizontal: the product grain/flute must run horizontally through the 
product

 Vertical: the product grain/flute must run vertically through the product

Size

At the top you see the Product Size and this is followed by a table with details of 
how this size is calculated, starting from the size of the image (Artwork Size) and 
after the cropping and scaling specified in the panels below is applied. A black 
asterisk is displayed when the size is different from the native size of the image, 
i.e. with scaling, fitting, image operations, etc. applied. The asterisk is blue if 
fitting is applied.
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Sources

This panel specifies the files used for the design and the artwork of the product. 
These file names may include the page number if the source file has several 
pages. Clicking the drop-downs reveals a menu for selecting a different design 
or artwork.

Design The first drop-down list in this panel specifies the file used for the design of the 
product; this can be a PDF file or a CAD file and is followed by an asterisk if the 
design has been changed.

Artwork The F and the B drop-downs specify the artwork file used for the front and the 
back of the product, respectively. A warning icon is displayed if the artwork 
cannot be aligned with the design automatically.

Crop

You can crop the image by specifying a single value for all four sides with the link 
icon closed, or by entering values for each side with the link icon open. These 
cropping values are applied to the original image dimensions, so before other 
modification such as fitting and bleed are applied. If you scale the image, you 
can select the Show scaled crop values check box and then enter values that 
relate to the scaled size.

NOTE: You can also use the Cropping tool to crop your image: see “Cropping 
an image” on page 619.

Step & Repeat (make
pattern)

Select this check box to step and repeat an image and create a pattern that can 
subsequently be placed on the layout sheet. See “Step & Repeat Patterns” on 
page 616.

Product Size

Size Here you can specify the size that you want for the finished product. When you 
open an image in the Product Editor the first time, the product size is equal to the 
image size. The product size is the same as the frame in the Layout Editor. Leave 
the link icon closed if you want to keep the aspect ratio of the original image. You 
can change the orientation of the product by clicking the swap dimensions 
button to the right of the size fields. 

 Use image size: The product size is identical to the image size and this size 
can be scaled by entering a percentage.

 Standard size from the list: Choose a size from the drop-down list and the 
scaling factors for the length and height are displayed to the left of the dimen-
sions. You can edit the dimensions. 
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 Custom: Lets you specify the length and width in your preferred size units. 

Fitting Options If you chose a size in the list or defined a specific product size you can also set the 
fitting options. Otherwise the image fits in the product box.

 Orientation: Selecting the Rotate for better fit check box rotates the image so 
the long edge of the product size aligns with the long side of the image.

 Scaling: Select how you want to scale the image to fit in the product:

 None: no scaling is applied to fit the image to the product; it takes up as 
much space as required to accommodate its original size

 Fill with image: scales the image so it fills the product and crops the image 
if necessary.

 Fit image: scales the image so it fits completely in the product which is not 
necessarily filled.

 Fit image to width: scales the image so its width fits that of the product.

 Fit image to height: scales the image so its height fits that of the product.

Maintain proportions Keeps the width and height scale factors the same when scaling. This means that 
some parts of the image may be clipped.

Alignment Choose a position (top left, top center, top right, etc.) for the cropped, scaled or 
rotated image inside the product size.

Total frame size The product size + canvas extensions

When you apply your changes, the image appears in the images list of the Layout 
Editor with the new product size. If you edit the image again, you can start from 
the original image size. Any changes you make do not affect images which are 
already placed on sheets.

Bleed/Mask

Bleed can be taken from the image file or created by the system. Specifying bleed 
does not affect the product size or crop.
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Bleed types From the drop-list you can specify when bleed is created by the system or taken 
from the bleed area available in the image file. These options are mainly relevant 
for images which have a bleed area present in the image file. Only the first and 
the last options are relevant if the image has no bleed area.

 None: Sets the maximum bleed to 0 even if bleed is provided in the image file. 
The bleed box coincides with the canvas extension box or the product size.

 From image, fixed size: The system uses the bleed in the image file for the 
maximum bleed you specified or only what is available if the bleed in the 
image is less than the specified bleed.

 From image, disable if none: The system uses the bleed in the image file for 
the maximum bleed or less if the bleed in this file is less. No bleed is created 
if the image file has no bleed.

 From image, create if needed: The system uses the bleed in the image file if it 
is equal or greater than the specified maximum bleed; if the image bleed is 
less than the specified bleed, the system creates the bleed and does not use 
the image bleed.

 Always create bleed: The system creates the maximum bleed, effectively 
replacing any bleed in the image file.

Maximum bleed Specify the size of the bleed area you want around the image or canvas exten-
sion. Bleed is created around the canvas extension if this is present, not around 
the image. Enter one value for all sides or open the link icon to enter values for 
bleed along the four sides as desired. Press Enter to apply the values.

Figure 10.48: Mirrored image content added as bleed (between black and red boxes)
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Bleed Generator

By default, the system mirrors the content along the edges of the image to create 
the specified bleed if no bleed area is provided in the image file. You can fine-
tune or change this behavior by clicking the pencil icon next to the bleed types to 
open the Bleed Generator dialog box.

Method This is how the system will create the bleed content from the image content:

 Mirror edge content: The bleed area is filled by mirroring the content 
within the bleed range along the edges of the product box.

 Scale entire content: The entire image is scaled proportionally to fill the 
bleed area.

Inset The bleed content is created, starting from the specified inset inside the product 
box and on top of the existing content. This is useful if the image content does 
not extend to the product box.

Preserve existing bleed Select the Options check box to preserve the bleed content in the image file 
underneath the bleed created by the system.
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Step & Repeat Patterns

Select the Step & Repeat (make patterns) check box at the top of the Image 
Inspector to step and repeat an image (i.e. the motif) and create a seamless 
pattern that can subsequently be placed on the layout sheet. This feature offers 
advanced options to vary the pattern which are not possible when using Step & 
Repeat to repeat an image directly on a sheet in the Layout Editor. Applications 
include wallpaper, curtains, flooring, etc.

Product Size

Size Here you can choose how you want the size of the finished product to be 
determined:

 Manual: Select this option to enter the product size; the initial size is the 
image size.

 From Pattern (default): The dimension boxes are disabled and the 
product size accommodates the pattern you create, including its gaps, 
scaling, etc.

 Minimal Repeat: The number of repeats and corresponding product size 
are calculated for making a minimum repeating pattern.

Cogwheel Open the cogwheel to match the product size with the size of the media. 
Choosing this option steps and repeats the motif so a pattern is created that fits 
the media size. This also enables the dimension boxes and sets them to Manual. 
You have two options:

Figure 10.49: Horizontal and vertical cells of a step & repeat pattern
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 From Media: Copies the dimensions of the currently selected media into 
the dimension boxes and creates a pattern that covers the entire media 
using the image as motif.

 From Media with Margins: Does the same as From Media but uses the 
dimensions of the media minus the finishing margins.

Horizontally and Vertically

In the Horizontally and Vertically panels you can fine-tune the horizontal rows 
and vertical columns of the pattern grid.

Repeat Enter the number of times you want to repeat the motif horizontally/vertically – 
if the Auto check box is not selected. If the check box is selected, the number of 
repeats is calculated for you, for example if you are using one of the From Media 
options.

Brick/Drop Brick sets an offset to shift the cells of alternating rows to the right, and Drop sets 
an offset to move alternating columns down. You can specify this offset in several 
ways: as a fraction of the motif, as a percentage of the motif, or as an absolute 
value in mm or inches. Click the drop-down list to display preset fractions and 
percentages, and options that allow you to enter your own absolute value, 
percentage or fraction.

Mirror Steps You can choose to mirror alternate stepped motifs horizontally, vertically or 
both. This is possible for rows as well as columns, or both.

Fitting Here you select how the generated pattern must be fitted on the specified 
product size:

1 Preset fractions for offsetting motifs in rows/columns
2 Preset percentages
3 Options to set your own fraction or percentage
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 Omit partial: The content of the last partial cells of the rows/columns is 
deleted from the pattern design.

 Clip partial: The content of the last cells of the rows/columns is clipped to 
coincide with the pattern size. This is the default if you specify the product 
size with From Media.

 Fit scale: Select this option to scale the repeated motif so it fits in all the 
cells. 

 Fit gaps: Select this option to add gaps so the entire repeated motif fits in 
all the cells.

Scale Set a percentage if you want to scale the cells and the motif horizontally/
vertically.

Gap/overlap A positive value creates a gap between the cells and a negative value makes them 
overlap. Click the drop-down list to display preset fractions and percentages, 
and options that allow you to enter your own absolute value, percentage or 
fraction (same as Brick/Drop). Select the Between images only check box if don’t 
want a gap/overlap at the beginning and end of the rows/columns.

Overlap Order Two buttons let you control how the repeated motifs overlap each other. The 
default order is that the motifs on the right/top overlap the adjacent motifs on 
the left/bottom.

Global

Settings in the Global panel apply to the whole pattern.

First Cell Here you can rotate (90°, 180°, 270°) and/or mirror the image to modify the 
initial motif. The F symbol indicates the combined effect of the rotation and 
mirroring.

Skip Steps Enter a value (n) to leave every n+1 cell empty (no motif).

Figure 10.50: Motifs on the right overlapping adjacent motifs (default)
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Offset Enter a value to shift the entire pattern horizontally or vertically. Click the drop-
down list to display preset fractions and percentages, and options that allow you 
to enter your own absolute value, percentage or fraction (same as Brick/Drop).

Rotate and Mirror (Positioning Tools)

Use the Rotate drop-down list (0, 90°, 180° or 270°) to rotate and the Vertical or 
Horizontal Mirror buttons to mirror the image and its product box. The F symbol 
next to the buttons indicates the combined effect of the rotation and mirroring.

You only see the effect of rotating and mirroring when you place the image on a 
sheet in the Layout Editor where you can also perform the same rotating and 
mirroring actions. See “Positioning and resizing products with the positioning 
toolbar” on page 511. The fact that you have rotated or mirrored the image is 
indicated with a green F icon in the top left corner of the image.

 Cropping an image

You can crop an image by entering values in the Crop panel of the inspector or 
interactively on the image using the Crop tool.

1 Open the image you want to crop and click the Crop Image tool in the bottom 
toolbar.

A crop box appears on the image which you can resize to define the crop. You 
will also see a Crop and Revert button in the toolbar.

2 When you’ve finished cropping the image, click Crop to save your changes 
and crop the image. Us the Revert button to go back to the previous status.
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Canvas Extensions and Grommets Inspector

With canvas extensions you can add extra material to one or multiple edges of 
the image to create flaps. Grommets can be positioned in these extensions or in 
a product without extensions.

 Click the tab to display the Canvas Extensions and Grommets inspector.

Canvas Extensions

You can specify the size of canvas extension and whether they are filled with 
content created by the system or left empty. Any bleed you specified in the image 
inspector is added to these extensions.

Select the Canvas Extensions check box to enable the settings:

Size Specify the size that you want the canvas to extend beyond the product size. 
Enter one value for all sides or open the link icon to enter different values for the 
four sides as desired. Press Enter to apply the values.

Figure 10.51: Mirrored image content added as extensions and bleed, corners not filled

• Canvas extension between the black product box (image) and yellow extension box
• Bleed between the yellow extension box and red bleed box
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Fill Corners This check box has to be cleared to create open flaps; when selected, corners 
with adjacent flaps are filled.

Content Here you can choose how the system will create content to fill the extensions:

 Scale image: The image is scaled proportionately so it fills the product 
size plus the canvas extensions plus the bleed areas

 Mirror image: The extensions are filled by mirroring the content within 
the extension range along the edges of the product box, optionally, 
starting from a specified inset inside the product box and on top of the 
existing content. This is useful if the image content does not extend to the 
product box. The bleed is a continuation of this mirrored content.

 Mirror and Flip image: Flips the image horizontally and mirrors the 
flipped image into the flaps. This option is needed for front/back printing 
the same image on opaque media.

 Image bleed: The extensions are filled with the bleed present in the image 
file or the generated bleed that runs into the extensions. If you cropped 
the image, the cropped parts are used.

 Color: Fills the extensions with a solid color (CMYK or RGB) that you can 
choose with the color picker. Open the color picker by clicking the patch 
next to the Content drop-down list when this option is selected.

 No ink: Leaves the extensions and bleed areas empty.

No-ink zone Enter a value for an area along the edges of the flaps where no ink is allowed. 
Entering a value here automatically disables any bleed settings.

Total frame size Displays the total frame size.

Print line marks You can use Print Line Marks to draw and print lines and create a printed box 
around the image and its extensions – without using mark sets. You can set the 
line thickness, color (open the color picker), and style (solid, dashed or dotted). 
The lines are centered on the extension borders.

NOTE: To see the line marks, apply the settings and place the image on a sheet.

 On product size: The lines are printed along the edges between the image 
and the extensions.

 On extensions: The lines create a closed box around the edges of the 
extensions.
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 Only on edges with extensions: The lines are only printed on the edges of 
the canvas that actually have extensions so the box may not be closed.

Grommets

Grommets are holes for reinforced eyelets which are generally placed along the 
edges of a product. Marks can be drawn on the product to indicate where these 
holes are to be made. These settings let you choose where the marks are drawn 
and what they will look like.

Position Click in the check boxes to position the grommet marks along the top, bottom, 
left or right edges.

Type Four types of grommet marks are available:

 Solid circle

 Circle

 Circle with cross

 Cross

The marks can be drawn as an outline by selecting the Draw outlined check 
box.

Figure 10.52: Grommets (circles with cross) in the extensions
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Diameter The diameter of the circle.

Line thickness The thickness of all the mark lines.

Line length The length of the 2 lines of the cross.

Color The color of all the grommets. Click the variable button, and select one or more 
colors to change the color of the cutting lines:

See “To print tile marks” on page 644 for more information on using colors to 
print marks.

Draw in You can choose to place the grommet marks in the image or the extensions, and 
specify the horizontal and vertical distance from either the outer edge of the 
image or the extensions. Close the link icon and re-enter a value if you want to 
use the same value for the horizontal and vertical distances.

At Specify how far the marks must be printed from either the edge of the Extension 
or from the Image. This is the distance between the reference point of the mark 
and the selected reference edges along each edge. This also sets the distance of 
the first and last grommets along the perpendicular edge.

From edge of  Image: Draw the grommet marks on the image.

 Extensions: Draw the grommet marks in the extensions.

Inset Outer Grommets Specify an inset for the first and last grommets of a line of grommets.
Apogee Reference Guide



624 CANVAS EXTENSIONS AND GROMMETS INSPECTOR
Mark Reference Select whether to specify distances to the Circumference or the Center of the 
mark. The Circumference actually uses the bounding box of the mark.

 Center: specify the distances to the Center.

 Circumference: specify the distances to the Circumference.

Max. distance between
marks

Enter the maximum distance between adjacent marks – horizontally and verti-
cally. Close the link icon and re-enter a value if you want to use the same value 
for the horizontal and vertical distances. In the Mark Reference drop-down list 
you can choose from where the distance is calculated: the center of the mark or 
its circumference.

 Max distance between marks: Specify the maximum distance the between 
the reference points of two adjacent marks in the same direction. You can set 
the horizontal and vertical distances independently of each other. The 
minimum distance must be greater than or equal to 2 × max (diameter, line-
length).

 Fixed number of marks: Specify the number of grommets to draw. You can 
specify the numbers per side or in pairs (horizontal and vertical). The 
minimum number is 2.
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Tiling Inspector

Use the Tiling inspector to divide a master image into parts, i.e. tiles, that can be 
printed independently of each other. After applying tiling, the tiles appear in the 
Product panel of the Layout Editor as individual images which can be placed on 
sheets for printing. The printed tiles are subsequently mounted to recreate the 
original master image.

The master image may have canvas extensions, and tiling is then applied to the 
total image area that consists of the image and the flaps.

Overlaps and non-content gaps

In most cases, the individual tiles will need to have overlaps on one or more sides 
so they can be assembled on top of each other – for example, the various panels 
of a billboard. These overlaps are added to the visible size of the tiles. The total 
size of a tile is the visible size plus the overlap and bleed. However, in some cases, 
overlapping is not necessary or possible – for example if thicker materials are 
used. Other applications may require that gaps are created in the content 
between the tiles.

 Click the tiling icon to display the Tiling inspector.

Tiling check box

Selecting the tiling check box enables the tiling settings in the inspector where 
you can set the parameters to let the system create tiles automatically. The check 
box is also selected and the inspector activated if you are creating your tiles 
manually. See “Interactive Tiling” on page 635. 

NOTE: Clearing the Tiling check box will delete all interactive tiling actions you 
performed on the image.

Tiling menu

Click the cogwheel to reveal a menu with the following commands:

Re-apply tiling set-up Resets the tiling arrangement according to the settings in the tiling inspector, 
undoing any interactive tiling actions.

Preferences Opens the Tiling Preferences dialog box with the settings for creating the 
montage instructions. See “Tiling Preferences” on page 647.
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Tiles

At the top of the Tiles panel you can specify how you want to create your tiles: 
the number of columns and rows and whether you want the tiles to have the 
same visible size or the same total size. Alternatively, you can specify the desired 
dimensions for the tiles – again based on either the visible or total size – and the 
system will use these dimensions to split the image. In this case, the last row and 
column will probably have tiles with different sizes to accommodate the 
remaining content of the image.

Figure 10.53: Tiling inspector
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Tile for current media Select this check box to let the system tile your image so it fits on the sheet or roll 
media currently being used. For example, a large image can be split into 3 tiles 
so it can be printed on the media. Selecting this option clears any manual 
settings you made.

Nr To start tiling, enter the number of columns in the box with the horizontal arrow 
and the number of rows in the box with the vertical arrow.

Total Size/Visible Size You can choose the total or visible size by clicking the black triangles to display 
the drop-down list:

 Visible size: the area of the tile that will be visible after mounting

 Total size: the visible size plus overlaps

Last The width of the last column and the height of the last row; only filled if you 
specify a desired size for the tiles.

Tiling arrangement

A tiling arrangement can be chosen depending on whether you need overlap-
ping tiles, non-image gaps between tiles, or extensions to recreate the master 
image from the tiles:

Overlaps

Select the Overlaps arrangement if you need overlapping tiles. Enter a 
horizontal and vertical size for the overlaps. The overlaps are areas with dupli-
cate image content so the tiles can be mounted on top of each other. Enter a non-
ink zone if you want part of the overlap to remain blank so the overlapping 
materials adhere better to each other.
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Gaps

Select the Gaps arrangement if you need content gaps between the tiles. The 
content gaps are not printed. Self-adhesive tiles for window panes are a typical 
application of gaps. Enter the gap size, for example the width of your window 
frame, and half of this size is deducted from adjacent tile edges to create the full 
gap. Enter extension sizes to create extra material with content to cater for size 
variations. Extensions are added to the sides opposite to the tile anchor, except 
along the outer edges of the image.

Symmetrical
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Similar to the Gaps arrangement but with extensions on all sides. Select the Add 
to outer edges check box to add extensions to the tiles along the outer edges of 
the image.

Montage Sequence

Here you specify the order for mounting the printed tiles, how the tiles are 
numbered, and on which edges the overlaps or gaps are located. This is done by 
combining the First Tile and Proceed buttons that provide a total of 16 
combinations.

First Tile Select the corner where you want to start the numbering of the tiles: top left, top 
right, bottom left, and bottom right. The sequence numbering starts with the tile 
that is to be mounted first and the anchor symbol moves to the respective corner 
of each tile. The tile overlaps, gaps or extensions are created accordingly.

Proceed The logic of the sequence numbering is controlled by four buttons in the drop-
down list. These let you choose the horizontal and vertical direction in the grid. 
The default sequence is with the first tile in the top left corner. The numbering 
then proceeds horizontally along the first row (left to right) and then on the 
following row in the same direction (left to right). Depending on the selected 
first tile, the following combinations are possible:

NOTE: The drop-down list only shows the four sequences that are possible with 
the selected first tile.
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Actual Total Sizes
(including bleed)

The Smallest and Largest total tile widths (horizontal arrow) and tile heights 
(vertical arrow) – not necessarily the same two tiles.

Various

Print tile marks Prints tile-specific marks on the tiles. See “Tile Marks Dialog” on page 643.

Export montage
instructions

Select the check box if you want the system to automatically create a PDF 
document with instructions for mounting the tiles when you submit the job. 
Click the Export and Open button without or with the check box selected to see 
the PDF with instructions immediately. See “Montage Instructions” on 
page 648.

Constraints

Minimum Visible Size Defines the minimum visible tile size. 

NOTE: The minimum visible tile size must be at least 5 mm.

Related topics: • Interactive Tiling on page 635
• Split Tool Shortcuts on page 1217
• Positioning Toolbar Shortcuts on page 1217
• Layout Toolbar on page 549
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Paths Inspector

You can use the Paths inspector to view and edit an existing path and its anchor 
points or to create a path from scratch. Paths are generally used as contours for 
finishing operations (cutting, creasing, etc.) and play an important role in true-
shape nesting of products on a sheet. Paths take the bleed that you set for the 
image but this is only visible in the Image inspector.

 Click the tab to display the Paths inspector.

The Paths panel lists the paths present in the image. An image always has at least 
one path, namely the frame. Paths can be added using the paths tools in the 
toolbar or you can auto-generate a path if the image is suitable with the Trace 
feature.

 Add a closed path (ellipse or rectangle)

1 Open the image that you want to add a path to and go to the Paths inspector.

2 Select the Ellipse tool or the Rectangle tool in the bottom toolbar and draw 
the path like you would place an object on top of the image:

 Click and drag to draw the ellipse or rectangle. Press the CTRL key to 
draw circles or squares.

 To move the path on the image, select the object with one of the pointer 
tools. You can adjust the width and height of the path’s bounding box in 
the Positioning Toolbar in the top left corner.

 Context-click an object to choose an Offset or Inset value that enlarges or 
shrinks the closed path.

NOTE: You can select the anchor points of a closed path with the white pointer 
(Path Selection tool) and modify the object.

3 Click Apply or Apply to All to save your changes.

 Add a free-form path with the pen tool

1 Open the image that you want to add a path to and go to the Paths inspector.

2 Select the Pen tool and click where you want to start drawing your path:
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 Click and release to set an anchor point and draw straight lines.

 Click again in an anchor point to display direction handles and draw a 
curved line.

 Command-click to stop drawing the path.

3 Click Apply or Apply to All to save your changes.

 Auto-generate a path

1 Open the image that you want to generate a path for and go to the Paths 
inspector.

2 Click the Trace button to open the Trace Content dialog.

3 Use the Edge Contrast slider to set the contrast used to define the path an 
click OK.

4 In the Paths list, select the auto-generated path you just created to display it 
in the Product pane. You can rename the path, choose a finishing operation 
and change the path color.

5 Click Apply or Apply to All to save your changes.

 Delete a path

 In the Paths list, context-click the path you want to delete, and choose 
Remove Path.

OR

In the Product pane, select the path with one of the pointer tools and press 
Delete.

Related topics: • Placing Products with Auto-Layout on page 533
• Cut File Operations on page 578
• Finishing on page 571
• Clip to contour on page 571
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• Positioning Toolbar Shortcuts on page 1217
• Layout Toolbar on page 549
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Mark Sets Inspector and Mark Inspector

 Click the tab to display a combined tab with the Mark Sets Inspector and the 
Mark Inspector.

You then see two tabs.

The first tab is the Mark Sets Inspector that you can use to apply sets of 
product marks to all the products in the job (first section) or to apply sets of 
Press Sheet Marks to all the press sheets in the job (second section). Select 
the check marks to add marks. Click the cogwheels to switch off the Mark Sets 
or remove manual marks.

The second tab shows the details of a selected mark or a mark you just placed 
using the Marks palette. You can edit the settings for the selected mark.

Related topics: • Mark Engraver on page 1038
• Place Station Numbers on page 542
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Interactive Tiling

Automatic tiling uses the settings in the Tiling inspector to create a grid where 
most of the tiles have the same size. However, you can use interactive tools to 
create a non-grid tiling arrangement from scratch or to modify the rows or 
columns of an existing arrangement.

Interactive tiling is indicated with a blue asterisk in the Tiling inspector header:

The following tools are available for interactive tiling:

 Split Tool (Manual Tiling)

 Selection Tool

 Omit Tiles

 Merge Tiles

 Horizontal and Vertical Splitting

 Positioning Toolbar

Split Tool (Manual 
Tiling)

You can use the Split tool to create tiles from a master image in free-style 
manner. The Split tool is visible in the tiling toolbar in the bottom left corner 
when you are in the Tiling inspector tab.

1 Open the image you want to tile in the Product Editor and go to the Tiling 
inspector tab.

2 Click the Split tool in the toolbar, or press K, to activate the tool. Now you 
start to tile an untiled image from scratch or to fine-tune an existing tiling 
arrangement.
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3 Hover over the image to start tiling. 

If you are tiling an untiled image, the Tiling check box at the top of the Tiling 
inspector tab is activated from the moment you create your first tile. If you 
want overlaps, gaps or extensions, you need to specify them before you start 
splitting.

NOTE: Changing the basic tiling settings in the inspector will undo interactive 
edits. Changing overlap size preserves interactive edits.

The Split cursor (large cross) appears with a magenta line parallel to the 
shortest side of the image, and the width of the split tiles on either side of the 
split line.

4 Move the split line to the desired position and click to confirm the splitting.

You can change the splitting orientation (from parallel with the shortest side 
to parallel with the longest tile) by pressing and releasing the space bar or 
TAB key.

The orientation of the split line changes automatically if you move into a tile 
whose shortest side or longest side has a different orientation.
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You can extend the splitting in one tile across all the tiles of an image by 
holding down the SHIFT key.

 Split Tool Shortcuts

Activate the Split tool by pressing K with the Tiling inspector selected. To control 
the splitting of tiles selected with the Split tool, use the following shortcuts.

Selection Tool If you created tiles interactively with the Split tool or automatically with the 
inspector, you can fine-tune them further with the selection tool. In this mode 
you can select tiles and change their size, merge the tiles, etc.

NOTE: You cannot create new split lines in this mode. 

1 Select the Selection tool in the bottom toolbar.

2 Hover over the split lines to display the tile dimensions on either side of the 
line, and the resize arrow.

3 Click and drag a split line to edit the tile size.

To Press

Change the splitting orientation (the magenta splitting line) Space bar or TAB key 
once

Extend the splitting action across all tiles Hold SHIFT

Repeat the split. CTRL

Cancel the image splitting ESC
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Use standard shortcuts to select multiple tiles. Hold SHIFT to resize all the 
selected tiles.

Omit Tiles You may decide that a particular tile in your tiling scheme does not have to be 
printed.

 Select the tile you want to omit with the Selection tool and clear the Print 
check box in the Positioning toolbar or press the Delete key.

The tile in question is grayed out which means it will not be created. The tile 
numbering and the total number of tiles is modified accordingly. When you 
apply the changes, this tile is not added to the Product panel in the Layout 
Editor.

NOTE: You can revert the delete tile action by selecting the Print check box 
again, even after you applied the changes. 

Merge Tiles Adjacent tiles can be merged along their common split line to create a new, 
merged tile. Settings for overlaps, gaps and extensions are applied to the newly 
created tile.

You can use the Merge Tiles command in the Positioning toolbar to merge 
selected tiles or drag the split line of a tile to append adjacent tiles.
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1 Select two or more tiles you want to merge with the Selection tool.

2 When the selected tiles form a rectangle, the system activates the Merge Tiles 
button in the Positioning toolbar.

3 Click the Merge Tiles button to merge the selected tiles.

OR

1 In Selection tool mode, hover over the common split line between the tiles 
you want to merge and drag the line to the opposite edge of the tile you want 
to append.

The split line snaps to the edge of the first tile.

2 Release the mouse button and the merged tile is created

The tile numbering and the total number of tiles is modified accordingly.

3 Now you can drag the split line to the edge of the following tile if you want to 
merge multiple tiles.

When you apply the changes, the merged tiles appear as a single tile in the 
Product panel in the Layout Editor.

NOTE: You cannot revert to the original tiles once you have applied the 
changes. 

Horizontal and 
Vertical Splitting

Manual tiling with the Split tool is not ideal if you want equal splits across one or 
more tiles, or if you want to control overlaps, gaps and extensions. In these cases 
it is recommended to use the Split Tile buttons in the Positioning toolbar.

1 Select the tile you want to split with the Selection tool. If you want to apply 
the same splitting to multiple tiles, select multiple tiles.

2 Click either the Horizontal or Vertical Split Tile button in the Positioning 
toolbar or press CTRL+U, or context-click and choose Split Tiles.

The Split Tile dialog box is displayed.
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The Equal size panel is enabled by default with the cursor in the horizontal 
or vertical Number box. This depends on whether you clicked the Horizontal 
or Vertical Split Tile button. The Equal size panel is similar to the Tiles 
settings in the inspector (see “Tiles” on page 626) and you can enter the 
number of horizontal columns and/or vertical rows to create a grid of tiles 
which all have the same size. Alternatively, you can enter a size and all 
columns and/or rows will have this size, except the last.

You can choose the Arbitrary sizes option button if you want to specify 
multiple horizontal and/or vertical sizes for some or all the tiles. Enter a size 
in the first horizontal and/or vertical box. This will be the size for the tile 
starting from the anchor corner. Continue with values for up to 5 tiles. You 
can use and asterisk if you want the system to split the remaining distance 
into equal tiles. For example, 100,200,*,400,*, splits a total distance of 
1000 into tiles of 100, 200,150,400,150.

You can select the Advanced option if you want to enter more sizes. You can 
use spaces or commas to separate the dimensions.

In the Overlaps/Extension/Gaps section you can choose how these settings 
are applied to the split tiles: 
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 From Tiling Set-up: the inspector settings are applied

 Same as selected tile: relevant if multiple tiles are selected for splitting; 
the new tile inherits the settings of the parent tile

 None: no overlaps or gaps are applied

3 Click Split to confirm your splitting settings.

Positioning Toolbar The Positioning toolbar at the top of the Product Editor lets you inspect and edit 
each individual tile in the tiling scheme. Entering values in the boxes for Width, 
Height, Overlap, Gap and Extensions will override the values you see in the 
Tiling inspector and may also affect tiles which are arranged adjacent to the 
selected tiles. The measurement boxes you see in the toolbar depend on the 
tiling arrangement used to create the tiling scheme.

You also have tools for rotating and mirroring tiles when placed on the sheet, 
tools for splitting and merging tiles, and the Print check box that can be cleared 
if you want to omit a tile. The pencil icon opens the Assign to Set dialog that can 
be used to specify custom tile names for multiple sets of tiles.

Select one or more tiles to activate the tools.

1 Width and height of the tile (value is “mixed” if multiple tiles are selected)
2 Anchor direction
3 Overlap size or Extension/No-ink zone on the Left, and Top edges of the tile
4 Overlap size or Extension/No-ink zone on the Right, and Bottom edges of the tile
5 Gap size on the Left, Right, Top and Bottom edges of the tile
6 Rotation and mirror tools
7 Horizontal and vertical Split tools and Merge tool
8 Assign to Set button

 Positioning Toolbar Shortcuts

To control the Positioning toolbar when a tile is selected with Selection tool:
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Related topics: • Tiling Inspector on page 625
• Rotate and Mirror (Positioning Tools) on page 619
• Horizontal and Vertical Splitting on page 639
• Merge Tiles on page 638
• Omit Tiles on page 638

To

Open the Split Tile dialog box CTRL + U

Mirror the tile vertically when placed on a sheet SHIFT + M

Mirror the tile horizontally when placed on a sheet M

Rotate the tile clockwise in steps of 90° SHIFT + R

Rotate the tile anticlockwise in steps of 90° R

Merge the selected tiles CTRL+ G

Place the cursor in the first Overlap box of the Positioning toolbar O

Place the cursor in the first Gap box of the Positioning toolbar G

Jump to next box in the Positioning toolbar TAB
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Other Tiling Features

This section discusses some extra tiling features:

 How to print tile marks: see “Tile Marks Dialog” on page 643.

 “Renumber/Rename Tiles and Assign to Sets” on page 647.

 How to create a PDF with montage instructions: see “Tiling Preferences” 
on page 647.

Tile Marks Dialog You can print tile-specific marks on the tiles to help the person assembling the 
tiles arrange the tiles correctly. Two tile marks are possible: the tile name, which 
is text that typically includes the sequence number, and overlap line marks for 
aligning adjacent tiles. Select the check boxes to include the name and/or lines.

NOTE: Tile marks are only visible in the Layout Editor and when the image is 
placed on a sheet.

Figure 10.54: An example of tile marks (lines) as shown when a tile is placed on a sheet in the 
Layout Editor
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 To print tile marks

1 You enable tile marks by selecting the Print tile marks check box in the 
Various panel at the bottom of the Tiling inspector.

2 Click the Edit button (pencil) to open the Tile Marks dialog box where you 
can specify the content and the appearance of the marks.

Tile name

Text Any combination of static text and variables can be entered in the box for the 
name which will typically include the sequence numbers. 
For example: Tile no. $image.tile_number/$image.total_tiles resolves 
to Tile no. n/total. Valid variables appear in a drop-down list as you type in 
the box.

Font The typeface and point size for printing the text mark.
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Color Click the associated variable button, and select one or more options to determine 
on which plate(s) the text mark will be printed:

 Registration (all plates). When this option is selected, you will see an 
asterisk (*). 

 Process colors (CMYK)

 Darkest color

 Special colors

 Spot colors

Outline Adds a 1-point white line in knockout around the type so it stands out better with 
certain content.

Position Here you can specify where the tile name is printed on the tile by choosing one 
of the buttons:

 Centered in overlap: the default position which places the tile name in the 
center of the overlap or extension. For the tiles with no overlap, for example 
the last tiles, you can choose to omit the text, otherwise the tile name is 
printed in the visible area. You can change the default behavior as follows: 

 Prefer horizontal overlap (default): if possible, the text is printed in the 
horizontal overlap or extension

 Prefer vertical overlap: if possible, the text is printed in the vertical 
overlap or extension

 In horizontal overlap only: forces the system to place the text in the 
horizontal overlap

 In vertical overlap only: forces the system to place the text in the vertical 
overlap

If the tiling scheme has no overlaps or extensions specified, the system prints 
the tile name along the horizontal edge of the tile, and possibly in the visible 
area.

 Manual: Select this button if you want more control for placing the tile name 
mark. Specify the horizontal (left, center, right) and vertical (bottom, center, 
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top) alignment relative to the corners of the total size, the horizontal and 
vertical offset, and rotation of the text (0, 90, 180 or 270°).

Overlap (alignment lines)

The overlap marks are dashed, black and white lines that mark the border 
between the visible part of the tile and the overlap or extension. Tiles will have 
two, one or zero lines depending on their position in the montage, with small 
dashes for vertical lines and large dashes for horizontal lines.

Position The position of the line relative to the edges of the tiles:

 At overlap/extension: against the bordering line of the overlap/extension

 Centered in overlap/extension:

Length This option controls the length of the dashed line:

 Print in bleed only: This default setting prints a line in the bleed area only 
so it’s the smallest of the marks.

 Print into overlap: The line is printed in the bleed area and extends into 
the overlap or extensions.

 Print across entire size: The dashed line is printed along the entire length 
of the edges that have overlaps.

Thickness Enter the thickness of the dashed lines in points (pts).

Run into image area Enabled for the first two Length options: the length that the dashed line may 
extend into the image area.

Print tile line marks

You can print an outline along the edges of each tile:

 On Total Size: the tile including overlaps/extension

 On Bleed: the total size plus bleed

You can set the thickness, color and style of the line marks. Click the arrow 
icons to select a solid, dashed or dotted line.
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Renumber/
Rename Tiles and 
Assign to Sets

You can create multiple sets of tiles and identify the sets by renumbering/
renaming the tiles. This number is also picked up by the $image.tile_number 
variable which can be used to form the tile name.

1 Open the image and define the tiles.

2 Select the tiles you want to put in the first set, for example the Left tiles.

3 Click the pencil icon in the top toolbar with positioning tools to open the 
Assign to Set dialog.

4 Enter the Set Name, e.g. Left; you can also change the First Number in Set to 
renumber tiles starting from a different number than the default.

5 Click OK and then repeat to create a second set, for example the Right tiles.

Tiling Preferences This dialog box shows the settings for creating a PDF file with the montage 
instructions for the tiling arrangement at hand.
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 Open the cogwheel menu in the top right corner of the tiling inspector to 
open Tiling Preferences.

Montage Instructions

Montage instructions explain how the tiling arrangement is organized so the 
tiles can be assembled to recreate the original image. The instructions mention 
the order and job reference and give a short summary of the tiling set-up 
(product size, number of tiles, etc.).

Page size Choose a size and orientation for the PDF you will export.

Include You can choose to include a:

 List of tiles: A table with a list of all the tiles and the dimensions of the 
individual tiles with their overlaps and gaps.

 Montage overview: A diagram of the tiling arrangement as shown in the 
Product Editor. You can select a View Options preset to specify what will 
be printed exactly in the diagram.

Figure 10.55: A PDF document with montage instructions
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File name Enter a file name with or without variables from the drop-down list or use the 
default name with variables ($DOCUMENTBASENAME_MI$TIME).

Export directory Enter a location for saving the file with or without variables from the drop-down 
list.

Conflict handling Indicate how you want subsequent export files to be handled.

 Export a PDF with montage instructions

1 Open the tiled image in the Product Editor and go to the Tiling inspector tab.

2 If necessary, open the cogwheel menu and choose Tiling Preferences if you 
want to change the document set-up.

3 In the Various panel, select the Export montage instructions check box if 
you want the PDF to be created automatically when you submit the job.

OR

Click the Export and Open button to see the PDF immediately.

A PDF document with montage information and a tiling diagram is saved in 
the location specified in the Tiling Preferences and then opened in your 
default reader.
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Presets

NOTE: This option requires a special license.

Presets let you apply the settings you define for a particular image to other 
images of the same job or other jobs.

 In the Layout Editor or the Product Editor, open the Presets tool by clicking 
the Presets button in the toolbar.

The Presets dialog is displayed with a list of job presets and image presets on 
the left which are organized in folders. The list is initially empty. If you select 
an existing preset or create a new one you will see an overview of the settings 
that can be included in a preset in the panel on the right:

These are the settings that you would normally have to specify in the image 
inspectors for a new image. To save time, you can include all or some of the 
settings in a preset which can subsequently be used for new images.

Presets toolbar The + button to add a new preset; the cogwheel menu button and a gray triangle 
to open/close the settings panel.

Cogwheel menu The following commands are available; the commands are also available by 
context-clicking the preset in the list:

 Apply: Applies the selected image preset to the open image
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 Apply to New Images: The preset is applied to all images you add to the 
job. This option can be used to add image processing automation to 
Layout ticket templates (see “Creating Templates for Wide Format Jobs” 
on page 688).

 Edit Preset: Unlocks the presets so you can edit them; in this edit mode 
you can clear or select the settings check boxes and update the preset to 
match the settings of the current image; any changes you make to a preset 
in edit mode are saved automatically

 Rename Preset: Lets you edit the name of the selected preset

 Edit Description: Places the cursor in the Description box of the selected 
preset

 New Folder: Creates a new folder where you can put new presets

 New Job Preset: Creates a new job preset

 Duplicate Preset: Duplicates the selected preset

 Delete Preset: Deletes the selected preset

 Import Preset: Opens a file browser where you can select a preset for 
importing

 Export Preset: Opens a file browser where you can select a preset for 
exporting

NOTE: You can only add an image preset using the + button in the toolbar.

Preset filter Enter a value in the box to search for a preset in the list; click the X button to 
show all presets.

Presets list In this list you can create folders for Image presets; the first folder is the default 
folder and the only folder for all Job presets; image presets can be listed at the top 
level or one level lower in folders. Selecting an image preset displays the Image 
Settings of the preset in the panel on the right.

Image Settings Theses settings in the panel on the right are only displayed if you have selected 
an image preset in the list. The check boxes refer to the settings you can specify 
for an image in the Product Editor inspectors, plus the Image Mark Sets and 
Color Adjustments. Color Adjustments refer to changes you made in the Preview 
application, i.e. saturation, contrast, curves.
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Include None/Include All Buttons are enabled in edit mode. Use them to select all or none of the check 
boxes and include or omit the settings as specified for the current image in the 
selected preset.

Update Changed Button enabled in edit mode. Click to update the selected preset to match any 
changes made to the settings of the current image and which are included in 
your preset.

 Create image presets

1 Open the image whose settings you want to save as a preset in the Product 
Editor. This can be an image with bleed, canvas extensions and grommets, 
tiling, a step & repeat pattern, etc. as specified in the inspectors.

2 Open the Presets tool.

3 Click the + button (Add Preset) in the Presets toolbar.

The presets are unlocked and a new image preset appears in the list at the 
highest level. If you want to create the preset in a folder, select the folder 
before clicking the + button.

4 Enter a name for your new image preset.

In the Image Settings panel on the right, select the check boxes for the 
settings you want to include in the preset. You can also use the Include All or 
Include None buttons.

5 Enter a short description for the preset in the Description panel under the list.

6 Click the Update Changed button to confirm your preset.

7 Close the Presets tool.

8 Apply the Preset to a new image to test your preset.

 Apply image presets

You can apply an image preset in the Product Editor or in the Layout Editor. An 
existing preset can also be applied in a Layout Hot Ticket.

1 In the Product Editor, open the image to which you want to apply a preset.

2 Open the Presets tool.

3 Select a preset and check the Image Settings in the panel on the right.
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4 Open the cogwheel menu and choose Apply to apply the settings to the 
image. 

The image settings (bleed, canvas extensions, tiling scheme, etc.) are applied 
to the image.

OR

1 In the Layout Editor, select the image you want to apply the preset to in the 
Product panel.

2 Open the Presets tool.

3 Select a preset and check the Image Settings in the right panel.

4 Open the cogwheel menu and choose Apply to apply the settings to the 
image. 

The settings are applied to the image without opening the Product Editor. 
You will see the result of tiling immediately in the Product panel and when 
you place the image on a sheet.

NOTE: If an image has already been edited in the Product Editor, the preset 
replaces these existing setting and adds settings which are not yet specified 
for the image.

 Update a preset

1 Open the image which has the required settings in the Product Editor.

2 Open the Presets tool.

3 Select the preset you want to update and unlock the settings or choose Edit 
Preset on the cogwheel menu.

4 You can make further changes with the inspectors if you want and/or select 
or clear the check boxes in the Image Settings panel. 

5 Click the Update Changed button to include the changes in the preset.

6 Apply the Preset to a new image to test your preset.
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Tiles in the Layout Editor

The tiles of a tiled image appear as individual images in the Product panel of the 
Layout Editor. They form a group of images enclosed in a light blue box together 
with the master image. Tiles can be placed on sheets just like other images by 
dragging and dropping, or using the Auto Layout feature. Selecting the master 
images automatically selects all the tiles and places them on the sheet.

 Expand or collapse a tiled image

1 To expand a tiled image and see the individual tiles in the Product panel, 
context-click the tiled image and choose Expand Tiles.

2 To collapse the tiles of a tiled image, context-click a tile or the master image 
and choose Collapse Tiles, or double-click the master image.

1 Instances of an image on all the sheets of a job
2 Tile size
3 Position in the montage scheme: R1C2: Row 1; Column 2
4 Tile number: e.g. 2/4: tile number 2 of a total of 4 tiles

1

2

3

4
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Figure 10.56: Tiles expanded in the Product panel of the Layout Editor
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Design and Artwork Products

So-called packaging products generally combine a design and artwork: the 
contours of the design are filled with the artwork. The product design is defined 
by spot colors in a PDF file or the design paths in a CAD file. The artwork image 
can be aligned manually or snapped to a path in the design.

 Snap artwork to the product design

1 Click the artwork to reveal the known paths (spot colors) in the artwork.

The known paths appear in the Snap using drop-down list above the Product 
pane.

2 Choose a spot color and the Product Editor will attempt to align the paths of 
the selected color with the contour of the design.

If the artwork cannot be aligned with the design, its position does not change 
and a warning icon is displayed above the drop-down and in the Sources 
panel of the Product Inspector.

 Edit design paths

You can use the Path Editor inspector to edit the paths of a product design – not 
the paths in the artwork. Go to the Path Inspector for this.

Related topics: • Working with CAD Layouts on page 591
• Paths Inspector on page 631
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658 SYSTEM OVERVIEW WINDOW
System Overview Window 

The System Overview is one of the three main windows of the Apogee Client. It 
provides an overview of the overall configuration of your Apogee System and the 
Hardware System(s) running the system.

The System Overview is divided into 3 panes:

 Hardware Pane

 Task Processor Pane

 Resources Pane

Use this window primarily for:

 Configuring the Task Processors

 Creating and editing Parameter Sets for the Task Processors.

 Monitoring Task Processor activities

NOTE: Task Processor configuration is for service engineers only. However, the 
Press can be configured by an administrator.
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Hardware Pane

This pane displays the Apogee System icon and one or more Hardware System 
icons.

 The Apogee System stands for the entire software system running on one or 
more Hardware Systems. When you click the Apogee System icon, you will 
see all of the Task Processors available for the entire Apogee System. In the 
Resources pane, you will see icons for Apogee System Configuration, Job 
Housekeeping, Logging, Templates, Accounts, etc.

 Next to the System icon, Apogee displays the Hardware System(s) running 
the Apogee software. There is always at least one Hardware System icon 
which corresponds to the main Windows 2003/2008 server on which the 
Apogee System was installed. If, during installation, the Apogee System 
processes were distributed over additional “satellite” hardware systems, you 
will see the corresponding Hardware System icons (see “Hardware System 
Scalability” on page 659).

Hardware System 
Scalability

To provide faster and more efficient use of tasks and resources, your Apogee 
System processes may be distributed over 2 or more physical hardware systems. 
In this case, you will see additional “satellite” Hardware System icons in the 
Hardware pane, each one corresponding to a physical system. One of the 
Hardware Systems is highlighted in bold: This is the main Hardware System, 
which is running the “core” Apogee System software.

If you select one of these icons, you will see the Task Processors that are available 
on the selected Hardware System. All the other Task Processors will appear 
faded out. By selecting each of the Hardware Systems in turn, you can see which 
Task Processors are installed on which systems. 

Similarly, if you select a Task Processor, you will see to which Hardware System 
it belongs: The other Hardware Systems will appear faded out.

You may also see that some Task Processors (such as Normalize and Render) are 
duplicated on two or more Hardware Systems. This can reduce the processing 
burden on a single Hardware System, and greatly increase the speed with which 
jobs are handled by the Apogee System.
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For information on setting up Satellite servers, refer to the Apogee Installation 
Guide.

Activity Monitoring Your Apogee System can run certain maintenance tasks, such as Job House-
keeping, in the background. These tasks may slow down the processing of jobs. 
This kind of activity is indicated with a green border around the main or satellite 
icons in the hardware pane and implies that processing speed may be affected.

 Double-click a hardware icon to open the Activity Monitor dialog and display 
a list of current tasks and components.
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Task Processor Pane

This pane displays all of the available Task Processors for the selected hardware 
system. You can also check the Task Processors’ activity by double-clicking their 
icon.

The Task Processors are divided into four categories:

 Input Task Processors

 Processing Task Processors

 Output Task Processors

 Print Task Processors

Managing your 
Task Processors

This section explains how you can manage your Task Processors from the 
System Overview window. You can start, stop and restart any Task Processor. 
Stopping a Task Processor (if you are not planning to use it) will improve system 
performance, since Apogee will then require fewer system resources. Output 
Task Processors need to be restarted if you change the configuration of the 
associated output device.

Additionally, Task Processors associated with physical output devices can be put 
online and offline. You can also create a PostScript Printer Description file (PPD) 
containing all job-related information specific for your output environment.

TIP: In Apogee, you can create PPD files for different PS Printer Drivers for 
Macintosh as well as PC. You can further specify some content-related options.

See also “Monitoring your Task Processors” on page 664.

 To start a Task Processor

1 In the System Overview, locate the inactive Task Processor. 

When a Task Processor is inactive, the icon will have static horizontal stripes 
running through it. 

2 Context-click the Task Processor, and select Start from the context menu.
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 To stop a Task Processor

1 In the System Overview, locate the active Task Processor. 

2 Context-click the Task Processor, and select Stop from the context menu.

The Task Processor will stop after a few moments. When the Task Processor 
has stopped, the icon will have static horizontal stripes running through it. 

You can re-activate it by context-clicking it and selecting Start from the 
context menu.

 To restart a Task Processor

1 In the System Overview, locate the active Task Processor. 

2 Context-click the Task Processor, and select Restart from the context menu.

While the Task Processor is restarting, the icon will have moving horizontal 
stripes running through it. 

 To put an Output Task Processor offline

1 In the System Overview, locate the active Output Task Processor. 

2 Context-click the Task Processor, and select Put Offline from the context 
menu.

The Task Processor is colored blue to indicate that it is offline.

 To put an Output Task Processor online

1 In the System Overview, locate the offline Output Task Processor. 

Offline Task Processors are colored blue.
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2 Context-click the Task Processor, and select Put Online from the context 
menu.

The Task Processor comes back online, and the blue shading is removed from 
the icon.

 To create a PPD file for an Output Device

1 In the System Overview Window, select the output device for which you want 
to create a PPD file.

2 Choose File > Export Output Device PPD. You can also directly context-click 
on the Output Device and select Export Output Device PPD from the context 
menu.

The PPD User Options dialog box appears.

3 Specify the necessary Format and Content options as specified in “PPD User 
Options” on page 670.

4 Click OK to create the PPD file.

 To print an exposure test page for platesetters

When you first start to use your platesetters, you should submit an Exposure Test 
job to check the output and to select the engine’s best exposure settings. You 
should continue periodically to submit Exposure Test jobs to make sure that the 
engine is still producing good quality output. 

NOTE: This option is currently supported only for the Galileo and XCalibur 
platesetters.

1 Select the System Overview.

2 Select your platesetter.

3 Double-click the Linearization Curves icon in the Resources pane.

The Linearization Curves overview appears. In the upper pane, you see all of 
the available Linearization Curves for the selected platesetter.

4 Click the Exposure... button (only available for Galileo and XCalibur 
platesetters).

The Exposure Parameters dialog box is displayed. The name of the selected 
engine is displayed in the title bar of the dialog box.
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You will see a list of resolutions at which you can print an exposure test. For 
each resolution, you will see default frequency and exposure settings. If you 
wish, you can change these default settings.

5 To change the frequency and exposure settings:

 Select a resolution, and click the Edit button:

The Resolution Test Settings dialog box is displayed.

 Click the Frequency list, and select one of the available frequencies.

 Enter an Exposure setting.

 Click OK to return to the Exposure Test dialog box.

6 Use the check boxes in the Print column to select one or more of the available 
resolution settings.

7 Click the Print button.

The Exposure Test dialog box is closed, and test pages are printed out on the 
engine at the selected resolutions. The print date is automatically added to 
the test pages. 

In the Job List, all exposure tests are grouped under the same order number 
called “Exposure Test”. The job name of the test file to be printed is called 
“<device name> Exposure Test”.

Monitoring your 
Task Processors

The current status of a Task Processor is indicated by the appearance of the Task 
Processor icon. The icon may be adapted with a series of different colors and 
overlays which indicate the hardware or component status of the Task 
Processor.

Output Task Processor Hardware Status

The hardware status is the status reported by the physical output engine. 

When a physical output device is not idle (i.e. able to communicate and process 
jobs), it will be in one of the following states:
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In each of the above cases, the relevant status icon will appear as an overlay on 
the Output Task Processor.

NOTE: The hardware status is not the same as the component status. For 
example, the component status may be online and ready while the physical 
hardware engine is actually disconnected or paused.

Task Processor Component (Software) Status

This reflects the status of the connection between the Apogee System and the 
Apogee Task Processor component. As such this is a software setting which has 
no relation to the actual physical status of the associated output device.

NOTE: The component status is not the same as the hardware status. For 
example, the component status may be online and ready while the physical 
hardware engine is actually disconnected or paused.

The Task Processor component status is indicated visually as described below.

Paused: The output engine is able to communicate, but cannot process any tasks. A user 
interaction has taken place on the device itself to trigger this status.

Disconnected: The output engine's cable has been unplugged.

Warning: The hardware engine requires attention (e.g. ink low), but can still receive tasks.

This platesetter is managed by the PlateMaker Client. The yellow ‘sun’ patch indicates that 
the device is in attended state (i.e. A user is logged in to the PlateMaker Client).

This platesetter is managed by the PlateMaker Client. The gray ‘moon’ patch indicates that 
the device is in unattended state (i.e. no one is logged in to the PlateMaker Client).

Error: The hardware engine requires attention - it cannot continue to receive and process 
tasks until the problem has been resolved (e.g. no ink). 
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These status indicators can also be seen in the Output Device List, in the Job and 
Hot Ticket Managers.

Activity Window

The Activity window consists of two panes and a toolbar:

 In the upper pane, you can see the selected Task Processor icon, and a brief 
summary of the Task Processor’s activity. This indicates how many tasks are 
being processed or are waiting to be processed, and the number of errors. 
The status of the Task Processor is indicated by the color of the icon. For more 

The Task Processor is ready, and is currently idle.

The Task Processor turns green when it is processing a task. For example, the 
Avantra Task Processor is busy processing a separation.

The Task Processor turns red if a processing error occurs. In this case an error 
notification is sent to the Message Board, explaining the nature of the error.

The Task Processor turns blue if it is offline.

When the Task Processor has been stopped (inactive), the icon will have hori-
zontal stripes running through it. You can re-activate it by context-clicking on 
the icon and selecting Start from the context menu.

The Task Processor is starting up (moving horizontal stripes).

The Task Processor is locked, because you do not have a license to use it.

A purple arrow is attached to the Task Processor icon if:
• You have a remote license. This means that this Task Processor is not 

licensed to execute tasks: These tasks are processed remotely on another 
Apogee System. However, you can use this Task Processor to specify the set-
tings in the Production Plan.

• A remote proofer is installed (as specified in the installer). The remote proofer 
is combined with the Remote Proofer Controller Task Processor.
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information on icon color codings, see “Task Processor Component 
(Software) Status” on page 665.

You can see which tasks are currently being processed by the selected Task 
Processor. The progress of the activity is shown by a progress indicator. If 
more Task Processors of the same type are installed on the Apogee System 
(e.g., two Normalizers or two Renderers), then you will see the activity for all 
Task Processors of this type.

NOTE: If you are viewing the activity of an output Task Processor with 
ganging enabled (such as a Sherpa proofer), you will also see a Flush button. 
If you click this button, Apogee will stop collecting input (ganging) and start 
printing the available pages (see “To flush job results” on page 670). Apogee 
will also indicate which type of media is currently loaded.

 In the lower pane, you can see the tasks that are waiting to be processed. This 
information is displayed in three columns:

 Status icon: Indicates the current status of the task (waiting for media, 
waiting for a soft proof, etc.). For a description of all these icons, see “Job 
Status Icons” on page 151.

 Job: Lists the jobs, and the individual tasks within each job.

 Destination/Media: Indicates to which output device the job will be sent. 
If you are monitoring the activity of an output device, this column will 
display the type and size of the media that is being used.

By default, the tasks are sorted according to status. You can sort the list 
according to job name or job status, in ascending or descending order, by 
clicking the appropriate column title. You can also re-order the tasks by 
dragging and dropping.

 On the left side of the window, you can see the Activity Toolbar.
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Activity Toolbar

The Activity toolbar includes the following buttons that allow you to manage the 
activity of the selected Task Processor:

NOTE: The buttons you actually see depend on the current status of the task you 
are viewing.

 To check Task Processor activity

1 In the System Overview, locate the active Task Processor. It has changed 
color or is surrounded by a colored glow.

2 Double-click the Task Processor icon.

The Task Processor’s Activity window appears, where you can monitor the 
activity of Task Processors. The Activity window shows:

 The jobs that are currently being processed

 The jobs that are waiting to be processed

Continue processing a selected result that is on hold.

Put the selected activity on hold.
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 Any errors that have occurred

 To abort a task

1 In the System Overview, locate an active Task Processor. 

An active Task Processor will have changed color, or is surrounded by a 
colored glow.

2 Double-click the Task Processor icon.

The Task Processor’s Activity window appears. 

In the middle pane, you can see which jobs are currently being processed. 
The progress of the activity is shown by a progress indicator.

3 To abort the current task, click the Abort button to the right of the progress 
bar:

The selected task is immediately aborted.

 To hold a task

1 In the System Overview, locate the Task Processor which has scheduled the 
task you want to put on hold. 

2 Double-click the Task Processor icon.

The Task Processor’s Activity window appears. 

3 Select the task you want to hold.

4 Click the Hold button.

The selected task is put on hold. You will see the following status icon next to 
the task name:

 To resume a task that is on hold

1 In the System Overview, locate the Task Processor with a task on hold. 

2 Double-click the Task Processor icon.

The Task Processor’s Activity window appears. Any tasks on hold will have 
the following status icon next to the task name:
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3 Select the task on hold.

4 Click the Continue button.

The selected task resumes processing.

 To flush job results

1 In the System Overview, locate an active output Task Processor. 

NOTE: This must be a Proofer device.

An active output Task Processor will have changed color, or is surrounded by 
a colored glow.

2 Double-click the Task Processor icon.

The Task Processor’s Activity window appears. If you are viewing the activity 
of an output Task Processor with ganging enabled (such as a Sherpa proofer), 
you will see a Flush button.

3 Click Flush.

The selected Task Processor stops its current activity, and is forced to 
immediately output it’s collected results.

PPD User Options

This dialog box contains the different user options for PPD Format and Content.

PPD Printer Name

Here, you can change the name of the printer in the PPD file.

PPD Format

In the Format tab, you can specify the PS Printer Driver for which you want to 
create the PPD file. 

Create Windows PPD Files  Adobe PS Printer Driver (PS)

 Microsoft Driver NT (NT)
Apogee Reference Guide



 

11 MONITORING AND CONFIGURING YOUR SYSTEM 671
 Microsoft Driver 2000 (20)

 Microsoft Driver XP (XP)

 Microsoft Driver 2003 (23)

Create Mac PPD Files  Apple LaserWriter/Adobe PS Printer 8.3.X (83)

 Apple LaserWriter 8.4/Adobe PS Printer 8.5 (85)

 Apple LaserWriter/Adobe PS Printer 8.6 (86)

 OSX (10)

Append driver
identification to file names

Select this check box to add the 2-digit printer driver ID (PS, NT, etc.) to the end 
of the PPD files names.

Keep filename short Select this check box to ensure that the name of the printer does not exceed the 
maximum number of characters allowed by Windows.

Use Japanese character
encoding

Select this check box to enable Japanese character encoding.

PPD Content

In the Content tab, you can specify some content-related options for the PPD file 
by selecting the required check boxes.

Halftones Select this check box to include halftone information in the PPD.

Page Sizes Select the type of page size you want to use:

 Standard page sizes

 Output sizes defined for device

 Both

NOTE: Due to a limitation of the PPD file size, only 58 screens will be visible in 
front end applications.

Parameter Sets <output
device> Flow

If you would like to use any of the default parameter sets of the output compo-
nents specified in the Hot Ticket Production Plan, select the associated check 
box. By default, all the check boxes are selected (e.g. - for a TIFF Imagesetter 
flow - Normalize, Run List, Impose. Trap, Separate, Render, etc.).
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NOTE: This option is only available when creating a PPD for a Hot Ticket.

Grouping Task 
Processors for Load 
Balancing

If you have several task processors of the same type, you can group these task 
processors and subsequently use this group in your production plans. Apogee 
automatically chooses the task processor which is available and the most 
suitable for the job, effectively balancing the load applied to these task 
processors.

 To group Task Processors

You need at least 2 identical task processors to create a group.

1 In the System Overview, context-click one of the identical task processors 
and choose New Group.

The Edit User Group is displayed.

2 Enter a Group Name. You can change this name later if you want.

3 Select the check boxes for the additional Task Processors that you want to 
add to the group.

4 Click OK.

The new Task Processor group is displayed with the group icon.

You can now use this group in your production plans.

 To delete/edit a Task Processor group

1 In the System Overview, context-click the Task Processor group you want to 
delete or edit.

The Edit User Group is displayed.

2 Choose Delete Group to ungroup the Task Processors and delete the group

OR

3 Choose Edit group to add or remove Task Processors in the group.

4 Click OK.
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Resources Pane

The Resources pane displays the resources that are available for the currently 
selected System or Task Processor:

 If the Apogee System is selected in the Hardware pane, in the Resources pane 
you will see the Configuration, Job Housekeeping, Logging, and Templates 
icons. If you have additional options installed, you may also see the Accounts, 
JDF Server, and JDF Stripping icons.

 If a Hardware or “Satellite” System is selected in the Hardware pane, you will 
see the Disk Storage icon in the Resources pane.

 If a Task Processor is selected, you will see the available Resources for the 
selected Task Processor in the Resources pane. These will always include a 
Parameter Sets icon, which allows you to create predefined Task Processor 
settings.

NOTE: Most of these resources are intended for administrators, and are hidden 
to operators.

Apogee System 
Configuration

If you select the Apogee System in the Hardware pane, you will see the Configu-
ration icon in the Resources pane.

By double-clicking the Configuration icon, you can access the Apogee System 
settings. These settings allow you to specify an e-mail address to which all 
system-related messages will be sent.

Administrator access level only!

System Configuration Settings

Double-click the Configuration icon when the Apogee System is selected to 
access the Apogee System configuration settings.

Administrator access level only!
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Administrator

This tab allows you to specify an e-mail address to which all system-related 
notifications will be sent (e.g. “insufficient disk space”).

E-mail messages to Select this check box to enable the e-mail service, and enter an e-mail address in 
the box on the right.

Announcement to users Enter text that you want to display as a service message each time a user logs on 
to the ProductionCenter application. You can specify a message for internal 
users and another for web users.

Mail Server

Sender Name: Specifies the name associated with your e-mail address. When you send 
messages, this name appears in the From box of your outgoing messages.

Email address: Specifies the e-mail address that people should use when sending 
mail to you at this account. The e-mail address must be in the format 
name@company: For example, johndoe@ECO3.com.

Mail Server Outgoing mail (SMTP) server: Specifies your SMTP server for outgoing messages. 
You can get this information from your internet service provider or LAN 
administrator.

Requires secure connection: Specifies whether to use the SSL (Secure Sockets 
Layer) security protocol when connecting to this server. The administrator or 
internet service provider for the server will indicate if the SSL requirement 
exists.

Override default SMTP port: Allows you to specify an SMTP port that will be used 
instead of the default SMTP port.

Requires authentication: Specifies whether to require authentication when 
connecting to this server. Select this check box, enter the e-mail address and the 
password in the boxes on the right.

Test This button sends an e-mail using the Sender address to test the Mail Server 
configuration.

Database Maintenance

This tab allows you to control how Apogee maintains its own database.

Backup You can instruct Apogee to write backups of its system database to a backup disk 
or shared volume. This allows you to restore the database in case the main 
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system fails. The Backup tab controls whether Apogee backs up the system 
database, and how and when it does it.

Make Full Backup when Job Housekeeping runs: Backs up and optimizes the 
databases. Full backups are a costly operation, and you should therefore limit 
the frequency (the default is once a day) and run it when production activity is 
minimal (default at 04:00). The minimum period for a full backup is once per 
day.

The Schedule group shows the dates of the last full and incremental backups.

Backup Now: Press this button to perform a full database backup using the saved 
configuration (i.e. the configuration stored on the server). You can do this at any 
time, regardless of automatic backup schedules. This button is disabled when 
there is no backup destination, or when Apogee is currently backing up the 
database.

Include all System and Task Processor resources: Backs up system process 
resources (in the event of a system crash).

Backup to: Apogee writes a copy of the backup data to the location (local disk or 
shared volume) you define or to the PrintSphere cloud server. If it cannot write 
to that location, Apogee notifies you and disables the schedules.

Scratch disk: This is a local disk that Apogee uses during the backup process. You 
can select any disk that is local to the core server, and that is not being used as a 
backup destination.

Previous backup sets: You can keep a number of full backup sets instead of 
keeping only the latest. This allows you to roll back the state of the system 
beyond the most recent backup. If you choose to keep only the last one, Apogee 
deletes the previous backup set (or sets) after successfully doing a full backup. If 
you choose to keep the last ‘n’ sets, Apogee leaves the most recent backups and 
purges the older one(s). Any changes to this option come into effect the next 
time a full backup is made.

 Delete: Deletes the previous backup set after successfully writing the new 
one. Note that this deletes all previous backup sets (in case you switched 
from ‘Keep last’ to ‘Delete’).

 Keep last: Keeps the specified number of previous backup sets. Note that the 
total number of backup sets is number specified plus one (the current one). 
Make sure you have sufficient disk storage!
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Security

This tab allows you to protect PDF files with a password and/or with a certificate 
that uses private/public key encryption method.

Protected PDFs Document Open Password: Specify the password that is required to open the PDF 
files.

Change Permissions Password: Specify the password that is required to print and/
or change permissions of the PDF files.

Certificate security Digital ID file (.pfx, .p12): Locate the digital-ID file with extensions of .pxf or .p12 
files. The file must be accessible by the Apogee Server and all of its Satellites.

NOTE: Never distribute this file, as it contains the private key.

Password: Specify the password that is used to create the digital-ID.

Exporting files If you want to encrypt files when you export them, you must preserve the 
Certificate from the input files. The exported files can then re-use that 
Certificate.

Preserve input certificate and export encrypted files: Select this check box to 
preserve certificate of the input file and export encrypted files.

ProductionCenter

ProductionCenter URL The URL of the printer’s ProductionCenter portal.

All Printer Company users
can see all jobs

Select this check box to allow users with the View Only role to see jobs in the 
WebApproval service.

Cogwheel menu

Compare Configuration Compares the System settings against the default values.

Restore Defaults Restores all settings to their factory defaults.

Job Housekeeping

If you select the Apogee System in the Hardware pane, you will see the Job 
Housekeeping icon in the Resources pane.
Apogee Reference Guide



 

11 MONITORING AND CONFIGURING YOUR SYSTEM 677
Administrator access level only!

By double-clicking the Job Housekeeping icon, you can access the housekeeping 
options for archiving and deleting jobs. These tasks are performed on a daily or 
weekly basis, and cannot be switched off. You can specify, however, the exact 
time at which the archiving is carried out.

Whether a job will be archived or not, can be set in the Archive after finish option 
in the Options tab of the Ticket Editor. During the archiving, Apogee examines 
each job and archives the eligible ones.

NOTE: Preferably, you should schedule housekeeping activities at night, so that 
they do not interfere with your processing tasks.

Job Housekeeping Settings

Double-click the Job Housekeeping icon to access the Housekeeping settings for 
a selected System.

Administrator access level only!

Run Job List maintenance

Choose when Apogee runs the maintenance tasks by selecting the appropriate 
options from the lists:

Every: Specify how frequently Job List maintenance should be performed. This may be 
every day, or on a specific day of the week.

at: Specify the time of day when the Job List maintenance can start. You can either 
enter a time, or use the up and down arrows to select one.

Do Maintenance Now... Click this button to run all job maintenance tasks without waiting for the sched-
uled time. Note, however, that deleted jobs will only be cleaned up if you have 
set the ‘Keep deleted jobs...’ option to 0.

1- Archive jobs

Save job archive as Specify the directory in which job archives and dumps are saved. You need to 
specify the exact path name and use variables to guarantee a unique file name. 
You can also use the browse button next to the field to browse for the required 
location. This location must be a shared disk accessible by both Apogee Client 
and Server. For more information on variables, refer to System Variables.
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Include Job Log: Check this option to also archive the Job Log (selected by 
default).

Create archive folder Apogee system creates the archive directory on the occasion of following events:

When creating the job: Creates an archive folder, when you create a new job or 
duplicate from an existing one.

When archiving the job: Creates an archive folder, if that job has no current 
archive folder.

Pre-process archive folder
with

Select to run a pre-process script only after creating an archive folder for a new 
job. You must provide the full path name to the script.

Options Specify any optional extra arguments that should be passed to the script.

Post-process archive with Select to run a custom external script after the archive has been written. You 
must provide the full path name to the script.

Options Specify any optional extra arguments that should be passed to the script.

2 - Delete jobs

When you run the Job List maintenance, Apogee automatically deletes all 
finished jobs that are marked for deletion, and that have exceeded their “keep” 
period, as specified in the Options tab of the Job Ticket (see “When Job is 
Finished” on page 291). However, although it deletes all of the job’s documents, 
processing results, and processing parameters, it does not delete the job descrip-
tion and log entry. The job is only completely removed using the options in 
“Clean up deleted jobs”.

3 - Clean up deleted jobs

Keep deleted jobs for at
least

Specify how long you want to keep deleted jobs by typing a number in the field 
and selecting the time unit (hours, days, weeks) in the list next to it.

If you do not want to keep deleted jobs, enter 0.

4 - Maintain Databases

This task runs the Database Maintenance, as configured in the DatabaseMainte-
nance tab of the System Configuration.

Cogwheel menu

Compare Configuration Compares the Job Housekeeping settings against the default values.
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Restore Defaults Restores all settings to their factory defaults.

Logging

If you select the Apogee System in the Hardware pane, you will see the Logging 
icon in the Resources pane.

By double-clicking the Logging icon, you can access the settings related to the 
Logging activity of Apogee. These allow you to control different aspects of the 
logging such as the logging schedule, export directory for log files or the items to 
be logged.

Administrator access level only!

Logging Settings

Select the Apogee System, and double-click the Logging icon to access the 
Logging settings.

Administrator access level only!

System Log

This tab allows you to specify which events should be logged and when they 
should be removed from the system.

Events to log Select the appropriate check box to include the required events in the log:

User interactions (start, stop, restart, put online, put offline): This includes Task 
Processor statuses such as start, shutdown, hold or resume.

Errors & warnings: This includes the error status of Task Processors, device 
statuses such as error, online and offline and non-informative notifications with 
their reply.

Informative messages: Important job-related actions such as job editing.

Major Task Processor events (start, stop): This includes statuses such as boot or 
shutdown of Task Processors.
Apogee Reference Guide



680 RESOURCES PANE
Housekeeping tasks: This refers to cleanup tasks such as archiving or deleting.

Log Clean up Choose a schedule for cleaning up the system log:

Every: Specify how frequently the clean up should be performed. This may be 
every day, or a specific day of the week.

at: Specify the time at which the cleanup can start. You can either type the time 
or use the up and down arrows to choose it.

Clean Up Now: Click this button the cleanup the System Log immediately, 
without waiting for the scheduled time. This opens the Clean System Log dialog 
box. Here you can have all the events instantly removed regardless of their age, 
or have them first exported and removed afterwards.

Keep log of system events for at least: Specify the period during which a System 
event is kept in the log. Once it has exceeded this limit, Apogee will remove the 
event during the daily cleanup. The minimum period is 1 day.

Specify the period by typing the number in the field and selecting the time unit 
(days, weeks) in the field next to it. You can use the up and down arrows to select 
the time unit.

Export events before deletion: Select this check box if you want Apogee to export 
a copy of the events. This way, you can guarantee that no events will be lost or 
will appear twice. If you do not select this check box, Apogee will keep all the 
events, until you clean it manually or switch the option back on.

Export to: Enter the path and filename to be used for exporting the System log. 
Apogee exports the log after discarding the system events. You can also use the 
Browse button next to the field to locate the required directory.

There are three possibilities when exporting:

 If the log file already exists, Apogee will try to append the events to the file.

 If it cannot append the events, it will create a new file with a sequence 
number. 

 If there is no existing file, Apogee will create a completely new file.

Job Log

This tab allows you to specify which job events should be logged and when they 
should be removed from the system.
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Events to log Select the appropriate check box to include the required events in the log:

Media usage: Events related to the use of resources such as film and plate or 
proofing media.

Used resources: Events related to Resource selection such as screen types, 
profiles, calibration and linearization curves. Events related to Task Processor 
parameter sets.

Color Management: Events related to input document color management, press 
and proofing output color management and spot colors.

Proofing actions: Events related to the proofing result such as waiting, continue, 
reject.

User interactions: Job related events such as resume, rush, edit. Task Processor 
related events such as hold, resume, rush. Result related events such as remake.

Errors & warnings: Non-informative notifications and their replies.

Informative messages: Important job-related actions such as job editing.

Parameter updates by Task Processor: when a Task Processor changes the job 
settings.

Task Life cycle events (created, started, finished): When a job is created, has 
started or is finished.

Export job log Export the job log when a job finishes: Select this check box if you want Apogee to 
export the job log. This will happen shortly after the job has finished and not 
during the daily cleanup. 

If you remake a job after it has finished, Apogee will append the new events to 
the existing exported log. If the log has been removed, it will create a new one.

Export as: Enter the path and filename to be used for exporting the Job log. You 
can also use the Browse button next to the field to locate the required directory.

There are three possibilities when exporting:

 If the log file already exists, Apogee will try to append the events to the file.

 If it cannot append the events, it will create a new file with a sequence 
number. 

 If there is no existing file, Apogee will create a completely new file.
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Reporting

This tab allows you to specify the retention period in weeks, months or years.

Keep Reporting History for Enter the reporting history period in weeks, months or years.

Cogwheel menu

Compare Configuration Compares the Logging settings against the default values.

Restore Defaults Restores all settings to their factory defaults.

Templates

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the 
Templates icon in the Resources pane.

By double-clicking the Templates icon, you can access the Templates dialog box, 
which allows you to create, edit and manage the different types of templates 
(Job Tickets, Hot Tickets, Layout Tickets and Layout Hot Tickets). From here, 
you can edit an existing template and save it with a different name. This is very 
useful when you regularly need to create tickets for similar jobs. You can start 
from an existing template and make any necessary changes without having to 
create a completely new ticket from scratch. You can also create new templates 
from the Ticket Editor using the File > Save as Template command.

For more information on creating Tickets, see “Creating and Editing Tickets” on 
page 281. You can save the Ticket Templates in Template Folders. In this way, 
you can for instance group Ticket Templates that you use for a specific customer 
or print job.

Related topics: • Checking Hot Ticket and Ticket Template Consistency on page 270

Working with 
Template 
Categories

Template Categories are folders in which you can save your newly created Ticket 
Templates. You can group your Ticket Templates in different Template catego-
ries for specific types of jobs.

Administrator access level only!
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 To manage your template categories

1 In the System Overview, select the Apogee System icon in the Hardware 
pane.

2 Double-click the Ticket Templates Resources icon in the Resources pane.

The Templates dialog box appears.

3 Select either the Job Tickets tab or the Hot Tickets tab depending on for 
which type of Ticket Template you want to create or edit a Template 
Category.

4 In the Category list, do one of the following:

 Click the New button to create a new Template category, type the name 
of the new category and click OK.

 Select a Template category and click the Edit button to edit it. Rename the 
Template category and click OK.

 Select the Template category that you want to delete and press Delete or 
click the Delete button. Click ‘Yes’ to confirm the deletion.

5 Close the Ticket Templates dialog box.

Related topics: • Working with Ticket Templates on page 683

Working with 
Ticket Templates

In the Ticket Templates Resources category, you can edit, delete or set a Ticket 
Template as default.

Administrator access level only!
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 To manage your Ticket Templates

1 In the System Overview, select the Apogee System icon in the Hardware 
pane.

2 Double-click the Templates Resources icon in the Resources pane.

The Templates dialog box appears. 

3 Select either the Job Tickets tab or the Hot Tickets tab depending on which 
type of Ticket Template you want to edit.

4 To select the Ticket Template that you want to edit, delete or set as default, 
do one of the following:

 Select the Ticket Template category in the Category list and select the 
Ticket Template that you want to edit.

 Select All in the Category list to view all of the Ticket Templates and select 
the Ticket Template that you want to edit.

5 Do one of the following:

 Click the Edit button to edit the Template in the Ticket Editor. Choose 
File > Save as Template and specify in which folder you want to save the 
Template. You can also save it under a new name. Click Save to save it.

 Click the Default button to set the Template as default. It will appear in 
bold in the Ticket Template list.

 Delete the Template by pressing Delete or clicking the Delete button. 
Confirm the deletion.

6 Close the Ticket Template dialog box.
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 To export a Ticket Template

You may want to export a template for use by another Apogee System, or in 
order to have a temporary backup file.

NOTE: You can only import/export all ticket templates for a specific category.

1 In the Templates dialog box, select a template from the list and click the 
Export button.

2 Locate the folder to which you want to export the template, and click OK.

The template is exported as a MIME format file (*.mime).

 To import a Ticket Template

1 In the Templates dialog box, click the Import button.

2 Locate the folder which contains the template you want to import.

This will be a template that was previously exported. This file will be in MIME 
format (*.mime).

3 Click Open.

The imported template is displayed in the list.

Related topics: • Checking Hot Ticket and Ticket Template Consistency on page 270

Creating WebApproval and StoreFront Templates

If your system is set up to use the WebApproval service, the ProductionCenter 
application and/or the StoreFront application, you can prepare special 
templates to create jobs for these workflows.

These templates are indicated with special icons in the Template list of the 
Templates resource and the Templates dialog when creating a new job.
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1 A template to create WebApproval jobs
2 A template to create Self-Service jobs in the ProductionCenter application 
3 A template to create jobs automatically from data downloaded via the StoreFront application

 Create a ticket template for WebApproval jobs

WebApproval jobs allow remote users to upload files and/or approve the pages 
of the job.

1 Create, set up and submit a new WebApproval job

OR

Select an existing WebApproval job in the Job List.

NOTE: WebApproval jobs have a web-enabled Hot Folder and a Web Proof 
action in the plan.

2 Choose File > Save As Template.

3 Choose a Category and enter a Name and Description.

Optionally, you can make the ticket available for StoreFront.

4 Click Save.

When you choose File > New from Templates you will see the new template 
has been added to the list and it is indicated with the WebApproval icon.

The icons are also visible in the Template list of the Templates resource.

 Create a ticket template for ProductionCenter (Self-Service) jobs

An Apogee job can be created in the ProductionCenter web portal application. 
These so-called Self-Service jobs are created from ticket templates that you 
prepare in Apogee.

1 Create a ticket template for a WebApproval job as described above.

1

2
3
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NOTE: WebApproval jobs have a web-enabled Hot Folder and a Web Proof 
action in the plan.

2 When you save the template, select the Make available to 
ProductionCenter check box and choose one of the following options:

 Visible to all customers: All your companies (customers) will see and be 
able to use the template when they start a new job in ProductionCenter.

 Visible to <selected company>: Only the specified company will be able 
to use the template.

When you choose File > New from Templates you will see the new template 
has been added to the list and it is indicated with two icons: the WebApproval 
icon and the Apogee icon.

The icons are also visible in the Template list of the Templates resource.

 Create a StoreFront ticket template

A special job ticket template is required to create a job from the data downloaded 
automatically from the StoreFront application. Read the StoreFront Help for 
more information.

1 Create, set up and submit a new job

OR

Select an existing job in the Job List.

2 Choose File > Save As Template.

3 In the Templates dialog, select the Make available to StoreFront check box.

4 Choose a Category and enter a Name and Description.

5 Click Save.

When you choose File > New from Templates you will see the new template 
has been added to the list and it is indicated with the StoreFront icon.
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The icon is also visible in the Template list of the Templates resource.

NOTE: The StoreFront template can also be used for other jobs.

Creating Templates for Wide Format Jobs

When creating a template from a layout job, you have extra options to set the 
template as default for devices and for new jobs. Image processing automation 
can be achieved using presets (see “Presets” on page 650).

 Create a ticket template for Wide Format jobs

1 Create and set up a Wide Format job.

OR

Select an existing Wide Format job in the Job List.

2 Choose Save As Template from the File menu or the context menu.

3 Enter a name for the template in the Name box and choose a category.

You can select the following options:

 Use as default template for device: the new template will be used when 
creating wide-format jobs starting from a particular device (context-
clicking a S&D device in the Jobs window or dropping files on the device).

 Use as default template for new jobs: the new template will be used when 
using the New Wide Format Job command on the File menu or context 
menu.

 Make available to StoreFront: Select this check box if you want to use this 
ticket template to process orders in the StoreFront application. The ticket 
template will appear in the Default Ticket Template drop-down list.

and the following check box:
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 Include all frames, sheet and print layouts: all these settings, including 
named frames, will be applied to the new Wide Format job. 

4 Click Save.

Page Sizes

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the Page 
Sizes icon in the Resources pane. By double-clicking this icon, you can access the 
Page Sizes settings. This allows you to specify page size resources for use in 
Multi-part jobs (as a property of a part). 

Page Sizes Settings

Administrator access level only!

Name 

The name with which this particular page size is known. If you leave it empty, 
the page size is shown using the dimensions (w x h).

Page Size

The width and height of the page (cannot be blank or 0).

You can specify units by entering them explicitly. Apogee defaults to the 
standard units (mm) if you do not provide them.

You can create, edit or delete Page Sizes using the supplied buttons.

Products

The Products resource displays an overview of the Product presets which are 
available in the Product Inspector in the Products tab of the Job Ticket Editor. 
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Administrator access level only!

Refer to “Product Inspector” on page 299 for a description of the settings and 
Working with Apogee Impose on page 369.

Sheet Sizes

The Sheet Sizes resource allows you to specify Press Sheet sizes for use with 
Apogee Impose, as a property of a Press Sheet. 

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the Sheet 
Sizes icon in the Resources pane. By double-clicking this icon, you can access the 
Sheet Sizes settings.

Sheet Sizes Settings

Name 

The name with which this particular sheet size is known. If you leave it empty, 
the sheet size has no name so you must name it.

Sheet Size

The width and height of the page. For web production, leave the height blank or 
zero and these sizes will be picked up for web presses.

You can specify units by entering them explicitly. Apogee defaults to the 
standard units (mm) if you do not provide them.

You can create, edit or delete Sheet Sizes in the usual way.

StoreFront

The StoreFront resource allows you to set up the connection between Apogee 
and StoreFront. Apogee polls the StoreFront server for new orders, downloads 
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the order items and automatically creates jobs for further processing. For more 
information on StoreFront, refer to the application’s Online Help.

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the Store-
Front icon in the Resources pane. By double-clicking this icon, you can access the 
StoreFront settings.

StoreFront Settings

Enable StoreFront Polling

Select this check box to activate the StoreFront service and let Apogee poll the 
StoreFront server by clicking the Poll now button. This option must be selected 
to edit the settings.

Connection 

User Name/Password Enter your user name and password for the StoreFront server.

Download Poll Time Set how often you want to check for new order items on the StoreFront server. 
The minimum polling time is every 15 minutes.

Cogwheel menu

Compare Configuration Compares the StoreFront settings against the default values.

Restore Defaults Restores all settings to their factory defaults.

Imposition

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the Imposi-
tion icon in the Resources pane. By double-clicking the Imposition icon, you can 
access the Imposition settings. This allows you to specify some general and “split 
for proof” settings.
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Imposition Settings

Administrator access level only!

General

This tab allows you to enable the clipping and define the Sheet Prefixes.

Clipping Clip marks outside of the press sheet: Select this check box to clip marks when 
they run out of the press sheet.

Outer Margin: You can add a margin on the outside of the press sheet. Outer 
margin must be greater than or equal to zero.

Sheet Prefixes The sheet prefixes are used to distinguish between press and fold sheets of 
different parts. You can control the grouping and numbering of the sheets with 
the Sheet prefix. This is a string of one or more characters to provide:

 a simple mechanism to group and number sheets, regardless of part and 
production set: All sheets with the same prefix are grouped and numbered 
independently of other groups. The sheet containing the lowest signature 
index is given the number 1, and the others are numbered consecutively in 
order of signature. index. The gaps in the index numbering are ignored.

 a mechanism to uniquely identify a sheet: The prefix, in combination with 
the sheet number is a unique identification of a sheet. The prefix and the 
number are simply concatenated, if you want to have a dash or another 
separator (except spaces), you need to make it part of the prefix string.

Default prefix: When you create production sets from the parts, the prefix is set 
according to the part type. In case a production set contains pages from multiple 
parts, the lowest page number determines the part type to use.

When you create a new part manually, the prefix from the production set previ-
ously holding the sheets is copied (i.e., after filling in the sheets/sides). The 
prefix is left unchanged when you remove the sheets from a production set.

Part Type Prefix

Cover (empty)

Cover (perfect bound) C

Plain (empty)

Insert I
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You can configure the prefixes for every part type in the Sheet Prefix configura-
tion with the following parameters:

 Cover

 Cover (perfect bound)

 Plain

 Insert

Split for proof

Split for Proof disassembles the main imposition layout and reassembles it so the 
product can be proofed on a small (e.g. an A3) laser printer, maintaining the 
reader order of pages and the layout of the marks of the main imposition 
scheme. Split for Proof re-arranges the product as a set of 2-up saddle-stitch 
sheets. This arrangement allows for easy gathering and folding, with no cutting 
needed. Alternatively, you can have a 1-up arrangement. The following proofing 
modes are available: 

 1-up: Creates a proofing result for each page that is part of the main 
imposition.

 2-up: Creates a proofing result for reader-spread that is part of the main 
imposition.

 Product proof: Creates a proofing result for each product that is placed on a 
sheet.

NOTE: Product proof mode is only available for Layout Editor based jobs, 
Plate Assembler jobs are not included.

Limit number of sheets for
folding

You can limit the number of sheets that you need to fold together. The bigger the 
stack, the harder it is to fold. This option limits the number of sheets in a stack to 
the specified amount, making the folding easier. Note that this modifies the page 
arrangement: You need to stack and fold the correct number of sheets, otherwise 
the pages will not be in the correct reader order. 

NOTE: This option is only applicable when you use 2-up Split for Proof.

Limit mark-zone around
pages

You can limit the page area to be proofed to the page itself and a zone that 
contains the marks (except for the spine in case of 2-up). The area is thus the 
pages trim box expanded with the specified amount. If you switch it off, the 
boundaries of the page area are determined only by the output size.
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This option is especially useful for preventing pages from being scaled down too 
much when using an imposition with large sheet or plate margins.

Emulate asymmetrical
Folding Schemes and Web

Production Schemes

You can add filler pages to the Soft for proof result to obtain the same page 
distribution as the Folding Schemes and Web Production Schemes produce.

Template Manager

Template path Defines the location containing the Imposition templates.

Marks path Defines the location of the folder containing the Imposition marks.

Extra PJTF Marks path Defines the location of a folder containing extra PJTF files.

Marks Select which marks to print, and how to print them.

Print crop marks for bleed bounds: Print crop marks at the bounds of the bleed 
area.

Print side center marks: Print center marks for each side.

Print punch mark: Print a punch mark.

Crop and Fold Marks Print fold marks with white knockout: Print fold marks with a white knock-out. 
This makes the marks more visible when the underlying content is dark.

Print crop marks with white knockout: Print crop with a white knock-out.

Move crop marks when shingling: Move the crop marks together with the pages 
when using shingling. When you deselect it, the crop marks keep their original 
position, as if no shingling was applied.

NOTE: This option also affects the moving of crop marks for bleed bounds.

These options determine in which layer Apogee prints crop and fold marks.

 On top: The crop and fold marks appear on top of everything, including pages 
and those marks that are set to “Bring to front”.

 On top of pages, below “Bring to front” marks: The crop and fold marks 
appear on top of everything, excluding those marks that are set to “Bring to 
front”. The crop and fold marks appear on top of the pages (most likely the 
bleed area), but they can be covered by important marks such as a color bar. 
In order to be effective, you should set only important marks to “Bring to 
front”.
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 Below pages: Crop and fold marks appear below pages and marks. Select this 
option if you want pages and their bleed area to cover the crop and fold 
marks.

Text mark font Set the default font for text marks.

Default line width Set the default line width for marks.

Clip marks outside sheet Sets the distance outside the press sheet to clip marks.

Replace $SIDE by Defines how Apogee replaces the $SIDE variable, found as marks on imposition 
templates

A, B, C, D: Select this option for the traditional imposition replacement (A, B, 
and so on). This system assigns a unique identifier to each side, even on multi-
web presses.

Front & Back: Select this option for the Apogee convention: Front for front sides, 
Back for back sides.

Cogwheel menu

Compare Configuration Compares the Imposition settings against the default values.

Restore Defaults Restores all settings to their factory defaults.

Users

Administrator access level only!

The Users resource is where users are granted rights to Apogee. When a user logs 
on, the roles assigned to the user in this resource are automatically activated.

Select the Apogee System in the Hardware pane to see the Users icon in the 
Resources pane. Double-click the Users icon to open the resource where you can 
create users and set their roles with detailed privileges.

User Settings

User list

Administrators can add and delete users in this list. Select a user in the list to see 
personal details and the assigned roles in the details pane under this list. One or 
more roles can be assigned and these are also indicated with a green check mark 
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in the Role list. Assigning more than one role to a user allows further flexibility 
for user management. The names of the users in the Users column corresponds 
with the login names for your organization.

NOTE: A role indicated in red in the details pane means that the role was deleted 
while it was still assigned to a user.

Role list

Each role is a collection of privileges which are displayed in the Privileges tab. 
Several default roles are provided and these appear in the list in italics. These 
default roles each have a set of predefined privileges which are relevant for these 
specific roles. If necessary, these roles can be duplicated and the privileges fine-
tuned, or new roles can be created from scratch.

The default roles are the following:

Asanti/Prepress Operator You have access to the main job commands (except Edit Imposition) and to 
selected Task Processor resources.

Figure 11.57: User details
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Asanti/Prepress
Administrator

In addition to most job commands, you also have access to administration and 
system privileges; you can create and edit Task Processor Parameter Sets and 
ticket templates, and view and manage resources.

Imposition Operator You can only edit imposition jobs.

Imposition Administrator In addition to the Imposition Operator privileges, you can access the Imposition 
Task Processor Parameter Sets and manage its resources.

Layout Operator You can only access Layout jobs, you cannot perform any commands related to 
Commercial jobs.

Plate Operator You can perform certain platemaking commands such as making and remaking 
output. Only the Jobs window is visible.

View Only A user with this role can only view the selected windows of the Apogee client and 
is not able to perform commands.

Clicking a role in the Role list highlights the users with this role in the User list 
with a green check mark.

Privileges tab

Selecting a role in the Role list displays a breakdown of privileges in the Privi-
leges tab. Privileges are grouped in the following categories:

Job Operations Commands you can perform on tickets.

Prepress Administration Commands for managing Task Processors and licensing

System Resources Commands for managing system resources.

Task Processor Resources A list of all the Task Processors.

Client Display Options Use these options to show/hide specified windows or resources in the Apogee 
client.

Expand a category to display the privileges.

Edit Filter button Opens the Job Filter where you can fine-tune the privileges even further by 
specifying a filter to show/hide certain jobs in the Job List for the selected role. 
For example: user John has the role of Prepress Operator Plant A and can only 
see jobs whose Job Name contains ‘Plant A’. User Bill has the role of Prepress 
Operator Plant B and can only see jobs whose Job Name contains ‘Plant B’. See 
“Filtering the Job List” on page 146. This filter is set for a role so it can be re-used 
for all users with this role.
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Delete Filter button To delete a filter you may have set on a role.

The listed privileges refer to the ability to perform tasks or access resources in 
Apogee. Privileges can be selected individually within a category or at the 

Figure 11.58: Privileges for a typical Administrator role

Figure 11.59: Privileges for a typical Operator role
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category level. If all the privileges are selected within a category, the check mark 
is black, otherwise it’s gray.

User tab

This tab is also used in combination with the Role list. Select a role in the Role 
list to see which users have been assigned this role.

Accounts 

If you select the Apogee System in the Hardware pane, you will see the Accounts 
icon in the Resources pane. This resource provides an overview of the companies 
and user accounts which are specified in the WebApproval and PrintSphere 
applications. 

Apogee needs a license to enable WebApproval and PrintSphere. Without these 
licenses, none of the dedicated resources, channels and actions are available.

Figure 11.60: Users displayed in the User list and User tab for a selected role
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Administrator access level only!

Double-click the icon to access the Accounts Overview.

Company A list of all the companies with accounts. The list contains one printer company 
(default name: The Printer Company) and all your customers, i.e. print buyer 
companies.

Users The details of all the users with user accounts in the selected company.

Related topics: • Web Proof on page 318
• Customer on page 285
• JDF Server Settings on page 700

JDF Server

Administrator access level only!

If you select the Apogee System in the Hardware pane, you will see the JDF 
Server icon in the Resources pane.

By double-clicking the JDF Server icon, you can access the JDF Server settings. 
These allow you to specify how Apogee builds the production plan for jobs 
submitted by the JDFServer or JDF Import, and how Apogee communicates with 
external systems used to input JDF files.

NOTE: JDF is a licensed feature. 

JDF Server Settings

The JDF Server dialog box comprises four tabs which allow you to specify how 
Apogee builds the production plan for jobs submitted by the JDFServer or JDF 
Import, and how Apogee communicates with external systems used to input JDF 
files.

Administrator access level only!
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Job Settings

Milestones When a milestone is present in the JDF, Apogee sets the appropriate ‘milestone’ 
time in the job’s Options tab, and sets the notification to be sent some time before 
the specified milestone occurs.

Notify before: Specify the notification time.

Product Definition You have the option to match the JDF job with a Product whose name matches 
the value of @ProductTypeDetails or select a preferred preset for the different 
assembly types. Choose a preset Product from the drop-down lists for the 
different assembly types. If you clear both check boxes, the Default Product you 
choose in this drop-down list is used.

Apogee Impose Choose a Press Sheet Layout rule from this drop-down list for JDF jobs.

Sheet Prefixes Choose whether you want to use sheet prefixes of Production Sets in multi-part 
jobs or not at all.

Content By default, Apogee attempts to retrieve every content element as specified by the 
JDF, even in cases where none of them are located in their intended locations. 
When there are numerous missing documents for a job, this could take a while. 
In such a case, you can select the check box Stop retrieving content files as soon 
as one goes missing. 

PlateMaker Link You can enable the synchronization of separations between Prepress and Plate-
Maker servers by selecting the check box. As soon as rendered separations 
become available, they are transferred from Prepress Server to PlateMaker 
Server. 

Planless Submission

This tab defines how Apogee builds the production plan for jobs submitted by 
the JDFServer or JDF Import. Apogee uses these settings as defaults when it 
receives a ‘planless’ job description or an incomplete plan, such as submitted by 
a Hot Ticket with only a JDF Input.

Production Plan: Build
dynamically

Apogee will check the incoming JDF/JMF for processes/grayboxes, and will use 
this information to dynamically create the production plan for jobs.

Output device: Select a high-resolution output device from the list. If high-
resolution output is requested in the JDF but no specific device is specified, then 
this high-resolution output device will be used.

Imposition proofer: Select any proofer other than the TIFF Proofer. If proofing is 
requested in the JDF but no specific proofer is specified, then this proofer will be 
used.
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Proofer data by: Select how the page proofer receives its data:

 Separate Render: Apogee splits the imposition proof flow into two flows 
before the main Renderer, and uses a separate Renderer to drive the proofer.

 Digital Film Proof: Apogee splits the imposition proof flow into two flows 
after the main Renderer, and inserts a Digital Film Proofer to drive the 
proofer.

Page Proofer: Select a proofing device for page proofing from a list of all available 
proofers.

Press: Select a press from the list of available presses. If you select a Generic 
Press, you can also select a Press Parameter Set.

Digital Press: Select a Digital Press from the list of available Digital Presses.

Sign and Display Printer: Select an S&D printer from the list of available S&D 
Printers.

JMF Input Choose a JDF Import parameter set that contains the prepress expansion from 
the drop-down list.

Action Points Select the actions you need in the job’s Production Plan. By default, no actions 
are added, except ‘Collect for Output’ before the main device. Note that the 
‘Collect for Output’ action before the main device is set to collect by Job, and the 
one before the proofing device is set to collect by Page. None of the actions are 
set to Notify. The ‘Collect for Output’ action before the proofer flow is set to hold 
the results; you cannot select to continue them automatically.

 Add ‘Soft Proof’ before Impose Main Flow

 Add ‘Soft Proof’ before each Render TP

 Add ‘Hard Copy Proof’ before Render Main Flow

 Add ‘Keep Results’ on Render Main Flow

 Add ‘Collect for Output’ before Main Device

 Automatically start printing

 Add ‘Collect for Output’ before Proofing Device

Put job on hold If this check box is selected, the (not-intent) job stays on hold at the input 
channel until you continue it.
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Put intent job on hold If this check box is selected, the intent job stays on hold at the input channel until 
you continue it.

Production Plan: Use Ticket
Template

Apogee will use a ticket template to create the job. You can select a hot ticket 
template for regular jobs or for so-called layout jobs. See “Working with Hot 
Tickets” on page 268 and “Wide Format Hot Tickets” on page 273.

Hot Ticket Template From Category: Lists all categories and all Ticket Templates for Hot Tickets.

Default Template: specify a Default Template to be used for the various JDF job 
types.

Templates for Job Types: The five different job types correspond to a combination 
of specific grayboxes present in the submitted JDF. The fifth ‘job type’ is for 
assigning a ticket template to Intent jobs:

 Main flow only

 with Page Proofing

 with Imposition Proofing

 with Page and Imposition Proofing

 Intent jobs

 Digital Print jobs

Layout Hot Ticket Template From Category: Lists all categories and all Ticket Templates for Layout Hot 
Tickets.

Default Template: specify a Template to be used for the various JDF Layout job 
types.

Product Integration

These options allow you to specify how Apogee communicates with external 
systems and applications, such as an MIS system.

JDF Attribute Mapping The structure of a JDF job depends largely on the MIS vendor and the way a site 
uses it. To support the different structures, Apogee can map its attributes to the 
different parts in the JDF. This is especially important for administrative attri-
butes. The mapping between JDF and Apogee attributes is stored in a JDF 
Attribute Map resource.

Base Attribute Map: Defines the common attribute mappings used by most 
vendors.
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Edit Maps: opens the JDF Attribute Maps overview window. You can add, dupli-
cate, edit and delete JDF Attribute Maps using the corresponding buttons. You 
can also import and export maps.

Mis URL Only required for integration with StoreFront. Enter the URL where the MIS 
expects to receive JMF messages.

Apogee WebApproval Use Collaborators from MIS or WebApproval: This option specifies that Apogee 
should honor the list of collaborators as listed in the JDF job or ignore that list 
and use the list of collaborators set up in the WebApproval application.

Apogee Webserver Port: The port number of the Apogee Web server. Note that this does not set the 
port number. Apogee simply needs this number to pass on to external systems 
that need to connect to the web server. The default port number is 80.

Input Pre-process: “This option allows you to pre-process every file found in the Hot 
Folder before it is handled by the JDF Input Task Processor. Pre-processing input 
files is mainly used to ‘fix’ JDF files, and helps to integrate JDF products from 
different vendors.

Run script on incoming JMF: Specify the full path to the script you wish to 
execute. At runtime, the script is started with two or more arguments.

Optional arguments: Enter optional runtime arguments. Separate multiple 
arguments with spaces. If you need to specify an argument with a space in it, you 
must enclose that argument in single or double quotes, or you need to replace 
the space with a backslash. You can use Apogee variables as arguments. The JMF 
Input Task Processor substitutes each variable before passing it to the script. To 
avoid problems with spaces, JMF Input encloses each substituted string in 
double quotes.

Run script on incoming JDF: Specify the full path to the script you wish to execute. 
At runtime, the script is started with two or more arguments.

Optional arguments: Enter optional runtime arguments. Separate multiple 
arguments with spaces. If you need to specify an argument with a space in it, you 
must enclose that argument in single or double quotes, or you need to replace 
the space with a backslash. You can use Apogee variables as arguments. The JDF 
Input Task Processor substitutes each variable before passing it to the script. To 
avoid problems with spaces, JDF Input encloses each substituted string in 
double quotes.

Remove content files on external servers: This option determines whether or not 
Apogee removes externally referenced content files, and is deselected by 
default. This option only applies to files located in a Public Page Store or on a 
disk that is not being watched by a Hot Folder. It does not apply to files located 
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on a WebServer or in a Hot Folder, Files in a Hot Folder are always removed 
when they are moved into a job: Files referenced by other methods are never 
removed.

Extract thumbnails from PDF: JDF Server can extract the thumbnails of a PDF for 
viewing in the Results tab (when available). This option is available for all JDF 
jobs, regardless of how they were input (i.e. JDF Import or via JMF). This 
reduces the processing load, since the Normalizer does not have to create the 
thumbnails (which is slower than simply extracting them).

Output Include all partitions in resource messages: By default, all redundant information 
is removed from resource messages. Select the check box to include this 
information.

Post-process Run script on output JMF: Applies a post-processing script on outgoing messages 
towards MIS or Press. This can be used as a workaround to adapt messages if 
MIS has issues with it.

Optional arguments: Enter optional runtime arguments. Separate multiple 
arguments with spaces. If you need to specify an argument with a space in it, you 
must enclose that argument in single or double quotes, or you need to replace 
the space with a backslash. You can use Apogee variables as arguments. The JMF 
Input Task Processor substitutes each variable before passing it to the script. To 
avoid problems with spaces, JMF Input encloses each substituted string in 
double quotes.

Run script on output JDF: Applies a post-processing script on outgoing JDF. This 
can be used as a workaround to adapt a JDF if the receiver has issues with it.

Optional arguments: Enter optional runtime arguments. Separate multiple 
arguments with spaces. If you need to specify an argument with a space in it, you 
must enclose that argument in single or double quotes, or you need to replace 
the space with a backslash. You can use Apogee variables as arguments. The JDF 
Input Task Processor substitutes each variable before passing it to the script. To 
avoid problems with spaces, JDF Input encloses each substituted string in 
double quotes.

NOTE: Note that digital presses have their own script configuration

Output Accounting Report when output is made: Enables JMF reporting of the results that are 
produced.

Edit Cost Types: Click this button to tailor the reporting to your requirements. 
This displays the Cost Types dialog box where you can create, edit or delete a 
number of cost types. These allow you to track the number of plates that are 
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being made, both for keeping the stock inventory up to date and to perform post-
calculations

 Reason Text: A textual short description of the reason for the remake. This is 
what the operator will see.

 Cost Type: Whether the remake has to be charged to the customer or not. 

 Work Type: Why the plate is being remade:

 Original: First output of a plate (included in the order).

 Alteration: Remake because content has changed.

 Rework: Remake of the original plate (no changes in content, 
processing). For example, if the plate was scratched.

Job Finishing Events This section deals with the information that is exchanged between Apogee and 
the MIS system when a job nears its end of life. It specifies when Apogee should 
archive and delete a job, and when Apogee should report that a job is finished.

NOTE: You must respect the logical order of the events and actions.

Report ‘ReturnQueueEntry’ when: Determines when Apogee sends the Return-
QueueEntry (RQE) event, signaling to the MIS that it has completed the job.

 Apogee finishes the job: Send RQE when the job finishes (i.e. when the 
finished marks appear in front of the job).

 Apogee archives the job: Send RQE when Apogee has archived the job - but 
only when the job is finished. Note that this does place any restrictions on the 
event that triggers the archiving process.

 Apogee deletes the job: Send RQE when Apogee has deleted the job. Note 
that this does place any restrictions on the event that triggers the deletion 
process.

 MIS sends PrePress Completed: Send RQE when the MIS sends a PrePress-
Completed event.

 MIS sends Press Completed: Send RQE when MIS sends a PressCompleted 
event.

 MIS sends PostPress Completed: Send RQE when the MIS sends a PostPress-
Completed event.
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 MIS sends Shipping Completed: Send RQE when the MIS sends a Shipping-
Completed event.

 MIS sends Job Completed Successfully: Send RQE when the MIS sends a 
JobCompletedSuccessfully event.

Archive when: Select when to start the archival process:

 Honor job’s ‘Finish’ options: Apogee archives the job according to the respec-
tive options set in the job’s Option tab.

 When MIS sends <...> Completed: Apogee archives the job upon receiving a 
specified milestone event: PrePressCompleted, PressCompleted, PostPress-
Completed, ShippingCompleted, JobCompletedSuccessfully.

Delete when:  Select when to start the deletion process:

 Honor job’s ‘Finish’ options: Apogee deletes the job according to the respec-
tive options set in the job’s Option tab.

 When MIS sends <...> Completed: Apogee deletes the job upon receiving a 
specified Milestone event: PrePressCompleted, PressCompleted, PostPress-
Completed, ShippingCompleted, JobCompletedSuccessfully.

JDF Updating

A number of options control when a JDF job update is granted or denied. These 
options include unnotified acceptance or denial, or notified update.

There are a number of conditions that allow different update policies according 
to the current stage of the job.

As long as Run List is empty The Run List is currently empty. Default is Allow.

As soon as Run List
contains a page

There is at least one page placed, but no output has been made. Default is Allow.

A result, other than main
has been output

The job has produced at least one proof (or any other output other than from the 
main flow). Default is Notify.

A main result has been
output

The job has produced at least one result from a main flow. Default is Deny and 
inform

When job was edited The job was edited by the operator. This is not an actual phase of the job; it is a 
state that the job can be in, regardless of which stage it is in. Default is Allow.
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Apogee determines the stage of a job by inspecting it when receiving a JDF 
update; it does not maintain a history. Internal result states are cleared when a 
result (or job) is reprocessed, or when a page leading to a result is removed from 
the Run List.

The available policies for each of these stages are as follows:

 Allow: Allows the MIS to apply JDF job updates without asking, and without 
informing the operator that there was an update.

 Apply and Inform: Applies all JDF job updates without asking, but posts a 
notification after applying the updates.

 Notify: Posts a notification when a JDF job update needs to be applied. The 
operator can then decide whether to accept or deny the update.

This policy should only be used when the MIS supports asynchronous JMF 
commands. Otherwise, the MIS will fail the update when the operator does 
not immediately answer the notification. 

Apogee returns an error to the MIS upon receiving a synchronous command, 
and posts a notification. The notification states that the update was rejected 
because of a misconfiguration, and suggests you either change the MIS 
protocol settings or use a different update policy. The same message is 
included in the error reply sent to the MIS.

 Deny: Denies the JDF job update without asking, and without informing the 
operator that the update was denied.

 Deny and Inform: Denies the JDF job update without asking, but posts a 
notification informing the operator that the update was denied.

Cogwheel menu

Compare Configuration Compares the JDF Server settings against the default values.

Restore Defaults Restores all settings to their factory defaults.

Disk Storage

The Disk Storage icon is displayed in the Resources pane when you select a 
Hardware or “Satellite” System in the Hardware pane. You can double-click this 
icon to display the Disk Storage settings. This dialog box lists all of the available 
disks or partitions on the selected Hardware System.
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Administrator access level only!

Each Hardware System has a Disk Storage resource, comprising two parts:

 Storage Sets: To configure the Storage Sets

 Disk Monitor: To monitor disk usage

What are Storage Sets?

A storage set is a collection of one or more disks or shared volumes that are kept 
synchronized. When the Apogee System writes a file to a storage set, the file is 
copied to all disks or volumes which belong to that set. This provides system 
redundancy: If any disk or volume in a set fails, the Apogee System notifies you 
and disables the failed disk/volume. This disk/volume will not be used again 
until you enable it. When you do this, the disk is again synchronized with the 
other disks/volumes in the set. Whenever Apogee needs a file, it searches 
through every enabled disk in the set until one returns the required file. 
Normally, the first disk will return the file, so there is very little impact on 
performance.

If you add a disk or volume to a storage set, it is immediately synchronized with 
the other disks/volumes in the set.

Each storage set you define can handle only one of the following data types:

 Temporary data

 System files and resources

 PDF and Postscript files

 Raster files

You can define multiple storage sets to handle the same type of data. This 
increases the total disk capacity, and allows Apogee to alternately write data to 
each of the storage sets in turn (for example, writing C, M, Y, K separations to 
different sets).

Disk Storage Settings

The Disk Storage dialog box comprises two tabs which allow you to configure 
storage sets and monitor disk usage.
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Administrator access level only!

Storage Sets

This tab shows all storage sets, the disks or volumes in each set, and the kind of 
files it can receive. You can add, edit and delete storage sets using the buttons 
below the list (see “To create a new storage set” on page 713).

Storage Set The name of the disk or volume which contains the storage set.

Sys A check mark in this column indicates that the corresponding disk or volume is 
used to store system data only.

Temp A check mark in this column indicates that the corresponding disk or volume is 
used to store temporary or scratch data only.

PDF A check mark in this column indicates that the corresponding disk or volume is 
used to store PDF data only.

Raster A check mark in this column indicates that the corresponding disk or volume is 
used to store raster data only.

New button Click this button to create a new Storage Set, as described in “To create a new 
storage set” on page 713.

Edit button Click this button to access the Storage Set Editor, where you can view or modify 
the setup of the selected storage set.

Delete button Click this button to delete the selected Storage Set. Note that you cannot delete 
a Storage Set unless there is an alternative Storage Set available to take over the 
storage of each type of data held in the Storage Set.

Disk Monitor

This tab monitors the disk usage for all local disks and shared volumes.

Disk or Shared Volume Lists the disks or shared volumes you are using.

Capacity Displays the formatted capacity of the disk. 

Sys A check mark in this column indicates that the corresponding disk or volume is 
used to store system data.

Temp A check mark in this column indicates that the corresponding disk or volume is 
used to store temporary or scratch data.
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PDF A check mark in this column indicates that the corresponding disk or volume is 
used to store PDF data.

Raster A check mark in this column indicates that the corresponding disk or volume is 
used to store raster data.

SQL Indicates on which disk the database is installed.

Amount Used Indicates the amount of disk space (capacity) used by Apogee. For each disk, a 
bar displays the used amount in a solid color. For disks that are used for other 
purposes, the color is slightly faded out.

The bar of the largest disk fills the column width. The other bars are scaled 
proportionally. 

The color of the bar changes when the used amount exceeds a certain limit:

 Green: There is sufficient storage space left.

 Orange: The warning level has been reached.

 Red: The critical level has been exceeded. 

NOTE: The warning and critical levels are shown on the bar by two small 
markers. The first marker is the warning level: the second marker is the critical 
level.

Free The Free column shows the free disk capacity in absolute numbers and 
percentages.

Status Indicates the status of the disk or shared volume.

Edit button Click this button to access the Watermarks Editor, where you can specify free 
disk space warning and critical levels.

Enable button Select a Disk or Shared Volume, and click the Enable button to allow this disk or 
volume to be used by Apogee.

Watermarks Editor

The Watermarks editor allows you to specify free disk space warning and critical 
levels for the selected Disk or Shared Volume.
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Administrator access level only!

Notify when free space is
less than

This is the warning level of the free disk space. The warning level is indicated by 
the first of the two small marks on the Amount Used bar.

Specify the warning level below which Apogee will notify the user and/or 
administrator.

Do not use when free space
is less than

This is the critical level of the free disk space. The critical level is indicated by the 
second of the two small marks on the Amount Used bar (see above).

Specify the critical level below which the Hardware System becomes unusable. 
In that case, Apogee will notify the user and/or administrator.

NOTE: When the free disk space is not sufficient to write the data (especially 
raster files), Apogee will store the data on another Hardware System. The 
performance may suffer, but the processing will at least continue. Apogee will 
notify the user in the event of a switch of Hardware System.

Storage Set Editor

This dialog box allows you to view or modify the setup of the selected storage set. 
You can add and edit storage sets using the buttons below the list (see “To create 
a new storage set” on page 713).

Administrator access level only!

Files to store

Select the necessary check boxes to indicate which data can be stored on the 
disk.

Apogee Prepress system
data and resources

This data is essential to keep Apogee active. The data also includes resources 
such as fonts, halftone screens or calibration curves.

Apogee Prepress
temporary data

Various system components and Task Processors need this data to be able to 
write during their processing tasks.

PDF and Postscript files These are the files generated by the Normalizer and stored in the Page Store.
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Raster files These are the high-resolution raster files that need to be sent to the output 
devices. Generally, you store these files on any Hardware System that hosts the 
Render Task Processor.

CAUTION: Once Apogee has some data stored on the disk, you can no longer clear 
the check box corresponding to this data type. The check box will be activated 
only when there is no longer any Apogee data left on the disk.
If you clear the check box while Apogee is writing to the disk, you will get a 
warning dialog box telling you that the check box has been selected again.

 To create a new storage set

1 From the Disk Storage dialog box, select the Storage Sets tab

Administrator access level only!

2 Double-click a storage set entry, or select it and click the Edit button.

This opens the Storage Set Editor.

You will also see a set of check boxes at the top of the dialog box, and a set of 
buttons at the bottom of the dialog box. 

3 Click the New button. 

A Select Disk dialog box is displayed.

4 Select a local disk or enter a UNC shared volume name, and click OK.

The dialog box is closed. The new storage set appears in the list.

 To edit a storage set

1 From the Disk Storage dialog box, select the Storage Sets tab

Administrator access level only!

2 Double-click a storage set entry, or select it and click the Edit button.

This opens the Storage Set Editor.
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You will also see a set of check boxes at the top of the dialog box, and a set of 
buttons at the bottom of the dialog box. 

3 Select the local disk or shared volume, and click the Edit button. 

A Select Disk dialog box is displayed.

4 Select a different local disk or enter a UNC shared volume name, and click 
OK.

The dialog box is closed. The updated storage set appears in the list.

5 Select the file types you want to store on the storage set by clicking the appro-
priate check boxes.

6 Click Enable, and then click OK.

The Storage Set Editor is closed. Your new settings are displayed in the Disk 
Storage dialog box.

 To delete a storage set

1 From the Disk Storage dialog box, select the Storage Sets tab

Administrator access level only!

2 Double-click a storage set entry, or select it and click the Edit button.

This opens the Storage Set Editor.

You will also see a set of check boxes at the top of the dialog box, and a set of 
buttons at the bottom of the dialog box. 

3 Check that an alternate storage set is available to take over storage of the data 
from the set you are going to delete.

4 Select a storage set, and click the Delete button. 

A confirmation dialog box is displayed.

5 Click OK to confirm deletion.
Apogee Reference Guide



 

11 MONITORING AND CONFIGURING YOUR SYSTEM 715
NOTE: You cannot delete a storage set unless there is an alternate storage set 
available to take over the storage of each type of data.

Configuring Your 
Task Processors

By double-clicking the configuration icon in the Resources pane for each 
selected Task Processor, you can access and edit the Configuration settings. For 
most Task Processors, this is only possible at service level.

Service access level only!

 To work with Configurations

1 From the Apogee Navigation Bar, select System Overview.

2 Select the Task Processor for which you want to access the Configuration.

The Resources associated with the Task Processor appear in the Resources 
pane.

3 Double-click the Configuration icon in the Resources pane.

The Configuration dialog box appears.

4 Select the settings of your choice and/or enter any required information.

5 Click OK to close the Configuration dialog box.

The settings are immediately active.

Managing 
Parameter Sets

Parameter Sets are predefined Task Processor settings that you can use when 
creating a Production Plan in the Ticket Editor. You can access and manage your 
Parameter Sets from the System Overview by selecting a Task Processor, and 
then double-clicking the Parameter Sets icon in the Resources pane.

You can also create or edit Parameter Sets from the Settings pane in the Plan tab. 
For more information, see “Settings Pane (Ticket Editor)” on page 330.

 To create, duplicate, edit, delete, import or export Parameter Sets

Administrator access level only!
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1 From the System Overview, select the Task Processor whose Parameter Sets 
you want to work with.

The Resources associated with the Task Processor appear in the Resources 
pane.

2 Double-click the Parameter Sets icon in the Resources pane.

The Parameter Sets dialog box appears.

At the top of this dialog box, you will see one or more icons. These icons 
represent the operations of the selected Task Processor. For most Task 
Processors, there is a single operation. However, some Task Processors (such 
as Render or any Output Task Processor) have two or more operations. Each 
operation has its own individual Parameter Set(s).

Below this, you will see a list of available Parameter Sets for the selected Task 
Processor operation. Here, you will see at least an “initial” Parameter Set, as 
well as any additional Parameter Sets that may have been created.

You will also see a set of icons at the bottom of the dialog box.

You can use these icons to create, duplicate, edit, set as default, delete, 
import or export Parameter Sets for the selected Task Processor.

To create a new Parameter Set

1 In the Parameter Sets dialog box, select one of the Task Processor opera-
tion icons.

If there is only one operation, then this is selected by default.

2 Click the New button. 

A new untitled dialog box is displayed

3 Enter a unique name for the new Parameter Set, and select your settings.

For detailed information about these settings, refer to the description of 
the selected Task Processor.

4 Click OK to save your settings.

The dialog box is closed. The new Parameter Set appears in the list.
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To duplicate a Parameter Set

1 In the Parameter Sets dialog box, select a Parameter Set and click the 
Duplicate button: 

A copy of the Parameter Set is added to the list. The new Parameter Set 
takes the name of the original Parameter Set, appended with the word 
copy.

To edit a Parameter Set

1 In the Parameter Sets dialog box, select a Parameter Set and double-click 
it or click the Edit button: 

2 Make any changes you require, and click OK to save your settings.

To set a default Parameter Set

1 In the Parameter Sets dialog box, select a Parameter Set from the list and 
click the Default button:

The default Parameter Set is highlighted in bold.

To delete a Parameter Set

1 In the Parameter Sets dialog box, select a Parameter Set from the list and 
Press Delete or click the Delete button: 

2 Click Yes to confirm the deletion.

NOTE: For every Task Processor, there are predefined initial settings. You 
cannot delete these.

To import a Parameter Set

1 In the Parameter Sets dialog box, click the Import button.
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2 Locate the folder which contains the Parameter Set you want to import.

This will be a Parameter Set that was previously exported. This file will be 
in MIME format (*.mime).

3 Click Open.

The imported Parameter Set is displayed in the list.

To export a Parameter Set

You may want to export a Parameter Set for use by another Apogee System, or 
in order to have a temporary backup file.

1 In the Parameter Sets dialog box, select a Parameter Set from the list and 
click the Export button.

2 Locate the folder to which you want to export the Parameter Set, and click 
OK.

The Parameter Set is exported as a MIME format file (*.mime).

Managing 
Resources

For each Task Processor displayed in the System Overview window, you can 
access the associated Resource categories by selecting the Task Processor icon. 
Any Resource categories associated with the selected Task Processor are then 
displayed in the Resources Pane. For information on individual Resources, see 
“Task Processor Resources” on page 939.

 To create, duplicate, edit, delete, import or export Resources

You can manage your Resources in a number of ways. These procedures are 
similar for most Resource categories.

1 From the System Overview window, select (single-click) the Task Processor 
whose Resources you want to work with.

The Resource categories associated with the Task Processor appear in the 
Resources pane.

2 Double-click the Resource category of your choice.

The Resources that are available in this category are displayed in a new 
Resource category dialog box.
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You will also see a set of icons at the bottom of the dialog box.

You can use these icons to create, duplicate, edit, set as default, delete, 
import or export Resources within the selected Resource category.

NOTE: The icons and actions that are available vary from resource to 
resource.

 To create a new Resource

1 In the selected Resource category dialog box, click the New button: 

A new untitled Resource dialog box is displayed

2 Enter a name for the new Resource, and specify the Resource settings.

3 Click OK to save your settings.

The Resource dialog box is closed. The new resource appears in the list of 
Resources in the Resource category dialog box.

 To duplicate a Resource

1 In the selected Resource category dialog box, click the Duplicate button: 

A copy of the Resource is added to the list. The new Resource takes the 
name of the original Resource, appended with the word copy.

 To edit a Resource

1 In the selected Resource category dialog box, select a Resource from the 
list and click the Edit button:

2 Make any changes you require, and click OK to save your settings.

The Resource dialog box is closed.
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 To set a default Resource

1 In the selected Resource category dialog box, select a Resource from the 
list and click the Default button:

The default Resource is highlighted in bold.

 To delete a Resource

1 In the selected Resource category dialog box, select a Resource from the 
list and Press Delete or click the Delete button:

Click Yes to confirm the deletion.

NOTE: You cannot delete the standard system resources.

 To import a new Resource to a Resource category

1 In the selected Resource category dialog box, click the Import from file 
button:

An Open file dialog box is displayed. In the files of type list, the relevant 
file suffix for the type of file you want to import is selected (e.g. *.mime 
for color books).

2 Browse to the location of the Resource you want to import, select the 
Resource file, and click Open.

The Resource is imported, and is displayed in the list of Resources.

If the imported Resource is a “dedicated” Resource (such as a Press 
Profile), you will see the following icon next to the Resource in the list:

NOTE: Dedicated Resources are linked uniquely to a specific device: They 
are not shared between other devices of the same type. Some Resources 
are always shared between similar Task Processors, and others are always 
dedicated.
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 To export a Resource

You may want to export a Resource for use by another Apogee System, or in 
order to have a temporary backup file.

1 In the selected Resource category dialog box, select a Resource from the 
list and click the Export button.

2 Locate the folder to which you want to export the Resource, and click OK.

The Resource is exported as a MIME format file (*.mime).
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CHAPTER
12 Input Task Processors

Input Task Processors act as input channels through which you input your 
documents for processing by Apogee.

When you add an Input Task Processor to your Production Plan, a Keep Results 
action is automatically attached to the Task Processor. For more information, see 
“Keep Result” on page 326.
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 PrintSphere Upload ............................................................................................ 741
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NOTE: Unlike the Processing, Output, and Print Task Processors, no resources are 
associated with the Input Task Processors.
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724 HOT FOLDER
Hot Folder

The Hot Folder Task Processor is an input channel where you can drop the file 
that you want to process. You can input any of the following file types:

 Documents:

 PostScript

 PDF

 Images:

 See “File Types” on page 502

Once the processing starts, the input file is deleted from the Hot Folder.

Each Hot Folder is associated with a unique hot folder root. During installation, 
you will have to specify the location of the hot folder root on the Hardware 
System.

NOTE: When you are creating your Production Plan, a Keep Results action is 
automatically added to the Input Task Processor. For more information, see 
“Keep Result” on page 326.

Hot Folder Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.
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Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Hot Folder

Click the Browse button to locate the Hot Folder in which you want to input your 
document. You can also use variables in this field to automatically create 
subfolders inside the HotFolderRoot (e.g., referring to the name and order 
number of the job).

By default, the following string is already included in this field.

\\$SYSTEMCOMPUTER\HotFolderRoot\$ORDER\

NOTE: Each Hot Folder must have a unique name. The name should use ASCII 
characters, with a minimum of one and a maximum of 31 characters.

Variable button

Click the Variable button to insert variables. A drop-down list appears listing the 
variables that you can insert. For more information on variables, refer to System 
Variables.

Data Format

Defines the expected format of the input files, and allows the Task Processor to 
correctly process it. The valid data formats are:

 PostScript, PDF or bitmap images

 DCS PostScript

 GRS (Page Description Language (PDL) format)

 PPML-VDX (variable data format)
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 PDF-VT (variable and transactional printing format)

 XPS

Polling time

This option defines a polling time for this type of input channel.

Grouping

This option defines how single input files will be treated.

Always create new job Apogee treats every input file as a single job.

Add to existing job if found Input files with a specific filename are grouped into a single job. You can set up 
a filename template to specify what parts of the filename are taken into account, 
as described below.

Close job’s document input
when nothing received for

<n> seconds

This option tells Apogee to automatically close document input for the resulting 
job after a specified period of time during which no documents were received. 
This allows the job to finish when all processing is completed. 

NOTE: You can also close the document input manually. 

Flats/Pages

If a Hot Ticket has no Imposition Task Processor, then to support duplex 
proofing and proper InkDrive generation, Apogee needs to be told the type of 
input it is receiving.

Input represents This section determines whether the input represents pages or flats. The choice 
not only sets the display mode of the Results tab and defines the terminology of 
message and log events, but it also influences the other format-dependent 
options.

Pages: 'Apogee treats every page in the input file as a page in the publication. 
This usually means they need to be imposed before printing.

When you select ‘Pages’, nothing extra is done, and the remainder of the section 
is disabled.

Flats: 'Apogee treats every page in the input file as a flat (single side of a sheet). 
Usually, they need no further imposition.

Workstyle: These options are only enabled if you select Flats. You can then 
choose the orientation of the two sides of the sheet.
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 Sheetwise: A sheet has different content on front and back sides. The sheets 
are turned, keeping the gripper edge at the same side.

 Work And Turn: Both sides have the same content. The sheets are turned, 
keeping the gripper edge at the same side.

 Work And Tumble: Both sides have the same content. Sheets are turned in 
such a way that the gripper edge is on the opposite side.

 Perfecting: A sheet has different content on front and back sides. Sheets are 
turned in such a way that the gripper edge is on the opposite side.

 Single Sided: There is only one side per sheet.

 From filename: Extracts the workstyle from the filename (or directory struc-
ture). The filename template must contain <WORKSTYLE>.

Sides: These options are only enabled if you select Flats. You can then choose:

 Alternate Front/Back: Every new input file is assigned the 'next flat': 1F, 1B, 
2F, 2B, etc. The filename template cannot contain <SIGNATURE> or 
<SIDE>.

 From filename: Extracts the flat identifier from the filename (or directory 
structure). The filename template must contain both <SIGNATURE> and 
<SIDE>.

Filename Conventions

Filename template This option allows you to retrieve the job name, order number and imposition 
details from the filename of the document. To do this, you need to use the 
relevant variables, variable separators and wild cards to compose the filename 
template.

The first set of variables retrieves the order number <ORDER> and job name 
<JOB>, respectively. If you omit the order number or job name from the file 
name template, Apogee will use the Hot Ticket name or document file name, 
respectively. The default file name template is <JOB>.

The second set of variables retrieves the imposition work style <WORKSTYLE> 
and signature information <SIGNATURE> and <SIDE>.

Filename conventions for
<WORKSTYLE>

This field is only displayed when you select ‘From filename’ for Workstyle. Here, 
you can define which strings should be recognized as the Workstyle type. 
Apogee tries to match the position of <WORKSTYLE> in the filename template 
with any of the specified strings, and identifies the input as the associated 
workstyle when it matches a string. 
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Filename conventions for
<SIDE>

This field is only displayed when you select ‘From filename’ for Side. Here, you 
define which strings in the filename define the side (front or back). You can 
enter multiple strings, separated by commas, for each side. Apogee tries to 
match the position of <SIDE> in the filename template with any of the specified 
strings, and identifies the input as font or back when it matches a string. If there 
is no match, Apogee treats the input as a front. 

NOTE: These fields are completely ignored if the filename template does not 
contain <SIDE>.

Created Job

Job’s Hot Folder Here you can specify a different location for the hot folder when the job is 
created than the default $ORDER_$JOB. See for an explanation of the variables 
you can use to specify this folder. Select the Enable Job’s Hot Folder to enable 
this input channel for the job.

Backup

Select this check box to have a backup file of every incoming file copied to the 
specified folder. The directory structure in hot folder is replicated to this backup 
folder. If a file with the same name already exists, a suffix is added. The user 
must manage this backup folder.

PDF Certify Check

Verify Certification If you select this check box, you can choose a Preflight profile against which you 
can certify the incoming PDF. Apogee flags all failed PDF files with a notification, 
and you will see the failed certification icon in the Run List. 

NOTE: Postscript files always fail certification.

This option is only enabled for Postscript, PDF or bitmap.

Web

This panel is for creating so-called WebApproval jobs that allow remote users to 
upload files and/or approve the pages of the job.

Web Enabled Select this check box so users can work remotely using the WebApproval service.
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JDF Import

The JDF Import Task Processor is an input channel hot folder where you can 
drop a JDF file that you want to process. 

NOTE: Apogee also supports 
JMF (JDF Message 
Framework).

When the JDF Input Task Processor finds a JDF file (or MIME file containing a 
JDF part), it creates a job. The content files for the created job are referenced by 
the JDF. The JDF Input Task Processor ignores PostScript or PDF files in its Hot 
Folder (unless they are referenced by the JDF).

The Production Plan of the created job will be specified by the incoming JDF file. 
You should therefore leave the Hot Ticket's Production Plan empty, except for 
the JDF Import Task Processor. 

NOTE: When you are creating your Production Plan, a Keep Results action is 
automatically added to the Input Task Processor. For more information, see 
“Keep Result” on page 326.

JDF Import Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
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from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Hot Folder

Click the Browse button to locate the Hot Folder in which you want to input your 
job content. You can also use variables in this field to automatically create 
subfolders inside the HotFolderRoot (e.g., referring to the name and order 
number of the job).

By default, the following string is already included in this field (for the JDF 
Import Task Processor):

\\$SYSTEMCOMPUTER\JDFImportRoot\$ORDER\

For more information on variables, refer to System Variables.

Pre-process

This option allows you to pre-process every file found in the Hot Folder before it 
is handled by the JDF Import Task Processor. Pre-processing input files is mainly 
used to ‘fix’ JDF files, and helps to integrate JDF products from different vendors.

Run script on input

Specify the full path to the script you wish to execute. At runtime, the script is 
started with two or more arguments.

Optional arguments

Enter optional runtime arguments. Separate multiple arguments with spaces. If 
you need to specify an argument with a space in it, you must enclose that 
argument in single or double quotes, or you need to replace the space with a 
backslash. You can use Apogee variables as arguments. The JDF Import Task 
Processor substitutes each variable before passing it to the script. To avoid 
problems with spaces, JDF Import encloses each substituted string in double 
quotes.

ApoXML

This option allows you to pre-process the files using APOXML (XML-based data 
format) script for the JDF Import. XML transform will convert APOXML to JDF 
intent.

ApoCSV

You can pre-process the files using APOCSV conversion for the JDF import, when 
XML export is not possible. Comma-separated values (CSV) is a text file format 
that uses commas, semi-colons, or tabs to separate values and new lines.
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StoreFrontExport

This option allows you to export data related to the StoreFront application. A 
data file is generated for each ordered item.

Script can access console
or tracing window

If this option is selected, a console window is created each time a script is 
executed. The script tracing is displayed in the console window.

Content files

Remove content files on
external servers

This option determines whether or not Apogee removes externally referenced 
content files, and is deselected by default. This option only applies to files 
located in a Public Page Store or on a disk that is not being watched by a Hot 
Folder. It does not apply to files located on a WebServer or in a Hot Folder, Files 
in a Hot Folder are always removed when they are moved into a job: Files refer-
enced by other methods are never removed.

Order number and job name

 Set by JDF

 Use Hot Ticket name and document’s filename

Job’s Hot Folder

This field is only enabled when the ‘Enable Job’s Hot Folder’ check box is 
selected. Click the Browse button to locate the Hot Folder you want to use. You 
can also use variables in this field to automatically create a subfolder inside the 
HotFolderRoot. For example:

\\$SYSTEMCOMPUTER\HotFolderRoot\$TICKETNAME\

Enable Job’s Hot Folder

Apogee always inserts a Hot Folder in the created job's plan, allowing you to add 
additional content files or revisions. You can enable it by selecting the 'Enable 
Hotfolder' option. This is identical to the PS/PDF Hot Folder option.

Web Enable Hot Folder

This option, when selected, enables allows you to create WebApproval jobs that 
allow remote users to upload files and/or approve the pages of the job. 

NOTE: This option requires a special license.
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Pre-process Documents

These settings are only used if the incoming JDF contains a PrePressPreparation 
graybox (regardless of the preprocess document settings in the JDF Import 
channel). They define how Apogee expands the JDF PrePressPreparation 
graybox. 

Normalize Normalizes each incoming document (using the selected parameter set).

Preflight Choose the position to always add the Preflighter (before or after the Run List) 
and the type (Apogee Preflight or Preflight), and select a parameter set from the 
respective drop-down lists. If you choose after the Run List you can also add a 
second Preflighter after the Run List, again using the selected parameter set.
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Named Pipe

This is the standard input channel for Windows-based workstations. Through 
the Windows server, Named Pipe allows you to send jobs to the Windows 
spooler from either a Windows or a Macintosh front-end system. The spooler 
temporarily saves the data in order to release your front-end workstation for 
other activities.

NOTE: When you are creating your Production Plan, a Keep Results action is 
automatically added to the Input Task Processor. For more information, see 
“Keep Result” on page 326.

Named Pipe Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Pipe Name

Type the name of the Pipe that you want to use. By default, the $TICKETNAME 
variable is already included in this field.

Variable button

Click the Variable button to insert variables. A drop-down list appears listing the 
variables that you can insert. For more information on variables, refer to 
“System Variables” on page 1183.

Spooled Printing

Enable or disable spooled printing. The spooler temporarily saves the input data 
to disk to release the front-end workstation. By default, this option is not 
selected.

NOTE: The Spooled Printing option is only available when there is no Keep 
Results action on the Named Pipe component in the Production Plan.

Honor Apogee Prepress Hot Ticket PPD Settings

When this option is selected, Apogee will use the parameter set that is specified 
in the PPD section of the incoming document. This option is only for Hot Tickets.
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Open Connect

The Open Connect Task Processor is a specific type of Hot Folder input channel 
which you can use to input raster data (TIFF) and DCS files. Open Connect 
recognizes different workflows, and the different file conventions of TIFF and 
Raster files that are input, and processes them accordingly. 

Depending on the workflow, an input file might be a single separation, it might 
contain all separations, or it could be a composite file. It might represent a page 
(to be imposed), or a single side of a flat. The type of file may be indicated in the 
filename. Open Connect can interpret information contained in the filename in 
order to determine how the file should be processed. Once this processing starts, 
the input file is deleted from the Hot Folder.

Each Hot Folder is associated with a unique Hot Folder root. During installation, 
you need to specify the location of the Hot Folder root on the Hardware System.

NOTE: When you are creating your Production Plan, a Keep Results action is 
automatically added to the Input Task Processor. For more information, see 
“Keep Result” on page 326.

Open Connect Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Most Open Connect settings describe the structure and the meaning of the input 
files. Consequently, a single instance of an Open Connect Hot Folder in a plan 
can accept files from a single workflow only.
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Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Hot Folder

This option is identical to that of the Hot Folder Task Processor: It allows you to 
enter or select a Hot Folder name.

Data Format

Defines the expected format of the input files, and allows the Task Processor to 
correctly process it. Note that the available formats depend on the license. 
Formats that require an extra license are shown in italics:

 TIFF: 1-bit or 8-bit TIFF; RGB, CMYK or Grey color space; Pre-separated or 
composite 1 -bit, 8-bit DCS DCS-1 (multiple file) and DCS-2 (single/multiple 
file) (1-bit).

 Barco TIFF: Barco TIFF (1-bit)

 Harlequin TIFF: Harlequin TIFF (1-bit)

 PrintDrive Backup Data: PrintDrive Backup Data raster files with software 
compression (1-bit).

 Agfa PDFRIP TIFF: TIFF files created by the PDF RIP

 Plate Assembler TIFF: TIFF files as input for a Plate Assembler job (1-bit).

Polling time

Defines a polling time for this input channel.

Combining Files

Deliver combined files after
receiving nothing for <n>

seconds

Defines the amount of time (in seconds) that Apogee will wait for the next file, 
after receiving a file. After this period has expired, Apogee treats the group of 
previously received files as complete, and delivers them as a group. This feature 
is used to group separations into pages (or flats), and to group pages (or flats) 
into a job.
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Automatically close job’s
document input after last

page

If you select this option, Apogee closes document input for the receiving job. This 
allows the job to finish properly.

Tag Input

By default Apogee uses and interprets the file tags (this option is deselected). 
However, if you select the Tag Input check box, you can ‘tag’ the input by telling 
the system how the input should be treated. Basically, these Tag settings are a 
limited set of the Image settings from an Output Task Processor.

Reading Right/Wrong

Polarity Positive/Negative

Rotate 0, 90, 180, 270

Flats/Pages

This section determines whether the input represents pages or flats. The choice 
not only sets the display mode of the Results tab and defines the terminology of 
message and log events, but it also influences the other format-dependent 
options.

Input represents Pages:  Each input file (or set of files) is a single page. The Production Plan can 
have a Run List and an Imposition Task Processor to assemble the pages into 
flats. The pages can be placed in the Run List manually or automatically.

Flats: Each input file (or set of files) is a side of a flat. The Production Plan should 
not have a Run List or Imposition Task Processor, although it is not forbidden. 
The results tab displays flats. Note that you cannot select the pages on the flats.

Workstyle: These options are only enabled if you select Flats. You can then 
choose the orientation of the two sides of the sheet.

 Sheetwise: A sheet has different content on front and back sides. The sheets 
are turned, keeping the gripper edge at the same side.

 Work And Turn: Both sides have the same content. The sheets are turned, 
keeping the gripper edge at the same side.

 Work And Tumble: Both sides have the same content. Sheets are turned in 
such a way that the gripper edge is on the opposite side.

 Perfecting: A sheet has different content on front and back sides. Sheets are 
turned in such a way that the gripper edge is on the opposite side.

 Single Sided: There is only one side per sheet.
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 From filename: Extracts the workstyle from the filename (or directory struc-
ture). The filename template must contain <WORKSTYLE>.

Filename Conventions

Use Script Select this check box to execute scripts (e.g. for file renaming). The text field 
indicates the location of the selected script. Use the Browse button to select your 
script.

Filename template Describes the folder structure and the file name conventions that are expected. 
The list offers a number of presets which may vary, depending on the selected 
format. For example:

 <JOB>

 <JOB>\<DOCPAGE>\<SEPARATION>

 <JOB>\<SIGNATURE>\<SIDE>\<SEPARATION>

 <JOB>\<SIGNATURE>\<WEB>\<SIDE>\<SEPARATION>

 <JOB>\<WORKSTYLE>\<SIGNATURE>\<WEB>\<SIDE>\<SEPARATI
ON>

 <JOB>\<PRODUCTNAME>\<CUT>\<SEPARATION>

Filename convention
strings

Filename conventions for <SIDE>: These fields define which strings in the 
filename define the side (front or back). You can enter multiple strings, 
separated by commas, for each side. Apogee tries to match the position of 
<SIDE> in the filename template with any of the specified strings, and identi-
fies the input as front or back when it matches a string. If there is no match, 
Apogee treats the input as a front. 

NOTE: These fields are completely ignored if the filename template does not 
contain <SIDE>.

Filename conventions for <SEPARATION>: These fields define which strings 
should be recognized as process colors. Apogee tries to match the position of 
<SEPARATION> in the filename template with any of the specified strings, and 
identifies the input as the associated process color when it matches a string. If 
there is no match, Apogee assumes it is a spot color. 

NOTE: All string matches, for both <SIDE> and <SEPARATION>, are case 
insensitive.
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Filename conventions for <CUT>: These fields define which strings should be 
recognized as contour files and masks. Apogee tries to match the position of 
<CUT> in the filename template with any of the specified strings, and identifies 
the input as the associated when it matches a string. When it matches any of the 
contour strings, the file is used as a contour; when it matches any of the mask 
strings, the file is used as a mask.

Recombine mode This option is only displayed when you select the Harlequin TIFF Data Format 
(see above).

1-C, 1-M, 1-Y, 1-K...  Recombine mode is ON (check box selected). Each TIFF file 
is named according to the following file naming convention:

(page_number)(job_name)(color).tif’

For example, ‘2MyJobM00.tif’ means the Magenta Separation of Page 2 of 
“MyJob”.

1-C, 2-M, 3-Y, 4-K... Recombine mode is OFF (check box selected). Each TIFF file 
is named according to the following file naming convention:

(separation_number)(job_name)(color).tif’

For example, ‘2MyJobM00.tif’ means the second sequential separation of 
“MyJob” whose color is Magenta.

When the Force recombine option is selected (default) recombination of files 
will take place and rely on the dragging order. 

Separations (combining and delivering)

This section is only required for input formats that deliver separations as 
separate files. It describes when Apogee considers all separations of a page or 
flat to be available at the input, and consequently, when it can deliver this page 
or flat to the resulting job (where it appears in the Page Store).

This is important especially when the page or flat has to be proofed; it is not 
important when they only have to be printed on an imagesetter or platesetter: 
the different separations can be printed independently. 

NOTE: This is independent of the ‘Collect for output’ action.

The client will correctly show all separations of a page or flat, regardless of the 
order of input. However, a proof cannot be made until all separations are 
present. Also, when the Open Connect has to deliver PDF, it needs to know the 
separations for each page or flat.
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Open Connect will combine and deliver separations after the specified 
combining time has elapsed, or when receiving:

First separation of next
flat/page

The current page is considered to be complete when an input file is found that 
contains a separation for a different page or flat (as indicated by its file name). 
This option is displayed when you select the TIFF Data Format (see above).

<n> separations of the
same flat/page

The current page is considered to be complete when the specified number of 
separations are available. This option is displayed when you select the TIFF Data 
Format (see above).
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PrintSphere Upload
 

The PrintSphere Upload Task Processor is required as an input channel to create 
a PrintSphere job. This input channel works similar to a regular Hot Folder but 
it is provided as part of the PrintSphere service. PrintSphere is a cloud service 
hosted by ECO3 that allows easy file transfer between the different collaborators 
of a job: customers, designers, remote sites, etc. You can invite uploaders to 
upload files for a specific job or assign PrintSphere collaborators to companies. 
Refer to the PrintSphere Help and technical documentation for more 
information.

In order to use this channel, the following is necessary:

 A remote user must have a PrintSphere Account, and the account should be 
enabled (and not expired). 

 The PrintSphere Upload Task Processor must be included in the Production 
Plan.

PrintSphere 
Settings

See “Hot Folder Settings” on page 724. The User Folder field is the folder where 
files uploaded by the PrintSphere user are input. The Resolved field specifies the 
absolute location of this folder.
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TCP/IP
 

TCP/IP stands for Transmission Control Protocol/Internet Protocol. It is a 
communications language that is used to enable different computers to 
exchange data over a network. The TCP/IP Task Processor acts as the TCP/IP 
input channel.

A typical example would be someone inputting a document over a third party 
OPI server.

NOTE: When you are creating your Production Plan, a Keep Results action is 
automatically added to the Input Task Processor. For more information, see 
“Keep Result” on page 326.

TCP/IP Settings

 

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
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from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Port Number

Type a unique Port number that you want to use for the TCPIP input channel. 
Choose from a range between 1024 and 65535. Use only an even port number 
(e.g. 4000, 4002, 4004), not an odd one. This is because odd port numbers are 
used to return data. By default, Port 4000 is used.

Spooled Printing

Enable or disable spooled printing. The spooler temporarily saves the input data 
to disk to release the front-end workstation. By default, this option is not 
selected.

NOTE: The Spooled Printing option is only available when there is no Keep 
Results action on the TCP/IP component in the Production Plan.

Honor Apogee Prepress Hot Ticket PPD Settings

When this option is selected, Apogee will use the parameter set that is specified 
in the PPD section of the incoming document. This option is only for Hot Tickets.
Apogee Reference Guide



744 TCP/IP
Apogee Reference Guide



CHAPTER
13 Processing Task 
Processors

Processing Task Processors execute tasks on incoming documents, such as 
imposition, preflight, normalization, rendering, separation and trapping.

 Apogee Preflight ................................................................................................. 746
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 Digital Film Proof ................................................................................................ 757
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 Preflight .................................................................................................................. 805
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 Preview Generator .............................................................................................. 808
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 Raster Normalize ................................................................................................. 811
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 Using a Run List in a Hot Ticket ............................................................ 812

 Thumbnail Extractor ........................................................................................... 823
 TIFF Render ............................................................................................................ 824
 Versioning .............................................................................................................. 828

NOTE: A number of System Resources are associated with some of these Task 
Processors. For more information, see “Task Processor Resources” on page 939.
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Apogee Preflight

Apogee Preflight is a proprietary preflighting engine developed by ECO3 
Graphics. The Apogee Preflight Task Processor checks incoming PDFs against 
criteria called Action Lists and notifies the users in the event of issues. A series of 
action lists are provided by default and some action lists can be duplicated and 
customized. Extensive messaging and reporting are also provided as part of 
Apogee Preflight.

Associated Resources

When you select the Apogee Preflight Task Processor in the System Overview, 
the following associated resource categories are displayed in the Resources 
pane:

 Apogee Preflight Action Lists

 Apogee Preflight Profiles

 Fonts

 SISR Profiles

 Content Profiles

 Device Link Profiles

 Profile Link Exceptions

 Profiles

 Input Color Conversions

 Output Color Conversions

 InkTune Sets

 SolidTune Sets
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Apogee Preflight Settings

When you input PDF files, they are saved in the Page Store. To be sure that the 
PDFs do not generate errors when they are output, you can run an optional 
Apogee Preflight check.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Action Lists

The preflight process allows you to automatically edit the PDF, flag issues or 
perform color management tagging based on a set of rules, called Action Lists.

Category In this list you can select the action lists by category. The column on the right 
indicates how many action lists are selected out of the total number of available 
action list.

Job Type The Job Type list is used in combination with Category and State lists to filter 
action lists displayed in the Action List pane. You have 3 options:

 Any: displays all actions of the selected category for all job types

 Wide Format Jobs: displays actions of the selected category only for the Wide 
Format Jobs.

 Other Jobs: displays actions of the selected category for other job types 
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State The State list is used in combination with Category and Job Type lists to filter 
action lists displayed in the Action List pane. You have 3 options:

 Any: displays all actions of the selected category

 On: displays the active actions in the selected category and job type

 Off: displays actions which are not active in the selected category and job 
type.

Action List The Action List pane displays the action lists as selected in the Category, Job 
Type, and State lists. Each action list name has a short description to clarify the 
checking criteria. To activate or deactivate specific preflight checks, select or 
clear one or more of the available Action List check boxes.

You can filter the list of action lists by typing keywords in the Search box at the 
top of the list.

The categories and action lists are managed in the Apogee Preflight Action Lists 
resource. For more information, see “Apogee Preflight Action Lists Overview” on 
page 943.

Job Profile

Select one of the built-in profiles from the drop-down list. Job profiles provide 
information about the job and these criteria are used to fine-tune the preflight 
check. A short description of what the profile does is displayed when you choose 
a profile in the list. For example, choose ‘Soft Proof on Content’ and you will see 
the short description ‘Optimizes the PDF document for content printing’.

Clicking Manage Profiles at the end of the list opens the Apogee Preflight Profiles 
resource where you can see more information about the different job profiles. 
See “Apogee Preflight Profiles” on page 947.

Errors and Notifications

Here you can choose to trigger notifications if an Apogee Preflight warning or 
error is generated and/or a fix is applied by Apogee Preflight.

When Preflight has
warnings

Select this option to receive a notification when a warning is generated.

When Preflight applies
fixes

Select this option to receive a notification when a fix is applied.

When Preflight has errors You have two options in the drop-down list:

 Warn (processing continues)
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 Fail result (processing stops)

Report to WebApproval

Select this option to have a Preflight Report sent to the Customer via Remarks in 
the WebApproval application.

Refuse document place-
ment when Preflight has

errors

If you want jobs with errors and/or warnings to be refused, select one of the 
options in the drop-down list.

Automatically reject pages
with Preflight errors

Select this option if you want a page with errors to be rejected automatically.
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Automate

Automate uses conditions, variables and scripts to automate the processing of a 
job. For example in a multi-flow job, to direct certain pages of a document to a 
dedicated flow in the Production Plan.

Associated Resources

When you select the Automate Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Apogee Preflight Action Lists

 Apogee Preflight Profiles

 Automate variables

 Extend Scripts

 XSLT Conversions

NOTE: The Automate TP cannot be used after an Impose TP or after a Render TP.

Automate Settings

Automate uses a series of if/then conditions (cases) to test and direct a page, 
document or job to the next action, to output or to continue the case. When you 
create a new Automate parameter set from scratch, the list of cases on the left is 
empty and you will click the Add button to add one or more cases to the list. Then 
you can specify the conditions for each case in the two panels on the right.

Test and direct

Here you choose whether you want the condition to apply to a page, a document 
or the job. This parameter is set for all the cases in the list and must also be 
supported by the position of this TP in the Plan. 
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Cases

The cases panel on the left lists the series of conditions that are executed consec-
utively according to the list. You can add, duplicate, delete and change the order 
of cases in the list. Select the Submit notification with test results if you want 
to track the cases and be notified if a case fails.

If

In the If panel on the right you can set one or more criteria for the case. First 
specify how strict the condition for the case is:

 When all criteria are met

 When some criteria are met

 When no criteria are met

Then add your criteria to the list by clicking the Add button. You can duplicate, 
delete and change the order of criteria in the list.

Variable Click in the cell to see a list of all the available variables and choose a variable. 
Start typing in the cell to search for a particular variable. The variables you see 
here come from various sources that you can set up.

Test Click in this cell to see the Test criteria (e.g. equals, does not equal) and choose 
one. The criteria depend on the selected variable. A test can also be a regular 
expression.

Value Click in this cell to see the Value to be met by the criteria (e.g. Error, OK, 
Warning) and choose one. The criteria depend on the selected test.

Then

In the Then panel on the right you specify the action to be followed if the criteria 
are met:

 Send to output: sends the result being tested to the output specified in the 
drop-down list; the output is a flow in your Production Plan
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 Fail: stops the testing and generates an error

 Continue with case: continues testing with the case specified in the drop-
down list

 Continue with the next: continues testing with the next case in the list

The respective icons appear in the Cases list.
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Conditional

The Conditional Task Processor allows you to automatically process PDF files 
differently based on:

 The result of an Enfocus PitStop Preflight Action: 

There are 4 types of Preflight Actions: Selections, Changes, Checks and 
Informs. The Preflight Action that you can use with the Conditional Task 
Processor must be a Check Action type. A Check Action type can generate a 
warning or error report. The Conditional Task Processor will decide which 
flow should continue processing a document based on the created Preflight 
Action Report.

 The result of an Enfocus PitStop Preflight Profile:

A Preflight Profile can generate a warning or an error report. The Conditional 
Task Processor will decide which flow has to continue processing a document 
based on the created Preflight Profile Report.

NOTE: The Conditional Task Processor will not actually perform the fixes 
indicated in the Preflight Profile.

Associated Resources

When you select the Conditional Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Preflight Profiles

 Preflight Action Lists

Conditional Decision Settings

This dialog box allows you to configure the Conditional settings.
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You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Test

Pattern Match The Conditional Task Processor will process PDF files based on the result of the 
specified patterns.

Preflight Action The Conditional Task Processor will process PDF files based on the result of the 
specified Enfocus PitStop Preflight Action.

Preflight Profile The Conditional Task Processor will process PDF files based on the result of the 
specified Enfocus PitStop Preflight Profile.

Direct

You have two options:

Entire document The condition is applicable for all the pages of the document. If one of the pages 
does not match the condition, the complete document will fail.

Individual pages The condition is applied on a page-by-page basis. Only the pages of the 
document that do not match the condition will fail, the other pages of the 
document will pass. This setting will process slower.
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Send to top when

The content of this field depends on your Test selection (see above). You may 
have selected Pattern Match, Preflight Actions or Preflight Profiles. This option 
determines how the Conditional Task Processor combines the outcome of the 
individual tests. You have the following options:

 All tests pass

 All tests fail

 At least one test passes

 At least one test fails

Pattern match

Pass when If you have selected Pattern match, you have two options:

 At least one pattern matches: The documents or pages are sent to the upper 
flow when at least one pattern matches.

 All patterns match: The documents or pages are sent to the upper flow when 
all patterns match.

Match This field defines the text to match, expressed in the form of a variable or a 
combination of fixed text and one or more variables. The default value is 
$DOCUMENTBASENAME.

Patterns The field is a multi-line text field where you enter the patterns to match, one 
pattern per line. You can use the usual text-editing methods to enter and edit the 
patterns.

Try This text field allows you to test the patterns against any arbitrary string you type 
in.

Preflight Action

Pass when If you have selected Preflight Action, you have three options:

 No actions fail: The documents or pages are sent to the upper flow when the 
test condition succeeds.

 Any action fails: The document or pages are sent to the upper flow when at 
least one of the selected actions fails the condition.
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 All actions fail: The document or pages are sent to the upper flow only when 
all the selected actions fail the condition.

Actions Select the actions you want to test.

Preflight Profiles

Pass when If you have selected a Preflight Profile from the drop-down list, you have four 
options:

 has no errors

 has no errors or warnings

 has errors

 has errors or warnings
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Digital Film Proof

The Digital Film Proof Task Processor prepares 'Digital Film' (raster data) for 
proofing. This Task Processor accepts raster data, performs screening and Dot 
for Dot proofing, and outputs the results to a proofer.

Digital Film Proof can be installed on a separate hardware system, and can be 
used to take over the screening role of the Render Task Processor, thereby 
balancing the workload.

No resources are associated with a Digital Film Proof Task Processor.

Digital Film Proof Screen Proofer Settings

This dialog box allows you to configure the Digital Film Proof settings.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Dot for Dot

The Digital Film Proof Task Processor may have an additional option: “Dot for 
Dot” proofing (requires a license). Select this check box if you want to produce 
better quality proofs.

Dot for Dot proofing simulates the dots on the proof as they would appear on the 
press. Consequently, you can only use Dot for Dot when the Digital Film Proofer 
shares the Render Task Processor with a high resolution CTF/CTP output 
devices (i.e. when it receives high-resolution raster data). 

Digital Overlay

Select this check box to print the separations separately (instead of printing the 
composite color results), or to make arbitrary combinations. Deselect Digital 
Overlay to print all separations combined on a single sheet (this is the default 
setting).

All separately Prints all plates on different sheets.

Process colors separately,
all spot colors combined

Prints all process colors on separate sheets, and combines all spot colors on an 
extra sheet.

Process colors combined,
all spot colors separately

Combines all process colors on an extra sheet, prints all spot colors on separate 
sheets.

Print in color Print each sheet using the corresponding color. Deselect to print all in Black.

NOTE: Combined spot colors are always printed in color.

Clip to Press Sheet

Select this check box to remove plate and press borders from the Main flow for 
the Proofing flow.

NOTE: This option is only available when the Digital Film Proof used high-
resolution data from the Main flow.
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Impose

The Impose Task Processors allow you to predefine the final layout of the job. 
Apogee offers you a series of ready-made imposition templates, or you can 
design your own template.

There are two types of Impose Task Processors:

 Impose

 Raster Impose

The Impose Task Processor is used for PDF job assembly. The Raster Impose is 
used for raster job assembly.

Associated Resources

 Mark Engraver

 Folding Schemes

 Pagination Schemes

 Web Production Schemes

 Press Sheet Layout Rules

 Shingling Rules

 Bottling Rules

 Binding Options

 Auto Impose Rules

 Auto Fit Rules

 Margins

 Glue Zones

 Marks
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 Sheet Layout Templates

 Slow Down Wheels

 Number-up Schemes

Impose Settings

This dialog box allows you to specify how imposition will be applied in the 
currently selected Parameter Set. This is also where you can select the Apogee 
Impose module to perform your imposition.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Imposition Selection 

Undefined: Allows you to defer the selection of an imposition layout, and still 
submit a job.

From input: Select this option if you want to import an entire JDF file, more 
precisely the pages and the imposition data. The rest of the imposition settings 
are not required and are therefore not displayed. This mode is only available 
when you process JFD files as input (i.e. when you have a JDF Input Task 
Processor). This option should be disabled when you do not have a JDF Input 
Task Processor. With From input, Apogee uses the layout information (including 
marks) from the incoming JDF file.
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From file:  Select this option if you want to import only the imposition data from 
an external Apogee layout file (PJTF, JT, or JDF). This selection will activate a 
File Selection pane and a Sheet Adjustment pane. In the File Selection pane, you 
locate the file that you want to import with the Browse button. In the Sheet 
Adjustment pane, only the Press sheet scaling option is activated. See “Sheet 
Adjustment” below for more information on this option.

From template:  Select this option if you have installed Imposition Template 
Manager with Apogee. In this case, the Signature Selection panel is enabled, and 
your imposition settings will be taken from the selected imposition template.

Apogee Impose: Select this option if you want to use the integrated Apogee 
Impose module to create the imposition for a job. See “Working with Apogee 
Impose” on page 369 for more information. For Hot Tickets, the Run Auto 
Impose check box can be selected to ensure jobs created from the Hot Ticket are 
imposed using the Auto Impose settings.

Create backgrounds only This check box is only visible if you have a DQS license. It is hidden if you have 
no license. This option is used in parallel with your PrintDrive mode of opera-
tion: It should be checked when you select DQS PrintDrive mode, or cleared 
when you select Normal PrintDrive mode.

Border

If you have a JDF Stripping license, Apogee allows you to select an imposition 
border, which can place various marks around each page, section or sheet. 
Borders are only supported for JDF input.

NOTE: This panel is displayed only when you choose ‘From input’ as your 
Imposition selection. 

File Selection

Locate the PJTF, JT or JDF file that you want to import with the Browse button. 
Apogee will use the selected file to do the imposition. The Results tab shows the 
flat mockup. Apogee only uses the layout description and marks from a JDF file. 
If the file contains placed pages, they will be ignored (if you need the content 
from a JDF file, you should use the dedicated JDF input Task Processor).

This allows you to make Press sheet scaling and bottling adjustments (horizontal 
and/or vertical scaling percentages), in order to scale your output if your press 
sheet is too large or too small.
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NOTE: This panel is displayed only when you choose ‘From file’ as your 
Imposition selection. 

Signature Selection

This panel is displayed only when you choose ‘From template’ as your Imposition 
selection. The imposition settings will be taken from the selected imposition 
template. These settings are referred to as “signatures”. You can select signa-
tures automatically or manually:

Automatically from
<template>

Select this button if you want to select a template from the Available signatures 
panel, select a template and choose Auto Select. Apogee will automatically 
select the signatures from that template to cover the number of pages. The 
selected template is displayed in bold in the Available Signatures column.

NOTE: If you change the number of pages, the imposition Task Processor will 
have to rebuild the list of selected signatures. The list remains empty as long as 
the number of pages is unknown.

Manually Select this button if you want to select the signature manually. You can select the 
required signature in the Available Signatures column and drag and drop it in 
the Selected Signatures column. You can also use the Add button.

Binding Style Select the appropriate binding style from the drop-down list. The list of Avail-
able Signatures will be filtered accordingly.

Refresh All If you change the templates in the imposition template folders, the list of Avail-
able Signatures is not dynamically updated. You therefore need to click the 
Refresh All button to update the list for the selected Binding style.

NOTE: Since a refresh may take some time, Apogee displays the animated 
“chasing arrows” busy indicator next to the button.

Available Signatures Displays a hierarchical list of template folders, filtered according to the selected 
binding style. Each folder may contain one or more subfolders containing at 
least one template with the selected binding style. You can expand these folders 
to select templates and signatures contained within these templates. 
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You can drag and drop the required signatures from the Available Signatures 
column to the Selected Signatures column if you selected the Manual option. 
You can also select the signatures and click the Add button.

When you select a signature in either the Available Signatures or Selected Signa-
tures columns, information about the Press Sheet and signature size is displayed 
below the list of signatures.

Selected Signatures Displays (in the table on the right) the signatures you have selected.

Multiple sections: The Pages column on the right displays multiple page counts 
for signatures that have multiple sections. When you add such a signature, the 
different sections are added consecutively to the Selected Signatures table. You 
can change the order of each section separately, and can see at a glance which 
book signatures are part of a multiple-section signature: these rows have a 
section number. When you select one of these rows, Apogee displays a “linked” 
icon for the other sections from that same signature:

You can click the Section column to select all linked sections.

First Page: By default, Apogee places the job pages consecutively onto the signa-
tures, in the order as they appear in the signature list. The first page of each 
signature is therefore automatically determined by the number of pages that 
were placed on to the signatures that precede it.

However, for Perfect Bound templates you can override the first page of any 
signature by double-clicking the value in the ‘1st’ column, and entering a new 
value (you can also context-click). The number of the first page must be equal to 
or higher than the first page of the Run List. There is no upper limit for a first 
page; Apogee simply indicates the number of missing pages if you specify a value 
that is too high for the current Run List setup. 

Manually adjusted first pages are displayed in bold: They are fixed, and do not 
change if you edit the signatures.

Folder

Templates

Signatures

Indicates that this section is part of a multiple-section signature.
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NOTE: The Run List must be big enough to accommodate all positions in the 
signature list.

You can reset a manually adjusted first page by editing it and leaving the number 
empty, or by context-clicking it and selecting Reset First Page from the context 
menu.

Rearranging Selected
Signatures

You can use the Up and Down buttons below the Selected Signatures table to 
rearrange the signatures. You can also drag and drop them.

Deleting Selected
Signatures

Select one or more signatures, and click the Remove button to delete them.

Shingling

In the Shingling (Creep) panel, enter your inner and outer offsets. If you enter a 
positive number in the Inner and Outer fields, the image area moves toward the 
binding edge of the page. If you enter a negative number in these fields, the 
image area moves away from the binding edge of the page.

Page Position Adjustment

These settings allow you to adjust pages that are positioned inconsistently or 
incorrectly. You can apply horizontal and vertical offsets for odd and even pages.

 If you enter a positive number in the Horizontal field, the image area moves 
right on the page. If you enter a positive number in the Vertical field, the 
image area moves up on the page. 

 If you enter a negative number in these fields, the image area moves left 
horizontally and down vertically on the page.

Sheet Adjustment

Press Sheet Scaling These settings allow you to scale your output if your press sheet is too large or 
too small. You can enter a horizontal and/or vertical scaling percentage.

Bleed Margin Default You can specify a bleed margin (the amount that an image or color extends to the 
trimmed edge of the printed page). You should use this when you have created 
templates with “default” bleed margins.
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NOTE: The units of measurement displayed in this window are determined in 
your Preferences (see “General” on page 92).

In Apogee Imposition, the default bleed amount is 0.125 inch (3.175 mm), and 
is applied to all four sides of the pages. You can adjust the bleed amount to be 
smaller than the amount set in the source file. The new bleed amount applies 
only to the imposed job on which you are currently working.

The original bleed amount must be set in the source file. The bleed margins that 
you set are the final margins that will be printed around the trim size of the page. 

NOTE: You can make single page adjustments by modifying the individual page 
in the Run List. For more information, see “To adjust page imposition in the Run 
List” on page 223.
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Normalize

The Normalize Task Processor converts PostScript or EPS files to standardized or 
“normalized” PDF files. This process generates a PDF file that is suitable for 
reliable high-end prepress production. 

In order to make sure the normalized PDF is valid, you can preflight it. For more 
information on preflighting, see “Preflight” on page 805.

Associated Resources

When you select the Normalize Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Fonts

 Content Profiles

Normalize Settings

These settings allow you to specify how the Normalize Task Processor processes 
all incoming data, and customize the way in which the Normalize Task Processor 
produces PDF files in the selected flow. The Normalizer settings are grouped into 
five tabs. 

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.
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Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

GRS

Esko workflow has a secure format called GRS (Page Description Language), 
which is presently only compatible with the Security design program One and 
Fortuna.

Adjusted for workflow To replace the Flexrip-plate workflow, choose one of the following workflows:

 Automatic

 Plate

 Proof

 Depth

Show warnings Select this check box to show warnings generated by the PDF conversion.

Show fix messages Select this check box to show fix messages generated by the PDF conversion.

Add the press profile as
output intent

You can select this check box to specify the target device for printing the GRS 
document

PDF Generation

The PDF Generation Settings only affect incoming PostScript.

General Compatibility: You can choose between Acrobat 4.0 (PDF 1.3), Acrobat 5.0 (PDF 
1.4), Acrobat 6.0 (PDF 1.5), Acrobat 7.0 (PDF 1.6), and Acrobat 8.0 (PDF 1.7). 
Acrobat 4.0 is selected by default.

Binding style: The binding option affects how the pages are arranged side by side 
so that it will match the reading direction (left to right or right to left) of text in 
the document. You can choose either Left or Right. Right Edge binding is useful 
for viewing Arabic or Hebrew text or vertical Japanese text. By default, the 
binding is set to Left Edge.

Resolution: Enter the resolution at which you want to generate PDF files. The 
default setting is 1200 dpi, which is suitable for most jobs.
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NOTE: This is the internal Normalize resolution, and is not related to the output 
resolution of your device.

Use output resolution: Select this check box if you want to use the resolution of 
the output device. In this case, the Resolution field is disabled.

Pages Default page size: Specify the width and height that the Normalize Task 
Processor should use by default when no page size is specified in the incoming 
job. These values are used only when the document has no page size setting, or 
when the page size exceeds the allowed size.

Bleed amount : This is the amount that an image or color extends to the trimmed 
edge of the printed page.

NOTE: You cannot specify a bleed amount that is greater than the bleed specified 
in the incoming PostScript files.

Search for ‘BoundingBox’: Select this check box to search the incoming document 
for a specific page size.

Fallback: Specify the default page size (width and height) if no Bounding Box 
information can be extracted from the document.

Images

The Images Settings only affect incoming PostScript. 

Image Downsampling If you want to generate smaller PDF file sizes, you can set the Normalize Task 
Processor to downsample any images it encounters. 

NOTE: Excessive downsampling reduces quality.

A separate check box is provided for Monochrome images, Grayscale images, 
and Color images. To enable downsampling for a particular image type, select 
the corresponding Downsampling check box, and choose one of the downsam-
pling methods from the list:

Average downsampling: This is the fastest downsampling method.

Subsampling: This is the intermediate downsampling method that produces 
good results.
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Bicubic downsampling: This is the slowest downsampling method, which 
produces the best quality.

For each of the selected downsampling methods, enter your required target 
image resolution (dpi) in the ‘to’ box provided.

For each of the three image types, you can also specify image downsampling 
thresholds. By default, these values are set 150% of your selected target image 
resolution. For example, if you set your compression options to downsample 
color images to 300 dpi, then by default this downsampling will be applied to all 
color images that are 450 dpi or higher.

In the ‘above’ box, you can change this default for images above the dpi 
threshold to any value you require.

Image Compression The goal of image compression is to reduce the size of the PDF in order to 
improve performance.

To enable image compression for a particular image type, select the corre-
sponding check box, and choose one of the image quality options from the list.

CCITT Groups 3 and 4 compression: These are lossless compression methods 
which are good for most monochrome images.

ZIP compression : This is also a lossless compression method.

JPEG compression: These options compress images with a minimum amount of 
information (quality) loss. JPEG compression produces smaller files than ZIP 
compression.

Run Length: This is also a lossless compression method for images with large 
areas of solid black or white.

These options activate automatic image compression. The greater the compres-
sion the smaller the resulting file size. The image compression uses the best 
compression algorithm according to the specific image type. Although some of 
the original image quality is lost, even the lower image quality options will 
produce reasonable image quality.

Select the 'Compress text and line art' check box if you also want to compress the 
rest of the data in your input documents.

Application Settings

The Application Settings only affect incoming PostScript. These settings are 
typically used with documents from high-end documentation and graphics 
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applications, such as Adobe Illustrator and Adobe PageMaker. For more infor-
mation, see the documentation that came with the application.

General Preserve UCR and Black generation: Retains UCR (Under Color Removal) and 
Black Generation settings if they exist in the PostScript file. Black Generation 
calculates the amount of black to be used when trying to reproduce a particular 
color. Under Color Removal (UCR) reduces the amount of cyan, magenta, and 
yellow components to compensate for the amount of black that was added by the 
black generation. Because it uses less ink, UCR is generally used for newsprint 
and uncoated stock.

Preserve Halftone information: Retains any halftone information in files. 

For more in-depth information, see “Understanding Normalize Settings” on 
page 775.

CAUTION: If you select this option, the halftone information cannot later be 
replaced by settings in the JTE.

Transfer functions in composite PostScript: The following options are only appli-
cable for composite PostScript. For pre-separated PostScript, the value is always 
‘Apply’:

 Preserve: Retains the transfer functions traditionally used to compensate for 
dot gain or dot loss (that may occur when an image is transferred to film). 
This option is especially recommended for pre-separated files when using 
spot colors.

 Remove: Removes transfer functions.

 Apply: Applies a transfer function.

CAUTION: If you select ‘Preserve’, no transfer resource from the Render Task 
Processor can be used. However, Halftone-linked Transfer Resources can be 
concatenated in the Render Task Processor using a special boot resource. 

PostScript Color
Management

PostScript Color Management allows you to define the behavior of PostScript, 
EPS or PDF images and objects which may or may not have a Color Space Array 
(CSA) embedded. 

See also PostScript Color Management in “PDF Render - Render Settings” on 
page 796.
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TIP: What is CSA? A Color Space Array (CSA), is the PostScript profile for a 
color. The CSA has the information to translate the color data from the origin 
space to the XYZ space. It is either inserted into the PostScript print stream when 
the image is printed or is resident in an EPS image. No other graphic format 
supports CSA. Colors referred to as CSA are known as device-independent, or 
CIEBased colors. 

Honor application PostScript color management: Select this option if you want to 
use the Color Management settings of your application. This option disables the 
Color Management settings.

Apply fixed PostScript color management: In this section you can overwrite appli-
cation profiles, CIE based color spaces and render intents.

 Attach Profiles: Select the appropriate check box for each object. You can 
choose between:

 Images/objects

 Line Art objects

Once you have selected the check box, the corresponding drop-down list will 
be activated. Here, you can select the Profile you want to attach from the 
drop-down lists. You can choose from the following Profiles:

 Color Spaces: You have three options:

 Treat CIEBasedA objects as gray objects

 Treat CIEBasedDEFG objects as CMYK objects

 Treat CIEBasedDEF objects as RGB objects

A CSA is embedded in an image when you select “PS Colormanagement” 
while saving an EPS file in PhotoShop. There are three possibilities:

 A Gray CSA results in a CIEBasedA entry.

Objects Profiles for Images/objects Profiles for Line Art

RGB objects • DeviceRGB
• DefaultRGB

• DeviceRGB
• DefaultRGB

CMYK objects • DeviceCMYK
• DefaultCMYK

• DeviceCMYK
• DefaultCMYK

Gray objects • DeviceGray
• DefaultGray

• DeviceGray
• DefaultGray
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 A CMYK CSA results in a CIEBasedDEFG entry in the PS file.

 An RGB CSA results in a CIEBasedRGB entry for a monitor profile. It 
results in a CIEBasedDEF entry for a scanner profile or an extended 
monitor profile (feature of Colortune 4.0).

You are advised to use a CSA in RGB images, but not to use CSAs in CMYK or 
Gray images.

 Rendering Intent: You can overwrite render intents, and specify exactly how 
they should be overwritten. For more information on render intents, refer to 
“Rendering Intent” on page 862.

 Overrule rendering intent for RGB images with:

Choose one of the following: Perceptual, Relative Colorimetric, 
Saturation or Absolute Colorimetric.

 Overrule rendering intent for CMYK images with:

Choose one of the following: Perceptual, Relative Colorimetric, 
Saturation or Absolute Colorimetric.

 Overrule rendering intent for LAB images with:

Choose one of the following: Perceptual, Relative Colorimetric, 
Saturation or Absolute Colorimetric.

Overprint Honor application overprint: Select this option if you want to use the Overprint 
Settings of your application. This option disables the Force Knockout and Force 
Overprint settings.

Apply fixed overprint: Select this option if you want to overwrite the Overprint 
Settings of your application. This option enables the Force Knockout and Force 
Overwrite settings.

 Force Knockout: This option detects all “White objects” set to overprint, and 
changes them to knockout. Alternatively, you can change all overprint 
objects to knockout.

 Force Overprint: Choose your black overprint options by selecting the avail-
able check boxes. You can overprint any combination of black objects (lines, 
fills, and text). In the case of overprinting text, a point size limit can be set, 
above which no overprinting of the characters is forced. Setting this value 
high will cause all black text to be overprinted.
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Advanced Disable PSE: Select this check box if you want the application to process the files 
with PSE disabled.

PDF Processing

The PDF Processing Settings affect both incoming PostScript and PDF. 

File Format Select this option if you want to create PDF files in ASCII text format. This is 
useful if you want to send a file via email, although it increases file size.

Fonts You can configure the Normalize Task Processor to produce PDFs, even if 
documents are input with missing fonts, and the font is not available as an 
Apogee font resource. The Normalizer will then substitute any missing fonts 
with the substitution font that you specify. 

Missing fonts: There are a number of ways you can deal with missing fonts:

 Notify: The Normalizer stops processing the document, and places a ‘User 
Interaction’ notification on it.

 Ignore (only for PDF input): The Normalizer continues processing the 
document, but places a ‘Warning’ notification on it.

 Substitute with: The Normalizer continues processing the document, but 
replaces the missing font with the selected substitution font, and places a 
‘Warning’ notification on the document.

NOTE: If you input a document that uses font substitution, you cannot correct the 
font afterwards.

Subset all embedded fonts below: Select this check box to embed only a subset of 
the fonts, and specify a threshold percentage. If the threshold is 90, for example, 
and less than 90% of the characters are used, the Normalize Task Processor 
embeds only those characters. By default, this option is disabled.

NOTE: If you select this option, Apogee will create smaller PDF files. However, 
you will also limit the amount of editing that will be possible later, since not all 
the relevant font information will be available.

PANTONE conversion Convert all PANTONE color names to: This option allows you to change the name 
extension (such as CVC or CVU) according to the medium type:

 Coated

 Uncoated
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 Matte: Only for use with Pantone 2000 colors. If you choose Matte, the suffix 
will be changed to 'M'.

 ‘CV’

 Follow paper type

NOTE: These settings are not available for multi-part jobs and PDF Render.

Use Pantone 2000 color names: This option allows you to convert the old Pantone 
name extensions to the Pantone 2000 extensions. 

Recognize ‘PANTONE nnn’ as PANTONE color name: Apogee will interpret any 
color name beginning with a “P” as a Pantone color name.

NOTE: To use PDF to its full advantage, a composite workflow is required, 
allowing last minute decision making as to where and how the PDF should be 
processed. However, some users need support for legacy workflows, where files 
come in pre-separated (e.g. DCS files such as CopyDot and HexaChrome, or 
other pre-separated PostScript files). For this reason, the Normalizer always 
converts (re-combines) incoming pre-separated PostScript to composite.

Page Thumbnails Page Thumbnails are low-resolution images that Apogee uses to show thumb-
nails of a page in the Results tab. These thumbnails are not those that are 
embedded in the PDF file (and that you can see in a PDF viewer such as Acrobat): 
They are TIFF images that are stored inside Apogee. You should use the Export 
Task Processor to produce PDF files with embedded thumbnails.

Create thumbnails: Only when there are no document thumbnails present: The 
Normalizer uses the document's thumbnails as page thumbnails if they are 
present. It builds thumbnails for those pages that have no thumbnail. Note that 
the page thumbnails may not be built if there are problems generating a proper 
PDF file (from a PostScript file). This is the default setting.

Create thumbnails: Never, but use the document's thumbnails if present: The 
Normalizer uses the document's thumbnails as page thumbnails. Documents 
that have no thumbnails will have no page thumbnails, and are displayed with a 
generic icon in the Results tab. You should select this option if you want 
maximum performance and do not require thumbnails in the Results tab. This is 
also useful for fast processing of large documents, where page thumbnails are 
not important (e.g. a text-only book). For optimal performance, you can also 
enable the HotFolder's thumbnail extraction.

Create thumbnails: Always, ignoring the document's thumbnails: The Normalizer 
always builds page thumbnails for every file it successfully delivers, even if the 
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incoming file already contains thumbnails. The thumbnails may not be gener-
ated if there are problems generating a proper PDF file (from a PostScript file). 
Since this will slow down the Normalizer, you should use this option only if you 
know that the embedded thumbnails of the received PDF files are of bad quality.

Low Resolution Previews These are preview thumbnails used for viewing page content in Apogee Impose. 
They have a higher resolution than the page thumbnails displayed in the Results 
tab.

Create Low Resolution Previews: Select this option to create page preview thumb-
nails for Apogee Impose. See “Page Previews” on page 454 for more 
information.

For more in-depth information, see “Understanding Normalize Settings” on 
page 775.

Understanding Normalize Settings

This part contains more in-depth information on a number of settings of the 
Normalize Task Processor.

Conversion Limitation from Separations into Composite

This feature has the following limitations:

 Recombine only works when pre-separated PostScript is sent to the 
Normalize Task Processor.

 Ensure that CCITT Group 4 is chosen for Monochrome in the Image Handling 
options (for CopyDot support). 

 This option will only work with fully DSC-compliant PostScript.

 Since the decision to separate was already made in the authoring application, 
it is not possible to change the spot color behavior of the resulting PDFs. You 
will only be able to choose “keep as spot” or “map to other spot”.

 Adobe Acrobat or Acrobat Reader will not correctly view the resulting PDF. 
Since recombine is a process where separations are placed in one file using 
the overprint mode, only the last separation in the file (usually black) will be 
viewed. To obtain a correct preview of CMYK files in Acrobat 5.0.5 or higher, 
you have to enable overprint preview in the View menu of Acrobat.

 You cannot change the overprint behavior, or perform Trapping (in the 
Render Task Processor) on these recombined separations.
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Transfer Functions

Dot gain occurs when the ink dots that make up a printed image are larger (for 
example, due to spreading on paper) than in the halftone screen. Dot loss occurs 
when the dots print smaller. 

For example, a file that is intended for output on a particular imagesetter may 
contain transfer functions that compensate for the dot gain associated with that 
printer. Transfer functions are specific to an output device, and are typically 
loaded and managed on the Render Task Processor. If however, the input file 
contains transfer curves, you may want to preserve this information.

Halftone Information

Halftone information consists of dots that control how much ink is deposited by 
halftone devices at a specific location on the paper. Varying the dot size and 
density creates the illusion of variations of gray or continuous color. For a CMYK 
image, four halftone screens are used: one for each ink used in the printing 
process. In traditional print production, a halftone is produced by placing a 
halftone screen between a piece of film and the image and then exposing the 
film. Electronic equivalents, such as in Adobe Photoshop, let users specify the 
halftone screen attributes before producing the film or paper output. As with 
transfer functions, halftone information is intended for use with a particular 
output device.
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PDF Render

PDF Render accepts only PDF data and allows you to perform color management 
before outputting the re-screened raster data to an imagesetter, platesetter or 
proofer. 

PDF Render performs trapping, separation, rendering and screening of the data. 
Each of these processes have their individual settings. You can view these 
settings either when creating Parameter Sets, or from the Settings pane in the 
Plan tab of the Job Manager and the Ticket Editor.

 In the Trapping process, overlaps between adjacent colors are created to 
account for press misregistration, paper stretch or other variables.

 In the Separation process, a composite job is separated into different colors. 
On a press, each separated color has its own printing plate, each one printed 
in a different angle, producing the final printed color image. In traditional 
prepress, color images are separated into four layers corresponding to the 
four process colors (CMYK) used in process printing: cyan, magenta, yellow 
and black. For more information on these settings, see “PDF Render - Separa-
tion Settings” on page 788.

 In the Rendering process, you can specify your settings for Color Manage-
ment and Overprint.

 In the Screening process, continuous tone files are converted into halftone 
dots. This means that the image is converted into a number of dots in the 
predefined separation colors. You can enhance the quality of the image by 
adjusting the dpi (dots per inch) and the lpi (lines per inch), also called ‘line 
frequency’. Every line consists of a number of dots. For more information on 
these settings, see “PDF Render - Screen Settings” on page 800.

Associated Resources

When you select the PDF Render Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Fonts

 Content Profiles

 Device Link Profiles
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 Profile Link Exceptions

 Input Color Conversions

 Output Color Conversions

PDF Render - Trap Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Honor application trap zone and ink settings

Disables full-page Trapping. When selected, this option overrides the Global 
Trap options, described below. Apogee will then implement any Trapping and 
Ink settings which have been made in the original application (if the application 
allows it). If there are no application Trapping settings, then the job will be 
processed without trapping.

Apply application trap zones

The Trapping settings of the original application will be applied. You can still 
specify the Ink settings in the Apogee Trapping settings.
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You can still select Apply Additional Global Trap Zone, if there are no global trap 
zones defined in the PS or PDF file. 

NOTE: Application Trap Zones will always overrule the Apogee Trapping settings 
if both options are selected.

Apply additional global trap zones

Enables full-page Trapping. The Trapping settings of the original application 
will be ignored. The Global Trap settings will be used instead.

Trap Width Normal: Determines the width to be applied to the trapping elements. For quality 
offset printing, this value should normally be equivalent to a width of 0.5 - to - 2 
lines. For a 150 lpi job, this would be a value between 0.24 pts and 0.96 pts 
(0.084 mm and 0.336 mm). The higher the quality of the printed output, the 
smaller the trap should be.

Black:  Determines the width to be applied to black trapping elements.

Trap Appearance Trap style: The Trap Style option specifies how the traps are created in a point 
where three or more images with trapped colors, intersect each other. You have 
the following options:

 Split: This option will avoid the dark areas. This style is recommended for 
offset printing.

 Overlap: This option will leave the object shapes more intact. This style is 
recommended for packaging.
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Trap corner shape: The Trap Corner Shape setting provides three options for the 
outside spread style of the trap corner:

 Triangle

 Square

 Round

Trap Images Image boundaries: This value specifies the position, relative to the image border, 
where a trap will be placed:
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 Center: Places the trap half on the image and half on the object when both 
have to be trapped to each other. This option applies to image-to-object 
trapping and image-to-image trapping. Image-to-image trapping, however, 
only supports the boundaries “Center” and “Normal”.

 Normal: Applies the general trapping rules, and places the trap in accordance 
with the neutral densities of the image pixels. This option should be rarely 
used, since the color information in the image might be different for each 
single pixel, which may produce a “jagged” result.

 Spread: Places the trap on the vector information only. This option is useful 
for images that are placed on a dark background, such as a black keyline. If 
text is placed on the image, then this option helps to preserve the integrity of 
the text.

 Choke: Places the trap on the image only. This option is useful for images that 
are placed on a light background.

1-bit images: This option should be checked when you want to trap 1-bit TIFFs 
(with transparent background). The trap will be created between the image and 
the background, according to the standard trap rules. When an Image mask 
abuts an image, a trap will be created according to the Inks setting.

You can clear this option if you want to improve trapping performance. In partic-
ular, you should not use this option when working with copy-dot files or very 
complex image masks.

Within images: This option enables the creation of traps within images. In most 
cases, you should avoid trapping within images. It may be only really necessary 
when dealing with screen dumps or very high contrast artwork which is created 
without anti-aliasing in an image processing system. However, if you use this 
option, it should only be applied to the specific area (defined by trap zones) 
which contains the image, and not to the document as a whole.

NOTE: For standard operations, you are advised not to use this option.

Image to image: This trapping option is useful when one of the abutting images 
has a dominant color that is mostly absent from the other image, or simply when 
you want to produce traps consistently along all image edges. 

The Image to Image traps are placed to the Center. If Spread or Choke is selected 
or if Image Boundaries are off, Center will be applied. 

Only if Trap Image Boundaries is set to Normal, will the Image to Image traps 
also be set to Normal. 
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Thresholds Sliding traps color limit: Slides a trap gently from the lighter area to the darker 
area whenever the difference in “darkness” between the two areas is less than a 
specified percentage (0-100%). When the Sliding Trap Color Limit is set to 
100%, no sliding to center will occur, and the general trapping rules will be 
applied.

Relative color step limit: Traps are used in areas of varied color whenever the 
relative percentage of difference between two adjoining colors exceeds a 
predefined limit. The Relative color step limit option allows you to specify this 
percentage of difference. The lower the value, the more traps will be created. 
The default relative color step limit is 200%. 

Trap color density reduction: Allows you to reduce the darkness of a trap. This 
value is specified as a percentage (0-100%). This produces a trap that is “lighter” 
than would normally be used. The higher the color density reduction you 
specify, the lighter the trap. At 100%, the trap will have the same neutral density 
as the darkest color.

For more in-depth information, see “Understanding Trap Settings” on page 785.

Black Trapping Allows you to define which color has to be handled as black. There are two 
editable parameters:

Color tint value at least: Trapping can be configured to handle other dark or 
almost-black colors in the same way that it handles 100% black colors. 

Color density at least: Any ink at or higher than the specified color density 
threshold value will be treated as black.

For more in-depth information, see “Understanding Trap Settings” on page 785.

Inks

Click the Inks button to access the Ink Settings for the PDF Render Task Proces-
sors. In the Inks dialog box, you can view or edit the order in which all process 
and spot colors will be trapped. You can also view or edit the density and 
colorant type of each color.

Trapping Order

This table shows the order in which the colors will be trapped. You can use the 
Up and Down arrows to change the trapping order. The table also shows the 
corresponding density and the colorant type.
Apogee Reference Guide



 

13 PROCESSING TASK PROCESSORS 783
Determine trap order
automatically

You can choose to have Apogee manage the trapping order by selecting this 
check box. Apogee will order the colors as follows:

 Based on the colorant type: Transparent, Normal, Opaque, Opaque Ignore

 Based on neutral densities: Lower values are selected first.

 Equal colorant types and neutral densities will be ordered alphabetically.

Chosen Ink Name

Density You can either specify the density manually, or have it automatically retrieved 
according to look-up rules. For this, you need to select the Automatic check box. 
If the density cannot be retrieved from the application or the books, AND you 
have selected the “Use application values, calculate if not supplied” Ink Densities 
lookup option, it will be calculated according to the CMYK values of the spot 
color. 

NOTE: If the CMYK values cannot be retrieved, you will receive a warning.

Colorant type You can also select the type of ink you would like to use from this list. Your 
options are:

Normal:  Normal is the default for all colors. Normal trapping rules will be 
applied.

Transparent:  If you are using varnish inks, this option ensures that these inks will 
never be trapped. Underlying colors will however be trapped.

Opaque:  If you are using heavy, non-transparent inks, this option will prevent 
the trapping of underlying colors, but will allow trapping along the ink’s edges.

Opaque Ignore:  If you are using heavy, non-transparent inks, this option will 
prevent the trapping of underlying colors and along the ink’s edges. This option 
is required when using inks which react unpredictably with other inks (e.g. 
metallic inks).

Definition This field displays how the color was found. 

If the color is... You will see the message...

Entered manually <no message>

Found in the specified book <color book name> book

Supplied by the application Application

Found in the specified ink set (from the Press 
Task Processor) - only for process colors

<ink set name> ink set
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Occurs in The table shows on which pages the selected color is used (Run List position, 
document name and page number). 

Ink Densities

Specify how and from where Apogee will retrieve its color definitions. You have 
three search options:

Search books Apogee searches the specified books. The job will fail if the color is not found in 
any of the selected books.

Use application values Apogee will use the application color values. 

Use application values,
calculate if not supplied

Apogee uses the application values. If the application does not supply the values. 
Apogee will calculate them. 

NOTE: When this option is selected, the application might find a color in a 
different color space. In this case, there is a color space conflict.

Books Double-clicking the Books button displays the book selection window. The table 
shows all of the available books that can be searched. You can select or clear the 
check box next to the book’s name to either include the book in or exclude it from 
the search. You can also change the search order by using the up and down 
arrows or by dragging and dropping. 

NOTE: The books are shared between the Trap and Separation settings. If you 
enable a book in the Separation settings, it will also be enabled in the Trap 
settings, and vice versa.
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Understanding Trap Settings

This section provides more detailed information on the following options intro-
duced in PDF Render - Trap Settings.

 Using a Sliding Traps Color Limit

 Using a Relative Color Step Limit

 Using Trap Color Density Reduction

 How Black Trapping Works

Using a Sliding Traps Color Limit

As a general rule in trapping, a trap in the “lighter” color should always spread 
into the “darker” color. However, if the color in one of the lighter area changes 
gradually (e.g., a blend or a vignette), then the trap will “jump” into the darker 
area, creating a visible jagged edge as illustrated below left.

Jagged Trap (100%) and Slanting Trap (70%)

You can fix this type of problem by specifying a Sliding Traps Color Limit. This 
allows a trap to slide gently from the lighter area to the darker area whenever the 
difference in “darkness” between the two areas is less than a specified 
percentage (0-100%).
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In the example (above right), if you set the Sliding Trap Color Limit to 70%, the 
trap line will start to gradually slide into the darker area whenever the difference 
is less than 70%. This gives a gradual and barely perceptible slant of the trap line 
into the darker area, and avoids the abrupt and jagged jump.

Using a Relative Color Step Limit

Suppose you had 2 adjoining colors - Color A and Color B - with the following 
CMYK attributes:

The relative difference is equal to the absolute difference divided by the smallest 
component of the two colors.

If you specify a Relative Color Step Limit of 10%, then a trap will be needed 
between these 2 colors. This is because there is a relative difference of more than 
10% in at least 2 of the component colors (Cyan and Magenta) and this in 
opposite directions.

NOTE: You need also an absolute difference of at least 5%.

Using Trap Color Density Reduction

When a trap is created between 2 colors, the trap will adopt the highest color 
value for each of the CMYK elements available in the 2 adjoining colors. The 
resulting color is always darker than the two original colors, which produces a 
dark gray to black trap. However, you can reduce the darkness of the trap by 
setting a Trap Color Density Reduction value.

CMYK COLOR A COLOR B ABS DIFF REL DIFF

Cyan 35% 5% 30% 30/5 = 600%

Magenta 5% 40% 35% 35/5 = 700%

Yellow 16% 20% 4% 4/16 = 25%

Black 8% 5% 3% 3/5 = 60%
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Normal Trap Density (left) and 100% Trap Color Density Reduction (right)

How Black Trapping Works

There are three Black Trapping rules that are applied whenever black is 
involved:

 The Black Trapping sets a percentage of deviation from the normal trap 
whenever black is involved in the creation of a trap. This is because registra-
tion problems are more visible whenever black (or a very dark color) is 
involved. Traditionally, therefore, the width of a trap to a black area is made 
wider than a standard trap. A good default setting to use here is 200%.

 Auto-choke is always active. In cases involving a rich black (solid black with 
one or more support colors) that shares a common edge with white, a reverse 
trap will be created.

 Always spread under black.

However, when is black really black? To define which color has to be handled as 
black, you must specify minimum values for Color Tint and Color Density. Both 
of these values are required for a color to be considered as black.

Color Tint Setting a minimum color tint value is useful in specific situations. For example, 
if you are printing on newspaper quality or with polyester or other so-called 
lower quality plates, you may not use the full range of color tints (0-100%). 
Instead, you may limit color tints digitally between 4-96%. In this case, there will 
be no 100% black in the digital document. However, if you set the Color Tint 
Value to 96%, the Trapping module will treat black at 96% as it would treat 
black at 100%.

Color Density Setting a minimum color density is useful when you have dark spot colors that 
you want to be handled the same as black.
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How Black Trapping Works

Basic Trapping Terms

Spread A spread traps a light colored foreground object to a dark background. The 
darker of two adjacent colors defines the visible edge of the object. Therefore, 
spreading the lighter color slightly into the darker color maintains the visual 
edge.

Choke A choke traps a light colored background to a dark foreground object.

PDF Render - Separation Settings

This dialog box allows you to view or edit the Separate settings of the Render 
Task Processor. This process separates composite jobs into different colors. Each 
separated color has its own printing plate. Each plate is printed at a different 
angle, to produce the final printed color image.

You can access these settings:

without auto-choke with auto-choke

misregistration
on press

no misregistration
on press
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 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Color Policy

In this section, you can specify which colors are to be printed and which colors 
are to be converted.

Application decides If you select the Application decides check box, the application specifies whether 
to keep or convert a color. Apogee displays the colors according to the specifica-
tions of the application. The other options are disabled except for Color 
Definitions. In this case, you can make no changes to the separation output and 
order in the Image settings (see “Image Settings (for ECO3 Imagesetters and 
Platesetters)” on page 844).

CAUTION: This option is only available for Hot Tickets.

Colors are only displayed from pages in the Run List. If you remove a page from 
the Run List, its colors will no longer be displayed. 

If you clear the Application decides check box, Apogee keeps the current 
settings. You can then change these settings as required. If you reselect the check 
box, Apogee restores the application settings completely: All previous settings 
are lost, as well as any manually-added colors. In this case, Apogee will ask for a 
confirmation.

Keep This column lists the process colors and the colors that will be kept as spot colors. 
The names of the process colors are the generic color labels as defined in the 
color space associated with the selected ink set in the Press Task Processor. The 
process colors are listed first, followed by the spot colors, sorted alphabetically.
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CAUTION: This option cannot be used with composite PostScript documents.

You can add, edit and delete colors. For more information, see “To add or edit a 
spot color” on page 795 or “To delete a spot color” on page 796.

NOTE: The ink names specified by the ink set are not displayed.

Convert to Process This column lists the colors that are to be printed as process colors. The CMYK 
values are displayed next to the color. The colors are sorted alphabetically.

You can use the Right/Left arrows to move colors from one column to the other 
if necessary.

NOTE: The process colors are not shown if there is no Press Task Processor in the 
Production Plan (in this case, the CMYK colors are displayed in the Separation 
settings). The table is updated as soon as you insert the Press Task Processor. 
The process colors are also not shown when you are editing a Parameter Set, as 
they cannot be part of a Parameter Set.

A small icon appears before each color:

The color definition was found in the Apogee Color Books.

The Emulate Overprint option is always on.

The Emulate Overprint option is always off.

The Emulate Overprint option is selected automatically.

The color contains version-specific content.

The color does not contain version-specific content.

The color was found in the job.

The color was manually entered.

The color was manually entered and was found in the job.

The color is directly linked to the selected color
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NOTE: All colors that are linked to have the same color policy (process colors are 
always in the Keep list). However, the colors that link to them may be in either 
the Keep or Convert lists.

Colors not yet listed above In this drop-down list, you can specify how Apogee handles spot colors that are 
not specified in either of the two lists. You have three options:

Keep: Apogee will use them as separation colors. The job outputs additional 
plates for the spot colors.

Convert to Process: Apogee will convert them to the process colors.

Notify: Apogee sends a message to the Message Board and holds the job 
processing if a new spot color is found. Apogee automatically puts the newly 
found spot colors in the Convert to Process table and marks them as Policy 
undecided by a red in-job indicator and by putting the text in red and italics. 

You can then either keep the color in the Convert to Process table or move it to 
the Keep table. 

 To keep it in the Convert to Process, context-click the color and select 
Convert.

 To move it to the Keep table, use the arrows between the two tables. When 
you move the color to the Keep table, Apogee automatically accepts the color. 
You can also context-click the color, and select Keep.

CAUTION: You cannot submit a job as long as there are non-accepted colors.

The color is indirectly linked to the selected color.

The color was found in the border or the imposition template.

The color was manually entered, with marks.

Mapped color name as defined by the Pantone mapping settings.

Special color: varnish.

Special color: die line.

Special color: other.
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You can map a color to another by dragging it unto a specific color (or context-
clicking). Practically, this means that if you map red to green, red will be 
replaced with green. However, you can only have one mapping level. For more 
information, refer to “Understanding Separation Settings” on page 794.

Emulate Overprint policy Always on. Always off. Automatic. Emulate Overprint emulates the overprint 
behavior of colors whose color policy has been changed, for example when spot 
colors are printed with process colors. Changing the policy may require 
reprocessing.

Map spot colors from
marks/templates to
content spot colors

Controls the automatic mapping of the generic spot colors names used for marks 
and in templates to actual spot colors. This is selected by default but can be 
disabled if required, for example for some security printing applications.

<Color>

This section displays information about the color that is selected in the Color 
Policy section. The name of this section is the name of the selected color.

Press color values These fields display the CMYK values for the selected color in the Press color 
space. The CMYK displayed and the Definition specifies how the value was 
found.

Emulate Overprint Always on. Always off. Automatic. Emulate Overprint emulates the overprint 
behavior of colors whose color policy has been changed, for example when spot 
colors are printed with process colors. You will see the Emulate Overprint icon 
next to the separation name. Based on the input file and the required color 
behavior, Apogee will select Emulate Overprint by default. Manual override of 
the setting is not always allowed.

Versioning The Has version-specific content check box is selected to indicate that the color 
is version-specific. This is indicated with the “v” icon next to the color in the 
Color Policy. Works with the R4V action list.

If the color is... CMYK displayed Definition

Entered manually User CMYK

Found in book Calculated CMYK if profile 
selected, empty if no profile

Lab<Lab values> from “<book 
name>” book

Found in book with exception 
defined

Exception CMYK if profile 
selected, empty if no profile

Output profile exception for 
“<output profile>” in “<book 
name>” book

Supplied by application Application CMYK Application

Not found Empty <Not Found>
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Occurs in The table shows on which pages the selected color is used (Run List position, 
document name and page number). When the color is part of a Null device 
object, the table also shows the linked colors.

Color Definitions

This section specifies how and from where Apogee will retrieve its color defini-
tions. You have three search options:

Search books only Apogee searches the specified books. The job will fail if the color is not found in 
the any of the selected books.

Search books first, use
application values if not

found

Same as above, but now Apogee will also use the application values if the color 
is not found in the books.

Use application values
when supplied, else search

books

Apogee uses the application values, unless the application does not supply the 
values. Apogee will then search the books.

NOTE: When this option is selected, the application might find a color in a 
different color space. In this case, there is a color space conflict.

Books Clicking the Books button displays the book selection window. The table shows 
all of the available books that can be searched. 

You can select or clear the check box next to the book’s name to either include 
the book in or exclude it from the search. You can also change the search order 
by using the up and down arrows or by dragging and dropping.
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NOTE: The books are shared between the Trap and Separation settings. If you 
enable a book in the Separation settings, it will also be enabled in the Trap 
settings, and vice versa.

PANTONE Mapping

Map all PANTONE color
names to

This option allows you to change the name extension (such as CVC or CVU) 
according to the medium type:

 Coated

 Uncoated

 Matte: Only for use with Pantone 2000 colors. If you choose Matte, the suffix 
will be changed to 'M'.

 ‘CV’

 Follow paper type

Use Pantone 2000 color
names

This option allows you to convert the old Pantone name extensions to the 
Pantone 2000 extensions. 

Recognize ‘PANTONE nnn’
as PANTONE color name

Apogee will interpret any color name beginning with a “P” as a Pantone color 
name.

Understanding Separation Settings

This section provides you with in-depth information on the Separation settings.

Mapping colors

You can map a color to another by dragging it to the color. You can only do this 
up to one mapping level. Mapped colors appear indented below the color they 
are mapped to.

NOTE: Mapping colors with a 
pre-separated document is 
only possible if you have a 
Normalizer in the flow.

If you have a list of four colors and you drag color 2 to color 1 the result would 
be as follows:
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If you drag color 3 to color 1 or color 2, the result would be:

CAUTION: When you move a color to the other table, you will also move any 
colors that are mapped and linked to that specific color.

CMYK Conflict

If you select Use application values, Apogee might detect different CMYK values 
for the same color. In that case, a message will be sent to the Message Board. 

The conflicting color is shown in red italics with a red in-job indicator. The 
conflicting CMYK values are displayed in the Occurs in window in the Definition 
column. You can only resolve the conflict by clearing the Automatic check box, 
and entering the desired CMYK values.

A color policy conflict is displayed in red: A CMYK conflict is displayed in blue.

 To add or edit a spot color

1 Do one of the following to add or edit a spot color.

 Click the Add button underneath the column to add a spot color.

 Select the spot color and click the Edit button to edit it.

The Add or Edit Color window appears.

2 Click the Browse button to look for the spot color.

The Select Ink window appears.
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3 Select the Ink Book in the left column, then the Color of your choice in the 
right column and click OK.

4 Click OK in the Add Color window.

The newly added spot color appears in the list or the spot color has been 
edited.

 To delete a spot color

1 Select the spot color that you want to delete.

2 Click the Delete button underneath the column.

3 The spot color has been deleted.

NOTE: Make sure you delete the right spot color as there is no confirmation 
window.

PDF Render - Render Settings

This dialog box allows you to view or edit the Render settings of the PDF Render 
Task Processor. These settings define how color management is applied to the 
incoming data.

The settings you see in this dialog depend on the Color Management mode you 
select at the top of the dialog. In the Mode drop-down list, you choose one of the 
following modes:

 Document Based

 Honor application (7.x compatible)

 Custom (7.x compatible)

Document-Based Color Management settings

This mode uses input and output conversion presets for color management. 
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Input Conversion This drop-down list displays all the available input conversion presets. You can 
click the gray arrow to open the editor to consult or edit the settings. See “Input 
Color Conversions Overview” on page 1030 for more information. 

Output Conversion This drop-down list displays all the available output conversion presets. You can 
click the gray arrow to open the editor to consult or edit the settings. See “Output 
Color Conversions Overview” on page 1103 for more information.

Honor Application (7.x compatible) Color Management settings

In this mode, color management is based on settings in the incoming document 
and all other presets are disabled. This mode also ignores Document Output 
Intent and conversions depend directly on input profiles and press output 
profiles.

Click the grey arrow to open the editor to consult or edit the settings.

The following settings can also be applied in this mode: 

 Generic Settings

They are explained below.

Custom (7.x compatible) Color Management settings - RGB, Gray, 
CMYK tabs

In this mode, all color management settings in the incoming document are not 
honored and you can apply certain ICC Profiles to color spaces. Conversions 
depend directly on input profiles and press output profiles as explained here.

You can attach Profiles for the following objects: 

 Images

 Line Art

For each of these objects, you have a tab corresponding to the Color Space (RGB, 
Gray, CMYK, Spot, Document). Once you have selected one of these tabs, you 
can then choose to attach either a Profile or a Link to the Color Space. The corre-
sponding drop-down list is then activated, and you can select the profile or link 
you want to attach from the list.

The following settings can also be applied in this mode: 

 Generic Settings

They are explained below.
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Images and Line Art
settings

You can set either a device link profile or a profile for tagged and untagged 
objects. If there is an output intent in the PDF document (tagged), you can 
choose to use the document profile as tagged profile. 

Untagged (No Profile attached): Provides the following options:

 Use Default Profile

 Use Device Link Profile

 Simple Convert.

Tagged (Profile attached): Provides the following options:

 Use Tagged Profile

 Treat as Untagged

Default ICC Profile: Lists all Content Profiles, according to the selected color 
space.

Rendering intent: You can overwrite render intents, and specify exactly how they 
should be overwritten. For more information on render intents, refer to 
“Rendering Intent” on page 862. Choose one of the following: From Input, Same 
as Document, Perceptual, Relative Colorimetric or Saturation.

Black Point Compensation: This option may be available depending on source 
profile, destination profile and rendering intent.

Device Link Profile: The profiles shown in the list should include all the available 
device link profiles of which the source color space corresponds to the color 
space of the tab, and the destination color space is the same as that of the desti-
nation profile. 

Profile Link Exceptions: Lists all Profile Link Exceptions. This option is only avail-
able in the CMYK tab.

Custom (7.x compatible) Color Management settings - Spot tab

Conversion from Applica-
tion Values

Color Space of Application Values: Provides the following options:

 Don’t convert

 Treat as CMYK input: The line-art settings from the CMYK tab will be applied 
to the spot colors.

Conversion from Books Accurate spot color mixing: You can choose off, or maximum 2, 3, or 4 colors.
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Use Document Profile’s Paper White: If this option is selected, the paper white of 
the document profile is used in the color calculation. If this option is not selected, 
the paper white of the color book is used in the calculation of the spot colors. 

NOTE: A spectral press profile is required for this option.

Custom (7.x compatible) Color Management settings - Document tab

Document Profile The Document Profile is the ICC profile specified in the document.

Untagged (No Profile attached): Provides the following options:

 Use Destination Profile

 Generic CMYK

 All CMYK Content Profiles

Tagged (Profile attached): Provides the following options:

 Use Tagged Profile

 Treat as Untagged

Document Rendering
Intent

Rendering Intent: Choose one of the following: Perceptual, Relative Colorimetric 
or Saturation. 

Generic Settings

Advanced CMM Recent developments in the Color Management engine offer ‘Advanced CMM’, 
which provides a better way of bringing (smarter) colors into gamut. However, 
this comes at a small cost: it is a little slower.

Advanced Overprint
Handling

Preserves the Adobe overprint behavior during CMYK to CMYK conversions

Overprint Settings

Honor application settings If the Honor Application Settings check box is selected, all overprint settings will 
be taken from the information in the incoming document. In this case, the Force 
Knockout and Overprint settings are not displayed. If this check box is cleared, 
the Task Processor settings are displayed and enabled, and will overrule all 
overprint settings in the incoming document.

Force Overprint This section is only displayed when the Overprint Honor application settings 
check box is deselected. Here, you can choose your black overprint options by 
selecting the available check boxes.
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You can overprint any combination of black objects (lines, fills, and text). In the 
case of overprinting text, a point size limit can be set, above which no 
overprinting of the characters is forced. Setting this value high will cause all 
black text to be overprinted.

Missing Fonts

Select the ‘Substitute missing fonts with’ check box if you want Apogee to 
replace them with one of the available fonts in the associated drop-down list.

PDF Render - Screen Settings

This dialog box allows you to view or edit the Screen settings of the PDF Render 
Task Processor. The Screening process converts continuous tone images into 
halftone dots. 

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Select automatically from press

Select this check box to use an appropriate Parameter Set which is linked to the 
selected press using keywords. See “Parameter Set Lookup” on page 911. The 
settings are locked.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Single or Separate Settings

You can use a single group of settings for all content (both objects and images), 
or you can separately specify the settings for objects and images.

Use separate settings for
objects and images

When this check box is selected, Objects and Images tabs are displayed, and you 
can define separate screen settings (Screen Type, Frequency, and Dot Shape) for 
objects and for images.

Use single settings for all
content

When this check box is selected, a single Screen tab is displayed, and you can use 
a single group of settings (Screen Type, Frequency, and Dot Shape) for all 
content (objects and images).

Seamless Printing

When this check box is selected, the Seamless settings tab is displayed. This 
allows you to specify your options for seamless printing. Seamless printing is 
used in packaging jobs for printing a repetitive design, as in wallpaper or gift 
wrapping paper. These are usually printed in flexo.

NOTE: The Seamless Printing option is only available if you have a license. It is 
hidden if you do not have one.

Seamless

Join Select the edges that will be joined together on the sleeve.

Horizontal edges: The horizontal edges of the page will be prepared for seamless 
joining. The rendered image can be imaged directly on the sleeve.

Vertical edges: The vertical edges of the page will be prepared for seamless 
joining. The rendered image will have to be rotated 90 degrees before imaging 
on the sleeve.

Screen The Screen list box contains a filtered list of halftone screens (references) that 
can be selected by the job’s current screen settings. The entries appear in the 
same way as they appear in the Used Screen column of the Ruling Maps 
overview. You should select the screen to be used to render the content that runs 
across the seam. 

The list does not include references to Adobe Accurate or Rational Tangent 
screens as these are not supported. Hence, you might encounter a situation in 
which the list is empty. In that case, the JTE will post an error notification, and 
you will not be able to submit the job. 
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NOTE: You should always check the Seamless tab when you change a screen 
selection in any of the other tabs; the changes might invalidate the selected 
screen reference.

The simplest case is if you have selected a single fixed screen for all content. In 
this case, the list contains that single screen (reference) only. If you have two 
fixed screens, one for objects and another for images, the list contains these two 
screens. If you have selected a ruling map, the list contains all screens that can 
be selected by that ruling map using the output device’s resolution.

Screen

If the Fixed Screen option is selected, the Task Processor settings are enabled, 
and will overrule all screen settings in the incoming document.

Screen Type Choose one of the available screening settings:

Apogee Balanced Screening (ABS): A PostScript-based conventional, halftone 
screening system that uses supercell techniques and pre-calculated, balanced 
screen sets to deliver high quality color reproduction. ABS-screened halftones 
feature clear-centered rosettes for smooth tonal gradations and tints, and 
flawless skin tones free of moiré patterns.

Adobe Accurate: This screening method provides a close approximation to the 
standard screen angles for color separations (0, 15, 45 and 75 degrees) and 
frequencies.

Agfa Performa Screen: Agfa Performa Screen (APS) is a screening method with a 
dedicated developed set of halftone tiles for digital inkjet presses using FM 
technology.

Rational Tangent: This is standard PostScript screening technology implemented 
by Adobe. Standard screening is the oldest of the four screening methods and 
produces a lower output quality than either Apogee Balanced Screening or 
Adobe Accurate Screening. 

Frequency Choose one of the available line frequencies (lines-per-inch) from the Frequency 
box.

Dot shape Choose either an Elliptical or Round dot shape.

Honor Application

If the Honor Application check box is selected, all screen settings will be taken 
from the information in the incoming document. In this case, the Screen Type, 
Frequency, and Dot shape options will be different, and you will be able to select 
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a Ruling Map. The Ruling Map is used to map screen settings in the incoming 
document to predefined screen settings in Apogee. For more information on 
Ruling Maps, see “Ruling Maps” on page 1017.

If this check box is cleared, the standard Screen Type, Frequency, and Dot shape 
options will overrule all screen settings in the incoming document.

Screen Type: Choose one of the available screen settings (Ruling Map, Adobe Accurate, 
Rational Tangent) from the Screen Type box drop-down list.

When you select Ruling Map, you can specify which Ruling Map to be used in the 
drop-down list next to the Screen Type drop-down list.

Frequency This is linked to the selected Screen Type.

NOTE: If a Ruling Map is selected and the frequency is not found, frequency 0 will 
be used. If this frequency is not available, the job will fail.

Dot shape Choose one of the following:

 Application

 Ruling Map

 Elliptical

 Round

NOTE: The available screening settings will change in accordance with the 
selected output device.

Separation Angles

In the Separation Angles panel, you will see a list of the process and spot color 
plates in your job. You will also see a list of angles adjacent to the plates. The 
default angles are as follows:

 Cyan: 15°

 Magenta: 75°

 Yellow: 0°

 Black: 45°
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Depending on the selected screen parameters, your angle settings will either be 
honored, or will be redirected to the closest available angle.

NOTE: The Black plate angle (45°) is also used for any spot color plates.

Tagged Screening Elements which are tagged will follow the Honor Application settings.
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Preflight

The Preflight Task Processor checks that incoming PDFs meet your require-
ments. You can change the document properties with an Action list based on the 
predefined preflight profile.

Associated Resources

When you select the Preflight Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Preflight Profiles

 Preflight Action Lists

Preflight Settings

When you input PDF files, they are saved in the Page Store. To be sure that the 
PDFs do not generate errors when they are output, you can run an optional 
Preflight check.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
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from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Preflight Warnings Produce Notifications

If this check box is selected, any Preflight warning which is generated will also 
trigger a notification.

Actions

The preflight process allows you to automatically edit the PDF, based on a set of 
rules, called “Actions”. 

Use Action Lists To activate or deactivate specific preflight checks in your profiles, select the Use 
Action Lists check box, and select or clear one or more of the available Actions.

For more information on the default Action Lists, see “Preflight Action Lists 
Overview” on page 1119.

Job Profiles

Use Job Profile Select the ‘Use Job Profile’ check box, and select one of the built-in profiles from 
the drop-down list. 
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Preprocessor

The Preprocessor task processor is used in the background for Sign & Display 
jobs and no settings need to be specified.
Apogee Reference Guide



808 PREVIEW GENERATOR
Preview Generator

The Preview Generator task processor is a rendering processor which is similar 
to the PDF Render Task Processor but with limited resolution for previews. This 
task processor is used in the background for Sign & Display jobs. For more 
information, see “PDF Render” on page 777.
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Raster Compose

The Raster Compose task processor is used in the background for Sign & Display 
jobs and no settings need to be specified.
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Raster Impose

The Raster Impose task processor is an Impose task processor which is used for 
raster job assembly. For more information, see “Impose” on page 759.
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Raster Normalize

The Raster Normalize Task Processor converts raster data to TIFF format, and is 
specifically designed for Production Plans which include the Open Connect 
input Task Processor.

NOTE: Open Connect requires a Raster Normalize Task Processor.

No settings or resources are associated with Raster Normalize.
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Run List

The Run List Task Processor determines which pages of a job are going to be 
processed. If you insert a Run List in your Production Plan, a list of placeholders 
will appear next to the Page Store in the Pages tab. Every Job Ticket needs a Run 
List whereas a Hot Ticket can contain one, but it is not necessary (see “Using a 
Run List in a Hot Ticket” on page 812).

You have to drag the pages you want to process to the placeholders of your 
choice. You can select one or several pages, either keeping or modifying their 
original order. You can select the document itself and drag it to a placeholder of 
your choice. The pages will then be inserted into the subsequent placeholders, 
preserving the original order.

Not all of the placeholders need to contain PDF-pages. A placeholder can be 
empty, or can contain a blank page.

CAUTION: When you drag a document to the Run List, you have to make sure that 
there are enough placeholders available. For instance, if a document contains 28 
pages, the Run List has to contain 28 placeholders. You can modify the number 
of available placeholders in the Run List Settings.

No resources are associated with a Run List.

Using a Run List in a 
Hot Ticket

You do not need a Run List in a Hot Ticket unless:

 You want to be able to change pages in the jobs that are created.

 You want to use imposition.

Additionally, in a Hot Ticket a Run List does not have manual or automatic page 
placement options: Instead, the pages are always placed automatically. 

The number of pages in the Run List will vary depending on whether or not you 
specified an expected number of pages, and whether or not there is an Impose 
Task Processor in the Production Plan. 

The different possibilities are as follows:
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 No Impose Task Processor in Production Plan + unspecified number of pages 
in the Run List: No options are required - the number of pages of the 
incoming document will be automatically used.

 No Impose Task Processor in Production Plan + specified number of pages in 
the Run List: The job will fail if the actual number of pages in the document 
does not match the specified number of pages in the Run List.

 Impose Task Processor in Production Plan + unspecified number of pages in 
the Run List: If there is an Impose Task Processor in the Plan, you cannot 
specify a number of pages: The page count is taken automatically from the 
Impose Task Processor. No options are required here. However, you can 
choose to accept documents with a different number of pages. You can also 
automatically center all pages, as described in “Run List Settings” on 
page 813.

Run List Settings

The Run List consists of basic settings and automatic page placement rules.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Basic Settings

You can specify the number of available placeholders, the page number of the 
first page, and the page placement options.
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Number of pages The number of pages determines the size of the Run List (i.e., the number of 
pages in the job). More precisely, this is the number of available placeholders for 
the pages that you want to process.

First page starts at The page number of the first page in the Run List. In most cases, this is ‘1’.

You could for instance change the page number of the first page when you only 
have to print a subset of a magazine or a book.

NOTE: This option only affects the page numbers in the Run List and the page 
placement rules. It does not affect how the pages are handled by the Imposition 
Task Processor. The first page position is always treated as page 1 in the 
imposition engine, no matter what the number is.

Multi-part jobs do not support this option. In multi-part jobs, the Run List always 
starts at 1, and is read-only.

Place pages in run list There are two ways to place the document’s pages in the Run List:

Manually: You can place the pages in the Run List by drag & drop. 

Automatically by file name:  You can have Apogee place the page automatically 
using document naming conventions. Once you select this option, the Automatic 
Page Placement pane appears. For more information see “Automatic Page Place-
ment” below.

Automatically by page label: Apogee places the page automatically according to 
the page labels.

Automatically appending all pages: All the pages are placed automatically and 
placeholders are appended to accommodate all the pages.

NOTE: Automatic page placement will not work for pages coming from the Public 
Page Store.

NOTE: A document cannot be placed in the Run List if the Run List position is 
already occupied by a document with a different name.

Page adjustments The following options are only available in jobs or Hot Tickets which include an 
Imposition Task Processor in the Production Plan.
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Center pages: Ensures that by default, each page has a page adjustment set to 
center the page. You can edit the settings, but clearing returns it to the default 
centering action.

Scale pages to fit: Scales the page proportionally in order to fit either the width 
or the height, depending on which dimension needs the least amount of zoom 
factor. This adds also a check box with Retain original aspect ratio to every 
placeholder in the Run List.

If you select one of these options or both of them, the job/Hot Ticket will 
automatically add Page Imposition Adjustments (PIA) to every Run List page of 
each job it creates. These automatic imposition adjustments are limited to page 
centering and scaled to fit only, and cannot be distinguished from manual 
adjustments. If you wish, you can edit or remove them.

These options are hidden in normal jobs (though you can still use the Page 
Imposition Adjustment commands), and in jobs with no imposition (since 
centering and scale pages only makes sense with imposition). 

NOTE: You should use the center option in the output device Image operation to 
center a page on the output size.

Revisions

These options determine how Apogee will deal with documents that are input 
with the same name as documents that are already in the Page Store. These are 
often newer versions (revisions) of the same document.

When the run list already
contains a previous

revision

Update the run list: Replaces the previous version in the Run List by the newer 
one, and starts reprocessing. This option is available for both automatic and 
manual page placement. The Page Store and Run List display a revision number 
after each document. The initial document has no revision number. Later 
revisions are numbered in order of arrival (or creation), starting with [1].

Update the run list only when pages are not approved in WebApproval: Does the 
same as the previous option if the pages have not yet been approved in the 
WebApproval application. Pages are not replaced if they have already been 
approved.

Do not update the run list: The previous version in the Run List is not automati-
cally replaced: However, you can replace it manually.

Notify: The previous version in the Run List is not automatically replaced: 
Instead Apogee sends a notification allowing you to decide what to do. All 
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processing on results that use pages from the previous revision of the document 
are put on hold until you respond to the notification.

When the run list does not
contain a previous revision

Do not notify: Apogee does nothing.

Notify: Apogee sends a notification informing you that a new revision has 
arrived. 

When you receive a new revision notification, you can choose to update the Run 
List to use the new document(s), ignore it and keep the previous one(s), or open 
the job for editing. This last option allows you to inspect the document and selec-
tively replace pages. For more information, refer to “Message Board” on 
page 83.

Automatic Page Placement

NOTE: These settings are only displayed when you choose to place pages in the 
Run List automatically. They do not apply to Hot Tickets (since the Run List is 
configured to match the number of pages and their order from the incoming 
document).

Automatic Page Placement
Rules

This is where you can specify page placement rules. These rules are displayed in 
the Automatic Page Placement table in the order that they are executed. You can 
change the order of the rules by the using the up and down arrows, or by 
dragging a rule up and down.

Apogee starts with the top rule. if no match is found, it proceeds with the 
following rule until a match is found. If Apogee:

 finds a match, it places the pages in the required placeholders.

 does not find a match, it sends a message to the Message Board.

In the Ignore Case check box, you specify whether the rules distinguish between 
lower case and upper case. If it is checked, no difference will be made between 
lower case and upper case.

NOTE: These rules only apply for automatic page placement. You are always 
notified if a document cannot be placed by any of the rules.

If a new document would
occupy a run list position

already occupied by a
document with a different

name

Update the run list: Replaces the previous version in the Run List by the newer 
one, and starts reprocessing. This option is available for both automatic and 
manual page placement. The Page Store and Run List display a revision number 
after each document. The initial document has no revision number. Later 
revisions are numbered in order of arrival (or creation), starting with [1].
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Update the run list only when pages are not approved in WebApproval: Does the 
same as the previous option if the pages have not yet been approved in the 
WebApproval application. Pages are not replaced if they have already been 
approved.

Do not update the run list: The previous version in the Run List is not automati-
cally replaced: However, you can replace it manually.

Notify: The previous version in the Run List is not automatically replaced: 
Instead Apogee sends a notification allowing you to decide what to do. All 
processing on results that use pages from the previous revision of the document 
are put on hold until you respond to the notification.

 To create rules

1 Do one of the following:

 In the Ticket Editor, select the Run List in your Production Plan.

 In the System Overview, access the Parameter Sets dialog box for the Run 
List Task Processor and create or edit the Parameter Set in which you 
want to create placement rules.

2 Select Automatically in the pages placement section of the Run List pane.

The Automatic Page Placement pane appears.

3 Click the New button to create a new placement rule.

The Placement Rule window appears.

4 Click the Variable button to insert variables. 

A drop-down list appears listing the variables that you can insert.

For more information the use of variables, see “Defining the Page Placement 
Rules” on page 819.

5 Insert the required variables.

6 Click OK to save the placement rule.

The placement rule appears in the Automatic Page Placement table.

7 In the Parameter Set: Click OK to save the Parameter Set.
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8 Close the Parameter Sets dialog box.

 To delete rules

1 Do one of the following:

 In the Ticket Editor, select the Run List in your Production Plan.

 In the System Overview, access the Parameter Sets dialog box for the Run 
List Task Processor and select the Parameter Set in which you want to 
delete placement rules and click the Edit button.

2 Select the placement rule that you want to delete in the Automatic Page 
Placement table and click the Delete button:

The placement rule is deleted.

3 In the Parameter Set: Click OK to save the Parameter Set.

4 Close the Parameter Sets dialog box.

 To edit rules

1 Do one of the following:

 In the Ticket Editor, select the Run List in your Production Plan.

 In the System Overview, access the Parameter Sets dialog box for the Run 
List Task Processor and select the Parameter Set in which you want to edit 
a placement rule and click the Edit button

2 Select the placement rule that you want to edit and click the Edit button.

The Placement Rule dialog box appears.

3 Make the required changes and click OK to save the placement rule.

For more information on the use of variables, see “Defining the Page Place-
ment Rules” on page 819.

4 In the Parameter Set, click OK to save the Parameter Set.

5 Close the Parameter Sets dialog box.
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Defining the Page Placement Rules

Page placement rules can be defined using wildcards, page number and 
document page placeholders, multiple positions, and variables.

Wildcards

A wildcard is a kind of ‘joker’ card, which you can insert in the document name 
when defining the placement rule. It ignores the part of the document name 
where you have inserted the wildcard.

There are two types of wildcards:

If you precede the wildcards by a “\”, the characters have their literal meaning. 

The following examples will clarify the use of wildcards:

Wildcard Meaning

? Matches any single character,

* Matches any string of one or more characters or no 
character at all.

Rule Matches No match

A?B ACB
AAB
ABB

AB
ABC

AB? ABC
ABL

AB
ABCD

AB* AB
ABC
ABCCCCC
ABCDFHG23

AAB
CAB

*AB AB
CAB
DGH235AAB

ABC
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Page Number Placeholders

Every placement rule has to contain a placeholder reference. There are the 
following types of placeholder references:

 <RLPAGE>: This matches a string of digits of any size.

 <RLPAGE@m>: This matches a string of digits of any size, offset from the 
first page by <m> page positions (you must replace ‘m’ by an offset number).

 <RLPAGE:n>: This matches a string of exactly n digits.

 <RLPAGE:n@m>: This matches a string of exactly n digits, offset from the 
first page by <m> page positions (you must replace ‘m’ by an offset number).

Placeholder references are placed between the angular brackets - < and >. 

NOTE: The <RLPAGE@m> offsets specify an offset that it added to the page 
number; the combined sum gives the final Run List position. This allows you to 
divide the Run List into different sections each using a different starting position. 
It is not possible to read an offset from the file name. 

The following examples clarify the use of these placeholder references:

A*B AB
AFB
AAAAghB
AGHTD4516B

ABC
CAB

AB\* AB* AB
ABC

ECO3-H?-*N ECO3-H1-aa2N
ECO3-H6-OO5N
ECO3-H0-002aN

ECO3-H-Nb2
ECO3-H555-1N

Rule Matches No match

Rule Matches Placeholder No match

ABC -<RLPAGE> ABC-1
ABC-01
ABC-12345

1
1
12345

ABC-P1
ABC-0,1

ABC-<RLPAGE:3> ABC-001
ABC-123

1
123

ABC-01
ABC-P1

A??C-<RLPAGE:2> ABCC-02
A2DC-25

2
25

ABC-1
ABBCD-P02
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Multiple Positions

In some rare cases, a page needs to be placed in several positions in the Run List. 
To do this, you need to specify two or more <RLPAGE> placeholders in the rule. 
However, make sure that the filename matches all placeholders, and that the 
number of pages in the document is less than the gap between two successive 
run list positions (e.g. a 10-page document cannot be positioned on position 1 
and 5).

For example:

Variables

A placement rule can also include one more variable. These variables refer to 
certain job attributes such as job name or customer name.

Variables can have a width modifier, through which the variable is replaced with 
the exact given amount of characters. If the document name does not corre-
spond to the amount of characters, there are two possibilities:

 If the content is longer than the specified amount, Apogee truncates it.

 If the content is shorter, Apogee pads the document name with “?”. 

See “General Examples” below for examples of the width modifier.

NOTE: The variable content cannot contain wildcards, placeholders or other 
variables, except for the “?” for padding the document name.

General examples For a job that has the following attributes:

 Job name: AB1234

Rule Matches Matches

<RLPAGE:2><RLPAGE:2> 6401 1 and 64

0203 2 and 3

1513 13 and 15

Variable Refers to... in the Administration Tab

$JOB The Job name field

$CUSTOMER The Customer name field

$ORDER The Order number field

$OPERATOR The Operator field
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 Order number: 0106G

 Customer: ECO3

Rule Document name Position

$ORDER-P<RLPAGE:2> 0106G-P01 1

$CUSTOMER*ORDER-?*-<RLPAGE:3> ECO30106G-A3-004 4

$CUSTOMER??-<RLPAGE:3>?? ECO35A-102AB 102

$CUSTOMER:3-<RLPAGE:3> ECO-023 23

$CUSTOMER:6-<RLPAGE:3> ECO3BE-023 23
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Thumbnail Extractor

The Thumbnail Extractor task processor creates thumbnails for bitmap files. 
This task process is used in the background for Sign & Display work and no 
settings need to be specified.
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TIFF Render

The TIFF Render Task Processor prepares TIFF or Digital Film for imaging on an 
imagesetter or platesetter. TIFF Render provides the equivalent functionality of 
the PDF/PS input flow in the Render Task Processor. TIFF Render accepts 1-bit 
or 8-bit raster data (TIFF or Digital Film) and outputs the re- screened raster data 
on an imagesetter, platesetter or proofer. 

TIFF Render performs preparation, separation, and screening of the raster data. 
Each of these processes have their individual settings. You can view these 
settings either when creating Parameter Sets, or from the Settings pane in the 
Plan tab of the Job Manager and the Ticket Editor.

 In the Prepare process, the job’s resolution can be adapted in accordance with 
the output device, and the 8-bit raster data can be resampled using one of the 
supplied color management profiles (CieLab, Generic, CMYK, etc.). For more 
information on these settings, see “TIFF Render Prepare Settings” on 
page 825.

 In the Separation process, a composite job is separated into different colors. 
On a press, each separated color has its own printing plate, each one printed 
in a different angle, producing the final printed color image. In traditional 
prepress, color images are separated into four layers corresponding to the 
four process colors (CMYK) used in process printing: cyan, magenta, yellow 
and black. For more information on these settings, see “PDF Render - Separa-
tion Settings” on page 788.

 In the Screening process, continuous tone files are converted into halftone 
dots. This means that the image is converted into a number of dots in the 
predefined separation colors. You can enhance the quality of the image by 
adjusting the dpi (dots per inch) and the lpi (lines per inch), also called ‘line 
frequency’. Every line consists of a number of dots. For more information on 
these settings, see “PDF Render - Screen Settings” on page 800.

Associated Resources

When you select the TIFF Render Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Content Profiles
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What is the difference between Render and TIFF Render Task Processors?

Whereas the Render Task Processor accepts PostScript or PDF input data (i.e., 
pre-rendered job data), the TIFF Render Task Processor accepts only raster input 
data. (i.e., rendered job data). For more information, see “PDF Render” on 
page 777.

TIFF Render Prepare Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

These settings handle both 1-bit and 8-bit data. The settings for these data 
formats should be adapted according to the output device you are using.

1-bit

1-bit settings only apply when re-sampling is to be used. If the TIFF Render Task 
Processor is used to drive a proofer only, these settings are ignored.

NOTE: Color management is not applied to 1-bit data.

Notify when resampling Select this check box if you want Apogee to send you a notification whenever it 
needs to resample the data (i.e. when the input and output resolutions do not 
match). The notification allows you to resample the data, or to edit the job. You 
can also provide new input using the matching resolution.
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For 1-bit to 1-bit resampling, only 2540 to 2400 or 120 to 1200 is supported. A 
notification is displayed if this option is enabled. 3 to 8, 8 to 3 and 8 to 8 resam-
pling is performed silently for any resolution.

8-bit

8-bit input is always resampled to match the resolution of the output device. 
However, here you can specify the resampling algorithm.

Resample Select one of the supplied resampling algorithms.

RGB, CMYK, Gray From input, with fallback: Takes the color profile from the input data if it has one. 
If not, it assumes the specified one.

Overrule with / Use: Uses the specified profile, regardless of the input.

Rendering intent From input, with fallback: Takes the Rendering Intent from the input data if it has 
one. If not, it assumes the specified one (default setting):

 Absolute Colorimetric

 Relative Colorimetric

 Perceptual

 Saturation

Overrule with / Use: Uses the specified Rendering Intent, regardless of the input.
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TIFF Render Separation Settings

The TIFF Render Separation settings are identical to the Render Separation 
settings. See “PDF Render - Separation Settings” on page 788.

TIFF Render Screen Settings

The TIFF Render Screen Proofer settings are identical to the Render Screen 
settings. See “PDF Render - Screen Settings” on page 800.
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Versioning

The Versioning feature allows you to create jobs which contain several different 
versions, typically for some or all of the text (for example, using different 
languages or prices), and to choose the optimal set of plates to be made. If, for 
example, you want to publish a brochure in six different languages, you can 
include the Versioning Task Processor in your Production Plan, and then print 
several different language versions of the brochure using a single job. The basic 
Production Plan is straightforward, using a Versioning Task Processor instead of 
a Run List Task Processor, allowing you to optimize the usage of plates to 
produce the versions. 

For example, your Production Plan could be as follows:

Hot Folder - Normalize - Versioning - Impose - Render - TIFF Imagesetter - Press 

No resources are associated with the Versioning Task Processor.

NOTE: The Versioning Task Processor is not available for Hot Tickets.

Versioning Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
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from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

The Versioning Task Processor settings are divided into four tabs:

 Run List: Allows you to specify how pages are input into the Run List.

 Versions: Allows you to define one or more versions within the job; includes 
the Create Versions assistant.

 Page Assembly: This is where you specify how Apogee should combine the 
different documents and specified layers within the job. 

 Plates: This is where you specify the optimal sets of plates that you want to 
output. 

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Run List

Here, you can specify the number of pages and number of the first page, and the 
page placement/adjustment and revision options.

Number of pages The number of pages determines the size of the Run List (i.e., the number of 
pages in the job). More precisely, this is the number of available placeholders for 
the pages that you want to process.

First page starts at The page number of the first page in the Run List. In most cases, this is ‘1’.

You could for instance change the page number of the first page when you only 
have to print a subset of a magazine or a book.

NOTE: This option only affects the page numbers in the Run List and the page 
placement rules. It does not affect how the pages are handled by the Imposition 
Task Processor. The first page position is always treated as page 1 in the 
imposition engine, no matter what the number is.
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Page Adjustments If you select one of these options or both of them, the job will automatically add 
Page Imposition Adjustments (PIA) to every Run List page of each job it creates. 
You can edit any resulting page adjustments individually.

Center pages: Ensures that by default, each page has a page adjustment set to 
center the page. You can edit the settings, but clearing returns it to the default 
centering action.

Scale pages to fit: Scales the page proportionally in order to fit either the width 
or the height, depending on which dimension needs the least amount of zoom 
factor. This adds also a check box with Retain original aspect ratio to every 
placeholder in the Run List.

For a summary of the page adjustment icons, refer to “Page Store / Run List 
Icons” on page 178.

NOTE: You should use the center option in the output device Image operation to 
center a page on the output size.

from old below:

Page Adjustments Center pages with page adjustments: If you select this option, the job will 
automatically add Page Imposition Adjustments (PIA) to every Run List page of 
each job it creates. You can edit any resulting page adjustments individually.

For a summary of the page adjustment icons, refer to “Page Store / Run List 
Icons” on page 178.

NOTE: You should use the center option in the output device Image operation to 
center a page on the output size.

from old above:

Automatic Page Placement These settings are only displayed when you choose to place pages in the Run List 
automatically. Versioning jobs always have a fixed number of pages.

Place pages automatically: If you choose this option Apogee will check 
documents as they arrive in the Page Store, and will attempt to place them in the 
Run List according to the file and layer name information you provide in the 
Page Assembly tab.

NOTE: Automatic page placement will not work for pages coming from a Public 
Page Store.
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NOTE: A document cannot be placed in the Run List if the Run List position is 
already occupied by a document with a different name.

Position Conflict: If a new document would occupy a run list position already 
occupied by a document with a different name: 

 Update the run list: Replaces the previous version in the Run List by the 
newer one, and starts reprocessing. This option is available for both 
automatic and manual page placement. The Page Store and Run List display 
a revision number after each document. The initial document has no revision 
number. Later revisions are numbered in order of arrival (or creation), 
starting with [1].

 Update the run list only when pages are not approved in WebApproval: Does 
the same as the previous option if the pages have not yet been approved in the 
WebApproval application. Pages are not replaced if they have already been 
approved.

 Do not update the run list: The previous version in the Run List is not 
automatically replaced: However, you can replace it manually.

 Notify: The previous version in the Run List is not automatically replaced: 
Instead Apogee sends a notification allowing you to decide what to do. All 
processing on results that use pages from the previous revision of the 
document are put on hold until you respond to the notification.

Revisions These options determine how Apogee will deal with documents that are input 
with the same name as documents that are already in the Page Store. These are 
often newer versions (revisions) of the same document.

When the run list already contains a previous revision: 

 Update the run list: Replaces the previous version in the Run List by the 
newer one, and starts reprocessing. This option is available for both 
automatic and manual page placement. The Page Store and Run List display 
a revision number after each document. The initial document has no revision 
number. Later revisions are numbered in order of arrival (or creation), 
starting with [1].

 Do not update the run list: The previous version in the Run List is not 
automatically replaced: However, you can replace it manually.

 Notify: The previous version in the Run List is not automatically replaced: 
Instead Apogee sends a notification allowing you to decide what to do. All 
processing on results that use pages from the previous revision of the 
document are put on hold until you respond to the notification.
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When the run list does not contain a previous revision: 

 Do not notify: Apogee does nothing.

 Notify: Apogee sends a notification informing you that a new revision has 
arrived. When you receive a new revision notification, you can choose to 
update the Run List to use the new document(s), ignore it and keep the 
previous one(s), or open the job for editing. This last option allows you to 
inspect the document and selectively replace pages. For more information, 
refer to “Message Board” on page 83.

Versions

This is where you specify the different output variations a job will produce by 
means of a versions table. You populate this table with versions (rows), the 
version elements on which they depend (columns), and the version element 
variations (cells) which are used to help select the right content combination for 
each version.

# Each version is automatically assigned a specific version number (V1, V2, etc.) 
and color code for easy identification.

Version You can enter a name for each version you create (e.g. French, German, Italian). 
These names must be unique. Each version has its own set of pages and output. 
A versioning job must always have at least one version.

Version Element You can add one or more version “elements” to add extra dimensions to your 
versioning job. Typically you would do this if you wanted to add extra categories 
for your incoming documents (to be able to include or exclude specific subsets 
of data in each version.

Copy Count You can add one or more version “elements” to add extra dimensions to your 
versioning job. Typically you would do this if you wanted to add extra categories 
for your incoming documents (to be able to include or exclude specific subsets 
of data in each version.

Version Management
buttons

You can enter the number of copies for each version.

Add: Click this button to add a new version. New versions are automatically 
assigned different colors and version numbers. You can rename them as 
required.
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Duplicate: Click this button to duplicate the selected version. The duplicated 
version is automatically assigned a different color and version number, and you 
can rename it as required. The Elements values are also copied.

Delete: Click this button to delete the selected version. You are asked to confirm 
this action, since deleting a version will also delete any associated Plates data.

Move up / Move down: Click this button to reposition the selected version within 
the Versions list.

Auto-fill: Click this cogwheel to automatically fill the version table either with 
the names of the PDF layers or the names of the documents in the Page Store. 
There are 2 options:

 Auto-fill with PDF layers

 Auto-fill with directory names

NOTE: This does not remove existing entries, nor change them. It only adds 
entries for those PDF layers or folder names that are not yet present in the table. 
If you have an existing setup and you want to start afresh, you should first delete 
the existing entries. 

Create Versions button When using the Versioning Task Processor in a production plan, you can click 
this button to open the Create Versions assistant. You can also use the Create 
Versions assistant when working in the Pages tab. See “Create Versions Assistant 
in the Page Store” on page 226.

Version Element
Management buttons

These work the same as the Version Management buttons.

Page Assembly

This is where you specify the layers that Apogee should use to assemble version 
pages together with name-matching rules to help populate the layout.

For each version, Apogee must produce a run of version pages. While the content 
of a version page is specific to its version, it will likely have elements in common 
with pages from other versions. Unlike in a conventional job where pages are 
delivered to the job ready-made in their final form, Apogee will combine 
separate ingredients to make version pages for you, such that common and 
version specific elements can be taken from a variety of sources.

The Page Assembly tab allows you to specify how many items of content are to 
be combined, by means of page assembly layers, each of which can hold a page 
or a PDF layer from a page. When the content in each assembly layer has become 
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known and available, Apogee will combine the layers in order into a single 
version page, that is, with the first layer rearmost and the last layer foremost.

Name The name of the Run List Layer. Each layer is equivalent to one or more columns 
in the Run List.

Range The range of pages in the Run List to which the current layer is applied. By 
default, this is all pages (1-$). You can specify ranges in the same way as you do 
for the Discard Action (see “Discard Settings” on page 315).

Depends on Choose the version elements that a layer depends on. A layer that does not 
depend on any version elements will produce one column in the Run List, and its 
contents will be assembled into all versions. A layer that depends on one version 
element will produce one column per variation used in the versions table.

PDF Layers The naming convention for the PDF layer.

Layers buttons A group of buttons is provided to manage your layers:

Add: Click this button to add a new layer and default range.

Duplicate: Click this button to duplicate the selected layer.

Delete: Click this button to delete the selected layer. You are asked to confirm 
this action, since deleting a layer will also delete any positioned Run List files.

Move up / Move down: Click this button to reposition the selected layer within 
the list.

Layer Name: Enter or change the layer name.

Depends on: Apogee displays one check box for each version element column in 
the version table. By checking one of these boxes, you are declaring that the layer 
will vary according to the variations in the corresponding column in the versions 
table. The Run List column corresponding to this layer will in turn be split into a 
group of columns - one for each variation that you see in the versions table for 
the version elements you selected.

Run List Range: Enter the range of pages in the Run List to which the current layer should 
be applied. You can use variables in this field (e.g. 1-$).

File Selection Allows you to enter a pattern to match files by name.

Variable button: allows you to include version elements and system variables in 
your patterns. Include a version element in your pattern if you have already 
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checked ‘Depends On’ for that element. Apogee will then direct matched files to 
be used in the appropriate layer variation.

<RLPAGE> position Absolute in Run List: Specifies an absolute position in the Run 
List with reference to the specified range.

<RLPAGE> position Relative to RL Page: Specifies a relative position in the Run 
List with reference to the specified range.

Content Selection PDF Layers: Allows you to specify a pattern to match PDF layers by name. Include 
a version element in your pattern to pick the PDF layer and place that matches 
the particular variation used by a version.

Plates

This is where you can define and fine-tune your output - the plate set. 

Plate-sharing is a well-established procedure when producing multiple versions 
of output. Significant savings are made by keeping plates on the press that do not 
differ between two consecutive versions of output, as well as providing the 
certainty that the reused plates are already proofed.

In the Plates tab you can declare which plates will be used to produce which 
versions. Apogee then knows which image data to combine to give you accurate 
proofs of each version. This is something that is not possible when using conven-
tional jobs to produce versions. Furthermore, you can adjust the plate setup in 
response to any problems arising during processing, such as plates that are held 
up by problem pages.

By default, Apogee prints the first version in full CMYK, and the remaining 
versions print in K only. 

Version Selection list Each version is automatically assigned a specific version number (V1, V2, etc.) 
and color code for easy identification. Here, you can select a specific version, in 
order to display only the plates that contribute to this version. You can also select 
all versions.

Plates cogwheel Group Plates check box: This option allows you to ungroup the plates. By default 
the C, M and Y plates are grouped together for easy management, but there may 
be situations where you want different settings (e.g., cyan + black). When 
selected, each plate is allocated its own on/off button and version selector. Note 
that grouping always keeps the K plate separate and groups the remainder of the 
process colors as a single set, regardless of the color model. Spot colors always 
have their own individual setup.
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Edit Press Sheet Versions: Opens the Version Setup dialog box. See “Version 
Setup Dialog Box” on page 836.

Signature table Signature: Indicates the signature number.

Version: Indicates the Version number and name.

Front: Indicates the front side of the signature.

Back: Indicates the back side of the signature.

All Click this button to select all plates (CMY and K) for printing.

K Only Click this button to select only the black (K) plates for printing.

None Click this button to deselect all plates for printing.

Restore to Default Click this button to restore the default settings for printing (i.e. first version 
prints in full CMYK, and the remaining versions print in K only).

Plate Count Indicates the number of plates that will be printed for each version.

Plate colors

Dark gray-colored plates: These plates will be output for printing.

White-colored plates: These plates will not be output, but they can be used for 
soft proofing.

Spot colors

You will see a separate column for each kept spot color used in the job.

Version Setup Dialog Box

The Version Setup dialog box enables you to control how multiple product 
versions are arranged on a press sheet to create a mix of versions across the avail-
able press sheets.
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 The Version Setup dialog box is opened by clicking the Edit Press Sheet 
Versions command in the cogwheel menu in the Plates tab of the Versioning 
task processor (production plan in edit mode).

Press Sheets The list of press sheets for the job with the name of the press sheet and the 
number of press sheet versions for this press sheet indicated on the right.

Press Sheet Versions The list of sheet versions for the selected press sheet. Initially the list is empty. 
Sheet versions (SV1, SV2, etc.) are added by clicking the Add button at the 
bottom of the list. Each sheet version has a number of slots that is equal to the 
number of fold sheets (or web deliverables) available on the press sheet. Product 
versions are assigned to the sheet versions by selecting a product version in the 
drop-down list or by dragging versions from the Versions column onto the slots 
on the press sheet. Drag a version onto a filled slot to replace the assigned 
version. The calculated run length is displayed under the sheet version indicator.

Versions The list of all the available product versions, color-coded with a version number 
(V1, V2, V3, etc.), the version name (e.g. English, French, German) and the 

1 Sheet versions with calculated run length
2 Version slots
3 Product versions with requested copy counts

2 31
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requested/actual copy count for each product version. Product versions need to 
be assigned to sheet versions and the following color scheme is used to indicate 
the status of the copy count:

 black: product version is assigned and requested copy count reached

 red: product version is not yet assigned

 blue: the actual copy count exceeds the requested copy count

Search box Case-insensitive search feature to filter the sheet versions list by assigned 
product versions.

Filter on selection Select this check box to filter the sheet versions list by the product version 
selected in the Version list.

Cogwheel menu Auto-Assign All: Creates a mix of versions for all press sheets that respects the 
requested copy counts with the lowest possible total run length.

Assign All in Order: Fills all the available folding sheets (or web deliverable slots) 
with subsequent versions.

Reset All (single-version sheets): Creates a version mix with each version 
assigned to its own single-version press sheet (default versioning behavior).

Clear Selected: Clears the version slots of the selected press sheet versions.

Clear All: Clears all version slots on all press sheet versions on all press sheets.
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CHAPTER
14 Output Task Processors

The Output Task Processors represent your output devices: imagesetters, plate-
setters and proofers. Apogee provides Task Processors for physical ECO3 output 
devices, as well as for Generic devices. You can also export your output to file in 
PDF or PostScript format.
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NOTE: A number of System Resources are associated with each Task Processor. 
For more information, see “Task Processor Resources” on page 939.
839



840 INTRODUCTION
Introduction

There are two basic types of Output Task Processors:

 Task Processors for physical output devices. Jobs which include these Task 
Processors produce real physical output on the selected devices. These 
output devices include imagesetters, platesetters and proofers.

 Task Processors for generic output devices. Generic output Task Processors 
process files that can be imaged on third-party physical devices. However, 
they are not directly connected to these devices. The following types of 
generic output devices may be available:

 TIFF Imagesetter: Provides an imagesetter engine emulation in TIFF 
format.

 TIFF Platesetter: Provides a platesetter engine emulation in TIFF format.

 TIFF Proofer: Provides a proofer device emulation in TIFF format.

 PS Imagesetter: Provides a raster file in Adobe’s PostScript format.

 PS Proofer (PS): Provides a proof file in Adobe’s PostScript format.

 PDF Proofer: Provides a proof file in Adobe’s PDF format.

 GDI Proofer: Provides a proof file to any Windows printer driver 
supporting GDI, that works RGB based. 

NOTE: Generic output 
devices can be used for 
testing or demo purposes. 
They can for instance 
emulate the timing of a 
physical device without 
producing real output files. 

The PS Imagesetter and PS Proofer both output a rendered TIFF file with a 
PostScript wrapper. This file can be sent to any device which supports PostScript 
input. The output can be done via a Windows spooler, via TCP/IP or to file. The 
PDF Proofer outputs a rendered TIFF file with a PDF wrapper. This file can be 
opened in Acrobat as a soft proof.

In addition to the above, there is also:

 The Export Task Processor which allows you to output your jobs to file in 
either PDF or PostScript format.

 The Public Page Store component (available only when you create a ticket 
based on a Public Page Store template). You can use this to create a central 
repository of input documents available to all jobs.

 The Remote Proofer Controller (RPC) Task Processor, which provides a low-
cost proofing solution for customers working off-site. 
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 A series of Link Task Processors, which allow you to output jobs to specific 
digital presses.

 The Display Task processor allows you to perform high-fidelity soft-proofing 
of rendered results.
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ECO3 Imagesetters and Platesetters

Apogee provides a Task Processor for each imagesetter and platesetter. The 
settings for each of those are grouped in two sets: Image Settings and Output 
Settings. They can be accessed by double-clicking the Parameter Sets icon for the 
selected Task Processor in the Resources pane of the System Overview window. 
For more information on the settings, see “Imagesetter and Platesetter Settings” 
on page 844.

Apogee supports the following ECO3 imagesetters and platesetters:

 Imagesetters:

NOTE: “Fill entire drum” ganging is not possible: Apogee only supports “Fill 
entire row”.

Accuset 800, Accuset 1000, Accuset 1000W, Accuset 1500, 
Accuset 1500W, Accuset 1500 Plus 
(use the standard AccuSet 1500 Task Processor for the latter).

Avantra 20, Avantra 25, Avantra 25E, Avantra 25S, Avantra 25XT, 
Avantra 30, Avantra 30E, Avantra 30S (use the standard Avantra 30 Task Pro-
cessor for the latter), 
Avantra 36, Avantra 36S, Avantra 44, Avantra 44E, Avantra 44S, Avantra 44XT.

Avanxis IV (SCSI)
Avanxis IV PIF.

Avanxis VIII, Avanxis XVIII (China only).
(use the standard Avanxis VIII for the latter: There is a configuration setting to 
switch to the XVIII version).

Phoenix 2000, 
Phoenix 2250, 
Phoenix News (Media Profile modes are not supported).

Epson X500-CTF,
Epson X900-CTF.
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 Platesetters:

Supported Third-party Platesetters

The following third-party platesetters are supported by Apogee:

 Trendsetter

NOTE: When you are creating your Production Plan, a Collect for Output action 
is automatically added to the Output Task Processor. For more information, see 
“Collect for Output” on page 323.

Associated Resources

When you select a physical ECO3 output device Task Processor in the System 
Overview, the following associated resource categories are displayed in the 
Resources pane:

Acento E, Acento LF, 
Acento S,
Acento II (PIF).

Avalon LF, Avalon LF VIOLET (use standard Avalon LF Task Processor),
Avalon VLF (50, 60, 70, 80 and 83),
Avalon N4
Avalon N16-50-E, N16-50-S, N16-50-XT,
Avalon N24-50-S/SD, N24-50-XT, N24-70-SD*, N24-70-XT,
Avalon N36-50-S/SD, N36-50-XT, N36-70-SD*, N36-70-XT,
Avalon N8-10-E, N8-10-S, N8-20-E, N8-20-S, N8-20-Sr, N8-50-E, N8-50-S, N8-
50-XT, N8-70-XT, N8-80-XT, N8-90-E/S/XT. 

Galileo Classic, Galileo S, Galileo Talant, 
Galileo Thermal, Galileo ThermalS, 
Galileo VS, Galileo VS4, Galileo VXT.

Palladio, Palladio E, Palladio 30 and 30 M (Manual) should all use the standard 
Palladio Task Processor (SCSI),
Palladio II (PIF),
Avalon V4.

XCalibur 45, XCalibur E, XCalibur E Elite, XCalibur LE, XCalibur S, XCalibur S 
Elite, XCalibur XT, XCalibur XT Elite, XCalibur XXT (should all use the standard 
X45 Task Processor).
XCalibur VLF 50, XCalibur VLF 60, XCalibur VLF 70, XCalibur VLF 80 (all avail-
able in E, S, XT, and XXT versions).

Magis DI 1600.
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 Media

 Halftone Screens

 Linearization Curves

 Output Sizes

 Borders

 Marks

Imagesetter and 
Platesetter 
Settings

The settings are very similar for all of the imagesetters and platesetters. 
However, some settings may slightly differ depending on the installed features 
on your output device.

The settings of imagesetters and platesetters are grouped in two groups: 

 Image Settings (for ECO3 Imagesetters and Platesetters)

 Output Settings (for ECO3 Imagesetters and Platesetters)

 To access the image or output settings

1 In the System Overview window, select the required Task Processor and 
double-click the Parameter Set icon in the Resources pane.

The Parameter Sets dialog box appears where you can see the icons for the 
Image Settings and the Output Settings.

2 Select one of them.

3 The Parameter Sets dialog box will at least list the initial settings and any 
additional Parameter Sets that have been created.

4 Double-click the Parameter Set that you want to edit or select it and click the 
Edit button.

Image Settings (for ECO3 Imagesetters and Platesetters)
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You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Select automatically from press

Select this check box to use an appropriate Parameter Set which is linked to the 
selected press using keywords. See “Parameter Set Lookup” on page 911. The 
settings are locked.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Separation Output and Order

Specify which separations should be output, and in which order. The initial sort 
order places the process colors on top, in the same order as specified by the job’s 
color space. Spot colors come after the process colors, sorted alphabetically. You 
can reorder the separation order with the Up and Down arrows or by dragging 
and dropping. 

These check boxes are only accessible when the ‘Application Decides’ check box 
is deselected in the Separation settings (Hot Tickets only). If ‘Application 
Decides’ is selected, you can make no changes to the separation output and 
order: This is then controlled by the settings of the input document (as gener-
ated by a front end application, such as Quark).

NOTE: Process colors are not listed if there is no Press Task Processor in the 
Production Plan or if you are editing a Parameter Set. 

Do not output empty
separations

Select this check box, if you do not want Apogee to output empty separations 
(i.e., separations which do not contain any information: there can always be 
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separations with only imposition marks). This option is not available for proofer 
devices or M-Press.

Copies Specify the number of copies to be printed.

Collated This option is not available for digital printers.

Image

Reading and Polarity You need to set the Reading and the Polarity yourself because Apogee does not 
know what media is used for the print job. The preview icon on the right dynam-
ically reflects the chosen state.

Reading: Determines the mirror setting of the image to be output:

 Right Reading

 Wrong Reading

Polarity: Select the required polarity:

 Positive

 Negative

NOTE: The Polarity options are only available for imagesetters. 

Orientation You can select one of the four standard orientations (0, 90, 180, 270). You can 
also select the Optimized option to have Apogee select a specific orientation to 
avoid as much medium waste as possible. If you selected the “Select Automati-
cally” check box, the Orientation is automatically set to “From Output Size”, and 
you will need to specify horizontal and vertical positioning.

Border You can select a predefined border from the drop-down list as defined in the 
Border Resource category for the imagesetter or platesetter. Select None if you 
do not want to have a border at all. 

You can enter text as a comment in the Slug Lines section. If the selected border 
contains the comment marks, the text will be printed. If not, it will be ignored. 

Output Size You can select a predefined output size. You either do this manually or have 
Apogee do it for you according to the page or sheet size and the border.

If you choose to do it manually, select one of the available output sizes, or select 
<Manual from input> or <Manual from media> from the drop-down list. 
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Manual from input: The output size is calculated from the page/sheet size and 
selected border in the pages of the incoming documents. The resulting Output 
Size is not displayed in the list.

Manual from media: The output size is calculated from the media size. This is only 
relevant if a specific media is selected.

Select Automatically Select this check box to activate automatic selection. Apogee will then take the 
orientation from the predefined Output Size - you cannot change this. 

Fallback Here, you can select a fallback output size in case the input has no output size 
specified.

Position This field is enabled only if you choose the Select Automatically check box. In the 
Position drop-down list, you can select how Apogee positions the image on the 
medium. You have two options:

 For Press: Select this option when you are printing imposed sheets that have 
to be positioned on a plate. The image to be printed is positioned on the press, 
taking into account punch calibration and press attributes.

 Manual: Select this option for manual positioning.

Position Image within
Output Size

Horizontal: Choose Center, or specify an offset in mm or inches.

Vertical: Choose Center, or specify an offset in mm or inches.

Horizontal positioning and
mirroring:

Center Press Sheet Anchor: Select to center a press sheet to the center of the plate 
relative to an anchor (for web printing and partial webs, which are smaller than 
the full width of the press). See “Web Production Schemes” on page 1150.

Mirror position for back of sheet: Select to place the back of an off-center press 
sheet in a mirrored position on the back of the sheet.

Position Output on Device Horizontal: Select Center to center the output horizontally

Vertical: Select Center to center the output vertically.

NOTE: Some marks are 
ignored when ganging is 
used. The device is designed 
in such a way that two rows 
are always separated by a 
small space. 

Apply Ganging: Select Apply Ganging if you want Apogee to position as many 
pages as possible on the medium. Apogee tiles successive pages across the width 
of the medium, starting in the lower left corner, on to the left side of the next row 
when the current row is filled. Apogee images each page immediately next to the 
other. The amount of space between the adjacent border depends on the 
selected border and the ‘Feed between row and pages’ value (Task Processor 
Configuration settings).
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This check box is enabled when <Manual from Input> or Manual Position is 
selected.

Across Jobs: When switched off, Apogee starts a new row before and after a job, 
even if it wastes media. This option is only activated when Apply Ganging is 
selected.

NOTE: The Ganging options are only available for imagesetters. 

Margins The Left and Right margins specify how much extra white space Apogee should 
add to the device margins. Preferably, this should be 0. If you have selected the 
For Press option from the Position drop-down list, this is 0 and cannot be 
changed. 

The margins before job and after job specifies an extra amount of media between 
two adjacent jobs.

Scale content Use scaling to scale the page content. This does not scale the border, but marks 
that are relative to the sheet are repositioned and not scaled. 

From the drop-down list, you can turn scaling off, or you can do the scaling 
manually by selecting Manual. This activates the following settings:

Width and Height You can specify the scaling percentages for width and height scaling. 

 For pages, Width and Height have their starting point in the lower left corner. 
Width goes along the bottom edge and Height along the left edge.

 For imposed flats, Width is along the gripper edge and Height along the side 
edge. 

Constrain proportions Select the Constrain Proportions option if you want to keep both values equal. 
Selecting this option will copy the horizontal scale value into the vertical scale 
field. 

Clip This option specifies what will happen if the image is bigger than the output size.

Clip image: Any areas of the image that fall outside the output size are clipped.

Notify: The job will fail with a user interaction notification. The notification 
specifies the image and output sizes, and provides a 'Clip and Continue' option.

Base imaging on This option specifies how the image is clipped but does not influence the output 
result.

Trimbox: The image is clipped to the Trimbox size.
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All content: The image is clipped to the Mediabox size.

Slug Lines

In this pane you can enter up to four comments that can be part of a border. 
These comments are held in the variables $COMMENT1, $COMMENT2, 
$COMMENT3 and $COMMENT4. 

Each comment can contain one or more variables such as $DATE or $COMPANY. 
The comment variables themselves, however, cannot be part of the comment. 

For example: Comment 1: Printed by PrintRite on $DATE for $COMPANY.

Output Settings (for ECO3 Imagesetters and Platesetters)

NOTE: The Output Settings 
icon is identical to the icon 
for the selected imagesetter 
or platesetter.

Some output settings vary depending on the installed features on your engine, 
e.g. punching. 

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Select automatically from press

Select this check box to use an appropriate Parameter Set which is linked to the 
selected press using keywords. See “Parameter Set Lookup” on page 911. The 
settings are locked.
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Media

In this pane, you can select a specific medium or a medium type from the drop-
down list.

Media Select Media, if you want to select a specific medium. In the second drop-down 
list, you can further specify the medium type and its size.

The second drop-down list displays all of the compatible media for the output 
device that you want to use, regardless of the size of the currently active tray. 

Media Type Select Media Type, if you want to select specific media type. You can do this in 
the second drop-down list. Apogee is then free to image on any loaded media of 
the selected type, whatever size it has. 

This option is especially useful when several devices are grouped. Apogee can 
choose the most suitable device to minimize media waste. 

Imaging

Resolution Select the required resolution from the drop-down list. 

NOTE: Changing the resolution might invalidate the selected halftone screen.

Expose You can select the Left & Right Margins and/or the Head-Punch Area check box 
if you want to expose the area all around the image. The preview icon on the 
right shows you the selected options.

Punch You can activate or deactivate the device punch. Depending on the device, you 
have the following options:

Head: The punching will be done at the top of the film. You can further specify 
the distance to the image. The value should be at least 12,19 mm.

Tail: The punching will be done at the bottom of the film.

Side punch: The punching will be done on the right side of the film (e.g. 
Phoenix).

NOTE: Other punch options may be available, depending on the output engine.

The preview icon reflects the selected punch options. 

Compression type
(Platesetters)

Select the compression type from the drop-down list:
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 No Compression

 LZW Compression

 CCITT mod. Huffman RLE

 CCITT Group 3 Fax Encoding

 CCITT Group 4 Fax Encoding

 Macintosh Packbits RLE

 ZIP/Flate Compression

Emulating (Platesetters) Select the type of device that you want to emulate: 

 Drum Device: In an internal drum recorder, the film is mounted to the inside 
surface of a cylindrical drum. While the drum and film remain stationary, the 
laser (or optics transmitting the laser beam) spin around the axis of the drum 
to image the film. In an external drum recorder, film is mounted on the 
outside surface of a cylindrical drum. A laser is mounted so that its beam aims 
at the film wrapped around the drum. In this type of recorder, the laser 
remains stationary while the drum spins around its axis, exposing the film to 
the laser beam.

 Capstan Device: A capstan device feeds media from a roll installed in a supply 
cassette, past the laser, and into a takeup cassette or online processor. To 
feed the media, a set of rubber rollers pulls the media out of the supply 
cassette and another set of rubber rollers pushes the media into the takeup 
cassette.

File Parameters (Platesetters)

Create Choose one of the options from the list. The variables in the File name field are 
dynamically updated in accordance with your selection:

 Custom

 Single file for all sheets

 Single file per sheet

 Single file per side

 Single file per separation

 Single file per book signature
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NOTE: The Create setting determines the grouping of the output (group by page, 
job, etc.). This is also the case if Spooler is selected in the Configuration settings.

Save files in Choose either of the options. The variables in the File name field are dynamically 
updated in accordance with your selection:

 Directory hierarchy: Files are stored in sub-directories, in a hierarchical 
directory structure (see example below).

 Same directory: All files are stored in the same directory, using extended file 
names for identification.

File name This field is enabled if you select ‘Custom’ from the Create list. You can then set 
up a custom folder structure in which to store your output files. For example, you 
could enter the following variable string:

$ORDER\$JOB\$PAGE\$SEPARATION

Export directory Specify the directory in which you want to store the output data. You can use the 
Browse button to locate the directory.

File extension Specify a file extension for the separations.

Options Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Store separations in multi channel TIFF files: Select this check box to store separa-
tions in multi channel TIFF files (not applicable for Gray).

Generate STR file: Select this check box to generate the STR file.

Replace existing files: If a file with the same name already exists in the specified 
export directory, then the file is automatically replaced by the newly exported 
file.

Leave existing files, add sequence number to new file names: If a file with the 
same name already exists in the specified export directory, then a revision 
number is added to the name of the newly exported file.

Post-process files with
script

Select this check box if you want to process the files with a certain script file. You 
can specify the script in the field next to the check box. You can use the Browse 
button to locate the required script file.

Script options Here, you can specify command options.
Apogee Reference Guide



 

14 OUTPUT TASK PROCESSORS 853
Disable output This option disables any output possibility. The Generic Imagesetter will then 
act as a Null device suitable for training or testing purposes.

Image Quality

You can select the linearization curve. You can either select it manually from the 
drop-down list or have it selected automatically through the Auto-select from 
map option. Apogee will select the linearization curve according to the look-up 
rules of the Linearization Resource Category. 

For more information on Linearization Curves, see “Linearization Curves” on 
page 1033 and on Auto-Select Maps, see “Using Resource Auto-Select Maps” on 
page 1159.
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Proofers

Apogee provides a Task Processor for each supported proofer. The settings for 
each of those are grouped in two sets: Image Settings and Output Settings. They 
can be accessed by double-clicking the Parameter Sets icon for the selected Task 
Processor in the Resources pane of the System Overview window.

The ECO3 Proofer Devices

The following proofer devices are supported by Apogee:

Proofer Device

4D GrandSherpa 50

4D GrandSherpa 64

4D GrandSherpaMatic

4D Sherpa2

4DA GrandSherpa 50

4DA GrandSherpa 64

4DA GrandSherpaMatic

4DA Sherpa2

6D GrandSherpa 50

6D GrandSherpa 64

6D Sherpa 24 = Epson 7000

6D Sherpa 24M = Epson 7600 (6 Colors Dye inks)

6D Sherpa 43

6D Sherpa 44M = Epson 9600 (6 Colors Dye inks)

6D Sherpa 54

6D Sherpa 62

6D SherpaMatic

6DA Sherpa 43

6DA Sherpa 54

6DA Sherpa 62

6DA SherpaMatic

7DA GrandSherpa 50

7DA GrandSherpa 64

7DA GrandSherpaMatic

7P Sherpa 24M = Epson 7600 (7 Colors Pigment inks)
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7P Sherpa 44M = Epson 9600 (7 Colors Pigment inks)

4P Epson 4400 (not for contract proofing)

4P Epson 7400 (not for contract proofing)

4P Epson 9400 (not for contract proofing)

4P Epson T3000

4P Epson T3200

4P Epson T3405

4P Epson T5000

4P Epson T5200

4P Epson T7000

4P Epson T7200

5P Epson T7700

6D Epson 10000

7P Epson 4000

8P Epson 4800

8P Epson 4880

8P Epson 7800

8P Epson 7880

8P Epson 7890

8P Epson 9800

8P Epson 9880

8P Epson 9890

8P Epson 11880

8P Epson P6000

8P Epson P8000

9P Epson P10000

9P Epson P20000

10P Epson 4900

10P Epson 7900

10P Epson 9900

10P Epson P5000

10P Epson P5000-Violet

10P Epson P7000

10P Epson P7000-Violet

10P Epson P9000

10P Epson P9000-Violet

11P Epson P7500

11P Epson P9500

Proofer Device
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ECO3’s QMS provides a quality tool for ensuring identical tonal behavior over 
time and between multiple proofers. QMS is a client application that directly 
connects to Apogee. User-friendly wizards can be used to calibrate and create 
optimized profiles, as well as check existing calibrations. The QMS database 
tracks all measurements over time, making it easy to verify past achievements.

Associated Resources

When you select a proofer Task Processor in the System Overview, the following 
associated resource categories are displayed in the Resources pane:

 Media, About Task Processor Resources, Marks, Profiles, Color Books

Proofer Image Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

4D HP 750

4D HP 1050

4D HP 2500

4D HP 3500

4D HP 5500_42

4D HP 5500_60

6D HP 30

6D HP 130

10P HPZ3100

10P HPZ3200

Proofer Device
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When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Separation Output and Order

Specify which separations should be output, and in which order. The initial sort 
order places the process colors on top, in the same order as specified by the job’s 
color space. Spot colors come after the process colors, sorted alphabetically. You 
can reorder the separation order with the Up and Down arrows or by dragging 
and dropping. 

These check boxes are only accessible when the ‘Application Decides’ check box 
is deselected in the Separation settings (Hot Tickets only). If ‘Application 
Decides’ is selected, you can make no changes to the separation output and 
order: This is then controlled by the settings of the input document (as gener-
ated by a front end application, such as Quark).

NOTE: Process colors are not listed if there is no Press Task Processor in the 
Production Plan or if you are editing a Parameter Set. 

Copies Specify the number of copies to be printed. This option is not available for the 
Generic TIFF/PS/PDF Proofers.

Collated This option is not available for the Generic TIFF/PS/PDF Proofers.

Image

The Image pane is similar to the one in the Image Settings of the imagesetter and 
the platesetter. 

Reading You need to set the Reading yourself because Apogee does not know what media 
is used for the print job. The preview icon on the right dynamically reflects the 
chosen state.

Reading: Determines the mirror setting of the image to be output:

 Right Reading

 Wrong Reading

Orientation You can select one of the four standard orientations (0, 90, 180, 270). You can 
also select the Optimized option to have Apogee select a specific orientation to 
avoid as much medium waste as possible. If you selected the “Select Automati-
cally” check box, the Orientation is automatically set to “From Output Size”, and 
you will need to specify horizontal and vertical positioning.
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Border Select the required predefined border from the drop-down list as defined in the 
Border Resource category.

You can enter text as a comment in the Slug Lines section. If the selected border 
contains the comment marks, the text will be printed. If not, it will be ignored.

Output Size Select the appropriate output size from the drop-down list. This can be a fixed 
size (A4, Letter, etc.) or the size can be set to depend on the input, part or media 
(Manual from input, Manual from part, Manual from media). For example, 
Output from part is useful for WebApproval jobs.

Select Automatically: Select this check box to have Apogee automatically select 
the output size. In this case, the Orientation is automatically set to “From Output 
Size”, and you will need to specify horizontal and vertical positioning.

Fallback Here, you can select a fallback output size (Width and Height) in case the input 
has no output size specified.

Position Image within
Output Size

Horizontal: Choose Center, or specify an offset in mms.

Vertical: Choose Center, or specify an offset in mms.

Position Output on Device Center output size horizontal on device: Select this check box for horizontal 
centering.

Apply Ganging: Select this check box if you want to apply ganging. This check box 
is only enabled when Manual is selected for Position.

Across Jobs: When switched off, Apogee starts a new row before and after a job, 
even if it wastes media. This option is only activated when Apply Ganging is 
selected.

Margins The Left and Right margins specify how much extra white space Apogee should 
add to the device margins. Preferably, this should be 0. If you have selected the 
For Press option from the Position drop-down list, this is 0 and cannot be 
changed. 

The margins before job and after job specifies an extra amount of media between 
two adjacent jobs. 

Scale content From the drop-down list, you can activate scaling to scale the page content. This 
does not scale the border, but marks that are relative to the sheet are reposi-
tioned and not scaled. 

You can select different scaling modes from the drop-down list.
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Off: If you do not want apply scaling, select Off from the drop-down list. The 
settings will be greyed out. 

Size to fit: This option proportionally scales the images up or down to fit the 
media size. 

Enlarge to fit: This option proportionally scales the image up to fit the media size. 
When the image is larger than the media size, it will not scale up.

Shrink to fit: This option proportionally scales the image down to fit the media 
size. When the image is smaller than the media size, it will not scale down.

NOTE: The automatic scaling options are only available when an output size or 
the <manual from media> option is selected. It is not available when the 
<manual from input> option is selected.

Manual: This option enables the Width and Height scale fields. 

You can specify the scaling percentages for width and height scaling. 

 For pages, Width and Height have their starting point in the lower left corner. 
Width goes along the bottom edge and Height along the left edge.

 For imposed flats, Width is along the gripper edge and Height along the side 
edge. 

Constrain proportions: Select the Constrain Proportions option if you want to 
keep both values equal. Selecting this option will copy the horizontal scale value 
into the vertical scale field. 

Clip This option specifies what will happen if the image is bigger than the output size.

Clip image: Any areas of the image that fall outside the output size are clipped.

Notify: The job will fail with a user interaction notification. The notification 
specifies the image and output sizes, and provides a 'Clip and Continue' option.

Base imaging on This option specifies how the image is clipped but does not influence the output 
result.

Trimbox: The image is clipped to the Trimbox size.

All content (page, content, marks, border, ...): The image is clipped to the 
Mediabox size.
Apogee Reference Guide



860 PROOFERS
Rule-up

You can have a proofer print a rule-up. These are lines that correspond with the 
expected page positions on the template and the actual crop box from the pages.

Pages You can print a rule-up for:

 Artbox

 Trimbox

 Bleedbox

 Mediabox

Imposition You can print a rule-up for:

 Press Sheet

 Expected Page Size

Output You can print a rule-up for:

 Output Size

Die/CAD  Design lines: Select the check mark to choose a Line Appearance Set from the 
list or click the arrow to open the Line Appearance editor. See “Finishing 
Hub” on page 993.

For each of the above, you can select the color from the drop-down list (Red, 
Green, Blue, etc.), and a point size for the lines (0,25 pts, 0.50 pts, 0.75 pts 
or1.00 pts). You can also specify whether you want a dashed or a solid line. 

NOTE: You can only print a rule-up if you use an Impose Task Processor in your 
Production Plan.

Slug Lines

In this pane you can enter up to four comments that can be part of a border. 
These comments are held in the variables $COMMENT1, $COMMENT2, 
$COMMENT3 and $COMMENT4. 

Each comment can contain one or more variables such as $DATE or $COMPANY. 
The comment variables themselves, however, cannot be part of the comment. 

For example: Comment 1: Printed by PrintRite on $DATE for $COMPANY.
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Proofer Output Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Media

In this pane, you can select a specific medium, medium type or tray from the 
drop-down list.

Media Select Media, if you want to select a specific medium. In the second drop-down 
list, you can further specify the medium type and its size.

The second drop-down list displays all of the compatible media for the output 
device that you want to use, regardless of the size of the currently active tray. 

Media Type Select Media Type, if you want to select specific media type. You can do this in 
the second drop-down list. Apogee is then free to image on any loaded media of 
the selected type, whatever size it has. 

This option is especially useful when several devices are grouped. Apogee can 
choose the most suitable device to minimize media waste. 

Tray You can choose either of the following:

 Manual sheet
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 Roll

Image Quality

Quality Map Choose the quality map to be used for printing. The available quality maps 
depend on the selected device.

Ink Table Choose the ink table to be used for printing. The available ink tables depend on 
the selected device. Select the Auto-select from map check box, if you want 
Apogee to select an ink table for you according to the job settings. In this case, 
the Ink Table selection list is disabled.

Proofer Profile The Proofer Profile drop-down list shows all of the available profiles for the 
selected device. Select the Auto-select from map check box, if you want Apogee 
to select a proofer profile for you according to the job settings. In this case, the 
Proofer Profile selection list is disabled.

Rendering Intent There are 4 different Rendering Intents available, although not all profiles 
contain Look Up tables (LUTs) for each of the 4. Usually there are only 3 repre-
sented. In this case often a duplicate of one Look Up table is used for missing 
Render Intent LUT. The Rendering Intent defines the way the source colors are 
mapped to the destination space.

The following rendering intent options are available:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the 2 profiles is preserved. White of 
source color space is simulated with CMYK values from the destination color 
space. The consequence is that every white object/area is covered with certain 
ink amounts.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.

Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy
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NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.

Advanced CMM Recent developments in the Color Management engine offer ‘Smart CMM’, 
which provides better blending of converted spot colors. However, this comes at 
a small cost: it is a little slower.

Process Colors Don’t color manage: Select this option to disable color management.

Color manage from Press to Proofer profile: Select this option to color manage 
from Press to Proofer profiles.

Color manage using Device Link Profile: Select this option to color manage using a 
Device Link Profile.

NOTE: Apogee dynamically creates a Device Link Profile when an optimized 
proofer profile is used with Advanced CMM enabled.

 Device Link: Select a Device Link Profile.

 Exception: You can choose here whether or not you want Apogee to take into 
account any color exceptions. For more information see “Profiles” on 
page 1130.

 None: Apogee will not take into account any color exceptions.

 Default Exception Dictionary: Apogee will take into account color excep-
tions from the default color exception dictionary.

Auto-select Select an Auto-select check box if you want Apogee to automatically make selec-
tions for you according to the job settings. 

Apply black point
compensation

Select this check box to compensate the loss of range on the dark tones. Use 
when the proofer’s gamut in the dark tones is smaller than that of the press. It is 
disabled, if the option Don’t color manage is selected for Process Colors.

Spot Colors Accurate spot color mixing: In this enhanced mode, spot color visualization is 
superior to the standard color-managed mode. You can choose from the 
following:

 Off
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 Max. 2 colors

 Max. 3 colors

deltaE calculation Select the method to calculate the deltaE:

 deltaE*ab: Use the ΔΕab method, the first internationally endorsed color 
difference formula as published by the CIE Committee. This is the default 
value for reasons of compatibility.

 deltaE*00: Use the ΔΕ00 method, a revision of the ΔΕ94 formula. ΔΕ00 is the 
industry standard formula to be used.

 default: Use the default method.

White point Use Press Paper White: Pantone\spot color inks are transparent and appear 
differently when printed on different substrates. Normally, you should select 
this option when creating a proof which will be used by the printer to print a spot 
color on the Press (when the simulated spot color on proof needs to resemble the 
final printed result). In this case, the paper white from the press profile is used 
in the color calculation.

If this option is not selected, the measured paper white of the color book is used 
in the calculation of the spot colors. The option should therefore be deselected 
when the simulated spot colors on the proof are compared to the color book 
reference prints (with a measurement device, for example).

NOTE: A spectral press profile is required for this option.

Simulate Paper Stock You can simulate two aspects of the Paper Stock used for the job:

 White Point: Select to simulate the color of the paper stock on the proof.

 Texture: Select this check box to apply the texture (fiber and grain of the 
paper) specified in the Paper Stock resource. If no texture is selected for 
the Paper Stock, it will not be simulated.

Dot for dot Defines how to proof the screening dots from the main result. You can also 
enable Close Loop Control or let the system select a CLC profile automatically 
(Auto-select).

NOTE: The Dot for dot option requires Digital Film Proof in the flow.
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TIFF/PS Imagesetter

The TIFF and PS Imagesetters emulate third-party physical imagesetters, and 
have two groups of settings:

 TIFF/PS Imagesetter Image Settings

 TIFF/PS Imagesetter Output Settings

NOTE: When you are 
creating your Production 
Plan, a Collect for Output 
action is automatically 
added to the Output Task 
Processor. For more 
information, see “Collect for 
Output” on page 323.

Why is there a TIFF Imagesetter and a PS Imagesetter?

 The TIFF Imagesetter provides an imagesetter engine emulation in TIFF 
format.

 The PS Imagesetter provides a raster file in Adobe’s PostScript format (a 
rendered TIFF file with a PostScript wrapper). This file can be sent to any 
device which supports PostScript input. The output can be done via a 
Windows spooler, via TCP/IP or to file. 

Associated Resources

When you select the TIFF or PS Imagesetter Task Processor in the System 
Overview, the following associated resource categories are displayed in the 
Resources pane:

 Media, Halftone Screens, Linearization Curves, Output Sizes, Borders, 
Marks, PostScript Headers (for the PS Imagesetter only)

TIFF/PS Imagesetter Image Settings

The Image Settings of the TIFF/PS Imagesetter are the same as for most image-
setters. For more information, see “Image Settings (for ECO3 Imagesetters and 
Platesetters)” on page 844.

TIFF/PS Imagesetter Output Settings
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The Output Settings group all of the output settings for the TIFF/PS Imagesetter 
Task Processor.

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Media

In this pane, you can select a specific medium or a medium type from the drop-
down list.

Media Select Media, if you want to select a specific medium. In the second drop-down 
list, you can further specify the medium type and its size.

The second drop-down list displays all of the compatible media for the output 
device that you want to use, regardless of the size of the currently active tray. 

Media Type Select Media Type, if you want to select specific media type. You can do this in 
the second drop-down list. Apogee is then free to image on any loaded media of 
the selected type, whatever size it has. 

This option is especially useful when several devices are grouped. Apogee can 
choose the most suitable device to minimize media waste. 

Imaging

Resolution Specify the Resolution in dpi for Width and Height.

Compression type Select the compression type from the drop-down list:

 No Compression
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 LZW Compression

 CCITT mod. Huffman REL

 CCITT Group 3 Fax Encoding

 CCITT Group 4 Fax Encoding

 Macintosh Packbits RLE

 ZIP/Flate Compression

Emulating Select the type of device that you want to emulate (TIFF Imagesetter only): 

 Drum Device: In an internal drum recorder, the film is mounted to the inside 
surface of a cylindrical drum. While the drum and film remain stationary, the 
laser (or optics transmitting the laser beam) spin around the axis of the drum 
to image the film. In an external drum recorder, film is mounted on the 
outside surface of a cylindrical drum. A laser is mounted so that its beam aims 
at the film wrapped around the drum. In this type of recorder, the laser 
remains stationary while the drum spins around its axis, exposing the film to 
the laser beam.

 Capstan Device: A capstan device feeds media from a roll installed in a supply 
cassette, past the laser, and into a takeup cassette or online processor. To 
feed the media, a set of rubber rollers pulls the media out of the supply 
cassette and another set of rubber rollers pushes the media into the takeup 
cassette.

Encoding type Select your data encoding format (PS Imagesetter only):

 Binary

 ASCII Hex

 ASCII-85

PostScript header Optionally select a PostScript header, if this resource is available (PS Image-
setter only).

Create Choose one of the options from the list. The variables in the File name field are 
dynamically updated in accordance with your selection:

 Custom

 Single file for all sheets

 Single file per sheet
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 Single file per side

 Single file per separation

NOTE: The Create setting determines the grouping of the output (group by page, 
job, etc.). This is also the case if Spooler is selected in the Configuration settings.

Save files in Choose either of the options. The variables in the File name field are dynamically 
updated in accordance with your selection:

 Directory hierarchy: Files are stored in sub-directories, in a hierarchical 
directory structure (see example below).

 Same directory: All files are stored in the same directory, using extended file 
names for identification.

File name This field is enabled if you select ‘Custom’ from the Create list. You can then set 
up a custom folder structure in which to store your output files. For example, you 
could enter the following variable string:

$ORDER\$JOB\$PAGE\$SEPARATION

Export directory Specify the directory in which you want to store the output data. You can use the 
Browse button to locate the directory.

File extension Specify a file extension for the separations.

Options Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Replace existing files: If a file with the same name already exists in the specified 
export directory, then the file is automatically replaced by the newly exported 
file.

Leave existing files, add sequence number to new file names: If a file with the 
same name already exists in the specified export directory, then a revision 
number is added to the name of the newly exported file.

Post-process files with
script

Select this check box if you want to process the files with a certain script file. You 
can specify the script in the field next to the check box. You can use the Browse 
button to locate the required script file.

Script options Here, you can specify command options.
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Disable output This option disables any output possibility. The Generic Imagesetter will then 
act as a Null device suitable for training or testing purposes.

Image Quality

Bits per pixel 1: Detailed 1-bit high resolution data (each raster point is represented by a single 
display pixel).

8: 8-bit contone data.

Linearization Select the Linearization Curve to be applied from the drop-down list. 

Select the Auto-select from map check box, if you want Apogee to select it for you 
according to the job settings.
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TIFF Platesetter

The TIFF Platesetter emulates a third-party physical platesetter, in TIFF format.

There are two groups of settings:

 TIFF Platesetter Image Settings

 TIFF Platesetter Output Settings

NOTE: When you are creating your Production Plan, a Collect for Output action 
is automatically added to the Output Task Processor. For more information, see 
“Collect for Output” on page 323.

Associated Resources

When you select the TIFF Platesetter Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Media

 Halftone Screens

 Linearization Curves

 Output Sizes

 Borders

 Marks

TIFF Platesetter Image Settings

These are the same as the ECO3 Platesetter Image settings (see “Image Settings 
(for ECO3 Imagesetters and Platesetters)” on page 844).
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TIFF Platesetter Output Settings

These are the same as the TIFF/PS Imagesetter Output settings (see “TIFF/PS 
Imagesetter Output Settings” on page 865).
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TIFF/PS/PDF Proofer

The TIFF/PS/PDF Proofer simulates a real proofer for testing or demo purposes.

Why are there three types of Proofer?

 TIFF Proofer: Provides a proofer device emulation in TIFF format.

NOTE: These generic output 
devices can be used to 
emulate the timing of a 
physical device without 
producing real output files. 

 PDF Proofer: Provides a proof file in Adobe’s PDF format. It outputs a 
rendered TIFF file with a PDF wrapper. This file can be opened in Acrobat as 
a soft proof.

 PS Proofer: Provides a proof file in Adobe’s PostScript format. It outputs a 
rendered TIFF file with a PostScript wrapper. This file can be sent to any 
device which supports PostScript input. The output can be done via a 
Windows spooler, via TCP/IP or to file.

The TIFF/PS/PDF Proofer Task Processor consists of two groups of settings:

 TIFF/PS/PDF Proofer Image Settings

 TIFF/PS/PDF Proofer Output Settings

NOTE: When you are creating your Production Plan, a Collect for Output action 
is automatically added to the Output Task Processor. For more information, see 
“Collect for Output” on page 323.

Associated Resources

When you select the TIFF/PS/PDF Proofer Task Processor in the System 
Overview, the following associated resource categories are displayed in the 
Resources pane:

 Media

 Output Sizes

 Borders

 Marks
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 Profiles

 Color Books

 Contrast Adjustments

TIFF/PS/PDF Proofer Image Settings

These are the same as the ECO3 Proofer Image settings (see “Proofer Image 
Settings” on page 856).

TIFF/PS/PDF Proofer Output Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Media

In this pane, you can select a specific medium or a medium type from the drop-
down list.
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Media Select Media, if you want to select a specific medium. In the second drop-down 
list, you can further specify the medium type and its size.

The second drop-down list displays all of the compatible media for the output 
device that you want to use, regardless of the size of the currently active tray. 

Media Type Select Media Type, if you want to select specific media type. You can do this in 
the second drop-down list. Apogee is then free to image on any loaded media of 
the selected type, whatever size it has. 

This option is especially useful when several devices are grouped. Apogee can 
choose the most suitable device to minimize media waste. 

Imaging

Compression type Select the compression type from the drop-down list:

 No Compression

 LZW Compression

 JPEG Compression (various qualities)

 Runlength Encoding (Packbits)

Emulating Select the type of device that you want to emulate (TIFF Proofers only): 

 Drum Device: In an internal drum recorder, the film is mounted to the inside 
surface of a cylindrical drum. While the drum and film remain stationary, the 
laser (or optics transmitting the laser beam) spin around the axis of the drum 
to image the film. In an external drum recorder, film is mounted on the 
outside surface of a cylindrical drum. A laser is mounted so that its beam aims 
at the film wrapped around the drum. In this type of recorder, the laser 
remains stationary while the drum spins around its axis, exposing the film to 
the laser beam.

 Capstan Device: A capstan device feeds media from a roll installed in a supply 
cassette, past the laser, and into a takeup cassette or online processor. To 
feed the media, a set of rubber rollers pulls the media out of the supply 
cassette and another set of rubber rollers pushes the media into the takeup 
cassette.

Encoding type Select your data encoding format (PS and PDF Proofers only):

 Binary

 ASCII Hex
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 ASCII-85

PostScript header Optionally select a PostScript header, if this resource is available (PS Proofers 
only).

Create Choose one of the options from the list. The variables in the File name field are 
dynamically updated in accordance with your selection:

 Custom

 Single file for all sheets

 Single file per sheet

 Single file per side

 Single file per separation

NOTE: The Create setting determines the grouping of the output (group by page, 
job, etc). This is also the case if Spooler is selected in the Configuration settings.

Save files in Choose either of the options. The variables in the File name field are dynamically 
updated in accordance with your selection:

 Directory hierarchy: Files are stored in sub-directories, in a hierarchical 
directory structure (see example below).

 Same directory: All files are stored in the same directory, using extended file 
names for identification.

File name This field is enabled if you select ‘Custom’ from the Create list. You can then set 
up a custom folder structure in which to store your output files. For example, you 
could enter the following variable string:

$ORDER\$JOB\$PAGE\$SEPARATION
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Export directory Specify the directory in which you want to store the output data. You can use the 
Browse button to locate the directory. By default, these are:

 PDF Proofer: \\$COMPUTER\ProoferPDFRoot\$DEVICE\

 TIFF Proofer: \\$COMPUTER\ProoferTIFFRoot\$DEVICE\

 PS Proofer: \\$COMPUTER\ProoferPSRoot\$DEVICE\

File extension Specify the format of the result that you want to export (pdf, tif, ps).

Options Store separations in multi channel TIFF files: Select this check box to store separa-
tions in multi channel TIFF files (not applicable for Gray).

Generate STR file: Select this check box to generate the STR file.

Replace existing files: If a file with the same name already exists in the specified 
export directory, then the file is automatically replaced by the newly exported 
file.
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Leave existing files, add sequence number to new file names: If a file with the 
same name already exists in the specified export directory, then a revision 
number is added to the name of the newly exported file.

Post-process files with
script

Select this check box if you want to process the files with a certain script file. You 
can specify the script in the field next to the check box. You can use the Browse 
button to locate the required script file.

Script options Here, you can specify command options.

Disable output This option disables any output possibility. The Proofer will then act as a Null 
device suitable for training or testing purposes.

Image Quality

Bits per pixel (TIFF Proofer only)

1: Detailed 1-bit high resolution data (each raster point is represented by a single 
display pixel).

8: 8-bit contone data.

Quality Map Choose the quality map to be used for printing. The available quality maps 
depend on the selected device.

Proofer Profile The Proofer Profile drop-down list shows all of the available profiles for the 
selected device. Select the Auto-select from map check box, if you want Apogee 
to select a proofer profile for you according to the job settings. In this case, the 
Proofer Profile selection list is disabled.

Rendering Intent There are 4 different Rendering Intents available, although not all profiles 
contain Look Up tables (LUTs) for each of the 4. Usually there are only 3 repre-
sented. In this case often a duplicate of one Look Up table is used for missing 
Render Intent LUT. The Rendering Intent defines the way the source colors are 
mapped to the destination space.

The following rendering intent options are available:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the 2 profiles is preserved. White of 
source color space is simulated with CMYK values from the destination color 
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space. The consequence is that every white object/area is covered with certain 
ink amounts.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.

Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy

NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.

Advanced CMM Recent developments in the Color Management engine offer ‘Smart CMM’, 
which provides better blending of converted spot colors. However, this comes at 
a small cost: it is a little slower.

Process Colors Don’t color manage: Select this option to disable color management.

Color manage from Press to Proofer profile: Select this option to color manage 
from Press to Proofer profiles.

Color manage using Device Link Profile: Select this option to color manage using a 
Device Link Profile.

NOTE: Apogee dynamically creates a Device Link Profile when an optimized 
proofer profile is used with Advanced CMM enabled.

 Device Link: Select a Device Link Profile.

 Exception: You can choose here whether or not you want Apogee to take into 
account any color exceptions. For more information see “Profiles” on 
page 1130.

 None: Apogee will not take into account any color exceptions.

 Default Exception Dictionary: Apogee will take into account color excep-
tions from the default color exception dictionary.
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Apply black point
compensation

Apogee uses a built-in algorithm to adjust for differences in the black points of 
the selected source and destination profiles.

Spot Colors Accurate spot color mixing: In this enhanced mode, spot color visualization is 
superior to the standard color-managed mode. You can choose from the 
following:

 Off

 Max. 2 colors

 Max. 3 colors

deltaE calculation Select the method to calculate the deltaE:

 deltaE*ab: Use the ΔΕab method, the first internationally endorsed color 
difference formula as published by the CIE Committee. This is the default 
value for reasons of compatibility.

 deltaE*00: Use the ΔΕ00 method, a revision of the ΔΕ94 formula. ΔΕ00 is the 
industry standard formula to be used.

 default: Use the default method.

Use Press Paper White: Pantone\spot color inks are transparent and appear 
differently when printed on different substrates. Normally, you should select 
this option when creating a proof which will be used by the printer to print a spot 
color on the Press (when the simulated spot color on proof needs to resemble the 
final printed result). In this case, the paper white from the press profile is used 
in the color calculation.

If this option is not selected, the measured paper white of the color book is used 
in the calculation of the spot colors. The option should therefore be deselected 
when the simulated spot colors on the proof are compared to the color book 
reference prints (with a measurement device, for example).

NOTE: A spectral press profile is required for this option.

Simulate Paper Stock You can simulate two aspects of the Paper Stock used for the job:

 White Point: Select to simulate the color of the paper stock on the proof.

 Texture: Select this check box to apply the texture (fiber and grain of the 
paper) specified in the Paper Stock resource. If no texture is selected for 
the Paper Stock, it will not be simulated.
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Dot for dot Defines how to proof the screening dots from the main result. You can also 
enable Close Loop Control or let the system select a CLC profile automatically 
(Auto-select).

NOTE: The Dot for dot option requires Digital Film Proof in the flow.
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Display

Together with the Render Task Processor, the Display Task Processor allows you 
to create results for high-fidelity color-managed display proofing in Raster 
Preview. By taking into account the specifics of a given display device, the 
Renderer can create optimized, 8-bit results for viewing on this device. 

A color-managed display proof allows you to preview rendered results using 
color management to convert the press color space to the monitor color space 
based on ICC profiles. With a calibrated monitor environment and correctly 
configured monitor profile, contract-proofing quality should be achieved. This is 
a licensed feature.

The Display Task Processor represents a computers’ display device (also referred 
to as ‘monitor’). In order to display high frequency elements —such as fine text 
or line art— properly on a monitor, the image must be rendered at a sufficiently 
high resolution. To guarantee that the image is displayed with the correct size, 
the rendered resolution must be an integer multiple of 2 of the display’s 
hardware resolution (dpi).

To accomplish this when preparing a result for color-managed display proofing, 
the Renderer creates a set of images, starting at half the display’s hardware 
resolution (dpi) and each one having twice the resolution (dpi) of the previous 
one. For example, if the display’s hardware resolution (dpi) is 96 dpi, the 
Renderer creates images at 48, 96, 192, 384, and 768 dpi. The actual number of 
images created depends on the job’s settings.

When viewing the results, Raster Preview selects the proper image, according to 
the zoom factor you choose. However, you cannot zoom in to ‘raster’ (1-bit) 
zoom level, simply because there is no 1-bit raster data. You need to preview the 
high resolution main flow to do that.

Associated Resources

When you select the Display Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Borders

 Marks
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Display Image Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Border

Apogee can create a border around the image. Such a border could contain a 
patch allowing you to measure onscreen the quality of the display. You can select 
a border from the drop-down list (the default selection is None). For more infor-
mation, refer to “Borders” on page 963.

Rule-up

The Display Task Processor can print a rule-up. These are lines that correspond 
to the expected page positions on the template and the actual crop box from the 
pages.

Pages You can print a rule-up for:

 Art box

 Trim box
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 Bleed box

 Media box

Imposition You can print a rule-up for:

 Press Sheet

 Expected Page Size

Output You can print a rule-up for:

 Output Size

Die/CAD  Design lines: Select the check mark to choose a Line Appearance Set from the 
list or click the arrow to open the Line Appearance editor. See “Finishing 
Hub” on page 993.

For each of the above, you can select the color from the drop-down list (Red, 
Green, Blue, etc.), and a point size for the lines (0,25 pts, 0.50 pts, 0.75 pts or 
1.00 pts). You can also specify whether you want a dashed or a solid line. 

NOTE: You can only print a rule-up if you use an Impose Task Processor in your 
Production Plan.

Display Output Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.
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Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Render for viewing at

Enter the display’s resolution (dpi) at which the image will be viewed (the range 
is 72-150 dpi, inclusive). Viewing the image at this display resolution guarantees 
geometrical correctness (i.e. the dimensions on the display match the dimen-
sions of the printed result). Common resolutions are 72 dpi and 96 dpi. The 
default is 96 dpi.

NOTE: Do not confuse the display resolution with the render resolution. For 
optimal viewing results, the entered resolution (dpi) should match the device’s 
hardware resolution (dpi), and the display resolution (pixels x pixels) should 
match the optimum display resolution (pixels x pixels). This guarantees 
geometrically correct images without resampling. ColorTune Display and Raster 
Preview will warn you if these conditions are not met.

Maximum Viewing Zoom Level

This is the maximum zoom level that is normally used when viewing the image 
in Raster Preview. Together with the target resolution, this determines the 
maximum render resolution. Possible values are 2x, 4x, 8x, 16x and 32x. The 
default is 8x.

NOTE: This directly affects the number of images Apogee has to render, and 
therefore the required processing time. Apogee creates the different images at 
resolutions between 1:2 through to the target resolution, in steps of 2x. 

The zoom level in Raster Preview is relative to the target resolution. As a result, 
zoom level 1x guarantees a geometrical correct image when viewed on the 
target display Select the maximum viewing level that you will allow. This may 
be 2X, 4X, 8X, 16X, or 32X.

Simulate Paper Stock You can simulate two aspects of the Paper Stock used for the job:

 White Point: Select to simulate the color of the paper stock on the proof.
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 Texture: Select this check box to apply the texture (fiber and grain of the 
paper) specified in the Paper Stock resource. If no texture is selected for 
the Paper Stock, it will not be simulated.

Apply smoothing Select the check box to apply smoothing via DFP.
Apogee Reference Guide



886 EXPORT
Export

The Export Task Processor exports the latest processed results from the Produc-
tion Plan to a specific directory, in either PDF or PostScript format. This allows 
you to process the PDF/PS documents on a remote system.

Associated Resources

When you select the Export Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Preflight Profiles

 PostScript Headers

 XSLT Conversions

Export Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

The Export settings are divided into two tabs, one dealing with export format 
options, and the other dealing with the destination options.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
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from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Export

You can specify the format in which you want to export the results. There are two 
options:

 PS - PostScript format

 PDF format

Save result as PS

Content Insert PostScript header: If you select this check box, the associated list box is 
enabled, where you can select the PostScript header that you want to insert in 
your exported file. For more information, refer to “PostScript Headers” on 
page 1118.

 Collate

 DuplexFlipLongEdge

 DuplexFlipShortEdge

 Manual Feed

 Select Tray

Checksum: 

 None

 Create

 Compare against

Images If you have enabled Alternate Images in your Normalizer configuration (Service 
access level is required to do this), then a set of alternate low resolution images 
will be created. You can configure the Export Task Processor to remove either 
the high or low resolution images from your files by choosing one of the 
following:

High resolution only: Select this option if you are going to print the output. You 
should also always select this option when certification is used (see below).
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Low resolution only (for display): Select this option if you are not going to print the 
output.

NOTE: PostScript files cannot contain both resolutions.

Content Trimbox: 

 Preserve original trimbox

 Expand to include image’s border

Save result as PDF

Content Trimbox: Allows you to control the trimbox:

 Preserve original trimbox: The exported PDF file has the same trimbox as the 
original PDF. In other words, the existing trimbox remains unchanged.

 Expand to include borders: The trim box of the exported PDF file is changed 
to include a border added by Apogee. If there is no border, the trim box 
remains unchanged.

Images If you have enabled Alternate Images in your Normalizer configuration (Service 
access level is required to do this), then a set of alternate low resolution images 
will be created in your PDF files. You can specify which versions of the images 
you want to include in the exported PDF by choosing one of the following:

NOTE: This only applies to PDFs which contain images.

Include as is: The exported PDF will contain whatever images are present in the 
document that was input of the Export Task Processor. Although this requires no 
processing, the disadvantage is that you cannot be sure about the image content 
of the exported PDF. You should therefore not select this unless you are sure 
about the input to the Export Task Processor.

Include high and low resolution: The exported PDF will contain a high resolution 
and a low resolution version of each image. 

NOTE: The exported PDF will contain exactly one alternate image, regardless of 
the number of alternate images in the incoming PDF. 

 Optimize for display: Select this check box to control which version to use as 
the main image. When you view a file in Acrobat, you will see the main 
images. When the PDF is created with viewing in mind, the low resolution 
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image is the main image, and the high resolution image is the alternate 
image. The images can be tagged so that when printing the file, the high 
resolution image is used. However, some application may not honor this tag; 
they simply assume the main image is the one you need. In that case, you 
must make the high resolution version the main one.

 Create low resolution images: Allows you to choose how to include the low 
resolution images:

 Always: Apogee will generate a low resolution version at the specified 
target resolution by down-sampling the high resolution image. This 
ensures that the low resolution version is synchronized with the high 
resolution version. The drawback is that creating low resolution images 
takes some time.

 Only if not present: Apogee will simply use the low resolution image if it 
is present. If it is not present, Apogee creates one at the specified target 
resolution. 

 Only if different resolution: Apogee will only use low resolution images if 
they match the specified target resolution.

 Target: Specify the desired target resolution, in pixels per mm.

Include high resolution only: Apogee keeps the high-resolution images in the 
exported files and discards the low-resolution images. Use this when sending 
files to be printed, especially when you require certification. 

NOTE: ‘High resolution’ simply refers to the image version with the highest 
resolution, even if this highest resolution is only 12 dpi. To ensure the PDF is 
press-ready, you should therefore use a Preflight action to check the resolution.

Include low resolution only (display): Apogee keeps the lowest resolution images 
in the exported files and discards the high-resolution images. Use this when you 
want to export small files (e.g. for mailing them to the client for inspection). To 
ensure you really send low resolution images, select “Always” create low resolu-
tion images.

 Create low resolution images: Allows you to choose how to include the low 
resolution images:

Optimize for display Main image Alternate image

Selected low resolution high resolution

Deselected high resolution low resolution
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 Always: Apogee will generate a low resolution version at the specified 
target resolution by down-sampling the high resolution image. This 
ensures that the low resolution version is synchronized with the high 
resolution version. The drawback is that creating low resolution images 
takes some time.

 Only if not present: Apogee will simply use the low resolution image if it 
is present. If it is not present, Apogee creates one at the specified target 
resolution. 

 Only if different resolution: Apogee will only use low resolution images if 
they match the specified target resolution.

 Target: Specify the desired target resolution, in pixels per mm.

Thumbnails Specify whether or not to include thumbnails:

Include thumbnails: When you choose to include them, you have the same 
“Create” options as with images. Note that the default thumbnail resolution is 12 
dpi.

Exclude thumbnails: Makes a PDF without thumbnails, removing existing 
thumbnails.

Thumbnails as is: Keeps the existing thumbnails, if any.

Preflight/Certify Choose one of the following options:

OFF: No options are visible in this pane if you select this option.

Certify with Enfocus Preflight/Run Enfocus Preflight: You can choose to combine 
the export with a preflight check. Click the associated profile list and choose one 
of the available preflight profiles from the Preflight Profiles resource category.

When certification fails: You need to specify how Export should proceed if certifi-
cation fails:

 Notify: The export is halted, and a notification message is generated.

 Continue and put in sub-directory: The export continues, and the results are 
written to the folder of your choice.

Save Preflight report next to PDF file: Select this option to save the preflight 
report when a PDF file is written. This happens when the certification succeeds, 
or when the certification fails with the 'Continue' option selected. The report file 
is saved in the same directory as the PDF file.
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Only for warnings and errors: Saves the preflight report only when there were 
warnings or errors. When there are no warnings or errors, no report is written.

Save Apogee Preflight report: Choose one of the following options:

 Only for fixes, warnings and errors

 Ignore out-of-date reports

Protection Require a password to open the PDF file: You can prevent the reader from 
opening the PDF file. To open such a protected document, the reader must 
provide the password that is specified in the Open Document Password field.

Prevent editing and printing of the PDF file: You can prevent the printing and/or 
editing of the PDF file. In order to print and/or edit the document, the reader 
first needs to change the permissions after opening the document. Changing the 
permissions requires the password specified in the Change Permissions 
Password field. Even in a restricted document, you can grant permission for the 
reader to:

 Allow high-resolution printing

 Allow all editing

Destination

Output via You can select the required output channel from the drop-down list.

 File

 FTP

 LPR (PostScript output only)

 AppleTalk (PostScript output only)

 TCP/IP (PostScript output only)

 Windows Spooler (PostScript output only)

File

Create Select how you want Export to create files:

 Custom

 Single file per job
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 Single file per signature 

 Single file per web 

 Single file per side

 Single file per page 

 Single file per Run List page

 Single file per book signature

Save files in Select a folder structure in which you can store your output files. 

Directory hierarchy: The files will be saved in the specified subdirectory hierarchy 
(e.g. $ORDER\$JOB\$DOCPAGE).

Same directory: The files will be all be saved at the same directory hierarchy (e.g. 
$ORDER_$JOB_$DOCPAGE).

The variables will be separated by a slash if you select Directory hierarchy. This 
means that a directory will be made according to the file name. The variables 
will be separated by an underscore if you select Same directory. 

The folder structure corresponds to the following variable string:

$ORDER\$JOB\...

...followed by variables corresponding to your selected “Create” criteria. 

For example, if you chose to create a “Single file per signature” and save files in 
a Directory hierarchy, a directory would be automatically created based on the 
following variables: $ORDER\$JOB\$SIGNATURE.

Export directory You can specify to which directory you want to export your results. Again, you 
can use variables to create it automatically, or you can also use the Browse 
button to locate the directory.

File extension Specify the format of the result that you want to export.

Options Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Replace existing files: If a file with the same name already exists in the specified 
export directory, then the file is automatically replaced by the newly exported 
file.
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Leave existing files, add sequence number to new file names: If a file with the 
same name already exists in the specified export directory, then a revision 
number is added to the name of the newly exported file.

Create APOXML file The ApoXML section allows you to export an ApoXML file for each exported file. 
The ApoXML file can contain system- and user-specified variables for the 
exported result. You must select an XSLT to control the output of the file.

Post-process files with
script

Select this check box if you want to process the files with a certain script file. You 
can specify the script in the field next to the check box. You can use the Browse 
button to locate the required script file.

Script options Here, you can specify command options.

FTP

FTP output is similar to file output. However, here you also need to specify the 
FTP server (Host and Port), and the Username and Password with which Apogee 
can log into that server. Leave Username and Password empty to use anonymous 
FTP. In this case, the system administrator’s e-mail address will be used as 
password.

You can also select whether to use Passive FTP mode or not. If you are behind a 
firewall, you may need to use a proxy. You can use the core server’s proxy config-
uration (which may require no proxy server), or you can specify one yourself. 
Leave the User name and Password empty if you do not need to authenticate.

NOTE: The Base directory is relative to the login home directory.

LPR (PostScript output only)

The LPR options are applicable when you choose to print results using the LPR 
protocol. The LPR output requires the Host and Queue name you want to 
connect to.

AppleTalk (PostScript output only)

The AppleTalk options are applicable when you choose to print results using the 
AppleTalk protocol. AppleTalk output requires the Zone and Printer name you 
want to connect to.

TCP/IP (PostScript output only)

The TCP/IP options are applicable when you choose to print results using the 
TCP/IP protocol. TCP/IP output requires the Host and Port name you want to 
connect to.
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Windows Spooler (PostScript output only)

The Windows Spooler options are applicable when you choose to print results 
using the Windows Spooler. Windows Spooler output requires the name of the 
printer you want to connect to.
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GDI Proofer

The GDI Proofer is an indirect generic device driver, which can be used when no 
dedicated Apogee proofer device is supported. This device driver uses the 
standard Windows printer driver architecture.

Associated Resources

When you select the GDI Proofer in the System Overview, the following associ-
ated resource categories are displayed in the Resources pane:

 Media, Profiles, Color Books, Output Sizes, Borders, Marks, Contrast Adjust-
ments, Simulation Curves.

GDI Proofer Image Settings

These are the same as the ECO3 Proofer Image settings (see “Proofer Image 
Settings” on page 856).

GDI Proofer Output Settings

You can access these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Media

In this pane, you can select a specific medium, medium type or tray from the 
drop-down list.

Media Select Media, if you want to select a specific medium. In the second drop-down 
list, you can further specify the medium type and its size.

The second drop-down list displays all of the compatible media for the output 
device that you want to use, regardless of the size of the currently active tray. 

Media Type Select Media Type, if you want to select specific media type. You can do this in 
the second drop-down list. Apogee is then free to image on any loaded media of 
the selected type, whatever size it has. 

This option is especially useful when several devices are grouped. Apogee can 
choose the most suitable device to minimize media waste. 

Image Quality

Spooler settings You must supply the name of an existing Windows spooler queue. The job will 
fail if the queue cannot be found (at run time).

Resolution Enter the requested resolution.

Smoothing When Apply Smoothing is selected, Ax renders the pages at twice the requested 
resolution and anti-aliases it when producing the final image result (at the 
requested resolution).

Apply smoothing (via Render): Select the check box to apply smoothing via 
Render.

Apply smoothing (via DFP): Select the check box to apply smoothing via DFP

Color Management

Color Management affects the rendering of the imaging and the quality of the 
print.

Proofer Profile The Proofer Profile drop-down list shows all of the available profiles for the 
selected device. Select the Auto-select from map check box, if you want Apogee 
to select a proofer profile for you according to the job settings. In this case, the 
Proofer Profile selection list is disabled.

Rendering Intent There are five different Rendering Intents available, although not all profiles 
contain Look Up tables (LUTs) for each of the five. Usually there are only three 
represented. In this case often a duplicate of one Look Up table is used for 
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missing Render Intent LUT. The Rendering Intent defines the way the source 
colors are mapped to the destination space.

The following rendering intent options are available:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the 2 profiles is preserved. White of 
source color space is simulated with CMYK values from the destination color 
space. The consequence is that every white object/area is covered with certain 
ink amounts.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.

Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy.

Process Relative/Spots Absolute: Combines Relative Colorimetric for process 
colors and Absolute Colorimetric for spot colors.

NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.

Advanced CMM Recent developments in the Color Management engine offer ‘Smart CMM’, 
which provides better blending of converted spot colors. However, this comes at 
a small cost: it is a little slower.

Process Colors

Don’t color manage Select this option to disable the color management.

Color manage from Press to
Proofer profile

Select this option to color manage from Press to Proofer profiles.
Apogee Reference Guide



898 GDI PROOFER
Color manage using Device
Link Profile

Select this option to color manage using a Device Link Profile.

NOTE: Apogee dynamically creates a Device Link Profile when an optimized 
proofer profile is used with Advanced CMM enabled.

 Device Link: Select a Device Link Profile.

 Exception: You can choose here whether or not you want Apogee to take into 
account any color exceptions. For more information see “Profiles” on 
page 1130.

 None: Apogee will not take into account any color exceptions.

 Default Exception Dictionary: Apogee will take into account color excep-
tions from the default color exception dictionary.

 Auto-select: Select the auto-select check box if you want Apogee to automat-
ically make selections for you according to the job settings. 

Apply black point
compensation

Select this check box to compensate the loss of range on the dark tones. Use 
when the proofer’s gamut in the dark tones is smaller than that of the press. It is 
disabled, if the option Don’t color manage is selected for Process Colors.

Spot Colors

Accurate spot color mixing In this enhanced mode, spot color visualization is superior to the standard color-
managed mode. You can choose from the following:

 Off

 Max. 2 colors

 Max. 3 colors

deltaE calculation Select the method to calculate the deltaE:

 deltaE*ab: Use the ΔΕab method, the first internationally endorsed color 
difference formula as published by the CIE Committee. This is the default 
value for reasons of compatibility.

 deltaE*00: Use the ΔΕ00 method, a revision of the ΔΕ94 formula. ΔΕ00 is the 
industry standard formula to be used.

 default: Use the default method.

White point Use Press Paper White: Pantone\spot color inks are transparent and appear 
differently when printed on different substrates. Normally, you should select 
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this option when creating a proof which will be used by the printer to print a spot 
color on the Press (when the simulated spot color on proof needs to resemble the 
final printed result). In this case, the paper white from the press profile is used 
in the color calculation.

If this option is not selected, the measured paper white of the color book is used 
in the calculation of the spot colors. The option should therefore be deselected 
when the simulated spot colors on the proof are compared to the color book 
reference prints (with a measurement device, for example).

NOTE: A spectral press profile is required for this option.

Simulate Paper Stock

You can simulate two aspects of the press stock used for the job; its white point 
(color of the unprinted stock) and its texture (fibers, grain).

Paper Stock Select the Paper Stock to simulate:

 From Product/Part: Follow the Paper Stock as selected in the Product/Part 
definition. This guarantees that in jobs with mixed products/parts, the 
proofer will get the paper stock that corresponds with the result being 
proofed.

NOTE: This option is disabled in Hot Tickets (because there is no way to define 
a product).

 Manual selection: Select the Paper Stock to use. The proofer will use the 
selected stock, regardless of what’s selected in the Product/Part. It does not 
change the stock selection in the Product/Part.

Simulate White Point:  Select to simulate the color of the paper stock on the proof.

Texture:  : Select this check box to apply the texture (fiber and grain of the paper) 
specified in the Paper Stock resource. If no texture is selected for the Paper 
Stock, it will not be simulated.

Dot for dot

Defines how to proof the screening dots from the main result. You can also 
enable Close Loop Control or let the system select a CLC profile automatically 
(Auto-select).
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NOTE: The Dot for dot option requires Digital Film Proof in the flow.
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JMF Link

The JMF Link Task Processor is used to transport PDF data from the local Apogee 
system to a remote site using JMF (the remote site could be another Apogee 
system). This Task Processor links both sites bidirectionally, producing interme-
diate files and sending them to the remote site. JMF Link can also capture and 
show the status of the remote site. This task processor is also used to connect to 
digital presses with the DigitalPrintLink option.

JMF Link is closely related to the Export Task Processor: Basically, JMF Link is a 
PDF Exporter that specializes in JMF.

Associated Resources

No resources are associated with the JMF Link.
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Platemaker Link

Administrator access level only!

The PlateMaker Link Task Processor is used to set up an integration between two 
Apogee Systems. The first Apogee System is used as normal: The second Apogee 
System is called the Apogee PlateMaker System.

No resources or settings are associated with the PlateMaker Link.

PlateMaker Link Configuration

This dialog box allows you to specify the configuration settings of the Plate-
Maker Link.

JDF/JMF Communication

PlateMaker server name The name of the PlateMaker server.

Acknowledge time-out The maximum time in seconds that Apogee waits for an acknowledgement 
message after submitting a JMF job to the digital press system. If no acknowl-
edgement is received within the specified time, the job produces an error.

JDF Device ID In a JDF-controlled environment, each device/system/subsystem has its own ID. 
This ID is the JDF Device ID of the digital press system. Apogee needs to know 
the JDF Device ID of each system it communicates with: When Apogee receives 
a JMF message with a device status, it looks at the JDF Device ID in the message. 
Apogee then looks for a Link or Digital Press Task Processor with the corre-
sponding JDF Device ID. Once Apogee knows for which Task Processor the 
message was intended, it can act accordingly (e.g. set the Task Processor status, 
or log a message for that Task Processor).
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PDF Link

This task processor sends PDF data to digital printers. No settings need to be 
specified.
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Public Page Store

A Public Page Store is a repository of pages available for all jobs. To create a 
Public Page Store, you need to create a job based on the Public Page Store job 
template. Any documents or pages that are input via the Public Page Store input 
channel will then appear in the Pages tab, and will be available for all jobs. From 
here, users are free to select pages or documents, and include them in their job 
Run Lists. A Public Page Store can be viewed and accessed by all users. You can 
consider it as a central repository of documents ready to be processed.

You assign a unique name to the Public Page Store, and can create as many 
Public Page Stores as you require.

Automatic page placement will not work if your Production Plan contains a 
Public Page Store Task Processor (see “Run List Settings” on page 813). You 
must manually add documents or pages from the Page Store to the Run List.

No settings or resources are associated with a Public Page Store.
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Raster Link

This task processor sends raster data to digital printers. No settings need to be 
specified.
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Collect

Administrator access level only!

A Collecting Hot Ticket is used to create a wide-format job that is filled with 
multiple images collected from multiple files or multi-page files.

No resources are associated with this task processor.

Create Jobs

Use Ticket Template Shows the Wide-Format Ticket Template that will be used for processing. Click 
in the drop-down list to see your available Wide-Format Ticket Templates and 
choose a template. The Collecting Hot Ticket cannot be submitted if a template 
is not selected.

Job Name This field displays the Job name. The Job name may use the following variables: 
$COLLECT_TEMPLATENAME, $DATE, $TIME. 

Layout

These are the options you have for arranging the images on the sheet or sheets.

Center Choose whether you want to center images horizontally.

Rotation Choose whether you want to rotate images by 90° or 270° so they fit better on the 
sheet.

Group images by property Choose one or more variables from the drop-down list to group images on the 
sheet. You can Keep groups on separate sheets if you want.

Maximum length Specify the length if roll media will be used.

Coverage zones

In this panel you can set conditions for submitting the layouts automatically 
based on the coverage of the sheets, i.e. the percentage of the media surface that 
is covered by images.

Zone A Set a threshold percentage (Coverage is less than) or minimum length if roll 
media is used for never submitting.
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Zone C Set a minimum threshold percentage (Coverage is at least) for submitting 
automatically.

Zone B If sheets remain between the set thresholds (Zone A and Zone C) in a queue, you 
can specify when you want to be notified and when you want them to be 
submitted anyway.
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CHAPTER
15 Print Task Processors

Print Task Processors represent the printing devices on which you will print the 
output generated by Apogee. Each printing device that you define at installation 
will be represented by a unique Print Task Processor.

The settings and resources for installed Print Task Processors can be derived 
from the following task processors:

 “Generic Press” on page 910 for commercial presses

 “Generic SD (Sign and Display Printer)” on page 924 for Sign and Display 
(SD) digital printing devices: Anapurna, Jeti, etc.

 “Generic Digital Press” on page 928 for digital commercial printing presses: 
Canon, HP Indigo, Konica Minolta, Océ PrismaSync, etc.
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Generic Press

The Generic Press Task Processor has no attributes except its name. It has no 
type (sheet/web), no setback (Distance plate to sheet edge), no plate size, no 
clamp margins and no InkDrive settings.

There is therefore no need to install multiple instances, and no need for load 
balancing since the processing of a Generic Press is limited to writing the 
InkDrive file.

Associated Resources

When you select the Generic Press Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Borders, Marks, Profiles, Color Books, Paper Stock, Calibration Curves, 
Simulation Curves, WebGrowth Profiles, Ink Sets, InkTune Sets.

Generic Press Print Settings

You can access these settings:

 When creating Parameter Sets (see ““Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

When you create a Parameter Set, you should specify a Parameter Set name. You 
can always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Parameter Set Lookup

Enter keywords, separated with a comma, so the appropriate Image and Output 
parameter sets, and the Render-Screen parameter set can be selected automati-
cally from the press. Use the same keywords in the name of the appropriate 
parameter sets for these resources. Select the check box to also use the name of 
the press as a keyword. The lookup is activated by selecting the Select 
automatically from press check box for these resources in the panel under the 
plan.

Printing Tab

Paper Type Select the appropriate paper type from the drop-down list. The list contains all 
of the paper stocks in the Paper Resource category that are compatible with the 
selected press.

Ink Set Select the ink set from the drop-down list. The list contains all of the ink sets 
currently available in the Ink Sets Resource category.

Border Select the border from the drop-down list. The list contains all the borders 
currently available in the Borders Resource category. 

Color Profile Select the appropriate ICC Profile from the drop-down list. The list contains all 
of the ICC Profiles currently available in the ICC Profiles Resource category. 

When receiving PDF files, you can have Apogee honor the application’s supplied 
color profile by selecting ‘Use PDF Output Intent’. In this case, you should 
provide a fallback in case the input has no output intent.

Auto-select from map: Select this check box to have Apogee automatically select 
the Color Profile.

Fallback This option is only enabled when ‘Use PDF Output Intent’ has been selected in 
the Color Profile list. Here, you can select a fallback color profile in case the input 
has no output intent.

Calibration Select the Calibration Curve from the drop-down list. The list contains all of the 
curves currently available in the Calibration Curves Resource category.

Select None if you do not use calibration.

Auto-select from map: Select this check box to have Apogee automatically select 
a Calibration Curve.

Simulate Select the Simulation Curve from the drop-down list. The list contains all of the 
curves currently available in the Simulation Curves Resource category.
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Select None if you do not use simulation.

Web Growth You can select a WebGrowth profile, or select None to have no WebGrowth 
compensation applied. WebGrowth compensation is performed on the fly while 
outputting the raster data, so the raster files themselves are not affected (and 
WebGrowth compensation is therefore not visible in Raster Preview). For more 
information, see “WebGrowth Profiles” on page 1146.

Defined by Layout-editor: Select this check box to use an on-the-fly calculated 
WebGrowth profile, based on distortion values that are specified in the Layout 
Editor.

NOTE: Layout-Editor based distortion requires a special license. When using this 
option, WebGrowth profile becomes read-only and set to Calculated.

Don’t apply outside Press sheet: Select this check box to keep the area that is 
outside of the press sheet as it is. This option is read-only, when using Layout 
Editor-based distortion.

InkDrive Create InkDrive File: Select the check box if you want to create an InkDrive file. 
The InkDrive file is especially useful for the Press operator. It contains low-
resolution images to inform the operator how much ink he can use for the print 
job.

Density Curve: Applies the selected Density Compensation Curve to the CIP3/4 
preview and Ink key report. In some cases, e.g., when using pre-compensated 
screens or ink-saving techniques, the densities that are found in the image 
preview or the Ink key report do not really convey the effects of those screens or 
ink-saving techniques. In these cases, you can select an extra Density 
Compensation Curve from the drop-down box.

After Rendering: Creates and saves the InkDrive files immediately after 
rendering, i.e. before the raster files are imaged.

After Rendering is not available for DQS-jobs.

After Imaging: Saves the InkDrive files immediately after imaging. This is the 
default option.

NOTE: The InkDrive files are always created by the Render Task Processor, 
regardless of the selected option.

Ink Saving Two options are available:
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Apply InkTune Integrated: Select the check box and choose an InkTune set from 
the drop-down list or click the arrow to go to the resource. The list contains all 
the InkTune sets currently available in the InkTune Sets Resource category. 
These parameters allow you to apply ink saving techniques based on Grey 
Component Removal (GCR)to replace process color inks by black.

Apply SolidTune: This option applies ink saving to screened data. Choose a 
SolidTune set from the drop-down list or click the arrow to go to the resource.

Disable on marks: This option disables the colorbars on SolidTune.

NOTE: Service intervention is required to modify the PDF Render configuration 
for the initial rendering.

Type Tab

A press can either be web-fed or sheet-fed. Each type has its own characteristics. 

Press Name The actual name of the press; the lay and gripper settings for sheet-fed and the 
cut-off length for web printing (see below) must be the same for sets with the 
same Press Name.

Type Specify the type of press from the drop-down list:

Sheet Offset: A sheet-fed press aligns the press sheet against the leading edge of 
the plate, taking into account the non-printable area. Apogee uses the total 
setback distance together with punch calibration in order to position the press 
sheet image on film or plate. The other distances are not used for processing, but 
can be used for validation.

Web Offset: A web press has several ways to position the press sheet on the plate:

 Center between clamps: The press sheet is vertically centered in the exposed 
plate area (i.e., the part of the plate that is not tucked away in the clamps).

 Center on plate: The press sheet is vertically centered on the plate, ignoring 
the clamp areas.

 Align to leading edge: Same as with a sheet-fed press. Since there is no sheet 
edge, Apogee can use the lead edge clamp size as “total setback”.

Default Press Sheet Layout The layout that will be used by default for imposition. Select an available 
resource from the drop-down list. See “Press Sheet Layout Rules Overview” on 
page 1124.
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Distance plate to sheet
edge

This can be specified as a value, or it can be read from the signature definition in 
an imposition template:

From signature info: Reads the Setback value from the signature definition in an 
imposition template. This option is only available when the Production Plan 
contains an Impose Task Processor, and if it uses templates.

Custom: Allows you to specify a custom Setback value, in mm.

Default workstyle The workstyle that will be used by default for imposition in the Apogee Impose 
module. See “Working with Apogee Impose” on page 369.

Sheet Lay (sheet-fed) The press sheet lay can be:

 Left (Drive side)

 Right (Operator side)

Gripper Width (sheet-fed) Set the required width for the gripper.

Sheet height (web) The height of the press sheet as defined by web cut-off.

Pin area (web) When you set a pin area, Apogee Impose adds an extra margin across the bottom 
of each section. Regardless of whether the page's trim margins are large enough, 
this raises the pages by the specified height.

Slow Down Wheels Select one of the resources from the drop-down list. See “Slow Down Wheels” on 
page 1143.

Plate/Press Media

Plate Default plate size: The dimensions of the plate that you can mount on this press 
(width and height). The plate’s dimensions directly determine the media size 
selection in a CTP production plan. However, you could leave it blank to allow 
the user to select a plate manually (in the platesetter’s output parameters).

Clamp margins: Defines how much of the plate is “lost” in the clamps (Leading 
edge and Trailing edge). The clamp margins are used to calculate the press sheet 
position for a web press.

Press Media Default press media size: The dimensions of the press media (width and height).

Horizontal Position: Position of the press media (left, center, right or distance 
from left edge).

Clip Press Border Marks Select this check box to clip press border marks.
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Margins: You can add margins on the outside the press border. By default, the 
value is set to 3 mm. 

InkDrive Tab

You can ask Apogee to create CIP3/4 information when printing to a specific 
press. The format and contents of the CIP3/4 file depends on the given press 
(vendor/type). This section allows you to tell Apogee how to create the file and 
where to put it.

NOTE: This tab only appears when you have the InkDrive option installed.

InkDrive Format There are three modes for creating InkDrive data. The chosen mode determines 
the availability of the different InkDrive options:

You can select the mode from the InkDrive Format drop-down list. Only one 
mode is available for presses that do not support JMF messaging. Presses that 
support JMF can have the two other modes. 

NOTE: A press that has no JDF/JMF integration can only generate file-based PPF 
InkDrive data. In this case, the CIP4 Image Format is disabled. Also note that a 
press that is integrated via JDF/JMF cannot use the ‘old’ CIP3/PPF InkDrive 
method.

Use v3.0 standard: You can optionally select the v3.0 PPF standard (v2.1 PPF is 
used by default).

The InkDrive tab comprises three sub-tabs: File, Image and Contents.

File This tab describes the file format and contents of the exported CIP3/4 file, and 
where to save it. The first section defines what a PPF file should contain. The 
second section controls where the files are written to, and what the file names 
are.

Create: Specify the file creation. Select the required option from the drop-down 
list. 

Options when you select Press Type Sheet Offset:

InkDrive mode File Image Contents

CIP3/PPF X X X

CIP4/PPF - X X

CIP4/PNG - X -
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 Custom. When you select Custom, this field becomes editable, and you can 
enter your own construction.

 Single file for all sheets: All separations of a job are saved in one PPF file.

 Single file per sheet: Each PPF file contains all separations of both the front 
and back of a press sheet.

 Single file per side: Each PPF file contains all separations of a single side of a 
press sheet.

 Single file per side per version: Each PPF file contains all separations of a 
single side and version of a press sheet.

 Single file per separation: Each PPF file contains a single separation.

NOTE: This is the only available option, when the press is controlled by JMF. 

Options when you select Press Type Web Offset:

 Custom. When you select Custom, this field becomes editable, and you can 
enter your own construction.

 Single file per signature: All separations of all webs of a single signature are 
saved in one PPF file.

 Single file per web: Each PPF file contains all separations of both the front 
and back sides from a single web of a signature.

 Single file per web side: Each PPF file contains all separations of a single side 
from a single web of a signature.

 Single file per web side per version: Each PPF file contains all separations of 
a single side from a single web of a signature for a single version.

 Single file per separation: Each PPF file contains a single separation.

NOTE: This is the only available option, when the press is controlled by JMF. 

Save files in directory hierarchy: Select this check box if you want the InkDrive 
files to be saved according to the file name hierarchy.

Save files in same directory: Select this check box if you want all of the InkDrive 
files to be saved in the same directory, regardless of the file name.
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File Name: This field displays the file name under which the InkDrive files will be 
saved. The file name may use the following variables: $ORDER, $JOB, $SIGNA-
TURE, $WEB, $SIDE, $SEPARATION.

The variables will be separated by a slash if you select Save files in directory 
hierarchy. This means that a directory will be made according to the file name.

The variables will be separated by an underscore if you select Save files in same 
directory. 

Export Directory: Specify the directory where the InkDrive file will be located. 
Use the Browse button to locate the directory.

For example:

\\$COMPUTER\GenericPressRoot\$PRESS\

Extension: Specify the file extension to be used for the InkDrive files. By default, 
this is ‘ppf’.

Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Replace existing file: If a file with the same name already exists in the specified 
directory, then the file is automatically replaced by the new file.

Leave existing file, add sequence number to new file names: If a file with the same 
name already exists in the specified directory, then a revision number is added 
to the name of the new file.

Post-process files with script: Select this check box if you want to run an external 
script after the InkDrive file was written. 

Script options: You can specify script options, which will be passed to the script 
as space separated arguments.

Image This tab describes how the preview image should be generated. The first section 
describes the generation of the preview image. The second one describes how 
the consuming application expects its orientation in the CIP3/4 file. You can 
select from eight possible combinations: 4 rotations (0, 90, 180, 270) and the 
two readings: right or wrong. 

Resolution (dpi): Select the required resolution from the drop-down list.

Encoding: Select the appropriate encoding option from the drop-down list.
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 None (Binary)

 ASCII Hex

Compression: Select the appropriate compression option from the drop-down 
list.

 None

 Run Length

Linearisation: Applies the linearisation curve to the image using the CTP/CTF 
engine. This is checked by default, following the pattern of earlier iterations.

Define CIP3Matrix from scan direction CTP/CTF: Gets the rotation and reading 
from the CTP/CTF device. This disables the Rotation and Reading options.

Orientation: Select the required orientation options.

 Rotation: 0, 90, 180 and 270

 Reading: Right or Wrong

Contents Versioning: You can select the behaviour when generating a separate InkDrive 
file for each version and including information for other than per separation.

 Only include data for the new plates to be made for a version: Excludes data 
for the plates that have been made for other versions, but will be reused to 
print this version.

 Include data for all the plates used by a version (new and reused): Includes 
the data for the complete set of plates needed to print a version.

Include: Selects the data to include in the CIP3 file.

 Plate size: Select this check box if you want Apogee to retrieve the Press plate 
size from the Job Ticket.

 Default plate size: The dimensions of the plate that you can mount on this 
press (width and height). The plate’s dimensions directly determine the 
media size selection in a CTP production plan. 

 From Job Ticket if available: This option is automatically selected when 
you select “Include Plate size”.

Transverse: Flips the retrieved Press plate size.
Apogee Reference Guide



 

15 PRINT TASK PROCESSORS 919
 Press sheet size: elect this check box if you want Apogee to retrieve the Press 
sheet size from the Job Ticket.

 Default press sheet size: The dimensions of the press sheet that you can 
mount on this press (width and height). 

 From Job Ticket if available: This option is automatically selected when 
you select “Include Press sheet size”.

Transverse: Flips the retrieved Press sheet size.

 Press media position: Position of the press media (left, center, right or 
distance from left edge).

 Additional Imposition information: includes additional Imposition informa-
tion in the CIP3 file.

 Additional Media information: includes additional Media information in the 
CIP3 file.

Override : Selects the specific CIP3 tags to override.

 CIP3AdmJobCode: Overrides the value of $ORDER.

 CIP3AdmJobName: Overrides the value of $JOB.

 CIP3AdmSheetName: Overrides the value of $SHEET_$SIDE. Empty if there 
is no imposition.

 CIP3AdmSeparationNames: Overrides the value of $SEPARATION.

 Promote CIP3AdmSeparationNames and CIP3AdminInkColors to sheet level 
if applicable: This option is selected by default to optimize and override the 
CIP3AdmSeparationNames and CIP3AdminInkColors tags on the sheet level, 
unless there is a difference in color between the front and back sides.

Set CIP3 sheet sides: Allows you to control the Front/Back tagging.

 according to imposition used: Follow the job’s imposition settings.

 to all fronts: Force all sides to be marked as Front.

 to all backs: Force all sides to be marked as Back.

PDF The Ink Keys report is a simple PDF file containing a preview with Ink Keys 
settings. To create such a file, select PDF Ink-Keys as InkDrive Format in the 
InkDrive tab of the Press.
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NOTE: In the Printing tab, Create InkDrive file check box must be selected.

The PDF tab controls the page size and the orientation of the contents.

Width: The width of the page.

Height: The height of the page. 

Orientation : Select the orientation of the page; Best Fit, Portrait, or Landscape.

Ink Keys The Ink Keys options allow you to convert the densities to Ink Key values, if you 
select PDF Ink-Keys or REC Ink-Keys as InkDrive Format in the InkDrive tab of 
the Press. 

 Ink Keys Curve: Select the Ink keys curve to convert the densities to Ink Keys 
values.

 Precision: Select the precision for rounding. You can see this as tick marks on 
the vertical axis.

 Round to: Select how you want to round the Ink Keys values. This rounds the 
value to possible tick marks as established by the Precision option.

 Nearest value: Round to the nearest value.

 Lower value: Round to the nearest lower value.

 Higher value: Round to the nearest higher value.

 Round to higher value around 0%: Select to round values between 0 and the 
first tick.

JDF/JMF Integration

Apogee can act as a JDF controller with respect to a press. You will only see this 
tab if you have installed the JDF controller license.

To obtain the list of presses, controlled by the press controller, you need to query 
the press controller. The press controller will then return a list of devices it 
controls. You can then select the proper press from the ‘JDF DeviceID’ drop 
down. 

JDF ‘DeviceID’ Depending on the press vendor, the press controller (and its URL) either controls 
a single press, or it controls multiple presses. In the latter case, Apogee needs a 
‘Device ID’ to identify a unique press. 
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Press supports JMF Select this option if you want to control the Press via JDF/JMF.

Press URL Enter the URL of the press controller. If you do not specify the protocol, Apogee 
defaults to http://. You can also use the file:// protocol, specifying a directory, 
if the press controller requires it. In this case, Apogee will write the JDF 
commands as files to the specified location.

Finishing

The Generic Press Task Processor can optionally create a JDF file which contains 
instructions for finishing (post-press) equipment. The Finishing tab defines how 
Apogee creates the JDF file, and where it needs to put it. 

Create JDF for finishing
equipment

Select this check box to create a JDF which contains information for finishing 
equipment.

Create JDF Select to create JDF for finishing equipment:

 After impose 

 After imaging

Cut Blocks Select to create cut-blocks type depending on the product type in the job:

 Per Page

 Per Foldsheet

 Per Foldsheet (trim)

 Automatic

NOTE: To cut different sheets differently, you need to group them in production 
sets and adjust the cutting per set. Apogee Prepress determines the job type by 
checking the type of the first product in the Product list and cuts all sheets of the 
job according to that type. As such, a job that mixes different product types must 
be set-up very carefully. You cannot have different types of cutting on the same 
sheet.

JDF version Select the JDF version.

Include preview Apogee Prepress can create a preview of the side(s) of the sheet to be cut. This 
allows to check whether the currently loaded cutting instructions correspond 
with the stack of sheets that is on the table. The preview files are created in the 
same directory as the cut file itself and with the same name, but the extension is 
different.
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 Front: Creates an image preview of the front side.

 Back: Creates an image preview of the back side.

Create Specify the file creation. Select the required option from the drop-down list.

 Custom: When you select Custom, this field becomes editable you can enter 
you own construction.

 Single File for All Sheets: All separations of a job are saved in one PPF file.

 Single File per Sheet: Each PPF file contains all separations of both the front 
and back of a press sheet.

Save files in Directory hierarchy: Select this check box if you want the InkDrive files to be 
saved according to the file name hierarchy.

Same directory: Select this check box if you want all of the InkDrive files to be 
saved in the same directory, regardless of the file name.

File Name This field displays the file name under which the InkDrive files will be saved. The 
file name may use the following variables: $ORDER, $JOB, $SIGNATURE, 
$WEB, $SIDE, $SEPARATION.

The variables will be separated by a slash if you select Save files in directory 
hierarchy. This means that a directory will be made according to the file name.

The variables will be separated by an underscore if you select Save files in same 
directory. 

Export directory Specify the directory where the InkDrive file will be located. Use the Browse 
button to locate the directory.

For example:

\\$COMPUTER\PressRoot\$PRESS\

Extension Specify the file extension to be used for the InkDrive files. By default, this is ‘ppf’.

Options Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Replace existing file: If a file with the same name already exists in the specified 
directory, then the file is automatically replaced by the new file.
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Leave existing file, add sequence number to new file name: If a file with the same 
name already exists in the specified directory, then a revision number is added 
to the name of the new file.

Post-process files with
script

Select this check box if you want to run an external script after the InkDrive file 
was written. 

Script options: You can specify script options, which will be passed to the script 
as space separated arguments.

PressTune Tab

Create PressTune files Select the check box to create PressTune files which are used for the PressTune 
print optimization solution. You can use variables to specify the file names and 
location.

PressTune Project The folder where the PressTune project files will be saved.

File Name The file name of the PressTune project file. The file name may use the following 
variables: $ORDER, $JOB, $SIGNATURE, $WEB, $SIDE, $SEPARATION. An 
extension must not be used.

Template The template of the PressTune project file.

Target The target of the PressTune project file. 

Export directory Specify the directory where the PressTune files will be located. Use the Browse 
button to locate the directory.

For example:

\\$COMPUTER\PressTuneRoot\$PRESS\

Replace existing file If a file with the same name already exists in the specified directory, then the file 
is automatically replaced by the new file.

Leave existing file, add
sequence number to new

file name

If a file with the same name already exists in the specified directory, then a 
revision number is added to the name of the new file.

Post-process file with script: Select this check box if you want to run an external 
script after the PressTune file was written. 

Script options: You can specify script options, which will be passed to the script 
as space separated arguments.
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Generic SD (Sign and Display Printer)

The Generic SD Task Processor represents a generic Sign and Display digital 
printing device, for which you can define settings for specific job requirements.

Associated Resources

When you select the Generic SD Task Processor in the System Overview, the 
following associated resource categories are displayed in the Resources pane:

 Alignment Pin Sets, Contrast Adjustments, Curves Adjustments, Color Books, 
Finishing Hub, Marks, Media Hub, Profiles, Device Link Profiles, Print Modes

Generic SD Printer 
– Image Settings

The Image settings mainly control the rendering of the pages. You can access 
these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Separation Output and Order

Specify which separations should be output, and in which order. The initial sort 
order places the process colors on top, in the same order as specified by the job’s 
color space. Spot colors come after the process colors, sorted alphabetically. You 
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can reorder the separation order with the Up and Down arrows or by dragging 
and dropping. 

These check boxes are only accessible when the ‘Application Decides’ check box 
is deselected in the Separation settings (Hot Tickets only). If ‘Application 
Decides’ is selected, you can make no changes to the separation output and 
order: This is then controlled by the settings of the input document (as gener-
ated by a front end application, such as Quark).

NOTE: Process colors are not listed if there is no Press Task Processor in the 
Production Plan or if you are editing a Parameter Set. 

Image

Reading You need to set the Reading yourself because Apogee does not know what media 
is used for the print job. The preview icon on the right dynamically reflects the 
chosen state.

Reading: Determines the mirror setting of the image to be output:

 Right Reading

 Wrong Reading

Orientation You can select one of the four standard orientations (0, 90, 180, 270). You can 
also select the Optimized option to have Apogee select a specific orientation to 
avoid as much medium waste as possible. If you selected the “Select Automati-
cally” check box, the Orientation is automatically set to “From Output Size”, and 
you will need to specify horizontal and vertical positioning.

Border You can select a predefined border from the drop-down list as defined in the 
Border Resource category. Select None if you do not want to have a border at all. 

You can enter text as a comment in the Slug Lines section. If the selected border 
contains the comment marks, the text will be printed. If not, it will be ignored. 

CAUTION: You cannot select a border containing border marks as the plate size is 
not known. 

Output Size You can select a predefined output size. You either do this manually or have 
Apogee do it for you according to the page or sheet size and the border.

If you choose to do it manually, select one of the available output sizes, or select 
<Manual from input> or <Manual from media> from the drop-down list. 
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Manual from input: The output size is calculated from the page/sheet size and 
selected border in the pages of the incoming documents. The resulting Output 
Size is not displayed in the list.

Manual from media: The output size is calculated from the media size. This is only 
relevant if a specific media is selected.

Select Automatically Select this check box to activate automatic selection. Apogee will then take the 
orientation from the predefined Output Size - you cannot change this. 

Fallback Here, you can select a fallback output size in case the input has no output size 
specified.

Position Image within
Output Size

Horizontal: Choose Center, or specify an offset in mms.

Vertical: Choose Center, or specify an offset in mms.

Scale content Use scaling to scale the page content. This does not scale the border, but marks 
that are relative to the sheet are repositioned and not scaled. 

From the drop-down list, you can turn scaling off, or you can do the scaling 
manually by selecting Manual. This activates the following settings:

Width and Height You can specify the scaling percentages for width and height scaling. 

 For pages, Width and Height have their starting point in the lower left corner. 
Width goes along the bottom edge and Height along the left edge.

 For imposed flats, Width is along the gripper edge and Height along the side 
edge. 

Constrain proportions Select the Constrain Proportions option if you want to keep both values equal. 
Selecting this option will copy the horizontal scale value into the vertical scale 
field. 

Clip This option specifies what will happen if the image is bigger than the output size.

Clip image: Any areas of the image that fall outside the output size are clipped.

Notify: The job will fail with a user interaction notification. The notification 
specifies the image and output sizes, and provides a 'Clip and Continue' option.

Base imaging on This option specifies how images will be clipped:

Trimbox: The image is clipped to the Trimbox size.

All content: The image is clipped to the Mediabox size.
Apogee Reference Guide



 

15 PRINT TASK PROCESSORS 927
Slug Lines

In this pane you can enter up to four comments that can be part of a border. 
These comments are held in the variables $COMMENT1, $COMMENT2, 
$COMMENT3 and $COMMENT4. 

Each comment can contain one or more variables such as $DATE or $COMPANY. 
The comment variables themselves, however, cannot be part of the comment. 

For example: Comment 1: Printed by PrintRite on $DATE for $COMPANY.

Generic SD Printer 
– Print Settings

The Print settings define the media you will print on, the quality of printing, and 
various other options. These settings are specified when preparing the job in the 
Layout Editor. See “Layout Editor” on page 485.
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Generic Digital Press

The Generic Digital Press Task Processor represents a generic digital printing 
device for commercial jobs, for which you can define settings for specific job 
requirements.

Associated Resources

When you select the Generic Digital Press Task Processor in the System 
Overview, the following associated resource categories are displayed in the 
Resources pane:

 Borders, Color Books, Device Screens, Device Print Modes, Marks, Media, 
Output Sizes, Profiles, Profile Link Exceptions, Device Link Profiles, Quality

Generic Digital Press – Image Settings

The Image settings mainly control the rendering of the pages. You can access 
these settings:

 When creating Parameter Sets (see “Managing Parameter Sets” on 
page 715). Here, you will see a ‘Lock in Production Plan’ check box (selected 
by default). If this check box is selected, the settings will be initially locked in 
the Settings pane. If this check box is deselected, the settings can be edited in 
the Settings pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in “Settings Pane (Ticket Editor)” 
on page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.
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Separation Output and Order

Specify which separations should be output, and in which order. The initial sort 
order places the process colors on top, in the same order as specified by the job’s 
color space. Spot colors come after the process colors, sorted alphabetically. You 
can reorder the separation order with the Up and Down arrows or by dragging 
and dropping. 

These check boxes are only accessible when the ‘Application Decides’ check box 
is deselected in the Separation settings (Hot Tickets only). If ‘Application 
Decides’ is selected, you can make no changes to the separation output and 
order: This is then controlled by the settings of the input document (as gener-
ated by a front end application, such as Quark).

NOTE: Process colors are not listed if there is no Press Task Processor in the 
Production Plan or if you are editing a Parameter Set. 

Image

Reading You need to set the Reading yourself because Apogee does not know what media 
is used for the print job. The preview icon on the right dynamically reflects the 
chosen state.

Reading: Determines the mirror setting of the image to be output:

 Right Reading

 Wrong Reading

Orientation You can select one of the four standard orientations (0, 90, 180, 270). You can 
also select the Optimized option to have Apogee select a specific orientation to 
avoid as much medium waste as possible. If you selected the “Select Automati-
cally” check box, the Orientation is automatically set to “From Output Size”, and 
you will need to specify horizontal and vertical positioning.

Border You can select a predefined border from the drop-down list as defined in the 
Border Resource category. Select None if you do not want to have a border at all. 

You can enter text as a comment in the Slug Lines section. If the selected border 
contains the comment marks, the text will be printed. If not, it will be ignored. 

CAUTION: You cannot select a border containing border marks as the plate size is 
not known. 
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Output Size You can select a predefined output size. You either do this manually or have 
Apogee do it for you according to the page or sheet size and the border.

If you choose to do it manually, select one of the available output sizes, or select 
<Manual from input> or <Manual from media> from the drop-down list. 

Manual from input: The output size is calculated from the page/sheet size and 
selected border in the pages of the incoming documents. The resulting Output 
Size is not displayed in the list.

Manual from media: The output size is calculated from the media size. This is only 
relevant if a specific media is selected.

Select Automatically Select this check box to activate automatic selection. Apogee will then take the 
orientation from the predefined Output Size - you cannot change this. 

Fallback Here, you can select a fallback output size in case the input has no output size 
specified.

Position Image within
Output Size

Horizontal: Choose Center, or specify an offset in mms.

Vertical: Choose Center, or specify an offset in mms.

Scale content Use scaling to scale the page content. This does not scale the border, but marks 
that are relative to the sheet are repositioned and not scaled. 

From the drop-down list, you can turn scaling off, or you can do the scaling 
manually by selecting Manual. This activates the following settings:

Width and Height You can specify the scaling percentages for width and height scaling. 

 For pages, Width and Height have their starting point in the lower left corner. 
Width goes along the bottom edge and Height along the left edge.

 For imposed flats, Width is along the gripper edge and Height along the side 
edge. 

Constrain proportions Select the Constrain Proportions option if you want to keep both values equal. 
Selecting this option will copy the horizontal scale value into the vertical scale 
field. 

Clip This option specifies what will happen if the image is bigger than the output size.

Clip image: Any areas of the image that fall outside the output size are clipped.

Notify: The job will fail with a user interaction notification. The notification 
specifies the image and output sizes, and provides a 'Clip and Continue' option.
Apogee Reference Guide



 

15 PRINT TASK PROCESSORS 931
Base imaging on This option specifies how images will be clipped:

Trimbox: The image is clipped to the Trimbox size.

All content: The image is clipped to the Mediabox size.

Rule-up

You can have a proofer print a rule-up. These are lines that correspond with the 
expected page positions on the template and the actual crop box from the pages.

Pages You can print a rule-up for:

 Artbox

 Trimbox

 Bleedbox

 Mediabox

Imposition You can print a rule-up for:

 Press Sheet

 Expected Page Size

Output You can print a rule-up for:

 Output Size

Die/CAD  Design lines: Select the check mark to choose a Line Appearance Set from 
the list or click the arrow to open the Line Appearance editor. See 
“Finishing Hub” on page 993.

For each of the above, you can select the color from the drop-down list (Red, 
Green, Blue, etc.), and a point size for the lines (0,25 pts, 0.50 pts, 0.75 pts 
or1.00 pts). You can also specify whether you want a dashed or a solid line. 

NOTE: You can only print a rule-up if you use an Impose Task Processor in your 
Production Plan.
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Slug Lines

In this pane you can enter up to four comments that can be part of a border. 
These comments are held in the variables $COMMENT1, $COMMENT2, 
$COMMENT3 and $COMMENT4. 

Each comment can contain one or more variables such as $DATE or $COMPANY. 
The comment variables themselves, however, cannot be part of the comment. 

For example: Comment 1: Printed by PrintRite on $DATE for $COMPANY.

Generic Digital Press – Print Settings

The Print settings define the media you will print on, the quality of printing, and 
various other options. You can access these settings:

 When creating Parameter Sets (see Managing Parameter Sets on page 715). 
Here, you will see a ‘Lock in Production Plan’ check box (selected by default). 
If this check box is selected, the settings will be initially locked in the Settings 
pane. If this check box is deselected, the settings can be edited in the Settings 
pane.

 In the Settings pane, in the Plan tab of the Job Manager and the Ticket Editor. 
The settings may be initially locked, as indicated by the Lock icon. If you edit 
the job, you can unlock them as described in Settings Pane (Ticket Editor) on 
page 330.

Name

The name of the Parameter Set as it will appear in the Production Plan. When 
you create a Parameter Set, you should specify a Parameter Set name. You can 
always change this name later by editing the job, choosing the Parameter Set 
from the Task Processor in the Plan tab, and unlocking the settings in the 
Settings pane.

Media and Quality

In this tab, you can select a specific medium or a medium type from the drop-
down list.

Substrate Select the substrate you want to print on. The list contains all Substrate 
resources. 

Quality Choose the quality map to be used for printing. The available quality maps 
depend on the selected device.
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Inks Select the ink set from the drop-down list. The list contains all of the ink sets 
currently available in the Ink Sets Resource category. Changing the ink set has 
an impact on the Separation and Image operations. However, you will not be 
alerted or notified of any change in those operations.

Color Management

Color Management affects the rendering of the imaging and the final quality of 
the print.

Color Profile Use PDF Output Intent: Select this option if you want Apogee to honor the appli-
cation’s supplied color profile. Note that this is only possible when receiving PDF 
files.

list of recommended color profiles: Select a color profile from the list to override 
any automatic selection. Recommended color profiles are those that match the 
media family of the selected substrate.

Fallback This option determines what should happen if the automatic lookup fails, or if 
the input does not provide a color profile (output intent). You can choose an 
option from the list of recommended color profiles.

Rendering Intent There are 5 different Rendering Intents available, although not all profiles 
contain Look Up tables (LUTs) for each of the 4. Usually there are only 3 repre-
sented. In this case often a duplicate of one Look Up table is used for missing 
Render Intent LUT. The Rendering Intent defines the way the source colors are 
mapped to the destination space.

The following rendering intent options are available:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the 2 profiles is preserved. White of 
source color space is simulated with CMYK values from the destination color 
space. The consequence is that every white object/area is covered with certain 
ink amounts.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.
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Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy.

Process Relative/Spots Absolute: Combines Relative Colorimetric for process 
colors and Absolute Colorimetric for spot colors.

NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.

Advanced CMM Recent developments in the Color Management engine offer ‘Smart CMM’, 
which provides better blending of converted spot colors. However, this comes at 
a small cost: it is a little slower.

Press Repurposing -
Process Colors and

Converted Spots

Disabled: Disables press retargeting. This is the default setting.

Retarget using source press ICC profile: Select this option if there is a chance that 
some of your jobs have CMYK colors which are not defined as process colors but 
as deviceN colors, and you want to choose an ICC profile to be used as interme-
diate color space.

Retarget using device link profile: Select this option if there is a chance that some 
of your jobs have CMYK colors which are not defined as process colors but as 
deviceN colors, and you want to choose a device link to be used as intermediate 
color space.

Source ICC profile: Choose a standard profile that will be used as intermediate 
color space.

Retarget device link: Choose a link from standard profile to ink-jet device profile 
that will be used as intermediate color space.

Exception: Select one of the following Exception options: <None>, Keep 100% 
K, Normal, Preserve K, Preserve Pure Colors.

Auto-select: Select this check box if you want Apogee to automatically select an 
Exception (the Exception field is then disabled).

Apply black point compensation: Apogee uses a built-in algorithm to adjust for 
differences in the black points of the selected source and destination profiles.

Spot Colors Accurate spot color mixing: In this enhanced mode, spot color visualization is 
superior to the standard color-managed mode. You can choose from the 
following:
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 Off

 Max. 2 colors

 Max. 3 colors

Use Press Paper White: Pantone/spot color inks are transparent and appear 
differently when printed on different substrates. Normally, you should select 
this option when creating a proof which will be used by the printer to print a spot 
color on the Press (when the simulated spot color on proof needs to resemble the 
final printed result). In this case, the paper white from the press profile is used 
in the color calculation.

If this option is not selected, the measured paper white of the color book is used 
in the calculation of the spot colors. The option should therefore be deselected 
when the simulated spot colors on the proof are compared to the color book 
reference prints (with a measurement device, for example).

NOTE: A spectral press profile is required for this option.

Print

Copies Select the number of copies to print.

Layout preparation Specify the layout:

Automatic: The default value for layout preparation to calculate FlipX/Y based 
on the Lookup table.

Single sided: For unbound single sided jobs.

Two sided flip Y: If imposition is in portrait mode, or portrait PDF dropped 
without impose.

Two sided flip X: If imposition is in landscape mode, or landscape PDF dropped 
without impose.

Device Print Mode Allows you to select a Device Print Mode (if any are available). For more 
information, see Device Print Modes on page 991.

Control Digital Press Rip Put Job On Hold: If this check box is selected, the job stays on hold at the input 

channel until you continue it.

DFE Job Create:  Select a job type; Single Job, Job per Sheet, Job per Book Signature, or 
Job per Page from the drop-down list.
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Job Name:  Enter the Job name. The Job name may use the following variables: 
$PART, $BOOKSIGNATURE, $RLPAGE, $VERSION, $FLOWNAME, etc.

Inline Finishing

Sorter Mode Select of the following sorter mode options from the drop-down list:

 Collate

 Collate without shift

 Group

 Group without shift

Number of Copies for Offset Enter the number of copies per offset, applicable only for Sorter Mode Collate 
and Group options.

Paper Output Enter the paper output type from the drop-down list.

Page Order  Forward

 Reverse

Face Up Printing Select the check box to enable face up printing.

Offline Finishing

Create JDF for finishing
equipment

Select this check box to create a JDF which contains information for finishing 
equipment.

Create JDF Select to create JDF for finishing equipment:

 After impose 

 After imaging

Cut Blocks Select to create cut-blocks type depending on the product type in the job:

 Per Page

 Per Foldsheet

 Per Foldsheet (trim)

 Automatic
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NOTE: To cut different sheets differently, you need to group them in production 
sets and adjust the cutting per set. Apogee Prepress determines the job type by 
checking the type of the first product in the Product list and cuts all sheets of the 
job according to that type. As such, a job that mixes different product types must 
be set-up very carefully. You cannot have different types of cutting on the same 
sheet.

JDF version Select the JDF version.

Include preview Apogee Prepress can create a preview of the side(s) of the sheet to be cut. This 
allows to check whether the currently loaded cutting instructions correspond 
with the stack of sheets that is on the table. The preview files are created in the 
same directory as the cut file itself and with the same name, but the extension is 
different.

 Front: Creates an image preview of the front side.

 Back: Creates an image preview of the back side.

Create Specify the file creation. Select the required option from the drop-down list.

 Custom: When you select Custom, this field becomes editable you can enter 
you own construction.

 Single File for All Sheets: All separations of a job are saved in one PPF file.

 Single File per Sheet: Each PPF file contains all separations of both the front 
and back of a press sheet.

Save files in Directory hierarchy: Select this check box if you want the InkDrive files to be 
saved according to the file name hierarchy.

Same directory: Select this check box if you want all of the InkDrive files to be 
saved in the same directory, regardless of the file name.

File Name This field displays the file name under which the InkDrive files will be saved. The 
file name may use the following variables: $ORDER, $JOB, $SIGNATURE, 
$WEB, $SIDE, $SEPARATION.

The variables will be separated by a slash if you select Save files in directory 
hierarchy. This means that a directory will be made according to the file name.

The variables will be separated by an underscore if you select Save files in same 
directory. 

Export directory Specify the directory where the InkDrive file will be located. Use the Browse 
button to locate the directory.
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For example:

\\$COMPUTER\PressRoot\$PRESS\

Extension Specify the file extension to be used for the InkDrive files. By default, this is ‘ppf’.

Options Truncate file names exceeding 31 characters: If the filename is longer than the 
specified amount, Apogee truncates it. Select this check box to prevent file 
names from becoming too long.

Replace existing file: If a file with the same name already exists in the specified 
directory, then the file is automatically replaced by the new file.

Leave existing file, add sequence number to new file name: If a file with the same 
name already exists in the specified directory, then a revision number is added 
to the name of the new file.

Post-process files with
script

Select this check box if you want to run an external script after the InkDrive file 
was written. 

Script options: You can specify script options, which will be passed to the script 
as space separated arguments.
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16 Task Processor Resources

This section provides information on the Apogee Resources that are available for 
each Task Processor. Resources are collections of objects such as fonts, preflight 
profiles, or calibration curves that are required by the Task Processors.
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About Task Processor Resources

Most Resources can be configured and customized in the System Overview, and 
you can create, edit, and delete Resources in the available Resource categories. 
The Resource pane displays the resource categories that are available for the 
currently selected item in the System Overview. The displayed resources will 
therefore vary in accordance with the selected item. The first icon in the list is the 
Parameter Sets icon, which allows you to create and manage Parameter Sets for 
the Task Processor (see “Managing Parameter Sets” on page 715).

Administrator access level only!

Apogee Impose 
Resources

Many of the Apogee Impose resources can be accessed from within the Apogee 
Impose windows for viewing the details of the resource, managing and even 
creating new ones. This is mainly possible when creating your Product in the 
Product editor or when viewing the imposition with the Inspector. 

For example, the Shingling rules can be opened by choosing Manage Shingling 
Rules in the Shingling drop-down list in the Product editor.
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Alignment Pin Sets

Alignment pins represent a fixed set of alignment positions to which the media 
can be aligned on a print layout.

Administrator access level only!

Associated Task Processors

The Alignment Pin Sets Resource category is available for:

 Generic SD (Sign and Display Printer) and other SD printers

Overview

Name and Pin Width The name of the pin set and the width of the physical pins. Leave at 0 if the align-
ment positions take up no physical space on the bed.

Reference Alignment pin set corner references. Select one of the options from the drop-
down list: Bottom / Left, Bottom / Right, Top / Left, Top / Right, or Swap Left/
Right alignment edges in entire Alignment Pin Set.

Pin Configuration Several pin configurations can be specified in a set, e.g. Small, Medium and 
Large, with different alignment positions.

Name The name of the pin configuration.

Machine ID Enter a string that you want to send to the Automatic Board Feeder (ABF) to 
activate the chosen pin configuration. Leave empty if not applicable.

Alignment Position All the individual alignment positions for the selected pin configuration are 
shown in this list; for each position you can set the distance between the align-
ment pin and the printer’s default side lay, and whether to align left, right or 
against both sides of the pin.
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Apogee Preflight Action Lists

Action lists are useful for performing repetitious tasks either within a single PDF 
document or in multiple PDF documents.

An action list usually consists of several actions or checks and once you have 
created an action list, you can re-use it to perform these tasks in the predefined 
sequence.

Administrator access level only!

Associated Task Processors

The Apogee Preflight Action Lists Resource category is available for the 
following Task Processors:

 Apogee Preflight

Apogee Preflight Action Lists Overview

The Apogee Preflight Action Lists overview lists all available Apogee Preflight 
action lists.

A set of action lists is provided by default with your system. Additional actions 
list can be obtained and imported. Some action lists, e.g. Hairline in the 
Standard category, can be duplicated and customized.

In the Production Plan, the available action lists are filtered depending on their 
position in the plan.

Category In this list you can select the action lists by category. For example:

 Color Management

 Standard

Type The Job Type list is used in combination with Category to filter Apogee Preflight 
Actions displayed in the Action List pane. You have 3 options:
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 Any: displays all actions of the selected category for all job types

 Wide Format Jobs: displays actions of the selected category only for the Wide 
Format Jobs.

 Other Jobs: displays actions of the selected category for other jobs. 

Apogee Preflight Action
Lists

The Action Lists pane displays the action lists as selected in the Category list. 
Select an action list to see its settings in the pane below.

Name The name of the action list as it appears in this resource and the Apogee Preflight 
task processor.

Description A short description of what the action list does.

Tabs Depending on the type of action list, you will see Settings and/or Info tabs that 
define the behavior of the action list:

 Settings: in this tab you set the criteria and options for the preflight checks

 Info: an explanation of what the action list does

 Availability: Make Action List available for either Wide Format Jobs, or 
other jobs.

NOTE: You can filter the list of action lists by typing keywords in the Search box 
at the top of the list.

 To create a new Action List

Editable action lists can be customized or duplicated to create a new action list.

NOTE: An action list can be customized if it has a Settings tab and in this case the 
Duplicate option is available when clicking the cogwheel.

1 Unlock the Apogee Preflight Action Lists resource.

2 In the Apogee Preflight Action List, choose the action list that you want to 
duplicate, e.g Hairline in the Standard category.

Enter ‘hairline’ in the search box to locate this action list.

3 Click the cogwheel and choose Duplicate.

A duplicate appears in the list with the same name and the - copy extension.

4 In the settings pane below, rename the action list and enter a Description.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 945
5 Modify the Settings as required.

For example change the width.

NOTE: You cannot edit the Info tab.

6 Lock the resource.

The action list name is updated in the list. This new action list is now also 
visible in the Apogee Preflight task processor parameter settings.

 To edit an Action List

NOTE: An action list is editable if the Duplicate option is available when clicking 
the cogwheel.

1 Unlock the Apogee Preflight Action Lists resource.

2 In the Apogee Preflight Action List, choose the action list that you want to 
edit, e.g Hairline in the Standard category.

Enter ‘hairline’ in the search box to locate this action list.

3 In the settings pane below, modify the Settings as required.

For example change the width.

NOTE: You can’t edit the Info tab.

4 Lock the resource.

The action list is locked with the new settings.

 To import an Action List

1 In the Apogee Preflight Action Lists resource, click the cogwheel and choose 
Import.

2 Browse to the location where you saved your Action List files with 
extension .MIME, and click Open.

The imported action list is added to the list and the category is also added in 
Category list if this list does not yet exist.
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 To export an Action List

1 In the Apogee Preflight Action Lists resource, click the cogwheel and choose 
Export.

2 Browse to the location where you want to save your Action List files with 
extension .MIME, and click Save.

The exported action list is saved in the location specified.
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Apogee Preflight Profiles

To preflight PDF documents, you can use Profiles. A Profile is a collection of 
criteria which a PDF document should meet to be a valid PDF.

Through these Profiles, you can thoroughly check your documents and make 
corrections before processing. 

A set of profiles is provided by default with your system. Some profiles can be 
duplicated and customized. Use the cogwheel commands to import, export, 
remove or duplicate job profiles.

NOTE: You can also select Preflight profiles for a preflight check when exporting 
results through the Export Task Processor. For more information, see Profiling 
in the “Export Settings” on page 886.

Administrator access level only!

Associated Task Processors

The Preflight Profiles Resource category is available for the following Task 
Processors:

 Apogee Preflight

 Conditional

 Export

Apogee Preflight Profiles Overview

The Apogee Preflight Profiles overview lists all available Apogee Preflight 
Profiles.

Apogee Preflight Profile This is the list of all the available profiles. Select a profile in the list to see more 
information in the pane below.
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Name The name of the profile as it appears in this resource and as job profile in the 
Apogee Preflight task processor.

Description A short description of what the profile does.

Info A detailed explanation of what the profile does and where you can use it in the 
production plan.

NOTE: You can filter the list of profiles by typing keywords in the Search box at 
the top of the list.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 949
Auto Fit Rules

This resource provides job-wide preferences for automatic imposition of 
unbound products with Apogee Impose.

 Double-click the Auto Fit Rules icon for an overview of the available rules.

Associated Task Processors

The Auto Fit Rules resource is available for the following Task Processors:

 Impose

 Step and Repeat

 Raster Impose

 Digital Step and Repeat

Administrator access level only!

Auto Fit Rules Overview

The Auto Fit Rules dialog box lists all available resources in the left column.

 Click a rule in the left column to display its settings.

Strategy

The auto fit strategy helps you find a balance between keeping the number of 
plate sets to a minimum and printing extra copies. You can choose between two 
strategies that affect the copy counts of the parts by allowing extra copies of a 
part to be printed if this enables more elements to be combined on a sheet. 

NOTE: Elements are the instances of parts placed on a Press Sheet.
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 Fewer sheet layouts: checks the dirty waste, i.e. the area of the Press Sheet 
that contains extra copies. When you select this strategy, you can set the 
amount of dirty waste with the ‘Allow extra printed material’ slider.

 Less waste: this strategy checks the total waste which is the sum of extra 
copies and the blank paper. This strategy will generally create more Press 
Sheets. When you choose this strategy you can specify a percentage of 
acceptable waste in the ‘Keep waste below’ box.

Sheet Layout

These settings control how the elements are organized on the sheet.

Arrange Parts Keeping the elements that relate to a particular part together or in a certain 
arrangement may be a requirement for cutting, reducing color variations across 
a sheet, or for other reasons. You have the following options:

 Stack elements one by one: Stacks all elements on top of each other or 
next to each other until it reaches the end of the sheet, then starts a new 
column/row and repeats stacking elements.

 Pack elements in blocks: All the elements of a part are grouped together 
in the smallest possible rectangular block.

 Pack elements in blocks, vertically only: Elements of a part are grouped to 
produce a vertical layout with no color variation in the direction of the 
Press Sheet movement.

 Pack elements in blocks, horizontally only: Elements of a part are grouped 
to produce a horizontal layout with no color variation in the direction of 
the Press Sheet movement.

 Stack elements in separate columns: A new column is created for the 
elements of each part.

Rotate Elements Here you can choose when and how elements are rotated in order to maximize 
the available space on the Press Sheet. You have the following options:

When: 

 Never: the orientation is left as defined in the parts

 Always: you may have a preference for rotation that you always want to 
apply; in this case you can also select the rotation direction
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 When it produces a better fit: elements will be rotated if more elements 
can be placed on a single Press Sheet; in this case you can also select how 
to rotate and the rotation direction.

How: 

 Rotate all elements in the same way: all the elements of all parts are 
rotated in the same direction if possible; otherwise no elements are 
rotated.

 Rotate all elements of the same part in the same way: (default) all the 
elements of the part are rotated in the same direction if possible; other-
wise none of the elements of the part are rotated; part A elements may be 
rotated while part B elements are not rotated.

 Rotate all elements of the same size in the same way: all the elements of 
the same size (dimension) are rotated in the same direction.

When you select the check box Arrange all elements of the same size in the 
same direction, parts that have the same dimensions but different orien-
tation are rotated and they get the same orientation in the end. If the 
check box is not selected (default), parts that have the same dimensions 
but different orientation can be rotated independently of each other.

 Rotate elements individually: elements may be rotated differently to 
produce the tightest fit but possibly a layout which is difficult to cut.

When rotating elements, rotate by: When rotating elements, you must specify in 
which direction you want to rotate the elements.

 90 degrees: Turn all elements counter-clockwise by 90 degrees

 270 degrees: Turn all elements clockwise by 90 degrees

Lowest folio

This option determines on which side of the press sheet the lowest folio of a part 
is placed.

Place Select one of the options:

 On Front

 On Back
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NOTE: When printing a folded unbound work, the lowest folio page can be on the 
either side of the product, depending on the pagination scheme.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 953
Auto Impose Rules

The Auto Impose Rules resource provides job-wide settings to control the 
automatic imposition process referred to as Auto Impose. These settings conse-
quently have no effect on jobs which are imposed manually. The settings for 
bound jobs concern the following:

 the placing of Fold Sheets on a Press Sheet

 the Workstyle

 the Assembly of several book signatures

 Double-click the Auto Impose Rules icon for an overview of the available 
rules in the Auto Impose Rules dialog box.
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Associated Task Processors

The Auto Impose Rules resource category is available for:

 Impose

 Raster Impose

Administrator access level only!

About Auto Impose 
Rules

Apogee Impose selects the Folding Scheme to use to arrange the Pages of a 
Product by consulting a list of available Folding Schemes in the set you choose 
when setting up Auto Impose. Apogee Impose looks for the largest possible 
scheme that fits on the given Press Sheet size, taking the following aspects into 
account:

 trim size

 overfold

 trim margins

The selected Fold Sheet is then checked against the Placement rules and Apogee 
Impose places the Fold Sheet on the Press Sheet or moves onto the next Folding 
Scheme if it is not suitable. Apogee Impose also tries to put additional Fold 
Sheets on the same Press Sheet if there is sufficient space.

In addition, Apogee Impose can change the workstyle and order the book signa-
tures in an assembly to optimize the imposition arrangement.

Auto Impose Rules Overview

The Auto Impose Rules dialog box lists all available Auto Impose Rules resources 
in the left column with their settings in the right column.

Name A meaningful name of the rule, e.g. Lowest folio on Back, Magazine jobs

Selecting Fold Sheets The priority and strictness of the placement rules can be set here. Priority can be 
set for rules with the same strictness, by moving the rules up and down in the 
Rule table. The following rules are possible:
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 Largest fold sheet: instruction to use the largest possible Fold Sheet, i.e. 
the one with the most pages. The strictness setting is always Prefer but you 
can control this priority by moving the rule in the list.

 Align lays: instruction to place a Fold Sheet so that its lay is in the same 
corner as the Press Sheet lay. Default strictness setting is Must be met. This 
rule ensures that the distance between the Fold Sheet and the edge of the 
Press Sheet is constant.

NOTE: This rule is ignored when the alternative workstyles Work & Turn 
and Work & Tumble are applied.

 Lowest folio: instruction to put the lowest folio on the Front or Back of a 
Press Sheet. The default strictness setting is Do not consider that puts the 
front of the Fold Sheet on the front of the Press Sheet. This rule only 
applies for the Sheetwise or Perfecting workstyle. Apply to cover sheets 
only can also be selected for this rule.

 Maximize page count: instruction to search for alternative arrangements 
using multiple, smaller Fold Sheets to reduce paper waste. Default strict-
ness setting is Do not consider while Must be met cannot be selected. This 
rule also includes a check box to set the Maximum number of extra cuts to 
avoid complex layouts with too many extra cuts.

 Stitchable Fold Sheets: a built-in rule for nested assemblies that ensures 
that the resulting Fold Sheet can be stitched, e.g. an F8-2 is stitchable 
while an F8-5 is not.

 Single leaf (F2-1): a built-in rule to avoid the F2-1 Folding Scheme 
whenever possible; this scheme is only used when 2 pages are left or when 
required for the given Press Sheet Size.

NOTE: The latter 2 rules are not visible and cannot be switched off.

Placing Fold Sheets Select the Single-row schemes: Arrange according to Page Arrangement 
check box to have covers and irregular single-row schemes arranged according 
to the head and foot Page Arrangement settings of the Binding Options.

Alternative workstyle This setting instructs Apogee Impose to use a different workstyle than the 
default Sheetwise workstyle when printing several Folding Sheets on a single 
Press Sheet, e.g. to print a cover or to print partial book signatures on a larger 
Press Sheet.
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If possible, print N-up or
partial signature using

Select this option to print multiple Fold Sheets using an alternative workstyle. By 
default this is not selected and Press Sheets are printed using the Sheetwise 
workstyle. The two alternative workstyles are:

 Work & Turn

 Work & Tumble

N-up means that the alternative workstyle is applied in the following cases:

 if the same book signature can be used an even number of times

 if different book signatures can all be used an even number of times

NOTE: Alternative workstyles are never applied for printing on a perfector press.

Assembly These settings deal with the order of the book signatures in the Product assembly 
and whether partial signatures must be handled differently.

Book signature order: book signatures can be ordered in the assembly in two 
ways:

 Largest first: If a Product consists of book signatures of different sizes, 
Apogee Impose sorts them in descending order with the largest in front 
and the smallest at the end.

 Smallest first: Apogee Impose sorts book signatures in ascending order 
with the smallest in front and the largest at the end.

NOTE: The Parts of a Product also determine the order of book signatures and 
have precedence over the Assembly settings here. In other words, a Cover book 
signature is always placed before Body book signatures in the assembly.

Partial book signatures: Partial signatures are book signatures that have fewer 
pages than the largest book signature in the assembly. Ideally, an assembly must 
have full book signatures at both edges and partial signatures in between. Select 
the Keep away from edge by check box and enter the number of full book signa-
tures that must be between the front or end and the partial signature.
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Binding Options

The Binding Options resource defines the bindings that are available for a 
Product and its Parts. Binding is a key aspect of imposition and these resources 
provide the settings for a wide variety of stacked and nested assemblies of book 
signatures.

 Double-click the Binding Options icon for an overview of the available rules 
in the Binding Options dialog box.

Associated Task Processors

The Binding Options resource category is available for:

 Impose
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 Raster Impose

Administrator access level only!

Binding Options Overview

The Binding Options dialog box lists all available Binding Options resources in 
the left column and the settings for each resource in the right column.

Assembly

The assembly type is the top-level setting for binding and they apply for the 
entire product.

NOTE: In the Job Ticket Editor, the Assembly settings can only be viewed in the 
Product Editor and not in the Part Editor or the Inspector.

Stacked or Mixed This assembly type is chosen for perfect-bound jobs; the book signatures are 
stacked side-by-side and then glued together. Also choose this assembly type for 
mixed binding situations that combine stacked and nested assemblies.

Nested This assembly type is chosen for saddle-stitched jobs; the book signatures are 
bound by stitching using a wire through the spine, or by stapling.

Number Up Binding Number-up binding (also referred to as N-up or multi-up binding) combines two 
or more book signatures on a single bindery signature which is subsequently cut 
to produce two or more book signatures.

Click the drop-down list to see the different multi-up binding options:
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 1-up is the default value and applies for regular jobs

 2-up, 3-up, 4-up: for regular multi-up jobs; two, three or four identical book 
signatures are produced with the same orientation

 2-up, 3-up and 4-up Come and Go: two different book signatures are 
produced and the orientation of the book signatures is flipped

 2-up, 3-up and 4-up Come and Go (reversed): the page order and orientation 
of the book signatures are reversed

NOTE: A so-called True Come and Go job is possible with a stacked assembly 
and a 2-up Come and Go binding or a 2-up Come and Go (reversed) binding.

Cut Margin This option is only enabled for multi-up bindings. 

Apply page trim margins at cut: You can choose to apply or not to apply the page 
trim margins set below. This option can be disabled if the middle cut is good 
enough as a trim cut.

Extra gutter: Enter a value here if you want an extra gap between the Fold Sheets, 
for example to compensate for the width of the cutting blade. 

For a so-called dead-cut, clear the check box and set the Extra gap to 0.
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Fold Sheet

These options control how pages are arranged on the Fold Sheet and also affect 
the multi-up arrangement.

Page arrangement  Head to head: arranges pages in such a way that the head of the pages is on 
the closed head of the book signature, suitable for jogging to the head

 Foot to foot: arranges pages in such a way that the foot of the pages is on the 
closed head of the book signature, suitable for jogging to the foot

 From folding scheme: the page arrangement set in the folding scheme is used

 From folding scheme, reversed: the page arrangement set in the folding 
scheme reversed is used

Overfold The overfold is a small area of the folded sheet that sticks out so it can be grabbed 
by a gripper.

None: no lip is provided

On lowest folio: creates a lip on the side of the folded book signature that 
contains the low folios; typically used for foot to foot folding schemes

On highest folio: creates a lip on the side of the folded book signature that 
contains the high folios; typically used for head to head folding schemes

Lip Size The default size of the overfold lip and a maximum for sheet fitting.

Page Trim Margins

These margins add extra paper to the four edges of a page to accommodate for 
bleed and the marks, and provide space for trimmers. The settings for these 
margins depend mainly on the binding style used. A maximum value can be 
entered to extend the margins for sheet fitting.

Spine: margin width at the spine edge of a page

Face: margin width at the face edge of a page

Head: margin width at the top of a page

Foot: margin width at the bottom of a page

Suppress inner margins: Select to suppress the inner margins between the pages 
of a Fold Sheet or Web Production Schemes.
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 Horizontal margins: When selected, suppresses the inner margins that 
are parallel to the leading edge.

 Vertical margins: When selected, suppresses the inner margins that are 
perpendicular to the leading edge.

Sheet Fitting Strategy

These rules define how the overfold and page trim margins can be adjusted to 
make a Fold Sheet fit the size of the Press Sheet, and enable direct folding of the 
Press Sheet without trimming first. Sheet fitting can also be applied for Press 
Sheets with more than one Fold Sheet.

Sheet fitting also depends on the Positioning of Fold Sheets options in the Press 
Sheet Layout Rules to determine how a Fold Sheet is aligned.

NOTE: You cannot use sheet fitting if fixed offsets are specified in the Press 
Sheet Layout Rule.

Overfold, face, spine Here you choose how to enlarge the margins and overfold.

 Overfold first, then face and spine: first adjusts the overfold and then the 
remaining space between face and the spine evenly 

 Face and spine first, then overfold

 Overfold, face and spine evenly

Head, foot Here you choose the order for adjusting the head and foot margins.

 Head first, then foot

 Foot first, then head

 Head and foot evenly
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Boot Resources

From time to time, ECO3 will release updates and enhancements for individual 
Task Processors. These resources are distributed in the form of PostScript 
“patch” files which you can import as with any other type of resource.

Administrator access level only!

Associated Task Processors

The Boot Resources Resource category is currently available only for the Render 
and Normalize Task Processors. 

NOTE: Service access level is required to access the Boot Resources for the 
Normalizer.
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Borders

The Borders Resource category allows you to predefine border marks for specific 
job requirements. A Border is extra information that you can add to film or plate. 
This extra information can contain the order number, the print date or time, slug 
lines, separation names, registration marks, crop marks, etc.

A border can contain either of the two following mark types:

 Text mark: Text marks are defined with variables in Apogee. You can also 
choose a font type and point size for the variable.

 File mark: A file mark can be a special registration mark in the form of an EPS 
file or a PDF document.

You define the borders in the Resources of your output device. If you have 
several platesetters, filmsetters or proofing devices, the borders Resource is 
shared amongst the same type of output device.

When should you use Borders?

You should use borders when you have to work with a PDF document that lacks 
some essential information that should have been added in the source applica-
tion (e.g. QuarkXpress, Imposition Template Manager). This can be registration 
marks or separation names, for example. Registration marks are needed to 
assemble the different colors correctly on top of each other. Separation names 
give information on the colors used.

NOTE: If you are using Apogee Impose, text marks and file marks can also be 
applied with the Mark Engraver. See “Mark Engraver” on page 1038 for more 
information.

Associated Task Processors

The Border Resource category is available for:

 All Output Task Processors, except for Export and RPC.

 All Print Task Processors, except for Generic Press.
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For information on creating, editing, importing, exporting and deleting borders, 
refer to “Managing Resources” on page 718.

Administrator access level only!

Borders Overview

The Borders overview lists the available borders. You can create, duplicate, edit, 
import and export borders. 

Border Mark Editor

You can exactly define the Border Mark settings: the mark type and the exact 
location of the mark on the page or sheet.

Mark Type

Select the Mark type (for output devices only):

 A Text Mark

 A File Mark (EPS/PDF Mark)

Text Mark Text: In the Text field, you can specify which text is to be used as a mark. You 
have three options:

 Type some text in the Text field.

 Select a variable from the drop-down list. This list appears when you click the 
button next to the field.

 Use a combination of text and one or more variables.

Font: Select a font and a point size for the text mark.

Color: Click the variable button, and select one or more options to determine on 
which plate(s) the mark will be printed:

Click the associated variable button, and select one or more options to determine 
on which plate(s) the text mark will be printed:
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 Registration (all plates). When this option is selected, you will see an asterisk 
(*). 

 Process Colors (CMYK)

 Cyan 

 Magenta 

 Yellow 

 Black 

Rotate: Specify the rotation angle for the mark (0, 90, 180, or 270 degrees). 

Stripping Text Mark A stripping text mark serves as a placeholder for a StripMark. The main differ-
ence with the normal text mark is that the content of the stripping text mark is 
set by JDF. The JDF also specifies the stripping element to which the mark refers: 
The object whose edges are to be used as positioning references are set by JDF, 
but the offsets themselves are specified in the stripping text mark.

Crop Mark Crop marks indicate where to crop the page or image. A crop mark sets crop 
marks around pages or around the image. They are dynamically imaged 
according to the specified properties. 

Distance from image/page corner: Specifies the distance between the marks 
center and the images or pages corner.

Length of mark: Specifies the length of the mark.

Line width : Specify the width of the marks lines.

Print crop marks inside of imposition: Print crop marks that appear inside the 
imposed area (i.e. in between the pages). You should disable this option if you 
want the crop marks to appear only on the outside of the imposition (Imposition 
Borders only).

NOTE: Crop marks do not require the Position options.

Fold Mark Fold marks indicate where to fold the sheet. A fold mark sets several marks to 
indicate where the sheet is to be folded. They are dynamically imaged according 
to the specified settings.
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Distance from pages: Specifies the distance between the marks center and the 
page edges.

Length of mark: Specifies the length of the mark.

Line width : Specifies the width of the marks lines.

NOTE: Fold marks do not require the Position options.

Collation Mark Signature/Section Collation marks offer a way to quickly inspect the correct 
collation order of folded sheets.

Mark: The mark is the actual marking on the spine or fold. It is printed in black, 
and may optionally contain an index number.

 Thickness: The thickness (or width) of the mark. Also sets the width of the 
step area. The default is 3mm.

 Length: The length of the mark. Also sets the step size with which the mark is 
offset. Note that there is no gap between two adjacent marks. The default is 
11mm.

Step Area : The step area is the area in which the mark travels. The mark starts at 
the top (or bottom) of the step area, and advances one step with each section/
signature.

 Offset from Edges: Insets the height of the step area in the available space. 
The default is 0.

 Step Area Length: Sets the length of the step area. When you enter a value, 
Apogee calculates and displays the Number of steps.

 Number of Steps: Sets the number of steps in the step area. When you enter 
a value, Apogee calculates and displays the Step Area Length.

Pattern : The pattern defines the position of the first mark, the direction in which 
the mark is stepped (normal or reverse), and what to do when arriving at the end 
of the step area (sawtooth or zigzag). Apogee graphically represents the four 
possibilities. The default is to use normal direction with the sawtooth 
movement.

Index : Select whether to print the collation mark number (should correspond 
with the signature/section) inside the mark, and with which orientation (0, 90, 
180 or 270). Apogee graphically represents the five possibilities. The default is 
to print no index.
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File Mark Use this option, if you want to use a specific EPS or PDF file as a mark. 

File: Click the File list and select one of the available EPS or PDF files. The file is 
selected as the mark to be used.

Apply curves: Select the check boxes to apply the Linearization, Calibration or 
Simulation curves to the content of the file. By default, all curves are selected.

Rotate: Specify the rotation angle for the mark (0, 90, 180, or 270 degrees). 

You can manage the Marks in the Marks Resource category. See “Marks” on 
page 1086.

NOTE: The selected file is copied into a reserved directory on the server.

Position

Mark origin You can specify the exact position of the mark. This position is defined by a 
horizontal and a vertical distance from different parts of the sheet or plate. 

Horizontal For the horizontal position, select:

 distance...

 to right or left of...

 Sheet Left Edge, Sheet Right Edge, Sheet Center, Output Size Left Edge, 
Output Size Right Edge, or Output Size Center.

Vertical For the vertical position, select:

 distance...

 below or above...

 Sheet Leading Edge, Sheet Trailing Edge, Sheet Center, Output Size Leading 
Edge, Output Size Trailing Edge, or Output Size Center.

Print on  Front side
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 Back side

 Both sides. If you select this option, the following check boxes are enabled:

 Mirror Position on back

 Mirror Content on back

Conflicts

Notify when Mark runs: You can set Apogee to notify you, if the Mark or part of the mark area runs in or 
out the sheet or plate:

 Into the sheet: Notify when the whole or part of the mark’s area overlaps with 
the sheet area.

 Out of the sheet: Notify when the whole or part of the mark’s area does not 
overlap with the sheet area.

 Out of the Output Size: Notify when the whole or part of the mark’s area does 
not overlap with the output size area (disabled for Imposition Borders).

 Into the Page Content (trim box): Notify when the whole or a part of the 
mark’s area overlaps with the page’s content area, as defined by the page’s 
trimbox.

For each option, there is a check box. Apogee will send a message to the Message 
Board according to the selected options.

NOTE: Notification is a warning only, processing will continue.

Do not print mark when it
runs into the Page Content

Select this option if you want Apogee to remove a mark when it would otherwise 
run into a pages content area. The default setting is not to print marks that run 
into a Page Content.

Borders and Output 
Sizes

On a medium, you can distinguish different areas, including the borders and the 
output sizes. The following graphic clearly shows the different areas:
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Working with 
Borders and Border 
Marks

You first need to create a border. However, a newly created Border does not 
contain any border marks sets: You need to select the new border and add 
border marks to it. 

 To create and manage border mark sets

1 In the System Overview Window, select the Output Task Processor for which 
you want to make changes in the Border Marks.

2 Double-click the Borders icon in the Resources pane.

The Borders window appears, containing a list of all the available Borders.

3 Select the Border for which you want to create, edit, duplicate or delete a 
Border Mark and click the Edit button.

The Border window appears, containing the available Border Marks for the 
selected Border.

4 Do one of the following:

1 Press sheet
2 Border
3 Image size
4 Output size
5 Medium

1

2

3

4

5
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 Click the New button to create a new set of Border Marks. Enter any 
required information as described in “Border Mark Editor” on page 964 
and click OK.

 Select the Border Marks set that you want to edit and click the Edit button. 
Enter any required information as described in “Border Mark Editor” on 
page 964 and click OK.

 Select the set of Border Marks that you want to duplicate and click the 
Duplicate button. A copy of the Border Mark Set will appear in the list. 

 Select the set of Border Marks that you want to delete and press Delete or 
click the Delete button.

5 Click OK to close the Border window.

6 Close the Borders dialog box.

 To quickly copy borders from one Task Processor to another

1 In the System Overview Window, select the Output Task Processor from 
which you want to copy the Border.

2 Double-click the Borders icon in the Resources pane.

The Borders overview window appears, containing a list of all the available 
Borders.

3 Go back to the System Overview Window, and select the Output Task 
Processor to which you want to copy the Border.

4 Double-click the Borders icon in the Resources pane.

The Borders overview window appears.
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5 Return to the first Borders overview window, select the border you want to 
copy, and drag and drop it in the second Border overview window.

The selected border is duplicated.
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Bottling Rules

The Bottling Rules resource provides settings to compensate for page skewing, 
i.e. the rotation of the inner pages of a Fold Sheet. Page skewing is caused by 
cross-folding a sheet and increases when multiple cross-folds are required or 
multiple cross-folded sheets are combined. The selected rule will rotate the 
pages to compensate the fanning of the signature.

A bottling rule can be selected for a the whole web-fed product or a specific part 
in the Products tab.

NOTE: This option requires a special license.

NOTE: Bottling is only supported for web printing, not for sheet-fed printing.

 Double-click the Bottling Rules icon for an overview of the available rules in 
the Bottling Rules dialog box or to create your own rules.

Associated Task Processors

The Bottling Rules resource category is available for:

 Impose

 Raster Impose

 Raster Compose

Administrator access level only!

Bottling Rules 
Overview

The Bottling Rules dialog box lists all available Bottling Rules sets in the left 
column and the settings for each set in the right column.

Name

The name of the installed rules set or the name of your own rules set.
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Compensate Page Skew

Several methods ranging from automatic to manual are available for compen-
sating page skew cause by folding. Manual compensation refers to the use of a 
bottling table with pre-established rotation values, which may or may not be 
present in the Web Production Scheme (WPS). Automatic compensation is 
based on page creep.

Only when WPS has own
bottling table

Select the check box to apply bottling only if the WPS has a bottling table. Leave 
this check box unchecked to apply bottling to all Web Production Schemes. In 
the latter case, bottling is applied according to the bottling table if present and 
bottling based on creep (automatic) is applied to the other schemes.

See “Bottling Table button”.

WPS Bottling Table - Adjust
for stock thickness and

page size

Adjustment for thickness is applied if the table has a reference value for Stock 
thickness. The page size will be adjusted if the table has a reference value for 
Height. This setting only applies if the WPS has a bottling table.

Automatic Creep-based
Bottling

Automatic bottling applies simplified adjustments based on page creep. Takes 
effect if the Only when WPS has own bottling table is not selected.

Maximum Bottling Specify the absolute value of the maximum angle for the bottling. This limits the 
rotation of those layers that would require more.

Bottling Multiplier Enter a value greater than the default 1 to apply a multiplier to pre-established 
bottling values (e.g. for a newer version of a product).
Apogee Reference Guide



974 CALIBRATION CURVES
Calibration Curves

Every output device may have a certain discrepancy between the desired result 
and the actual result. This discrepancy is caused by dot gain. To compensate for 
this discrepancy, you need to calibrate your output device using the Curve 
Editor. Here, Apogee calculates a dot gain compensation curve so that your 
output device produces the desired results. The resulting curve may be irregular 
to produce the desired dot gain.

In Apogee, Calibration is only used for the press. For imagesetters and plateset-
ters, Apogee uses Linearization.

Administrator access level only!

Associated Task Processors

The Calibration Curves Resource category is available for the Press and Generic 
Press Task Processors.

Calibration Settings

You create calibration curves using the Calibration Curve Editor. For more infor-
mation, see “Calibration and Linearization Settings” on page 1166.

Screen (Workflow Polarity)

In the upper right corner, the Screen setting allows you to select the polarity of 
the workflow. You can choose between:

 Positive

 Negative

This option is repeated in the Calibration Map Settings, so that you have a 
complete overview of all the relevant settings when creating Auto-Select Maps 
for Calibration. For more information on Calibration Auto-Select Maps, see 
“Auto-Select Maps” on page 975.
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Calibration Curves List

Here you can manage your Calibration Curves. You can sort the list by clicking 
in any of the five column headers.

Calibration Curve The name of the Calibration Curves.

Paper Type The selected printing stock.

Ink Set The ink set that was selected from the Ink Sets Resource category.

Screen The screen type, resolution, frequency and dot shape. For more information on 
screen types, see “PDF Render - Screen Settings” on page 800).

Modified Modification date and time of the Calibration Curves.

Auto-Select Maps

You can create Calibration Auto-Select Maps in the Calibration Curves Resource 
category. For more information on Auto-Select Maps see “Using Resource Auto-
Select Maps” on page 1159.

In order to do so, select the Calibration Curve and click Add Map. This will open 
the settings dialog box for Calibration maps. These settings are identical to the 
General Settings of a Calibration Curve. For more in-depth information on these 
settings, see “Calibration Print Settings” on page 1166.

NOTE: You can also drag and drop a Calibration Curve to the Calibration Auto-
Select Maps table.

Fallback Click the Fallback button to specify what Apogee should do if the automatic 
selection of calibration curves does not find a match. You have the following 
options:

Use no calibration: The job will be processed without calibration.

Notify: Apogee will put the job on hold and send a message to the Message Board.

 To manually create a new calibration curve

1 In the System Overview window, select the Print Task Processor for which 
you want to create a new Calibration Curve.

2 Double-click the Calibration Curves icon in the Resources pane.
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The Calibration Curves dialog box appears, containing all of the available 
Calibration Curves for the selected Print Task Processor.

3 Click the New button.

A dialog box appears in which you can specify printing stock and halftone 
screen settings.

4 Specify the job details regarding printing stock, screen type and associated 
resolution, frequency, and dot shape. Screen polarity (Positive or Negative) 
cannot be selected: It is displayed for information purposes only. 

For more information, see “Calibration Print Settings” on page 1166.

NOTE: For CristalRaster screens, you have to specify the Dot Size instead of 
Frequency and Dot Shape.

5 Click OK to save your selection and close the dialog box.

6 Specify how you want to initialize the table (manually) as described in 
“Create Table” on page 1168 and click Next.

7 Select the values for the Stimuli column as described in “Stimuli Selection” 
on page 1168 and click Next.

8 Select the values for the Wanted column as described in “Wanted Selection” 
on page 1169 and click Finish.

The Calibration Curve editor appears.

9 Make any required changes as described in “Curve Editor” on page 1170, 
type the name of your Calibration Curve and click Save.

Your new Calibration Curve appears in the Calibration Curves List in the 
upper pane.

10 Close the dialog box.
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Color Books

Apogee contains a database of colors that are organized in books. As each ink 
produces a slightly different color depending on the stock it is printed on, each 
book represents the colors as they appear on a specific paper type.

Administrator access level only!

Associated Task Processors

The Color Books Resource category is available for all Press Task Processors and 
Proofers.

Color Books Overview

The Color Books overview consists of the books table and the colors table. You 
can create and partially edit color books, or individual colors within a specific 
book. You can also import color books, which can be useful if you want to have 
access to older Pantone colors.

You can click the International button to view translations of the color names in 
several languages.

NOTE: System Color Books are displayed in italics, and cannot be edited.

Color Books Editor

The Color Books Editor allows you to modify the attributes of the selected Color 
Book. 

NOTE: You can only modify the dot gain values of the System Color Books. The 
names of the System Color Books are displayed in italics.

Book Settings

Book Name Enter a name for the selected Color Book.
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Prefix Enter a prefix (for Spectral Color Book).

Suffix Enter a suffix (for Spectral Color Book).

Suitable for printing on:

Paper type Select one of the paper types that are available for the selected color book.

Dot gain

Specifies the dot gain values for the selected Color Book.

Value Default is 15.

Highest at Default is 50.

Starting at Default is 0.

Ending at Default is 100.

Special Colors button

Special colors are color names for unusual inks such as varnishes and die-cutting 
marks, glue zones, etc. These colors are organized in categories that determine 
their behavior. 

Click the Special Colors button to open the Special Colors editor.

Category Following built-in categories are provided:

 Die line: Not mapped to color strip colors, never printed in the main flows.

 Varnish: Mapped to varnish in in inkset, for main input only and never 
printed in the proofing flows.

 White: Mapped to white ink in inkset. If white is not part of the inkset, the 
color is switched off.

 Primer: Mapped to primer ink in inkset. If primer is not part of the inkset, the 
color is switched off.

NOTE: Special Color categories are also used by Apogee Preflight action lists.

Colors Enter additional color names (for example in your language) or click the Colors 
button to choose colors that you want to add to this category.
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International button

Click the International button to open the International Color Names editor 
where you can add translations for the four process color names and ensure the 
correct mapping of these color names when they appear in the different 
languages.

Color Accuracy

Select the Show color accuracy (deltaE) check box to expand the Color Accuracy 
panel.

Color Editor

The Color Editor allows you to modify the attributes of the selected color. 

NOTE: You cannot modify colors that belong to one of the System Color Books. 
The names of the System Color Books are displayed in italics.

General

Color name This name should be unique within the Color Book.

Colorant type Select the ink type:

 Normal

 Opaque

 Opaque Ignore

 Transparent

Color definition Define the color by its Lab color values.

Db (Neutral Density) The initial value is calculated from the color definition. These values are used by 
trapping.

The Calculate button allows you to calculate the Neutral Density.

SID (Solid Ink Density) Specify the Solid Ink Density (SID).
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Color Exceptions

You can specify the color values to be used in case the conversion from Lab color 
does not produce the expected results. In that case, Apogee will use your values 
instead of calculating them from the Lab values.

This table lists all of the exceptions that are defined for the print or proofing 
device that you selected.

 To create or rename a color book

1 In the System Overview window, select the Press Task Processor for which 
you want to create a new Color Book.

2 Double-click the Color Book icon.

The Color Book overview appears, containing the available Color Books in 
the left column and its respective colors in the right column.

3 To create or rename a Color Book, do one of the following:

 Click on the New button underneath the left column to create a new Color 
Book.

 Click the Edit button to rename the Color Book.

The Color Book editor appears.

4 Type an unique name for the book in the Name field and select a paper type 
from the drop-down list.

5 Specify the dot gain values for the color book.

 Value: By default, this is set to 0.

 Highest at: By default, this is set to 50.

 Starting at: By default, this is set to 0.

 Ending at: By default, this is set to 100.
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For more information on dot gain values, refer to “What is Calibration?” on 
page 1164.

6 Click OK.

CAUTION: The newly created Color Book does not contain any colors yet. You 
need to create these in the right column. For more information, see To 
manage your colors in a selected color book on page 981.

7 Close the Color Books overview.

 To import a color book

1 In the System Overview window, select the Press Task Processor for which 
you want to import a Color Book.

2 Double-click the Color Book icon.

The Color Book overview appears, containing the available Color Books in 
the left column and its respective colors in the right column.

3 Click the Import button:

An Open file dialog box is displayed.

4 Browse to the location of the color book you want to import, select the color 
book file (*.MIME), and click Open.

The color book is imported, and is displayed in the list of color books.

 To manage your colors in a selected color book

1 In the System Overview window, select the Press Task Processor for which 
you want to create, edit or delete a color.

2 Double-click the Color Books icon.

The Color Books overview appears, containing the available Color Books in 
the left column and its respective colors in the right column.
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3 Select the Color Book in which you want to create, edit or delete a color in the 
left column or create a new book by clicking the New button. In the newly 
created book, you can then create new colors as described below.

You need to specify the Paper Type for the new book.

All of the book’s colors appear in the right column.

4 Do one of the following:

 Click the New button underneath the right column to create a new color, 
define the color properties and click OK to save your settings.

 Click the Edit button to edit a color, define the color properties and click 
OK to save your changes. 

 Select the color that you want to delete in the right column and press 
Delete or click the Delete button. Confirm the deletion.

5 Close the Color Books overview.

 To create or edit a color exception

1 In the System Overview window, select a Press Task Processor for which you 
want to create or edit a color exception.

2 Double-click the Color Books icon.

The Color Books overview appears, containing the available Color Books in 
the left column and its respective colors in the right column.

3 Select the Color Book in which you want to create or edit a color exception in 
the left column.

All of the book’s colors appear in the right column.

4 Click the Edit button under the right column to edit a color. 

5 Expand the Color Exceptions section.
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6 Do one of the following to either create or edit the exception.

 Click the New button to create an exception.

 Click the Edit button to edit an exception.

The Color Exception editor appears.

7 Select the ICC Profile that you want to use for this exception.

8 Specify the CMYK values for Lab to Process Color conversion.

9 Click OK to save your changes.

10 Click OK to close the Color Editor window and save the color exception.

NOTE: When you create an exception, standard CMYK values are calculated for 
the selected profile.

 To delete a color exception

1 Edit a color.

2 Expand the Color Exceptions section.

3 Select the exception that you want to delete and click the Delete button.

4 Click Yes to confirm the deletion.

5 Click OK to close the Color Editor window and delete the color exception.

NOTE: If you click Cancel, all color exception changes are lost.
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Color Spaces

This category allows you to manage your Color Space resources.

NOTE: Service access level only!

Associated Task Processors

Color Spaces Resources are available for the following Task Processors:

 M-Press Color Separations

 All Presses, including Digital Presses
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Content Profiles

The Content Profiles Resource category contains the Color Profiles (*.icm and 
*.icc files) that are available to the Normalize and Render Task Processors. 
These Profiles have no effect on the Profiles selected for the Press.

Administrator access level only!

Associated Task Processors

The Content Profiles Resources are available for the following Task Processors:

 All Render Task Processors

 Normalize

 Apogee Preflight

Content Profiles Overview

The Content Profiles overview lists the profile names and their color spaces.

Content Profile

The name of the Profile

Color Space

The name of the color space to which the Profile belongs. This may be:

 CMYK

 Grayscale

 RGB

You can import, export or delete a Content Profile.
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Contrast Adjustments

This resource allows you to create adjustments for the contrast of rendered 
results. For more general information on Contrast Adjustments, see “Distortion” 
on page 127.

Administrator access level only!

Associated Task Processors

The Contrast Adjustments Resource category is available for the following Task 
Processors:

 Generic Digital Press

 Generic SD (Sign and Display Printer) and other SD printers

 To create a new contrast adjustment curve

1 In the System Overview window, select the M-Press Task Processor for which 
you want to create a new Contrast Adjustment Curve.

2 Double-click the Contrast Adjustments icon in the Resources pane.

The Contrast Adjustments overview appears, containing all of the available 
Contrast Adjustments for the M-Press Task Processor.

3 Click the New button.

The curve editor is displayed.

4 Enter a name for your new curve, e.g. High Contrast, Low Contrast.

This is the name that appears in the presets list in Raster Preview.

5 Drag the curve to set the adjustments as desired.
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For more general information on working with the curve editor, see “Distor-
tion” on page 127.

6 Click Save.

Your new adjustment appears in the Contrast Adjustments List. 

7 Close the overview.
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Curves Adjustments

This resource allows you to create adjustments for the CMYK channels of 
rendered results. For more general information on Curves Adjustments, see 
“Distortion” on page 127.

Administrator access level only!

Associated Task Processors

The Curves Adjustments Resource category is available for the following Task 
Processors:

 Generic SD (Sign and Display Printer) and other SD printers

 To create a new curves adjustment

1 In the System Overview window, select the M-Press Task Processor for which 
you want to create a new Curves Adjustment Curve.

2 Double-click the Curves Adjustments icon in the Resources pane.

The Curves Adjustments overview appears, containing all of the available 
Contrast Adjustments for the M-Press Task Processor.

3 Click the New button.

The curve editor is displayed.

4 Enter a name for your new curve.

This is the name that appears in the presets list in Raster Preview.

5 Select a Cyan, Magenta, Yellow or Black channel in the drop-down list to 
activate the respective channel.

6 Drag the curve to set the adjustments as desired.
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For more general information on working with the curve editor, see “Distor-
tion” on page 127.

7 Click Save.

Your new adjustment appears in the Curves Adjustments List. 

8 Close the overview.
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Device Link Profiles

The Device Link Profiles Resource category contains the profiles (*.icm and *.icc 
files) that are available to the Normalize and Render Task Processors. These 
Profiles have no effect on the Profiles selected for the Press.

Administrator access level only!

Associated Task Processors

The Device Link Profiles Resources are available for the following Task 
Processors:

 PDF Render

 All Proofer Task Processors

 Apogee Preflight

 Generic Digital Press

 Generic SD (Sign and Display Printer) and other SD printers

Device Link Profiles Overview

By default, the Device Link Profiles overview list is empty. You can import, 
export or delete profiles.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 991
Device Print Modes

Allows you to create, duplicate, select and rename, delete, import or export a 
device print mode for a digital printer.

Administrator access level only!

Associated Task Processors

The Device Print Modes Resource is available for all commercial digital printers:

 Generic Digital Press
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Device Screens

Allows you to select, rename or delete a device screen for your digital printer.

Administrator access level only!

Associated Task Processors

The Device Screens Resource is available for all commercial digital printers:

 Generic Digital Press
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Finishing Hub

The Finishing Hub is where you manage cutters, finishing operations and 
finishing margins. You can create new resources or edit existing ones using the 
File and Edit menus, or by context-clicking in the various lists.

Administrator access level only!

Associated Task Processors

The Finishing Hub is available for the following Task Processors:

 Generic SD (Sign and Display Printer) and other SD printers

 Open the Finishing Hub

 In the Layout Editor, choose Window > Resources and select Finishing Hub, 
or go to System Overview.
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Finishing Hub 
Overview

1 Cutters
2 Finishing operations
3 Finishing margins
4 Details of cutters, operations or margins
5 Open other resources button

Cutters

This panel lists the cutting devices. The Type and Result Delivery tabs contain 
the details for each cutter.

Name The name given to the cutting device.

Type tab The type of cutting device:

 X-Y cutter: A cutter, such as a table cutter or plotter, that can cut out any 
possible form and perform a variety of operations/tools.

 Roll cutter: A cutter that can cut a roll into sheets and slice them into strokes 
as well.

 Guillotine: A cutter that cuts in straight lines from edge to edge while taking 
into account the sheet layout.
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 CAD Die Maker: A cutter that exports a CAD file for die-making.

Result Delivery tab Here you can choose to create a cut file automatically for each sheet or not.

Create cut file: If the check box is selected, a cut file is generated and sent 
automatically to a directory as specified. If the check box is not selected, you can 
still send the file manually.

Export directory: The directory where the cut file is saved.

File name: The name of the cut file. The directory and file name can be generated 
using variables. See “System Variables” on page 1183 for more information on 
using variables.

Mirror suffix:  The suffix to append to the filename when a cut file is mirrored.

Double-sided sheets: : If the check box Create for both sides is selected, two cut 
files are generated, one per side. By default, check box is not selected, a cut file 
is generated for the front side only 

Format: The file format of the cut file:

 PDF: the default and most common format for a cut file

 EPS: for large sheets

Acrobat compatibility for large sheets: Select for sheets larger than 200 inches or 
5.08 m to process the file using User Units.

Conflict handling: Choose what you want to do if a cut file has the same name as 
an existing file: replace the existing file or keep the existing file and append a 
sequence number to the new file.

Rotate contents: The content of the cut file can be rotated 0°, 90°, 180° or 270° 
without having to rotate the sheet. The default is 0° so the cut file has the same 
orientation as the sheet.

Post-process files: After a cut file has been created, the system can run a script on 
this file, for example to change the file format:

 Script: the full path to the script you want to run. It must be accessible by 
the computer running Apogee. Click browse to open a file explorer and 
select the location of the script.

 Options: Optional arguments that can be passed to the script. They are 
passed as entered; the options are not enclosed in quotes or double 
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quotes, so the script can see them as individual arguments. The file name 
of the cut path is always the last argument.

Preview panel Here you can choose to create a preview of the cut file. This file is saved in the 
same directory and with the same file name (except the extension) as the actual 
cut file. The following file formats are available:

 PNG

 BMP

Simplify Paths This section provides options to simplify the paths in the cut file. 

When frame edges touch or overlap: Select this check box to simplify the paths by 
merging overlapping or touching lines.

NOTE: This is not only for the contour cutting operations, it simplifies the paths 
of any Operation.

Operation Mapping tab This tab provides a mapping table to define whether the available finishing 
operations are selected for the cutter in question and how the generic names 
(left column) are mapped to cutter-specific names (right column).

Clear the check box next to an operation if it is not supported by the cutter.

The default operations and any operations you add in the Finishing Operation 
panel appear in this table with the generic name in the left column. To map an 
operation to a cutter-specific name, select the operation in the list and enter the 
cutter-specific name in the panel on the right. You can also set a Path Color for 
the cutting path in the cut file.

Finishing Operations

A Finishing Operation is a line that is drawn in the artwork or in a CAD file that 
represents various processing operations, such as:

 shape the product (e.g. Cut and Crease, Through Cut)

 identify zones that require special treatment (e.g. Gluing, Perforate)

 provide information (e.g. Dimensions).

Operation: The name of the Operation.
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Special behavior: You can choose one of the following special behaviors for the 
selected operation, except for the Camera Registration which has a built-in 
behavior that cannot be changed.

 Defines product contour: A Contour-defining Operation marks the path 
or box that defines the shape of the final product. It is used to calculate the 
clipping and bleed paths, it sets the initial size of the frame and deter-
mines nesting.

 Defines ink-free zone: An Ink-free Operation provides a way to mark the 
ink-free areas on a product, e.g. on flaps those need to be glued together. 
An ink-free area only clears the content of the artwork. However, you can 
still have marks inside that area. 

 Exclude from cut file: Operations marked with this behavior will not be 
included in the cut file. However, you can still proof and display them via 
a Line Appearances set.

 Registration: The main purpose of this behavior is to print specific CAD 
lines on the main output. This special behavior has no effect on how the 
lines appear in the client or on the proof, which is still determined by the 
Line Appearance sets. It has no effect on how lines are presented in cut-
file, that remains controlled by the Operation Mapping of each cutter.

 None: This behavior is for backwards compatibility. Paths are made avail-
able to the cutters, but they have no other behavior.

In the details panel, you can specify one or more conditions for applying an 
existing or new operation to an image automatically. The conditions can be set 
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to check the following items in your images and map these items to a finishing 
operation:

 Spot color name: If you select the spot color name as condition, you can 
choose one of the following options for matching the value or values you 
enter in the comma-separated list of possible names:

 equals

 contains

 begins with

 ends with

Finishing Margins

Finishing margins can be defined in two ways as reflected by the settings of the 
Finishing Margins dialog:

 Tool width (t)

 Minimum Material Next to Cut (e)

OR

 Minimum Distance between Images (g)

 Minimum Distance between Images and Sheet Edges (m)

Click the link icon if you want to set specific values for Left, Right, Top or Bottom. 
Margins are relative to the frame which initially corresponds with the trim box 
of your image.
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Open Button

Click this button to open related resources:

Mark Engraver See “Mark Engraver” on page 1038.

Line Appearance Sets The Line Appearance Sets resource is where you can control the color of the 
various lines that represent operations and whether or not these lines are visible 
on the sheet. Click a color patch if you want to change the color or thickness of 
the line. In this dialog you can also change the solid line to a dashed line in 
various styles. Click the eye icon to make the line visible or to hide it. Click the 
Show only visible check-box to filter the list of lines in this dialog. You can work 
with the default set or create your own sets that you can apply in different situa-
tions (regular proofing, imposition proof, etc.).

CAD Line Input Maps This resource maps the lines detected in CAD files to operations (Cut, Crease, 
Perforate, Print Registration, etc.). Default maps are provided for selected CAD 
files formats. Select a file format (CFF2, DXF, etc.) in the Format drop-down list 
to see the maps for that format and then select a name in the list to see all the 
lines included in the map. Each line has a type number and a mapped operation 
that you can change in the line inspector on the right.
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Folding Schemes

The Folding Schemes resource provides sets of Folding Schemes that Apogee 
Impose can choose from to perform automatic imposition, or that you can select 
to perform a manual imposition.

A Folding Scheme is a description of how the pages of a Product are arranged on 
the sheet in a grid of cells. The scheme also contains a sequence of folding 
instructions: where to fold, the folding direction and orientation, and the final 
result of the folding. The number of pages in a signature determines which 
Folding Schemes are eligible for the Fold Sheet.

 Double-click the Folding Schemes icon for an overview of the available sets 
and schemes in the Folding Schemes dialog box.

Associated Task Processors

The Folding Schemes resource category is available for:

 Impose
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 Raster Impose

Administrator access level only!

Folding Schemes Overview

The Folding Schemes dialog box lists all available Folding Schemes sets in the 
left column, the Folding Schemes for the selected set in the centre column, and 
the Folding Schemes for each number of pages in the right column.

Folding Scheme Sets (left column)

This column lists the default Folding Scheme set and any new or modified sets 
you have created.

New sets can be created for jobs with specific Fold Page requirements or if you 
want to limit the number of schemes that Apogee Impose can choose from.

Name A meaningful name, such as ‘booklet’, ‘brochure’, etc.

Folding Scheme list (center column)

This list displays the Folding Schemes grouped by the number of pages to be 
folded (2, 4, 6, ... pages). Each entry in this list (e.g. F6-1) represents several 
different Folding Schemes for that particular number of pages (F6-1, F6-2, ...).

Use Only schemes with the check box selected are considered by Apogee Impose for 
the Auto Impose feature. A grey arrow indicates that not all folding schemes for 
that particular number of pages are selected. 

All Folding Schemes are available for manual imposition.

Pages Folding Schemes are organized by the number of pages to be folded for the Fold 
Sheet.

Top Pick Indicates the Folding Scheme which has the highest priority for the selected 
number of pages.

Folding Scheme Overview (right column)

The different Folding Schemes are displayed for a particular number of pages.

Folding schemes can be added, edited or deleted and also moved up and down 
the list to set their priority. The selected scheme which is the highest in the list, 
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is the Top Pick and the one that appears in the center column for that particular 
number of pages.

Use Only schemes with the check box selected are considered by Apogee Impose for 
the Auto Impose feature. All Folding Schemes are available for manual 
imposition.

Name The standardized CIP4 name or another name for a user-defined Folding 
Scheme.

CxR Abbreviation for Columns x Rows; e.g. 4 x 2 means 2 rows of 4 pages.

Folding Sequence The notation for how the Fold Sheet is folded.
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Folding Scheme Editor

 In the Folding Scheme Overview (right column), click the New button or the 
Edit button to open the Folding Scheme editor.

General

Name and Description Enter a meaningful name and description

Columns and Rows Columns indicate the number of horizontal cells and Rows the vertical cells of 
the page arrangement.

Glue Zones Select the check box if you want to apply ink-free areas for gluing; when 
selected, the glue zones are displayed as blue strips in the folding scheme 
diagram, and the glue tool is enabled.
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Page Arrangement

If you have an existing Fold Sheet that you want to emulate, the Page Arrange-
ment method is used to create a scheme. You simply assign page numbers in the 
cells using the two buttons and select a binding edge to preview the page orien-
tation of the Fold Sheet.

NOTE: The page numbers of a Folding Scheme are not necessarily the page 
numbers of a Product. The first page is always 1 and the last page is always the 
number of pages on the Fold Sheet. You only see the page numbers of the 
Product when you apply the Folding Scheme to the Fold Sheets.

Folding Scheme diagram

1 Red corner icon: Lay on Front
2 Red corner icon (faded): Lay on Back
3 Yellow page: The lowest page number of the signature
4 Blue corner icon: Top page of the signature
5 Page numbers: rotated according to the rotation of the page on the Fold Sheet; 

ambiguous numbers are underlined
6 Fold lines which are colored (green, blue, red)

- solid line: if the pages are still on top
- dashed line: if the pages are underneath

7 Fold line labels in the same color as the lines and as an extension of the line;
f1, f2, f3, etc. indicate the sequence of the folds

8 Jog edges in solid black and non-jog edges in gray
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Arrangement buttons

Preview for Left, Right, Top or Bottom binding for the Press Sheet preview.

NOTE: This binding style is not part of the actual Folding Scheme setting.

Folding Scheme

If you don’t have an existing Fold Sheet to work from, you can enter the sequence 
here using the Folding Sequence Notation.

Folding Sequence Indicates the sequence for the scheme

Edit Sequence This button opens the Folding Sequence editor where you can edit an existing 
folding sequence or create a new one

Default page arrangement  Head to head: arranges pages in such a way that the head of the pages is on 
the closed head of the signature, suitable for jogging to the head

 Foot to foot: arranges pages in such a way that the foot of the pages is on the 
closed head of the signature, suitable for jogging to the foot

 To edit, add or duplicate a Folding Scheme

You can add a new Folding Scheme to an existing Set or create a new Set first 
and add your new Folding Scheme to this new Set. Every scheme you add 
becomes a part of every Set but is only enabled in the Set where it was originally 
added.

1 In the Folding Schemes dialog box, click the New button or the Edit button to 
open the Folding Scheme editor directly, or click the Duplicate button and 
then edit the newly created scheme in the list.

2 Enter a name and description.

3 Enter the number of columns and rows.

NOTE: If you made a copy of an existing scheme, the page arrangement is 
reset and the cells are emptied if you change the number of columns or rows.

cursor button for typing the page numbers on the Front or Back of the Folding Scheme; the 
number for the other side (Front or Back) is added automatically

pointer button that inserts page numbers on the Front and Back of the Folding Scheme

Reset resets the scheme and empties the cells
glue tool
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You now have two options to make the actual scheme.

4 Use the Page Arrangement buttons to create the scheme. Clicking the Reset 
button displays a blank scheme.

Enter the binding for previewing the Folding Sheet. This may also change the 
layout of the pages to meet Head to Foot and Foot to Foot restrictions.

OR

5 Click Edit Sequence to open the Folding Sequence Editor and create the 
sequence using the Folding Sequence buttons.

6 Click OK.

7 Choose the Default page arrangement.

8 Click Save.

If a Folding Scheme with the same folding sequence and the same page 
arrangement already exists or a Folding Scheme with the same name exists, 
Apogee Impose displays a warning dialog box.

9 Click Save Anyway or Cancel.
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 To work with the Page Arrangement tools

1 Enter the Name, Description, and Columns and Rows for the Folding 
Scheme.

The Page Arrangement grid displays empty cells.

2 Click the cursor button and click the cell where you want the first page to be 
located.

3 Type “1”.

Apogee puts the corresponding back page in the correct cell of the Back of the 
Folding Scheme.

NOTE: The Back Page number is displayed when you click in a following cell.

OR

4 Click the pointer button and hover over the cells of the grid.

Apogee displays the first or next page number on the Front and Back of the 
Folding Scheme.

5 Continue until all pages have been arranged.

Apogee Impose now displays the completed Folding Scheme:

 the folding lines and Folding Sequence

 the page with the lowest page number

NOTE: If the arrangement of the pages cannot be folded, a message is 
displayed and you need to change the sequence.
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 To use the Folding Sequence editor

1 In the Folding Scheme editor, click the Edit Sequence button to open the 
Folding Sequence editor.

The Folding Sequence editor is empty if you are creating a new Folding 
Scheme and you did not create a scheme with the Page Arrangement tools. If 
you copied an existing scheme, the sequence for that scheme is displayed but 
is cleared once you start editing.

2 Click in the Folding Sequence box and use the following shorthand notation 
to define the sequence.

NOTE: The folding direction depends on the position of the lay.

3 Enter the folds until the Folding Sequence is complete and the message 
‘Folding sequence is not complete yet’ is no longer displayed at the bottom of 
the dialog box.

4 Click OK.

NOTE: The OK button is only enabled when the sequence is complete.

Fold up; use button or type “ ^ ”

Fold Down; use button or type “ v ”

1/4 Parallel Fold: parallel to the first fold and 1/4 of total length; use button or type the fraction

1/2 Parallel Fold: parallel to the first fold and 1/2 of total length; use button or type the fraction

3/4 Parallel Fold: parallel to the first fold and 3/4 of total length; use button or type the fraction

1/2 Cross Fold: perpendicular to the first fold; use button or type the fraction

+ Change direction; use button or type “ + ”
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 To export a Folding Scheme/Folding Scheme Set

You can export a Folding Scheme/Set to another Apogee system.

1 In the Folding Scheme Overview (right column) or the Folding Scheme Set 
overview (left column), click the export button.

2 Browse to the folder where you want to save the Folding Scheme/Set and 
click Save.

 To import a Folding Scheme/Folding Scheme Set

You can import a Folding Scheme/Set from another Apogee system.

1 In the Folding Scheme Overview (right column) or the Folding Scheme Set 
overview (left column), click the import button.

2 Locate the folder from which you want to import the Folding Scheme/Set, 
and click Open.

NOTE: You may need to confirm that existing Folding Schemes can be 
overwritten.
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Fonts

The Fonts resource category contains the default fonts that were installed with 
the Apogee software, together with any other fonts that have been imported. 

Associated Task Processors

Apogee is delivered with a font database comprising the most common 
PostScript fonts. There is one common font database for the following Task 
Processors:

 PDF Render

 Normalize

Font Overview

Displays a list of the currently installed fonts, and allows you to filter the list.

Display resources containing

Any text entered here will dynamically filter the list of fonts to display only the 
font names which contain this text.

Font

Displays the font name

Type

Displays the font type, which may be any of the following:

 PostScript

 True Type (*.ttf)

 Type 1 (*.pfb)

 PostScript (*.pfa)

 Open Type fonts (*.otf)
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 CID

File Name

Displays the name of the font file. This is normally the same as the font name.

Except for the filtering feature, the general procedures for managing resources 
apply also to fonts. You can also import ttf, pfb, pfa, and otf fonts into the Apogee 
font database

 To filter the fonts list

1 Select a Task Processor that uses the Fonts Resource, by clicking it.

The resources associated with the Task Processor appear in the Resources 
pane.

2 Double-click the Fonts icon in the Resources pane

The Fonts dialog box appears containing the available fonts for your system.

3 If necessary, filter the Fonts List by font name or part of the font name. For 
example, type the word “Arial” in the text field at the top of the dialog box 
and press Enter.

The dialog box lists only the Fonts containing the word Arial.

4 Close the Fonts dialog box.
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Glue Zones

The Glue Zones resource provides settings to create ink-free areas where glue is 
to be applied for binding a product. Depending on the type of product, glue is 
applied on different areas of the product: inside or outside the spine, in or next 
to the fold, on the body and/or cover, etc. You also need to specify how you want 
the ink-free areas to be created.

 Double-click the Zones icon for an overview of the settings in the Glue Zones 
dialog box.

Associated Task Processors

The Glue Zones resource category is available for:

 Impose

 Raster Impose

 Raster Compose

Administrator access level only!

Glue Zones 
Overview

The Glue Zones dialog box lists all available Glue Zones sets in the left column 
and the settings for each set in the right column.

Name The name of the glue zone preset.

Provide Glue Zones The condition for creating a glue zone:

 As specified by Category: Provide glue zones on the pages and with the 
width as specified below, ignoring settings in the Folding Schemes or Web 
Production Schemes.

 As specified by FS/WPS: Provide glue zones as specified in the Folding 
Schemes or Web Production Schemes and with the width as specified 
below.
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 As specified by Category and FS/WPS: Provide glue zones on pages and 
with the width as specified below, and where set in the Folding Schemes 
or Web Production Schemes.

How Here you specify how the areas are to be made ink-free:

 Knock out: Knocks out the entire page area, including the top and bottom 
trim margins, that lies in the glue zone.

 Shift: Shifts the entire page horizontally away from the spine, so that 
spine edge of its trim box aligns with the outside of the glue zone. In 
addition, the glue zone is knocked out to prevent bleed being pulled into 
the glue zone.

 Scale: Scales the page horizontally by moving the spine edge of its trim 
box out of the glue zone while keeping the face edge in place. In addition, 
the glue zone is knocked out to prevent bleed being pulled into the glue 
zone.
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Assembly Select one or more of the following categories (not active if As specified by FS/
WPS is selected) to be applied to the assembly.

 Between cover and body: creates glue zones between facing pages of the 
cover and body parts

 On outermost pages: on the two outermost pages of the entire assembly, 
excluding the cover and first signature

 On innermost pages: on the two innermost pages of the entire assembly

 Between book signatures: no glue is applied on pages between the cover 
and the facing pages; different widths for stacked or nested book 
signatures

 On last spread: create glue zones between the last and penultimate layers 
of the last book signature of the entire assembly. Use this option in stapled 
products that use a very light stock.

1 Between cover and body
2 Between book signatures

1 2 2
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Book Signature  On inner pages of book signature: creates glue zones on the inner pages 
of a single book signature, but not on the outermost or innermost pages of 
the specified signature.

 On single pages only (asymmetrical schemes): creates glue zones 
between layers when one of those layers is a single leaf, i.e., when the 
layer does not run through the spine. Use this option on jobs that produce 
a stapled product that uses asymmetrical schemes.

1 outermost pages
2 innermost pages
3 inner pages of a book signature

1

2

3 3 3
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Halftone Screens

When an image is output to an imagesetter for printing processes or laser printed 
artwork, etc., the image is converted into a pattern of dots according to well 
defined Halftone Screen settings. Each Halftone Screen contains a pattern of 
dots of different sizes or shapes, simulating the effect of different tones and 
colors. 

Ruling Maps

You can predefine screen settings and add them to a Ruling Map. A Ruling Map 
contains various rules that specify how the screen settings are to be applied. You 
can re-use a Ruling Map whenever necessary. When creating a job, you can 
select a specific Ruling Map for processing to avoid any problems due to 
mistakes.

In the Halftone Screens dialog box, you will see all the available Halftone screens 
in the upper panel, and all available Ruling Maps in the lower panel. You can use 
this dialog box to create your own Ruling Maps containing specific halftone 
screen settings.

NOTE: Any Halftone Screens displayed in italics are not yet licensed, and cannot 
be used. If you want to license these screens, you must follow the licensing 
procedure described in the Apogee Licensing Guide.

Associated Task Processors

The Halftone Screens Resources are available for the following Task Processors:

 All imagesetters and platesetters

Administrator access level only!
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Halftone Screens Editor

The Halftone Screens editor allows you to import, delete, and customize 
halftone screens, and create and use ruling maps.

Halftone Screens

Screen Select either Positive or Negative screens.

Screen Type Select the screen type that you want to edit:

 ABS (Apogee Balanced Screening)

 Adobe Accurate

 CristalRaster Uncompensated

 Rational Tangent

Import: You can click the Import button to import another screen type to the list 
from file (in MIME format).

Delete: You can click the Delete button to remove the selected screen type from 
the list. This will also remove any resources related to the selected halftone 
screens.

Resolution The available resolutions are dependent on the selected Screen Type.

Duplicate: You can click the Duplicate button to create a custom resolution for 
the Adobe Accurate and Rational Tangent screen types.

Delete: You can click the Delete button to remove the selected resolution from 
the list. This will also remove any resources related to the selected resolution.

Frequency The available frequencies are dependent on the selected resolution.
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Add: You can click the Add button to add a custom frequency for the Adobe 
Accurate and Rational Tangent screen types.

Delete: You can click the Delete button to remove the selected frequency from 
the list. This will also remove any resources related to the selected frequency.

Dot Shape  Elliptical

 Round

Dot Size CristalRaster only.

Separation/Angle  Cyan - 15

 Magenta - 75

 Yellow - 0

 Black - 45

NOTE: You can define custom angles (positive or negative) for Adobe Accurate 
and Rational Tangent screens.

Ruling Maps

Ruling Map Folder Name of the Ruling Map folder.

Resolution The available resolutions are dependent on the selected Screen Type.

Frequency/Used Screen Dependent on the selected resolution.

 To create a new ruling map folder

TIP: You can also create new 
folders automatically when 
adding halftone screens.

1 Open the Ruling Maps pane, and click the New button.

The Ruling Map Folder dialog box appears.

2 Type a name for your Ruling Map folder and click OK.
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The new folder appears in the Ruling Map Folder list. 

CAUTION: The folder you have just created is empty. This means that it does 
not contain any halftone screens yet. To add halftone screens to your Ruling 
Map folder, follow the procedure “To add halftone screens to a ruling map 
folder” on page 1020.

 To add halftone screens to a ruling map folder

To add a halftone screen to a Ruling Map folder, you must first specify the screen 
type, resolution, frequency and dot shape, in that order.

NOTE: For CristalRaster screen types, you must specify the resolution and dot 
size.

1 Select the halftone screen you want to add by selecting a screen type, resolu-
tion, frequency and dot shape.

2 Once you have specified the dot shape or dot size (CristalRaster), open the 
Ruling Map list.

The Ruling Map dialog box appears.

TIP: You can also enter the 
name of a new Ruling Map 
folder: This will create the 
folder automatically.

3 Specify the Ruling Map folder by selecting it in the drop-down list and the 
frequency number (lpi value), if necessary.

4 Click Add Map to add the halftone screen to your Ruling Map.

5 Click OK.

The halftone screen is added to your Ruling Map folder.

6 Select the folder in the Ruling Map Folder list and then select the specified 
resolution.

You can now see the halftone screen in the Used Screen list.

NOTE: When adding CristalRaster screens to a Ruling Map folder, you have to 
type the frequency number that you want to associate with a certain dot size. 
You can, for instance, type 112 and link it to a dot size of 21 microns. When 
using the 112 value in your pre-press application, the CristalRaster dot size 
21 is automatically selected.

 To change the halftone screen angle

1 Do one of the following:
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 Select the screen type or 

 Add a new screen type by clicking the Add button.

2 Select the resolution.

3 Select the frequency.

NOTE: This is not applicable to CristalRaster screens.

4 Select the dot shape (or dot size for CristalRaster screens).

5 To change a color separation angle, do one of the following:

 Double-click a color separation.

 Select a color separation and click the Edit button.

You can define custom angles (positive or negative) for Adobe Accurate and 
Rational Tangent screens.

6 For ABS screens, select one of the available color separation angles from the 
list. For Adobe Accurate or Rational Tangent screens, enter a custom color 
separation angle of your choice.

7 Click OK.

 To specify the angle for spot colors

1 Do one of the following:

 Select the screen type or

 Add a new screen type by clicking the Add button.

2 Select the resolution.

3 Select the frequency.

NOTE: This is not applicable to CristalRaster screens.

4 To specify the angle for spot colors, do one of the following:

 For new spot colors click the New button.
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 For existing spot colors select the spot color and click the Edit button.

The spot colors will be given sequence numbers according to the separation 
order. The spot color itself can be specified in the Separation Settings for the 
Render Task Processor (see “PDF Render - Separation Settings” on 
page 788).

NOTE: You can specify angles not only for spot colors, but also for process 
colors. 

 To delete spot color angles that you have added

1 Select the spot color angle, and click the Delete button.

2 Click Yes to confirm the deletion.

The spot color angle is deleted.

NOTE: You can only delete the spot color angles that you have added.

 To import custom dot shapes for your halftone screens

1 From the Halftone Screens dialog box, select the Adobe Accurate or Rational 
Tangent screen type.

2 Select a resolution, frequency and dot shape.

3 Click the Import button.

4 Locate the folder which contains your Dotshape packages.

These dot shape packages are in MIME or PostScript file format (*.mime, 
*.ps)

5 Click Open.

The custom dot shapes are displayed in the Dotshape list.
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 To delete custom dot shapes

1 From the Halftone Screens dialog box, select a screen type, resolution, 
frequency and dot shape.

1 Select a custom dot shape, and click the Delete button.

2 Click Yes to confirm the deletion.

The dot shape is deleted.

NOTE: You can only delete custom dot shapes.
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InkTune Sets

This resource allows you to control ink saving. Ink saving is achieved by applying 
Grey Component Removal (GCR) to replace the usage of process color inks by 
black.

Administrator access level only!

Associated Task Processors

 Apogee Preflight

 Generic Press

What is GCR?

Within the CMY color space, any hue angle can be achieved by combining two of 
the three primaries. The intention of the third color is to move that hue towards 
grey (decrease saturation), and is known as the greying agent. However, as that 
greying agent has an inherent hue of its own, it also shifts the hue as it changes 
the saturation of the resulting color. The most efficient way to change the satura-
tion of a given color while maintaining the same hue angle is to use the Key 
(Black) component. The act of substituting a quantity of the greying agent for a 
quantity of black is known as Grey component replacement. In grey component 
replacement (GCR), the CMY values that add to grey all along the tone scale can 
be replaced with black ink. Gray component replacement only adds black to the 
CMY equivalent of what would have printed as a grey.

GCR has benefits because black ink is generally less expensive than colored inks, 
and the resulting output is less susceptible to changes in the printing variables 
since you are not continually trying to balance as much C, M, and Y.

InkTune Sets Overview

This is the list of all the available ink-saving presets. 

Select a preset in the list to see more information in the pane on the right. Use 
the sliders to change the values of the presets.
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In Neutrals

These settings control GCR in the neutral tones.

Start K The value at which GCR in neutral tones kicks in. Typically, this should be 0%.

GCR Mid tones This slider is used to control the GCR curve between the Start K point and the 
blackpoint.

GCR Blackpoint Sets the percentage of GCR applied to the neutral tones. Blackpoint is the darkest 
point as defined by the press profile.

In Colors

These settings control GCR in the colored tones.

Chroma Zone Defines the Chroma value from which point onwards the GCR Chroma % is 
applied. For colors with a Chroma value below the set point, the amount of GCR 
is gradually set between the GCR % of the Neutral set up, and the GCR 
Chroma %. Any color with a Chroma value higher than the Chroma Zone value, 
will be treated with GCR Chroma % value.

GCR Chroma Sets a different amount of GCR for (saturated) color than for neutrals. The GCR 
Chroma % value will be applied to any color with a Chroma value higher than 
the Chroma Zone value. 

Multi-Colors

These settings control GCR in the multi-colored tones. Refer to Chroma Zone 
and GCR Chroma for parameter descriptions.

Ink Limits

These values set the limits for controlling GCR. Select the Override Input Ink 
Values check box to force ink save for colors with higher ink loads than the press 
profile.

Override Input Ink Values This check box can be selected to force colors with higher ink loads than the 
press profile to apply ink saving up to a new maximum ink load — for both the 
total ink load and for max K separately.

NOTE: When this option is selected, the label of the Max K parameters changes 
from GCR Max K to Force Max K and the Ink Limits drop-down list is enabled.

When this check box is cleared, the Max K slider defines the maximum value for 
K to be used during the GCR calculation. However, input colors that already 
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contain more K than the result after GCR calculation, will not be changed in 
order not to waste ink.

Force Max K The maximum amount of black ink that may be used for ink saving.

Ink Limits Two options are available in the drop-down list:

Total Ink Limit (TIL/TAC): Set a total ink limit so that all colors will have ink saving 
applied with that value as maximum total ink value.

Dynamic Low-ink Coverage (DLC): Selecting this option displays advanced 
settings to save ink by adjusting the color gamut of a profile and omitting zones 
where color differences are difficult for the human eye to distinguish. Sliders 
with a maximum value of 400% are displayed for the following ink zones:

 Primary CMYK

 Secondary RGB

 Secondary CK, MK, YK

 Tertiary CMY

 Tertiary CMK, CYK, MYK

 Equal CMYK.
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Ink Sets

Ink Sets contain the color specifications for the process colors. Apogee ships with 
a number of installed ink sets such as Euro, Swop, Toyo, Dic and Iso. They all use 
the standard CMYK color space. 

In the Ink Sets Resources you can select an existing Ink Set for your Press Task 
Processor or create a new one where you can manually specify which colors have 
to be used as separation colors.

Administrator access level only!

Associated Task Processors

The Ink Sets Resources are available for all Print (Press) Task Processors.

Printing Ink Sets Overview

Provides an overview of the available ink sets.

Ink Set

Lists the names of the ink sets that are available on the Press.

Process

Indicates which colors are available in the available ink sets.

Ink Set Editor

Allows you to edit an ink set.

Name

The name of the Ink Set should be unique. This field cannot be left empty.
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Color Space

The name of the used color space. In the drop-down list you see all of the avail-
able color spaces.

Colors

In these fields you see the name of the inks used for that specific color model.

 To edit an ink set

1 In the System Overview window, select the Press Task Processor for which 
you want to edit an ink set.

2 Double-click the Ink Sets icon in the Resources pane.

The Ink Sets overview appears, listing all of the available Ink Sets.

3 Select the Ink Set that you want to edit and click the Edit button.

The Ink Set editor appears.

4 Select the Color Book in the left column and the color in the right column.

5 Click OK.

The selected color will be used as a separation color.

6 Repeat the selection procedure for each separation color.

7 Click OK to save your settings and to close the Ink Set editor.

8 Close the Ink Set overview.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1029
Ink Tables

This category allows you to manage your Ink Table resources.

Administrator access level only!

Associated Task Processors

The Ink Tables Resources are available for the following Print Task Processors:

 M-Press

 M-Press Color Separations

Ink Tables Overview

The Ink Tables overview lists the available ink tables.

You can import, export or delete ink tables.
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Input Color Conversions

Input Color Conversions are presets that convert the color values of the 
document elements to the document output intent. The actual input conversion 
is performed by the PDF Render task processor where you select the Input 
Conversion preset in the Render operation.

To select your input color conversion in the Render operation of PDF Render, 
you must choose Document Based mode in the color management settings.

Associated Task Processors

 Apogee Preflight

 PDF Render

Input Color Conversions Overview

Administrator access level only!

The Input Color Conversions overview lists all available input conversions.

Input Color Conversion list

Select a conversion in the list to see more information in the pane on the right.

Convert Objects to Document Intent

These setting define how color values in CMYK, RGB and Gray objects are 
converted to the Document Output Intent.
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Apply Black Point
Compensation

Apogee uses a built-in algorithm to adjust for differences in the black points. 
Select the color space or spaces you want to apply this conversion to: RGB, 
CMYK, Gray.

Gray Conversion: Convert
as pure K

Select this option to render a gray image in K only.

CMYK Profile Link
Exception

Choose an exception from the drop-down list:

 None

 Keep 100% K

 Normal

 Preserve K

 Preserve Pure Colors

 other exceptions as listed in the Profile Link Exceptions resource

Defaults

If the input tagging sets the rendering intent to From Input but no color values 
are specified, a default rendering intent is applied.

Rendering Intent Choose a default rendering intent from the drop-down list:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.

Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative Colorimetric, except that here the white point of the two profiles is 
preserved. White of source color space is simulated with CMYK values from the 
destination color space. The consequence is that every white object/area is 
covered with certain ink amounts.
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NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.
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Linearization Curves

Linearization is a special type of calibration, intended specifically for imageset-
ters and platesetter. For more general information on Linearization, see “What 
is Linearization?” on page 1164.

Associated Task Processors

The Linearization Curves Resource category is available for the following Task 
Processors:

 All of the Imagesetter and Platesetter Task Processors.

Administrator access level only!

Linearization Settings

The creation process of Linearization curves consists of a series of dialog boxes 
and the Linearization Curve Editor. For detailed information on the settings of 
these dialog boxes, see “Calibration and Linearization Settings” on page 1166.

 To create a new linearization curve

1 In the System Overview window, select the Output Task Processor for which 
you want to create a new Linearization Curve.

2 Double-click the Linearization Curve icon in the Resources pane.

The Linearization Curves overview appears. In the upper pane, you see all of 
the available Linearization Curves for the Output Task Processor.

3 Click the New button.

A dialog box appears in which you can specify different settings.
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4 Select the type of Screen and the associated Resolution, Frequency, Dot 
Shape, Media and Polarity.

Workflow cannot be selected. It is displayed only for information.

NOTE: For CristalRaster screens, you have to specify the Dot Size instead of 
Frequency and Dot Shape.

5 Click OK to save your selection.

A Curve Wizard dialog box appears.

6 Specify how you want to initialize the table and click Next.

A Curve Wizard dialog box appears where you can specify the initial curve 
data.

7 Select the values for the Stimuli column and click Next.

A Curve Wizard dialog box appears where you can specify the initial curve 
data.

8 Select the values for the Wanted column and the Measured column and click 
Finish.

The Linearization Curve dialog box appears.

9 Enter any required information, type the name of your Linearization Curve 
and click OK.

Your Linearization Curve appears in the Linearization Curve List in the upper 
pane.

10 Close the dialog box.

Workflow Selection In the upper right corner, you can select the polarity of the workflow. You can 
choose between:

NOTE: These polarity options 
are not displayed for 
platesetters.

 Positive CTF

 Negative CTF

This option is repeated in the Linearization Map Settings, so that you have a 
complete overview of all the relevant settings when creating Auto-Select Maps 
for Linearization. For more information on Linearization Auto-Select Maps, see 
“Linearization Auto-Select Maps” on page 1035.
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Linearization Auto-
Select Maps

You can create Linearization Auto-Select Maps in the Linearization Curves 
Resource category. For more information on Resources maps see “Using 
Resource Auto-Select Maps” on page 1159.

In order to do so, select the Linearization Curve and click Add Map. This will 
open the settings dialog box for Linearization maps. These settings are identical 
to the General Settings of a Linearization curve. For more information on these 
settings, see “Curve Editor” on page 1170.

NOTE: You can also drag and drop a Linearization Curve to the Linearization 
Auto-Select Maps table. 

Fallback

Click the Fallback button to specify what Apogee should do if the automatic 
selection of linearization curves does not find a match. You have the following 
options:

Use no linearization

The job will be processed without linearization.

Notify

Apogee will put the job on hold and send a message to the Message Board.
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Margins

This resource is important for unbound work and provides extra cut-off margins 
around the different elements of the unbound work. These margins are similar 
to the Page Trim Margins for bound work.

 Double-click the Margins icon for an overview of the available Margins.

Associated Task Processors

The Margins resource is available for the following Task Processors:

 Impose

 Raster Impose

Administrator access level only!

Margins Overview

The Margins dialog box lists all available Margin resources in the left column.

 Click a Margin in the left column to display its settings.

Name A meaningful name of the resource
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Offcut Enter the Offcut distances in mm. These are the Top, Bottom, Left, Right margins 
for extra paper around each element. 

Click the link icon if you want to set specific values for Left, Right, Top or Bottom. 
Margins are relative to the frame which initially corresponds with the trim box 
of your image.
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Mark Engraver

The Mark Engraver is an important resource of Apogee Impose which is used to 
organize marks in Mark Sets and add these Mark Sets to the Pages, Fold Sheets 
and Press Sheets of an imposition.

The marks are placed automatically using conditions, however, it is also possible 
to place the marks manually using the Marks palette in the Press Sheet View of 
Apogee Impose. Although the Mark Engraver is for administrators only, the 
settings of the different marks can be accessed by all users in the Press Sheet 
View.

Associated Task Processors

The Mark Engraver resource category is available for:

 Impose

 Raster Impose

Administrator access level only!
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 Open the Mark Engraver

 In the Layout Editor, choose Window > Resources and select Mark Engraver, 
or go to System Overview.

At the top of the Mark Engraver you have an overview of marks in the 
different categories.

The section under the overview shows the conditions for the selected Mark 
Set or the details of the individual Marks within each Mark Set. This section 
can be opened by clicking the grey triangle.

By default, the conditions and details are locked. You can unlock the condi-
tions and details for editing by clicking the Lock icon in the bottom left 
corner.

Mark Sets 
Overview

The left column of the overview section displays the three Mark Sets categories 
and the number of Mark Sets in each category. The Mark Sets consist of marks 
which are brought together and placed according to the specified positioning 
and conditions.
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The Mark Sets are organized in the following categories:

 Page Marks: Crop, File, Text, Line, Rectangle, Page Fold Line, Circle

 Fold Sheet Marks (bound products): File, Text, Line, Rectangle, Registration, 
Cut Mark, Cross Mark, Collation Mark, Fold Line, Circle

 Press Sheet Marks: Cut-off, File, Text, Line, Rectangle, Registration, Slit, 
Color Bar, Cutter Registration, Density, Color Bar, Ink-Eater, Circle

 Element Marks (unbound folded and flat products): File, Text, Line, 
Rectangle, Cut, Fold Line, Registration, Circle

 Image Marks: Text, File, Crop, Grommet, Color Bar, Line, Rectangle, Circle

 Sheet Marks: Text, File, Cut, Registration, Fotoba, Cutter Registration, 
Grommet, Line, Rectangle, Circle

 Product Marks: Text, File, Station Number, Color Bar

The middle column lists all the Mark Sets for a particular category and the 
number of Marks in the selected Mark Set. The Name of the Mark Set is preceded 
by an icon that indicates the condition applied to the Mark Set.

The right column lists all the Marks of the selected Mark Set.

 To add/edit a Mark Set

1 Unlock the Mark Engraver and click a Category

2 Click the new button above the Name column.

OR

Right-click in the middle column and choose New from the list.

A new Mark Set name appears in the list with a default name and 0 Marks.

OR

Right-click an existing Mark Set and choose New or Edit from the list.
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3 Set the conditions for this new Mark Set.

4 Lock the Mark Engraver.

 To add a Mark

1 Unlock the Mark Engraver and click a Mark Set name.

2 Click the new button above the Marks column.

A drop-down is displayed with a list of the different Mark types.

OR

Right-click in the Marks column.

3 Select the Mark type you require.

The Mark is added to your Mark Set with a default name.

4 In the Details section, edit the settings for your new Mark.

5 Lock the Mark Engraver.
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 To duplicate a Mark/Mark Set

1 Unlock the Mark Engraver and right-click a Mark/Mark Set name.

A menu is displayed.

2 Select Duplicate to copy the Mark or Mark Set.

The new Mark Set contains the same Marks as the original and has the same 
conditions. The Marks have the same details.

3 Edit the settings for the new Mark Set/Mark as required.

 To move/copy Marks between Sets

 Drag a Mark from one Mark Set to another or press the Ctrl key while 
dragging to duplicate the Mark.

NOTE: You cannot move between categories.

 To name/re-name a Mark/Mark Set

1 Unlock the Mark Engraver and context-click a Mark/Mark Set name.

A menu is displayed.

2 Select Edit to rename the Mark or Mark Set.
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Mark Set Conditions

The Conditions section of the Mark Engraver is the same for the four categories 
of Mark Sets. By default you see one line where you can enter criteria. Criteria 
lines can be added, edited or deleted. The printing of the marks can also be 
limited to proofs.

Examples of conditions: 

Apply When all criteria are met with criterion $product.name equals 
MyProduct.

Apply When some criteria are met with criterion 
$press_sheet.side.press.name equals Large Press.

 Click a Mark Set category and then the Name of a Mark Set to display the 
Conditions section.

Apply to “Split for Proof” results only

Select this check box if you only want the mark set to appear on the proofs of a 
press sheet and not on the actual press sheet when it is printed. If you select this 
option, the proof-only marks do not appear in the Mark Sets inspector nor in 
Sheet View and no checks are performed for conflicts. Proofs always include the 
actual press sheet marks.

Apply

 Always: the Mark Set is always applied and does not take the criteria into 
account.

 Manually only: The Mark Set can only be placed manually.

 When all criteria are met: The Mark Set is only applied when all the criteria 
lines are true.

 When some criteria are met: The Mark Set is applied when at least one of the 
criteria lines is true.

The selected condition is indicated with an icon in the Mark Sets list.
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Variable

This drop-down lists the variables you can use for your criteria.

Expressions

Depending on the variable you use for your criterion, you will see expressions 
that test against a string (e.g. the name of a Press or Product) or a number:

 equals (string or number)

 does not equal (string or number)

 less than (number)

 greater than (number)

 less than or equal to (number)

 greater than or equal to (number)

 is even (number)

 is odd (number)

 contains (string)

 does not contain (string)

Value

In this field you enter the value you want to apply for the variable:

 a string: e.g. your Product, your Press

 a number with/without unit: e.g. 1000 mm

Mark Set is always applied

Mark Set is only applied manually

Mark set is applied when all/some criteria are met

Mark set is applied partially (mark deleted manually for example)

None of the marks of the mark set are applied (marks deleted manually for example).
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 To create/edit a Mark Set condition

1 Click a Mark Set Category and then a Name to display the Conditions section.

2 Choose one of the options from the Apply drop-down list, e.g. When all 
criteria are met.

3 Click the New button next to the conditions line to create a new criteria line.

4 Choose a variable from the first drop-down list, e.g. $job.order, an expression 
from the middle list, and enter a value in the right field to complete the 
criterion.

Mark Types The different Mark types are indicated with a specific icon:

Circle Mark: draws a circle with or without fill color

Collation Mark: stepped blocks with the signature number which are used to inspect the 
correct collation order of folded sheets

Cut Mark: a horizontal and a vertical line in the corners of a Fold Sheet to indicate the 
boundaries of the Fold Sheet and where it is to be cut

Cut-off Mark: lines at the cut-off between Web Production Schemes, on the left and right 
sides of the web

File Mark: places a specific EPS or PDF file as a mark

Fold Line: draws a set of vertical or horizontal lines that indicate where to fold the sheet or 
the page.

Line Mark: draws a line

Crop Mark: a horizontal and a vertical line to indicate where the page has to be cropped

Rectangular Mark: draws a rectangle with or without fill color

Registration Mark: draws a series of marks which are used to check that the registration of the 
different printing colors is correct

Text Mark: prints the job name, order number, color name, etc. on the Press Sheet

Slit Mark: draws a line to indicate where a press sheet is to be cut in ribbons for web printing

Color Bar Mark: generates a bar of color patches, using the colors that are present on the 
press sheet (offset and wide-format) or in the product.
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These icons are also used in the Mark Sets Inspector in the Press Sheet View.

Each Mark type has its own settings which are displayed in the Details section of 
the Mark Engraver. The Details section has a number of tabs depending on the 
Mark type:

 “Mark Attributes” on page 1046

 “Mark Position” on page 1076

 “Mark Conflicts” on page 1079

 “Mark Repeat” on page 1080

 “Mark Special” on page 1081

Mark Attributes The Attributes are explained for each Mark type.

 “Circle Mark Details” on page 1047

 “Collation Mark Details” on page 1048

 “Color Bar Mark Details” on page 1053

 “Crop Mark Details” on page 1057

 “Cross Mark Details” on page 1057

 “Cut Mark Details” on page 1058

 “Cut-off Mark Details” on page 1059

Cross Mark: indicates the crosspoint of two gutters, or at the endpoint of a gutter.

Density Bar: draws bars of equal density across the full width of the press sheet or along the 
edges. 

Ink-Eater Mark: places a background mark between the products or on the outside of the fold 
sheets. 

Page Fold Line: draws a set of vertical or horizontal lines that indicate where to fold on a 
single page element.
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 “Cutter Registration Mark Details” on page 1059

 “Density Bar Details” on page 1061

 “File Mark Details” on page 1063

 “Fold Line Mark Details” on page 1064

 “Fotoba Mark Details” on page 1065

 “Grommet Mark Details” on page 1066

 “Ink-Eater Mark Details” on page 1067

 “Line Mark Details” on page 1070

 “Page Fold Line Mark Details” on page 1071

 “Rectangle Mark Details” on page 1071

 “Registration Mark Details” on page 1072

 “Slit Mark Details” on page 1073

 “Station Number Mark Details” on page 1074

 “Text Mark Details” on page 1074

Circle Mark Details

Mark Sets Categories: Pages, Fold Sheet, Press Sheet, Image, Sheet

The Circle Mark draws a rectangle with a border and fill color. This mark is 
always printed using knock-out.

Width Specifies the horizontal size of the mark. You can create oval shapes by 
unlocking the link and entering different values for Width and Height.

Height Specifies the vertical size of the mark.

Border pen Choose a pen to draw the lines; lines have different thicknesses.
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NOTE: The border is created on the inside of the bounding box.

Fill with color This option is selected by default.

Click the variable button, and select one or more options to determine on which 
plate(s) the mark will be printed:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Collation Mark Details

Mark Sets Category: Fold Sheet

A Collation Mark combines a signature mark and a version mark to check that 
folded sheets are collated in the correct order for each version.

Attributes tab

Step Area The step area is the area in which the mark travels. The mark starts at the top (or 
bottom) of the step area, and advances one step with each section/signature.

 Position: You can choose to position the collation marks automatically, semi-
automatically or manually.

 Automatically by Assembly Style: Apogee determines the target and 
position of the step area, based on the assembly style; in nested styles, 
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Apogee Impose draws the mark on the closed-head, and in stacked styles 
it draws it in the outer spine.

 Spine: The marks are placed on the outer spine.

 Closed Head: The marks are placed on the last but one fold.

 Open foot: The marks are placed on the margin opposite to the closed 
head, on every page of the fold sheet, on both front and back sides.

 Overfold: The marks are placed on the innermost overfold.

 Faces: The marks are drawn on the face margin of every page of the fold 
sheet.

 Manually: You can define the position of the marks in the Position tab. See 
“Mark Position” on page 1076.

 Offset from edges: The distance of the step area from the page trim edges. 
The default value is 0 mm.

 Thickness: The thickness (width) of the step area. The default value is 3 mm.

 Rotate: If you select manual positioning of the step area, you can also choose 
to rotate the marks.

 Knock-out: Select to knock out the area under the mark. The knock-area is 
the bounding box of the mark.

 Extend: Extends the knock-out area of the mark by the specified values for 
the left and right edges and for the top and bottom edges; can be used for 
conflict checking.

Stepping  Number of Steps: Sets the number of steps in the step area:

 Fit within available space: Apogee calculates the number of steps possible 
in the available space.

 Fit within fixed length: enter a length and Apogee calculates the number 
of steps.

 Fixed: set the number of steps you require.

 Pattern: The pattern defines the position of the first mark, the direction in 
which the mark is stepped (normal or reverse), and what to do when arriving 
at the end of the step area (sawtooth or zigzag). Apogee graphically 
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represents the four possibilities. The default is to use normal direction with 
the sawtooth movement.

Signature Mark The signature mark is the marking on the spine or fold of the folded sheets that 
indicates the signature. It is printed in black and may optionally contain an index 
number.

 Color: The color of the stepped blocks of the mark; the text in the mark is 
always white and knocked out of the blocks.

 Fixed Color: Specify any of the fixed color names. When Fixed Color is 
selected, you can choose the colors with the variable button

–

 Indexed Color: The Color edit field becomes read-only when you use 
indexed colors, it shows the name of the selected Color palette, you can 
change the parameters of the indexed colors with the pen button.

See “About Colors and Depth for Printing Marks” on page 1083 for more 
information on using colors to print marks.

Color name Description

* All colors (‘register’)

! The separation with the lowest L-value of all (‘darkest’) 

Cyan, Magenta, Yellow, 
Black

Fixed process colors, regardless of the ink-set used.

C, M, Y, K Short names for the fixed process colors.

Spot1, Spot2, ... Spot color by order of separation.

White, Varnish, Primer The special inks of ink-jet printers.
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 Length: The length of the mark. Also sets the step size with which the mark is 
offset. Note that there is no gap between two adjacent marks.

 Index: Indicates the orientation of the index number: not printed, at 0 
degrees, 90 degrees, 180 degrees, 270 degrees.

 Text: Selects the text to print. You can combine the literal text with variables. 
The default value is $fold_sheet.name. This field is disabled when the Index 
is set to None.

 Color: Selects the color to print the index. The default value is Automatic. 
This field is disabled when the Index is set to None.

 Automatic: Draws the text is with the same color as the shuttle’s color.

 Fixed Color: Specifies the color to draw with. 

 Indexed Color: Selects the color palette.

Script and Font Two drop-down lists for the script and font to be used for the index number. The 
default script is Roman which uses the Helvetica font by default.

For Chinese or Japanese, choose these from the Script drop-down list and then 
select an appropriate font for these languages from the Font drop-down list. 
Choosing Chinese or Japanese changes the writing direction of the index 
number to vertical. This writing direction can be combined with the index 
number orientation option.

NOTE: This dialog box always shows an Arabic number 1 as an example. The 
actual rendering can only be seen in the Press Sheet view or Raster Preview.

Versioning tab

Versioning  Draw versioning collation mark in versioning jobs: Select to draw the 
versioning collation mark in versioning jobs.

Reserve Zone in Step Area  Number of version Steps: Specifies how many steps to reserve for the version 
shuttle. The default value for percentage of steps is 33%.

 Fixed: Specifies the number of steps (nv). The number of steps must be 
larger than 1 and not cause the number of signature steps (ns).

 Fixed with fixed length: Specifies the length of the zone (V). The zone 
length must be at least twice the size of the shuttle and not cause the 
number of signature steps to become less than 2.
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 Percentage of total steps: Specifies the percentage of the total number of 
steps to use. The value must not cause the number of signature steps to 
become less than 2.

 Automatic: Allows Apogee divide the step area using the same ratio as the 
number of signatures versus number of product versions. The number of 
steps in each zone must be always > 1. 

 Space between version and signature marks: Enter the distance that you 
want between the two marks. When it is set to 0, both marks are edge-to-
edge.

Version Mark A colored mark placed next to the signature mark to indicate the version for a 
versioning job.

 Color: The color in which to draw the version shuttle rectangle. 

 Automatic: Selects the color that is guaranteed to be unique for every 
product version. In case there is no such color the shuttle is printed in 
black.

 Fixed Color: Specifies a specific color. 

 Indexed Color: Selects the color palette. 

 Length: The length of the space to be reserved for the version mark; the width 
is the same as the signature mark.

 Index: Specifies how the version number is printed:

 Number only: print the version number without the ‘v’

 Short version name: print the version number with the ‘v’

 None: no version number will be printed

Pattern Select the pattern in which direction the two shuttles move. If there are more 
positions requires than available, Apogee follows the Pattern selected in the 
signature mark.
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 Moving inwards: The first position of both shuttles are on the outside of the 
step area.

 Moving outwards: The first position of both shuttles are located where the 
two step areas meet. 

Color Bar Mark Details

Mark Sets Categories: Press Sheet, Image, Product Marks

The Color Bar generates a bar of color patches using the colors that are present 
on the press sheet (offset and wide-format) or in the product.
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Contents Each row shows the type of the element, the shape and stroke of the patch, the 
size, the local gradations and the presence and position of the label. You can add, 
duplicate, delete and change the order of elements in the list.

Patch  Inks: Select the inks (colors) to add to the color bar. The drop-down lists the 
Inks’ options.
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.

 Shape: Select the shape of the patch.

 Size: Specify the width and height of the patch. The shape always fills the 
specified size.

 Stroke: Specify how to stroke the patch.

 Registration: Prints the stroke in all colors in the current scope, same as 
"*".

 Darkest Color: Prints the stroke in the darkest color in the current scope, 
same as "!".

 None: Do not stroke the patch.

 Width: The width of the stroke. It is disabled when the stroke is set to None.

 Gradations: Specify the gradations as a comma-separated list of densities (0–
100). An empty entry signifies that the patch follows the gradations of the 
bar. In that case, the field shows the text in gray text.

Label  Position: Select whether to have no label or a label below or above the patch. 

 Format: Select how to format the label.

 Short name: Print the short name of the color.

 Full name: Print the full name of the color.

Ink Description

All colors Generates patches for all colors in scope.

Process colors Generates patches for all process colors in scope.

Spot colors Generates patches for all spot colors in scope.

Darkest color Generates a patch for the darkest color.

No color Generate a patch that prints no color.

Color by index Generates a patch that prints the specified ith color, with i being 
integer numbers starting from 1.

Spot color by index Generates a patch for the specified color specification, using the 
extended color specification syntax.

Custom Generates a patch for the specified process color. The menu shows a 
list of the colors in the currently selected ink set. In the Mark 
Engraver, the lists shows the four standard process colors (CMYK). 

Process color list Generates a patch for the specified spot color.

Spot color list The menu shows a list of the actual spot colors that are in scope. 
The circular icons show the actual color.
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 Short name, Gradation: Print the short name of the color and the 
gradation (without %).

 Single line: Select to print the gradation on the same line as the color name 
(separated by a space) or below the name (centered). It is disabled when not 
printing the gradation.

Strip  Exclude: Select the special colors that will not be included when using any of 
the following patch entries; All colors, Process colors, Spot colors. These 
colors will not be listed in the color selection menus, either.

 Varnishes: Exclude all colors that are found in the Varnish category of the 
Special Colors.

 Dielines/Operation Colors: Excludes all colors that are found in the 
Dielines category of the Special Colors or that are recognized as 
Operations.

 Gap between patches: The gap between two successive patches. 

NOTE: The bounding box of the color bar is at the edges of the outer patches; 
it does not include 1/2 gap size.

 Align patches: The vertical alignment of the patches when they have different 
heights. An empty value is interpreted and replaced by 100%.

 Gradations: Enter 1 or more comma-separated graduation values in range 1–
100.

 Rotate: The rotation of the color bar.

 Knock-out: Select to knock out the area under the mark. The knock-area is 
the bounding box of the mark.

 Extend: Extends the knock-out area of the mark by the specified values for 
the left and right edges and for the top and bottom edges; can be used for 
conflict checking.

 When Clipping: Select to clip the mark (when it needs clipping) at the 
boundaries of each cell so that all patches are printed with the full size. 

NOTE: The left and right edges of the bounding box of a color bar are always 
at the edges of a patch, i.e., it does not include the gap. 
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Crop Mark Details

Mark Sets Category: Pages, Image

A Crop Mark is a horizontal and a vertical line to indicate where the page has to 
be cropped.

Type A drop-down list with 2 options for what the crop mark indicates:

 Page Trim: the final size of the pages

 Page Bleed: perpendicular lines at the corner of the bleed zone of a page, 
indicating the bleed area

Distance from corner Specifies the distance between the center of the mark and the page corner; the 
page corner can be for the Page Trim or the Page Bleed.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.

Hiding Selected by default and hides the marks between adjacent pages.

Shingling Specify whether shingling is to be applied or not.

NOTE: Crop marks only have the Layer settings to be defined in the Position tab.

Cross Mark Details

Mark Sets Category: Fold Sheet
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A Cross mark indicates the crosspoint of two gutters, or at the endpoint of a 
gutter. They are commonly used in web production schemes to verify the 
correctness of cutting, slitting, and folding.

Length Specifies the length of the line in a full cross, e.g. the line segments of a cap are 
half the specified length.

Pen Choose a pen to draw the cross lines.

Hiding Hides the marks on the outside of the fold sheet.

Cut Mark Details

Mark Sets Category: Fold Sheet, Sheet

A Cut Mark is a horizontal and a vertical line in the corners of a Fold Sheet to 
indicate the boundaries of the Fold Sheet and where it is to be cut.

Distance from corner Specifies the distance between the corner end of the mark and the Fold Sheet 
corner.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.
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NOTE: There is no option to hide marks between adjacent Fold Sheets.

Cut-off Mark Details

Mark Sets Category: Press Sheet

A Cut-off Mark is a line that indicates where to cut between sheets in web 
printing. The line is drawn at the cut-off inside a single Web Production Scheme, 
but no marks are drawn when there is only one cut-off between schemes or when 
placed on a sheet-fed sheet. Cut-off marks are situated on the left- and right sides 
of the web and not at the edges of the ribbons.

Distance from sheet edges Specifies the distance from the left and right edges of the sheet.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.

Cutter Registration Mark Details

Mark Sets Category: Sheet

Cutter registration marks are reference dots which are drawn on a layout to 
enable cutting with X/Y cutting devices.

Type The following types of Cutter Registration marks are available:
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 Filled circle

 Reversed circle

 Filled rectangle

 Reversed rectangle

Diameter/Width, Height The diameter/width and height of the circle/rectangle.

Outer size The diameter of the reversed circle.

Distance from images The distance of the dots from the edge of the image or image block.

Color/Reverse Color The colors of the filled circle and reversed circle can be specified separately. 
Click the variable button, and select one or more colors to change the color:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Location

In the location panel, you specify where you want the dots to appear, and 
depending on the chosen location, the number of marks. The following options 
are available from the drop-down list:

Corners Dots are placed at the corners of the image block. 3, 4 or 5 dots can be placed to 
indicate the lay of the cut block.

Individual Images Dots are placed along a cut path that takes into account the nested arrangement 
of all the images. Here you can choose between Few and Many.

Top/Bottom Dots are placed along the top and bottom of the image block, and you can set the 
number of dots by specifying the distance between them.

Left/Right Dots are placed along the left and right side of the image block, and you can set 
the number of marks by specifying the distance between them.

All Sides Dots are placed along all sides of the image block, and you can set the number of 
marks by specifying the distance between them.

Max. distance between
marks

Set the distance between adjacent dots if you require more than the default 
number of dots.
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Shift top/left marks The offset applied to the dots on the top or left side.

Distance from The distance of the dots from the edges of the images or media.

Density Bar Details

Mark Sets Category: Press Sheet

The Density Bar mark draws bars of equal density across the full width of the 
press sheet or along the edges. A bar is drawn for each separation color. In the 
Conflicts tab, you can specify the action to be taken (fail the job, print mark, do 
not print the mark, notify) if the step area interferes with the content.

Type

Top bars Draws density bars at the top of the sheet and across the entire width of the press 
sheet or content block.

Edge bars: left or right Draws smaller density bars, similar to patches, on the right or left side of the 
press sheet. These bars are centered on the specified edge, i.e. half the width falls 
outside the press sheet and is not clipped.
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Custom Lets you specify the location of the step area where the bars are drawn. Choosing 
this type enables extensive settings in the Position tab.

Step Area

This is the zone where the density bars are drawn on the press sheet – outside the 
content block (pages plus bleed) – so they do not interfere with the actual 
printed content. The available settings depend on the chosen type. 

References Select the Use press sheet margins as edge check box if you want to bring the 
bars within the margins of the sheet. Otherwise the bars extend to the edges of 
the sheet.

Position Specifies where the bars will appear:

 At top of sheet: The top of the step area is at the top of the press sheet or 
against the margins, with the topmost bar against the top of the step area.

 Above content block: The bottom of the step area is against the top edge 
of the content block, with the bottommost bar against the bottom of the 
step area.

 At Gripper: The bottom of the step area is against the gripper.

 Center of press sheet: The vertical center of the step area is in the vertical 
center of the press sheet, with the bars centered vertically in the step area.

Height Specifies the total height of the step area:

 Available space: Uses the space between the edge of the press sheet and 
the topmost margin of the content block, minus the offsets specified in the 
Offset From settings.

 Fixed: You can enter a value for the height of the step area.

Width Specifies the total width of the step area:

 Across the press sheet: Prints the bars across the entire press sheet (with 
the margins), minus the offsets specified in the Offset From settings.

 Across content block: Keeps the bars within the width of the content 
block.

Offsets from Enter a distance that the step area must keep away from the content block or 
sheet edges
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Bars

Here you specify the height of the bars and the spacing between them.

Height  Fill step area: The height of the step area is divided by the number of 
colors, minus the space between the bars, to obtain the height of the 
individual bars.

 Fixed: You specify the height of the individual bars.

Between bars Specify the distance between the individual bars; the space can also be zero.

Colors

By default, each color in the job has its own bar. They appear in the same order 
as in the separation list of the Render task processor. You can control which 
colors are printed as follow:

Include Choose which colors you want to print bars for:

 All colors: all kept and converted colors

 Process colors: all kept process colors

 Spot colors: all kept non-process colors

Except Enter the names of the colors (not case-sensitive) that you do not want to print 
as color bars; separate the names with a comma.

File Mark Details

Mark Sets Categories: Pages, Fold Sheet, Press Sheet, Image, Sheet, Product

Use a File Mark, if you want to place a specific EPS or PDF file as a mark.
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File Click the File list and select one of the available EPS or PDF files. The file is 
selected as the mark to be used and you see the size and number of colors used 
for the mark.

NOTE: You can open the Marks Resource by clicking the Open File Marks button, 
for example, to import a new mark. 

 Scale: Specifies the scaling percentage of the file. The default is 100% in both 
directions. The link button keeps both directions at the same scale.

 Knock-out: Select to knock out the area under the mark. The knock-area is 
the bounding box of the mark.

 Extend: Extends the knock-out area of the mark; can be used for conflict 
checking.

When clipping Only enabled if the selected file has an internal cell structure. Select if you only 
want the mark to be clipped at the cell boundaries of the mark (e.g. color bars); 
clear if it is alright to clip the mark anywhere.

Rotate Specify the rotation angle for the mark (0, 90, 180, or 270 degrees). 

NOTE: The selected file is copied into a reserved directory on the server.

Fold Line Mark Details

Mark Sets Category: Pages Fold Sheet

A Fold Mark draws a set of vertical or horizontal lines that indicate where to fold 
the sheet, mainly for bound products. Fold marks are not drawn on spread-based 
covers or unbound flat elements. For unbound folded work, the outside fold 
lines are drawn but not the lines between pages.
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Distance from page trim Specifies the distance from the nearest end of the mark to the page trim.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.

NOTE: Fold marks only have the Layer settings to be defined in the Position tab.

Fotoba Mark Details

Mark Sets Category: Sheet

Fotoba marks consist of horizontal and vertical lines which are drawn on a 
layout to enable cutting with a Fotoba cutting device.

Horizontal/Vertical Cut Marks

Fotoba cut marks are drawn along the horizontal and vertical sides of the 
individual images on a layout. Horizontal lines are drawn by default and you can 
optionally specify vertical lines.

Type: Single mark, Double
mark

Draws single or a double lines to indicate cutting.

Line thickness The thickness of each line.

Inner white The distance between the lines of a double mark.
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Side Mark

The side mark is a vertical line which is drawn in addition to the vertical cut 
mark.

Distance from image The distance from the image to the side mark.

Line thickness The thickness of the side mark line.

Color

The color of all the cutting lines. Click the variable button, and select one or 
more colors to change the color of the cutting lines:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Grommet Mark Details

Mark Sets Category: Image, Sheet

Grommet marks are sequential marks which are placed along the sides of an 
image or layout. These marks are printed on the layout and indicate where 
reinforced eyelets (grommets) can be produced. The marks are not part of the 
cut file.

Mark

First you specify the appearance of the marks.

Grommet type Three types of grommet marks are available:
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 Circle

 Circle with cross

 Cross

Diameter The diameter of the circle.

Line thickness The thickness of all the lines.

Line length The length of the 2 lines of the cross.

Color The color of all the cutting lines. Click the variable button, and select one or 
more colors to change the color of the cutting lines:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Placement

In the placement panel, you specify where you want the grommet marks to 
appear.

Placement You can choose to place the grommet marks along all sides of the image or 
layout, left and right, or top and bottom.

Distance from edge The horizontal and vertical distances of the grommet from the edge of the image 
or sheet.

Max. distance between
marks

The maximum horizontal and vertical distances between adjacent marks.

Ink-Eater Mark Details

Mark Sets Category: Press Sheet

The Ink-Eater Mark places a background mark (one large mark or repeated) 
between the products or on the outside of the fold sheets. The ink-eater can use 
all of the available space of a press, within the printable area of the press.
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Target The Target section defines which area of the sheet you want to fill with the ink-
eater.

 Area to fill: Select the area to fill.

 Press sheet: The area defined by the left, right, top and gripper edges. You 
can reduce the area by specifying the values in the Reduce by attribute. 
Positive values reduce the area.

 Product block: The area defined by the bounding box of the bleed paths 
from all products on the sheet. You can extend the area by specifying the 
values in the Extend by attribute.

 Reduce/Extend by: Extra space to add to the Product block or to subtract 
from the Press sheet. The default value is 0 for both cases.

Mask Products The Mask section defines how to protect the content: You can select whether to 
mask the contour or the bleed.

 By: Select the path to be used to mask the products: 

 Bleed: Use the product’s bleed path.

 Contour: Use the product’s contour-defining path.

 Extend by: Extend the product mask by the specified amount.

Type The Type section defines the type of the mark. The manual types draw a bar for 
each included color and repeat these across the entire width or height of the 
sheet. You can select the orientation and direction and set the densities of each 
color.

 Bars Up: Creates an ink-eater with bars across the width of the sheet, 
starting at the bottom of the ink-eater zone and repeating upwards to the 
top of the zone.

 Bars Down: Creates an ink-eater with bars across the width of the sheet, 
starting at the top of the ink-eater zone and repeating downwards to the 
bottom of the zone.

 Bars Left: Creates an ink-eater with bars across the height of the sheet, 
starting at the left of the ink-eater zone and repeating rightwards to the 
right of the zone.
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 Bars Right: Creates an ink-eater with bars across the height of the sheet, 
starting at the right of the ink-eater zone and repeating leftwards to the 
left of the zone.

 Number of steps: Select whether to specify a fixed number of repetitions or 
to allow the ink-eater to calculate it.

 Automatic: Select to allow the ink-eater to calculate the number of repeti-
tions, given the Minimum size of a single bar.

 Fixed: Select to allow the ink-eater calculate the size of the bars, given the 
Number of repetitions.

 Minimum size: The minimum size of a single bar.

Colors The Color section defines the colors to include. You can add, duplicate or remove 
the colors from the list.

Patch The color or color generator chosen for the selected entry in the Color list.

NOTE: The darkest color is set per side, not per zone.

 Density: The density to print the colors of the selected patch with.

NOTE: When using a mixed color entry, the density applies to all components, 
e.g. you can mix 60% Cyan, 40% Magenta and set the density to 40%. The 
end result will be a color of 24% Cyan and 16% Magenta.
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Exclude Select if the special colors to be excluded by the color generators.

 Varnishes: Excludes all colors marked as varnish.

 Dielines and Operation colors: Excludes all colors marked as contours and 
other Operations.

Line Mark Details

Mark Sets Categories: Pages, Fold Sheet, Press Sheet, Image, Sheet

The Line Mark draws a line that can be used for various purposes in production.

Type You can choose to draw a line at a specific location and with a specified size 
(custom), or let the line resize automatically to match a chosen target (auto-
sizing).

Auto-sizing line settings:

Target Choose the edge where you want to place the line (left, right, top, bottom) and 
the target box (page, fold sheet, spine, etc.). The available targets depend on the 
mark category. In the Offset field you can specify a distance from inside or 
outside the target box. The distance is from the center of the line to the target. 

Length An auto-sizing line is delimited by the target box you chose to position the line, 
(from target), or from other available boxes depending on the mark category.

Extend Enter a negative or positive value to respectively shorten or extend the line in 
both directions.

Pen Choose a pen to draw the lines; lines have different thicknesses.

Custom line settings:

Length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.

Angle Specify the rotation angle for the mark (0, 90, 180, or 270 degrees). 
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1071
Page Fold Line Mark Details

Mark Sets Category: Pages

A Page Fold Line Mark draws a set of vertical or horizontal lines that indicate 
where to fold on a single page element. 

Distance from page trim Specifies the distance from the nearest end of the mark to the page trim. 

By default, Apogee Impose only prints the fold marks on the outside of the page, 
but not on the inside. To draw them on the inside of the page, specify a negative 
value for Distance from page trim and allow the mark to overlap the page 
content.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the lines; lines have different thicknesses.

Rectangle Mark Details

Mark Sets Categories: Pages, Fold Sheet, Press Sheet, Image, Sheet

The Rectangle Mark draws a rectangle with a border and fill color. This mark is 
always printed using knock-out.

Around Choose the reference for drawing the mark. Choose Custom to use all the options 
on the Position tab, or choose a target object (Image block, sheet, etc.) if you 
want to draw the mark around an object. The available objects depend on the 
mark category.

Expand If you choose a target object for the Around option, you can also set a distance 
from the object where the mark will be drawn. Enter a positive value to draw a 
mark which is larger than the object (e.g. a rectangle around an image block), or 
a negative value for a mark which is smaller than the object.

Width Specifies the horizontal size of the mark.

Height Specifies the vertical size of the mark.
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Border pen Choose a pen to draw the lines; lines have different thicknesses.

NOTE: The border is created inside the mark.

Fill with color This option is selected by default.

Click the variable button, and select one or more options to determine on which 
plate(s) the mark will be printed:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Registration Mark Details

Mark Sets Category: Press Sheet, Fold Sheet, Sheet

A Registration Mark draws a series of marks which are used to check that the 
registration of the different printing colors is correct.

File Click the File list and select one of the available EPS or PDF files. The file is 
selected as the mark to be used and you see the size and number of colors used 
for the mark.

The preview pane shows the selected mark.
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NOTE: You can open the Marks Resource by clicking the Open File Marks button, 
for example, to import a new mark. 

Knock-out Select to knock out the area under the mark. The knock-area is the bounding box 
of the mark.

Extend Extends the knock-out area of the mark; can be used for conflict checking.

Rotate Specify the rotation angle for the mark (0, 90, 180, or 270 degrees).

Where Click in the diagram to specify where the mark is printed on the Press Sheet: in 
the four corners, the four center-side positions, or any other combination.

Offset from edges Distance between the center of the mark and the edges of the Press Sheet 
(including the lay).

Slit Mark Details

Mark Sets Category: Press Sheet

A Slit Mark is a line indicating where a sheet is to be cut in ribbons, as used in 
web printing. A line is drawn between two adjacent ribbons and not on the outer 
edges of the web. No marks are drawn when only one ribbon is present or if 
sheet-fed sheets are used. The position of the Slit Mark is defined in the Attri-
butes tab and not in the Position tab.

Distance from sheet edges Specifies the distance from the sheet’s leading and trailing edges.

Line length Specifies the length of the mark.

Pen Choose a pen to draw the line; lines have different thicknesses.
Apogee Reference Guide



1074 MARK ENGRAVER
Station Number Mark Details

See Text Mark Details, except for the Text field which is a number that is 
generated automatically to indicate the position of the product on a sheet.

Text Mark Details

Mark Sets Categories: Pages, Fold Sheet, Press Sheet, Image, Sheet, Product

Text Marks are used to print text on a Press Sheet and identify Press Sheets by 
printing the job name, order number, color name, etc.

Text In the Text field, you can specify which text is to be used as a mark. You have 
three options:

 Type some text in the Text field.

 Select a variable from the drop-down list. This list appears when you click in 
the Text field the button next to the field.

 A combination of the two previous methods, e.g. some text followed by a 
variable

Font Select a font and a point size for the text mark.

Length If you want you can change the calculated length of the text mark which is based 
on the amount of text, the point size and the variable. You can revert to the 
default, calculated length by clicking the revert arrow.

Script Select a Roman, Chinese, Hebrew or Japanese script for the text mark. Choosing 
Chinese or Japanese activates the Writing Direction option.

NOTE: If you choose Chinese or Japanese, don’t forget to select a relevant font 
for these languages in the Font drop-down list.

Writing Direction Horizontal is selected by default for Roman script (e.g. European languages) 
and can’t be changed; choosing Chinese or Japanese script activates the 
following options:

Horizontal: Select this option to place the text characters horizontally; the text is 
left-aligned in the text box.
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NOTE: The anchor point in the Mark Position tab is also used for aligning a 
Text mark. For example, placing a Text mark in the top right position means 
the text will grow from right to left and it is right-aligned in the text box.

Vertical: Select this option to place the characters underneath each other 
(certain Asian languages).

Use Arabic Numerals: Select this option to use Arabic numerals in vertical text.

Color Click the variable button, and select one or more options to determine which 
plate(s) will print the mark:

See “About Colors and Depth for Printing Marks” on page 1083 for more infor-
mation on using colors to print marks.

Readability Select the options to improve the readability:

 Underline text: Underlines the text.
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 Outline text: The text is outlined with a 1-point line at 0% of the specified text 
color, printed in knock-out around the type.

 Knock-out text box: Knocks out the area under the text. The knock-out area 
is the bounding box of the mark.

Extend Extends the knock-out area of the mark; can be used for conflict checking.

Rotate Specify the rotation angle for the mark (0, 90, 180, or 270 degrees).

Mark Position The Position tab in the Details pane contains settings that apply for all of the 
Mark types. These settings are explained in this section for all Mark types.

Mark

Anchor Point You can specify the exact position of the mark. This position is defined by a 
horizontal and a vertical distance from different parts of the sheet or plate. 

Target

Reference Choose a reference for the anchor point from the drop-down list. This reference 
depends on the Mark type:

 Page Marks

 Page Trim

 Fold Sheet Marks

 Fold Sheet 

 Outer Overfold

 Inner Overfold

 Outer Spine

 Inner Spine

 Lowest Page

 Highest Page
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 Top Page

 Bottom Page

 Press Sheet Marks

 Press sheet

 Fold sheet blocks

 Page trim block

 Press Sheet Marks (web-based sheets only)

For these web-based targets, you have further options to place the mark on 
the press sheet. A switch is provided that lets you specify all the items or just 
a specific one with an index number.

 Ribbon: the vertical sections of a web-based sheet; only applicable for 
web production schemes with multiple ribbons

 Slit: the line where the sheet is cut into ribbons; only applicable for web 
production schemes with multiple ribbons

 Cut-off: where the web is cut horizontally

 Horizontal fold: a fold across the web

 Vertical fold: a fold along the web

 Row: cells across the web

 Column: cells along the web

 Cell: a single page cell; here you have two input fields, C for Column and 
R for row, to specify a cell; enter an asterisk for all the cells in a row or 
column.

puts the mark in a specific 
row: row 2

puts the 

puts the mark in all rows
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 Image Marks

 Image Frame

 Image Trim box

 Bleed

 Sheet Marks

 Sheet

 Image Block

Horizontal For the horizontal position, select:

 distance...

 to right or left of...

 Left Edge, Right Edge, or Center.

Vertical For the vertical position, select:

 distance...

 below or above...

 Top Edge, Bottom Edge, or Center.

Print on  Front side

 Back side

 Both sides. If you select this option, the following check boxes are enabled:

 Mirror position on back

 Mirror content on back

puts the mark in a specific 
cell: column 3 of row 1

puts the 

puts the mark in all cells
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Layer See “Mark Layers” on page 1082 for information on how layers are used to 
arrange content:

 Top Marks

 Page Content

 Bottom Marks

Mark Conflicts Conflicts may arise if a mark overlaps another mark, a mark runs into the page 
content or bleed zone, or a mark falls outside the area of interest or box. The areas 
of interest are the Pages, Gutters, Gripper, Press Sheet, etc. for each respective 
Mark type. For example, press sheet marks must fall inside the Press Sheet.

Clipped

These are the possible actions if a mark falls outside the box or area where it is 
expected to be drawn.

These are the possible actions if a mark falls outside the box or area where it is 
expected to be drawn clipped: The mark is clipped to fit in the box and printed.

 Do not Print: The mark is ignored.

 Fail: The job will be aborted. The notify action is selected and an error is 
displayed for the job.

NOTE: You can choose to be notified by selecting the Notify check box.

Overlaps

These are the possible actions if a mark overlaps with Page Content (Trim), Page 
Bleed or another mark.

 Print: The mark is printed even if it falls outside the box.

 Do not Print: The mark is ignored.

 Fail: The job will be aborted. The notify action is selected and an error is 
displayed for the job.

NOTE: You can choose to be notified by selecting the Notify check box.
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Include knock-out for conflict checking

When selected, the knock-out area is included for conflict checking.

Mark Repeat In the Repeat tab of the Details section, you can choose to repeat a mark by 
selecting the Repeat mark check box. The fields are disabled if this check box is 
not selected.

NOTE: The Repeat tab is only available for File Marks and these settings are used 
to repeat color bars.

Step Area

The Step Area is the area where a Mark is repeated.

Orientation Choose Horizontal or Vertical to define the orientation for repeating the Mark.

Number of Steps You have the following options to define how many times the mark is repeated:

 Fit within available space: the mark is repeated within the available space

 Fit within fixed length: choosing this option enables an extra field where you 
can enter the length of the step area

 Fixed: in the extra field that is displayed, enter the number of times (steps) 
you want to repeat the mark

Stepping

Direction  If Horizontal orientation is chosen, then the direction is Left to right and 
Right to left; if Vertical orientation is chosen, then the direction is Bottom to 
top or Top to bottom; 

 Inside/Out: positions the mark on each side of the center of the Step Area and 
repeats the mark in both directions

 Centered: positions the mark in the middle of the Step Area and repeats in 
both directions

Mirror mark around center Option to mirror the mark when repeating Inside/Out.

Center Gap The gap between the two center marks when repeating Inside/Out and the 
number of steps is even.

Spacing The gap between repeating marks; this option has no effect on Center Gap.
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Partial last step This option defines what happens when the last step extends beyond the avail-
able area:

 Draw clipped: the mark is clipped at the end of the available area

 Omit: the mark is not drawn and consequently not clipped

Mark Special In the Special tab of the Details section, you can choose to apply special settings 
to the mark.

Apply curves  Linearization

 Calibration

 Simulation

NOTE: The Apply Curves option is only available for File Marks.

Finishing Include in cut file: Draws the mark in the cut file if applicable.

Do not print: The mark is not drawn on the printed sheet.

Print mark in overprint Select the Overprint check box to print a text mark in overprint. The default 
printing method for marks is knockout.

NOTE: The Apply Curves option is only available for Text Marks.

Mark Pens Pens are used to define a thickness and style for lines and borders used to draw 
certain Marks. 

Width The width of the line in points.

Color/Depth The drop-down list lets you choose a color or, for certain applications, you can 
choose to define the Depth of the pen.

 Color: Click the associated variable button, and select one or more 
options to determine on which plate(s) the mark will be printed:

See “About Colors and Depth for Printing Marks” on page 1083 for more 
information on using colors to print marks.
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 Depth: Enter a value to set the depth of the engraving in micron (mu). 

Knock-out around pen Select to knock out the area under the pen line.

Dashed line Select this check box for a pen with a dashed line. Enter the size in points of the 
dash and the distance between the dashes. The default values are 12pt for the 
dash and 6pt for the gap.

 To create/edit Mark pens

1 In the Mark Engraver, click the cogwheel in the top left corner and choose 
Manage Pens.

2 Click the New button and a new Pen appears in the list.

3 Enter a name in the Name field.

4 Complete the fields as required.

Mark Layers Layers are used to arrange marks in a certain order, with the highest layer having 
the highest priority.

Layers are controlled at the bottom of the Position tab. There are three default 
layers which cannot be deleted:
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Top marks Marks to be printed on top of the Page content, e.g. crop marks

Middle (Page Content) The reference layer.

Bottom marks Contains marks to be printed below the page content, e.g. all marks except crop 
marks.

Additional layers can be created and deleted.

 To create Mark Layers in the Engraver

1 In the Mark Engraver, click the cog wheel in the top left corner and choose 
Manage Layers.

2 Click the New button and a new Layer appears in the list.

3 Click this new Layer to edit its Name.

4 Use the arrow buttons to move the new Layer in the list and change the 
order.

About Colors and 
Depth for Printing 
Marks

Certain marks have a Color (default) or in certain applications a Depth. One of 
these options can be chosen from the drop-down list.
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Color

For certain marks you can choose in which color they will be printed. You do this 
by choosing the plates and optionally also specifying the density. 

In the Color field you choose one of the plates or create a comma-delimited list 
with several plates.

 Click the associated variable button, and select one or more options to deter-
mine on which plate(s) the mark will be printed:

The default is an asterisk (*) which means that the mark will be printed on all 
plates; in the drop-down list this corresponds to Registration (All Plates). You 
can also choose from the following:

 Process Colors: C, M, Y, K plates only, not spot colors

 Darkest Color

 Cyan

 Magenta

 Yellow

 Black

 White, Varnish, Primer

 Spot colors

You can also specify the density for printing the mark and combine colors, for 
example:

 *:50 means print on all plates at 50%

 Cyan:40 means print on Cyan plate at 40%

 Cyan:40, Magenta:50 means print on Cyan at 40% and Magenta at 50%

Depth

Enter a value to set the depth of the engraving in micron (mu).
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Marks

In the Marks Resource category, you can manage the file marks used in the Mark 
Engraver and Borders Resource categories. In Apogee Impose, these file marks 
are included in the Mark Sets.

The Marks can be EPS or PDF files. You import them or delete them.

Associated Task Processors

The Marks resource category is available for:

 All Output Task Processors except for Export and RPC

 All Print Task Processors except for the Generic Press.

Administrator access level only!

Marks Overview

The Marks overview lists all available marks.

You can import, export or delete marks.

Related topics: • To create, duplicate, edit, delete, import or export Resources on page 718

 To import marks

1 In the System Overview Window, select the Output Task Processor for which 
you want to import the Mark.

2 Double-click the Marks icon in the Resources pane. 

The Marks dialog box appears, containing an overview of all the available 
Marks.
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3 Click the import button.

4 Locate the folder from which you want to import the marks, and click Open.

5 Close the Marks dialog box.

After adding a mark, Apogee will try to calculate it’s bounding box. This will 
be displayed in the Dimensions column.
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Media Hub

The Media Hub is where you manage Calibrated Printing Modes (CPMs). CPMs 
are presets that you can select in the Layout Editor to obtain the best possible 
printing results for the selected printing quality, press and media on the speci-
fied printing device.

Associated Task Processors

The Finishing Hub is available for the following Task Processors:

 Generic SD (Sign and Display Printer) and other SD printers

 Open the Media Hub

 In the Layout Editor, choose Window > Resources and select Media Hub.

Administrator access level only! Select a printing device in the System Overview 
and you will see that the Media Hub is a resource.

You can select a CPM in the list of Calibrated Printing Modes. You can use the 
filter box to filter the CPMs by printing device for example.

 Create a CPM

New Calibrated Printing Modes are generally based on a default CPM, but you 
can also create them from scratch.

 In the Media Hub, choose File > New Calibrated Print Mode.

The CPM Creation Wizard opens.

The wizard consists of 3 steps. Visit the Tutorial page on the AsantiNetwork 
for a detailed procedure.
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Media Hub 
Overview

1 Quality
2 Printer
3 Media Category and Media
4 List of Calibrated Printing Modes (CPMs) for the selected quality, printer and media
5 Details of the selected quality, media or CPM, or adjust Printer Parameters for category

A series of base or default CPMs are included with your system and new CPMs 
can be created based on these CPMs. You can see the default CPMs if you select 
All Qualities + All Printers + Generic Media (in the All Media or Generic Media).

When you start a job in the Layout Editor, you need to choose a Calibrated 
Printing Mode (CPM) that corresponds with the requirements of the job. A 
number of CPMs are available for each printing device (Anapurna, Jeti, etc.) to 
ensure optimum printing results on each device. The CPM settings take into 
account the following parameters:

 Quality: The Quality parameter allows you to choose a desired quality level 
for the printed product. The quality level you choose depends on the charac-
teristics of the images to be printed, the desired color gamut, the viewing 
distance and the printing speed. The following quality levels are available:

 Express

 Express Plus

 Production

 Production Plus

 Standard
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 High Quality

 High Definition

 High Density

 Custom

 Printer: A particular printing device cannot necessarily handle all quality 
levels. Only the quality levels that apply for the available printing devices are 
shown when you set up a job.

 Media: The expected quality varies according to the chosen media.

 Clear Selection: This button resets the selection to All Qualities, All Printers 
and All Media.

Calibrated Printing 
Modes Details

General

The name and properties of the Calibrated Printing Mode. 

Color On Media

The printing mode and color mode for printing the process color inks directly on 
the substrate, and the associated calibration and characterization resource. This 
applies when printing without white, or when printing with post-white, regard-
less of the kind of white application.

Color On White

The same set of properties for printing the process color inks on white ink.

White

The print and screen properties for printing white.

CPM cogwheel menus

 Click the cogwheel to open the CPM menu which has the following 
commands:

 Calibrate: Opens the CPM Calibration Wizard.

 Update G7 Calibration: Only active if the CPM includes a G7 calibration 
step. Use this option to update this step.

 Tune Profile: Opens the CPM Profile Tuning Wizard.
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 Edit Profile Settings: Opens the Edit Profile Settings dialog

 Redo CPM Setup Wizard: Launches the wizard to redo the calibration 
wizard.

 Revert Calibration: Opens the Revert Calibration dialog where you can 
choose a calibration date to revert to.

 Revert G7 Calibration Update: (Only active if the CPM includes a G7 
calibration.) 

 Revert Profile: Opens the Revert Profile dialog where you can choose a 
profile date to revert to.

 Revert Edit Profile Settings

 Revert Redo CPM Setup Wizard

 Report: Opens the CPM Quality Report. You can save the report as a PDF 
or print it.

 Export Profile: Exports the profile.

 Print Mode Parameter: Opens the Edit Print Mode dialog.

NOTE: Visit the Tutorial page on the AsantiNetwork for detailed procedures.

Media Details General

Name How you want to call the media.

Sheet only The media can be used on flat-bed or hybrid printers.

Roll only The media can be used on roll-to-roll or hybrid printers.

Both The media can be used on any type of printer.

Default thickness The default thickness of the media.

Categories One or more categories that the media belongs to. Select the categories from the 
drop-down list.
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Media Calibration

Here you can choose whether the new media needs a dedicated CPM, or can use 
that of an existing media by choosing one from the drop-down list.

 Create New Quality

 In the Media Hub, choose File > New Quality.

A new quality is added to the list. You can edit the Name, Short name and 
Description in the Quality details panel.

 Create New Media

 In the Media Hub, choose File > New Media.

A new media called Media is added to the list. You can edit the name and 
specify the settings in the Media details panel.

Other Media Hub 
Commands

 Configure Printer

 In the Media Hub, choose File > Configure Printer to open the configuration 
window for the selected printer.

NOTE: Depends on access level.

 Manage Sheet Sizes

 In the Media Hub, choose File > Manage Sheet Sizes.

The Sheet Size resource is displayed. See “Sheet Sizes” on page 690.

 Import/Export CPMs

 In the Media Hub, choose File > Import or Export.

The file browser is displayed.

NOTE: Many of these commands are available by context-clicking the 
appropriate item.
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 Adjust Printer Parameters

1 Select a category and click the Adjust button in the Printer Parameters panel 
on the right. Unlock the parameters first.

2 The Printer Parameters dialog box is displayed where you can specify device-
specific settings. Click the cogwheel icon if you want to restore the settings.
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Media

In the Media resource category, you can manage the media for imagesetters, 
platesetters, and proofers. 

The Media Resource category for proofers is similar to the one for imagesetters 
or platesetters. The main difference is that proofers do not report which medium 
is loaded. You have to manually enter this information.

The loading of media is executed automatically by Apogee.

Associated Task Processors

The Media Resource category is available for the following Task Processors:

 All of the Imagesetter, Platesetter, and Proofer Task Processors

 Commercial digital Print Task Processors

Media Overview

In the Media overview, you can check which media is currently loaded, as well 
as the details of any other available media. You can unload, load, and delete 
media, and edit media settings.

For both imagesetters and platesetters, you can create, edit or delete media 
types and media sizes. For platesetters, you can also import the media database 
file generated by the output device. 

Available Media

The Available Media pane displays the available media for the selected engine. 
The displayed media is compatible and fits on the widest tray. The pane consists 
of two tables: media type and the available media of that type.

The first table shows the known types. If you select a type, the second table 
shows the available media of that type, displaying the size and the batch 
number. For imagesetters and platesetters, you will also see the thickness.
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With the buttons below the table, you can add, edit or delete media for the 
selected media type. 

Loaded Media (Imagesetters and Platesetters only)

The Loaded Media pane displays the trays and the medium that is loaded in each 
of them. The tray table shows the tray status icon, the tray name, the name of the 
currently loaded medium, and the amount of media available (if the device can 
report it). 

You may see the following status icons in the Display Cassette Name column:

The loading of media is executed automatically by Apogee according to the 
media attributes film or paper, thickness and width as reported by most image-
setters and platesetters.

Apogee may not always find a match, for instance if there is no media record. In 
this case, Apogee sends a notification. 

Conflict table (Imagesetters and Platesetters only)

If Apogee has several records that match the reported media attributes, there is 
a media conflict. In this case, the Loaded Media panel displays <multiple> as 
Media name. If you click on this, the Conflict table displays all the matching 
records that were found. You then need to select the media that is actually 
loaded and click the Load button.

NOTE: Devices that can report loaded media will send a message to the Message 
Board in case of an unknown medium.

• If the icon is followed by a name: There is a cassette in the tray but it is not loaded (not 
active). However, it can be activated by Apogee.

• If the icon is followed by a name in bold: There is a cassette in the tray and the cassette is 
loaded (active). Note that some devices (e.g. Galileo) may have more than one tray active at 
the same time.

The icon is followed by a name: There is a cassette in the tray but it is not loaded (not active). 
Furthermore, it cannot be activated by Apogee (manual intervention on the engine is 
required).

There is no cassette in the tray.

There is an unknown problem with the tray.
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Media Editor

If you click the Add button, the media editor opens, where you can specify 
various media settings.

NOTE: The media editor fields differ according to the selected device. For 
example, some devices have a predefined set of media properties that cannot be 
changed (e.g. substrate, roll, polarity, etc.).

Type

This field contains the name of the media type. Media with the same type are 
grouped in the type table and should have the same type attributes (substrate, 
thickness and device compatibility). 

Polarity (Imagesetters and Platesetters only)

The polarity of a medium is an internal and invisible setting. For film and paper, 
the polarity is always positive. For plate, it is always negative. 

Dimensions (Proofers only)

Specify whether the dimensions apply to sheet media or roll media.

Select the Roll Media check box, if the media comes in rolls.

NOTE: For roll media you can only specify the width. 

Substrate

Select the substrate from the drop-down list. The substrate is associated with the 
type. You have three options:

 Film

 Plate

 Paper

Width

Specify the media width. This value must be smaller than the widest tray. 
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Height

Specify the height of the plate. This setting only applies when you are using a 
platesetter. 

NOTE: This does not apply to roll media.

Thickness (Imagesetters and Platesetters only)

Specify the thickness. This value is associated with the type.
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Number-up Schemes

The Number-up Schemes resource allows you to create multiple slots on a Fold 
Sheet for jobs that require more flexibility for cutting and assembling number-
up jobs .For example, you can use these schemes to place multiple Book Signa-
tures in the slots of the same Fold Sheet to create multiple deliveries from a 
single Press Sheet.

A number-up scheme can be selected for a job in the Products tab.

 Double-click the Number-up Schemes icon for an overview of the available 
rules in the Number-up Schemes dialog box or to create your own rules.

The Number-up Schemes resource lists the available schemes in the left column 
and a schematic representation of the cutting events for that scheme and the 
resulting deliveries in the right column. 

Associated Task Processors

The Number-up Schemes resource category is available for:

 Impose

 Raster Impose
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Administrator access level only!

Number-up Schemes Editor

Editing an existing scheme or creating a new scheme in the Number-up Schemes 
resource opens the Number-up Editor with all the settings.

Name and Description

The schemes provided with your installation use a shorthand convention for the 
Name which is explained in the Description. For example, 3-up C&A means that 
3 Book Signatures will be produced for cutting and assembling.

Actions

A Number-up Scheme uses a sequence, or chain of actions, to create deliveries

Perform actions on In this panel you can choose the item on which the chain of actions as specified 
below will be performed: the folded sheets or the Assembly block.

Actions In this panel you can define the actual processing as a chain of actions. You start 
with choosing the direction of the cutting: horizontally or vertically. Then in 
subsequent actions (as many as you want) you can cut, rotate, stack, nest, 
assemble, turn over or tumble the items:
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 Cut Horizontally: cuts all the items you have so far in 2 or more parts with 
cuts at a right angle to the last fold.

 Cut Vertically: cuts all the items in 2 or more parts with cuts parallel with the 
last fold.

Select the number of parts from the In drop-down list.

 Rotate: rotates an item by 180°; the default is to rotate item 2, not 1 because 
item 1 is usually the one in the reference corner, i.e., the one at the intersec-
tion of the last fold and closed head; if there is only one item, the default is 
item 1.

Specify the items to rotate in the Item(s) box with a comma-separated list of 
item numbers; the second item is entered by default.

 Stack Items, 1 on Top: stacks all items on top of each other with the first item 
on top of the stack – only meaningful if the assembly method is also stacked.

 Stack Items, 1 on Bottom: stacks all items starting with the first item on the 
bottom of the stack.

 Nest Items, 1 as Outer: nests all items with the first item as the outermost – 
only meaningful if the assembly method is also nested.

 Nest Items, 1 as Inner: nests all items with the first item as the innermost.

 Assemble Items, 1 as First: collects all items specified by the Assembly style 
in the Binding Options (nested or stacked), with the first item as the 
topmost/outermost

 Assemble Items, 1 as Last: collects all items with the first item as bottommost 
or innermost

 Turn over Items: turns the specified items (like work & turn); the default is 
the same as for Rotate

 Tumble over Items: tumbles the specified items (like work & tumble); the 
default is the same as for Rotate

 Done: an action that doesn’t do anything; choose this option as the last action 
in your processing chain.

Apply page trim margins Select this option to keep the page trim margins on either side of the cut or to set 
them to 0.
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Extra gutter Add an additional margin as specified between the pages on either side of the 
cut.

Chain of actions diagram The chain of actions is presented schematically at the bottom of the Actions 
panel so you can check that the results are what you want. The red lines with 
numbers indicate cuts which can be horizontal or vertical.

The red dot indicates the location where the last fold and the closed head 
intersect.

A red edge indicates the result of a cut

Delivery

The Delivery panel on the right lists the deliveries that will be created by the 
chain of actions. These deliveries can then be used when you define the imposi-
tion to produce different products or multiple copies of the same product. The 
deliveries are shown as rows and labeled A, B, C, etc. using different colors and 
you can specify how the pages are arranged for each delivery:

Page Arrangement  From Binding Options: the default page arrangement as set in the Binding 
Options with an upright delivery letter (A, B, C, etc.) to indicate the 
orientation.

 Reverse of Binding Options: the page arrangement is opposite to that set in 
the Binding Options and indicated with the delivery letter upside down.

 Same as A: uses the page arrangement you chose for the first delivery in the 
list.
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 Reverse of A: uses the opposite of the page arrangement that you chose for 
the first delivery in the list.

Deliveries This section shows the color-coded deliveries with delivery letters in the 
arrangement which is based on how the Fold Sheet or Assembly is cut up and re-
assembled.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1103
Output Color Conversions

The Output Color Conversions resource converts the color values of the 
document output intent to the printing profile of the output device. The actual 
output conversion is performed by the PDF Render task processor where you 
select the Output Conversion preset in the Render operation.

To select your output color conversion in the Render operation of PDF Render, 
you must choose Document Based mode in the color management settings.

Associated Task Processors

 Apogee Preflight

 PDF Render

Output Color Conversions Overview

Administrator access level only!

The Output Color Conversions overview lists all available conversions.

Output Color Conversion list

This is the list of all the available output conversions. Select a conversion in the 
list to see more information in the pane on the right.

Convert Process Colors

Here you choose when and how to convert process colors.
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Color Conversion method Choose a conversion from the drop-down list:

 Don’t Convert: Choosing this option hides all the options for process color 
conversions.

 Repurpose: Choose this method to repurpose for different output devices. 
Repurposing triggers a specific output conversion that preserves the GCR of 
the input colors while applying a color conversion. If you choose this method, 
you can only set the Rendering Intent.

 ICC-based conversion: Choosing this option shows all the process color 
conversion options. This output color conversions triggers the standard ICC 
conversion that applies the GCR of the output press profile. 

 Use device link: Choose a device in the drop-down list. This list is empty by 
default and device links can be added in the Device Link Profiles resource.

Rendering Intent If you selected ICC-based color conversion, choose a rendering intent from the 
drop-down list:

Relative Colorimetric: A colorimetric conversion, tries to maintain the exact 
relationship (Smallest Delta E), between in-gamut colors, while out of gamut 
colors will be clipped. With Relative Colorimetric RI the white point from source 
color space is mapped to the white point of destination, this means that white 
stays white. No ink will be placed in white areas.

Perceptual: Perceptual aims to preserve the visual relationship between colors so 
it is perceived as natural to the human eye. The relationship between out of 
gamut colors is maintained. This can result in inaccuracies for in gamut colors as 
well.

Saturation: Saturation tries to produce vivid colors in an image at the expense of 
color accuracy.

Absolute Colorimetric: Absolute Colorimetric rendering intent is similar to 
Relative except that here the white point of the two profiles is preserved. White 
of source color space is simulated with CMYK values from the destination color 
space. The consequence is that every white object/area is covered with certain 
ink amounts.

Absolute Colorimetric + Preserve White: By default, Absolute Colorimetric + 
Preserve White is the Output Color Conversion setting for spot colors. This 
rendering intent uses absolute colorimetric rendering for the solid spot color 
tints and smooths out towards relative colorimetric rendering for the highlights 
tints of the spot color, ensuring that no background simulation is present in the 
output (typically for white objects when rendering absolute colorimetric).
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NOTE: The result of choosing a rendering intent depends on the graphical 
content of documents and on the profiles used to specify color spaces. Some 
profiles produce identical results for different rendering intents. Differences 
between rendering intents are apparent only when you print a document or 
convert it to a different working space.

Black Point Compensation Apogee uses a built-in algorithm to adjust for differences in the black points. 
Choose On or Off.

Profile Link Exceptions If you selected ICC-based color conversion or Repurpose, choose an exception 
from the drop-down list:

 None

 Keep 100% K

 Normal

 Preserve K

 Preserve Pure Colors

 other exceptions as listed in the Profile Link Exceptions resource

Prevent Overprint issues Select this option to preserve zero CMYK. For ICC based conversions, this option 
prevents overprint changes during color conversion. This option is always 
enabled for repurposing conversions.

Convert Spot Colors using Color Books

Accurate spot color mixing This improves spot color overlaps significantly. Choose Off or maximum 2, or 3 
colors.

deltaE calculation Select the method to calculate the deltaE:

 deltaE*ab: Use the ΔΕab method, the first internationally endorsed color 
difference formula as published by the CIE Committee. This is the default 
value for reasons of compatibility.

 deltaE*00: Use the ΔΕ00 method, a revision of the ΔΕ94 formula. ΔΕ00 is the 
industry standard formula to be used.

 default: Use the default method.

Paper white If ‘Use white point from Press Profile’ is selected, the paper white of the 
document profile is used in the color calculation. If this option is not selected, the 
paper white of the color book is used in the calculation of the spot colors. 
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Output Sizes

The Output Sizes Resource category defines the different available output sizes 
that can be used for printing the image on a particular imagesetter or platesetter. 
This also allows you to define a punch calibration, and link it to the used output 
device.

Punch Calibration defines how the sheet is being “punched” to ensure a correct 
sheet position. There are two punching methods supported by Apogee: head 
punching and tail punching.

Associated Task Processors

The Output Sizes Resource category is available for the following Task 
Processors:

 All of the Imagesetter, Platesetter, and Proofer Task Processors

 Commercial digital Print Task Processors

Administrator access level only!

Output Sizes Overview

The Output Sizes overview lists the available Output Sizes. You can create, 
duplicate, edit, delete, import or export Output Sizes.

Output Sizes Editor

The Output Sizes Editor allows you to create or modify an Output Sizes. You can 
specify a height, width, orientation and punch calibration.
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Punch Calibration Editor

In this window, you can specify the punch settings for the imagesetters or plate-
setters and print a test page in order to measure the offsets.

Name

The name of the punch calibration. This field cannot be left empty.

Punch Location

The location of the Punch (virtual or real) on the test image. This can be the 
device punch or the transfer punch. 

X Axis The distance between the center of the test image and the punch reference 
(punch center for film and leading edge for plate).

Y Axis The offset between the center of the test image and the punch center for films. 
This option is disabled for platesetters.

Plate Exposure Unit Pin Bar (Imagesetters only)

Specify the distance between the film punch and the edge of the plate when both 
the film and the plate are mounted on the pin bar. This option is disabled for 
platesetters. The initial value is the last entered value. 
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Test Page

You can print a test page in order to measure the offsets. Proceed as follows:

1 In the Punch Calibration dialog box, click the Test button.

The Punch Calibration Test Page dialog box is displayed.

2 Select the Output Size that you want to associate with the Punch Calibration.

3 Click the On list and select the media you want to print the test page on.

4 Select any Parameter Sets you may have created for the Image and Output 
operations.

5 Click Print.

A test job is composed and automatically submitted to the device, and a 
progress indicator appears. You are notified when the job has been success-
fully submitted.

NOTE: The OK button is disabled if you have not selected a valid tray.

 To create and edit an output size

1 In the System Overview, select the Output Task Processor for which you want 
to create or edit an Output Size.

2 Double-click the Output Sizes icon in the Resources pane.

The Output Sizes overview appears.

3 Do one of the following to create or edit an Output Size.

 Click the New button to create a new Output Size.

 Select the Output Size that you want to edit in the Output Size list in the 
upper pane and click the Edit button.

The Output Size editor appears.
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4 Type the name for the Output Size and specify the width, height and 
orientation.

5 Select a punch calibration from the Punch Calibration list.

NOTE: You can select None if you do not want to use a Punch Calibration. In 
that case, no offsets are applied.

6 Click OK.

Your settings are saved. The newly created Output Size appears in the list.

7 Close the Output Sizes dialog box.

 To create and edit a new punch calibration

1 In the System Overview, select the Output Task Processor for which you want 
to create or edit a punch calibration.

2 Double-click the Output Sizes icon in the Resources pane.

The Output Sizes overview appears.

3 In the lower pane, do one of the following to create or edit a Punch 
Calibration.

 Click the New button to create a new Punch Calibration.

 Click the Edit button to edit a Punch Calibration.

The Punch Calibration editor appears.

4 Specify the Punch Calibration settings. 

5 Click OK to save your settings.

The settings are saved. The newly created Punch Calibration appears in the 
lower pane. You can select the required Punch Calibration in the Output size 
dialog box when creating or editing an Output Size. 
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6 Close the Output Sizes dialog box.

 To delete a punch calibration

1 In the System Overview, select the Output Task Processor for which you want 
to delete a punch calibration.

2 Double-click the Output Sizes icon in the Resources pane.

The Output Sizes dialog box appears.

3 In the lower pane, select the Punch Calibration that you want to delete and 
do one of the following:

 Press Delete.

 Click the Delete button.

4 Click Yes to confirm the deletion.

5 Click either Yes or No depending on whether you want to delete the linked 
Output Size.

The Punch Calibration is deleted and no longer appears in the lower pane.

6 Close the Output Sizes dialog box.
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Pagination Schemes

The Pagination Schemes resource provides page arrangement schemes for 
unbound folded work in Apogee Impose. These are similar to folding schemes, 
however, the pages of the part can be arranged arbitrarily and individual pages, 
or panels, can be smaller, equal or larger than the part size.

Pagination schemes do not include information for the folding sequence.

 Double-click the Pagination Schemes icon for an overview of the available 
schemes and then add or edit a scheme to open the Pagination Scheme dialog 
box.

Associated Task Processors

The Pagination Schemes resource category is available for:

 Impose

 Raster Impose
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Administrator access level only!

Pagination Schemes Overview

Pagination Schemes list

In this list you see default Pagination Schemes and any new or modified schemes 
you have created.

CxR Abbreviation for Columns x Rows; e.g. 4 x 2 means 2 rows of 4 pages.

Pagination Scheme Settings

Name and Description Enter a meaningful name, such as ‘leaflet’, ‘flyer’, ‘letter, etc., and a description.

Sides The default is single-sided; select the check box if you want to create a double-
sided scheme; the schemes are filtered on this setting when choosing a scheme 
in the part editor.

Columns and Rows Columns indicate the number of horizontal cells and Rows the vertical cells of 
the page arrangement grid as shown in the Page Assignment pane below.

Copy from Click this button to copy a page arrangement from a folding scheme. The 
columns and rows are filled in accordingly. This can be useful as a starting point 
for a new scheme.

Page Assignment

In this pane you see the part as an arrangement of panels in a grid with the 
number of rows and columns specified above. Use the arrangement buttons to 
enter the page numbers.

NOTE: Pages can be assigned arbitrarily so no page numbers are added 
automatically to the Top or Bottom of the pagination scheme.

Pagination Scheme grid
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1113
Arrangement buttons

Change panel size This option is active when you select a page using the pointer button and you can 
use it to change the size of individual pages or panels. This option can be used to 
reduce the size (enter negative values) of the panel or increase the size (enter 
positive values). A modified panel size is indicated in the page arrangement grid 
with measurement arrows.

NOTE: Changing the size of one panel may affect the entire row or column, 
also on the other side of the sheet. The affected panels are indicated in light 
blue.

The values are applied to modify the actual page size as defined for the part in 
the job ticket editor.

Page orientation Select a panel with the pointer button and rotate the page by 180 degrees. This 
does not affect the orientation of the panel on the other side of the sheet.

1 Blue page: Panel selected with pointer button
2 Measurement arrows: panel size has been changed
3 Light blue cells: these are affected by the modified panel size
4 Grey triangle icon: page orientation
5 Page nos. with underscore: ambiguous page nos.: 6, 9, 8
6 Red corner icon: Lay on Front
7 Red corner icon (faded): Lay on Back

pointer button for selecting a panel in the grid

cursor button for typing the page numbers on the pagination scheme; you must start with 1 and 
increment by 1, otherwise the scheme is invalid
pointer button that inserts incremental page numbers on the pagination scheme

Reset resets the scheme and empties the cells
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Paper Stock

This resource category groups the paper that you can use for all presses, and is 
used to describe the surface type and weight of the paper. The choice of paper 
has a serious impact on the processing of a job. The paper type defines the profile 
and calibration to be used, and also selects the ink books. If a specific paper 
behaves other than expected, you should create a new paper type for it.

A Paper Stock is mapped to one of the standard Paper Types and a series of 
weights.

 Click the Paper Stock icon in the Generic Press Resources pane to open the 
Paper Stock dialog box.

Associated Task Processors

The Paper Stock resource is available for the following Task Processors:

 Press

 Generic Press
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Administrator access level only!

Paper Stock Overview

The Paper Stock dialog box lists all available Paper Stocks in the top list and the 
available Paper Types in the bottom list.

 Click a Stock to display the Paper Type and Weight in the panel on the right.

Paper Stock

Name A unique and meaningful name such as the brand of the paper, what it will be 
used for (e.g. cover), or a generic description (e.g. Matt-coated)

Paper Type The type that describes the surface of the paper. The paper types you see and can 
select in the drop-down are managed in the Paper Type list in the bottom left 
corner. These types are mapped to the JDF grades as explained below.

Color Management

You can set the white point and the texture of the stock, and this information is 
used by proofing color management to mimic the final print on this specific 
stock:

Whitepoint Here you can choose the source of the white point to be used:

 From Press Profile: This is the default value used for the paper type associ-
ated with the press selected for the job.

 LAB: Specify a different value for the white point; use the revert button to 
go back to the default.

Texture 4 textures are provided (Carton, Coated paper, Newspaper, Uncoated paper) 
which are images of unprinted paper stock.

Intensity Enter a percentage to control the intensity of the selected texture.

Weight and Thickness This table displays the available Weights with corresponding Thickness in mm or 
mil.

Paper Type

Paper types are mapped to JDF grades for automatic selection by Apogee 
Impose or to Not mapped for manual selection.
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Name A unique and meaningful name that refers to the grade

JDF grade A number from 1 to 5 for the following JDF paper grades:

 1 for gloss-coated paper

 2 for matt-coated paper

 3 for gloss-coated, web paper

 4 for uncoated, white paper

 5 for uncoated, yellowish

 0 for Not mapped: manual selection, no JDF mapping selected

 To work with Paper Stocks

You can create, edit or delete a Paper Stock, map it to a Paper Type and then 
choose the Weights you want to make available for your production. This is done 
with the usual procedures for working with resources.

You can also import a .txt file with the weights and thicknesses for a particular 
Paper Stock.

NOTE: The Paper Type determines the profile, calibration and the ink books. 
When a specific paper behaves differently, you should create a new Paper Type.

 To add a Paper Weight

1 Click the new button below the Thickness box.

OR

Click the cogwheel and choose Copy from and then select the Paper Stock 
you want to copy the Paper weight from.

A new Weight and Thickness appear at the top of the list.

2 Edit these two settings as required.

3 Lock the Paper Stock settings.

 To import a Paper Stock from a tab-delimited text file

You can import a paper stock database from a plain text file. The text file must 
be formatted with paper records on each line, and each paper record containing 
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1117
tab-delimited values for stock name, weight, thickness, thickness units and 
paper type.

 Click the import button under the Paper Stock table and choose the .txt file 
you want to import.

The file is checked for validity and if applicable a report is generated 
indicating how to remedy import issues.

The above example creates two new Paper Stocks, each with its own thick-
ness table and the values from the records you imported.
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PostScript Headers

You can use the Export Task Processor to export the latest processed results from 
the Production Plan to a specific directory, in either PDF or PostScript format. 
This allows you to process the PDF/PS documents on a remote system. When 
you export results in PostScript format, you can also select a PostScript header 
file that you want to have inserted in your exported file.

This resource category allows you to import or delete PostScript Header files for 
use with the Export Task Processor. 

Administrator access level only!

Associated Task Processors

The PostScript Headers Resource category is available for the following Task 
Processors:

 Export

 JMF Link

PostScript Headers Overview

The PostScript Headers overview lists all available PostScript Headers.

You can import or delete PostScript Headers.
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Preflight Action Lists

Action lists are especially useful when there are sequences of tasks, which you 
have to do a number of times, either within a single PDF document or in multiple 
PDF documents.

To simplify repetitious tasks, you can group a series of tasks into an Action List. 
Once you have created an Action List, you can re-use it to perform these tasks in 
the predefined sequence.

Administrator access level only!

Associated Task Processors

The Preflight Action Lists Resource category is available for the following Task 
Processors:

 Preflight

Preflight Action Lists Overview

The Preflight Action Lists overview lists all available Preflight Action Lists.

You can import, export or delete Preflight Action Lists.

By default, the following action lists are provided.

Black2RichBlack

Finds all black fills (except for text < 24pts) and sets these objects to 100% black 
and 40% cyan.

ChangeTrimboxToCropboxSize

Changes the trimmed page size (the size of the paper in the desktop printer; the 
size of the pages after folding/binding and cutting in a production house) to the 
page size in Acrobat.
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CMYK100toRegistration Color

Finds all colors with 100% Cyan, 100% Magenta, 100% Yellow and 100% Black, 
and sets them to registration colors.

FailIfCourier

Displays an error message if the Courier font is found in the file. This often 
means that font substitution has been used. This action will result in the Preflight 
process failing.

FailIfTransparent

Displays an error message if transparent images are found in the file. This action 
will result in the Preflight process failing.

Hairline=.25pts

Finds all rules less than ¼ of a point, and changes them to ¼ of a point.

NonBlack2Knockout

Finds all non-black fills set to overprint, and changes them to knockout.

NonBlackText2Knockout

Finds all “non-black type” set to overprint, and changes them to knockout.

RemoveAllICCProfiles

Removes any ICC profiles found in the PDF file.

RemoveHalftoneInformation

Removes any Halftone information found in the PDF file.

RemoveOPIComments

Removes any OPI comments found in the PDF file.

RemoveTransferFunction

Removes any transfer functions found in the PDF file.

White2Knockout

Find all “white objects” set to overprint, and change them to knockout.
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Related topics: • Preflight Profiles on page 1122
• To create, duplicate, edit, delete, import or export Resources on page 718
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Preflight Profiles

To preflight PDF documents, you can use Profiles. A Profile is a collection of 
criteria which a PDF document should meet to be a valid PDF.

Through these Profiles, you can thoroughly check your documents and make 
corrections before processing. 

The Preflight Profiles Resource category provides you with a set of default 
Profiles, and allows you to import, export or delete Profiles. 

NOTE: You can also select Preflight profiles for a preflight check when exporting 
results through the Export Task Processor. For more information, see Profiling 
in the “Output Settings (for ECO3 Imagesetters and Platesetters)” on page 849.

Administrator access level only!

Associated Task Processors

The Preflight Profiles Resource category is available for the following Task 
Processors:

 Preflight

 Conditional

 Export

Preflight Profiles Overview

The Preflight Profiles overview lists all available Preflight Profiles.

You can import, export or delete Preflight Profiles.
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Press Sheet Layout Rules

A Press Sheet Layout Rule is a series of settings for positioning one or more Fold 
Sheets (i.e. a Fold Sheet Block) on a Press Sheet.

These rules are available in a drop-down list in the Imposition pane in the 
Products tab of the Job Ticket Editor. A Press Sheet Layout Rule must be selected 
from this list before an imposition for the Product can be created.

Apogee Impose provides ample flexibility for positioning and you can choose:

 what is to be aligned

 the horizontal and vertical reference for aligning

 and/or you can add a fixed offset

NOTE: Press Sheet Layout Rules are not applied for JDF jobs with absolute 
positioning.

Associated Task Processors

The Press Sheet Layout Rules resource category is available for:

 Impose

 Raster Impose

Administrator access level only!
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 Click the Press Sheet Layout Rules icon in the Impose Resources pane to open 
the Press Sheet Layout Rules dialog box.

Press Sheet Layout 
Rules Overview

Rules list

The left column of the Press Sheet Layout Rules dialog box displays a list of the 
default rules provided with Apogee Impose and any new rules that you may have 
created.

Rules are organized alphabetically and you can choose an ascending or 
descending order by clicking in the Name column header.

Rules settings

Name A meaningful name, such as ‘Center Bottom’, ‘Center Center’, etc.

Positioning of Fold Sheets

Here you can choose a number of references for aligning the Fold Sheet.
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Target area The target area for positioning a Fold Sheet can be the full press sheet or the area 
within the press sheet margins.

Vertical/Horizontal
alignment

Fold Sheet: the entire Fold Sheet or Fold Sheet Block is aligned, including the 
page trim margins and overfold gap.

Page Trim: the default setting; the Fold Sheet is aligned taking into account the 
smallest rectangle around the final trim edges of all the pages.

Fit to sheet edges: the Fold Sheet is extended by enlarging the page trim margins 
and overfold lip, with priorities as set in the Fitting Strategy of the Binding 
Options. This option overrides all fixed positioning settings and is meant to 
avoid extra cuts before folding, especially for Multi-Up jobs.

Vertical alignment to Leading Edge: the Fold Sheet is aligned to the leading edge of the Press Sheet.

Gripper: alignment to the Gripper as set in the Press Task Processor.

Center of Sheet: the Fold Sheet is aligned to the center of the Press Sheet.

Trailing Edge: the Fold Sheet is aligned to the trailing edge of the Press Sheet.

Horizontal alignment to Side Lay: the Fold Sheet is aligned to the side lay edge of the Press Sheet.

Left Edge: alignment to the left edge of the Press Sheet.

Center of Sheet: the Fold Sheet is aligned to the center of the Press Sheet.

Right Edge: alignment to the right edge of the Press Sheet.

Offset Available for horizontal and vertical positioning. The value can be:

 positive Offset: moves the Fold Sheet away from the alignment reference; 
when centering on the sheet: upwards and to the right.

 negative Offset: moves the Fold Sheet into the alignment reference, for 
example you could move the Fold Sheet into the Gripper; when centering 
on the sheet: downwards and to the left.

NOTE: Apogee Impose always checks that the Fold Sheet fits completely on 
the Press Sheet and will display an error in the Snag List if this is not the case.
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Work & Turn or Work & Tumble

For Work & Turn and Work & Tumble jobs, Apogee Impose puts the front and 
back of a Fold Sheet on one side of a Press Sheet and mirrors this arrangement 
on the other side of the Press Sheet.

Work & Turn or Work &
Tumble

Align fold sheets to flip axis: overrules the standard alignment (including the 
offset and reference edge) and centers the Fold Sheet around the flip axis.

Gap between Fold Sheets

Horizontal/Vertical Sets the horizontal and vertical gaps between the sides of Fold Sheets or Page 
trims in mm. These gaps are also applied to the distance between multiple Fold 
Sheets when using the Work & Turn workstyle and between elements placed on 
a Press Sheet for unbound jobs.

Press Sheet Margins

Margins are zones where you prefer not to have any page content, also referred 
to as no-content zones. If content is detected in such a zone, Apogee Impose 
displays a warning in the Snag List.

NOTE: Apogee Impose does not take these zone into account when calculating 
the imposition.

You can set the following margins along the four sides of the Press Sheet, from 
the sheet edge and Gripper:

Trailing margin from page trim box to trailing edge of the Press Sheet

Leading extra margin from page trim box to the Gripper

Left/Right margin to left and right Press Sheet edge

Slow Down Wheels

For sheets printed on a perfecting press, you choose on of the following options 
to provide content-free zones for slow-down wheels:

 Automatic: The default Slow Down Wheels resource as specified for the 
press will be used.

 Custom: Specify the width and the number of content-free zones for this 
particular layout.

 None: No content-free zones will be provided for slow-down wheels.
Apogee Reference Guide



 

16 TASK PROCESSOR RESOURCES 1127
 To add/edit a Press Sheet Rule

1 Click the new button.

2 Choose the settings for this new Press Sheet Layout Rule.

3 Lock the settings.

 To name/re-name a Press Sheet Rule

1 Unlock the settings and click a Press Sheet Rule.

2 Edit the name in the Name box and lock the settings again.
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Print Modes

The Print Modes resource category is where set the following parameters:

 Resolution width

 Resolution height

 Device Print Mode

 Droplets per dot

 Bits per pixel

Administrator access level only!

Associated Task Processors

The Finishing Hub is available for the following Task Processors:

 Generic SD (Sign and Display Printer) and other SD printers
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Profile Link Exceptions

The Profile Link Exceptions Resource category contains rules for not applying 
profile links. For example, you may want to preserve K as pure K and not apply 
color conversions or adaptations.

Administrator access level only!

Associated Task Processors

The Profile Link Exceptions Resource category is available for the following Task 
Processors:

 PDF Render

 All Proofer Task Processors

 Apogee Preflight

 Generic Digital Press

 Generic SD (Sign and Display Printer)

Profile Link Exceptions Overview

The Profile Link Exceptions overview lists the following default profile excep-
tions. Others can be created with the QMS application.

 Keep 100% K

 Normal

 Preserve K

 Preserve Pure Colors

You can import or delete profile link exceptions.
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Profiles

ICC Profiles are standards for describing color characterizations of different 
output devices. Apogee provides you with a set of standard ICC color profiles. 
You can import additional color profiles (*.icm or *.icc files), and delete profiles. 

You can also import (and delete) color exceptions, in tab-delimited format 
(*.dat files) and in MIME format (*.mime files). The colors will then appear in 
the Color Exceptions table, together with their process value percentages.

You can create auto-select maps to make a profile available for automatic selec-
tion. For more information, see “Using Resource Auto-Select Maps” on 
page 1159.

Administrator access level only!

Associated Task Processors

The ICC Profiles Resources are available for:

 All Proofer Task Processors

 All Print (Press) Task Processors

 Apogee Preflight

Profile Selection Maps Editor (Press)

You can specify which job settings the automatic selection of the profile will 
depend on. For Press, these are as follows. 
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Printing Stock

Paper Type Select the appropriate paper type from the drop-down list. For example:

 Gloss coated wood free

 Matt coated wood free

 Uncoated white

Ink Set Select the ink set from the drop-down list. You can choose from the available Ink 
Sets in the Ink Sets Resource category that have the same color space as the 
profile.

Workflow

Displays the polarity (for information only):

 CTP or Positive CTF

 Negative CTF

NOTE: Computer to Plate printing is always positive.

Halftone Screen

Specify the halftone screen settings:

Screen Select the screen type from the drop-down list. 

 ABS

 Adobe Accurate

 Rational Tangent

For more information on these screen types, see “PDF Render - Screen Settings” 
on page 800.

Resolution Specify the screen resolution from the drop-down list.

Frequency Select the line frequency (lpi) from the drop-down list.
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Dot Shape Select the dot shape from the drop-down list. 

Profile Selection Maps Editor (Proofers)

You can specify which job settings the automatic selection of the profile will 
depend on.

Media

Media Type Select the Media type from the drop-down list.

Output

Inkset The ink set corresponds to the Color Space of the Profile.

Quality

Quality Select the required output quality from the drop-down list.
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Quality

Administrator access level only!

Associated Task Processors

The Quality Resource category is available for the following Task Processors:

 Generic Digital Press

Quality Overview

Quality dialog box lists all the available Qualities.

 Double-click a Quality in the list to display its settings.

Name Name of the Quality

Printing Parameters  Output Resolution width

 Output Resolution height

 Bits per pixel

 Screen type
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Sheet Layout Templates

This resource lists the Sheet Layout Templates you create in the Layout Editor. 

 Double-click the Sheet Layout Templates icon for an overview of the 
available templates.

You can only delete the templates you create in the Layout Editor. This 
resource cannot be used to create templates.

Associated Task Processors

The Sheet Layout Templates resource is available for the following Task 
Processors:

 Impose

 Raster Impose

Administrator access level only!

 Open the Sheet Layout Templates

 In the Layout Editor, choose Window > Resources and select Sheet Layout 
Templates, or go to System Overview, choose Impose or Raster Impose and 
double-click the Sheet Layout Templates.
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Sheet Layout 
Templates 
Overview

The Sheet Layout Templates window is used to rename, change their category, 
import, export, and delete the Sheet Layout Templates as resource editor. You 
can also manage the categories by adding, removing and renaming them.

For more information about the Sheet Layout Templates, refer to “Sheet Layout 
Templates” on page 583.

NOTE: You cannot edit the layout of a Sheet Layout Template in this Sheet Layout 
Templates resource window.

.
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Shingling Rules

This resource category allows you to compensate for creep automatically by 
choosing a Shingling Rule when you set up the Product. Creep is the result of the 
nesting of pages inside each other for a single signature and for multiple signa-
tures. Horizontal creep affects the face of pages and vertical creep influences the 
head/foot.

Face creep can be compensated in two ways: either by shifting the content on the 
page or by scaling the content. The shingling rule does not allow a combination 
of shifting and scaling. Head/foot creep can only be compensated by shifting the 
content in both ways. The default setting for a new shingling rule is to shift both 
ways towards the trim edge to compensate for face creep only.

Shingling rules do not use absolute values. They ensure that the optimum 
compensation is applied, based on the number of layers in a job and the thick-
ness of the stock. Apogee Impose requires that the stock thickness is set in the 
Paper Stock resource, in order to make the shingling calculation.

Apogee Impose calculates the shingling for simple nested and stacked Products 
that use the same paper stock but also for more complex Products containing 
Parts with different paper stock per Part.

Figure 16.61: Horizontal (face) and vertical (head/foot) shingling
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 Click the Shingling Rules icon in the Impose Resources pane to open the 
Shingling Rules dialog box.

Associated Task Processors

The Shingling Rules resource category is available for:

 Impose

 Raster Impose

Administrator access level only!

Shingling Rules Overview

The Shingling Rules dialog box lists all available Shingling Rules in the list on the 
left the settings for each rule on the right. 

Face creep can be compensated in two ways: by shifting the content on a page or 
by scaling it so that all pages ultimately have a common page trim edge. Head/
foot creep can only be compensated by shifting the content.

The following rules are supplied with Apogee Impose:

 Scale inwards
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 Shift both ways

 Shift outwards

 Shift both ways (advanced)

 Click a Shingling Rule to display its settings.

Compensate Face Creep

Method Shift pages: The content of the pages is shifted inwards or outwards to align the 
trim boxes of the different pages.

Scale pages: The content is scaled slightly in the same direction as the creep.

Direction Both ways (align with face trim): Shifts/scales the inner pages towards the spine 
and the outer pages towards the face edge. The target of this shingling is the final 
trim width of the Product, indicated by the red line.

Inwards (towards spine): Shifts/scales all the pages, except the outer ones, 
towards the spine. The target of this shingling is the face edge of the outer pages.

Outwards (towards face): Shifts/scales all the pages, except the inner ones, 
towards the face. The target of this shingling is the face edge of the inner pages
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Compensate Head/Foot Creep

Select the check box to compensate for head/foot creep by shifting the content 
in both ways. You cannot choose the compensation method or direction. 
Selecting this option also affects the compensation for face creep because a more 
advanced algorithm is used to calculate the shingling.
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Simulation Curves

For more general information on Simulation curves, see “What is Simulation?” 
on page 1165.

Administrator access level only!

Associated Task Processors

The Simulation Curves Resources are available for the following Task 
Processors:

 Generic Press

 All Digital Presses

 All Proofers

Simulation Settings The Simulation settings are almost identical to the settings of Calibration and 
Linearization. For detailed information on these settings, see “Calibration and 
Linearization Settings” on page 1166.

 To create a new simulation curve

1 In the System Overview window, select the Press Task Processor for which 
you want to create a new Simulation Curve.

2 Double-click the Simulation Curve icon in the Resources pane.

The Simulation Curves overview appears, containing all of the available 
Simulation Curves for the Press Task Processor.

3 Click the New button.

The Create Table dialog box appears.
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4 Specify how you want to initialize the table and click Next. For more informa-
tion, see “Create Table” on page 1168.

A Curve Wizard dialog box appears where you can specify the initial curve 
data.

5 Select the values for the Stimuli column and click Next. For more informa-
tion, see “Stimuli Selection” on page 1168.

A Curve Wizard dialog box appears where you can specify the initial curve 
data.

6 Select the values for the Wanted column and click Finish. For more informa-
tion, see “Wanted Selection” on page 1169.

The Simulation Curve Editor appears.

7 Enter any required information, type the name of your Simulation Curve and 
click OK. For more information, see “Curve Editor” on page 1170.

Your Simulation Curve appears in the Simulation Curve List. 

8 Close the overview.

 To edit a simulation curve

1 In the System Overview window, select the Press Task Processor for which 
you want to edit the Simulation Curve. 

2 Double-click the Simulation Curve icon in the Resources pane. 

The Simulation Curves overview appears.

3 Select the Simulation Curve that you want to edit in the Simulation Curves 
list and click the Edit button.

The Simulation Curve Editor appears. 

4 Enter any required information and click OK. For more information, see 
“Curve Editor” on page 1170.

Your Simulation Curve has been modified and is listed as such in the Simula-
tion Curves List. 

5 Close the overview. 
Apogee Reference Guide



1142 SISR PROFILES
SISR Profiles

Smart Input Space Recognition (SISR) is a technology used to automatically 
recognize the standard ICC color profile that has been used to generate the 
CMYK values of images in incoming documents. The retrieved profiles can be 
used for multiple purposes: warn for incorrect tagged profiles, tagging untagged 
images, overruling incorrect profiles of images or even, through statistical 
analysis, determine which profile fits best as output profile for a complete PDF 
document.

The SISR profiles in this resource are used by the SISR category of Apogee 
Preflight action lists.

Administrator access level only!

Associated Task Processors

The SISR Profiles Resource category is available for the following Task 
Processors:

 Apogee Preflight

SISR Profiles Overview

By default, the SISR Profiles overview list is empty. You can import, export or 
delete ICC profiles in this list. All the ICC profiles in the list will be used by the 
SISR preflight action lists.
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Slow Down Wheels

A press has slow-down wheels to slow down a sheet as it leaves the press. This 
resource specifies zones without content for slow-down wheels so the smearing 
of ink that is still wet can be avoided.

 Double-click the Slow Down Wheels icon for an overview of the available 
rules.

Associated Task Processors

The Slow Down Wheels resource is available for the following Task Processor:

 Impose

Administrator access level only!

Slow Down Wheels Overview

The Slow Down Wheels dialog box lists all available rules in the left column.

 Click a rule in the left column to display its settings.

Widths A press may have wheels at 5 positions on the sheet: 
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 Drive side of the sheet

 1/3 of the width of the sheet

 Center of the sheet

 2/3 of the width of the sheet

 Operator side of the sheet 

Enter the width of the zone you want to create for each wheel or leave the box 
blank if there is no wheel at this position. The zone is between the bleed boxes of 
each page.

Keep Symmetrical Select this check box if the width of the two side wheels (Drive and Operator) 
must be the same as the width of the 1/3 and 2/3 wheels. If you clear this box, 
you can edit the 2/3 and Operator widths.

Keep within Enter values to let the center wheel and the 1/3 and 2/3 wheels deviate from 
their exact position.

Allow special combinations Two special combinations of wheels can be selected:

 Center and single side: the center wheel and a single side

 Thirds and single side: the 1/3 and 2/3 wheels and a single side
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SolidTune Sets

This resource applies ink-saving to screened data by creating holes in solid areas 
while optionally avoiding the edges in order to preserve crispness.

Associated Task Processors

 Apogee Preflight

 Generic Press

SolidTune Sets Overview

Two methods are available for this type of ink-saving:

Random pattern method

This method removes a specified amount of pixels from the solid area using a 
random pattern. 

Target Set the target amount of ink-saving in percent.

Size Set the size of the holes (width and height).

Mask method

A pre-defined mask can be selected.

Mask Select a mask from a list of installed mask resources.

Preserve edges For both methods: Specify the size (in pixels) of the area where no holes will be 
created along the edges of the solid area.
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WebGrowth Profiles

Administrator access level only!

What is Web Growth?

Web Growth is the deformation (stretch) of the paper as it is printed on the 
various color units on a web press. The physical deformation occurs as the paper 
absorbs ink and water, and is accelerated with pressure and tension.

Factors contributing to web growth include: type of press, press configuration, 
paper stock, humidity, ink coverage and conditions of the blanket. Heaters may 
cause paper to shrink on press.

Using marks and profiles to compensate for Web Growth

Web Growth Compensation profiles allow printers to compensate for press mis-
registration due to distortion of the printed media. This most frequently occurs 
on web presses where the paper may expand or shrink slightly after running 
through a specific press-station, causing subsequent colors to misalign. This also 
occurs less frequently with higher-grade paper.

The WebGrowth Profiles resource allows you to import, export or delete ANSI 
WebGrowth Profiles (*.wgc files). You can link a web growth profile with a 
paper type in your Press settings.

You can also create your own WebGrowth profiles for any combination of press, 
ink, stock, etc. and special marks can be placed on the Press Sheet to measure 
and monitor web growth. The WebGrowth mark is a special file mark (.pdf) that 
needs to be placed on the Press Sheets.

NOTE: Deferring this image compensation to the film/plate phase of the 
workflow allows the user to use a regular pre-press workflow without 
compromising proofing and preview job approval features.
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Associated Task Processors

The WebGrowth Profiles Resources are available only for Press and Generic 
Press Task Processors.

WebGrowth Profiles Overview

When you open this resource you will see a list of the available WebGrowth 
Profiles. The table shows the Press, Ink Set, Paper Stock and Weight for which 
the profile has been created.

WebGrowth Profiles Editor

You can edit any of the listed profiles or create new ones from scratch in the 
editor.

Name The initial name filled in here is taken from the initial Print settings but you can 
change it to suit your needs

Print Settings button

Click this button to open the initial Print settings dialog if you want to modify the 
settings; Press Name, Ink set, Stock, Weight, and Grain/Flute).
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Options button

Here you choose whether you want to set up compensation for the different inks 
and how to measure the shift.

Inks  Measurements: One compensation per color or One compensation for all 
colors. For the latter, you can also specify if spot colors will be used and then 
you can enter values for these colors too.

 Spot colors: Number of spot colors.

Measurements  Back side compensation: choose whether you want to enter dedicated values 
for the back of the press sheet (Custom back) or Same as Front or Mirrored to 
Front.

 Measurement type: If you chose One compensation per color you can specify 
here to which color (yellow or black) the measurement relate; Relative to 
theoretical position should be chosen if you can measure the distance to all 
colors exactly in relation to the reference zero point with a digital meter.

Settings Table per Web

The second panel in this dialog box is a table that gives the mark position and the 
measured growth values per web and per web side.

Side Select the side in the left column.

Mark Position Specify the position of the WebGrowth mark in the center column. The four 
corners of the sheet are indicated with North-West, South-West, North-East, 
South-East and the Horizontal and Vertical values specify the exact distance 
from the center. The values are red until all values have been entered per mark. 
You can see the selected mark in the overview panel at the bottom of the editor.

Shift The column on the right is where you enter the web growth values that you 
measured on a printed test using a WebGrowth mark. The horizontal and 
vertical shift must be entered for all inks or for each ink separately – process inks 
and spot colors (S1, S2, etc.). These values can be positive (shrinking) or 
negative (expanding). The values are red until all values have been entered per 
mark. Context-click a Mark Position to take shifts from other positions.
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Overview/Zoom panel

In this panel you can see where the WebGrowth marks are positioned on the 
sheet as you select them in the Mark Position panel. The sheet is indicated with 
a dashed blue line. The mark and deformation are shown in the ink color or in 
black if the same compensation applies for all inks. The drop-down list provides 
quick access to all the marks per web and per color. Use the arrows on the left 
(up) and right (down) to move up and down the marks in the Mark Position 
table and per color. Select the Zoom button and use the slider if you need to 
zoom into an area to see the mark.

 Create and Test a WebGrowth Profile

1 Click the New button in the WebGrowth Profiles overview: 

A new untitled Resource dialog box is displayed.

2 Enter the initial Print settings for the profile:

 Press Name: choose a web-fed press from the list of your presses

 Ink set, stock, weight

 Grain/Flute: always set to Long for web presses

3 Click OK to confirm these initial settings and then you can continue in the 
WebGrowth Profiles Overview.

4 Click Save when all the measurement values have been entered.

5 The profile is displayed in the WebGrowth Profiles resource.

6 Select this new profile in the list and click Test in the bottom right corner to 
generate a test page and verify that the web growth is OK.
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Web Production Schemes

 Double-click the Web Production Schemes icon for an overview of the avail-
able schemes in the Web Production Schemes dialog box.

Associated Task Processors

The Web Production Schemes resource category is available for:

 Impose

 Raster Impose

Administrator access level only!

Web Production Schemes Overview

The Web Production Schemes dialog box lists all available Web Production 
Schemes. These schemes are organized per press. The Press panel lists the 
default schemes and any new or modified schemes you have created. When you 
create a new scheme you can choose an existing category or create a new 
category. The panel on the right lists the schemes per press and category. A 
scheme can be used for several presses, deliveries and categories as indicated in 
the respective columns. Select a scheme in the list to see an outline of the scheme 
in the bottom panel. Enter search criteria in the filter box in the top right corner 
to organize the schemes.
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Web Production Scheme Editor

 In the Web Production Schemes Overview, click the New button or the Edit 
button to open the editor.

General

Name and Description Enter a meaningful name and description.

Categories Select an existing category from the drop-down list or type a new category. You 
can also select existing categories from the list and type new ones by comma-
delimiting them. Categories appear in the Workstyle drop-down list of the press 
sheet in the Product view.

Suitable for Presses

Web Production Schemes are often created to meet the requirements of a 
dedicated web press although it is possible to re-use the same scheme on 
different presses.

Presses Select the press or presses from the drop-down list. Leave empty if you want to 
use the scheme for all web presses.
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Formers Enter the number of formers that the press has for folding.

Cut-offs Enter the number of cut-offs per cylinder circumference. Cut-offs are indicated 
with a scissors icon in the page assignment panel.

Basics

Deliveries A single web can produce one or more deliveries. Enter minimum 1 and 
maximum 8. Each delivery is indicated with a letter in the page assignment 
panel.

Webs Some web presses have more than one web. Enter minimum 1 and maximum 8. 
Each web is displayed in the page assignment pane: Web 1, Web 2, etc.

Number Up Binding Select the Number Up production method that you intend to use. This will 
provide a clearer preview of how the pages are laid out. See “Binding Options” 
on page 957.

Width (columns) Enter the number of columns for the width of each web. Multiple webs are 
indicated with W1, W2, W3, etc. above the field box.

Height (rows) Enter the number of rows (maximum 100) for the height of the scheme. The 
number of rows must be an integer multiple of the number of cut-offs.

Cut-off offset Enter the offset of the cut-cylinder (default 0, min 0, max 100). The offset is the 
number of rows, counting upwards from the bottom, where the cut-cylinder will 
cut.

Slit points scissors A web can be slit into ribbons between each column. Click the scissors in the 
page assignment panel to indicate the slitting points.

Glue Zones Select the Requires dedicated glue zones check box if you want to apply ink-
free areas for gluing; when selected, the glue zones are displayed as blue strips 
in the page assignment panel, and the glue tool is enabled.

Bottling Select the Requires dedicated bottling check box if you want to use a dedicated 
Bottling Table to compensate page skew in folded signatures. When selected you 
can click the Bottling Table button to open the Bottling Table editor.

Bottling Table button Opens the Bottling Table editor to create a new table or edit an existing one. A 
red note is displayed if you select the check box and the WPS does not have a 
Bottling Table defined. 
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The panel on the left shows the number of layers and their respective pages and 
the negative or positive rotation values for the pages on this layer. Double-click 
a value in the Rotation column to edit the rotation value for all the pages on this 
layer. Press Enter or go to another layer with the arrows or Tab key to confirm 
the value. The Shift column is empty if the table has not been initialized with the 
Initialize button.

The panel on the right shows the page grids with negative rotation values in red 
and the positive rotation values in blue, and the rotation centers as black squares 
per page. Use the Cross tool to change the position of the rotation anchors or the 
Angle tool to change the rotation values of specific pages on a layer.

Initialize button The Initialize button applies the values set in the Bottling table. The button is 
Initialize All if the scheme has more than one delivery. Layers with modified 
rotation values are indicated with an asterisk and those with modified rotation 
anchors with a cross. In this case you need to re-initialize the table with the 
Initialize button.

Reference values for
‘Adjust’ rule option

The page height and stock thickness fields show the reference values which are 
needed for adjusting the bottling values to the job’s actual height and thickness. 
These values are normally set when you initialize the table, but you can adjust 
them as well.

Stock Thickness Adjustment for the thickness is only possible if the table has a Stock thickness 
reference value and the stock selected in the part has a Stock thickness value.

Height (H) Adjustment for page size is only possible if the table has a Height reference 
value.
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The Initialize Bottling Table dialog has the following settings:

Calculate initial values
from

Here you choose how the initial values for each page are calculated:

 Creep (auto-bottling): Initial values are based on the thickness of the 
paper and calculated in the same way as for automatic bottling.

 Outer Fold Shift: Uses the measured displacement of the spine or face 
edge to determine the skew angle.

 Applied Correction: Uses previously established correction angles.

Thickness Thickness taken from a Paper Stock resource that you can select here.

Height The size of the folded signature, measured along the last fold (i.e. not the page 
size).

Outer Fold Shift Enabled if you chose this option in the Calculate initial values from panel.

Applied Correction The correction angles for the first and last layers as established previously.

Maximum Bottling Specify a maximum angle for the rotation.

Anchor point The center of rotation which can be selected by clicking a circle.

Reference Layer The layer that will not be bottled or will be bottled the least.
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Default Page Arrangement

You can choose a page arrangement for each delivery. Each letter (A, B, C, etc.) 
refers to a delivery.

H/H (Head to head) Arranges pages in such a way that the head of the pages is on the closed head of 
the signature, suitable for jogging to the head.

F/F (Foot to foot) Arranges pages in such a way that the foot of the pages is on the closed head of 
the signature, suitable for jogging to the foot.

Blank Marks pages as blank delivery, If you intend to leave an area of the sheet blank, 
you must account for an extra delivery that needs to be set to blank.

Page Assignment

The page arrangement is presented in a table with cells. In this panel you assign 
page numbers in the cells using one of the two buttons and select a binding edge 
to preview the page orientation on the web sheet.

The arrow to the left of the table indicates the running direction of the web so 
you know where the trailing and leading edges of the web production scheme 
are located. Context-click in the table to copy deliveries. The scissors indicate 
where the ribbons are slit into deliveries and the symbols under the scissors are 
centering anchors to indicate which gutter will be centered on the plate and to 
align partial webs.
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NOTE: The Web Production Scheme must be valid before it can be saved. Refer 
to the documentation of your press to create a valid page arrangement. 

Page Assignment buttons

Preview for Left, Right, Top or Bottom binding. 

NOTE: This binding style is not part of the actual setting.

 Assign pages with the Page Assignment tools

There are two methods for assigning pages to a web sheet grid.

1 Click the cursor button and click the cell where you want the first page to be 
located.

2 Type “1”.

Apogee puts the corresponding back page in the correct cell on the Bottom of 
the scheme.

NOTE: The Back Page number is displayed when you click in a following cell.

OR

3 Click the pointer button and hover over the cells of the grid.

Apogee displays the first or next page number on the Top and Bottom of the 
scheme.

4 Continue until all pages have been arranged and the grid is full.

Cursor button for typing the page numbers on the Top or Bottom of the Web 
Production Scheme; the number for the other side (Top or Bottom) is added 
automatically.
Pointer button that inserts page numbers on the Front and Back of the Web 
Production Scheme.

RESET Resets the scheme and empties the cells.
Glue tool (when Glue Zones check box is enabled).

Rotate tools can rotate single cells. The tools are disabled if the scheme is not 
valid.
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5 Click the greyed-out scissors icon along the width of the sheet to indicate 
where the sheet is to be slit in ribbons.

6 Click Save.

NOTE: If the scheme is not valid, the Save button remains greyed out.

 Merge cells to create pages with different sizes

It’s possible to merge cells and create pages with different sizes.

 Assign the same page number to two cells in an imposition scheme by 
pressing the CTRL key, to create a double-sized page. The same method can 
be used to create triple or quadruple-sized pages.
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XSLT Conversions

A resource for importing XSLT transformation files. The Export Task Processor 
can produce an ApoXML file for the results it exports, with an XSLT conversion 
that can read the custom variables set by the Automate Task Processor(s). The 
ApoXML file can then be built by the XSLT to drive certain processing parame-
ters, for example, by choosing a parameter set or explicitly setting processing 
parameters.

Associated Task Processors

The XSLT Conversions Resources are available for the following Task 
Processors:

 Automate

 Export

You can import, export or delete XSLT conversions.
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Using Resource Auto-Select Maps

When creating a Ticket, you can specify how the Task Processor will select the 
required Resources. There are two options:

 Manually select the Resources to be used in the settings of the Task Processor.

 Have the Task Processor itself automatically search for the required Resource 
based on predefined look-up rules. Briefly, you create an ‘automatic look-up’ 
mechanism by mapping those rules in an ‘Auto-Select Map’. For more infor-
mation on creating an Auto-Select Map, see “To create an auto-select map” 
on page 1159.

For example, if you select a specific medium in the output settings of a Press Task 
Processor and activate the automatic selection for calibration, Apogee will 
automatically look for the required Calibration Curve.

If Apogee does not find a match, you can tell it what to do by clicking the Fallback 
button. For more information see Fallback on page 1161.

Associated Task Processors

You can create Auto-Select Maps for the following Resource categories:

 Calibration Curves

 Linearization Curves

 Profiles

 To create an auto-select map

1 In the System Overview, select an Output or Print Task Processor.

2 Check that the Task Processor has one or more of the following Resource 
categories associated with it in the Resources pane:

 Calibration Curves

 Linearization Curves

 Profiles

3 Double-click one of these associated Resource categories.

The Resources overview dialog box appears.
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4 Select a Resource that you want to use as a basis to create a look-up rule and 
click the Add Map button. You can also drag and drop a resource into one of 
the map overview lists

The Resource dialog box appears where you can change the settings.

5 Click OK.

The Resource appears in the Auto-Select Map or Profile Selection Map pane. 
It will function as a look-up rule.

6 Close the Resources dialog box.

NOTE: You can also drag and drop a profile onto the Profile Selection Maps table. 

 To edit and delete an auto-select map

1 In the System Overview, select an Output or Print Task Processor.

2 Check that the Task Processor has one or more of the following Resource 
categories associated with it in the Resources pane:

 Calibration Curves

 Linearization Curves

 Profiles

3 Double-click one of these associated Resource categories.

The Resources overview dialog box appears.

4 Do one of the following to edit or delete an Auto-Select Map:

 Select the Auto-Select Map that you want to edit in the Auto-Select Maps 
pane and click the Edit button. Click OK to save your changes.

 Select the Auto-Select Map that you want to delete and press Delete or 
click the Delete button to delete it. Click Yes to confirm the deletion.

5 Close the Resources overview.
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Fallback Click the Fallback button to specify what Apogee should do if the automatic 
selection does not find a match. 

NOTE: This function is available for Calibration, Linearization and Ink Tables. 
Check those Resource categories for the information on the Fallback settings.
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CHAPTER
17 Calibrating Your Output 
Devices

This section explains the theory behind calibration and provides more in-depth 
information on the various settings in the Curve Editors for Calibration, 
Linearization and Simulation.

 What is Calibration? ......................................................................................... 1164
 Calibration and Linearization Settings ...................................................... 1166
 Curve Editor ......................................................................................................... 1170
1163
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What is Calibration?

Every output device may have a certain discrepancy between the desired result 
and the actual result. This discrepancy is caused by dot gain. To compensate for 
this discrepancy, you need to calibrate your output device. 

In practice, this happens in the Curve Editor, where Apogee calculates a dot gain 
compensation curve so that your output device produces the desired results. The 
resulting curve may be irregular to produce the desired dot gain.

Depending on the type of output device, you may have to calibrate it regularly. 
The print results may differ for instance because of climatic changes.

In Apogee, Calibration is only used for the press. For imagesetters and plateset-
ters, Apogee uses Linearization.

What is Linearization?

Linearization is a special case of calibration. It is especially used for imagesetters 
and platesetters. Through linearization, you can adjust the Stimuli values so that 
they equal the Wanted values during output. In other words, you linearize the 
Stimuli values with the Wanted values, unlike Calibration, where the curve is 
not necessarily linear.

Before Apogee can linearize your output device, you need to print a test page. 
The test page is based on the Stimuli values. These are the measuring points that 
will be used to calculate the linearization curve. They will appear on the test 
page as printing blocks. If you measure the printing blocks with a densitometer, 
you obtain the Measured values. The Wanted values are the desired results. The 
difference between the Measured values and the Wanted values is the dot gain 
of your output device. In the Curve Editor, you need to fill in those values in the 
Values table or import them from an existing file.

Calibration for Press Task Processors

Linearization for Imagesetters and Platesetters. 
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What is Simulation?

Simulation can be considered as Calibration for special needs. This means that 
you are free to use Simulation curves anyway you want. You can for instance 
purposely use a nonlinear curve to obtain a certain dot gain or other special 
effects. 

This is why there are no Measured values for Simulation. The curve is solely 
based on Wanted values, which is the desired curve.

This simulation technique is very common in packaging, where flexography is 
used.

NOTE: The Simulation curves are only used for the Press.
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Calibration and Linearization Settings

This part elaborates on the different settings for creating and editing Calibration 
and Linearization curves. The creation and editing process for Calibration 
consists of a series of dialog boxes eventually followed by the Curve Editor. 

 You start with the General Settings, where you need to specify various 
settings concerning the print job. See “Calibration Print Settings” on 
page 1166 and “Linearization Print Settings)” on page 1167.

 In the second dialog box, you need to specify how you are going to enter the 
necessary values to calculate the calibration curve. See “Create Table” on 
page 1168.

 If you have chosen to create your table manually, you need to select the 
number of Stimuli values or measuring points to specify the accuracy of the 
calibration curve. See “Stimuli Selection” on page 1168.

 In the Wanted settings dialog box, you have different options for the 
Measured and the Wanted values. See “Wanted Selection” on page 1169.

 Finally, you enter the Curve Editor from where you can print a test page or 
where you can enter the Measured and Wanted values. See “Curve Editor” on 
page 1170.

NOTE: The settings for Simulation are almost identical to those for Calibration 
and Linearization. Simulation has no Measured values and therefore no options 
for them.

Calibration Print 
Settings

Opens the print job details regarding stock and screen type.

Printing Stock

Paper type Select a paper type from the drop-down list.

Ink set Select an ink set from the drop-down list. The drop-down list shows all of the 
available Ink Sets in the Ink Sets Resource category.

Screen

The screen polarity is taken from the selected Press.

Positive/Negative Specify the polarity.
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Halftone Screen

Select the screening details from the various drop-down lists:

Screen Apogee Balanced Screening, Adobe Accurate, and Rational Tangent (for more 
information on the screen types, see “PDF Render - Screen Settings” on 
page 800).

Resolution Choose a resolution.

Frequency Choose a line frequency.

Dot shape Elliptical or round.

Linearization Print 
Settings)

This dialog box contains the print job details regarding surface and screen type.

Media Type

Select the appropriate medium from the drop-down list.

Workflow

Specify the polarity of the print job by selecting the appropriate check box:

 Positive CTF

 Negative CTF

Halftone Screen

Select the screening details from the various drop-down lists:

Screen Apogee Balanced Screening, Adobe Accurate, and Rational Tangent (for more 
information on the screen types, see “PDF Render - Screen Settings” on 
page 800).

Resolution Choose a resolution.

Frequency Choose a line frequency.

Dot shape Elliptical or round.
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Create Table In this dialog box, you specify how you want to initialize the values table. The 
values table contains the Stimuli, Measured and Wanted values. 

Depending on the type of densitometer, you will either have to enter the 
Measured values manually or import them from a file that is generated by the 
densitometer. You can also import an existing curve, created in an external 
application.

Manually

Select this option if you want to type the values manually in the table. This 
means that you will have to enter the values based on the measured results of the 
test page.

Import from File

Select this option if you want to import the values from a specific file.

You can import:

 an existing curve that was created in an external application and saved as an 
ASCII file

 a curve from an older version of Calibrator (not for Linearization).

NOTE: Apogee warns you when it does not recognize the file format.

Stimuli Selection In this dialog box, you specify how many Stimuli values (in dot percentages) you 
want for the table and the curve. The number of Stimuli values determines the 
accuracy of the curve. An accurate compensation curve will result in an accurate 
calibration of your output device. 

You have the following options:

Standard 3

Select this option if you want the three standard values from 0 to 100: 0, 50 and 
100.

Standard 13

Select this option for the 13 standard values: 0, 5, 10, 20,... 90, 95, 100.
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Standard 21

Select this option for the 21 standard values: 0, 5, 10, 15,... 90, 95, 100.

Standard 31

Select this option for the 31 standard values: 0, 1, 2, 3, 4, 5, 6, 10, 15, 20,... 85, 
90, 94, 95, 96, 97, 98, 99, 100.

0 to 100 Steps

Select this option if you want to enter the number of Stimuli values yourself.

Wanted Selection In this dialog box, you define the Wanted values.

Wanted Values

Linear Select this option if you want the Wanted values to be the same as the Stimuli 
values. This option will result in a linear curve. 

Simulate dot gain Select this option if you want the Wanted values to correspond to a certain dot 
gain. You can use this option if you want to calibrate your output device to 
produce a certain dot gain and not to compensate the dot gain.

Compensate for dot gain The Wanted values will compensate for the specified dot gain. 

Dot gain Type the dot gain percentage for which you want the Wanted values to 
compensate.

Highest dot gain at Specify the stimuli for the highest dot gain.

NOTE: For Linear curves, only the Linear option is available.
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Curve Editor

The Curve Editor is where you enter the Stimuli, Measured and Wanted values 
to view the associated curves. You also have options to adjust the curves, select 
the ink and further specify the Measured values. Under the curve name you can 
see when the curved was modified the last time and enter comments.

Ink

Select the curve in the curve set that you are going to edit or view. Each curve 
corresponds to an ink in the ink set and an ink table. 

You can create calibration curves for each of the separation inks and also for spot 
colors. For more information on Ink options, see “Table Options” on page 1170.

NOTE: This option is only available for Calibration, and when measurements is 
one per ink.

Ink Values Table

The ink values table contains the Stimuli, Measured and Wanted values in three 
columns. The values determine how the calibration curve will look like in the 
diagram next to the table. At the top of this table you can choose the ink curve 
you want to see from the drop-down list or using the arrows, if you have more 
than one ink curve.

You manually edit the values (in dot percentages) to make further adjustments 
to the curve. The values may be displayed in dot percentages or in densities, 
depending on the curve options.

Stimuli values These are the number of measuring points of dot percentages for the test page. 

Measured values These are the values that are measured on the test page, either entered manually 
or imported from a file.

Wanted values These are the desired dot gain values in dot percentages for the final print result.

Adding or Deleting Values Use the Add or Delete buttons to either add or delete a value.

Table Options This dialog box allows you to specify the required table options for the curve, the 
inks and the measured values.
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Copy/Paste

Use these commands to copy all the data of a table and paste it in another table. 
You can only copy data from a single table but you can paste this data into 
multiple tables by selecting multiple tables in the ink table list.

Curve Options

Apply to all Select this check box to save the settings in the Always applied to all section to 
all tables or deselect it to save the settings for the selected curves only. Apogee 
Prepress remembers the state of this option between sessions.

Smooth curve This option will smoothen the curve around the measuring points. If this option 
is not selected, the measuring points will be connected with straight lines.

Curve through
measurements

This option forces the curve to go exactly through the measured points. 

Smooth curve + Curve
through measurements

If you select both these options, Apogee generates a smooth curve that goes 
through the measured points. 

Minimum Select this option if you want to have a minimum value at which the compensa-
tion curve starts. All values below that one will be clipped to the minimum value 
(Wanted values). 

Clip to 0 below Every value in the compensation curve below the specified percentage in the 
field, will become 0 (Wanted values). 

Maximum Select this option if you want a maximum value for the compensation curve. All 
values that are higher, will be clipped to the maximum value (Wanted values).

Always keep 100 All the 100% values will be kept as 100 in the transfer curve.

Apply limits to Select the curve that you want to apply the minimum and maximum limits to.

 Wanted curve: Limit the compensated curve so that the resulting printed 
output reaches the specified limit. As a result, the values for the limit you 
will see on the compensated curve will be different than the ones 
specified.

 Compensated curve: Limit the compensated curve to the specified values.

Resolution Select the resolution of the curve: Standard or High (slower).
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Reset

Choose this option if you want to fill the table with new values. You will have to 
go through the Initialize dialog boxes again to specify whether you will manually 
enter the values or import them. See “Create Table” on page 1168.

CAUTION: Clicking this button will delete the previous table values.

Import/Export Data Sets

You can exchange the table data with other applications such as PressTune. The 
main difference with the other exchange methods is that this method exports 
and imports a multi-set data XML file, only containing the data points of the 
different inks and possible front/back sides.

Print Settings 
Button)

Opens the print job details regarding stock and screen type. See “Calibration 
Print Settings” on page 1166 and “Linearization Print Settings)” on page 1167.

Options Button Click this button to access the Global Options dialog box. You can make further 
adjustments to the curve sets and access the different options for the Measured 
values.

Sets

First you can select whether you want curves One for all sides or One per side of a 
sheet, and you can also specify the number of webs. Then you specify settings for 
the curves you want per ink.

NOTE: This tab appears only for calibration curves, not for linearization curves.

Measurements You can either select an ink set per Ink or an Ink Set for all Inks. Select the 
required option from the drop-down list:

 One set per ink: Allows you to edit the CMYK curves separately.

 One set for all inks: The values for the three columns only need to be entered 
once - the curve will be applied to all separations.

Compensation Select the appropriate compensation curve option from the drop-down list:

 One for all inks: Apogee will calculate the average of the four compensation 
curves (C+M+Y+K /4)to create one compensation curve for all separations. 
This option can only be selected if ‘one set per ink’ is chosen from the 
Measurements list.
Apogee Reference Guide



 

17 CALIBRATING YOUR OUTPUT DEVICES 1173
 One per ink: Creates a separate compensation curve for each ink.

 One for black, one for the rest: Calculates the CMY average to create a 
compensation curve for these inks, and creates a separate compensation 
curve for black.

Weighted average This check box is displayed if Measurements is set to ‘one set per ink, and 
Compensation is set to ‘one for all inks’. You only need to enable the weighted 
average option when working with Sublima screens (for better results).

Compensate unknown
colors as

Select a process ink or spot color whose compensation curve will be used for spot 
colors. Choosing Spot Colors in this list adds this option to the Ink drop-down list 
in the Curve Editor so a dedicated curve can be created for spot colors.

Measurements

The values in the Measured
column are in

Specify how the Measured values will be expressed. You have two options.

Dot %: Express the Measured values in dot percentages.

Density (more accurate): Express the Measured values in densities.

Dmin and Dmax: Specify the minimum and maximum densities. 

Maximum density settings that are too low, will clear up the printed images. 
Dark areas will not appear dark enough.

Maximum density settings that are too high will blur the printed images in the 
darker areas. 

Refer to the user manual of your output device to see what the appropriate 
maximum density level is.

NOTE: These options do not apply to Simulation curves.

Print Button

Click this button to either print a test page or a verification page. 

Not compensated Test page with non-compensated values: Select this option if you want to print a 
test page. You can use this test page to measure the dot gain with a densitometer. 
This way you will obtain the Measured values that you can enter in the Values 
table.
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Compensated Test page with compensated values: Select this option to print a verification 
page. This page already contains compensated values. You can use this page to 
check whether the output devices have been calibrated correctly.

On Select the tray which the test page will be printed.

NOTE: This button is only available for Linearization.

Chart Panel

This part of the editor displays the curve as selected in the Display drop-down list 
below. See Display Curve Options for more information on the display options.

The different curves reflect the entered values in the Values table and are 
displayed on a X-Y axis system.

Every curve in the chart has a specific color. The curve that you selected in the 
drop-down list below, will be highlighted.

 Wanted curve: Black

 Measured curve: Blue

 Compensation curve: Green

 Error curve: Red

Display Curve Options

In this drop-down list, you can select which curve you want to see. For every of 
the four options, the selected curve will be highlighted. 

Wanted This option highlights the curve for the Wanted values as specified in the Wanted 
column.

Measured This option highlights the curve for the Measured values as specified in the 
Measured column.

If there is a difference between the Measured values and the Wanted values, the 
curve will not be linear. This deviation is then compensated by the Compensa-
tion curve.

Compensated This option highlights the Compensation curve (green) for the discrepancy 
between the Measured (blue) and the Wanted values (black). Both curves 
neutralize each other resulting in a linear curve producing the desired results.
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The screenshot below shows a compensation curve for a 20% difference 
between the Wanted and the Measured values.

Error This option displays the deviation curve between the Measured values and the 
Wanted values. The screenshot below shows a deviation curve for a 20% differ-
ence between the Wanted and the Measured values.
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CHAPTER
18 Troubleshooting

This section contains information to help you understand and troubleshoot 
issues that may arise when using the software.

 Unexpected Output with Asymmetrical Imposition ............................ 1178
1177
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Unexpected Output with Asymmetrical Imposition

Message:

Pagination does not match folding sequence in fold sheet [X].
Pagination may change!

Pagination does not match Web Production Scheme in fold sheet [X].
Pagination may change!

Why are you seeing this
message?

The message states that the pagination calculated by Apogee Impose does not 
match the pagination that should normally result from the folding or production 
sequence. In older versions of Apogee Impose, all book signatures were treated 
as symmetrical signatures, meaning that the insertion point for nesting was 
always in the middle of the fold sheet, even if the Folding Scheme or Web 
Production Scheme was asymmetrical. For example, this was the case for fold 
sheets created with 6, 10, 14, 18, etc. pages which are always asymmetrical 
folding schemes but previously resulted in symmetrical signatures which were 
incorrect. Pagination of these signatures followed accordingly.

From Apogee version 10.5 and higher, pagination is determined more accurately 
according to the folding sequence for Folding Schemes and the production 
sequence for Web Production Schemes. This means that Folding Schemes/Web 
Production Schemes using an asymmetrical sequence will result in a pagination 
that differs from what you saw previously. Unfortunately, this may result in 
unexpected output when working with jobs you created in older versions of 
Apogee (archives, job dumps, ticket templates, etc.) and for which the imposi-
tion has been updated. You may have chosen to update the imposition 
intentionally using the Auto Impose feature, manually removing a fold sheet 
from a press sheet, reapplying mark sets, etc. However, an imposition can also be 
updated unintentionally, for example when you change the page size of the 
product.

What is an asymmetrical
book signature?

An asymmetrical book signature is a signature whose insertion point for nesting 
is not in the middle of the fold sheet. For example, book signatures with 6 pages 
(F6-1, F6-2, etc.) are always asymmetrical:
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F6-1 folding scheme: after insertion of BS2, 2 pages left and 4 pages right (spine not in the 
center) so BS2 starts with page 3 left.

F6-2 folding scheme: after insertion of BS2, 4 pages left and 2 pages right (spine not in the 
center) so BS2 starts with page 5 left.
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Book signatures that use 12-page folding schemes can also be asymmetrical (e.g. 
F12-3, F12-4, etc.):

Affected Default Installed
Folding Schemes

The following default installed folding schemes are asymmetrical:

 F2-1, F6-1, F6-2, F6-3, F6-4, F6-5, F6-6, F6-7, F6-8, F8-3, F8-5, F8-6, F10-1, 
F10-2, F10-3, F12-3, F12-4, F12-5, F12-6, F12-11, F12-12, F12-13, F12-14, 
F14-1, F16-5, F18-1, F18-2, F18-3, F18-4, F18-5, F18-6, F18-7, F18-8, F18-9

New Default Resources
Made Symmetrical

ECO3 has created symmetrical folding schemes for the following default 
installed asymmetric folding schemes:

 F8-3, F12-6, F16-5

 Default FoldingSchemeSet with page 1 on front

These resources were delivered in previous versions and may contain incorrect 
sequences. Please contact your Service Technician to update them.

Do you need to review your
Folding Scheme/Web

Production Scheme
resources?

It is recommended to review all your Folding Scheme and Web Production 
Scheme resources marked as “not symmetrical” in the resource editors.
If such a Folding Scheme is not supposed to be asymmetrical, you should edit it 
and select a symmetrical folding sequence.

F12-3 folding scheme: after insertion of BS2, 8 pages left and 4 pages right (spine not in the 
center) so BS2 starts with page 9 left.
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If such a Web Production Scheme is not supposed to be asymmetrical, review the 
scheme and add scissors to cut the web in ribbons. A fold is then changed to a cut 
which could make the Web Production Scheme symmetric but you can also 
recreate the Web Production Scheme.

The Folding Scheme editor where you can select a symmetrical folding sequence for a Folding 
Scheme marked as “not symmetrical”
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Any new Folding Schemes/Web Production Schemes that you create in Apogee 
version 10.5 and higher will first select a symmetrical sequence if available.

NOTE: If you cannot find a symmetrical folding sequence/production 
sequence and you were able to process the Folding Scheme/Web Production 
Scheme with a previous version of Apogee, contact your Service Technician.

When should you review an
imposition?

An old job or ticket template that uses an asymmetrical Folding Scheme/Web 
Production Scheme was always imposed symmetrically with symmetrical 
pagination. In this case you will see the message attached to the book signature 
icon (BS) in the assembly pane and you will be prompted to check the Folding 
Scheme/Web Production Scheme in the resources. If you do not review the 
imposition, your output may be different than the last time.

Related topics: • Product View on page 386
• Folding Scheme Editor on page 1004
• Web Production Schemes on page 1150

Warning indicating unexpected output
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A System Variables

This section provides a list of all System variables. It also defines their syntax, 
and rules on how to use them.

 Generic Variables .............................................................................................. 1184
 Mark Engraver Variables ................................................................................. 1195
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Generic Variables

You can use variables in a number of different areas to replace parameter and 
resource settings. These variables are automatically replaced by a text string, or 
are assigned a text string.

Variable Description

$BOOKSIGNATURE The prefix-based name of the book signature when used in a split-for-proof flow using Apogee 
Impose. Otherwise resolves to $SIGNATURE.

$CALCURVE The name of the calibration curve used to print a separation. If a separation contains several 
objects with different curves, only the name of the first one is used.

$CIP3PAPERTYPE The CIP3 paper type derived from the paper type that corresponds with the press sheet paper 
stock. (same as HDMPaperTypeFront or CIP3AdmPaperGrade)

COLLECT_TEMPLATENAME The name of the ticket template that is to be used for a job created by the collecting hot ticket.

$COMMENTS The “Remarks” field in the Administration tab.

$COMMENTS_1-10 The “n”-th paragraph of text in the Remarks field of the Administration tab. A paragraph is a 
single line of text, delimited by paragraph marks or by the start or end of the text.

$COMPANY The “Company” field in the Customer Contact information.

$COMPANYADDRESS The “Address” field of the customer’s company.

$COMPANYCITY The “City” field of the customer’s company.

$COMPANYCOUNTRY The “Country” field of the customer’s company.

$COMPANYPHONE The “Phone” field of the customer’s company.

$COMPANYSTATE The “State” field of the customer’s company.

$COMPANYZIP The “Zip” field of the customer’s company.

$COMPUTER The name of the Hardware System on which the current Task Processor (or service) is running.

$CONTACTEMAIL The “E-mail” field of the customer’s contact person.

$CONTACTFIRST The “First” field of the customer’s contact person.

$CONTACTLAST The “Last” field of the customer’s contact person.

$CONTACTMOBILE The “Mobile” field of the customer’s contact person.

$CONTACTPHONE The “Phone” field of the customer’s contact person.

$CONTACTTITLE The Title field of the customer's contact person.

$COPYCOUNT The Requested Copy Count of an Image (S&D jobs only, sets number of copies of the part that 
is associated with that image).

$CPM The Calibrated Printing Mode used for the job.

$CUTTER The name of the cutting device set for the job.

$DATE The current date (i.e. the date when the variable is resolved). Insert a space when combining 
this variable with other variables, e.g. \\$SYSTEMCOMPUTER\ArchiveRoot\$DATE:%Y%m 
\$JOB\

$DESCRIPTION The Description field in the Administration tab.

$DEVICE The name of the output device.
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$DEVICEGROUP The name of the device group to which the used output device belongs. For system device 
groups, $DEVICE and $DEVICEGROUP are identical.

$DOCPAGE The page number (index) of a page in its document, starting at 1.

$DOCPAGELABEL The (text) label of a page in its document. Defaults to $DOCPAGE if there is no label.

$DOCPAGETRIMBOX The trim box of a page, expressed as "<W> x <H>", whereby <W> and <H> are "<value> 
<units>". The units are determined by the international settings of the server, and can be in 
mm or inches.

$DOCUMENT Document title (set by %%Title).

$DOCUMENTAUTHOR The author of the (PDF) document.

$DOCUMENTBASENAME The filename of a document, excluding path and extension. Defaults to $DOCUMENT for docu-
ments arriving via streamed input channels.

$DOCUMENTCREATOR The creator of the (PDF) document.

$DOCUMENTEXTENSION The extension of a document, excluding the separation point. Defaults to $FORMAT for docu-
ments arriving via streamed input channels.

$DOCUMENTFILENAME The filename of a document, including extension but excluding path. Defaults to $DOCU-
MENT.$FORMAT for documents arriving via streamed input channels.

$DOCUMENTLIST A set of document names in a multi-page result, such as a flat.

$DOCUMENTPATH The pathname of a document (excluding the file name) relative to the Hot Folder path. Does 
not contain the leading or trailing backslash (\). Empty for documents input via streamed input 
channels. Contains the common path of pre-separated input documents where the separations 
arrive in different subfolders.

$DOCUMENTPRODUCER The producer of the (PDF) document.

$DOCUMENTREV Document revision. Empty for the original. “1” for the first revision, etc.

$FLOWNAME New SplitJDF; resolves to the Flow Name if there is more than one flow.

$FLOWTYPE New SplitJDF; resolves to the Flow Type if there is more than one flow.

$FORMAT The 3-letter extension associated with the type of data being processed.

$HSCALE The horizontal scale used by the Render Task Processor, expressed as a percentage. See also 
$SCALE and $VSCALE.

$HOTFOLDERROOT Root for all PS/PDF Hot Folders (default in Hot Folder Task Processor).

$IMPSIGNATURENAME The name of the selected signature.

$IMPTEMPLATENAME The name of the imposition template (name only, no path).

$INKSET The name of the inkset as selected in the Generic Press.

$JDF_ASSEMBLYIDS The JDF assembly IDs.

$JDF_CUSTOMERID The JDF customer ID.

$JDF_CUSTOMERJOB The JDF name of the customer job.

$JDF_CUSTOMERORDER The JDF name of the customer order.

$JDF_DESCRIPTIVENAME Descriptive name per separation.

$JDFIMPORTROOT The root for all JDF Hot Folders. (default in JDF Input Task Processor)

$JDF_JOBDESCRIPTION The JDF job description.

$JDF_JOBNAME The JDF job name.

Variable Description
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$JDF_JOBPARTID The JDF part ID.

$JDF_OPERATOR The operator name in the JDF file.

$JDF_ORDERDESCRIPTION The JDF order description.

$JDF_ORDERNUMBER The JDF order number.

$JDF_PARTNAME The JDF part name.

$JDF_PARTVERSION The JDF part version.

$JDF_PRODUCTID The JDF product ID.

$JDF_PROJECTID The JDF project ID.

$JDF_SEPARATION The JDF separation name.

$JDF_SHEET The name of the sheet in the JDF layout.

$JDF_SIGNATURE The JDF signature.

$JOB The “Job name” field in the Administration tab.

$JOBDATE The date when the job was submitted.

$JOBID A unique job identifier (intended mainly for internal use).

$JOBNR A unique job sequence number.

$JOBTIME The time when the job was submitted.

$LINCURVE The name of the linearization curve used to print a separation. If a separation contains several 
objects with different curves, only the name of the first one is used.

$MEDIANAME The name of the media.

$MEDIATYPE The type of media.

$MEDIATHICKNESS The thickness of the media used.

NONE Overrides the default behavior of generating no text if the specified variable is not used. To be 
used without the $ sign and between pipe characters. Example: $COMPANY|NONE| generates 
the text string NONE if the specified company variable is not used.

$OPERATOR The “Operator” field in the Administration tab.

$ORDER The “Order number” field in the Administration tab. This is the “Name” field in the Hot Ticket 
Editor.

$OUTPUTSIZE The size of the rendered image for a sheet/plate. For DQS, the size of the bounding box of all 
rendered elements on that sheet.

$PLATEID The platecounter PLATEID. Only supported as a TextMark in the Border which in turn becomes 
a DeviceMark, which can only be resolved in TP_Output.

$PAPERGRADE The paper grade that corresponds with the paper type of the press sheet paper stock.

$PAPERSTOCK The name of the press sheet paper stock.

$PAPERTYPE The paper type that corresponds with the press sheet paper stock.

$PAPERWEIGHT The weight of the press sheet's paper stock.

$PART The name of the part. If it contains pages of different parts, the part name of the page with the 
lowest Run List index is used.

$PRESS The name of the press.

$PRESSPROFILE The profile of the press.

$PRINTDATE The date the job was printed. 

Variable Description
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$PRINTMODE The date the job is printed (yyyymmdd) This format is best suited for creating pathnames that 
sort properly by name. It also follows the ISO guidelines for date and time formats.

$PRINTTIME The time the job was printed.

$PRODSET The name of the production set.

$PRODSETPREFIX The sheet prefix associated with the production set to which the current sheet belongs.

$PRODUCTDISPLAYNAME E.g. 'Apogee'

$PRODUCTNAME E.g. 'APOGEE Prepress' (guaranteed to contain NO special characters)

$PRODUCTVENDOR E.g. ‘ECO3’

$PRODUCTVERSION E.g. 3.0

$PRODUCTVERSIONMAJOR E.g. 3

$PRODUCT_CODE The code of a product. Resolves to a comma-separated list when the context addresses multi-
ple products.

$PRODUCT_GRAIN The grain direction of a product. Resolves to a comma-separated list when the context 
addresses multiple products.

$PRODUCT_NAME The name of a product. Resolves to a comma-separated list for multiple products.

$PRODUCT_ORDER The order number of a product. Resolves to a comma-separated list for multiple products.

$PRODUCT_COPYCOUNT The requested copy-count of a product. Resolves to a comma-separated list for multiple prod-
ucts.

$PRODUCT_TOTALPAGES The number of pages in a product. Resolves to a comma-separated list for multiple products.

$QUALITY The output quality as specified in the Layout Editor

$RESOLUTION The resolution of the image.

$RLCOMMENT Run List comment

$RLINDEX The index of the position of a page in the Run List, starting at 1. Do not confuse this with 
RLPAGE.

$RLPAGE The number associated with the position of a page in the Run List. The number of the first posi-
tion in the Run List is specified by the value of First page at: in the Run List Task Processor. Not 
to be confused with $RLINDEX.

$RLPAGE@m A string of digits of any size, offset from the first page by <m> page positions (you must 
replace ‘m’ by an offset number).

$RLPAGE:n A string of exactly <n> digits.

$RLPAGE:n@m A string of exactly <n> digits, offset from the first page by <m> page positions (you must 
replace ‘m’ by an offset number).

$RULINGMAP Name of the RulingMap in case of Application screening, otherwise empty.

$RUNLENGTH The run length of the job.

$SCALE The scale used by the Render Task Processor, expressed as a percentage. This is replaced by 
$HSCALE ‘ x ’ $VSCALE when the image is scaled disproportionally.

$SCREEN The name of the screen that was used to screen the separation. If a separation contains several 
objects with different screens, only the name of the first one is used.

$SCREEN_ANGLE The angle that was used to screen the separation. If a separation contains several objects with 
different screens, it is resolved in the same way as the $SCREEN variable.

$SEPARATION The color name of the separation.

Variable Description
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$SEPARATIONSHORT The color name of the separation, but the primary colors are 'C', 'M', 'Y' and 'K'. Other names 
are abbreviated in the same way they are abbreviated by the custom color bar mark.

$SHEET Evaluates to $SIGNATURE for single or no web impositions. Evaluates to $SIGNATURE $WEB for 
multi-web impositions.

$SHEET_GRAIN The grain of the sheet.

$SHEETVERSION The `SV<n>'  version number of a sheet version, with <n> being the $SHEETVERSIONINDEX. 
When used on a result that has the default single-version set-up, <n> is the same as the $VER-
SIONINDEX.

$SHEETVERSIONINDEX The index <n> of the sheet version in the sheet version table, starting at 1, per sheet.  When 
used on a result that has the default single-version set-up, <n> is the same as the $VER-
SIONINDEX.

$SIDE The Press Sheet side (“F” for Front, “B” for Back). Note that the SIDE variable maps either to the 
SIDE or the SIDEA Apogee variables, depending on the setting of the Imposition Service.

$SIDEA The name of the web (starting from A). $SIDEA produces a letter that uniquely defines a side 
(front or back) on a web. The front of web 1 is referred to as A, the back as B; the front of web 2 
is C, the back is D, and so on. This does not depend on the imposition template - If the imposi-
tion only uses the fronts of two webs, they will be referred to as A (web 1 Front) and C (web 2 
front).
This variable produces an empty string if the result is not an imposed flat or if the imposition 
template is not multi-web.

$SIGNATURE The number of the signature including the prefix. Produces an empty string if the result is not 
an imposed flat.

$SIGNATURENUMBER The number of the signature without the prefix. Produces an empty string if the result is not an 
imposed flat.

$SIGNATUREINDEX The index of the signature without the prefix. Produces an empty string if the result is not an 
imposed flat.

$SIGNATURE_MAIN Same as $SIGNATURE of the main imposition. Can be used in a 1-up S4P flow to refer to the 
results of the main imposition.

$SIGNATURENUMBER_MAIN Same as $SIGNATURENUMBER of the main imposition  Can be used in a 1-up S4P flow to refer 
to the results of the main imposition.

$SIGNATUREINDEX_MAIN Same as $SIGNATUREINDEX of the main imposition  Can be used in a 1-up S4P flow to refer to 
the results of the main imposition..

$SIMCURVE The name of the simulation curve used to print a separation. If a separation contains several 
objects with different curves, only the name of the first one is used.

$SLUG1 First slug-line specified in the output parameters of an output device.

$SLUG2 Second slug-line specified in the output parameters of an output device.

$SLUG3 Third slug-line specified in the output parameters of an output device.

$SLUG4 Fourth slug-line specified in the output parameters of an output device.

$SYSTEM The name of the Apogee System.

$SYSTEMCOMPUTER The name of the Hardware System.

$TICKETNAME See $ORDER.

$TICKET_TEMPLATENAME The name of the ticket template that is to be used for a job created by the collecting hot ticket.

Variable Description
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NOTE: You can use a drop-down menu in the various contexts to see which 
variables are supported in which context.

You can also use system variables to automatically print information about a job, 
a template, or the part of a job that is being printed, since the information that 
prints varies from one sheet of media to the next.

$TIME The current time (i.e. the time when the variable is resolved).

$TOTALPAGES The total number of pages of a job. I.e. the size of the Run Lists when Run Lists are present. 
Value is -1 when no page count established or no Run List is present.

$TOTALSHEETS The total number of press sheets in a job.

$TOTALPRODUCTS The total number of products in a job.

$TRAY The display name of the engine's current tray that is used. Note that this may change during 
the course of a job.

$VERSION The name of the product version of a result. This is the contents of the second column in the 
product version table (even if that column is renamed). Can be used for input and output. Note 
that $VERSION always refers to the second column in the table (i.e. the one after the '#' col-
umn), even if you have renamed it. Resolves to a comma separated list of product versions 
when used on a press sheet that contains multiple product versions. Can be used in read-syn-
tax in Page Assembly of Versioning TP.

$VERSIONELEMENT<i> Used in Versioning jobs: the content of the ith version element in the version table.

$VERSIONELEMENTNAME<i> Used in Versioning jobs: the name (value of the column header) of the ith version element in 
the version table.

$VERSIONINDEX Used in Versioning jobs: the index of the version in the version table, i.e., its row number, start-
ing at 1.

$VERSIONSHORT The `V<n>' short version number of a product version, with <n> being $VERSIONINDEX. I.e., 
the content of the first column in the product version table. Evaluates to a comma separated 
list of product versions short names when used on a result that contains multiple product ver-
sions. Can be used in read-syntax in Page Assembly of Versioning TP.

$VSCALE The vertical scale used by the Render Task Processor, expressed as a percentage. See also 
$SCALE and $HSCALE.

$WEB The number of the web (starting from “1”). Evaluates to an empty string if the result is not an 
imposed flat or if the imposition template is not multi-web.

$WEB_MAIN Same as $WEB of the main imposition. Can be used in a 1-up S4P flow to refer to the results of 
the main imposition.

$WEBGROWTHPROFILE The name of the web-growth profile used for a job (i.e. press parameter).

$WHITEMODE The white application mode (pre-white, post-white or sandwich-white) used to print the white 
on the sheet/layout. Empty if no white.

$WORKSTYLE The workstyle used by imposition. Resolves to any of the strings Sheetwise, Work and Turn, 
Work and Tumble, Single Sided, Perfector.

$WPS The displayname of the WebProductionScheme resource.

Variable Description
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Variable Syntax This section explains the variable syntax, and describes how variables are inter-
preted and replaced by Apogee. Any variable that cannot be appropriately 
interpreted in a given context will be replaced by an empty string.

NOTE: Variables are case sensitive! For example, $system will not be recognized 
as the $SYSTEM variable: Instead, it will be interpreted as literal text.

Start and End

Variables always start with a dollar sign ($), immediately followed by the 
variable name. Any non-alphanumerical character (including space or tab) 
marks the end of the name. 

NOTE: The RLPAGE variables that are used in the Run List settings for automatic 
page placement do not use the dollar sign. They are delimited using the less 
than/greater than symbols. For example, <RLPAGE:n>. This is also the case 
when they are used in an input filename template (Open Connect, Hot Folder).

Braces

The variable name should be enclosed between braces {  } when other alphabet-
ical text immediately follows the variable name.

Square Brackets

Square brackets should be used to prevent unwanted gaps when variables 
cannot be resolved because the value is nil, out of context, or only one value is 
possible.

For example:

$JOB[-$PART][-$BOOKSIGNATURE][-$RLPAGE][-v$VERSION][-$FLOWNAME]

Width Modifier

Variables can have a width modifier (a colon followed by a number, such as :3). 
This causes the variable to be substituted with exactly the specified number of 
characters. If the content is longer than the specified width, Apogee truncates it: 
If the content is shorter than the specified width, Apogee pads the remainder 
with blanks. You can customize the padding by inserting a plus (+) or minus (-) 
sign before the width modifier:

 Inserting a “+” before the width modifier specifies that the padding or 
truncation will be at the end of the variable. Any character you enter after the 
+ will be used as the padding character for the specified number of spaces. 
For example, +Y12 will result in a 12-character name, padded out at the end 
with Ys where necessary (e.g. ECO3YYYYYYYY).
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 Inserting a “-” before the width modifier specifies that the padding or trunca-
tion will be at the beginning of the variable. Any character you enter after the 
+ will be used as the padding character for the specified number of spaces. 
For example, -X12 will result in a 12-character name, padded out at the 
beginning with Xs where necessary (e.g XXXXXXXXECO3).

When omitted, Apogee assumes "+ " (plus, followed by a space), in which case 
the padding is done with the “?” wildcard character.

When the string following a $ is not recognized as a variable, it is printed as a 
literal (e.g. $SITE becomes "$SITE"). To overrule the meaning of the $ character 
when followed by a legal variable name, you need to prefix the $ with another $: 
For example, $$SIDE then becomes "$SIDE".

In the following examples, we assume that the job has the following attributes:

 Order number ($ORDER) = 0106G0001

 Customer contact ($CUSTOMER) = ECO3

Use NONE without the $ sign and between pipe characters to override the 
default behavior of generating no text if the specified variable is not used. 

Variable Example Substitution Result

$CUSTOMER$ORDER ECO30106G001

$CUSTOMER ECO3

$CUSTOMER:3 ECO

$CUSTOMER:6 ECO3 

$CUSTOMER:+ 6 ECO3??.

$CUSTOMER:+_6 ECO3__

$CUSTOMER:-_6 __ECO3

$RLPAGE:-03 001, 002, 003,... 010, ... (3 character nos, padded up front with 0s)

$CUSTOMERX $CUSTOMERX

${CUSTOMER }P ECO3P

$CUSTOMER|NO NAME| ECO3

$CUSTOMER|NO NAME| NO NAME (when Customer contact is empty)

$ORDER-P 0106G0001-P

$ORDER:>4 0001

$ORDER[:4] 0106 (takes first 4 characters)

$ORDER[5:] G0001 (takes characters starting from the 5th character)

$ORDER[-2:] 01 (takes last 2 characters)

$ORDER[:-2] 0106G000 (takes all characters that precede the last 2 and 
includes the last but two character)
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Example: $COMPANY|NONE| generates NONE if the specified company 
variable is not used.

Date and Time 
Variable Formats

The date and time variables by default print the date and time according to the 
regional settings of the computer that evaluates the variable. However, in some 
cases you may want to have it printed differently.

NOTE: When you use format strings, the date and time variables (DATE/TIME 
and PRINTDATE/PRINTTIME) produce the same result: Apogee only uses the 
format to see what has to be printed.

You can modify the behavior of some format codes by prefixing them with #.

When you specify no format string, $DATE and $TIME default to $DATE:%x and 
$TIME:%X.

You need to enclose the variable name and format string in braces if you want to 
print spaces (see examples below).

When you specify an unknown format string, Apogee prints it as a literal 
(without the %). A width modifier is therefore also printed literally.

Format Code Description

%#a, %#A, %#b, %#B, 
%#p,%#X, %#z, %#Z, %#%

# flag is ignored.

%#c Long date and time representation, appropriate for current 
locale. For example: Tuesday, August 05, 2008, 12:41:29.

%#x Long date representation, appropriate to current locale. For 
example: Tuesday, August 05, 2008.

%#d, %#H, %#I, %#j, %#m, 
%#M, %#S, %#U, %#w, %#W, 
%#y, %#Y

Remove leading zeros (if any).

Date and Time formatting options

%a Abbreviated weekday name (first 3 chars).

%A Full weekday name.

%b Abbreviated month name (first 3 chars).

%B Full month name.

%c Date and time representation appropriate for locale.

%d Day of month as decimal number (01 - 31).

%j Day of year as decimal number (001 - 366).
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Other characters not prefixed with % are printed as literals.

NOTE: You can control the width of the replacement string by using the 
appropriate format codes. Most of them have a fixed width. Use %a and %b to 
retrieve the abbreviated day and month names, fixed to 3 characters wide.

Combinations with $DATE

Insert a space when combining this variable with other variables, e.g. 
\\$SYSTEMCOMPUTER\ArchiveRoot\$DATE:%Y%m \$JOB\

Examples

%m Month as decimal number (01 - 12).

%U Week of year as decimal number, with Sunday as first day of week (00 - 53).

%w Weekday as decimal number (0 - 6; Sunday is 0).

%W Week of year as decimal number, with Monday as first day of week (00 - 53).

%x Date representation for current locale.

%y Year without century, as decimal number (00 - 99).

%Y Year with century, as decimal number.

%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown.

%c Date and time representation appropriate for locale.

%H Hour in 24-hour format (00 - 23).

%I Hour in 12-hour format (01 - 12).

%M Minute as decimal number (00 - 59).

%p Current locales A.M./P.M. indicator for 12-hour clock.

%S Second as decimal number (00 - 59).

%X Time representation for current locale.

%z, %Z Time-zone name or abbreviation; no characters if time zone is unknown.

%% Percent sign.

Format String Result Remarks

$DATE 07/09/03 Depends on locale. Equivalent to %x.

$TIME 11:14:45 Depends on locale. Equivalent to %X.

$DATE:% A Wednesday

$DATE:%c Wed Jul 9 11:16:49 2003 Depends on locale.

${DATE:Week %j} Week 190

$DATE:%A%f Wednesdayf %f printed as literal.

${DATE:Hello World} Hello World Printed as literal.

Date and Time formatting options
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$DATE:+ 5 + 5 Width modifier printed as literal.

$DATE:%y%m%d 030709

$DATE:%Y%m%d 20030709 Case matters!

Format String Result Remarks
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Mark Engraver Variables

These variables can only be used in the Mark Engraver. 

Table legend:

 C = The variable can be used as a condition.

 T= The variable can be used to insert data in Text Marks.

 V = The variable can be resolved in the specified view.

 X = The variable cannot be resolved in the specified view, however, the 
output will be OK even it is not resolved in the view.

 Generic Variables: This column lists the corresponding variables that can be 
used in Border, File Name Template, etc.

 Preps Variables: This column lists the corresponding variables that can be 
used in Preps templates

Mark Engraver Variables
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Generic Variables Preps Variables

$product

$product.binding_edge CT CT CT V

$product.binding_options.assembly_type CT CT CT V

$product.binding_options.name CT CT CT V

$product.code T T T T T V PRODUCT_CODE

$product.copy_count T T T T T V PRODUCT_COPYCOUNT

$product.design T T T T T V

$product.finished_trim_size.height CT CT CT T T V

$product.finished_trim_size.name T T CT T T V

$product.finished_trim_size.width CT CT CT T T V

$product.grain T T T T T V

$product.name CT CT CT T T V PRODUCT_NAME

$product.order T T T T T V PRODUCT_ORDER

$product.sub_type CT CT CT V

$product.total_pages T T T V PRODUCT_TOTALPAGES

$product.type CT CT CT V

$product.type_name CT CT CT V
Apogee Reference Guide



1196 MARK ENGRAVER VARIABLES
$page

$page.book_signature.index CT V

$page.book_signature.number_pages C V

$page.document_base_name T X DOCUMENTBASENAME

$page.document_filename T X DOCUMENTFILENAME

$page.document_name T X DOCUMENT

$page.document_page T X DOCPAGE

$page.document_page_label T X DOCPAGELABEL

$page.finished_trim_size.height CT V

$page.finished_trim_size.name T V

$page.finished_trim_size.width CT V

$page.part.comments T PARTCOMMENTS

$page.part.copy_count_actual T V

$page.part.copy_count_requested T V COPYCOUNT

$page.part.finished_trim_size.height CT V

$page.part.finished_trim_size.name T V

$page.part.finished_trim_size.width CT V

$page.part.name CT V PART

$page.part.number_colors CT V

$page.part.process_colors CT V

$page.part.range CT V

$page.part.spot_colors CT V

$page.part.type CT V

$page.rlindex CT V RLINDEX

$page.rlpage CT V RLPAGE

$image

$image.copy_count_actual T V

$image.copy_count_requested T V COPYCOUNT

$image.document_base_name T X DOCUMENTBASENAME

$image.document_filename T X DOCUMENTFILENAME

$image.document_name T X DOCUMENT

$image.document_page T X DOCPAGE

$image.document_page_label T X DOCPAGELABEL

$image.finished_trim_size.height CT V

$image.finished_trim_size.name T V

Mark Engraver Variables
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$image.finished_trim_size.width CT V

$image.horizontal_scale CT V

$image.product_size.height T V

$image.product_size.name T V

$image.product_size.width T V

$image.scale T V

$image.station_number T V

$image.tile_number T X

$image.tile_rc T X

$image.total_tiles T X TOTALTILES

$image.vertical_scale CT V

$assembly

$assembly.number_fold_sheets T T X

$fold_sheet

$fold_sheet.binding_options.assembly_type CT V

$fold_sheet.binding_options.name CT V

$fold_sheet.bottom_page.finished_trim_size.height CT V

$fold_sheet.bottom_page.finished_trim_size.name T V

$fold_sheet.bottom_page.finished_trim_size.width CT V

$fold_sheet.bottom_page.part.copy_count_actual T V

$fold_sheet.bottom_page.part.copy_count_requested T V COPYCOUNT

$fold_sheet.bottom_page.part.finished_trim_size.height CT V

$fold_sheet.bottom_page.part.finished_trim_size.name T V

$fold_sheet.bottom_page.part.finished_trim_size.width CT V

$fold_sheet.bottom_page.part.name CT V PART

$fold_sheet.bottom_page.part.number_colors T V

$fold_sheet.bottom_page.part.process_colors T V

$fold_sheet.bottom_page.part.range CT V

$fold_sheet.bottom_page.part.spot_colors T V

$fold_sheet.bottom_page.part.type CT V

$fold_sheet.bottom_page.rlindex CT V RLINDEX

$fold_sheet.bottom_page.rlpage CT V RLPAGE

$fold_sheet.folding_scheme CT V IMPSIGNATURE-
NAME

Mark Engraver Variables
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$fold_sheet.highest_folio_page.finished_trim_size.height CT V

$fold_sheet.highest_folio_page.finished_trim_size.name T V

$fold_sheet.highest_folio_page.finished_trim_size.width CT V

$fold_sheet.highest_folio_page.part.copy_count_actual T V

$fold_sheet.highest_folio_page.part.copy_count_requested T V COPYCOUNT

$fold_sheet.highest_folio_page.part.finished_trim_-
size.height

CT V

$fold_sheet.highest_folio_page.part.finished_trim_-
size.name

T V

$fold_sheet.highest_folio_page.part.finished_trim_-
size.width

CT V

$fold_sheet.highest_folio_page.part.name CT V PART

$fold_sheet.highest_folio_page.part.number_colors T V

$fold_sheet.highest_folio_page.part.process_colors T V

$fold_sheet.highest_folio_page.part.range CT V

$fold_sheet.highest_folio_page.part.spot_colors T V

$fold_sheet.highest_folio_page.part.type CT V

$fold_sheet.highest_folio_page.rlindex CT V RLINDEX

$fold_sheet.highest_folio_page.rlpage CT V RLPAGE

$fold_sheet.imposition_type CT V

$fold_sheet.index CT V SIG (Multi Section)

$fold_sheet.lowest_folio_page.finished_trim_size.height CT V

$fold_sheet.lowest_folio_page.finished_trim_size.name T V

$fold_sheet.lowest_folio_page.finished_trim_size.width CT V

$fold_sheet.lowest_folio_page.part.copy_count_actual T V

$fold_sheet.lowest_folio_page.part.copy_count_requested T V COPYCOUNT

$fold_sheet.lowest_folio_page.part.finished_trim_-
size.height

CT V

$fold_sheet.lowest_folio_page.part.finished_trim_size.name T V

$fold_sheet.lowest_folio_page.part.finished_trim_size.width CT V

$fold_sheet.lowest_folio_page.part.name CT V PART

$fold_sheet.lowest_folio_page.part.number_colors T V

$fold_sheet.lowest_folio_page.part.process_colors T V

$fold_sheet.lowest_folio_page.part.range CT V

$fold_sheet.lowest_folio_page.part.spot_colors T V

$fold_sheet.lowest_folio_page.part.type CT V

$fold_sheet.lowest_folio_page.rlindex CT V RLINDEX
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 SYSTEM VARIABLES 1199
$fold_sheet.lowest_folio_page.rlpage CT V RLPAGE

$fold_sheet.name T X SIG

$fold_sheet.number T X

$fold_sheet.number_pages CT V

$fold_sheet.top_page.finished_trim_size.height CT V

$fold_sheet.top_page.finished_trim_size.name T V

$fold_sheet.top_page.finished_trim_size.width CT V

$fold_sheet.top_page.part.copy_count_actual T V

$fold_sheet.top_page.part.copy_count_requested T V COPYCOUNT

$fold_sheet.top_page.part.finished_trim_size.height CT V

$fold_sheet.top_page.part.finished_trim_size.name CT V

$fold_sheet.top_page.part.finished_trim_size.width CT V

$fold_sheet.top_page.part.name CT V PART

$fold_sheet.top_page.part.number_colors T V

$fold_sheet.top_page.part.process_colors T V

$fold_sheet.top_page.part.range CT V

$fold_sheet.top_page.part.spot_colors T V

$fold_sheet.top_page.part.type CT V

$fold_sheet.top_page.rlindex CT V RLINDEX

$fold_sheet.top_page.rlpage CT V RLPAGE

$press_sheet

$press_sheet.cad_layout_name CT V

$press_sheet.cutter.name CT V CUTTER

$press_sheet.fold_sheet.index T V

$press_sheet.grain CT V

$press_sheet.imposition_type CT V

$press_sheet.index T T CT V SIGNATUREINDEX

$press_sheet.name T T T V SHEET SIG (No Multi Sec-
tion)

$press_sheet.number T T T V SIGNATURENUMBER

$press_sheet.number_fold_sheets T T CT V

$press_sheet.number_images T T V

$press_sheet.run_length T T T V RUNLENGTH

$press_sheet.side.inksave_set_name T X INKSAVESETNAME

$press_sheet.side.inkset T X INKSET
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1200 MARK ENGRAVER VARIABLES
$press_sheet.side.number_colors T T CT V

$press_sheet.side.press.name T T CT V PRESS PRESS

$press_sheet.side.press.sidelay C V

$press_sheet.side.press_profile T X PRESSPROFILE

$press_sheet.side.process_colors T T CT V

$press_sheet.side.production_set.name T T T X PRODSET

$press_sheet.side.production_set.prefix T T T X PRODSETPREFIX

$press_sheet.side.side T T CT V SIDE SIDE

$press_sheet.side.side_a T T CT V SIDEA

$press_sheet.side.spot_colors T T CT V

$press_sheet.size.height T T CT V

$press_sheet.size.name T T CT V

$press_sheet.size.width T T CT V

$press_sheet.stock.name T T CT V

$press_sheet.stock.weight T T CT V

$press_sheet.web_index T T CT V

$press_sheet.web_number T T T V WEB

$press_sheet.wps CT V

$press_sheet.work_style T T CT V WORKSTYLE WORKSTYLE

$sheet

$sheet.cad_layout_name CT V

$sheet.cutter.name CT V CUTTER

$sheet.cutter.type C V

$sheet.finishing_margins CT V

$sheet.grain CT V

$sheet.media.name CT V MEDIANAME

$sheet.media.thickness CT X MEDIATHICKNESS

$sheet.media.type CT V MEDIATYPE

$sheet.name T T V SIGNATURE - SHEET SIG

$sheet.number_images T CT V

$sheet.press.name T CT V PRESS PRESS

$sheet.press.sidelay C V

$sheet.run_length T CT V RUNLENGTH

$sheet.side.side T CT V SIDE

$sheet.size.height T CT V
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 SYSTEM VARIABLES 1201
$sheet.size.name T T V

$sheet.size.width T CT V

$sheet_side

$sheet_side.side T CT V SIDE SIDE

$output

$output.calibration_curve T T T X CALCURVE

$output.cpm CT X CPM

$output.device T T T X DEVICE

$output.horizontal_scale T T T X HSCALE

$output.linearization_curve T T T X LINCURVE

$output.printdate T T T T T X PRINTDATE DATE

$output.printmode CT X PRINTMODE

$output.printtime T T T T T X PRINTTIME TIME

$output.quality T X QUALITY

$output.resolution T T T T X RESOLUTION

$output.scale T T T X SCALE

$output.separation T T T X SEPARATION COLOR - SEPARA-
TION

$output.sheetversion.index T X SHEETVERSIONINDEX

$output.sheetversion.name T X SHEETVERSION

$output.simulation_curve T T T X SIMCURVE

$output.size.height T T V

$output.size.name T T V

$output.size.width T T V

$output.slug<i> T T T X SLUG<i>

$output.tray T T T X TRAY

$output.version.element<i> T T T X VERSIONELEMENT<i>

$output.version.element_name<i> T T T X VERSIONELEMENT-
NAME<i>

$output.version.index T T T X VERSIONINDEX VERSIONINDEX

$output.version.name T T T X VERSION VERSION

$output.version.short_name T T T X VERSIONSHORT VERSIONSHORT

$output.vertical_scale T T T X VSCALE
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1202 MARK ENGRAVER VARIABLES
$administration

$administration.comments CT CT CT CT CT X COMMENTS COMMENT

$administration.comments_<i> CT CT CT CT CT X COMMENTS_<i> REMARK_LINE_<i>

$administration.contact.email T T T T T X CONTACTEMAIL CONTACTEMAIL - 
CONTACTMAIL

$administration.contact.first T T T T T X CONTACTFIRST CUSTOMER

$administration.contact.last T T T T T X CONTACTLAST CUSTOMER

$administration.contact.mobile T T T T T X CONTACTMOBILE CONTACTMOBILE

$administration.contact.phone T T T T T X CONTACTPHONE

$administration.contact.title T T T T T X CONTACTTITLE CONTACTTITLE

$administration.customer.address T T T T T X COMPANYADDRESS ADDRESS

$administration.customer.city T T T T T X COMPANYCITY CITY

$administration.customer.country T T T T T X COMPANYCOUNTRY COUNTRY

$administration.customer.name CT CT CT CT CT X COMPANY COMPANY

$administration.customer.phone T T T T T X COMPANYPHONE PHONE

$administration.customer.state T T T T T X COMPANYSTATE STATE

$administration.customer.zip T T T T T X COMPANYZIP POSTCODE - POST-
ALCODE

$administration.description CT CT CT CT CT X DESCRIPTION DESCRIPTION

$system

$system.date T T T T T X DATE

$system.time T T T T T X TIME

$jdf

$jdf.customer_id T T T X JDF_CUSTOMERID

$jdf.descriptive_name T X JDF_DESCRIPTIVE-
NAME

$jdf.job_description T T T X JDF_JOBDESCRIPTION

$jdf.job_name T T T X JDF_JOBNAME

$jdf.order_description T T T X JDF_ORDERDESCRIP-
TION

$jdf.order_number T T T X JDF_ORDERNUMBER

$jdf.part_version T T T X JDF_PARTVERSION

$jdf.product_id T T T X JDF_PRODUCTID

$jdf.project_id T T T X JDF_PROJECTID

$jdf.separation T T T X JDF_SEPARATION
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 SYSTEM VARIABLES 1203
$jdf.sheet T T T X JDF_SHEET

$jdf.signature T T T X JDF_SIGNATURE

$job

$job.date T T T T T X JOBDATE JOBDATE

$job.id T T T T T X JOBID

$job.name CT CT CT CT CT V JOB JOBNAME - JOB_TI-
TLE

$job.nr T T T T T X JOBNR

$job.operator CT CT CT CT CT V OPERATOR OPERATOR

$job.order CT CT CT CT CT V ORDER JOBID

$job.ticket_name T T T X TICKETNAME

$job.time T T T T T X JOBTIME JOBTIME

$job.total_pages T T T V TOTALPAGES

$job.total_products T T T V TOTALPRODUCTS

$job.total_sheets T T T V TOTALSHEETS

$apogee

$apogee.computer T T T T T X COMPUTER

$apogee.displayname T T T T T X PRODUCTDISPLAY-
NAME

$apogee.name T T T T T X PRODUCTNAME PRODUCTNAME

$apogee.system T T T T T X SYSTEM SYSTEM

$apogee.systemcomputer T T T T T X SYSTEMCOMPUTER SYSTEMCOMPUTER

$apogee.vendor T T T T T X PRODUCTVENDOR

$apogee.version T T T T T X PRODUCTVERSION PRODUCTVERSION

$apogee.version_major T T T T T X PRODUCTVERSIONMA-
JOR

$apogee.version_minor T T T T T X PRODUCTVERSIONMI-
NOR
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APPENDIX
B Keyboard Shortcuts

This section lists the shortcut keys that can be used on Windows workstations.

 Job Ticket Editor ........................................................................................ 1206
 Jobs Window ............................................................................................... 1208
 Layout Editor and Product Editor ......................................................... 1213
 Apogee Impose .......................................................................................... 1218
1205



1206 KEYBOARD SHORTCUTS
Job Ticket Editor

 Switch Tabs

The following shortcut keys can be used to switch between tabs in the Jobs and 
Job Ticket Editor windows.

 Job List Shortcuts

The following shortcut keys can be used in the Job List.

 Page Store/Run List Shortcuts

The following shortcut keys can be used in the Pages tab, when editing the Run 
List.

To switch between tabs... Press (Windows)

Select the next tab. CTRL + Tab

Select the previous tab. SHIFT + CTRL + Tab

To... Press (Windows)

Expand all jobs. CTRL + click the ‘+’ icon 
of a collapsed job

Collapse all open jobs. CTRL + click the ‘-’ icon 
of a collapsed job
or simply CTRL + F5

Purge a job (complete 1-step delete) SHIFT + Delete
or Delete

Edit a job. CTRL + Enter (Numeric 
keypad)

Move cursor to Quick Filter text field (Find 
job).

CTRL + F

To... Press (Windows)

Fill a placeholder with a blank page. CTRL + B

Jump to a specific Run List position. # + Run List position 
number (do not press 
simultaneously)
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 KEYBOARD SHORTCUTS 1207
 Plate Set-up (versioning jobs)

These shortcuts are available in the plate set-up tab of the Versioning task 
processor in the Plan tab.

When dragging pages from the Page 
Store to the Run List...

Press (Windows)

To replace pages in the Run List. SHIFT + drag

To insert pages in the Run List. ALT + drag 

To reverse the order of the pages when 
dragging in the Run List.

Drag and briefly press R

To reverse the order of the selected 
placed pages in the Run List.

CTRL +SHIFT + R

To select even placeholders E

To select odd placeholders O

When dragging pages within the Run 
List...

Press (Windows)

To replace pages in the Run List. SHIFT + drag

To insert pages in the Run List. ALT + drag 

To copy pages in the Run List. CTRL + drag

To... Press (Windows)

Switch to a next version, or the first one if 
on `all versions'. Does not
wrap around, and does not select `all ver-
sions' if on the last version.

CTRL + ]

Switch to a previous version, or the last 
one if on `all versions'. Does not
wrap around, and does not select `all ver-
sions' if on the first version.

CTRL + [

Show all versions. CTRL + \

To select/clear a range of version-depen-
dent plates.

ALT + click a plate

To set every version in the selected rows 
to a specific version.

ALT + select a specific 
version in the Version 
list

To set every version in the selected rows 
to its own version.

ALT + select Own Ver-
sion at the top of the 
Version list
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 Imposition and From Template Shortcuts

The following shortcut keys can be used in the Signature Selection section of the 
Imposition settings.

 Resource Editors

Jobs Window NOTE: Refer to the separate section for the Apogee Impose menu shortcuts.

 Apogee Menu Shortcuts

The following Apogee menu shortcut keys can be used.

 File Menu Shortcuts

The following File menu shortcut keys can be used.

Expand a selection. SHIFT

Exclude from a selection. CTRL

Clear a selection. CTRL + SHIFT + A

To... Press (Windows)

To... Press (Windows)

Refresh all templates. ALT + Refresh

In the Available Signatures list:
• Select a single signature. Enter

In the Selected Signatures list:
• Find in Available Signatures list. Enter

In the Selected Signatures list:
• Move selected Signatures. CTRL + Up/Down arrow

To... Press (Windows)

To lock and unlock the settings of a resource (padlock button) CTRL + l

To... Press (Windows)

Quit the Apogee Client. ALT + F4

Display Preferences. CTRL + ,
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 KEYBOARD SHORTCUTS 1209
 Edit Menu Shortcuts

The following Edit menu shortcut keys can be used.

To... Press (Windows)

Open a new print layout. CTRL + N

Open the Ticket Template dialog box. CTRL + N

Open the JTE with the default ticket tem-
plate selected.

CTRL + ALT + N

Open the Layout Editor with the default 
wide format job ticket template

CTRL + SHIFT + ALT + N

Select and open a previously saved ticket 
(*.ajt). 

CTRL + O

Close the current window.
Close all windows.

ALT + F4

Save the current ticket (Ticket Editor 
only).

CTRL + S

Save the ticket with a different name 
(Ticket Editor only).

CTRL + SHIFT + S

Save the ticket as a Ticket Template 
(Ticket Editor only).

CTRL + ALT + S

Submit a new Ticket to the Apogee Sys-
tem, or submit the changes you’ve made 
to an existing job (Ticket Editor only).

CTRL + SHIFT + G

Log on to an Apogee System, or to log off 
from one.

CTRL + K

Upload a document. CTRL + U

Open in WebApproval CTRL + SHIFT + M

To... Press (Windows)

Undo the last Cut, Copy, or Paste opera-
tion.

CTRL + Z

Delete the selected text, and copy it onto 
the clipboard.

CTRL + X

Copy the selected text onto the clipboard. CTRL + C

Paste the contents of the clipboard at the 
selected location.

CTRL + V

Delete the current selection. Delete

Delete Task Processor and Following. ALT + Delete

Edit the selected item. CTRL + ENTER

Display the selected item using the 
default viewer.

ENTER

Edit job’s imposition CTRL + SHIFT + ENTER
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 Control Menu Shortcuts

The following Control menu shortcut keys can be used.

Duplicate a job. CTRL + D

Merge Jobs. CTRL + Y

Rename the selected item. F2

Select all items in the current view. CTRL + A

Deselect all items in the current view. CTRL + SHIFT + A

Find in Page Store. CTRL + ALT + F

Find the selected page in the Results 
pane.

CTRL + ALT + SHIFT + F

Find plate identity. CTRL + H

Open the “Create Part” dialog box for 
creating a new part (Product tab only).

CTRL + N

Set the page size of the selected/associ-
ated part(s) to the size of the first placed 
page in the part’s range in the run list 
(Product tab only).

CTRL + SHIFT + Z

Set the name of the selected/associated 
part(s) to the file name of the first placed 
page in the part’s range in the run list 
(Product tab only).

CTRL + SHIFT + X

Set the page size and name of the 
selected/associated part(s) (Product tab 
only). 

CTRL + SHIFT + C

Open the “Adjust Offset” dialog box for 
the selected page(s)/placeholder(s).

CTRL + ALT + SHIFT + O

Open the “Adjust Scale” dialog box for 
the selected page(s)/placeholder(s).

CTRL + ALT + SHIFT + S

Open the “Adjust Rotation” dialog box for 
the selected page(s)/placeholder(s).

CTRL + ALT + SHIFT + R

Remove all adjustments to a page at 
once.

Delete

Put a blank page in the selected place-
holder(s).

CTRL + B

Enter Run List position comments ALT + ;

Reverse Page Order CTRL + SHIFT + R

Preferences CTRL + ,

To... Press (Windows)

To... Press (Windows)

Continue CTRL + G
Apogee Reference Guide



 

 KEYBOARD SHORTCUTS 1211
 View Menu Shortcuts

The following View menu shortcut keys can be used.

 Raster Preview View Menu Shortcuts

The following Raster Preview menu shortcut keys can be used.

To... Press (Windows)

Display thumbnail images of all pages in 
the Job Layout pane.

CTRL + SHIFT+ T

View Flats Only. CTRL + SHIFT + F

View Extra information. CTRL + T

Scale Small. CTRL + -

Scale Normal. CTRL + O

Scale Large. CTRL + +

Scale Fit to Window. CTRL + ALT + O

View Page Labels. CTRL + SHIFT + L

Display the run list indexes next to the 
numbers in run list.

CTRL + SHIFT + N

View Extended Page Adjustments. CTRL + SHIFT + E

Columns Front or Back N/A

Columns Fill Width N/A

Show/hide Devices pane CTRL + ALT + 1

Show/hide Job List pane CTRL + ALT + 2

Show/hide Flow Activity pane CTRL + ALT + 3

Show/hide Production Sets pane CTRL + ALT + 4

Show/hide Separations pane CTRL + ALT + 5

View All Versions CTRL + \

View Previous Version CTRL + [

View Next Version CTRL + ]

To... Press (Windows)

Zoom In. CTRL + +

Zoom Out. CTRL + - 

Size to Fit. CTRL + O

Show Actual Pixels. CTRL + ALT + O

Toggle full screen mode F or F11

Show Info. CTRL + I 

Show / Hide Grid. CTRL + ALT + ‘

Next Sheet. Right arrow
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1212 KEYBOARD SHORTCUTS
 Raster Preview Tool Toggle Shortcuts

The following Raster Preview tool toggle shortcut keys can be used.

 Window Menu Shortcuts

The following Window menu shortcut keys can be used.

Previous Side. Left arrow

First Side. Home

Last Side. End

Turn Sheet. CTRL + T

Previous Version CTRL + [

Next Version CTRL + ]

Color-Managed. ALT + C

Light Table. ALT + L

Toggle depth-map mode ALT + H

Toggle Web-growth compensation mode ALT + G

Display annotations ALT + A

Toggle the display of the selected Rule-
ups.

ALT + R

Press Sheet. ALT + P

Device Output. ALT + D

Transform -> Rotate 90 CW. ALT + T

Transform -> Rotate 90 CCW. ALT + SHIFT + T

Transform -> Flip Horizontal. ALT + F

Transform -> Flip Horizontal. ALT + SHIFT + F

Invert ALT + SHIFT + I

To... Press (Windows)

To... Press (Windows)

Toggle on/off the Marquee tool. M

Toggle on/off the Hand tool. H

Toggle on/off the Zoom tool. Z

Toggle on/off the Measurement tool. I

To... Press (Windows)

Minimize the current window. N/A

Display the System Overview. CTRL + 1 

Display the Hot Tickets window. CTRL + 2 

Display the Jobs window. CTRL + 3 
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 KEYBOARD SHORTCUTS 1213
 Help Menu Shortcuts

The following Help menu shortcut keys can be used.

Layout Editor and 
Product Editor

 Menu Shortcuts

Display the Message Board. CTRL + 4

Display Info for <selected item>. CTRL + I

Display Activity for <selected item>. CTRL + J

Display Remarks CTRL + R

Palettes: Show Navigator CTRL+ ALT+ A

Palettes: Show Inks CTRL+ ALT+ I

Palettes: Show Rule-ups CTRL+ ALT+ U

Palettes: Show Versions CTRL+ ALT+ V

Palettes: Hide Tools CTRL+ ALT+ T

Display the Log for <selected item>. CTRL + L

Cycle forward through Windows or Raster 
Preview palettes.

TAB

Cycle backward through Windows or Ras-
ter Preview palettes.

N/A

Display Problem Report for selected job. CTRL + SHIFT + I

Display Preflight Report for selected job. CTRL + E

To... Press (Windows)

To... Press (Windows)

Display the Apogee Help. F1

Display the What’s This? Help. SHIFT + F1

To Press

Add Product CTRL + SHIFT + O

Get Info CTRL + I

Show Preflight Report CTRL + E

Open in Production Center CTRL + SHIFT + M

Open in Production Dashboard CTRL + SHIFT + D

Submit CTRL + SHIFT + G

Undo last action CTRL + Z
Apogee Reference Guide



1214 KEYBOARD SHORTCUTS
Redo last undone action CTRL + Y

Remove selected object(s) and store in clipboard CTRL + X

Copy selected object(s) to pasteboard CTRL + C

Paste contents of pasteboard: frame or group onto a sheet, separation 
on a product.

CTRL + V

Delete selected object(s). Del

Place additional copy of the placed items on the sheet in the next 
available position. If there is not enough room, the items will be added 
into a new sheet.

CTRL + D

Step and Repeat CTRL + ALT + S

Create or Edit Grid. CTRL + ALT + G

Select All CTRL + A

Select None CTRL + SHIFT + A

Group the selected items CTRL + G

Ungroup the selected items CTRL + U

Auto-Layout Products CTRL + N

New Empty Sheet Layout/Printer Layout CTRL + SHIFT + N

Rearrange frames on a sheet layout/sheet layouts on a printer layout CTRL + SHIFT + F

Rearrange all frames in job CTRL + ALT +SHIFT + 
F

Reapply marks CTRL + ALT + SHIFT + 
M

Reapply all mark sets in Job CTRL + SHIFT + M

Fix bleed overlaps CTRL + ALT + M

Zoom into layout CTRL + +
OR
CTRL + mouse wheel

Zoom out of layout CTRL + -
OR
CTRL + mouse wheel

Zoom to fit layout in window CTRL + 0 (zero)

Display the System Overview. CTRL + 1 

Display the Jobs window. CTRL + 3

Open the Media Hub CTRL + ALT + 1

Open the Finishing Hub CTRL + ALT + 2

Open the Mark Engraver CTRL + ALT + 3

Open the Sheet Sizes CTRL + ALT + 4

Open the Page Sizes CTRL + ALT + 5

Open the Color Books CTRL + ALT + 6

Open the Sheet Layout Templates CTRL + ALT + 7

To Press
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 KEYBOARD SHORTCUTS 1215
 Placing and arranging images on a sheet

NOTE: Some of these shortcuts can also be used for placing sheets on printer 
layouts.

Align pin sets CTRL + ALT + 8

Show/hide the Snag List CTRL + R

Show/hide View Options CTRL + SHIFT + E

Show/hide Presets CTRL + SHIFT + P

Show/hide Inspector Panel CTRL + SHIFT + I

Show/hide Product Panel CTRL + ALT + I

Open the Job Set-up Inspector ALT + 1

Open the Frame Inspector ALT + 2

Open the Color Inspector ALT + 3

Open the Mark Sets Inspector ALT + 4

Open the Sheet Inspector ALT + 5

To Press

To Drag the image and

Place one or more images at the cursor position without ganging them. Hold SHIFT and 
release

Switch between snapping to margins (magenta snap guides) and snap-
ping to edges (blue snap guides).

Press ALT

Restrain movement horizontally and vertically. Hold SHIFT

Cancel the image placement. Press ESC

Rotate one or more images 90° counterclockwise, while moving them Press space bar once

Copy a selected image. Press CTRL + C

Paste a copied image. Press CTRL + V

Center an image on the current sheet or on a new sheet if the current 
one is not empty. Multiple selected images are centered on individual 
sheets.

Press C

Center an image on the current sheet even if it is not empty. Multiple 
selected images are centered on individual sheets.

Press SHIFT + C

Duplicate one or more selected images according to the copy count 
and gang the images on the current and new sheets.

Press N

Duplicate one or more selected images according to the copy count 
and gang the images on the current and new sheets but starting at the 
cursor position.

Press SHIFT + N
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 Toolbar tools

Duplicate one or more selected images according to the copy count 
and center the images on the current sheet if empty and on new 
sheets.

Press N + C or
Press SHIFT + N + C

Duplicate the selected image and fill the current sheet if empty. Fill 
one sheet for each image if multiple images are selected.

Press F

Duplicate a selected image and gang the images with existing images 
on the current sheet to fill the sheet. Selecting multiple images fills 
multiple sheets.

Press SHIFT + F

Duplicate the selected image and fill and center on the current sheet if 
empty. Fill one sheet for each image if multiple images are selected.

Press F + C or
Press SHIFT + F + C

Rotate the selected image or images clockwise. Press R

Rotate the selected image or images counterclockwise. Press SHIFT + R

Mirror the selected image or images clockwise. Press M

Mirror the selected image or images counterclockwise. Press SHIFT + M

To Drag the image and

Selection tool: To select a component or area and display its properties. 
This is the default tool.

A

Single Instance Selection tool: To select a single instance of marks 
which are placed at various locations, or part of a compound mark. In 
the Paths inspector: selects a path and its anchor points.

D

Pan tool: To pan layouts in the Layout Editor. H

Zoom tool: To zoom into a specific area of a layout. Z

Frame tool: To draw empty frames on a sheet. F

Measurements tool. Use this tool to make measurements on the Press 
Sheet.

ALT+ M

Clear Measurements tool (only activated if the sheet has measure-
ments). Click to remove all measurements displayed on the Press 
Sheet.

CTRL + ALT+ M

View Options palette button: Shows/hides the View Options palette. CTRL SHIFT+E

Marks palette button: Shows/hides the Marks palette. CTRL+M

Presets (Licensed feature): To open the Presets dialog box. CTRL SHIFT+P

Crop image: Activates the crop mode to crop an image (Image inspec-
tor in the Product Editor).

K

Split tool: Activates the Split tool to split an image into tiles (Tiling 
inspector in the Product Editor).

K

Pen tool: Activates the Pen for drawing free-form paths on an image 
and adding/deleting points of existing paths (Paths inspector in the 
Product Editor).

P
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 Split Tool Shortcuts

Activate the Split tool by pressing K with the Tiling inspector selected. To control 
the splitting of tiles selected with the Split tool, use the following shortcuts.

 Path Editing Shortcuts

In the Paths inspector, activate the Pen tool by pressing P, the Rectangle tool 
with R and the Ellipse tool with L. To draw paths with these tools, use the 
following shortcuts.

 Positioning Toolbar Shortcuts

To control the Positioning toolbar when a tile is selected with Selection tool:

Ellipse Path tool: Activates the Ellipse Path tool to draw ellipse and cir-
cle paths on an image (Paths inspector in the Product Editor).

L

Rectangle Path tool: Activates the Rectangle Path tool to draw rectan-
gle paths on an image (Paths inspector in the Product Editor).

R

Zoom slider with Zoom to fit and Zoom to maximum buttons, and drop-
down list with zoom presets

CTRL +/-

To Press

Change the splitting orientation (the magenta splitting line) Space bar or TAB key 
once

Extend the splitting action across all tiles Hold SHIFT

Repeat the split. CTRL

Cancel the image splitting ESC

To Press

Draw a square with the Rectangle tool R

Draw a circle with the Ellipse tool L

To

Open the Split Tile dialog box CTRL + U

Mirror the tile vertically when placed on a sheet SHIFT + M

Mirror the tile horizontally when placed on a sheet M
Apogee Reference Guide



1218 KEYBOARD SHORTCUTS
Apogee Impose These shortcuts apply for the Apogee Impose module.

 Quick Access to the Product and Press Sheet Views

The following shortcuts provide quick access to the Product View or Press Sheet 
View.

 Tools in Product View

Rotate the tile clockwise in steps of 90° SHIFT + R

Rotate the tile anticlockwise in steps of 90° R

Merge the selected tiles CTRL+ G

Place the cursor in the first Overlap box of the Positioning toolbar O

Place the cursor in the first Gap box of the Positioning toolbar G

Jump to next box in the Positioning toolbar TAB

To

To... Press (Windows)

Select a job in the Jobs List and jump to the Product View CTRL + SHIFT + Enter

Jump to the Product View while in the Job Ticket Editor CTRL + SHIFT + Enter

View a flat you selected in the Results tab in the Product View CTRL + SHIFT + Enter

View a flat you selected in the Results Preview in the Product View CTRL + SHIFT + Enter

Return to the Job Ticket Editor from the Product View ALT + F4

Close the Product View and submit the Job Ticket CTRL + SHIFT + G

Jump to the Press Sheet View from the Product View, with a Press 
Sheet selected in the Press Sheet or Press nodes 

CTRL + Enter

To... Press (Windows)

Switch to the Select Tool ALT + A

Switch to Split Assembly Tool ALT + S

Temporarily switch to the Split Assembly Tool Hold ALT

Split into multiple blocks (with Split Assembly Tool selected) Hold CTRL

Switch to the Split Assembly Tool and split an assembly in multiple 
blocks

Hold ALT + CTRL

Split a stacked signature horizontally, splitting off inserted child nodes. Hold + SHIFT

Repeat Step and repeat a placed fold sheet or element interactively ALT + R

Repeat the selected Fold Sheet (Repeat tool) CTRL + ALT + S

Open the Auto Impose window in the Product View CTRL + N
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 Tools in Press Sheet View

Rotate a Fold Sheet 90 degrees counterclockwise (must be selected on 
a Press Sheet)

CTRL + ALT + SHIFT + 
T

Rotate a Fold Sheet 90 degrees clockwise (must be selected on a Press 
Sheet)

CTRL + ALT + T

Flip a Fold Sheet (must be selected on a Press Sheet) CTRL + ALT + F

Rotate a Fold Sheet 180 degrees (must be selected on a Press Sheet) CTRL + ALT + Y

Show/Hide Inspector CTRL + I

Show/Hide Mark Set Inspector CTRL + SHIFT + I

Show/Hide Positioning Palette CTRL + |

Repeat the layout of an imposed Press Sheet to other Sheets CTRL + ALT + R

Show/Hide Assembly pane CTRL + ALT + 1

Show/Hide Fold Sheets CTRL + ALT + 2

Show/Hide Part/Fold Sheet details CTRL + ALT + 3

To... Press (Windows)

To... Press (Windows)

Switch to the Select Tool ALT + A

Select segments or individual instances of an item. ALT + D

Switch to the Pan Tool ALT + H

Switch to the Zoom Tool ALT + Z

Switch to Measurement Tool ALT + M

Clear any measurements from a Press Sheet CTRL + ALT + M

Show/Hide Inspector CTRL + I

Show/Hide Mark Set Inspector CTRL + SHIFT + I

Show/Hide Positioning Palette CTRL + |

Show/Hide Marks Palette CTRL + M

Show/Hide View Options CTRL + E

Go to previous sheet (Sheet View) CTRL + left arrow

Go to next sheet (Sheet View) CTRL + right arrow

To turn the Press Sheet: flip front to back (Turn Press Sheet tool) CTRL + T

Switch Light Table mode on and off CTRL + L

Temporarily switch to the Measurement Tool Hold ALT

Temporarily switch to the Pan Tool Hold space bar

Zoom into Press Sheet CTRL +
OR
CTRL + mouse wheel

Zoom out of Press Sheet CTRL -
OR
CTRL + mouse wheel
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 Navigating Multiple Products in the Products Tab

The following shortcuts apply if you have more than one product in the products 
list (multi-product jobs).

 Menu Shortcuts

Zoom to fit Press Sheet in window CTRL + 0 (zero)

Close the selected gaps (Sheet View) CTRL+.

Copy a mark CTRL+ drag

To... Press (Windows)

To... Press (Windows)

Go to the next item in the list CTRL + Down arrow

Go to the previous item in the list CTRL + Up arrow

Go to the next item of the same level in the list CTRL + SHIFT + Down 
arrow

Go to the previous item of the same level in the list CTRL + SHIFT + Up 
arrow

Go to the next cover part c or C

Go to the next plain or insert part b or B

To... Press (Windows)

Open the Auto Impose window in the Product View CTRL + N

Return to the Job Ticket Editor from the Product View ALT + F4

Submit a job CTRL + SHIFT + G

Undo an action (unlimited) CTRL + Z

Redo the last change CTRL + Y

Remove Mark Del

Select all CTRL + A

Select none CTRL + SHIFT + A

Repeat the layout of an imposed Press Sheet to other Sheets CTRL + ALT + R

Re-apply Mark Sets (manual marks are removed and marks sets are 
placed according to conditions

CTRL + SHIFT + M

Flip a Fold Sheet (must be selected on a Press Sheet) CTRL + ALT + F

Rotate a Fold Sheet 90 degrees clockwise (must be selected on a Press 
Sheet)

CTRL + ALT + T

Rotate a Fold Sheet 90 degrees counterclockwise (must be selected on 
a Press Sheet)

CTRL + ALT + SHIFT + 
T

Rotate a Fold Sheet 180 degrees (must be selected on a Press Sheet) CTRL + ALT + Y
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Repeat the selected Fold Sheet (Repeat tool) CTRL + ALT + S

Close the selected gaps (Sheet View) CTRL+.

Show/Hide Run List Indexes: switches between absolute run list index 
and page numbering per part

CTRL + SHIFT + N

Zoom into Press Sheet CTRL +

Zoom out of Press Sheet CTRL -

Zoom to fit Press Sheet in window CTRL + 0 (zero)

Show the current selection (orange highlight draws attention to the 
selected items and scrolls or zooms if they are off-screen)

CTRL + *

Show/Hide Assembly pane CTRL + ALT + 1

Show/Hide Fold Sheets CTRL + ALT + 2

Show/Hide Part/Fold Sheet details CTRL + ALT + 3

Show/Hide Page Previews CTRL + SHIFT + T

Show/Hide Measurements CTRL + SHIFT + R

Compact View CTRL + SHIFT + K

Show PressSheet View CTRL + Enter

Show the Inspector CTRL + I

Show/Hide Mark Set Inspector CTRL + SHIFT + I

Show/Hide Marks Palette CTRL + M

Show/Hide View Options CTRL + E

Show/Hide Positioning Palette CTRL + |

Show the Snag List CTRL + R

System Overview CTRL + 1

Hot Tickets CTRL + 2

Jobs CTRL + 3

Message Board CTRL + 4

Show/Hide all the marks and inspector pallets F4

To... Press (Windows)
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APPENDIX
C Icons Overview

This section contains a list of icons that appear in the user interface.

 Main Windows ............................................................................................ 1224
 Apogee Impose .......................................................................................... 1243
 Layout Editor and Product Editor ......................................................... 1248
1223



1224 ICONS OVERVIEW
Main Windows

Job Notification Icons

Job Status Icons (including
Page Store jobs)

The Apogee system issued a critical system message.

The job has stopped pending user interaction.

The job has generated an error, and has stopped.

The job has generated a warning.

WebApproval remark: A remark on this job (or results) has been received from WebApproval.

The job has generated an information message.

The job is being archived or dumped.

The job is being imported from archive.

The job is being deleted.

Apogee is queuing all commands for this job.

The document is being edited (it is ‘checked out’).

The job is being edited by another user.

The Run List is being edited by another user.

You are editing the job. 

You are editing the Run List.

The job is finished.

The job was broken during editing. You can remove this icon by opening the job for editing.
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The job has been manually put on hold.

The job output is waiting for the correct media to be loaded on the output device.

The job is waiting for a Task Processor (none currently available).

A group of results is complete, and is waiting to be printed (blue icon).

The result is waiting for a hard proof.

The result is waiting for a web proof.

The job is waiting for a soft proof.

A task has been aborted.

The task has been manually put on hold.

New (unplaced) documents are available in the (Private) Page Store.

The job is waiting for results.

Not all the results of a group are yet available (green icon).

The job is waiting for After Hours processing.

Some results have been rejected by the user.

The layout/imposition is not yet defined.

The job has reached a Milestone: The Run List is not complete. This Milestone was set up in 
the Options tab.

The job has reached a Milestone: The job deadline has been reached. This Milestone was set 
up in the Options tab.

The job has reached a Milestone: The result is not available in time. This Milestone was set up 
using a Milestone Action in the Production Plan.

The job is managed by PlateMaker (ready to plate). The PlateMaker client will take care of fur-
ther plate production.

A job that has been merged
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Job Status Icons in Tab
Area (JTE only)

Job List Icons

A merged job: The job resulting from the merging of two or more other jobs.

Job is a recurring job.

A StoreFront job: The job was generated by StoreFront.

The job is being viewed by you or by another user (JTE only). 

The job is being edited by another user. 

You are editing the job. 

The selected job was being edited by you or by another user, but the edit session was broken 
(Jobs window only). You can remove this icon by opening the job for editing.

The job has remarks.

Job group.

Commercial job with incomplete Run List.

Commercial job with complete Run List.

Rush job (Commercial jobs only).

Commercial job with disabled input channel.

Commercial job is scheduled to be archived when it is finished (Options tab).

Commercial job has been archived.

Commercial job is scheduled to be deleted when it is finished (Options tab).
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Hot List Icons

Flow Icons

Commercial job has been deleted.

Commercial job is scheduled to be archived and deleted when it is finished (Options tab).

Commercial job has been archived and deleted.

Commercial Hot Ticket.

Commercial Hot Ticket with a disabled input channel.

Job that requires set-up by Printer (WebApproval jobs only)

Collecting Hot Tickets (tickets grouped in separate panel)

Main Output to a high resolution output device.

Main Output to a Sign and Display output device.

Imposition Proof: An optional flow which may be added to the Main Output flow, and is used 
for output to an imposition proofing device.

Page Proof: An optional flow which may be added to the Main Output flow, and is used for 
output to a page proofing device.

Export: An optional or alternate flow to the Main Output flow, used for exporting job results to 
file in PDF or PostScript format.

Public Page Store: An optional or alternate flow to the Main Output flow, used for storing job 
results in a Public Page Store.

Display: An optional or alternate flow to the Main Output flow, used to create job results for 
high-resolution soft proofing.

Digital Quick Strip (DQS): An alternate mode of operation which supports the PrintDrive DQS 
mode of Apogee Series3. In this mode, Apogee creates and renders the flat backgrounds and 
pages separately. These are then sent as separate items to PrintDrive. PrintDrive assembles 
the pages onto the backgrounds, and then outputs the results as an integral job.

Collecting Hot Ticket: Uses the Collect TP to collect images and create special Hot Tickets.
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Flow Icon Color Coding

Filter Buttons

Flow Control Actions

A white background color indicates that this flow is idle. 

A green background color indicates that this flow is currently active. 

A blue background color indicates that this flow is on hold.

A yellow background color indicates that this flow contains tasks which are queued and wait-
ing to be processed.

A white background color with a green checkmark indicates that this flow has finished. 

A red background color indicates that this flow has generated an error.

A purple background color indicates that further handling of this flow has been taken over by 
PlateRunner (Main flow only). For more details, refer to the PlateRunner documentation.

Job Filter not applied.

Job Filter applied.

Discard

Wait for Results

Web Proof

Soft Proof

Hard Copy Proof

Collect for Output

After Hours
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Result Actions

Page Store / Run List Icons

Keep Result

Archive Result

Notify

Milestone

PDF / PostScript composite document.

PDF / PostScript composite page.

PDF / PostScript pre-separated document.

PDF / PostScript pre-separated page.

Raster composite document.

Raster composite page.

Raster pre-separated document.

Raster pre-separated page.

A red-colored icon indicates that the document or page has been processed with errors.

An icon with a red stripe indicates that the document or page has been rejected.

A blue-colored icon indicates that the document or page is on hold.

A Public Page Store (Page Store only).

Empty placeholder (Run List only).

Blank page (Run List only).
Apogee Reference Guide



1230 ICONS OVERVIEW
PDF Layer icons (Versioning
jobs)

Job processing is not yet complete in the Production Plan before the Run List.

Unknown document.

Page imposition has been adjusted (Run List only).

(in Run List status column of normal job). The page has a preflight report. Clicking on the icon 
will open the report in your PDF viewer.

(in Run List status column of versioning job). One or more pages in this row have a preflight 
report. Clicking on the icon will bring up a menu which contains the titles of the objects to 
which the preflight reports are attached. Selecting one of the menu items opens the report in 
your PDF viewer.

(in Run List status column of job). The page has generated a preflight error. Clicking on the 
icon will open the Problem Report.

(in Run List status column of job). The page has generated a preflight warning. Clicking on the 
icon will open the Problem Report.

PDF is certified.

PDF is not certified.

Document is being edited interactively within Apogee using the Check-Out plug-in for Acro-
bat or any other PDF Viewer/Editor application such as the Amfortis Editor.

Document has been edited interactively within Apogee using the Check-Out plug-in for Acro-
bat or any other PDF Viewer/Editor application such as the Amfortis Editor.

Document page size does not match the page trim size set for the product or part.

A single PDF layer from a page, without errors.

A single PDF layer from a page, with errors.

A single PDF layer from a page, on hold before reaching the Run List.

A single PDF layer from a page, which has been rejected.
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Plate Set Indicators
(Versioning jobs)

Extended Page Adjustment
Icons

A full bar indicates that one or more of the side versions to which this page contributes will 
have a full set of plates made.

A half full bar indicates that one or more of the side versions to which this page contributes 
will have a partial set of plates made.

An empty bar indicates that none of the side versions to which this page contributes will have 
any plates made.

Center Offset Scale Rotate

Horizontal

Vertical

Both

Auto-center

90

180

270
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Results - Job Layout
Thumbnails

A thumbnail view of this page is either not available, or is currently being 
retrieved from the Apogee System (green background color).

Page has been processed successfully (no background color).

Page has been processed successfully, and is on hold pending approval 
(blue background color).

Page has been processed with errors (red background color).

Page is managed by the PlateMaker Client, and is ready to plate (purple 
background color).

Page has been processed successfully, but has been rejected.
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Results - Data Indicators

Page has been discarded.

An empty page in the Run List (white background with a cross).

A blank page in the Run List (white background).

The page/flat belongs to a proofing workflow or a layout job, and is a composite file (i.e., not 
a separation). The page/flat has been rendered, and is ready for output.

The page/flat belongs to a proofing workflow or a layout job, and is a composite file (i.e., not 
a separation). The check mark indicates that it has been successfully printed.

A square gray-colored indicator in the lower right corner of the page indicates that all separa-
tions have been fully rendered and are ready for previewing or output. Visible for DQS and 
Raster Impose results when you choose View > Show > Page Rendered.

A small fold in a corner of a page indicates the orientation. The position of the fold tells you 
where the top of the page is.The orientation of a page may vary in an imposition layout.

The job or flow is finished.
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Results - Job Layout Action
Icons

Results - Job Layout Action
Icon Status

The job’s Production Plan contains an After Hours Action. When this point is reached, the job 
results are held (written to disk) pending the specified time.

The job’s Production Plan contains a Soft Proof Action. When this point is reached, the job 
results are held (written to disk) pending approval/rejection of a Digital Film preview by the 
user.

The job’s Production Plan contains a Hard Copy Proof Action. When this point is reached, the 
job results are held (written to disk) pending approval/ rejection of a hard copy proof by the 
user.

The job’s Production Plan contains a Ready for Plating Action. When this point is reached, the 
job results are taken over and managed by PlateRunner (ready to plate).

The job’s Production Plan contains a Collect for Output Action. When this point is reached, 
the job results are held (written to disk) pending user intervention.

The job’s Production Plan contains a Waiting for Results Action. When this point is reached, 
the job results are held until the target flow or required pages are finished. 

The job’s Production Plan contains a Discard Action. When this point is reached, the job 
results are held until the specified pages have been automatically discarded.

The job’s Production Plan contains a Web Proof Action. When this point is reached, the job 
results are held (written to disk) pending approval/rejection of a Digital Film preview by the 
remote user.

Result will be frozen once it has been approved by the remote user.

Result has been frozen because it has been approved by the remote user.

The page or flat has not yet reached this Action.

The page or flat has reached this Action (blue background).

The page or flat has passed this Action (dimmed icon).
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Results - Separation/
Composite Indicators in a

Normal job

Results - Separation/
Composite Indicators in a

Versioning job

Square outlined separation indicator: 
• A process color separation is expected (it has not yet been rendered). In this example, it is 

the magenta separation.
• The background is available for an Apogee DQS job.

Square solid separation indicator: A process color separation has been rendered, and is ready 
for output. In this example, it is the magenta separation.

Checked separation indicator: The separation has been rendered, and has been successfully 
output. In this example, it is the magenta separation.

Dimmed separation indicator: The separation has been discarded, and will not be output.

Round outlined separation indicator: A spot color separation is expected (it has not yet been 
rendered). The outline color is the color of the expected spot color.

Round solid separation indicator: A spot color separation has been rendered, and is ready for 
output. The solid color is the spot color.

Checked separation indicator: The spot color separation has been rendered, and has been suc-
cessfully output.

Process colors known but not rendered (round separation indicators for spot colors).

Process color plates from this version to be output (round separation indicators for spot col-
ors).

Process color plates from other version to be remade for this version (round separation indica-
tors for spot colors).
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Versioning Icons in the
Results Tab

Render - Separate - Color
Separation Icons

Process color plates from other version reused, but not remade (round separation indicators 
for spot colors).

Process color plates from this version made (round separation indicators for spot colors).

Process color plates from reused (but not remade) version output (round separation indicators 
for spot colors).

Full bar at the side of the box: A full set of plates will be made for this side.

Half bar at the side of the box: A partial set of plates will be made for this version.

One or more version pages used by the side is not yet available (empty placeholder).

The background and all version pages used by the side are available, but the render data for 
the whole side is not yet complete.

All render data for the side is available, but not all plates have yet been produced.

Finished state: All plates for the side have been produced.

Error state: Processing of this side has been stopped by an error.

On Hold state: Processing of this side is waiting at a hold point.

This side or one of its separations or pages has been rejected.

This side has been discarded and will not be processed further.

The color definition was found in the Apogee Color Books.

The Emulate Overprint option is always on.

The Emulate Overprint option is always off.

The Emulate Overprint option is selected automatically.
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Imposition Linked Icon

Monitor Status

The color contains version-specific content.

The color does not contain version-specific content.

The color was found in the job.

The color was manually entered.

The color was manually entered and was found in the job.

The color is directly linked to the selected color

The color is indirectly linked to the selected color.

The color was found in the border or the imposition template.

The color was manually entered, with marks.

Mapped color name as defined by the Pantone mapping settings.

Special color: corresponds with an operation other than the contour-defining one.

Special color: varnish.

Special color: die line.

Special color: other.

Indicates that this section is part of a multiple-section signature.

The monitor status is up to date and the overall display rating is equal or greater than 90% 
(Excellent). 

The monitor status is up to date and the overall display rating is between 80% and 90% 
(Medium).

The monitor status is up to date and the overall display rating is less than 80% (Bad).

There is no monitor status, or it is out of date (Undefined).
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Remark Origin

Remark Type

Task Processor Color
Coding

Customer remark (WebApproval jobs only).

Printer remark (WebApproval jobs only).

An annotation remark created in WebApproval. Click the associated (blue -encircled) annota-
tion number to jump directly to the referenced location in Raster Preview. 

The job has been approved by the corresponding reviewer (printer, customer).

The job has been rejected by the corresponding reviewer (printer, customer).

A job remark.

A page remark.

Preflight remark

Preflight remark - warning

Preflight remark - error

Internal remark which cannot be seen by the customer

Remark has attachment (customer remarks only)

View file produced after preflight

View report produced by preflight

The Task Processor is ready, and is currently idle.

The Task Processor turns green when it is processing a task. For example, the Avantra Task 
Processor is busy processing a separation.

The Task Processor turns red if a processing error occurs. In this case an error notification is 
sent to the Message Board, explaining the nature of the error.
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Output Task Processor
Hardware Status

The Task Processor turns blue if it is offline.

When the Task Processor has been stopped (inactive), the icon will have horizontal stripes 
running through it. You can re-activate it by context-clicking on the icon and selecting Start 
from the context menu.

The Task Processor is starting up (moving horizontal stripes).

The Task Processor is locked, because you do not have a license to use it.

A purple arrow is attached to the Task Processor icon if:
• You have a remote license. This means that this Task Processor is not licensed to execute 

tasks: These tasks are processed remotely on another Apogee System. However, you can use 
this Task Processor to specify the settings in the Production Plan.

• A remote proofer is installed (as specified in the installer). The remote proofer is combined 
with the Remote Proofer Controller Task Processor.

Paused: The output engine is able to communicate, but cannot process any tasks. A user 
interaction has taken place on the device itself to trigger this status.

Disconnected: The output engine's cable has been unplugged.

Warning: The hardware engine requires attention (e.g. ink low), but can still receive tasks.

This platesetter is managed by PlateRunner. The yellow ‘sun’ patch indicates that the device 
is in attended state (i.e. A user is logged in to the PlateRunner application).

This platesetter is managed by PlateRunner. The gray ‘moon’ patch indicates that the device 
is in unattended state (i.e. no one is logged in to the PlateRunner application).

Error: The hardware engine requires attention - it cannot continue to receive and process 
tasks until the problem has been resolved (e.g. no ink). 
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Resource Status Icons

Apogee Archive Icons in
Windows Explorer

Apogee Ticket Icons in
Windows Explorer

Apogee Toolbar

Media: The icon is followed by a name: There is a cassette in the tray but it is not loaded (not 
active). However, it can be activated by Apogee. If the name is in bold, the cassette is loaded 
(active).

Media: The icon is followed by a name: There is a cassette in the tray but it is not loaded (not 
active). However, it cannot be activated by Apogee (manual intervention on the engine is 
required).

Media: There is no cassette in the tray.

Media: There is an unknown problem with the tray.

Dedicated Resource linked uniquely to a specific device: This Resource is not shared between 
other devices of the same type.

Archived Commercial job (.arch)

Archived Public Page Store job (.arch)

Saved Commercial Job Ticket(.ajt)

Saved Commercial Hot Ticket(.aht)

Submit job or submit changes to a job.

Delete the selected item.

Edit job.

View <selected item> (Job Ticket Editor only).

Make Blank (page in Run List - Job Ticket Editor only).

Give priority to processing the selected job (Rush job).
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Preview Palette Tools

Hold job, or put device offline (System Overview).

Resume a job on hold, or put device online (System Overview).

Continue processing <selected item>.

Reject <selected item>.

Reprocess job from first.

Re-image <selected item>.

Enables the selected Hot Ticket (Hot Tickets window only).

Disables the selected Hot Ticket (Hot Tickets window only).

Display information about <selected item>.

Marquee tool. Allows you to draw a rectangle in the Preview window by clicking and drag-
ging. The ink values for the selected region are measured and displayed in the Inks palette.

Hand tool. Pans the image, allowing you to view a page that exceeds the size of the Preview 
window. With this tool selected, click inside the Preview window and drag the image around.

Zoom tool. Zooms in to the next zoom level in the Preview window. You can zoom out by 
holding down the Alt key. Alternatively, you can click and drag to zoom into a specified area.

Measure tool. Measures raster angles, and distances between the raster points. You can also 
use it to calculate the line ruling of a separation.

Next tool: Displays the next side result (e.g. Cover Sig 1 Front > Cover Sig 1 Back > Cover Sig 
2 Front > Cover Sig 2 Back etc.). If you hold down the ‘C’ key while clicking the tool, Apogee 
displays the next sheet result (e.g. Cover Sig 1 Back > Cover Sig 2 Back > Cover Sig 3 Back).

Previous tool: Displays the previous side result. If you hold down the ‘C’ key while clicking 
the tool, Apogee displays the previous sheet result.

Turn Sheet tool. If your results have 2 sides (front and back), Raster Preview can switch 
between the two sides. Click this tool (Ctrl-T) to toggle the view (front or back). This tool is 
disabled if the result only contains one side.

Info tool. Display information about the selected item.

Light Table tool. Displays or hides blended front and back views of your raster data. This fea-
ture only works on the front and backs of the same signature/page.
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Other Buttons

Rule-Ups tool. Displays or hides additional layers of information on top of the Raster Preview 
image. The Rule/ups palette contains a table which lists the layers you can display.

Rotate clockwise tool. Rotates the current view 90 degrees clockwise. 

Rotate counterclockwise tool. Rotates the current view 90 degrees counterclockwise. 

Flip vertical tool. Flips the current view vertically. 

Flip horizontal tool. Flips the current view horizontally. 

Invert tool. Inverts the current view (negative).

Color Managed tool. Activates color-managed raster preview. This allows you to preview the 
rendered result using color management to convert the press color space to the monitor color 
space (based on ICC profiles). 

Show/Hide rulers tool. Shows/Hides ruler coordinates in the units set in your Preferences. 

Show/Hide grid lines tool. Shows/Hides grid lines for every major and minor division of the 
ruler. The default setting is specified in your Preferences.

Approve tool. Approves a previewed result. This tool is disabled if no soft preview has been 
requested.

Reject tool. Rejects a previewed result. This tool is disabled if no soft preview has been 
requested.

Task Processor Settings lock.

Edit 

Create New

Delete

Set as default

Duplicate

Export
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Customer Contact

Apogee Impose

Product View Tools

Import

Auto-fill (Versioning): Automatically fills the version table either with the names of the PDF 
layers or the names of the documents in the Page Store.

Insert variable

Approver

Uploader

Viewer

Candidate CSR (Customer Service Representative)

Preferred CSR (Customer Service Representative)

WebApproval account is inactive: the account exists but is not enabled.

WebApproval account is active: the account exists and is enabled.

PrintSphere account is inactive: the account exists but is not enabled.

PrintSphere account is active: the account exists and is enabled.

Press Sheet View button. Select a Press Sheet or Press Sheet side in the Press Sheet or Press 
nodes and click this button to open the Press Sheet View and view the selected Press Sheet 
side.

Selection tool. Use this tool to select a component or area and display its properties. This is 
the default tool.

Split Assembly tool. Use this tool to split blocks in the Assembly.

Repeat tool. Use this tool to repeat selected components.

Auto Impose button. Click this button to perform the Auto Impose task, for example after rear-
ranging nodes or changing the properties of a Fold Sheet, Press Sheet or Press.

Rotate counterclockwise tool (only if Fold Sheet is selected). Rotates selected Fold Sheets 90 
degrees counterclockwise on the Press Sheet. 
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Sheet View Tools

Rotate clockwise tool (only if Fold Sheet is selected). Rotates selected Fold Sheets 90 degrees 
clockwise on the Press Sheet. 

Flip Over tool (only if Fold Sheet is selected). Flips the front and back of the selected Fold 
Sheet on the Press Sheet.

Shows/Hides the Inspector window

Shows/Hides the Mark Sets Inspector window.

Shows/Hide the Positioning palette

Submit button. Submits the job with the edited imposition.

Close button. In the imposition windows, saves your changes and closes the imposition win-
dow. Behavior is set in the Preferences.

Product View button. Return to Product View from Press Sheet View.

Selection tool. Use this tool to select a component or area and display its properties. This is 
the default tool.

Single Instance Selection tool. Use this pointer tool to select a single instance of marks 
which are placed at various locations on the Press Sheet, or part of a compound mark.

Pan tool: To pan layouts in the Layout Editor.

Zoom tool: To zoom into a specific area of a layout.

Measurements. Use this tool to make measurements on the Press Sheet.

Clear Measurements (only activated if the sheet has measurements). Click to remove all mea-
surements displayed on the Press Sheet.

Shows/Hides the Inspector window

Shows/Hides the Mark Sets Inspector window.

Shows/Hide the Positioning palette

Marks Palette button: shows/hides the Marks Palette

View Options Palette button: shows/hides the View Options Palette

Go to previous Press Sheet or web

Go to next Press Sheet or web
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Page Icons

Node Icons

Turn Sheet button. In the Press Sheet View, click to view the other side of a Press Sheet.

Light Table.

Zoom slider with Zoom to fit and Zoom to maximum buttons, and drop-down list with zoom 
presets

Submit button. In the Press Sheet View, closes the window and submits the job without 
returning to the Product View.

Pages not assigned to signature (grey outline)

Pages assigned to signature (black outline)

Shingling applied (black arrows)

No shingling applied

Bleed (thick grey border on bleed side)

Glue zones (blue strips indicate non-image areas)

No spine (unbound product)

Double-sided part (unbound product - Fold Sheet node)

The initial node definition has been overruled (yellow background if only gutters and/or mar-
gins have changed).

The node contains an error that needs to be resolved.
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Apogee Impose - Mark
Types

Circle Mark: draws a circle with or without fill color

Collation Mark: stepped blocks with the signature number which are used to inspect the cor-
rect collation order of folded sheets

Cut Mark: a horizontal and a vertical line in the corners of a Fold Sheet to indicate the bound-
aries of the Fold Sheet and where it is to be cut

Cut-off Mark: lines at the cut-off between Web Production Schemes, on the left and right 
sides of the web

File Mark: places a specific EPS or PDF file as a mark

Fold Line: draws a set of vertical or horizontal lines that indicate where to fold the sheet or 
the page.

Line Mark: draws a line

Crop Mark: a horizontal and a vertical line to indicate where the page has to be cropped

Rectangular Mark: draws a rectangle with or without fill color

Registration Mark: draws a series of marks which are used to check that the registration of the 
different printing colors is correct

Text Mark: prints the job name, order number, color name, etc. on the Press Sheet

Slit Mark: draws a line to indicate where a press sheet is to be cut in ribbons for web printing

Density Bar: draws bars of equal density across the full width of the press sheet or along the 
edges. 

Cross Mark: indicates the crosspoint of two gutters, or at the endpoint of a gutter.

Page Fold Line: draws a set of vertical or horizontal lines that indicate where to fold on a 
single page element.
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Apogee Impose - Mark Set
Conditions

Part Types (Products tab)

Mark Set is always applied

Mark Set is only applied manually

Mark set is applied when all/some criteria are met

Mark set is applied partially (mark deleted manually for example)

None of the marks of the mark set are applied (marks deleted manually for example).

Bound product

Cover part

Plain part

Insert part

Unbound, flat, single-sided product

Unbound, flat, double-sided product

Unbound, folded, single-sided product

Unbound, folded, double-sided product

Unbound product with different part types

Calendar product

Sign and Display product
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Layout Editor and 
Product Editor

Product Status

The design of the product has a contour-defining operation (other than the frame or trim-box).

The product is double-sided.

At least one of the product’s artworks was rejected. In addition, the thumbnail of the rejected 
artwork is shown with a red diagonal line.

At least one of the product’s artworks has remarks other than rejected.

At least one of the product’s artworks could not be aligned to the design.

At least one of the product’s artworks could not be aligned to the design with great 
confidence.

The product is Locked or Uniform.

The product requires vertical or horizontal Grain/Flute and there are no placed instances that 
violate that requirement.

The product requires vertical or horizontal Grain/Flute, but at least one placed instance 
violates that requirement.

The product has white content, either from the artwork or generated.

The product has varnish content, either from the artwork or generated.

The product has primer content, either from the artwork or generated.

The image is being edited via an external editor.

Indicates that full-gamut color management is applied.

‘F’ shows the effects of the rotation and mirror attributes (here shown with 90 degrees 
rotation and no mirroring.

Indicates a preflight report has been generated for the image.

Image preview has been generated (gray) or is being processed (green).

Color adjustments (saturation, contrast, curves) have been made in Preview.
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Colors Inspector

Tools

The product has Image Operations that prevent changing the product’s size (tiling, canvas 
extensions, etc.).

There is a notification or snag message present on the product. The icon depicts the severity 
of the status: error, warning or intervention required.

The color will be printed/output (‘Print as’ check box selected).

The color will not be printed/output (‘Print as’ check box not selected).

The color is a process color or will be printed as a process color.

The color is a spot color, varnish or white.

The color is mapped to a color from a color book.

The color is taken from the application.

The color is mapped to a finishing operation.

The color is mapped to a custom color.

The color is mapped automatically as defined for the colors of the device.

The color is mapped to and depends on another color in the list.

Selection tool: To select a component or area and display its properties. This is 
the default tool.

Single Instance Selection tool: To select a single instance of marks which are 
placed at various locations, or part of a compound mark. In the Paths inspector: 
selects a path and its anchor points.

Pan tool: To pan layouts in the Layout Editor.

Zoom tool: To zoom into a specific area of a layout.

Frame tool: To draw empty frames on a sheet.

Measurements tool. Use this tool to make measurements on the Press Sheet.
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Sheet Layout

Mark Types

Clear Measurements tool (only activated if the sheet has measurements). Click 
to remove all measurements displayed on the Press Sheet.

View Options palette button: Shows/hides the View Options palette.

Marks palette button: Shows/hides the Marks palette.

(Licensed feature) Presets: To open the Presets dialog box.

Crop image: Activates the crop mode to crop an image (Image inspector in the 
Product Editor).

Split tool: Activates the Split tool to split an image into tiles (Tiling inspector in 
the Product Editor).

Pen tool: Activates the Pen for drawing free-form paths on an image and add-
ing/deleting points of existing paths (Paths inspector in the Product Editor).

Ellipse Path tool: Activates the Ellipse Path tool to draw ellipse and circle paths 
on an image (Paths inspector in the Product Editor).

Rectangle Path tool: Activates the Rectangle Path tool to draw rectangle paths 
on an image (Paths inspector in the Product Editor).

Zoom slider with Zoom to fit and Zoom to maximum buttons, and drop-down 
list with zoom presets

Unlocked sheet layout/frame

Locked sheet layout/frame.

Circle Mark: draws a circle with or without fill color

Collation Mark: stepped blocks with the signature number which are used to inspect the cor-
rect collation order of folded sheets

Cut-off Mark: lines at the cut-off between Web Production Schemes, on the left and right 
sides of the web

File Mark: places a specific EPS or PDF file as a mark

Fold Line: draws a set of vertical or horizontal lines that indicate where to fold the sheet

Fotoba Mark: draws horizontal and vertical lines to enable cutting with a Fotoba cutting 
device.
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Mark Set Conditions

Grommet Mark: draws sequential marks along the sides of an image or layout. These marks 
are printed on the layout and indicate where reinforced eyelets can be produced.

Cutter Registration Mark: draws reference dots to enable cutting with X/Y cutting devices.

Line Mark: draws a line

Crop Mark: a horizontal and a vertical line to indicate where the page has to be cropped

Rectangular Mark: draws a rectangle with or without fill color

Registration Mark: draws a series of marks which are used to check that the registration of the 
different printing colors is correct

Station Number Mark: indicates the station of an instance of a product, i.e. its position on the 
sheet

Text Mark: prints the job name, order number, color name, etc. on the Press Sheet

Slit Mark: draws a line to indicate where a press sheet is to be cut in ribbons for web printing

Color Bar Mark: generates a bar of color patches, using the colors that are present on the 
press sheet (offset and wide-format) or in the product.

Density Bar: draws bars of equal density across the full width of the press sheet or along the 
edges. 

Ink-Eater Mark: places a background mark between the products or on the outside of the fold 
sheets. 

Mark Set is always applied

Mark Set is only applied manually

Mark set is applied when all/some criteria are met

Mark set is applied partially (mark deleted manually for example)

None of the marks of the mark set are applied (marks deleted manually for example).
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APPENDIX
D Context Menu Commands

This section lists the context menu commands.

NOTE: If a menu item is not available in a particular context, it is displayed as 
grayed-out.

 Job List Context Menu Commands ............................................................ 1254
 Job List Filter Context Menu Commands ................................................. 1256
 Layout Editor ....................................................................................................... 1256
 Product Editor - Presets .................................................................................. 1257
 Hot Ticket List Context Menu Commands ............................................... 1258
 Page Store Context Menu Commands ...................................................... 1259
 Run List Context Menu Commands ........................................................... 1263
 Job Layout Context Menu Commands ...................................................... 1265
 Separations Context Menu Commands .................................................... 1269
 System Overview Context Menu Commands ......................................... 1271
 Activity Window Context Menu Commands ........................................... 1272
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Job List Context Menu Commands

You can directly issue commands by context-clicking on items in the Job List. 
The following table lists the items that may be displayed when you context-click 
a Job Folder or Job.

Context Menu Item Description

New From Selected Opens the Job Ticket Editor with an empty Administration tab but 
with the same plan, imposition, etc.

Save As... Allows you to save the job with a different name

Save As Template... Allows you the save the job as a Ticket Template.

Upload Document Allows you to add a file or a folder containing files to a job or Public 
Page Store. When you upload a folder, Apogee uploads all files and 
folders in that folder recursively. The uploaded folder appears as a 
subfolder in the Page Store.

Invite PrintSphere 
Uploader

Invites a collaborator to upload files for the job to the PrintSphere 
cloud server. Only for a PrintSphere job.

Submit Changes Submits the changes you have made to a job.

Archive Job Saves the selected job items to file (.arch).

Stop Archiving/Import-
ing

Stops archiving or importing the selected job.

Export... • Run List - Exports the entire run list as a single PDF file. A ”Save 
As’ dialog prompts for a location and file name (job name as 
default). Run list must be complete (blanks allowed).

• Job Dump - Similar to Archive Job, but only accessible by adminis-
trators for troubleshooting purposes (only for jobs, not for Hot 
Tickets).

• Job Log - Exports the log file for the selected job.
• Input JDF - Exports the input JDF that created the job.
• CAD Files - Export all CAD files (layout and 1-up) that were 

imported in the job.
• InkDrive - Exports the InkDrive files for the selected job (only 

available when the job has InkDrive files).
• File list - Exports a tab-delimited text file listing the used pages/

products.
• Imposition Layout - Exports the Imposition Layout and Marks files 

for the selected job (only available when the job has received lay-
out information 'from Input').

Open in ProductionCen-
ter

Opens the selected job in the ProductionCenter web application.

Open in Production Dash-
board

Opens the selected job in the Production Dashboard web applica-
tion

Delete Job Deletes the current job(s).

Edit Job Displays the selected job using the default editor (Job Ticket Editor 
or Layout Editor), where you can modify it.
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Edit Production Plan Opens the JTE Window in Production Plan tab for the selected job 
(Service access level only).

Edit Imposition Opens the Apogee Impose module to edit the imposition of the job.

Export Imposition Report Opens the Imposition Mock-up and Report dialog: see “Marks Pal-
ette” on page 427.

Duplicate Job Duplicates the selected job.

Select • All - Selects all jobs in the current view.
• None

Rush Job Upgrades the selected job to a Rush job.

High priority, Normal pri-
ority, Low priority

Changes the priority of the job as set in the Options tab to one of 
the three priorities.

Hold Job Suspends all processing of the selected job(s) after the current 
activity for the items has been allowed to finish. This option is dis-
abled if all items are already on hold.

Resume Job Resumes processing of the selected job(s). This option is disabled if 
all items are already running.

Clear and Rebuild Run 
List

Removes all pages from the run list and places them again accord-
ing to the file name conventions.

Restart Job Processing At Remakes all the existing job results which follow the selected point 
in the Production Plan. You may want to re-render a job if you have 
changed your resources (new fonts, color books, etc.) or if you want 
to remake aborted results, or remake output when no raster data is 
available

Enable Inputs Re-activates all input channels for the selected job(s). By default, 
input channels are enabled. This option is disabled if all job(s) have 
their inputs enabled.

Disable Inputs De-activates all input channels for the selected job(s). This option is 
disabled if all job(s) have their inputs disabled.

Mark as Finished Marks the selected job as finished, aborting all current processing 
and removing all outstanding tasks.

(Re)make Cut File for Job (Re)Makes the Cut file(s) for the selected item(s). Job must use cut-
ter that expects cut files.

Reveal Cut File for Job Open the directory containing the cut file and select the cut file(s) 
for the selected item (Disabled if there is no cut file for the selected 
item).

Send Cut File Sends the cut file of a layout job to the cutter.

Log for Job Opens a Log window for the selected job(s). You can open multiple 
Log windows.

Problem Report for Job Opens a Problem Report window for the job. You can open multiple 
Problem Report windows (PDF documents only).

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description
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Job List Filter Context Menu Commands

Layout Editor

The context menu commands are explained in the relevant section about the 
Layout Editor: see “Context Menus” on page 603.

Context Menu Item Description

Save As... Allows you to create a new custom job filter from the initial Custom 
Filter.

Edit Opens the Job Filter settings.

Rename Allows you to rename the selected custom job filter.

Duplicate Allows you to duplicate the selected custom job filter.

Delete Deletes the selected custom job filter.

Insert Divider Inserts a group divider under the last custom job filter.

Move Up/Down Moves the selected filter up or down in the list.
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Product Editor - Presets

The following commands are available in the Presets dialog by context-clicking 
a preset in the list:

Context Menu Item Description

Apply Applies the selected image preset to the open image

Apply to New Images Applies the default preset to all new images.

Edit Preset Unlocks the presets so you can edit them; in this edit mode you can 
clear or select the settings check boxes and update the preset to 
match the settings of the current image; any changes you make to a 
preset in edit mode are saved automatically

Rename Preset Lets you edit the name of the selected preset

Edit Description Places the cursor in the Description box of the selected preset

New Folder Creates a new folder where you can put new presets

New Job Preset Creates a new job preset

Duplicate Preset Duplicates the selected preset

Delete Preset Deletes the selected preset

Import Preset Opens a file browser where you can select a preset for importing

Edit Description Places the cursor in the Description box of the selected preset
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Hot Ticket List Context Menu Commands

You can directly issue commands by context-clicking on Hot Tickets in the Hot 
Ticket List. The following table lists the items that may be displayed when you 
context-click a Hot Ticket.

Context Menu Item Description

Save As... Allows you to save the ticket with a different name.

Save As Template... Allows you the save the ticket as a Ticket Template.

Export Hot Ticket PPD Create PPD for Hot Ticket - Allows you to create a PPD file for the 
selected Hot Ticket.

Upload Document Allows you to add a file to a Hot Ticket.

Invite PrintSphere 
Uploader

Shows the dialog box where you can invite someone to upload 
documents via PrintSphere.

Delete Hot Ticket Deletes the selected Hot Ticket.

Edit Hot Ticket Displays the selected Hot Ticket using the default editor, where you 
can modify it.

Edit Production Plan Opens the JTE Window in Production Plan tab for the selected job 
(Service access level only).

Edit Imposition Opens the Apogee Impose module to edit the imposition of the job.

Duplicate Ticket Duplicates the selected job and opens the result with the most 
appropriate editor.

Select • All - Selects all Hot Tickets in the current view.
• None

Enable Inputs Re-activates all input channels for the selected Hot Ticket(s). By 
default, input channels are enabled. This option is disabled if all Hot 
Ticket(s) have their inputs enabled.

Disable Inputs De-activates all input channels for the selected Hot Ticket(s). This 
option is disabled if all Hot Ticket(s) have their inputs disabled. A 
Hot Ticket cannot produce any jobs while disabled.

Log for Hot Ticket Opens a Log window for the selected Hot Ticket.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.
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Page Store Context Menu Commands

You can directly issue commands by context-clicking on items in the Page Store. 
The commands that you will see in the context menu depend on the item you 
select (page, document, or folder).

Page Store Folder The following table lists the items that may be displayed when you context-click 
a Page Store folder.

Page Store 
Document

The following table lists the items that may be displayed when you context-click 
a Page Store document.

Context Menu Item Description

Export Folder From • Latest (Page Store) - Exports the latest version of the selected PDF 
folder outside Apogee.

• <Task Processor name> - Exports a previous version of the 
selected folder from a preceding Task Processor in the Production 
Plan.

Delete Folder/Docu-
ments

Deletes the selected folder(s) / document(s) from the Page Store.

Select • All - Selects all folders in the current view.
• None

Create Versions Creates versions of the selected folder(s) / document(s) from the 
Page Store (only applicable for versioning jobs)

Page Labels Displays/Hides the Page Label column in the Run List.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.
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Context Menu Item Description

Export Document From • Latest (Page Store) - Exports the latest version of the selected PDF 
document outside Apogee, where the document can be edited, 
and then imported back into Apogee.

• <Task Processor name> - Exports a previous version of the 
selected PDF from a preceding Task Processor in the Production 
Plan.

View Document From • Latest <Task Processor name> - Displays the latest version of the 
selected document using the default viewer. 

• <Task Processor name> - Displays a previous version of the 
selected document from a preceding Task Processor in the Pro-
duction Plan.

You cannot edit the item.

Check Out and Edit 
Document

Opens the selected PDF editor and checks out the PDF document.

Info for Document From • Latest <Task Processor name> - Opens an Info window for the 
selected document(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
document(s) from a preceding Task Processor in the Production 
Plan. 

You can open multiple Info windows.

Upload Document Allows you to add a file or a folder containing files to a job, Hot 
Ticket or Public Page Store. When you upload a folder, Apogee 
uploads all files and folders in that folder recursively. The uploaded 
folder appears as a subfolder in the Page Store.

Delete Document Deletes the selected document(s).

Select • All - Selects all pages in the current view.
• None

Continue Document Continues all or part of a document that has stopped. The document 
may have stopped because it has reached a hold Action in its Pro-
duction Plan, or because it has been aborted, rejected, or in error.

Reject Document Rejects the selected document(s). All processing will be stopped for 
the rejected document(s).

Clear Rejected Status Removes the rejected status from a previously rejected document, 
and restarts processing.

Restart Document Pro-
cessing At

First <Task Processor name> - Remakes all the existing job results 
which follow the selected point in the Production Plan. You may 
want to re-render a document if you have changed your resources 
(new fonts, color books, etc.) or if you want to remake aborted 
results, or remake output when no raster data is available

Create Versions Creates versions of the selected document(s) from the Page Store 
(only applicable for versioning jobs)
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Page Store Page The following table lists the items that may be displayed when you context-click 
a Page Store page.

Preflight Report Generates a Preflight Report.

Page Labels Displays/Hides the Page Label column in the Run List.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description

Context Menu Item Description

Export Page From • Latest <Task Processor name> - Exports the latest version of the 
selected page. 

• <Task Processor name> - Exports a previous version of the 
selected page from a preceding Task Processor in the Production 
Plan.

View Page From • Latest <Task Processor name> - Displays the latest version of the 
selected page using the default viewer. 

• <Task Processor name> - Displays a previous version of the 
selected page from a preceding Task Processor in the Production 
Plan.

You cannot edit the pages.

Check Out and Edit 
Document

Opens the selected PDF editor and checks out the PDF page.

Info for Page From • Latest <Task Processor name> - Opens an Info window for the 
selected document(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
document(s) from a preceding Task Processor in the Production 
Plan. 

You can open multiple Info windows.

Upload Document Allows you to add a file or a folder containing files to a job, Hot 
Ticket or Public Page Store. When you upload a folder, Apogee 
uploads all files and folders in that folder recursively. The uploaded 
folder appears as a subfolder in the Page Store.

Select • All - Selects all pages in the current view.
• None
Apogee Reference Guide



1262 PAGE STORE CONTEXT MENU COMMANDS
Continue Page Continues a page that has stopped. The page may have stopped 
because it has reached a hold Action in its Production Plan, or 
because it has been aborted, rejected, or in error.

Reject Page Rejects the selected page(s). All processing will be stopped for the 
rejected page(s).

Clear Rejected Status Removes the rejected status from a previously rejected page, and 
restarts processing.

Create Versions Creates versions of the selected page(s) from the Page Store (only 
applicable for versioning jobs)

Preflight Report Generates a Preflight Report.

Page Labels Displays/Hides the Page Label column in the Run List.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description
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Run List Context Menu Commands

You can directly issue commands by context-clicking on items in the Run List. 
The commands that you will see in the context menu depend on the item you 
select (page, placeholder, or imposition adjustment).

The following table lists the items that may be displayed when you context-click 
a Run List page or placeholder.

Context Menu Item Description

Export Page From • Latest <Task Processor name> - Exports the latest version of the 
selected page. 

• <Task Processor name> - Exports a previous version of the 
selected page from a preceding Task Processor in the Production 
Plan.

View Page From • Latest <Task Processor name> - Displays the results of the 
selected page from the last Task Processor which processed it.

• <Task Processor name> - Displays the results of the selected page 
from a preceding Task Processor in the Plan.

The results are displayed using the default viewer. You cannot edit 
the page.

Info for Page From • Latest <Task Processor name> - Opens an Info window for the 
selected page(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
page(s) from a preceding Task Processor in the Production Plan. 

You can open multiple Info windows.

Delete Pages Deletes the selected page (Ticket Editor only).

Delete Page Adjustment When you click a page adjustment icon, this deletes the associated 
page adjustments only (Ticket Editor only).

Select • All - Selects all pages in the current view.
• None
• Even Positions - Selects all even placeholders/pages 
• Odd Positions - Selects all odd placeholders/pages 
• Empty Positions - Selects all empty placeholders
• Size

Find • Page in Page Store- Highlights the corresponding page in the 
Page Store.
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Page Adjustments • Offset By... - Allows you to adjust the offset of the selected page(s) 
/ placeholder(s).

• Scale By... - Allows you to adjust the scale of the selected page(s) 
/ placeholder(s).

• Rotate By... - Allows you to adjust the rotation of the selected 
page(s) / placeholder(s).

• View - Opens the Page Adjustments dialog box for the selected 
page(s)/placeholder(s). If you are not editing the job, the Adjust-
ments dialog box is read-only.

• Clear - Clears all adjustments.

Placeholder • Insert... - Allows you to insert or append placeholders.
• Make Blank - Puts a blank page in the selected placeholder(s).
(Ticket Editor only)

Comments Opens a dialog to enter Run List position comments.

Continue Page Continues all or part of a page that has stopped. The page may have 
stopped because it has reached a hold Action in its Production Plan, 
or because it has been aborted, rejected, or in error.

Reject Page Rejects the selected page(s). All processing will be stopped for the 
rejected page(s).

Clear Rejected Status Removes the rejected status from a previously rejected page, and 
restarts processing.

Preflight Report Generates a Preflight Report.

Extended Page Adjust-
ments

Extends the Adj column in the Run List to display extra icons (up to 
4 icons) which indicate specific page adjustments in the job.

Page Labels Displays/Hides the Page Label column in the Run List.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description
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Job Layout Context Menu Commands

You can directly issue commands by context-clicking on items in the Job Layout 
pane. The commands that you will see in the context menu depend on the item 
you select (flat or page in flat).

Flats The following table lists the items that may be displayed when you context-click 
a Flat.

Context Menu Item Description

Export Flat From • Latest <Task Processor name> - Exports the latest version of the 
selected flat. 

• <Task Processor name> - Exports a previous version of the 
selected flat from a preceding Task Processor in the Production 
Plan.

View Flat From • Latest <Task Processor name> - Displays the results of the 
selected flat from the last Task Processor which processed it.

• <Task Processor name> - Displays the results of the selected flat 
from a preceding Task Processor in the Plan.

The results are displayed using the default viewer. You cannot edit 
the flat.

Info for Flat From • Latest <Task Processor name> - Opens an Info window for the 
selected flat(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
flat(s) from a preceding Task Processor in the Production Plan. 

You can open multiple Info windows.

Select • Select All Flats - Selects all flats in the current view
• None
• Fronts - Selects all front sides when the view is set to “Fronts and 

Backs”.
• Backs - Selects all back sides when the view is set to “Fronts and 

Backs”.
• Signature - Selects all sides in the signature when the view is set 

to “Fronts and Backs”.

Continue Flat Continues all or part of a flat that has stopped. The flat may have 
stopped because it has reached a hold Action in its Production Plan, 
or because it has been aborted, rejected, or in error.

Reject Flat... Rejects the selected flat(s). All processing will be stopped for the 
rejected flat(s).

Edit Imposition Opens the Apogee Impose module to edit the imposition of the job.

Clear Rejected Status Removes the rejected status from a previously rejected flat, and 
restarts processing.
Apogee Reference Guide



1266 JOB LAYOUT CONTEXT MENU COMMANDS
Pages The following table lists the items that may be displayed when you context-click 
a Page.

Discard Flat Prevents the selected flat(s) from being printed, without stopping 
the rest of the job from being printed. Available only when the 
items are waiting on a Hold action or when finished.

Include Flat Includes a discarded flat.

Re-render Flat Remakes all the existing job results which follow the selected point 
in the Production Plan. You may want to re-render a flat if you have 
changed your resources (new fonts, color books, etc.) or if you want 
to remake aborted results, or remake output when no raster data is 
available

Re-image Flat Remakes previously imaged raster data (Digital Film) on your output 
devices. This feature is available only for flows that have an imaging 
output device and finished raster data.

Re-export Flat Re-exports previously exported results (when resources have 
changed or exported files have to be recreated).

Remake InkDrive for Flat Remakes InkDrive files for the selected flats.

Re-print Flat Remakes previously imaged raster data (Digital Film) on a digital 
press. This feature is available only for flows that have a digital 
press and finished raster data.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description

Context Menu Item Description

Export Page From • Latest <Task Processor name> - Exports the latest version of the 
selected page. 

• <Task Processor name> - Exports a previous version of the 
selected page from a preceding Task Processor in the Production 
Plan.

View Page From • Latest <Task Processor name> - Displays the results of the 
selected page from the last Task Processor which processed it.

• <Task Processor name> - Displays the results of the selected page 
from a preceding Task Processor in the Plan.

The results are displayed using the default viewer. You cannot edit 
the page.

Info for Page From • Latest <Task Processor name> - Opens an Info window for the 
selected page(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
page(s) from a preceding Task Processor in the Production Plan. 

You can open multiple Info windows.
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Delete Page (imposed 
pages only)

Deletes the selected page.

Select • Select All Pages- Selects all pages in the current view
• None
• Even Positions - Selects all even placeholders/pages 
• Odd Positions - Selects all odd placeholders/pages 
• Signature - Selects all sides in the signature when the view is set 

to “Fronts and Backs”.

Find • Page in Page Store- Switches to the Page Store and highlights the 
corresponding page.

Page Adjustments
(imposed pages only)

• Offset By... - Allows you to adjust the offset of the selected page(s).
• Scale By... - Allows you to adjust the scale of the selected page(s)
• Rotate By... - Allows you to adjust the rotation of the selected 

page(s)
• Edit/View - Opens the Adjustments dialog box for the selected 

page(s). If you are not editing the job, the Adjustments dialog box 
is read-only.

• Clear - Clears all adjustments.

Placeholder • Make Blank - Puts a blank page in the selected placeholder(s).

Comments Opens a dialog to enter Run List position comments.

Continue Page Continues all or part of a page that has stopped. The page may have 
stopped because it has reached a hold Action in its Production Plan, 
or because it has been aborted, rejected, or in error.

Reject Page Rejects the selected page(s). All processing will be stopped for the 
rejected page(s).

Clear Rejected Status Removes the rejected status from a previously rejected page, and 
restarts processing.

Discard Page Prevents the selected page(s) from being printed, without stopping 
the rest of the job from being printed. Available only when the 
items are waiting on a Hold action or when finished.

Include Page Includes a discarded page.

Re-render Page Remakes all the existing job results which follow the selected point 
in the Production Plan. You may want to re-render a page if you 
have changed your resources (new fonts, color books, etc.) or if you 
want to remake aborted results, or remake output when no raster 
data is available.

Re-image Page Remakes previously imaged raster data (Digital Film) on your output 
devices. This feature is available only for flows that have an imaging 
output device and finished raster data.

Re-export Page Re-exports previously exported results (when resources have 
changed or exported files have to be recreated).

Context Menu Item Description
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Remake InkDrive for 
Page

Remakes InkDrive files for the selected pages.

Preflight Report Generates a Preflight Report.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description
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Separations Context Menu Commands

You can directly issue commands by context-clicking on separations in the 
Separations pane. The following table lists the items that may be displayed when 
you context-click a Separation.

Context Menu Item Description

Export Separation From • Latest <Task Processor name> - Exports the latest version of the 
selected separation. 

• <Task Processor name> - Exports a previous version of the 
selected separation from a preceding Task Processor in the Pro-
duction Plan.

View Separation From • Latest <Task Processor name> - Displays the results of the 
selected separation from the last Task Processor which processed 
it.

• <Task Processor name> - Displays the results of the selected sep-
aration from a preceding Task Processor in the Plan.

The results are displayed using the default viewer. You cannot edit 
the page.

Info for Separation From • Latest <Task Processor name> - Opens an Info window for the 
selected separation(s) at the latest point in the Production Plan. 

• <Task Processor name> - Opens an Info window for the selected 
separation(s) from a preceding Task Processor in the Production 
Plan. 

You can open multiple Info windows.

Select • All - Selects all separations in the current view.
• None

Continue Separation Continues all or part of a separation that has stopped. The separa-
tion may have stopped because it has reached a hold Action in its 
Production Plan, or because it has been aborted, rejected, or in 
error.

Clear Rejected Status Removes the rejected status from a previously rejected separation, 
and restarts processing.

Discard Separation Prevents the selected separation(s) from being printed, without 
stopping the rest of the job from being printed. Available only when 
the separations are waiting on a Hold action or when finished.

Include Separation Includes a discarded separation.

Re-render Separation Remakes all the existing separations which follow the selected 
point in the Production Plan. You may want to re-render a separa-
tion if you have changed your resources (new fonts, color books, 
etc.) or if you want to remake aborted results, or remake output 
when no raster data is available

Re-image Separation Remakes previously imaged raster data (Digital Film) on your output 
devices. This feature is available only for flows that have an imaging 
output device and finished raster data.
Apogee Reference Guide



1270 SEPARATIONS CONTEXT MENU COMMANDS
Re-export Separation Re-exports previously exported results (when resources have 
changed or exported files have to be recreated).

Remake InkDrive for Sep-
aration

Remakes InkDrive files for the selected separations.

Re-print Separation Remakes previously imaged raster data (Digital Film) on a digital 
press. This feature is available only for flows that have a digital 
press and finished raster data.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description
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System Overview Context Menu Commands

You can directly issue commands by context-clicking one of the Task Processors 
or the Apogee System icon in the Hardware pane. 

Task Processors The following table lists the items that may be displayed when you context-click 
a Task Processor in the System Overview.

Apogee System The following table lists the items that may be displayed when you context-click 
the Apogee System icon in the Hardware pane of the System Overview.

Context Menu Item Description

Export Output Device 
PPD (Output Task Proces-
sors only)

Device PPD...- Creates a PPD file for the selected output device.

Start Start a Task Processor

Stop Stops a Task Processor

Restart Stops the Task Processor and starts it again.

Put Online (Output Task 
Processors only)

Enables the scheduling of tasks for the selected Output Task Pro-
cessor. This option is disabled if all Output Task Processors are 
online.

Put Offline (Output Task 
Processors only)

Disables the scheduling of tasks for the selected Output Task Pro-
cessor. This option is disabled if all Output Task Processors are 
offline.

Configure Allows you to access the Configuration settings of the selected out-
put device. Administrator access level required,

Resources Allows you to quickly access the resources of the selected Task 
Processor.

New Group Creates a Task Processor group for the selected Task Processor.

Edit Group Edits the selected Task Processor group

Delete Group Deletes the selected Task Processor group

Activity for <selected 
Task Processor>

Opens the Activity window for the selected Task Processor. For more 
information, see “Monitoring your Task Processors” on page 664.

Log for <selected Task 
Processor>

Opens a Log window for the selected Task Processor(s). You can 
open multiple Log windows.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.
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Activity Window Context Menu Commands

You can directly issue commands by context-clicking one of the tasks listed in the 
Activity window.

Context Menu Item Description

Log for Apogee System Opens a Log window for the Apogee System.

Export System Log Exports the System Log.

Help Opens context-sensitive help for the currently selected item. If no 
specific help is available for the selected item, then more general 
context help is displayed.

Context Menu Item Description

Continue Tasks Continues all or part of a task that has stopped. The task may 
have stopped because it has reached a hold Action in its Pro-
duction Plan, or because it has been aborted, rejected, or in 
error.

Hold Tasks Puts the selected task(s) on hold.

Help Opens context-sensitive help for the currently selected item. If 
no specific help is available for the selected item, then more 
general context help is displayed.
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APPENDIX
E Glossary

This glossary defines many of the terms used in this document with which the 
user may not be familiar.

Action There are 2 types of Actions: 
Flow Control Actions control the 
flow of job data through a Produc-
tion Plan; Result Actions keep track 
of job results in the processing chain.

Apogee System The Apogee System 
manages all data and processing 
functionality, and runs on one or 
more dedicated Windows servers.

Archive A job which has been saved 
as a .arch file. In the Job Ticket 
Options you can define which parts 
of the job are archived (input files, 
marked results, all results, imposi-
tion resources, Preflight profiles, 
etc.).

Assembly The arrangement of signa-
tures which are bound to create a 
finished printed product.

Bleed Margin The distance that a 
printed image extends beyond the 
trim size of a page, in order to avoid 
white space at the edges of pages in 
the trimmed product.

Binding Style The method used to 
bind the signatures of a printed 
product. See Saddle Stitch, Perfect 
Bound, Come and Go, Cut and Stack, 
Flat Work, Mechanical.

Book Signature A section of a book 
formed by folding and trimming a 
Press Sheet with 4 or more pages. 

Each book signature consists of the 
pages for both the front and the back 
of the press sheet. Jobs with more 
pages than can print on a single 
press sheet are comprised of many 
book signatures. 

Bottling The adjustment required to 
compensate for the undesired 
rotation of pages as a result of 
folding a press sheet to obtain a 
signature.

Calibration The process of calculating 
and compensating for irregularities 
in the output of a press or imaging 
system due to dot gain. Dot gain 
occurs when the ink dots that make 
up a printed image are larger (for 
example, due to spreading on paper) 
than in the halftone screen.

CID Font The CID-keyed font file 
format is designed for fonts with 
large character sets, and can be used 
with PostScript printing software. It 
is the ideal format for Chinese, 
Japanese, or Korean fonts, and may 
also be used for Roman fonts with 
very large character sets. “CID” 
refers to the Character ID numbers 
that are used to index and access the 
characters in the font.

CIELab CIELab is the color space that 
ICC Profiles and CMMs often use as 
an intermediary space when 
converting colors. So a monitor to 
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printer match translates colors from 
the monitor’s space (RGB) into Lab 
and then into the printer's color 
space (CMYK for example). The L 
component is the lightness of the 
color. The a component is the red/
green scale (+a is red, -a is green) 
The b component is the blue/yellow 
scale (+b is yellow, -b is blue). 

Client The Apogee Client application 
allows you to access and control the 
Apogee System remotely from any 
PC on the network.

CMYK Cyan, Magenta, Yellow, and 
Black - the standard ink colors used 
in four-color printing. CMYK is a 
color model based on the subtractive 
color theory, and is used by profes-
sional printers to reproduce color 
using offset lithography.

Coated Stock Any paper that has a 
mineral coating applied after the 
paper is made, giving the paper a 
smoother finish.

Color Bar A color test strip that is 
printed on the waste portion of a 
press sheet. It allows a pressman to 
determine the quality of the printed 
material relative to ink density, 
registration and dot gain. It also 
includes the Star Target, which is a 
similar system designed to detect 
ink problems. 

Color-managed Display Proofing
Displays the job data on-screen in 

Raster Preview. However, in this 
case you have a preview of the 
rendered result using color manage-
ment to convert the press color 
space to the monitor color space 
based on ICC profiles. With a 

calibrated monitor environment and 
correctly configured monitor 
profile, contract-proofing quality 
should be achieved.

Color Separation In traditional 
prepress, the separation of a color 
image into four layers corre-
sponding to the four process colors 
(CMYK) used in process printing.

Come and Go A term used to refer to 
a binding style whereby the bound 
signature contains two complete 
products; the bound signature is 
subsequently cut in two.

Composite A term used to refer to 
multi-color files (i.e. composite 
printing).

Copy Dot High resolution scanning 
software which produces files 
suitable for input to the Apogee 
System.

CPSI Configurable PostScript 
Interpreter.

Creep The undesired result of the 
nesting of pages inside each other 
whereby the inside pages extend 
slightly beyond the outside pages.

Crop Marks Short vertical and 
horizontal lines, printed on an 
output medium which is larger than 
the page size of a document, to 
indicate the finished page area.

CSA A Color Space Array is the 
PostScript profile for a color. The 
CSA has the information to translate 
the color data from the origin space 
to the XYZ space. It is either inserted 
into the PostScript print stream 
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when the image is printed or is 
resident in an EPS image. CSA colors 
are referred to as device-indepen-
dent, or CIEBased colors.

CSR Customer Service Representa-
tive: The person who works for a 
print service provider and who is the 
main point of contact for one or 
more customers of the print service 
provider.

CtF Computer-to-Film: An analog 
graphical workflow solution in 
which the rendered data is sent first 
to an imagesetter to produce films. 
These films are then used to 
generate the plates for printing.

CtP Computer-to-Plate: A fully 
digital graphical workflow solution 
in which no film is produced. 
Instead “Digital Film” is sent directly 
from the Render Task Processor to 
the platesetter.

Cut and Stack A term used to refer to 
a binding style whereby print sheets 
are cut and the halves are stacked to 
create a product.

DCS Desktop Color Separation. This 
is essentially an enhancement to the 
EPS definition for pictures that can 
hold the four-color separations of an 
image in one file or in 5 separate 
PostScript files.

Dead cut A single cut that separates 
adjacent elements on the sheet of an 
unbound job.

Densitometer An optical device used 
by printers and photographers to 
measure and control the density of 
color.

Density The degree of tone, weight 
of darkness or color within a photo 
or reproduction; measurable by the 
densitometer.

Digital Film The results of documents 
that have been rendered by the 
Apogee System. This high resolution 
Digital Film can be previewed as 1-
bit data (where each raster point is 
represented by a single display 
pixel), and can be output directly to 
a platesetter.

Display Resolution The actual 
dimensions of the area (expressed in 
pixels x pixels), that the operating 
system’s display driver is set to. 
Several display resolutions may be 
available (e.g. 1920 x 1080, 1680 x 
1050, 1344 x 800).

Dot The smallest individual element 
of a halftone.

Dot for Dot Proofing Allows you to 
print “screened” proofs. These are 
different from the normal error-
diffused proofs (which place ink 
droplets anywhere in the image). 
Screened proofs can only place ink 
droplets where the dots are, which 
means more ink is applied to a small 
area. These small areas (the dots) 
need to be color managed to 
produce the correct color. Dot for 
dot processing should only be done 
on 7+ color pigment proofers.

Dot Gain Terms to describe the 
occurrence whereby dots are 
printing larger than they should.

Dot Pitch The distance between two 
adjacent hardware pixels. The dot 
pitch is the inverse of the Display 
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Hardware Resolution (e.g., 0.258 
mm corresponds to approximately 
98 dpi).

Downsampling The Normalize Task 
Processor can downsample high-
resolution bitmap images to reduce 
file size. Downsampling reduces the 
number of pixels in a file by 
averaging the color of pixels in a 
sample area and replacing that area 
with one pixel of the averaged color.

DQS Digital Quick Strip. In this 
mode, Apogee creates and renders 
the components of a layout 
separately so these components can 
be replaced without re-rendering 
everything. This approach keeps 
your page workflow independent of 
imposition templates.

Dynamic Resubmit After you edit and 
submit a job, Apogee will automati-
cally determine which results need 
to be reproduced, and will process 
them accordingly.

Elliptical Dot Halftone screens in 
which the dots are actually 
elongated to produce improved 
middle tones.

EPS Encapsulated PostScript: A 
standard format for a drawing, 
image, or complete page layout, 
allowing it to be placed into other 
documents. EPS files normally 
include a low resolution screen 
preview

Flat A sheet of film used to expose 
one printing plate. A flat may be 
either a front signature or a back 
signature.

Flatten The Flatten operation 
‘flattens’ multi-layered images, and 
converts layers that contain trans-
parent objects into layers without 
transparent objects.

Flat Work A term used to refer to a 
binding style whereby print sheets 
do not have to be folded to create a 
product.

Flow A sequence of components 
(Task Processors and Actions) in a 
Production Plan. A Production Plan 
has at least one Main processing 
flow, but can include as many 
additional flows as you require. 
Each flow leads to a unique output 
device.

Font A set of letters, numbers, 
punctuation marks, and symbols 
that share a unified design. The 
design is called a typeface.

Font Outlining Missing or incorrect 
fonts often cause problems for 
prepress operators. The font 
outlining feature allows even 
encrypted and protected fonts to be 
included in the normalized PDF. 

Foot to Foot Imposition layout with 
the bottom of the pages arranged 
against the bottom of other pages.

FTP File Transfer Protocol. One of 
the standard protocols defined for 
use on a TCP/IP network.

Ganging The bundling of two or 
more different printing projects on 
the same media.

Generic Devices These devices 
process files for imaging on non-
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ECO3 physical output devices, 
without being directly connected to 
them. Generic devices can be used 
for testing or demo purposes. For 
example, they can emulate the 
timing of a physical output device 
without producing real output files. 

Grayscale Shades of gray that range 
from black to white.

Grayscale Image A single-channel 
image consisting of levels of gray 
(up to 256 levels of gray with 8 bits 
of data per pixel).

Gripper Edge The grippers of the 
printing press move the paper 
through the press by holding onto 
the leading edge of the sheet; this 
edge is the gripper edge.

Halftone The reproduction of a 
continuous-tone image, which is 
made by using a screen that breaks 
the image into various size dots.

Halftone Screen Traditionally, 
continuous-tone art (such as a 
photograph) is reproduced by 
photographing the original artwork 
through a crossline or contact 
screen. The resulting halftone image 
is composed of a matrix of dots, 
ellipses, squares, or lines of various 
sizes that can be reproduced via 
offset lithography.

Head Margin from the top of a page 
to the type area.

Head to head Imposition layout with 
the top of the pages arranged 
against the top of other pages.

Hi-Fi Color Any process that 
increases the color gamut of an 
output imaging device (printer). 
Usually refers to adding extra inks 
and plates to the traditional CMYK 
set to improve the color gamut of 
offset lithography.

Hot Folder An input channel used for 
file-based input. This type of input is 
based on dragging files to specific 
folders. Apogee polls all configured 
Hot Folders, and automatically picks 
up and processes the documents 
that are dropped in them.

Hot Ticket Hot Tickets automate the 
job creation process, creating 
multiple jobs on demand. When you 
send a document to a Hot Ticket 
input channel, the Hot Ticket 
creates a new job (by combining a 
copy of its ticket with the input 
document), and automatically 
submits it to the Apogee System. No 
further user intervention is 
required.

ICC Profile The International Color 
Consortium was founded to create 
an open, vendor-independent, 
cross-platform standard for color 
management. ICC Profiles are 
standards for describing the color 
characterizations of different 
devices. 

Imagesetter A high-resolution 
printer used to prepare high-quality 
page art on paper or film (usually at 
resolutions between 1,200 and 
5,000 dots per inch).

Imposition The arrangement of 
pages on the press sheet so that 
when folded the pages read consec-
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utively. How you arrange the pages 
on the sheet depends on the sizes of 
the press sheet and the pages, and 
how the job will be folded and 
bound.

InkDrive File This file contains low-
resolution images to inform the 
Press operator how much ink he can 
use for the print job.

Ink Set Contains the color specifica-
tions for the process colors of the 
used color space. Euro, Swop, Toyo 
and Dic are some examples of Ink 
Sets. They all use the standard 
CMYK color space. 

Input Channel A channel through 
which you can input your 
documents for processing by Apogee 
(e.g. Hot Folder).

JDF JDF (Job Definition Format) 
technology is an extensible, XML-
based format based on Adobe's 
Portable Job Ticket Format (PJTF), 
providing compatibility with a 
greater variety of job creation utili-
ties. Apogee can import JDF files 
generated by Apogee Series3, or 
3rd-party applications, and convert 
them to Apogee Job Tickets. Apogee 
interprets JDF instructions for end-
to-end job ticket specification, 
streamlining print production from 
creation to delivery. 

Job Ticket Job Tickets define how the 
pages of a single job are to be assem-
bled, the processing features to be 
used (imposition, separation, 
trapping, overprinting, rasteriza-
tion, etc.), and the output device to 
which the rendered job will be sent. 
A Job Ticket is always associated 

with one or more unique input 
channels (Hot Folders, AppleTalk 
Channels, etc.).

Jog A term used in binding to refer to 
the evening up of stacked pages to 
prepare them for binding.

Keep Results By default, when a 
Task Processor passes on its results, 
it does not retain a copy of them. 
However, the Keep Result Action 
instructs Apogee to keep this Task 
Processor’s results. This ensures that 
these intermediate results are saved 
and kept on the system.

Lay An indication of how a press 
sheet is to be fed into a press.

Lay edge The edge of the press sheet 
that is fed into a press. See also 
Gripper Edge.

Layout job A job that’s created using 
the Layout Editor.

Linearization This is a type of calibra-
tion, especially used for 
imagesetters and platesetters. 
Through linearization, you can 
adjust (linearize) the Stimuli values 
so that they equal the Wanted values 
during output. Unlike Calibration, 
where the curve is not necessarily 
linear.

LPR LPR/LPD is the printing method 
most commonly used in TCP/IP 
networks. The LPR/LPD protocol is 
broken into two parts, LPR and LPD. 
LPR (Line Printer Request) is the 
client part of the protocol that 
submits the print request. LPD (Line 
Printer Daemon) is the server part 
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that receives and processes the 
request.

Mechanical A term used to refer to a 
binding style whereby spiral, coils, 
rings, etc. are used to bind the signa-
tures of a product together.

Milestone A Milestone Action passes 
on the intermediate job results from 
the associated Task Processor to the 
next Task Processor in the flow 
without interruption. However, a 
notification is generated if the 
associated Task Processor does not 
deliver all intermediate job results 
by a predefined date and time.

MIME Multipurpose Internet Mail 
Extensions. An Internet standard 
which allows transfer of binary files 
(word-processing documents, 
spread sheets, images, sounds, etc.) 
between any compliant mailers.

Milling A term used in the binding 
process that refers to preparing the 
spine edge of folded signatures so 
the glue has a firmer grip on the 
pages.

Moiré An undesirable halftone 
pattern produced by the incorrect 
angles of overprinting halftone 
screens.

Multi-part job This type of job 
typically comprises a number of 
sections (cover, editorial, sports 
section, etc.) each with different 
properties (paper type, color or 
B&W, binding style, etc.). Different 
signatures may be combined onto a 
single sheet, separations may be 
combined on a single plate, different 

sheets may be printed on different 
presses, and so on.

Nesting A type of imposition which 
optimizes the use of media.

Normalize Convert PostScript, EPS or 
PDF-files to standardized or 
“normalized” PDF files. This process 
generates a PDF file that is suitable 
for reliable high-end prepress 
production.

Opaque Ink Ink that completely 
covers any ink under itself.

OPI Open Prepress Interface. A speci-
fication that describes how a 
document refers to external images 
(low or medium resolution) without 
actually including them in a 
document. At print time, an OPI 
server replaces these low or medium 
resolution images by their high-
resolution counterparts.

Output Device A hardware device 
that writes raster data onto media 
such as film, plate or paper. There 
are two types of output devices: 
Generic (non-physical) output 
devices and physical output devices. 
A typical output device may be a 
printer, sign and display device, 
proofer, platesetter, or imagesetter.

Overprinting A printing technique 
where a darker color prints on top of 
a lighter color (i.e. black text on a 
light colored background), thus 
eliminating the need for trapping.

Overfold A small flap on one of the 
sides of a folded signature which is 
used by the stitching machine to 
grasp the signature.
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Packaging Job A job that uses a CAD 
layout and which is prepared in the 
Layout Editor.

Parameter Set Each Task Processor is 
installed with initial settings that are 
automatically assigned by Apogee, 
and cannot be changed or deleted. 
However, you can define additional 
groups of settings based on the 
initial settings, and save them under 
different names. These are referred 
to as Parameter Sets.

PDF Portable Document Format. A 
file format used to describe cross-
platform documents which are 
created using Adobe Acrobat 
Exchange or Distiller, and which can 
be viewed on-screen and printed, 
using Adobe Acrobat Reader.

PDF Job Both job ticket information 
and the referenced pages can be 
saved in a single composite PDF file, 
referred to as a PDF Job. When a 
PDF job is opened, the embedded 
job ticket references point no longer 
to local PDF files, but to the PDF job 
itself. You can then specify the 
necessary processing and output 
parameters, and submit the job for 
processing.

Perfect Bound A term used to 
describe the binding process where 
the signatures of a book are held 
together by a flexible adhesive.

Perfecting A workstyle whereby both 
sides of a press sheet are printed in a 
single pass through the press. See 
also Perfecting Press

Perfecting Press A printing press 
than can print both sides of a press 
sheet at once.

Pica A typesetting unit of measure-
ment equaling 1/6th of an inch.

PJTF Imposition is the arrangement 
of pages on the press sheet so that 
the pages can be correctly folded 
and read consecutively. How you 
arrange the pages on the sheet 
depends on the sizes of the press 
sheet and the pages, and how the job 
will be folded and bound. All 
imposition information can be 
gathered in one PJTF file (Portable 
Job Ticket Format). The PJTF file 
defines the complete imposition for 
your job.

Placeholder A reserved space within 
a job ticket in which you can place 
one page of a document, or a blank 
page.

Plane A single separation in a color 
image.

Platesetter A high-output computer-
to-plate imaging system, which 
produces full-page images from 
computer directly onto plate, ready 
for offset printing.

Point A basic unit of typographic 
measurement. A point is approxi-
mately equal to 1/72 of an inch.

PostScript The language developed 
originally by Adobe to communicate 
high-level graphic information to 
digital laser printers. PostScript 
expresses complex digital graphics 
in a device-independent manner. 
Powerful typesetting features are 
Apogee Reference Guide



 

 GLOSSARY 1281
built into the language for sophisti-
cated handling of letter forms and 
graphics.

PPD PostScript Printer Description: 
A readable, machine-parsable text 
file that provides a uniform 
approach to using the special 
features of devices that contain 
PostScript interpreters. These 
features include different page sizes, 
different methods of paper and film 
handling, memory size, font avail-
ability, duplex printing and stapling. 
All devices do not have the same set 
of features, and even devices with 
the same features do not necessarily 
invoke those features in the same 
way. The PPD file contains the 
PostScript language code to invoke 
each feature.

Preflight The process of checking a 
PDF document against various 
criteria to ensure that the document 
meets all the requirements for 
output or publication. Typically, the 
criteria vary depending on the 
output or publishing process.

Preflight Profile A set of criteria 
matching the requirements of a 
particular output or publishing 
process.

Pre-separated A pre-separated PDF 
or PostScript file contains a separate 
plate for each color in the document. 
A standard process color job would 
have four plates (pages) containing 
just the color information for each 
color of CMYK. For spot colors, there 
is a page for each spot color. 

Print Buyer The person in an organi-
zation who is responsible for 

purchasing the services of a print 
service provider and as such is the 
customer of the print service 
provider.

Print Center Printing companies or 
other service providers belonging to 
the same organization and that can 
use Apogee independently from 
each other.

Print Service Provider An organiza-
tion that provides printing and 
related services, also referred to as a 
printer or printing company.

PrintSphere A cloud service hosted 
by ECO3 Graphics that allows easy 
file transfer between the different 
collaborators of a job

Private Page Store The Page Store is 
a repository of pages available for a 
single job. When you input 
documents to Apogee, the 
document pages are stored in the 
Private Page Store associated with 
the job input channel you selected.

Process Color Any color (except 
cyan, magenta, yellow, black, white, 
and certain Pantone colors) can be 
specified as spot colors or process 
colors When separations are 
printed, all process colors on a page 
are broken down into their cyan, 
magenta, yellow, and black compo-
nents, each of which is printed on its 
own separation plate. When 
combined during offset printing, the 
process colors can reproduce full-
color page art.

Product A book, magazine, brochure, 
flyer, etc. that a print-buyer wants a 
printer to produce.
Apogee Reference Guide



 

 GLOSSARY 1282
Production Plan A series of compo-
nents (Task Processors and Actions) 
linked together to form one or more 
processing flows. These components 
can be configured to define exactly 
how jobs are to be input, processed, 
and output.

Proof A set of job results produced 
before the final results are output to 
a plate- or imagesetter. This allows 
you to verify and correct different 
aspects of a job before submitting it 
to press. In Apogee, you can 
generate a page proof, an imposition 
proof, or a production proof.

Proofer A high-resolution printer 
(such as the Sherpa Proofer) for 
printing hard copy color proofs.

Public Page Store A repository of 
pages available for all jobs. To input 
documents to a Public Page Store, 
you must use an input channel that 
was configured using a blank Page 
Store job template.

Punch Calibration This allows 
Apogee to calculate the exact 
position of the imagesetter punches 
in order to ensure the correct 
positioning of the printed image on 
the output media.

QMS ECO3’s Quality Management 
Software ensures an identical tonal 
behavior for the different Sherpas, 
and verifies the output accuracy. This 
guarantees the same output quality 
for every Sherpa model.

Registration Marks Reference marks 
that appear on camera-ready art, 
generally for CMYK color separa-

tions, which help align the 
overlaying printing plates.

Remote Proofer Controller The RPC 
Task Processor provides a low-cost 
proofing solution for customers 
working off-site. These customers 
require only an ECO3 proofing 
device and the RPC software 
package to print proofs. The 
prepress shop, equipped with a full 
Apogee System, creates and exports 
the RPC files. These files are then 
sent to the remote site, where they 
are imported into the customer's 
RPC application.

Render A Render Task Processor 
converts a PostScript or PDF 
document into a matrix of dots, 
ready for output to a specific output 
device such as an imagesetter, plate-
setter, proofer, or color printer.

Render Resolution The ratio of pixels 
per inch that the Render Task 
Processor uses when generating an 
image (expressed in dpi).

Resolution A measure of the fineness 
of spatial detail that a device can 
record or produce. The higher the 
resolution, the finer the detail. 
Resolution is expressed in elements 
per unit length; for example, pixels 
per inch (ppi) for scanners and 
monitors (refer also to dpi).

Resource A collection of objects 
(such as fonts, preflight profiles, or 
calibration curves) that are required 
by selected devices or Task Proces-
sors. By default, Apogee provides 
you with some basic resources for 
each of the available Resource 
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categories. You can also add your 
own resources to those supplied.

Result A result is the tangible output 
that is produced by a Task Processor 
component. It can be a document 
(PDF, TIFF or other file) or an image 
on a piece of film, plate or paper. A 
result can be intermediate or final. A 
final result is the result produced by 
the last component in the Produc-
tion Plan flow. All other results are 
intermediate; they are passed from 
one component to another; and can 
be deleted when no longer required.

RGB Red, Green, Blue Refers to the 
primary colors, namely Red, Green, 
Blue, in the additive color model. 
The RGB model is used in color 
televisions, monitors, scanners, and 
color film recorders.

Rule-up A press sheet with rules to 
indicate the various components 
such as the imposed pages, the fold 
sheet, bleed area, etc.

Run List A Run List determines which 
pages of a job will be processed. If 
you insert a Run List in your Produc-
tion Plan, a list of placeholders 
appears in the Pages tab. You can 
then select PDF pages from the Page 
Store and drag them across to the 
Run List. Not all placeholders need 
to be filled. A placeholder can be 
empty, or can contain a blank page. 
Every Job Ticket needs a Run List 
whereas a Hot Ticket can contain 
one, but it is not necessary.

Rush Job You can upgrade any job in 
the Job List to a “rush” job. This puts 
the job to the top of the queue of jobs 
waiting to be processed by Apogee. 

A rush job is processed as soon as 
Apogee has finished processing the 
current job.

Saddle Stitch The binding of 
booklets or other printed materials 
by stapling the pages on the folded 
spine; also called saddle wire.

Screening The conversion of contin-
uous-tone images to halftone dots. 
The resulting images are Bitmap 
files ready to be sent to an output 
device.

Screen Angles The angles at which 
halftone screens are placed in 
relation to one another.

Screen Font A bitmap representation 
of a font that is used to display the 
characters on-screen.

Screen Frequency The density of dots 
on the halftone screen, commonly 
measured in lines per inch (also 
known as screen ruling).

Screen Ruling A measurement 
equaling the number of lines or dots 
per inch on a halftone screen.

Seamless Printing used in packaging 
jobs for printing a repetitive design, 
as in wallpaper or gift wrapping 
paper. These are usually printed in 
flexo.

Separation Before an image can be 
output via an output device, it is split 
up into separation colors. The most 
common used separation colors are 
Cyan, Magenta, Yellow and Black 
(CMYK). When combining these 
separations, the Press produces the 
final image.
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Server In the context of Apogee, this 
is the Windows 2003/2008 Server 
on which the Apogee System is 
running (represented by the 2nd 
icon in the System Overview 
window). In future releases, you 
will be able to deploy the Apogee 
System over several Servers.

Sheetwise A workstyle whereby a 
print sheet has different content on 
the front and back sides. The sheets 
are turned in such a way that the 
gripper edge is kept at the same side.

Shingling An adjustment applied to 
template pages and jobs to compen-
sate for the creep that occurs when 
signatures are folded and nested 
inside each other.

Signature See Book Signature.

Simulation This is a type of calibra-
tion which you can use to simulate 
or test different types of output 
results. You can for instance 
purposely use a non-linear curve to 
obtain a certain dot gain, or attempt 
other special effects. There are no 
Measured values for Simulation. 
The curve is solely based on Wanted 
values (i.e. the desired curve).

SISR Smart Input Space Recognition.

Soft Proofing This method does not 
physically output the proof to a 
printer. Instead, the job data is 
displayed on-screen. Raster or PDF 
soft proofs show trapping and 
overprint information. These can be 
sent to customers and verified using 
Acrobat or Photoshop.

Spot Color Any color (except cyan, 
magenta, yellow, black, white, and 
certain Pantone colors) can be speci-
fied as spot colors or process colors. 
When separations are printed, each 
spot color on a page is printed onto 
its own separation plate. In contrast, 
process colors are broken down into 
their cyan, magenta, yellow, and 
black components, each of which is 
printed on its own separation plate.

Task Processor Task Processors are 
software components that perform 
one or more tasks (specified by the 
Ticket), such as input via Hot Folder, 
Normalization, Preflight, Trapping, 
rendering, etc. A sequence of Task 
Processors can be linked together to 
form a Production Plan.

TCP/IP Transmission Control 
Protocol / Internet Protocol: This is 
a communications “language” 
which is used to enable two different 
computers to exchange data over a 
network, particularly over the 
Internet.

TIFF Tagged Image File Format: This 
is a standard file format used for 
exchanging bitmapped images 
between applications or platforms.

Trapping A printing technique where 
adjoining colors are made to overlap 
slightly to compensate for misregis-
tration on the printing press. Usually 
the darker color is used to define the 
edges of an element while the 
lighter color spreads into it.

Type area Area within the margins of 
a page.
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Versioning Allows you to create jobs 
which contain several different 
versions, typically for some or all of 
the text (for example, using 
different languages or prices), and 
to choose the optimal set of plates to 
be made. If, for example, you want 
to publish a brochure in six different 
languages, you can include the 
Versioning Task Processor in your 
Production Plan, and then print 
several different language versions 
of the brochure using a single job. 
The basic Production Plan is 
straightforward, using Versioning 
instead of a Run List Task Processor.

VLF Very Large Format platesetter, 
which can produce plate sizes up to 
80 x 58” (2030 x 1475mm).

Web browser Software for 
navigating and viewing web 
documents.

Web Growth The deformation 
(stretch) of the paper as it is printed 
on the various color units on a web 

press. The physical deformation 
occurs as the paper absorbs ink and 
water, and is accelerated with 
pressure and tension.

Wide-Format Job A job prepared for a 
a wide-format printing device such 
as used for sign and display printing.

Work And Tumble A workstyle 
whereby a press sheet has the same 
content on the front and back sides. 
The sheets are turned in such a way 
that the gripper edge is at the 
opposite side.

Work And Turn A workstyle whereby 
a press sheet has the same content 
on the front and back sides. The 
sheets are turned in such a way that 
the gripper edge is kept at the same 
side.

Workstyle A term that refers to how 
print sheets are printed on a press; 
see also Sheetwise, Work And Turn, 
Work And Tumble, Perfecting.
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